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Getting Started

Welcome to Output Manager
Welcome to the User Guide for Output Manager. This guide contains the task descriptions and reference
documentation that describes how to use Output Manager to manage an organization's output operations.

Output Manager gives organizations control of what, when, and how they produce and deliver information. Output
Manager is designed to route documents through a centralized system. This provides significant benefits over
unmanaged systems in which documents travel directly between origin and destination.

Product Features

Output Manager contains the following core features:

• Maximizes the number of sources from which you can receive documents.
• Provides unrivaled control over documents.
• Manages many different document destinations.
• Ensures security and integrity of documents during the entire send and receive cycle.
• Produces a completely integrated audit trail.
• Provides accounting functionality to monitor and control costs.
• Supplies tools to convert document formats for particular destinations.
• Allows administrators, operators, end users and management to view and monitor processes.

Output Manager supports a wide variety of sources for receiving documents. However, regardless the source
application, Output Manager maps document information, such author, header, or job ticket, and maps it to Output
Manager document properties. This enables a workflow to route documents based on specific job information. You
will find that Output Manager's many options allows users to connect seamlessly to your systems and receive files no
matter where they originate.

Getting Started
Follow these high-level steps for a basic Nuance Output Manager implementation. The steps for your implementation
may vary.

1. Perform initial administrative setup

• Manage Nuance Output Manager security roles
• Configure Nuance Output Manager Console security
• Detect printers
• Manage SNMP devices
• Customize the grid views
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2. Define a source to receive documents into Output Manager

• How to add an AutoStore source on page 83
• Receive documents from an email address
• Receive documents from an FTP connection
• Receive documents from an LPD connection
• How to add a Mobile Server source on page 104
• How to add a NetWeaver source on page 108
• Receive documents from a network folder
• Receive documents from another Nuance Output Manager
• Receive documents from a socket connection
• How to add a TCP/IP NJE source on page 122
• How to add a WCF API source on page 126
• How to add a Web Upload source on page 130
• Receive messages from WebSphere MQ
• Receive documents from a Windows queue

3. Define a destination to send documents from Nuance Output Manager

• Sending Documents to AutoStore on page 161
• Send documents to an email address
• Sending Documents to a Fiery Device on page 165
• Send documents to an FTP server
• Send documents to an IPDS printer (not available for new sales)
• Send documents to an IPP destination
• Sending Documents to JDF/JMF on page 176
• Send documents to an LPR server
• Send documents to a network folder
• Route documents to another Nuance Output Manager
• Sending Documents to a PRISMAProduction Destination on page 187
• Sending Documents to a SharePoint Site on page 189
• Send documents to a socket
• Send documents to a WebSphere MQ
• Send documents to a Windows queue

4. Route documents to a destination

• Manually route documents from the Nuance Output Manager Console
• Automatically route documents using business rules

Output Manager Concepts
Nuance Output Manager is a complex application with numerous features targeted at increased efficiency in
managing output. This section covers the core concepts of the system.
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Sources

Documents are received into Nuance Output Manager via sources. These sources can be created, configured, and
monitored by administrators using the Output Manager Console. Sources can be organized into source groups, which
allow for easier monitoring from the Output Manager Console. The following table lists the source types supported by
Nuance Output Manager.

Table 1: Source types

AutoStore Output Manager servers

Email Socket

FTP TCP/IP NJE

IPP WCF API

LPD Web Upload

Mobile Server WebSphere MQ

NetWeaver Windows queue

Network folders

Destinations

Documents are sent from Nuance Output Manager to destinations. These can be printers or other devices, as shown
in the following table. Destinations can be created, configured, and monitored by administrators using the Output
Manager Console.

Destinations can be organized into destination groups, which allow for easier monitoring from the Output Manager
Console. These destination groups also play an important role in configuring functions such as failover printing, load
balancing, and print splitting.

Table 2: Destination types

AutoStore Network folders

Email Output Manager servers

Fiery Device PRISMAProduction

FTP SharePoint

IPDS (not available for new sales) Socket

IPP WebSphere MQ

JDF/JMF Windows queues

LPR

Printer families The concept of printer families is used in Nuance Output
Manager to configure commands for print languages and
map them to destinations based on their capabilities.
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SNMP devices Modern printers can provide information about their
status and capabilities via SNMP. Nuance Output
Manager uses SNMP to both discover and monitor
printers. Once discovered, administrators can create
destinations associated with these physical devices.

Documents

The main purpose of Nuance Output Manager is to manage the flow of documents. The concept of the document is
therefore present in virtually all areas of the product.

Document properties Every document in Nuance Output Manager has
metadata associated with it. This can range from
obvious items like document name and type, to finishing
options like stapling and binding. All of these are called
document properties. Some of the properties are editable,
while others are shown only for informational and
reporting purposes. When setting up Nuance Output
Manager, administrators configure which document
properties are active, their display names, and their
default initial values.

Active documents Documents coming into Nuance Output Manager are
considered Active, until they are either printed or deleted.

Retained documents Once a document is printed or deleted, it is retained.
Retained documents can be easily restored to the Active
status from one of Nuance Output Manager’s various
user interfaces. There are global and document specific
settings that govern whether a document is retained or
not.

Document library This destination is intended for long-term document
storage and web presentation purposes. The Library
application is similar to the Documents application
because it has a folder structure that you can modify for
better organization and queries for finding documents.
The documents are put in the library folder when they are
routed to the Document Library destination.

Document folders Documents can be organized into document folders.
These folders govern the security rights that users and
user groups have over documents.

Document queries Document queries are used to quickly locate documents
based on their properties. Queries can be run ad hoc or
saved for future use.

Routing of documents There are three ways to route documents from a source to
a destination:

• Include a default destination in the source
configuration.

• Create a business rule to route to a destination.
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• Manually route the document from one of Nuance
Output Manager’s user interfaces.

Document transformations Nuance Output Manager supports a variety of document
types, such as PCL, PS, PDF, Text, TIFF, JPG, PGN,
AFP, IPDS (not available for new sales), LCDS, and so
on. The system also supports transforming documents
between these print description languages (PDL).

Document re-engineering There are times when customers want to add or remove
information from documents without making changes to
the application that generates the document. Examples
include adding barcodes, OMR marks, logos, and so
on. Similarly, bundling and splitting of documents is
sometimes desired. Nuance Output Manager includes
broad support for all these actions.

Package Nuance Output Manager uses a package to describe a
collection of documents. In most cases, there is only
one document in a package. You can think of packages
as documents. Packages are used to group multiple
documents together to be sent to a destination as a
single unit. A package can be created or modified using
Business or Ad Hoc Rules. You can select documents
that you want to add or remove from packages by
selecting Package Manager from the document context
menu.

Output processes

Nuance Output Manager includes the powerful concept of output processes. These processes can be associated with
either destinations or documents. They represent a predefined set of actions which would impact a document as it is
being sent to a destination. Examples include search and replace, setting finishing options, and inserting overlays.

The output Process Designer is a utility included in the Output Manager Console that is used by administrators to
design Output Processes. The visual flowchart style designer makes it easy and intuitive to create complex, powerful
processes.

File stores

Nuance Output Manager’s architecture includes a database which only stores document properties. The actual files
are stored in network folders, called file stores. Administrators can define multiple file stores, and configure which
documents go into which file stores.

Security

Security control is a central component of Nuance Output Manager. Granular rights can be assigned to users and
user groups for every major area of the system: destinations, sources, documents, administration, and user interfaces.
These rights control both visibility and which actions can be performed. The use of inheritance throughout the product
greatly simplifies the process of setting up security.
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Failover profiles

In an ideal world, destinations are always ready to receive documents. In the real world, at times printers or other
devices are inaccessible. Nuance Output Manager includes failover profiles, which allow administrators to specify
what should happen to documents in such cases. Included in the failover profiles is the ability to pick alternate
destinations where the documents can be routed.

Business rules

Nuance Output Manager is designed to operate unattended. It is a system geared towards automation of document
processes. Business rules represent the main interface for managing and configuring these automatic processes.
Administrators can create rules which include conditions and actions. Conditions have to be true in order for the rule
to affect the document. Actions impact documents in a variety of ways. Examples include routing to destinations,
transforming to other print languages, assigning to document folders, editing document properties, and so on.

Ad Hoc Rules

Ad Hoc Rules are run on user-selected documents that already exist in Nuance Output Manager. You can manually
initiate the rules or you can schedule them to run periodically using the Schedule Manager. Examples of ad hoc
actions that may be in an ad hoc rule include create a package of documents, merge documents in to a package, set
document states, and assign documents to a document folder.

Alert rules

Alert rules allow administrators to configure advanced alert options for when certain events happen. This is
particularly useful for monitoring printer states. Through alert rules, support personnel can be proactively informed
when printers have conditions that could prevent end user printing.

Billing accounts

Nuance Output Manager offers complete flexibility in configuring billing accounts. These accounts can be associated
with documents. The association can occur automatically based on document properties, or manually based on input
from users. Reports can then present a complete picture of total print output by billing account.

Costing

Nuance Output Manager sources and destinations can have per page costs associated with them. A cost can be
assigned to every document coming in and going out of Nuance Output Manager. This cost can be based on basic
document properties such as color versus black and white, or more advanced properties such as media type and
finishing options.

Quota management profiles

Reporting, costing, and billing accounts can provide a complete picture of printing costs. Quota management profiles
are used to take this one step further and actually modify user behavior. These profiles can be configured to set up
restrictions based on the type of document. Examples include disallowing color printing, requiring documents to be
duplex, disabling print from certain applications, and so on.
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User balances

In addition to quota management profiles, users can be assigned balances. For example, all users in a particular
department could be assigned a $50 print allowance for the month. Once reached, any print from the respective users
is disallowed. Administrators have full control over setting up balance amounts and refresh periods.

Messages

Nuance Output Manager posts messages whenever an event takes place. These messages are viewable using the
Message Console included in the Output Manager Console. Administrators can monitor messages in order to ensure
trouble free operation of the system.

Output Manager User Interfaces
Nuance Output Manager user interface components enable users to administer and interact with an Nuance Output
Manager server.

There are several user interfaces that administrators, operators, and end users can use to interact with Nuance Output
Manager. These user interfaces vary in terms of platforms they can be run on, richness of features, and footprint.

Output Manager Console The Nuance Output Manager Console is the main user
interface for Nuance Output Manager. Designed in C#,
it can be installed on any machine running Windows 7,
Windows XP, Windows 2003 Server, Windows Vista,
or Windows 2008 Server. Multiple Nuance Output
Manager Consoles can connect to the same DBM Service
simultaneously.

The Nuance Output Manager Console is the most feature
rich Nuance Output Manager user interface. It can
be used by administrators to configure the product,
operators to manage destinations and documents, and end
users to access active, retained, and archived documents.
Granular security controls allow for varied access to
features, depending on the identity of the logged in user.

Nuance Output Manager Web Interface The Nuance Output Manager Web Interface can be
accessed from any web browser, regardless of the
operating system of the machine. This user interface is
targeted towards operators and end users, so it lacks the
administrative features of the Nuance Output Manager
Console.

The functionality available in the Nuance Output
Manager Web Interface includes:

• Displaying the list of active and retained documents.
• Downloading and viewing the contents of documents.
• Routing documents to destinations.
• Changing the state of documents.
• Reprinting documents.
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Nuance Output Manager Desktop Client The Nuance Output Manager Desktop Client is designed
for Microsoft Windows workstations in typical office
print environments. It is a small footprint software
package that you can deploy using any desktop
deployment application. Running as a tray application,
the Nuance Output Manager Desktop Client allows
Nuance Output Manager to provide information to the
user and receive data from the user. It can provide users
with status messages about the documents they submit,
and allow users to view and change document properties.
It can also prompt users for cost, billing account, and
other information about the their documents. The Nuance
Output Manager Desktop Client can also monitor local
printing by users, such as documents going to USB and
parallel port printers, as well as direct IP printing.

Nuance Output Manager Embedded Interfaces In addition to the user interfaces running on PC
platforms, Nuance Output Manager also supports user
interfaces embedded in certain printer models. These
embedded user interfaces allow users who walk up to
the printers to see the list of their documents in Nuance
Output Manager. Documents can then be released for
printing or reprinting from the printer.

Instances of Output Manager
The Output Manager Console can simultaneously connect to multiple instances of Output Manager, which allows
users to quickly switch between instances. Output Manager can be configured to transfer documents and metadata
between instances.

Output Manager services
The Output Manager services provide functionality, interfaces, and data access for an Output Manager system.

Nuance Output Manager is based on the Microsoft .NET Framework. Microsoft Windows services are the backbone
of the system. They can be hosted on physical or virtual machines running Microsoft Windows operating systems.
For large implementations of Nuance Output Manager, it is a best practice to install the services on machines running
server operating systems. Throughout this guide, any machine that has at least one Nuance Output Manager service
installed is called an Output Manager server.

Output Manager server runs the services described in the following table:

Service Description

Output Manager DBM Service The DBM (database manager) service is the central point
for communication with the Output Manager Database.

Output Manager Input Service The Input Service is responsible for receiving documents
into Output Manager.
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Service Description

Output Manager Output Service The Output Service is responsible for sending documents
from Output Manager to destinations.

Output Manager SNMP Service The SNMP Service detects printers on the network and c
ontinuously monitors printer status using SNMP.

Output Manager Rules Agent Service The Rules Agent service acts as an agent for the rules en
gine that is integrated in the DBM Service.

The Output Manager Installation Guide provides more information on Output Manager server services.

Output Manager applications
Related functionality, objects, and settings are grouped and managed using applications in Output Manager.

Application Description

Destinations application The Destinations application is used to manage and
monitor destinations. Destinations provide the methods
to send documents to devices, printers or other locations.

Sources application The Sources application is used to manage and monitor
sources. Sources provide the methods to receive
documents into the Output Manager system.

Documents application The Documents application is used to manage the flow
of documents in Output Manager.

Library application The Library application allows for long-term storage of
documents that have been received into Output Manager.

Reports Application on page 24 The Reports application provides summary and
details of activity by user, department, document, and
destination.

Devices Application on page 24 The Devices application is used to manage and monitor
devices used by Nuance Output Manager. Devices
represent the physical printing hardware.

Administration application The Administration application is used to configure
administrative options in Output Manager.

Destinations application
The Destinations application is used to manage and monitor destinations. Destinations provide the methods to send
documents to devices, printers or other locations.

The Destinations application is opened by clicking the Destinations button in the Output Manager console. Output
processes can be configured to modify the print stream as a document is sent to a destination. Destination types
include the following:

• Document Library
• Email
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• FTP
• IPDS (not available for new sales)
• IPP
• JDF/JMF
• LPR
• Network folder
• NetWeaver
• Output Manager server
• PRISMAProduction
• SharePoint
• Socket
• WebSphere MQ
• Windows print queue

Sources application
The Sources application is used to manage and monitor sources. Sources provide the methods to receive documents
into the Output Manager system.

The Sources application is opened by clicking the Sources button in the Output Manager console. Document
properties and metadata are collected by sources depending on the source type and document type. Source types
include:

• AutoStore
• Email
• Epic
• FTP
• IPP
• LPD
• Mobile Server (Nuance AutoStore)
• NetWeaver
• Network Folder
• OM (Output Manager server)
• Socket
• TCP/IP NJE
• WCF API
• Web Upload
• WebSphere MQ
• Windows Queue (print queue)

Documents application
The Documents application is used to manage the flow of documents in Output Manager.

The Documents application is opened by clicking the Documents button in the navigation pane of the Output
Manager console. The Documents application displays a configurable Documents tree showing document folders
and saved document queries. You can add document folders to the tree for organizing documents. Under the
Document Queries folder, you can create queries for quickly locating documents based on their properties. You can
add query folders for organizing queries. You can drag-and-drop document folders, query folders, and queries to
reorganize objects on the tree.
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Library application
The Library application allows for long-term storage of documents that have been received into Output Manager.

Based on user permissions, library documents can be viewed, reprinted, and so on. Documents are placed in the
Library by sending them to the Output Manager Document Library destination. This destination is a default
destination that is created when Output Manager is installed on a server. Documents are assigned to library folders in
a dynamic manner using a library filing profile. The filing profile can be assigned by the Output Manager Document
Library destination or using business rules.

Reports Application
The Reports application provides summary and details of activity by user, department, document, and destination.

The Reports application is opened by clicking the Reports button in the Nuance Output Manager console. Nuance
Output Manager is installed with many sample reports already defined. You can use the Report Designer to create
new reports. You can configure report folders for restricted access for users and groups.

Devices Application
The Devices application is used to manage and monitor devices used by Nuance Output Manager. Devices represent
the physical printing hardware.

The Devices application is opened by clicking the Devices button in the Nuance Output Manager console. Devices
can be configured into device groups for ease of display and controlling access by users and user groups.

Administration application
The Administration application is used to configure administrative options in Output Manager.

The Administration application is opened by clicking the Administration button in the navigation pane of the
Output Manager console. Options may be configured in the following categories:

• Columns
• Document properties
• Billing accounts
• Licenses
• Product components
• SNMP
• Users
• Windows queues
• General preferences

Learning About the Output Manager Console
The Output Manager Console is the main window for Nuance Output Manager. It is primarily used to manage the
flow of documents in Nuance Output Manager. Access is available to all active, retained, and archived documents.
You can also manage and monitor sources (how documents are received into Nuance Output Manager) and
destinations (where documents can be sent). Administrators can use the Output Manager Console to configure
administrative settings such as permissions, billings accounts, and default display settings. Granular security controls
allow for varied access to features, depending on the permissions assigned to the logged in user.

This topic is intended to help you learn more about the features of the Output Manager Console window. Descriptions
are provided for all of the menu bar and status bar options.
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Click the area of the window you want to learn more about.

1. Menu bar on page 25
2. Status bar on page 31
3. Application window on page 30
4. Service status lights on page 30

Menu bar

The menu bar displays below the title bar.

Menu Command Description

File New • Window — Opens the current
Nuance Output Manager
connection in a new window.
This window will open inside the
current Output Manager Console.
The title bar of the first window
will be DBM server name 1.
Each successive window opened
will be numbered accordingly.
For example, you could use
the first window for the Source
application and the second for the
Destination application.



Output Manager Administration Guide
Version 4.0 SP2

26 © 2016 Nuance Communications, Inc. All rights reserved.

Menu Command Description

Note:  When multiple
console windows
are opened within a
single Output Manager
Console, all windows are
connected to the same
Output Manager DBM
Service using the same
user name. To have an
Output Manager Console
with a different user
name you must open
another Output Manager
Console.

• Connection — Displays the
Connect to OM Server dialog
box for starting a new Nuance
Output Manager connection. Your
existing connections will remain
connected.

Close Closes any of the open connections.
Choose the number that corresponds
with the connection you want to clos
e.

Exit Closes the Output Manager Console.

Note:  Nuance Output
Manager continues to
operate in the background
after you exit the Output
Manager Console. To stop
Nuance Output Manager
operation, you must stop
the Nuance Output Manager
services. Make sure to stop
the Output Manager DBM
Service last.

View Dest - Sources Window Shows or hides the Destinations or
Sources pane, depending on the activ
e application.

Documents Shows or hides the Documents wind
ow.

OM Instances Displays the Output Manager
Instance panel, in which you can cho
ose an instance to manage.
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Menu Command Description

Tools Ad Hoc Rules Allows administrators to create an
d manage merging and packaging
actions. Displays the Alert Rules
Manager dialog box.

Alert Rules Allows administrators to configure
advanced alert options for when ce
rtain events happen. This is particul
arly useful for monitoring destinati
on states. Displays the Alert Rules
Manager dialog box.

Business Rules Allows administrators to configure a
utomated document processes. They
can create rules with conditions and a
ctions that affect documents. Examp
les include routing to destinations, tr
ansforming to other print languages,
assigning to document folders, and e
diting document properties. Display
s the Business Rules Manager dialo
g box.

Device Wizard Allows administrators to convert W
indows queues to Nuance Output
Manager sources, detect devices usin
g SNMP, and restore previously conv
erted Windows queues.

Job Status Manager Opens the Job Status Manager win
dow, which shows documents waitin
g status updates from a destination. Y
ou can check status on a selected job.

Process Designer Allows administrators to configure o
utput processes. Output processes co
ntain a predefined set of actions whi
ch impact a document as it is being s
ent to a destination. Examples includ
e search and replace, setting finishing
options, and inserting overlays. Outp
ut processes can be associated with a
destination or a document. Displays t
he Process Designer.

Profile Manager You can view and work with any typ
e of profile.

Resource Manager Provides a central way for managing
all of the Nuance Output Manager re
sources. Resources are used in busine
ss rule and output process actions. D
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Menu Command Description

isplays the Resource Manager dialo
g box.

Schedule Manager Configures a recurring schedule for a
task. Tasks can be created to run an a
d hoc rule, create reports to save or e
mail, update output history with pag
e counts, import users, or synchroni
ze LDAP and Active Directory users
. For more information, see Working
with Ad Hoc Rules.

Universal PS Driver Wizard Invokes a wizard to create Windows
queues and OM sources:

• Add new OM destinations and
devices

• Add new OM destinations to
match existing devices

• Match existing destinations and
devices

Console Security Allows administrators to assign perm
issions to users and user groups for e
very major area of the system: Desti
nations, Sources, Documents, and A
dministration. These rights control b
oth visibility and which actions can
be performed. Displays the Security
Configuration dialog box.

Security Roles Allows administrators to define and
modify the security roles of users an
d groups. The Role Manager utility c
onsists of different types of roles and
corresponding security-related permi
ssions that can be granted or denied t
o each role.

Message Console Opens the Message Console, which p
rovides a real-time log of all Nuance
Output Manager activity. For more i
nformation, see Learning About the
Message Console

Audit Console Opens the Audit Console, which d
isplays detailed information on use
r actions. For more information, see
Learning About the Audit Console.
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Menu Command Description

Configure Viewer Opens the Viewer Configuration dia
log box for configuring the Viewer ut
ilities you want to use.

Console Options > Check News Enables or disables the News and
Support options in the menu bar. T
hese options connect you to the inte
rnet for viewing up-to-date news or
support information related to your
Nuance Output Manager serial numb
er.

Desktop Client Installation Creates a customized installation (M
SI) package to install the OM Deskto
p Client for a specified DBM server a
nd backup DBM server.

Applications Destinations Displays the Destinations applicatio
n.

Sources Displays the Sources application.

Documents Displays the Documents application.

Library Displays the Library application.

Reports Displays the Reports application.

Devices Displays the Devices application.

Administration Displays commands to display the
Administration applications.

Window Alignment • Vertical — Displays all of the
open connections vertically, so
they can be viewed at the same
time.

• Horizontal — Displays all of the
open connections horizontally, so
they can be viewed at the same
time.

• Cascade — Displays a cascading
view of all open connections.

1, 2, 3... Allows for easily switching between
all open connections. Choose the nu
mber that corresponds with the conne
ction you want to view.

Help OM Help Displays the Output Manager
Console Help window. The Help win
dow incorporates contents, index, se
arch, and favorites tabs to make it ea
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Menu Command Description

sy for you to find answers to your qu
estions.

About OM Console Displays program information, versio
n number, and copyright.

The menu bar also has a Themes option that allows you to change the Nuance Output Manager design and color
scheme.

Service status lights

The service status lights display to the right of the menu bar. The lights indicate the status of each monitored service
type. Move the pointer over a light to identify its service type and status. You can choose which services influence the
status lights in the Manage Product Components Utility. To enable/disable monitoring, select and clear the appropriate
check boxes in the Monitored column.

Application window

The Output Manager Console consists of a navigation pane and a console window. The navigation pane displays
along the left side of the window, providing quick access to the Destinations, Sources, Documents, Library, Reports,
Devices, and Administration applications. You can easily switch between applications by clicking the application
buttons at the bottom of the pane. The information that displays in the navigation pane and the console window are
different depending on the application you select.

You can customize the navigation pane to see more or fewer buttons, add or remove buttons, or gain more space to
display items in the pane. You can customize the console window display by configuring the grid views and showing
and hiding the grids from the View menu. If two grids are displayed, you can also adjust the height of the grids by
dragging the bar that separates the grids. A grid layout consists of the column size and order, as well as any grid filter
applied. Individual grid layouts can be configured and saved as desired. The last applied layouts will persist between
OM Console startups.

Searching is also provided in navigation pane tree views and console window grid views. If a tree view displays in the
navigation pane, you can search the tree using the controls in the search panel below the tree. For grid views, you can
use the controls in the search panel below the grid columns.

Each grid view can display a maximum of 5000 records. If more than 5000 records exist, navigation images below the
grid will enable to allow paging through the records. You can select to view the first page, previous page, next page,
or last page.

Review the following sections for more specific information on each application.

• Destinations application
• Sources application
• Documents application
• Library application
• Reports application
• Devices application
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Status bar

The status bar displays the following information.

Options Descriptions

Nuance Output Manager server Displays the name of the current Nuance Output
Manager server connection. If you have multiple connect
ions open, the status bar will update to show the current c
onnection as you switch between windows.

User name Displays the logged in user name.

Connection Status Displays the status of the connection to the Output
Manager DBM Service.

How to Open the Output Manager Console

Use the Output Manager Console to administer Nuance Output Manager. Before you access the console, verify that
your system administrator added you as an Nuance Output Manager administrator.

1. Open the Output Manager Console using one of the following methods:

• On the task bar, click Start > All Programs > NSi > NSi Output Manager Server > Output Manager
Console.

• Double-click the OM Console icon that was placed on the desktop during installation.
2. Specify connection details as described in the following table:

Option Description

OM server Enter or select the Nuance Output Manager server to w
hich you want to connect.

Connection mode Select a connection mode:

• Net.Tcp — Connect through the Transmission
Control Protocol (TCP).

• Http — Connect through Hypertext Transfer
Protocol (HTTP).

• Https — Connect through secure HTTP.

Logon as Select the logon type:

• Current Windows user — Connect with your
currently active Microsoft Windows credentials.

• Output Manager user — Connect with your
Nuance Output Manager credentials.

• LDAP user — Connect with your Lightweight
Directory Access Protocol (LDAP) credentials.

• Different Windows user — Connect with different
Microsoft Windows credentials.
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Option Description

User name If you are logging on as the current Microsoft Window
s user, an Nuance Output Manager user, or an LDAP u
ser, type your user name.

Password Type your password.

Domain If you are logging on as a different Windows user, ente
r or select the domain to which you belong.

Remember settings Save your connection settings for the next logon.

3. Click Connect.

Customizing the Grid Views
You can customize the Nuance Output Manager grid view by sorting, grouping by columns, and filtering on values.
These actions are useful when trying to quickly find items in the grids. You can also add and remove columns and
change the order in which the columns display. In the Output Manager Console, your grid display choices can then be
saved to a layout file.

• Sort by columns
• Group by columns
• Filter on values
• Configure columns
• Use grid layouts

How to Sort by Columns
You can sort data by an unlimited number of columns.

When sorting is applied to the view, the records are rearranged to meet the current sort settings.

• To sort by a column's values and replace any existing sort conditions applied to the current column or other
columns, click the column's header.
An up or down arrow icon is displayed in the header to indicate ascending and descending sort orders respectively.

• To sort by a column's values and preserve existing sort conditions:

• Click the column header while pressing the Shift key.
• Right-click a column header, and click Sort Ascending or Sort Descending.

How to Group by Columns
You can group data by the values of one or more columns.

If you group the data in the grid by a single column, records which have identical values in the same column are
arranged into corresponding data groups. Each data group is identified by an expandable group row. If you then group
the data by another column, the data rows within each group are combined into second level groups according to the
new grouping column's values.

• Group by a specific column
• Remove grouping
• Change the group order
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To group by a specific column
Use one of the following methods to group by a specific column.

• Click the column header you want to group, and drag and drop to place the column in the group panel above the
grid.

• Right-click the column header and click Group By This Column.

To remove grouping
Use one of the following methods to remove grouping.

• Click the column header you want to remove from grouping, and drag and drop to place the column header back
in the column header panel.

• Right-click the grouping column's header and click UnGroup.
• To remove all grouping, right click the group panel and Clear Grouping.

To change the group order

• Click the column header you want to move, and drag and drop to move the column header to another position
within the group panel.

How to Filter on Values
You can customize the grid views by filtering on values.

Filters are used to view only the items that meet conditions you specify. When filtering is applied, the records
displayed are restricted to those that meet the current filter criteria. For example in the Documents grid, if you filter
the Class column on value A, only documents with a class value of A will display. All of the other documents still
exist and can be seen again by removing the filter. You can apply filters to single or multiple columns.

• Create a simple filter condition
• Create a complex filter criteria
• Clear the filter
• Disable/enable the filter

To create a simple filter condition
Complete the following steps to select records that contain a specific value in a specific column.

1. Point to the column header you want to filter.
2. Click the filter image ( ) that displays in the column header.

The filter menu will display listing all of the available values in the column.
3. Select a filter value in the menu. The menu will automatically close. The grid now displays only the records which

contain the specified value in the specified column. All of the other records have been hidden from the view, but
can be restored by removing the filter.
Notice that a filter panel is displayed at the bottom of the grid showing the current filter criteria. You can remove
the filter by clicking the close (x) button on the panel. You can enable or disable the filter using the check box on
the filter panel. The right-side of the panel contains an Edit Filter button, which you can use to easily open the
Filter Builder for editing.

To apply another filter, repeat the procedure.

To create complex filter criteria
Complete the following steps to construct filter criteria using the Filter Builder.

1. Right-click a column header and click Filter Editor.
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This opens the Filter Builder dialog box. If no filtering has been applied to the grid, the Filter Builder will
contain a new filter condition referring to the clicked column. If filtering has been applied, the Filter Builder will
list all current filter conditions.

2. Click the column name link in the condition and select the appropriate column from the list.
All available columns will display in the list.

3. Click operator link in the condition and select the appropriate comparison operator from the list.
The comparison operator list displays only the operators supported by the current column's data type. For
example, the Priority column is of the numeric type so the operator list does not display the 'Begins with' operator
and other operators that are related to the string type.

4. Click <enter a value>, and enter a comparison value in the box.
5. To add additional conditions, click the plus button next to the group's AND operator.

This will create new conditions below the current one. Complete each condition statement using the steps above.
6. Click OK or Apply to filter data using the created filter condition.

A filter panel will display at the bottom of the grid showing the current filter criteria. The filter panel contains an
Edit Filter button, which you can click to quickly open the Filter Builder for editing.

Tip:  You can create more advanced filter criteria containing multiple logical (Boolean) operators. To change
the root logical operator, click the current AND operator and select the appropriate operator from the list. You
can then add a new filter condition group by clicking the operator and selecting Add Group. You can add
multiple groups containing multiple conditions. Complete each group using the procedure.

To clear the filter
Use one of the following methods to clear filtering.

• Point to the filtered column header and click the filter image ( ) that appears, then click (All) on the menu.
• Right-click the filtered column header and click Clear Filter.
• To clear all filter criteria, click the (x) button in the filter panel that displays at the bottom of the filtered grid.

To disable/enable the filter
This procedures toggles the filter on and off in the grid.

• Click the Enable Filter check box in the filter panel that displays at the bottom of the filtered grid.

How to Configure Columns
You can configure the columns that display in the grid views.

You can change the column order and choose which columns you would like to display.

• Reorder columns
• Hide columns
• Display hidden columns

To reorder columns

• Click and drag the column header you want to move and to a new position.
Dropping the column header changes the column order.

To hide columns

• Click and drag the column header you want to remove to the cell area of the grid.
While you are dragging the column in the cell area, the cursor changes its image to a big 'X'.
Dropping the column header hides the column from the grid.
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To display hidden columns

1. Right-click a column header and click Column Chooser.
This opens the Customization dialog box, which lists any hidden columns.

2. Drag and drop a column to place it in the grid.

How to Use Grid Layouts
Grid layouts allow define a grid configuration for reuse.

Layout files can be saved for each application grid view, Destinations, Sources, Documents, Library, and Devices.
Layout files can also be saved for the Documents grid that displays in the Destinations and Sources applications.
This allows you to choose how you want the Documents grid to appear for each application you open.

When the Output Manager Console is opened, the grids will display using the last opened layout file. If no layout files
have been saved, the grids will display using the default settings. The default settings for the Destinations, Sources,
Library, and Devices grids are configured in the Configure Columns Utility. The default settings for the Documents
grid are configured in the Configure Document Properties Utility.

Important:  Layouts are saved for the Output Manager Console logged in user on that specific computer. The
same user on a different computer will have to setup the layouts on that system.

• Save grid layouts
• Reset grid layouts
• Load grid layouts
• Delete grid layouts

To save grid layouts
Complete this procedure to save a grid layout.

Once you have configured the grid views, you can save your grid settings to a layout file. Layouts are saved for the
Output Manager Console logged in user on that specific computer. The same user on a different computer will have to
setup the layouts on that system.

1. Configure the grid view as desired.
2. Right-click in the grid, and click Layouts > Save Layout.

This opens the Save Layout dialog box.
3. In the Layout name box, enter the name of the layout file.

This specifies to save the layout for the logged in user on the computer.
4. Click OK.

To reset grid layouts
Complete this procedure to clear the layout and return to the default grid settings.

• Right-click in the grid and click Layouts > Reset layout.

To load grid layouts
Complete this procedure to load a grid layout.

1. Right-click in the grid and click Layouts > Load layout.
This opens the Load Layout dialog box.

2. In the list, select the layout you want to load.
You can only load layout files created by the currently logged in user.

3. Click OK.
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To delete grid layouts
Complete this procedure to delete a grid layout.

1. Right-click the grid and click Layouts > Delete layout.
This opens the Delete Layout dialog box.

2. In the list, select the layout you want to delete.
You can only delete layout files created by the currently logged in user.

3. Click OK.

Configuring Output Manager Console Security
The Security Configuration dialog box is used to assign permissions to individual users or groups of users.
Complete the steps in this procedure to assign permissions for the Output Manager Console.

To configure security for the Output Manager Console, you must be assigned the Allow user to Configure Console
Security permission or be added to the security during the Nuance Output Manager installation. Users added to the
security during installation are considered administrators and are assigned all permissions by default.

Permissions authorize a user or group to perform actions within specified areas of Nuance Output Manager. Without
the appropriate permissions, attempts to carry out those actions are blocked.

1. From the Output Manager Console menu bar, select Tools Console Security.
This opens the Security Configuration dialog box.

2. From the Users and groups with permissions list box, select the appropriate user or group in the list.
The Assigned permissions list box will display the assigned permissions for the selected user. If you want to set
permissions for a user or group that does not appear in the list, click Add. From the User and Group Selection
dialog box, select the users/groups you want to add and click OK. If the user/group is not listed, click More Users
and then click the type of user you wan to add, Nuance Output Manager users, LDAP users, or Windows users.
You can also choose to import LDAP users. See the Adding users and groups to Nuance Output Manager  topic
for detailed procedures on adding users. Once users are added, they are placed in the Nuance Output Manager
database, causing them to always be listed in the future.

3. From the Assigned permissions box, select or clear the appropriate permissions. Click Select All or Unselect All
to assign or remove all permissions.

Tip:  To assign initial permissions that will allow users to open the Output Manager Console and view
the Destinations, Sources, and Documents applications, select the Allow user to run the OM Console,
Allow user to access the Destinations Application, Allow user to access the Sources Application, and
Allow user to access the Documents Application permissions. For information on assigning security for
Destinations, Sources, and Documents, see the appropriate help link.

4. Once all of your permission changes are complete, click OK.

Defining Viewer utilities
Complete the following steps to define and configure Viewer utilities.

Nuance Output Manager allows you to define the Viewer utilities that display when you right-click documents in the
Output Manager Console. You can configure the data types that each Viewer utility can open.

1. On the Output Manager Console menu bar, select Tools > Configure Viewer.
This opens the Viewer Configuration dialog box.
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The first grid lists the Viewer utilities that will be available when right-clicking documents in the Output Manager
Console.

2. To add a new Viewer utility, complete the following steps.
a) Click <insert new> in the Viewer Name column at the bottom of the list.
b) Enter the name of the Viewer utility.

This name will display when you right-click documents in the Output Manager Console.
c) In the Viewer path column, enter the path and file name of the Viewer utility executable.

You can type the path and file name or click the Browse button in the cell to navigate.
d) In the Arguments column, enter any command line options or switches that will be used to start the utility

with the desired configuration.
The Viewer utility is now added.

Note:  You can delete Viewer utilities by clicking the X in the Delete column.

3. Select the Viewer utility you want to configure.
The second grid displays the data types this Viewer utility can open.

4. Complete the following steps to configure the data types for the selected Viewer.
a) Click <insert new> in the Data Type column.
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b) Choose a data type this Viewer can open.
c) If necessary, click in the Conversion (Advanced) column to assign a conversion.

You can choose to convert files from the Output Manager Print Server (.tnj) file format to one of the following
types: binary (.bin), text (.txt), or Xerox (.xrx).

d) Repeat these steps until you have selected all of the necessary data types for the selected Viewer.

Note:  You can delete data types by clicking the X in the Delete column.

5. Click OK.

How to Configure Columns
Complete the following steps to configure columns.

Administrators can configure the columns that appear by default in the Destination, Source, Document, Library, and
Device grids. Users can customize the grids by adding, removing, and reordering columns as necessary from the
grids.

1. In the Output Manager Console navigation pane, select the Administration application.
2. In the navigation pane, select the columns that you want to configure:

To configure Do this

Destinations, Sources,
Library, and Devices grids

• Click Configure Columns.

In the console window, the Configure Columns Utility
displays tab pages representing each grid.

Documents grid • Click Configure Document Properties.

The Configure Document Properties Utility displays
in the console window.

3. Configure columns as follows:

• To specify if the column will display in the grid and if it will be editable, use the Visible in Grid and Editable
in Grid columns. Cells with a shaded background cannot be edited.

• To specify if the column will be available and editable from the Business Rules Manager, use the Visible in
Rules and Editable in Rules columns.

The Alert Rules Manager also applies for the Destinations grid. Cells with a shaded background cannot be
edited.

• To reorder columns:

• From the Configure Columns Utility tab pages, select a row and click Move Up or Move Down.
• From the Configure Document Properties Utility, click Set view order. From the View Order dialog

box, select a property and click Move Up or Move Down as necessary. When finished, click OK.
• You can perform the following procedures from the Configure Columns Utility for the Destinations,

Sources, and Library grids:

• To add columns, click Add and select columns from the Add Column dialog box. Make sure you select
the appropriate check boxes for the new column.

• To remove columns, select a row and click Remove.
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• To change the display name, click the appropriate cell in the Display Name column and enter the new
name. Cells with a shaded background cannot be edited.

4. Click Apply to apply and save column changes.
5. If necessary, select another application tab and make additional changes.
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Users

Managing Users
You can add users and groups from a Microsoft Windows Active Directory server, a Lightweight Directory
Access Protocol (LDAP) server, or directly through Nuance Output Manager. Windows users are maintained and
authenticated by the Active Directory server. LDAP users are maintained and authenticated by the LDAP server.
Nuance Output Manager users are maintained and authenticated by Nuance Output Manager.

• Add users and groups
• Add a department
• Map groups to departments
• Configure Users on page 47
• How to Configure Departments on page 48
• Modify a user, group, or department
• Remove a user, group, or department
• How to Assign a Print Delegate on page 49

Adding Users and Groups to Output Manager

You can add users and groups to Nuance Output Manager from the Users and Groups tabs in the Manage Users
utility and in the User and Group Selection dialog box. You can choose to add Nuance Output Manager users,
LDAP users, or Windows users. You can also choose to import LDAP users. Once users are added, they are placed in
the Nuance Output Manager database and always listed in the future.

The Manage Users utility is an Administration application for adding and removing users and groups and configuring
quota management settings. You can access the Users and Group Selection dialog box when configuring security
roles, assigning permissions for the Output Manager Console, destinations, sources, and documents, and for
configuring notification profiles during source configuration and business rule creation.

• Group Membership on page 40
• Add an Nuance Output Manager user
• Add an Nuance Output Manager group
• Add an LDAP user or group
• Add a Windows user or group
• Import users and groups into Nuance Output Manager

Group Membership

When you add a group to Nuance Output Manager from a Microsoft Windows Active Directory or a Lightweight
Directory Access Protocol (LDAP) server, Nuance Output Manager stores basic information about the group and does
not account for group membership. Nuance Output Manager synchronizes users to groups when the following events
occur:

• Administrator-level user connects to Nuance Output Manager with the Nuance Output Manager Console using a
domain account.

• User connects to the Nuance Output Manager Web Console using a domain account.
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• User authenticates at an MFD with the Unified Client.
• The first time a user prints to an Nuance Output Manager Windows print queue source.
• Periodic subsequent user printing to an Nuance Output Manager Windows print queue source (not to exceed 24

hours).

How to add an Output Manager User
Use this procedure to add an Nuance Output Manager user.

1. From the Users tab or the User and Group Selection dialog box, click More Users, and then click Add OM
User.
This opens the OM User dialog box.

2. In the User name box, type the user name, and in the Full name box type the full name of the user.
3. In the Password and Confirm password boxes, type the user password that will be used when logging on to the

server.
4. In the Email address box, type an email address for the user.
5. If this user is a member of a department, either click the Department box and select one of the existing

departments or click New to create a department in the Department dialog box.
6. Configure the following options for the account:

Option Description

User must change password at next logon Specifies whether the user must change the password at
the next logon.

Password never expires Specifies whether the password will never expire.

Account is disabled Specifies whether the selected account is disabled.

7. Click OK.

How to add an Output Manager Group
Perform this procedure to add an Nuance Output Manager group.

Nuance Output Manager groups can include Nuance Output Manager, LDAP, and Windows users.

1. In the Nuance Output Manager console navigation pane, select the Administration application.
2. In the navigation pane, click Manage Users.

This displays the Manage Users utility in the right panel.
3. Click the Groups tab.
4. Click More Groups, and then click Add OM Group.

This displays the OM Group dialog box.
5. In the Group name and Email address boxes, enter a name and an email address for the group.
6. The Select users grid displays all of the Nuance Output Manager users. Add users to the group by selecting check

boxes for users and clicking the > button to move the users to the Group members grid, or by clicking the >>
button to move all users.
If you want to remove a user from the group, select the check box column the user and click the < button to move
the user back into the Select users grid. You can remove all users by clicking the << button.

7. When the group is complete, click OK.
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How to Add an LDAP User or Group
Perform this procedure to add an LDAP user or group.

LDAP groups can only include LDAP users.

1. Depending whether you want to add an LDAP user or group, complete one of the following procedures:
To add an Do this

LDAP user On the Users tab or in the User and Group Selection
dialog box, click More Users and then click Add
LDAP User. This opens the LDAP User dialog box.

LDAP group In the Groups tab, click More Groups and then click
Add LDAP Group. This opens the LDAP Group
dialog box.

2. You can select an existing LDAP server or define a new LDAP server.
To Do this

Select an existing server • Click the server name in the LDAP server box.

You can modify the server by clicking the Modify
button.

Define a new server 1. Click New to open the LDAP Server dialog box.
2. In the Server Type list, click Microsoft Active

Directory Server or Generic LDAP Server.
3. In the Server Description box, enter a name to

identify this server.
4. In the Server Address box, enter the DNS (Domain

Name System) name of the server.
5. In the Port box, enter the standard IP port for the

LDAP server.
6. In the Login ID box, enter the DN (distinguished

name) of a user with administrative permissions.
7. In the Password box, enter the password for this

user.
8. Click Verify Connection to confirm that

a connection can be established using this
information.

You will see either Success or Failure next to the
button.

9. After verifying the connection, click OK.

3. Specify the LDAP user or group DN (distinguished name). You can either enter the DN into the box or click
Browse or do the following to browse for the DN:
a) Click the Browse button.

This opens the Browse LDAP Server dialog box.
b) In the Base DN box, type the DN (distinguished name) of the entry to begin the search.
c) In the Filter box, specify criteria to use in the search.

You can enter a filter or click the arrow to search the list of existing filters.
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d) Click Search.
e) Click the pertinent entry in the tree view of the LDAP directory, and then click this user’s DN entry in the grid.
f) Click OK.

4. If you want to change any of the LDAP detail information for the Nuance Output Manager environment, do one of
the following:

For Do this

LDAP users To change the user name, display name, or email
address, or to select an existing department, select
Override LDAP data. The boxes will be made
available for entry. You do not need to activate the
override function to define a new department. Click
New and the Department dialog box is displayed.

LDAP groups To change the group name, display name, or email
address, select the Override LDAP data check box.

5. Click OK.

How to add a Windows User or Group
Perform this procedure to add a Windows user or group to Nuance Output Manager.

1. Depending on if you want to add a Windows user or group, do one of the following:
To add a Do this

Windows user In the Users tab or User and Group Selection dialog
box, click More Users, and then click Add Windows
Users and Groups to open the Users and Groups
dialog box.

Windows group In the Groups tab, click More Groups and then click
Add Windows Users and Groups to open the Users
and Groups dialog box.

2. Enter all or part of the user or group name you want to add, and click Find.

Note:  You can use options to determine to search the Local Machine or a Domain for Users or Groups.

The results are displayed in the Selection list box.
3. Select to add users or groups you in the Selection list box.

The selected users or groups will be automatically added to the Selected list box.
4. Optional: If you need to remove an item from the Selected list box, click the item in the box to remove it

automatically.
5. Click OK.

Import users and groups to Output Manager
You can import user data from a file, from an Active Directory server or from an LDAP server.

Procedure Description

How to import users from a file on page 44 Use this procedure to use the User/Group Import
Wizard to import user data from a file.
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Procedure Description

Import from user data from a database

How to import Active Directory users or groups on page
45

Use this procedure to import Active Directory users and
groups.

Import LDAP users or groups on page 45 Use this procedure to import LDAP users and groups.

How to import users or groups with a recurring task on
page 46

This procedure describes how to create a recurring task
to import users or groups.

How to import users from a file
Use this procedure to use the User/Group Import Wizard to import user data from a file.

1. In the navigation pane of the Nuance Output Manager console, click the Administration application.
2. In the Administration pane, click Manage Users.
3. On the Users tab in the Administration - Manage Users pane, click the User/Group Import Wizard button.
4. In the User and Group Import and Synchronization Wizard, click Import user data from a file (no groups),

and then click Next.
5. In the Select the file containing user data to import box, enter the full path to the data file.

You can click the Browse button to locate the file.
6. If the first row in the file contains headers, select the File contains a header record check box.
7. In the Select the file delimiter box, click the delimiter that is used to separate fields in each record.

• Comma (CSV)
• Tab
• Semicolon

8. In the Type of users contained in this file box, click to choose the type of data contained in the file.

• Output Manager Users
• Windows Users
• LDAP Users

Data for existing users is matched by the User Name field.

Important:  You can only add new users from Output Manager user data. You can use Windows user or
LDAP user data to update information for existing users.

9. Click the Next button.
10. On the Select Import Options page, select check boxes to specify how to perform the import:

Select To

Add new users/groups to Output Manager Add data from records that do not match any existing
user. This option is only available for Output Manager
data.

Update information within Output
Manager for existing users/groups

Update existing users from records that match an
existing user.

Only fill in missing values Do not replace existing data when updating user data.
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Select To

Remove users/groups that are
not found during the import

Only retain existing users that match the user name in
an imported record.

11. On the Map Imported Values page, match Output Manager Property to a label or data in the first imported row
to map a property to a field in the imported records.
Leave the Imported Value for a property blank when there is no matching field in the imported data.

12. Click next, and on the Preview Import page, verify the information that is being imported.
13. Click the Import button.

Nuance Output Manager processes the data an displays the results.
14. Optional: You can schedule this import as a recurring task by clicking the Click here link.
15. Click Finish.

How to import Active Directory users or groups
Use this procedure to import Active Directory users and groups.

Use the LDAP Import Utility to import users and groups from an Active Directory source. You choose the users and
groups to import from an Organizational Unit (OU) container in a specific Active Directory server.

1. In the navigation pane of the Nuance Output Manager console, click the Administration application.
2. In the Administration pane, click Manage Users.
3. On the Users tab in the Administration - Manage Users pane, click the User/Group Import Wizard button.
4. In the User and Group Import and Synchronization Wizard, click Import LDAP users and groups.
5. On the Specify LDAP Server Connection page, choose an Active Directory server or click New and in the

LDAP Server Details select "Microsoft Active Directory Server" for Server Type, and specify details for your
LDAP server.

6. After you choose an Active Directory server or after you save details for an Active Directory server, click the
Verify Connection button to confirm that you can access the server, and then click Next.

7. Define the user and group identifying characteristics of your Active Directory server and click the Next button.
8. Use the Active Directory objects tree presented to select the OUs, containers, and groups you wish to import, and

then click Next.
Groups will be imported only if they are individually selected. Only security groups will be imported. Distribution
groups will not be imported.

9. Choose the desired import options.
You may also view or modify the user property mappings by selecting the View or modify which attributes are
mapped to Output Manager properties link.

10. Click the Import button.
OM processes the import and produces a results screen.

11. Optional: You can schedule this import as a recurring task by pressing the click here link.
12. Click the Finish button.

Import LDAP users or groups
Use this procedure to import LDAP users and groups.

Use the LDAP Import Utility to import users and groups from an LDAP source. You choose the users and groups to
import from an Organizational Unit (OU) container in a specific LDAP server.

1. In the navigation pane of the Nuance Output Manager console, click the Administration application.



Output Manager Administration Guide
Version 4.0 SP2

46 © 2016 Nuance Communications, Inc. All rights reserved.

2. In the Administration pane, click Manage Users.
3. On the Users tab in the Administration - Manage Users pane, click the User/Group Import Wizard button.
4. In the User and Group Import and Synchronization Wizard, click Import LDAP users and groups.
5. On the Specify LDAP Server Connection page, choose an LDAP server or click New and in the LDAP Server

Details select "Generic LDAP Server" for Server Type, and specify details for your LDAP server.
6. After you choose an LDAP server or after you save details for an LDAP server, click the Verify Connection

button to confirm that you can access the server, and then click Next.
7. Define the user and group identifying characteristics of your LDAP server and click the Next button.
8. Use the LDAP objects tree presented to select the OUs, containers, and groups you wish to import, and then click

Next.
Groups will be imported only if they are individually selected.

9. Choose the desired import options.
You may also view or modify the user property mappings by selecting the View or modify which attributes are
mapped to Output Manager properties link.

10. Click the Import button.
OM processes the import and produces a results screen.

11. Optional: You can schedule this import as a recurring task by pressing the click here link.
12. Click the Finish button.

How to import users or groups with a recurring task
This procedure describes how to create a recurring task to import users or groups.

You can choose to create a recurring task from either the User/Group Import Wizard or by clicking Tools >
Schedule Manager in the Output Manager Console window.

1. Select the new import job from the jobs list and click the Modify button.
2. Optional: You can define your own name and description
3. Click the Schedule tab to adjust the schedule.

By default the import is scheduled to occur every day, at the time of day it was originally created.
4. Click the Modify button to modify the schedule.

You can define a simple schedule of minutes, hours, days, or weeks. You can also define a more complex daily
schedule. Finally, you can define the most complex monthly schedule. Set the range of recurrence to define the
starting and ending time, if applicable.

5. Click the Save Edit button to save the schedule changes.
6. Click the Tasks tab to redefine or edit the import task.
7. Select the import task and press the Modify button.

This displays a task summary page.
8. To modify the task, click the User Import Wizard button, and refer to help topics for the User/Group Import

Wizard for further guidance.

How to add a department
Perform this procedure to add and configure a department.

1. In the Output Manager Console navigation pane, select the Administration application.
2. In the navigation pane, click Manage Users.

This opens the Manage Users utility in the right panel.
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3. Click the Departments tab.
4. Under the Departments grid, click Add.

This opens the Department dialog box.
5. Type the name of the new department in the Department name box.
6. In the Select users grid, choose each user that you want to add to the new department by selecting the check box

column for the user.
7. When you finish adding users, click the > button to move selected users into the Department members grid. You

can click the >> button to move all users.
To remove users from the department, select the check box column for users in the Department members grid
and click the < button. This returns selected users to the Select users grid. You can click the << button to remove
all users.

8. When you are finished adding users to the new department, click OK.
9. Use the following procedures to configure departments on the Departments tab.

• Manage quota profiles

• Assign a quota profile
• Create a basic quota profile
• Create user quota rules

• Manage desktop client profiles

• Assign a desktop client profile
• Create a desktop client profile

• Configure balance settings

How to map groups to departments
Perform this procedure to map groups to departments.

1. In the Output Manager Console navigation pane, click the Administration application.
2. In the navigation pane, click the Manage Users.

This opens the Manage Users utility in the right panel.
3. Click the Departments tab.
4. Click the Groups to Depts Mapping button.
5. Associate groups to departments.

Configure Users
Use this procedure to configure users on the Users tab.

1. In the Administration application, click Manage Users.
2. To inherit quota settings from a department, including balance settings, select Inherit.

By default, users are configured to inherit settings from the department. If you do not want the user to inherit
quota settings, clear the check box.

3. If you do not want to track print jobs for the user, select Do Not Track.
4. Click in the Card ID cell and type an identification value that the user enters on the MFP before faxing or

scanning.
5. To enter a second identification value, click in the Secondary Card ID cell and type another value.
6. Assign a print rules profile to the user.
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7. Assign a desktop client profile to the user.
8. Assign a device profile to the user.
9. Assign print delegates to the user.

Print delegates have permission to print documents for the user.
10. Select a role for the user.
11. Click Apply.

How to Configure Departments
Use this procedure to configure users departments on the Departments tab.

1. Type a department name.
2. Type a full name for the department.
3. Assign a print rules profile to the department.
4. Assign a desktop client profile to the department.
5. Assign a device profile to the department.
6. Assign an allowance profile to the department:

a) Select the Set Balance check box.
b) Select the allowance profile.

7. Click Apply.

How to Modify a User, Group, or Department
Use this procedure to make changes to an existing user, group, or department.

1. In the Output Manager Console navigation pane, select the Administration application.
2. In the navigation pane, click Manage Users. The Manage Users utility is displayed in the right panel.

To modify a Do this

User Click the Users tab, and in the grid, select a user and
click Modify.

• If you select an Nuance Output Manager user, this
opens the OM User dialog box.

• If you select an LDAP user, this opens the Edit
LDAP User dialog box.

• If you select a Windows user, this opens the Edit
Windows User dialog box.

Group Click the Groups tab, and in the grid, select the group
you want to modify and click Modify.

• If you select an Nuance Output Manager group, this
opens the OM Group dialog box.

• If you select an LDAP group, this opens the LDAP
Group dialog box.

Note:  You cannot modify a Windows group.
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To modify a Do this

Department Click the Departments tab, and in the grid, select the
department you want to modify and click Modify.
Use the Department dialog box to add and remove
department members.

How to Remove a User, Group, or Department
Use this procedure to remove a user, group, or department.

1. In the Output Manager Console navigation pane, select the Administration application.
2. In the navigation pane, click Manage Users.

This displays the Manage Users utility in the right panel.
3. Click the Users tab, Groups tab, or Departments tab.
4. In the grid, select the user, group, or department you want to remove, and click Remove.

How to Assign a Print Delegate

You can assign a user or group as a print delegate for another user. If you assign a group as a delegate, all members
of the group can print documents for the user. A user who has print delegates can choose not to delegate printing for
specific documents.

1. In the Administration application, click Manage Users and click the Users tab.
2. On the General or Balances tab, select the user for whom you want to assign a print delegate.
3. In the Print Delegates cell, click the ellipsis button.
4. In the User and Group Selection dialog box, select the delegate user or group.
5. Click OK.
6. Click Apply.

Managing Output Manager Security Roles
Administrators can use Role Manager to define and modify the security roles of users and groups. The Role
Manager utility consists of different types of roles and corresponding security-related permissions that can be granted
or denied to each role. There are three roles defined in Nuance Output Manager:

OM Document Owner Defines the rights, or permissions, of document
owners. You can limit or extend the permissions of
document owners as appropriate. For example, an
administrator who wants to prohibit document owners
from assigning documents to destinations would remove
this permission. This role is limited to Documents and
Library applications.

OM System Administrators Defines the members and permissions for system
administrators. System administrators can configure
and manage all of the security permissions. As with
the Document Owner role, you can limit or extend
the permissions of system administrators as needed.
By default, all permissions are granted to the System
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Administrators role at the time of installation; you can
modify permissions as appropriate for the installation.
A company might have several system administrators.
This role defines permissions for all applications, that is,
Destinations, Sources, Documents, Library, Reports, and
Administration.

OM Security Administrators Is identical to the role of System Administrator except
that a subset of permissions is always unavailable for
modification; this safeguard insures that an installation
does not accidentally lock itself out of Nuance Output
Manager, preventing the configuration of security
permissions. A company typically would have only one
Security Administrator.

Warning:  These permissions are set for the role and cannot vary for users or groups within a role.

You can add and remove users and groups from the System Administrator and Security Administrator roles as
needed to manage security access; for example, you might want add a system administrator to serve as backup to an
established system administrator.

Tip:  Permissions can also be set through the Destinations, Sources, and Documents applications, and for the
Output Manager Console.

• Add users or groups
• Remove users or groups
• Modify security permissions

How to Add Users or Groups
Complete the steps in this procedure to add users or groups to a security role.

1. On the Output Manager Console menu bar, select Tools > Security Roles.
This opens the Role Manager dialog box.

2. In the Role name box, select the role to which you want to add a member.

Note:  Because a document can have only one owner, you cannot add members to the Document Owner
role.

3. Click Add.
This opens the User and Group Selection dialog box is displayed.

4. From the grid, select the users or groups that you want to add, and then click OK.
If a user or group is not listed, click More Users to locate the user. From the More Users list, you can choose to
add Nuance Output Manager users, LDAP users, or Windows users and groups. You can also choose to import
LDAP users and groups. When you are finished, click OK. See the Adding users and groups to Nuance Output
Manager  topic for detailed procedures on adding users.

5. Click OK.

How to Remove Users or Groups
Complete the steps in this procedure to remove a user or group from a security role.

1. On the Output Manager Console menu bar, click Tools > Security Roles.
This opens the Role Manager dialog box.



Output Manager Administration Guide
Version 4.0 SP2

51 © 2016 Nuance Communications, Inc. All rights reserved.

2. In the Role name box, select the role from which you want to remove a member.
3. From the grid, click the users or groups that you want to remove.
4. Click Remove.

How to Modify Security Permissions
Complete the steps in this procedure to modify the security permissions of a role.

Warning:  Permissions are set for the role and cannot vary for users or groups within a role.

1. On the Output Manager Console menu bar, select Tools > Security Roles.
This opens the Role Manager dialog box.

2. Next to the Role name box, click the browse button (…).
This opens the Manage Roles dialog box.

3. Select the role you want to modify and click Modify.
This opens the Configure Role dialog box. This dialog box lists, in tree form, all the security permissions for the
selected role.

4. Modify permissions by selecting or clearing check boxes.

Note:  In the list of permissions for the Security Administrator role, a subset of permissions is unavailable
for modification so that security can always be configured.

5. When you are finished, click OK.
6. Click Close.
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Devices

Learning About the Devices Application
Use the Devices application to manage and monitor devices. The navigation pane displays a configurable Devices tree
that shows all devices. You can drag-and-drop devices to device groups.

Nuance Output Manager differentiates between destinations and devices. Destinations are queues where Nuance
Output Manager sends documents. They can be queues on physical printers or a variety of other destination types,
such as network folders and FTP servers. Devices are the physical printing hardware. You can define multiple
destinations for the same device. This is helpful for production devices where the controller supports multiple LPD
queues, each defined with different print preference settings.

The console window displays a tabbed view of the Device tree selection. When a device is selected in the tree, a
device home page will display showing the properties and status of the device. Below the home page, a grid displays
listing all destinations associated with the device. When a device group (folder) is selected in the tree, the Device
grid will display listing all of the devices in the group. Notice the Device grid is in a tab page control. By default,
navigating in the tree will replace the information in the active tab. To open a device or group in new tab, right-click
the item and click Open in New Tab. Your tree selection, open tab pages, and console window settings will be saved
for the next time you open the application.

Managing Devices
Nuance Output Manager differentiates between destinations and devices. Destinations represent "queues" where
Nuance Output Manager can send documents. Devices represent the physical printing hardware. You can control
devices from the Output Manager Console using the following procedures.

• Open a device
• Move a device
• Rename a device
• View device output history
• View SNMP alert history
• Initiate an SNMP update for a device

How to Open a Device
You can use one of several methods to open a device in the current tab or in a new tab.

• Use one of the following methods to open a device.
To open a device Do this

In the current tab In the Devices tree, click a device.

In the current tab In the Devices tree, right-click a device and click
Open.

In a new tab In the Devices tree, right-click a device and click Open
in New Tab.



Output Manager Administration Guide
Version 4.0 SP2

53 © 2016 Nuance Communications, Inc. All rights reserved.

How to Move a Device
You can use drag and drop or a shortcut menu command to move a device.

Devices can be organized into device groups. Once groups are created, devices and groups can be easily moved in the
tree as necessary.

1. In the Devices tree, click and drag a device or device group to a different location in the tree.
As you drag the item a yellow arrow will appear to the left of the tree to indicate where the item will be placed.

2. Right-click a device in the Devices tree and click Move to Group, then when prompted, select the group where
you want to move the device.

How to Rename a Device
Use this procedure to rename a device.

1. In the Devices tree, right-click a device and click Rename.
2. Type the new device name and press Enter.

To cancel the rename, press Esc.

How to View the Device Output History
Complete this procedure to view the output history of devices or device folders.

You can choose from one of the predefined history time frames or create a custom query.

1. In the Devices tree, select a device or device folder.
2. Right-click the selected device or folder and click Output History, and then click to use a predefined history time

frame or to create a custom query. To create a custom query, complete the following steps:
a) In the submenu, select Custom query.

This opens the query tool dialog box.
b) Click the + button next to the AND operator.
c) To select the column, click the column name link in the condition and select the appropriate column from the

list.
This displays all available columns in the list.

d) Click the operator link in the condition and select the appropriate comparison operator from the list.
The comparison operator list displays only the operators supported by the current column's data type. For
example, the Priority column is of the numeric type so the operator list doesn't display the 'Begins with'
operator and other operators that are related to the string type.

e) Click the <enter a value> link, and enter a value in the box.
f) To add additional conditions, click the + button next to the group's AND operator, and then repeat steps 2.c on

page 53 through 2.e on page 53 to complete new condition statements.
g) Click OK to query data using the statement.

Tip:  You can create more advanced queries containing multiple logical (Boolean) operators. To change
the root logical operator, click the current AND operator and select the appropriate operator from the list.
You can then add a new query statement group by clicking the operator and clicking Add Group. You can
add multiple groups containing multiple conditions. Complete each group using the steps above.

To cancel the query, click the Cancel Query Mode button below the grid.
3. In the Destination Output History window, review the output history for the selected device or folder.
4. Use the following methods to change the history as needed.
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• In the Devices tree, click devices and folders to update the grid to match a new tree selection.
• Click a new history time period to update the grid to match a new time period selection.
• Click Refresh Query below the grid to update the grid with the latest information.

5. You can do the following with the search results:
To Do this

Search the tree • In the Search box below the tree, type the text you
want to find and press Enter or click the search
button.

If the text is found, your focus will be moved to the
first occurrence. New buttons will appear near the
Search box that allow you to move to the previous
occurrence and move to the next occurrence.

Search the grid • In the Search box below the grid, type the text you
want to find, click the column in the grid you want
to search, and then press Enter or click the Search
button.

If the text is found, your focus will be moved to the
first occurrence. New buttons will appear near the
Search box that allow you to stop searching, move
to the previous occurrence, and move to the next
occurrence.

Print the history • Click the Print button below the grid to print the
history.

How to View the SNMP Alert History
Complete this procedure to view the SNMP alert history of devices or device folders.

You can choose from one of the predefined history time frames or create a custom query.

1. In the Devices tree, select a device or device folder.
2. Right-click the selected device or folder and point to SNMP Alerts History, and then click to use a predefined

history time frame or to create a custom query. To create a custom query, complete the following steps:
a) In the submenu, select Custom query.

This opens the query tool dialog box.
b) Click the + button next to the AND operator.
c) To select the column, click the column name link in the condition and select the appropriate column from the

list.
This displays all available columns in the list.

d) Click the operator link in the condition and select the appropriate comparison operator from the list.
The comparison operator list displays only the operators supported by the current column's data type. For
example, the Priority column is of the numeric type so the operator list doesn't display the 'Begins with'
operator and other operators that are related to the string type.

e) Click the <enter a value> link, and enter a value in the box.
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f) To add additional conditions, click the + button next to the group's AND operator, and then repeat steps 2.c on
page 54 through 2.e on page 54 to complete new condition statements.

g) Click OK to query data using the statement.

Tip:  You can create more advanced queries containing multiple logical (Boolean) operators. To change
the root logical operator, click the current AND operator and select the appropriate operator from the list.
You can then add a new query statement group by clicking the operator and clicking Add Group. You can
add multiple groups containing multiple conditions. Complete each group using the steps above.

To cancel the query, click the Cancel Query Mode button below the grid.
3. In the SNMP Alert History window, review the SNMP alert history for the selected device or folder.
4. Use the following methods to change the history as needed.

• In the Devices tree, click devices and folders to update the grid to match a new tree selection.
• Click a new history time period to update the grid to match a new time period selection.
• Click Refresh Query below the grid to update the grid with the latest information.

5. You can do the following with the search results:
To Do this

Search the tree • In the Search box below the tree, type the text you
want to find and press Enter or click the search
button.

If the text is found, your focus will be moved to the
first occurrence. New buttons will appear near the
Search box that allow you to move to the previous
occurrence and move to the next occurrence.

Search the grid • In the Search box below the grid, type the text you
want to find, click the column in the grid you want
to search, and then press Enter or click the Search
button.

If the text is found, your focus will be moved to the
first occurrence. New buttons will appear near the
Search box that allow you to stop searching, move
to the previous occurrence, and move to the next
occurrence.

Print the history • Click the Print button below the grid to print the
history.

How to Initiate an SNMP Update for a Device
Complete this procedure to initiate and SNMP update for a selected device.

1. In the Devices tree, select a device.
2. Right-click the selected device and click SNMP Update.

After you complete this procedure, any SNMP updates are performed automatically.
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How to configure access control
Access control enables an administrator to regulate access to specific features of an MFD, such as restricting a users
to making only black and white copies on a particular MFD.

To support this feature, an MFD must provide API support for access control and the device must be configured as an
MFP type in the device configuration.

1. In the Output Manager Console, click the Devices application.
2. In the Devices list, right-click the device you want to configure.
3. On the shortcut menu, click Configure Access Control.
4. In the Assign Access Control profile dialog box, select check boxes to apply access control profiles for Users,

Groups, or Departments.
5. To edit or create access profiles, click the browse button (...) for a user, group, or department, and add, remove, or

edit profiles in the Manage Profiles dialog box.
6. When you add or edit a profile, you can edit Basic settings that apply for every type of MFD or Advanced

settings that are specific to the MFD.

Manage Device Groups

Device groups are used to organize devices in the Device tree. Groups are represented as folders in the tree. In the
Output Manager Console Devices tree, you can create, move, rename, and delete device groups.

• Create a device group
• Move a device group
• Rename a device group
• Delete a device group

To create a device group

1. In the Device tree, right-click a device group (folder) and click New Group.
A new group (folder) titled UnNamed is added to the device group.

2. In the edit field, type the name of the new group and press Enter.

To move a device group

• In the Device tree, click a device group and drag it to a new location in the tree.
As you drag the item a yellow arrow will appear to the left of the tree to indicate where the group will be placed.

To rename a device group

1. In the Device tree, right-click a device group, and click Rename.
2. In the edit field, type the new group name and press Enter.

To cancel the rename, press Esc.

To delete a device group

All objects in a group must be removed before a group can be deleted. Groups that contain devices or device groups
cannot be deleted.
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• In the Device tree, right-click a device, and click Delete.

How to Add Devices
Complete this procedure to add a device to the Devices application.

1. In the Devices tree, right-click a device group (folder) where you want to add devices, and click New Device.
This opens the New Device dialog box.

2. In the Name box, enter the name of the device.
3. In the Server list, select the appropriate server.
4. In the IP Address box, enter the IP address of the device.
5. Click OK.

How to Modify Devices
Complete the following steps to modify devices in the Devices application.

1. From the Devices tree or grid, right-click the device you want to modify and click Configure Device.
This opens the Configure Device dialog box.

2. Click directly in the grid to change the Device Name or Type.
3. Click OK.

How to Create Destinations
Complete this procedure to create a destination from a selected device.

1. In the Devices tree or grid, right-click a device and click Create Destination.
This opens the Add Destination dialog box.

2. In the Type list, select the type of destination you want to create.
3. In the Server list, select the appropriate server.
4. Under Assign to group, select the destination group where the destination will be created.
5. Click OK.

The destination will be created using the device name. If a destination already exists using that name, a counter will
be added to the end of the destination name.

Search for Devices
You can search for devices from the Device tree and Device grid.

• To search the Devices tree on page 57
• To search the Devices grid on page 58

To search the Devices tree

1. In the Search box below the tree, type the text you want to find.
2. Press Enter or click the search button.
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If the text is found, your focus will be moved to the first occurrence. New buttons will appear near the Search box that
allow you to move to the previous occurrence and move to the next occurrence.

To search the Devices grid

1. In the Search box below the grid, type the text you want to find.
2. Click the column in the grid you want to search.
3. Press Enter or click the Search button.

If the text is found, your focus will be moved to the first occurrence. New buttons will appear near the Search box that
allow you to stop searching, move to the previous occurrence, and move to the next occurrence.

Managing devices through SNMP
Simple Network Management Protocol (SNMP) is used to communicate with network capable printing devices.
It allows Output Manager to detect devices, gather information and status about devices and manage them. This
provides flexibility and allows making use of the broadest set of features the devices support. Output Manager
currently supports multiple versions of SNMP. You can select whichever one is most suitable and supported by the
devices in your network.

You can specify how frequently the Output Manager SNMP Service updates Nuance Output Manager destinations
that are auto-detected SNMP printers. The SNMP update has two types of values, dynamic and static, each with their
own frequency setting. Dynamic values are values that change while the printer is being used, such as out of paper
and low on toner. Static values are values that do not change or change very infrequently, such as the printers name
and IP address. In most cases, you should configure the dynamic values to update more frequently than the static
values. Dynamic value updates are needed to maintain timely alerts so the printer can stay operational. Additionally,
SNMP metering can periodically gather information from certain devices about how many copies, prints, faxes, etc.
have been made on the device and save the data to be used for reporting.

• SNMP Versions and Communication Security
• Configure SNMP Services (including monitoring devices)
• Organizing detected SNMP devices on page 60
• Detecting Printers
• How to Override Global SNMPv3 Settings on page 63

SNMP Versions and Communication Security

For the Nuance Output Manager SNMP service to communicate with a printing device, the security configuration
must match between Nuance Output Manager and the device.

Nuance Output Manager supports SNMP versions 1 (SNMPv1), 2 (SNMPv2c), and 3 (SNMPv3). SNMPv1 and
SNMPv2c use a community name for security. The Nuance Output Manager SNMP service is installed with a default
community name of public. Nuance Output Manager uses the default community name during device detection
and stores it with the new Nuance Output Manager device. Subsequent communication with the device uses the
community name that is stored with the Nuance Output Manager device. To change the community name for a device,
change it on the physical device and in the Nuance Output Manager Device Configuration dialog.

SNMP communicates with SNMPv3-enabled devices with a matching user name, authentication password, and
protocol configured between the devices and Nuance Output Manager. To encrypt the data being communicated, use a
matching encryption password and protocol.



Output Manager Administration Guide
Version 4.0 SP2

59 © 2016 Nuance Communications, Inc. All rights reserved.

Note:  If Nuance Output Manager does not communicate with devices through SNMPv3 with matching user
names, authentication passwords, and protocols, include a remote engine context name in the configuration
settings.

You can specify global SNMPv3 settings to communicate with all SNMPv3-enabled devices. If a device does not
allow you to change SNMPv3 settings such as user name, authentication protocol, and encryption algorithm, you can
override the SNMPv3 settings for the device on the Device Configuration dialog box accessible through the Devices
application.

How to Configure SNMP Services
Complete this procedure to configure SNMP monitoring for Nuance Output Manager.

1. In the Output Manager Console navigation pane, select the Administration application.
2. In the navigation pane, click Manage Devices.
3. In the SNMP services grid, select the check box for the server you want to configure.
4. Click Configure to open the SNMP Server Configuration dialog box.

Tip:  Click the Help button for information about options in this dialog box.

5. Configure the settings in Autodetection as follows:
a) In the Auto-detection period field, specify how often you want to run the auto-detection process.

Auto-detection is initially disabled, so the default value is 00.00:00:00.
For example, to specify an auto-detection period of one hour, set the value to 00.01:00:00.

b) Select Use SNMP Detection.
c) Select the SNMP version that Nuance Output Manager uses for auto-detection.

Querying the network with both SNMPv1 and SNMPv3 could increase the detection time.
d) Select the detection method:

• To use a broadcast query, select Broadcast.
• To search IP address ranges, select IP Range(s) and click Configure ranges to configure settings in the

Configure IP Ranges dialog box.
e) Select Use web (HTTP) detection (requires IP Range configuration) to use HTTP to search for devices that

do not respond to SNMP queries. If Nuance Output Manager detects devices through HTTP, Nuance Output
Manager retrieves only the device manufacturer and model.

6. Configure the settings in the SNMP update and meter parameters section as follows:
a) To use the Domain Name System (DNS) instead of the IP address to communicate with a printer, select Use

DNS printer names if available.
b) If necessary, change the Default community name value of public to your community name when running

SNMP detection using SNMPv1 or SNMPv2c.
If you change the default community name, configure devices with the new community name.

c) Select the Default SNMP version for global communication with all SNMP devices.

Tip:  Click the Help button for more information about Default SNMP version options in this box.

d) Select the SNMP versions that Nuance Output Manager uses to detect devices.
Selecting both Allow SNMPv1/v2c queries and Allow SNMPv3 queries increases the time it takes Nuance
Output Manager to query for devices.

7. To define when Nuance Output Manager gathers information from a device, configure the settings in the SNMP
metering section as follows:
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a) Select Update metering values.
b) Enter the SNMP metering period.
c) Enter the SNMP metering timeout period in seconds.

8. To define how often Nuance Output Manager updates static values, configure the settings in the Static update
section as follows:
a) Select Update static values.
b) Enter the Static update period.
c) Enter the Static update timeout period in seconds.

9. To define how often Nuance Output Manager updates dynamic values, configure the settings in the Dynamic
update section as follows:
a) Select Update dynamic values.
b) Enter the Dynamic update period.
c) Enter the Dynamic update timeout period in seconds.

10. To define a custom interval for polling the DBM service for devices in an alert condition, configure Alert
Monitor settings:
a) Select Allow alert checks.
b) Specify the custom polling interval.

11. If you selected Auto or SNMPv3 as the default SNMP version, configure settings in Global SNMPv3 settings.
Global settings enable Nuance Output Manager to communicate with all SNMPv3-enabled devices. Configure all
SNMPv3 devices with matching settings. If you cannot configure a device with global settings, you can override
the global settings for the device.
a) In the User  field, type the user name Nuance Output Manager and SNMPv3-enabled devices use to

communicate.
b) In the Authentication Password field, type the password Nuance Output Manager uses to authenticate

devices.
c) Select the authentication Protocol.
d) Optional: In the Encryption password field, type the password Nuance Output Manager uses to encrypt data.
e) Select the encryption Algorithm.
f) In the Remote engine context name field, type the name of the specific context for communication between

Nuance Output Manager and SNMPv3-enabled devices.
12. Click OK.

Organizing detected SNMP devices

These task are performed in the Autodetected devices grid. The grid lists all of the SNMP devices that have been
detected. There are five tabs below the grid, Unused devices, OM devices, Ignored devices, All devices, and
Merged devices.

Use the devices grid to do the following:

• Perform an immediate SNMP update for detected SNMP devices
• Delete SNMP devices
• Add detected devices as Nuance Output Manager destinations
• Ignore SNMP devices
• Restore ignored SNMP devices
• Merge Nuance Output Manager devices
• Unmerge Nuance Output Manager devices
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• Demote Nuance Output Manager devices

To update detected SNMP devices
You can perform an update from any of the tab pages.

1. Select the check boxes for SNMP devices you want to update.
2. Click Update.

To delete SNMP devices

1. Select the check boxes for the devices you want to delete.
2. Click Delete.

To promote devices as Nuance Output Manager devices

1. On the Unused devices tab, select the check box for each device you want to be added as a Nuance Output
Manager destination.

2. Click Promote to OM.
The selected devices are moved to the OM devices tab.

3. When prompted whether to create a destination for the selected device, click Yes.
4. In the Add Destination dialog box, select the destination Type.

You can choose IPP JDF/JMF, LPR, or socket.
5. Select the Nuance Output Manager Server.
6. Select the group where you would like the destination created.
7. Click OK.

To ignore SNMP devices

1. On the Unused devices tab, select the check box for each device you want to ignore.
2. Click Ignore.

The selected devices are moved to the Ignored devices tab.

To restore ignored SNMP devices

1. From the Ignored devices tab, select the check boxes for each device you want to restore.
2. Click Restore.

The selected devices are moved to the Unused devices tab.

To merge Nuance Output Manager devices

1. On the OM devices tab, select the check box for each device you want to merge.
2. In the Merge Devices dialog box, select the main device.

This device will remain listed on the OM devices tab.
3. Click OK.

The devices are listed on the Merged devices tab.

To unmerge Nuance Output Manager devices

1. On the Merged devices tab, select the check box for each device you want to unmerge.
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2. Click Unmerge.

The devices are listed on the OM devices tab.

To demote Nuance Output Manager devices

1. On the OM devices tab, select the check boxes for the devices you want to demote.
2. Click Demote.

The selected devices are listed on the Unused devices tab.

Detecting devices using SNMP
Devices can be detected on all servers that have the Nuance Output Manager SNMP Service installed. Once devices
are detected, they can be associated with new Nuance Output Manager destinations.

SNMP detection can be performed automatically or manually.

• Detect devices automatically using SNMP
• Detect devices manually using SNMP in the Manage Devices utility
• Detect devices manually using SNMP in the Output Manager Device Wizard

Detect devices automatically using SNMP

1. Configure SNMP services as described in How to Configure SNMP Services on page 59.
2. When configuring SNMP services, specify an auto-detection period value other than 00.00:00:00. This frequency

period is in the format days.hours:minutes:seconds and defines when auto-detection runs.

Detect devices manually using SNMP in the Manage Devices utility

1. After SNMP services have been configured, click Manage Devices in the Administration application.
2. In the SNMP services section, select the check box for the SNMP server on which to detect devices.
3. Click Detect now to open the Select Detection Ranges dialog box.
4. Select Broadcast or IP Ranges as the detection method.

If you select IP Ranges, specify the IP address ranges for which you want to detect devices. The dialog box
contains all the ranges that have been configured for the SNMP service.

a) Select the check boxes for the IP address ranges.
b) If no ranges were configured for the service or the ranges that you want are not included, add them using one

of the following options:

• Click Import ranges from file to load ranges from a CSV file.
• Add a single range at a time.
• Click Discover next to Discover domain IP ranges to collect IP address ranges. This is a useful option if

you do not know the network topology.

Note:  Ranges are merged in the list if adding a range would result in overlaps or joining boundaries.

c) Click OK after selecting the IP ranges.

The selected ranges are used for this manual detection, but any modifications to the list of ranges does not alter
the configured ranges for the SNMP service.
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Note:  During detection, addresses that do not respond to SNMP queries are scanned as web addresses
for an alternate means of detecting devices. If they are successful by this alternate detection, the printer
manufacturer and model are retrieved and a device is added to the Autodetected devices grid.

5. When detection is completed, the Auto Detection Status column indicates Last completed: date time.

After detection is completed, use the method described in Organizing detected devices to create destinations.

Detect devices manually using SNMP in the Output Manager Device Wizard

1. On the Output Manager Console menu bar, click Tools > Device Wizard.
2. Select Detect devices via SNMP, then click Next.
3. On the SNMP Services page, select servers on which you want to run SNMP detection.

The grid lists all of the servers with the Nuance Output Manager SNMP Service installed.
4. Click in the Detection Method/IP Range(s) column to open the Select Detection Ranges dialog box.
5. Select IP address ranges as described in step 4 in Detect devices manually using SNMP in the Manage Devices

utility on page 62 above, then continue with the next step.
6. Click Detect.

This starts SNMP detection on the selected servers.
7. When the detection is complete, perform the following steps on the SNMP Detection page to create new Nuance

Output Manager destinations to be associated with the SNMP devices.
You can change the view of the grid to show only the newly detected devices or to show all devices. Newly
detected devices are devices where no destinations are yet associated with it.
a) In the grid, select the devices that you want to be associated with new Nuance Output Manager destinations.
b) In the Destination Type column, select the destination type you want to create. You can create IPP, LPR, or

socket destinations.
c) In the Destination Group column, select where the Output Manager Destinations will be grouped.
d) In the Destination Server column, select the appropriate Server.
e) Click Next.
f) On the Confirmation of Action page, click Continue to create the destinations.

This displays the Device Wizard Log.
g) Optional: You can save the log file by clicking Save.

8. Click Finish.

How to Override Global SNMPv3 Settings
Complete this procedure to override the global SNMPv3 settings for a device.

1. In the Output Manager Console, click the Devices application.
2. Right-click the device and click Configure.
3. On the SNMP tab, select Override global SNMP v3 settings.
4. Define the device-level SNMPv3 settings and click OK.

Important:  Specify a value for each SNMPv3 setting.

5. In the Devices application, right-click the device and click SNMP Update.
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Ethernet Card Reader
The Ethernet Card Reader connects to a printer and authenticates users to release print jobs securely.

The Ethernet Card Reader authenticates users to securely release all of that user's print jobs upon card swipe at single
function and multifunction printers. The card reader has two connection ports:

• One port connects to the Ethernet network, and supports Power-over-Ethernet
• One port connects to the printer

When a user presents their ID card at the card reader, documents associated with that card's owner are released.

Hardware Overview

The Ethernet Card Reader is a dual frequency (125 kHz and 13.56 MHz) RFID card reader with two RJ-45 10/100
Fast Ethernet ports.

The LED light on the card reader indicates the status of the network system and the card reader itself. Different
patterns of lights appear when the card reader is online or offline. See LED Status Messages.

How to Connect the Ethernet Card Reader
This procedure provides the basic steps for connecting an Ethernet Card Reader to a printer.

The following diagram shows the physical hardware connections:

To connect the Ethernet Card Reader, do the following:

1. Disconnect the existing network cable from the printer and connect it to the Network port on the card reader.
2. Connect the provided Ethernet cable to the printer’s network jack and the Printer port on the card reader.
3. If the network does not supply Power-over-Ethernet, attach the separate power supply to the card reader.
4. Secure the card reader near or on the printer using the provided self-adhesive Velcro strips.
5. Secure the card reader cables using the cable ties and self-adhesive cable tie mounts.
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When the card reader is powered up, the card reader beeps and the LED light appears orange for a few seconds, then
changes to the appropriate light for its current state. See LED Status Messages.

How to Add the Ethernet Card Reader
This procedure provides the basic steps for detecting and adding an Ethernet Card Reader.

The printer must be a known Output Manager device and must be promoted in Output Manager.

After the Ethernet Card Reader is connected to the printer, it needs to be added in Output Manager.

1. On the Output Manager Console menu bar, select Administration > Manage Devices.
2. Select the server that is associated with the Ethernet Card Reader.
3. Click Detect readers. The Detect Reader dialog box opens.
4. Enter the IP address range in the Start and End fields, and click OK.
5. When the Ethernet Card Reader is detected, go to Devices > Configure > Devices Details and confirm that the

Secure release type is Nuance Ethernet Card Reader and the Reader IP Address, Reader Serial Number,
and Reader Firmware Version fields are completed.

6. Click OK.

How to Update the Ethernet Card Reader Firmware or Configuration
This procedure provides the basic steps for updating the Ethernet Card Reader firmware or configuration settings.

If you receive a firmware update or a configuration update, you can apply it to the Ethernet Card Readers in Output
Manager. Do the following:

1. Go to Devices > Configure.
2. Right click and select Device Details.
3. Select one or more printers, and right-click and select Configure.
4. In the Device Configuration dialog box, click the Device Details tab.
5. Do one of the following:

• To update one card reader, click Update and browse to the .bf2 firmware or the .bec configuration file.
• To update more than one card reader, click Select all or select the card readers individually. Click Update card

reader firmware and browse to the .bf2 firmware or the .bec configuration file.
6. Click OK.

LED Status Messages

The Ethernet Card Reader displays different patterns of LED lights to communicate the system status to users. Some
types of LED light patterns might not be used on all systems.

LED Behavior Meaning

Solid red light The system is ready for the user’s ID card.

Slow flashing green light The system is authenticating the user’s ID card.

Fast flashing green light There are no print jobs for the user.

Fast flashing red light The user’s ID card is not recognized.

Slow flashing red light There is no printer associated with the card reader.
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Ethernet Card Reader Troubleshooting

The following table describes the behavior of the LED patterns when the card reader is offline and provides possible
tips to fix the error.

LED Behavior Meaning Action

One green blink The card reader’s network port has an E
thernet link, but does not have a valid I
P address.

• Verify with your IT department that a
DHCP server is accessible at this network
drop.

• Verify with your IT department that the
DHCP server will assign an IP address to
devices with the Vendor Class Identifier
(DHCP Option 60) "Baltech Proxreader".

Two green blinks The card reader is attempting to connec
t to its configured host or has not been a
dded to the system.

• If this light pattern continues for more than
60 seconds, verify the system configuration
and manually add the card reader, if
required.

One red blink The card reader cannot detect an Ethern
et link on either of its ports.

• Verify that the Ethernet cable is connected.

Two red blinks The card reader automatically discovere
d the printer and its host server, but was
unable to connect to the system.

• Add and configure the card reader to the
system manually.

Three red blinks The card reader cannot connect to its co
nfigured host, the host servers might be
down, or there is a network problem.

• Verify the host and network operation, then
disconnect and reconnect the card reader to
reset.

Four red blinks The card reader has detected that the IP
address assigned to it is already in use b
y another device on the network.

• Contact your IT department to identify the
device with the same IP address. Change
the IP address of the card reader or the
conflicting device.

• If no change was required to the card
reader’s IP address, then disconnect and
reconnect the card reader to reset.

How to Resetting the Card Reader
This procedure provides the basic steps for using Maintenance Mode to recover an Ethernet Card Reader firmware.

You must reset a configured Ethernet Card Reader to its factory default settings before deleting it from the system.

1. Go to Devices and select the device associated with the Ethernet Card Reader.
2. Select Configure > Device Details.
3. In the Secure release type list, select None and click Apply.
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How to Use Maintenance Mode to Recover an Inaccessible Card Reader
This procedure provides the basic steps for using Maintenance Mode to recover an Ethernet Card Reader firmware.

An Ethernet Card Reader might become inaccessible if there are issues with the configured card reader settings. This
may occur when:

• The card reader was originally assigned to a different system.
• The card reader’s network settings aren’t compatible with the network.
• The card reader was deleted from the system without resetting it to its factory default settings.

Maintenance mode temporarily restores the default settings, so you can perform a factory reset and reconfigure the
card reader.

To use maintenance mode to reconfigure a card reader, do the following:

1. Connect the power supply.
2. Connect the network cable to the Printer port only.

The LED light blinks red and green.

3. Reset the Ethernet Card Reader.

Note:  The card reader cannot be configured any further until it is taken out of maintenance mode by restoring
its normal network and printer connections.

RF IDeas Ethernet 241 Card Reader
The RF IDeas Ethernet 241 Card Reader connects to a printer and securely releases documents associated with a card
ID.

You can use the RF IDeas Ethernet 241 Card Reader to securely release and print documents. This card reader has
two ports that connect to the Ethernet network and the printer.

When Output Manager and this card reader are properly installed and configured, a user can swipe an RFID card on
the device’s card reader, and any documents associated with the card ID will be released to the printer connected to
the device.
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Prerequisites
This topic lists the prerequisites to using an RF IDeas Ethernet 241 Card Reader.

Before you can use the RF IDeas Ethernet 241 Card Reader, you need to complete the following:

• Purchase the RF IDeas Ethernet 241 Card Reader hardware from RFIDeas or a third-party vendor
• Purchase an Ethernet Card Reader Release for 3rd party readers license for Output Manager from Nuance
• Download the Discovery Tool and additional instructions for the Ethernet 241 Card Reader from www.rfideas.com

How to Install the RF IDeas Ethernet 241 Card Reader
This procedure provides the basic steps for connecting an RF IDeas Ethernet 241 Card Reader to a printer.

1. Connect the Ethernet cable from the network to the RF Ideas Ethernet 241 Card Reader network port.
2. Connect the Ethernet cable from the printer to the RF Ideas Ethernet 241 Card Reader device port.
3. Connect the power cube to the power connector on the RF Ideas Ethernet 241 Card Reader.
4. The card reader obtains an IP address using DHCP from the network. If your network is using DHCP, refer to the

RF Ideas Ethernet 241 Card Reader documentation to configure a static address.
5. Run the Discovery Tool by clicking 241DiscoveryTool.exe to find all the RF IDeas readers on your local network.

Note:  Use this application on the same local network where the devices are located. If you know the IP
address of the device but the device isn’t on the local network, you can connect to the IP address using a web
browser. For more details, refer to the RF Ideas Ethernet 241 Card Reader documentation.

6. Once the card reader is discovered, open the web page on the device.
7. Select the Server tab on the web page.
8. In the Data Server URL field, type the IP address for the Output Manager server.
9. In the Data Server Port field, type 80.
10. Click Update to initialize the device with these parameters.

How to Configure Output Manager with the RF IDeas Ethernet 241 Card Reader
This procedure provides the steps for configuring Output Manager with the RF IDeas Ethernet 241 Card Reader.

You need an Ethernet Card Reader Release for 3rd party readers license for each card reader.

1. Prepare the Output Manager RF IDeas Ethernet 241 web service.
a) From the Output Manager Console menu bar, select Applications > Administration > Manage License and

confirm that the Ethernet Card Reader Release for 3rd party readers flag is displayed.
If the license was recently added, reinstall and activate the license.

b) From the Administration section, select Set General Preferences and click the Clients tab.
c) In the Client web server list, select RFIDeas241Reader.
d) In the Server Port field, type 80.
e) Click the Restart server check box.
f) Click Apply.

2. Prepare the printer connected to the RF IDeas Ethernet 241 Card Reader to process a secure document.
a) From the Output Manager Console menu bar, select Applications > Manage Devices, and select the SNMP

server row.
b) Click Configure. The SNMP Server Configuration dialog box opens. Configure the server as required.
c) Click Detect readers. The Detect Readers dialog box opens.
d) Type the IP range that contains the printer and click OK.
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e) Once the device has been discovered, promote it to Output Manager and create a destination for that device.
The destination is usually named after the device DNS name.

f) From the Output Manager Console menu bar, select Applications > Destinations and create a new group
called IE_Secure by right-clicking on New Group on the All Destination group folder or subfolder.

g) Move the new destination to the IE_Secure group.
h) Right-click on the IE_Secure group and create a pending queue.
i) From the Output Manager Console menu bar, select Tools > Universal PS Driver Wizard and click the

Match with existing OM destinations radio button to create a source to match to the new pending queue in
the IE_Secure group.

j) Using the printer properties of the new printer device, print a Test Page.
This document is listed in the documents of the destination pending queue as ready to print.

k) At the printer, find your RF IDeas card ID by tapping the RFIDeas Ethernet 241 reader with the card. Then
check the cns entry in the most recent log in the C:\Program Files\NSi\Output Manager\Services\Clients
\RFIDeas241Reader\Logs\...folder.

l) From the Output Manager Console menu bar, select Applications > Administration > Manage Users and
select the user that printed the document.

m) Type the value from the cns entry to the Card ID cell and click Apply.
n) From the Output Manager Console menu bar, select Applications > Devices and right-click the device

connected to the RF IDeas Ethernet 241 and click Configure.
o) On the Device Details tab, in the Secure release type list, select RFIDeas241Reader.
p) Click Apply.

The test document is released when the card is swiped again at the RFIDeas Ethernet 241.

Once a document has been released and you have enough licenses, a 3rd party card reader check box on the Device
Details tab is automatically selected.

To release a license from this device, clear the 3rd party card reader check box and click Apply. You can then use
this license for another device.
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Queues and Universal
Postscript Driver

Converting Windows Queues
Nuance Output Manager will often be installed in an existing print environment. This means there will already be one
or more Windows print servers, each serving dozens or hundreds of Windows queues. You can easily use the Nuance
Output Manager Device Wizard to convert these Windows queues to Nuance Output Manager sources. All documents
sent to the converted Windows queue will be automatically received in Nuance Output Manager through the new
source.

You can choose to create a Nuance Output Manager destination for the queue. Nuance Output Manager will
automatically configure the source to route to the destination. This is useful because no change will appear to the end
users, and they will continue print and receive their documents as usual.

• Convert Windows queues
• Convert Windows queues (advanced mode)

The difference between converting queues in basic and advanced mode amounts to granularity of controlling options.

In basic mode:

• The options to create sources and/or destinations apply to all converted queues the same.
• The optional destination will be a Socket type destination only.
• The source and destination group selections will apply to all new sources and destinations.
• File store selection will apply to all new sources the same.

In advanced mode:

• The option to create a sources and/or destination is chosen per device to convert.
• The optional destinations can be of type Socket: IPP or LPR.
• The source and destination group selections are chosen per device to be converted.
• File store selection is made per source to be created.

If you decide you no longer want the Windows queue routed through Nuance Output Manager, you can easily restore
the Windows queue.

• Restore Windows queues

How to Convert Windows Queues
Complete this procedure to convert existing Windows queues to Nuance Output Manager sources and destinations.

1. In the Output Manager Console, click Tools > Device Wizard.
2. Select Convert Windows Queues on one or more Print Servers.
3. On the Print Server Selection page, select the servers that contain the Windows queues you want to convert., then

click Next.
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Only servers with the Nuance Output Manager Input Service running will be listed in the grid. If the server you
want is not listed, run the Nuance Output Manager Input Service on that server and try again.

4. On the Conversion Method page, select the conversion method you want to use.
Conversion method Description

Complete Conversion (recommended) Creates both a new Nuance Output Manager source
and Nuance Output Manager destination on the chosen
print servers for each detected Windows queue.

Sources Only Creates only a new Nuance Output Manager source
on the chosen print servers for each detected Windows
queue.

Destinations Only Creates only a new Nuance Output Manager
destination on the chosen print servers for each
detected Windows queue. This will create a single
Nuance Output Manager destination when multiple
printers/ports share the same IP address and queue
name or port number.

5. On the File Store and Groups page, configure the grid as necessary, and when finished, click Next.
a) Select the File Store to be associated with the new source.

All file stores defined in the Set General Preferences Utility are displayed.
b) Choose the Source Group where the new source will be created.

The new source will use the same name as the Windows queue.
c) Choose the Destination Group where the new destination will be created.

The new destination will use the same name as the Windows queue.
Depending on the conversion method selected, columns will display for source and/or destination configuration.

6. On the Windows Queues page, in the Convert column, select Convert for the Windows queues you want to
convert, then click Next.
This grid displays all of the Windows queues found on the selected server that are using one of the following
Windows ports: LPR port, Standard TCP/IP port, HP Standard TCP/IP port, or SC2 TCP/IP port.

7. You can use the Destination Name column to build the name to use for the new destination.
In this column, you can type to edit the content, you can right-click and use the context menu to add variables, or
you can use a combination of typing and right-clicking to build the name.

8. You can edit the Location and Comment columns as needed. These values will show up in the new source and
destination in Nuance Output Manager .

9. On the Confirmation of Action page, click Convert to convert the Windows queues.
When the conversion is complete, the Device Wizard Log dialog box displays. You can save the log file by
clicking Save.

10. Click Finish.

How to Convert Windows Queues (Advanced Mode)
Complete this procedure to covert existing Windows queues to Nuance Output Manager sources and destinations
using advanced mode.

1. In the Output Manager Console, click Tools > Device Wizard.
2. Select Convert Windows Queues on one or more Print Servers and Advanced mode.
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3. On the Print Server Selection page, select the Server that contains the Windows queues you want to convert, then
click Next.
Only servers with the Nuance Output Manager Input Service running will be listed in the grid. If the server you
want is not listed, start/install the Nuance Output Manager Input Service on that server and try again.

4. On the Windows Queues page, configure the grid as necessary, and when finished, click Next.
You can choose to create a source and/or destination for each queue.

• If you select Create Source, select File Store and Source Group to be associated with the new source.

All file stores defined in the Set General Preferences Utility are displayed. The new source will use the same
name as the Windows queue.

• If you select Create Destination, select the Destination Server, Destination Type, and Destination Group.

The new destination will use the same name as the Windows queue. However, the Destination Name column
can be used to build the name to use for the new destination. To build the name, you can type in the box, right-
click to use the context menu to insert variables, or use a combination of both typing and right-clicking.

• You can edit the Location and Comment columns as needed. These values will show up in the new source and
destination in Output Manager.

• By default, the Create single destination for multiple queues when possible check box is selected.

This will create a single Nuance Output Manager destination when multiple printers/ports share the same IP
address and queue name or port number. If this is not selected, new Nuance Output Manager destinations are
created for each queue converted.

5. On the Confirmation of Action page, click Convert to convert the Windows queues.
When the conversion is complete, the Device Wizard Log dialog box displays. You can save the log file by
clicking Save

6. Click Finish.

How to Restore Windows Queues
Complete this procedure to restore converted Windows queues.

1. From the Output Manager Console, select Tools > Device Wizard.
2. Select Restore previously converted Windows Queues and click Next.
3. On the Print Server Selection page, select the server that contains the converted queues, then click Next.

Only servers running the Nuance Output Manager Input Service will be listed in the grid. If the server you want is
not listed, start the Nuance Output Manager Input Service on that server and try again.

4. On the Restore Windows Queues page, select the Windows queues you want to restore and click Next.
All of the converted Windows queues for the selected server are listed in the grid.

5. On the Confirmation of Action page, click Restore to restore the selected Windows queues.
When the conversion is complete, the Device Wizard Log dialog box displays. You can save the log file by
clicking Save.

6. Click Finish.

Universal Postscript Driver
The NSi Universal PostScript Driver is a Windows printer driver that allows users to print documents to Output
Manager (OM) and output them to any supported PostScript printer serviced by OM, regardless of the printer’s
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manufacturer or model.This eliminates the need to install different printer drivers for every make and model of printer
in your network, and allows for advanced features such as dynamic routing, pull printing, and failover printing.

The driver is part of our universal printing concept and works by rendering the job at print time, after the destination
has been selected. When the user prints a document, the driver creates a generic PostScript representation of the
document and sends it, along with information about how the document should be printed, to OM for processing.
Once the document arrives in OM, it can be processed using all of the normal features built into OM, and can routed
to a particular destination using any of the usual methods (static routing, dynamic routing, pull printing, etc.) When
the document is routed to a specific printer, the generic data and printing options are converted to printer specific
commands that print the document correctly on the target printer. This allows the same document to be printed on any
supported PostScript printer serviced by OM.

The driver supports x86 and x64 clients running Windows XP SP3 and higher, and provides printing options common
to most model specific printer drivers. The driver is multilingual and supports English, Danish, Dutch, French,
German, Italian, Portuguese, Norwegian, Spanish, and Swedish. The driver’s user interface dynamically adjusts to the
appropriate language based on the user’s language settings Windows, and support multiple languages simultaneously
on the same server or client system without having to install different drivers or language packs.

The NSi Universal PostScript Driver is installed with the Output Manager Input Service, and is typically used in a
shared printing environment. After setting up the shared printer, network users with appropriate rights simply connect
to the shared printer, and are able to print. The Point-And-Print features supported by the driver automatically install
the necessary driver files on the client system.

How to use the NSi Universal Postscript Driver

To use the driver, perform the following steps.

1. Install the Input Service on your network print server.
2. Create a shared printer using the NSi Universal PostScript Driver and NSi Job Monitor Port.

Note:  These steps may vary slightly by operating system.

a) Open Devices And Printers.

Note:  Until a Windows Queue source has been created for this printer, the port is unable to send data
to OM. Therefore, the Print Test Page feature will now work until after the Windows Queue source has
been setup.

b) Click Add a printer.
c) Click Add a local or network printer.
d) Click Create a new port, select NSi Job Monitor from the drop down, and click Next.
e) Enter a name for the port and click OK.
f) Select Notable Solutions, Inc. in the manufacturers list, select NSi Universal PostScript Driver in the printers

list, and click Next.
g) Select Use the driver that is currently installed and click Next.
h) Enter a name for the printer and click Next.
i) Choose Share this printer, set shared name (usually the same as the printer name), and click Next.
j) Click Finish.

3. Create a Windows Queue source in Output Manager to receive documents printed through the driver.
See Receiving documents from a Windows queue.

4. Create an Output Manager destination to output to the target printer.
See Sending Documents to an IPDS Printer.
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Note:  Alternately, the Universal PS Driver Wizard can be used to create printers with the driver, or
convert existing printers to use the driver. For more information, see Universal PS Driver Wizard.
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Security

Output Manager Security
Output Manager security provides the ability to control access to resources.

Output Manager provides three types of security to control access:

Category Description

Document Ownership Grants users access to the documents they own. By defau
lt, users have full access to their documents, but no acces
s to other resources.

Security Roles Grant global access to Output Manager resources. The S
ystem Administrators Role has all permissions by default
. No user has any access to Output Manager until users o
r groups are assigned this role during installation through
the OM Server Configuration utility.

Configured Security Provides a means for administrators to grant access to sp
ecific resources such as Documents, Sources, Destination
s, Devices, and Reports.

Once security is configured, access control can be enforced immediately.

Document ownership
Document ownership is a special security role that grants users access to the documents they own. By default, users
have full access to their documents, but no access to other resources.

Document ownership is established by relating an Output Manager user with an Output Manager document. The
permissions granted automatically to document owners can be modified through the role manager (See Security
Roles).

Document Ownership

Document ownership is established through two mechanisms:

Automatic Some types of Output Manager sources assign the correct
user as the owner of the document automatically. Here
are a few examples:

• When using Windows print queues to send
documents to Output Manager, the source assigns the
domain user who sent the document as the document
owner.

• LPD sources will attempt to match the user in the
control file with an Output Manager user account.
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• Network Folder sources are always going to use the
Input service account as the document owner, which
will normally not be helpful.

Business Rules When document owner security is necessary and the
automatic document owner is not correct, a business rule
must be used to correct the document owner. There are
a variety of business rules designed to extract metadata
from a document, and an extensive business rule that will
use document metadata to assign the document owner
(see Business Rules).

Note:  Document Owner assignment is also
required for pull printing or secure release, since
the user will be choosing from the documents
he/she owns

Document Owner Permissions

The permissions granted to the document owner can be modified through the Document Owner role with the Role
Manager dialog (see Security Roles).

Security Roles
Administrators use Role Manager to add users and groups to roles and to modify the permissions associated with
roles.

There are three roles defined in Output Manager:

Document owner This role the rights of document owners. You can
limit or extend the permissions of document owners as
needed. For example, an administrator who wants to
prohibit document owners from assigning documents to
destinations could remove this permission. This role is
limited to Documents and Library applications. This role
is different in that users/groups are not assigned this role.
The Document Owner role intrinsically applies to any
user and his/her owned documents.

System administrator Members of this role by default have access to all
aspects of Output Manager. You may only rarely need
to modify the permissions associated with the System
Administrators role. When you are installing Output
Manager, you can use the Output Manager Server
Configuration Utility to assign users and groups to the
System Administrators role. You can modify the users/
groups and permissions as needed using Role Manager.
Some permissions cannot be removed from this role to
guard against accidentally locking administrators and
everyone else out of Output Manager.

Security administrator This optional role is identical to the System
Administrators role except that the permissions
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associated with configuring security cannot be removed.
This role is only used when an organization wants
to configure security outside of general system
administration.

How to add or remove users and groups in roles
Follow the steps in this procedure to add or remove users and groups in roles.

You can use either the Role Manager or the Output Manager Server Configuration Utility to configure members
in a role.

• To add users or groups to a role using the Output Manager Console, click Tools > Security Roles to open the
Role Manager dialog box.
a) In the Role name box, choose the System Administrators role.
b) Click the Add button.
c) To add a user or group to Output Manager, click More Users.

• To add users or groups using the Output Manager Server Configuration Utility, click Start > All Programs >
Output Manager > Output Manager Server > OM Server Configuration
a) Click the Output Manager security administration tab.
b) Click the Connect button to connect to the database.
c) Use the Add or Remove button to add or remove users in the User and Groups list.

How to add or remove role permissions
Use the Role Manager to configure role permissions.

1. In the Output Manager Console, click Tools > Security Roles to open the Role Manager dialog box.
2. Next to Role name, click the browse button (...).
3. In the Members box, click the role that you want to manage.
4. Click the Modify button.
5. In the Configure Role dialog box, select or clear check boxes to add or remove permissions.
6. Click the OK button.

Configuring permissions
An administrator can grant access to specific resources such as Documents, Sources, Destinations, Devices, and
Reports.

Permissions can be granted to users and/or groups directly to the using console or object permissions.

Console permissions

Console Permissions allow access to individual areas of the Output Manager Console. Console permissions grant
access to the following

• The Output Manager Console
• Individual applications (Sources, Destinations, Administration, and so forth)
• Individual administrative tasks in the Administration application
• Menu items on the Tools menu

There is no inheritance in console permissions.
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Object permissions

Object permissions provide access to features and components of Output Manager.

• Destination Permissions allow access to printers or groups of printers.
• Document Permissions allow access to documents in a given document folder.
• Library Document Permissions allow access to documents in a given document library folder.
• Query Permissions allow access to document and document library queries.
• Report Permissions allow access to reports or report group folders.
• Source Permissions allow access to sources or groups of sources.

In tree and grid interfaces, an object that supports security configuration will display a Security command on its
context menu. This opens the Security Configuration which has features similar Windows security, similar to the
Security tab in the Windows folder properties dialog box. This standardized functionality helps increase familiarity of
options in the dialog box.

The available permissions are specific to the type of object. For example destinations have a different list of
permissions from Reports. The complete list of permissions is always in the same for a given object type. Although
a list of users and user groups can be configured, a single user or user group in the list will always be selected.
The enabled permissions are always in the context of the selected user or user group. A check box to the left of
the permission description indicates its enabled state. Clicking on a permission toggles its enabled state. When a
permission is enabled via inheritance, it displays grayed-out and control over that permission is disabled even though
adjacent permissions maybe configured (see Inheritance).

Inheritance

Objects inherit permissions from their parent object unless you specify not to do so. Inherited permission are
permissive. When an object inherits permissions from a parent, you can only add permissions for specified users and
groups. You cannot remove inherited permissions from a user or group.

Administrators use inheritance to productively configure security. By default, when security is configured on an
object hierarchy, all of the children (folders and objects) inherit that security configuration. For example, configuring
security on the “All Destinations” folder in the Destinations tree will apply that security to every folder and every
destination that does not block inheritance from its parent. When security is configured on any descendant object in a
tree, all children of that object inherit those settings as well.

The Security Configuration dialog box allows you to control inheritance. An administrator can add permissions for
specified objects or users or block inheritance for the object. When an administrator blocks inheritance for an object,
the administrator can choose to copy permissions from the parent object into the current object and then configure
those as required. Alternatively, the administrator can choose not to copy inherited permissions and configure entirely
new permissions to apply to that object and any of its descendants.

Security configuration is audited in Output Manager, so it is possible to report on changes in the security
configuration. For example, Audit Reports show who granted a given permission to whom and for what object.

Tip:  In general it is a good practice to define permissions at the highest level folder or object possible and
allow inheritance to provide access to all descendants. This allows you to more easily assign and manage
permissions for many different objects. If necessary, you can add members or groups to an object to add
additional permissions to those that are inherited. You should only block inheritance for an object when you
need to limit access to specific groups or users.

How to configure console permissions
This procedure describes how to configure console permissions.

1. Click Tools > Console Security.
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This opens the Security Configuration dialog box.
2. In the Users and groups with permissions box, you can configure users to whom you want to assign permission.

• To add a user or group, click the Add.

This opens the User and Group Selection dialog box, which allows you to select from Output Manager users
or add users if they are not already listed. For details selecting or adding users, click the Help button in this
dialog box.

• To remove a selected user or group, click the Delete button.

This removes a user from the console configuration, but it does not remove the user from Output Manager.
3. To change permissions for a selected user or group, select or clear check boxes in the Assigned permissions box.

• To assign all permissions, click the Select All button.
• To clear all permissions, click the Unselect All button.

4. When you are finished, click the OK button.

How to configure object permissions
This procedure describes how to configure permissions for objects that support permissions.

1. Right-click the object in its application window.
2. On the shortcut menu, click Security.

The Security command is available for any object that supports security configuration.
3. You can choose to block inheritance for the object.

a) In the Inherit permissions from the parent box, click the browse button (...).
This opens the Security Configuration - Change inheritance dialog box.

b) In the Inherit permissions from the parent box, click "Do not inherit".
c) Optional: To copy permissions from the parent object, select the Copy inherited permissions check box.

Select this check box to modify rather than discard inherited permissions.
d) Click the OK button.

4. In the Users and groups with permissions box, you can configure users to whom you want to assign permission.

• To add a user or group, click the Add.

This opens the User and Group Selection dialog box, which allows you to select from Output Manager users
or add users if they are not already listed. For details selecting or adding users, click the Help button in this
dialog box.

• To remove a selected user or group, click the Delete button.

This removes a user from the object, but it does not remove the user from Output Manager.
5. To change permissions for a selected user or group, select or clear check boxes in the Assigned permissions box.

• To assign all permissions, click the Select All button.
• To clear all permissions, click the Unselect All button.

The permissions shown here depend on the type of object. Selections here add to any permissions already
inherited from the parent object. Clearing or not selecting a check box in the Assigned permissions box does not
remove an inherited permission.

6. When you are finished, click the OK button.
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Security enforcement

A security enforcement cache object is instantiated by any user interface as it initializes. Most user interfaces can
determine when the security configuration has changed, and update their security enforcement cache. Consequently,
security changes commonly take effect immediately.
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Sources

Learning About the Sources application
Use the Sources application is to manage and monitor sources. Sources receive data into Nuance Output Manager.
The navigation pane displays a configurable Sources tree showing all sources. You can drag-and-drop to move
sources into source groups.

The console window displays a tabbed view of the Source tree selection. When a source is selected in the tree, a
source home page will display showing the properties and the status of the source. When a source group (folder) is
selected in the tree, the Sources grid lists all of the sources in the group. The Sources grid is in a tab page control.
By default, navigating in the tree will replace the information in the active tab. To open a source or group in new tab,
right-click the item in the tree and click Open in New Tab. Your tree selection, open tab pages, and console window
settings will be saved for the next time you open the application.

By default the Documents grid displays below the Sources grid. There are two tabs below the grid, Spooled and
Retained. The Spooled tab lists all of the documents currently received by the source selected in the tree. The
Retained tab lists all of the documents that were received by the selected source and then retained. If a group is
selected, the list will contain documents for all of the sources in the group. You can switch the tabs to view either
spooled or retained documents. As you select items in the tree, both of the grids will update to show only the
appropriate documents.

The following table describes source states:

Source States Descriptions See

Enable Allows the source to receive docume
nts into Nuance Output Manager.

• Enable a source

Disable Stops this source from receiving doc
uments.

• Disable a source

How to Manage Source Groups
You can create, move, rename, and delete source groups in the Output Manager Console Sources tree.

Source groups are used to organize sources in the Sources tree. Groups are represented as folders in the tree.

• Create a source group
• Move a source group
• Rename a source group
• Delete a source group

To create a source group

1. In the Sources tree, right-click a source group (folder) and click New Group.
A new group (folder) titled UnNamed is added to the selected source group.

2. In the edit field, type the name of the new group and press Enter.
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To move a source group

• In the Sources tree, drag the source group you want to move to the desired tree location.
As you drag the item a yellow arrow will appear to the left of the tree to indicate where the group will be placed.

To rename a source group

1. In the Sources tree, right-click a source group and click Rename.
2. In the edit field, type the new group name and press Enter.

To cancel the rename, press Esc.

To delete a source group

All of the objects must be removed before the group can be deleted.

Groups that contain sources or source groups cannot be deleted.

1. In the Sources tree, right-click the source you want to delete.
2. Click Delete on the shortcut menu.

How to Add Sources
Complete the following steps to add sources to the Sources application.

1. In the Sources tree, right-click the source group (folder) where you want to add sources, and click New Source.
This opens the Add Source dialog box.

2. In the Type list, select the source type.
3. Next to Add new devices enter the number of sources you want to create.

You can create multiple sources of the type selected and configure the sources simultaneously. The configuration
tab pages that displays is different depending on whether you choose to create a single source or multiple sources.

Source Displays

Single source configuration Configuration options are listed on the tab pages.

Multiple source configuration Sources are configured in grid format on each tab page.

You will need to configure the options for each source row. You can use Series Fill to automatically populate
multiple fields in a column. To create a series fill, select the rows you want to automatically fill and then click
inside one of the cells that you are editing. Click Series Fill and enter the text and configure the counter in the
Series Fill dialog box. The series will start with the first selected row.

4. Click OK.
Tab pages will display with options specific to the selected source type. The configuration options is different
depending on whether you choose to create a single source or multiple sources. When configuring one source,
individual options are listed on the tab pages. When configuring multiple sources, the options are listed in grid
format to allow for configuring multiple sources simultaneously. You can add and remove sources by clicking
Add and Remove below the grid. You can also select sources and click Copy to create copies

5. Configure the general settings. For multiple source configuration, this is configured on the General tab.
a) Enter the source Name.
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b) In the Server list, click the Output Manager server where the Output Manager Input and Output services are
located for this source.

c) Enter any Comments or Location information for the source.
6. Make the necessary changes on each tab.

The following topics provide more information on configuring tabs for source types:

• How to add an AutoStore source on page 83
• How to add an Email source on page 86
• How to add an FTP Source on page 95
• How to add an IPP Source on page 100
• How to add an LPD Source on page 103
• How to add a Mobile Server source on page 104
• How to add a NetWeaver source on page 108
• How to add a Network Folder source on page 111
• How to add an Output Manager source on page 115
• How to add a Socket Connection source on page 119
• How to add a TCP/IP NJE source on page 122
• How to add a WCF API source on page 126
• How to add a Web Upload source on page 130
• How to add a WebSphere MQ source on page 133
• How to add a Windows Queue source on page 137

7. Click OK.

How to add an AutoStore source
Complete the following steps to create AutoStore sources. Documents received by this source will be routed to
Nuance Output Manager.

1. In the Sources tree, right-click the source group (folder) where you want to add sources and click New Source.
This opens the Add Source dialog box.

2. In the Type list, select AutoStore.
3. Next to Add new devices enter the number of sources you want to create.

You can create a single AutoStore source or create multiple AutoStore sources and configure them simultaneously.
4. Click OK.
5. Configure the general settings.

For multiple source configuration, this is configured on the General tab.
a) Enter the source Name.
b) In the Server list, click the Nuance Output Manager server where the Nuance Output Manager Input Service is

located for this source.
The source does not have to be on the same server as the Nuance Output Manager Input Service.

c) Enter any Comments or Location information for the source.
d) Optional: To change the large source image that displays when configuring a single source, you can click

Select Image and choose the appropriate image file (BMP, JPEG, or PNG).
The selected image will be compressed and scaled to 96x96 pixels. Changing this image will not change the
smaller image that displays or the image that displays in the source tree. To change the image back to the
default, click Reset Image.
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6. Configure the document properties that will be applied to all documents received by the source.

Configuration Method

Single source configuration Use the Document properties tab.

Multiple source configuration Use the Document properties (Bulk Configuration) ta
b.

Determine if you want to use advanced document properties. Advanced document properties facilitate the setting
of document properties from multiple sources. This is a complex feature that only advanced users and professional
service engineers should configure.

To Do this

Use advanced document properties Select Use advanced document properties. This
enables the advanced document properties profile
list. Select the default profile or an existing profile.
To configure document profiles, see the Configuring
document property profiles topic.

Not use advanced document properties If you do not want to use advanced document
properties, leave the check box disabled and configure
the following:

• Select the Document owner. This user will be the
owner of all documents received using this source.
Click the browse button (...) to select a user.

• Configure the document properties by entering
property values directly in the grid. All of the
available property values are listed and grouped
into categories. Expand the appropriate category
by clicking the arrow next to the category name.
The first node level in the category determines
the print preferences for the properties it contains.
On the print preference node, click in the Mode
column and configure how the property should be
applied when a document is sent to a destination.
Select Always Apply to always apply the specified
property value. Select Informational Only to use
the value for informational purposes only. In the
Value column, click in the grid cell to specify the
document property value.

Important:  This can only be configured
during single source configuration.

7. Configure the following configuration settings.

Configuration Method

Single source configuration Use the More settings tab.

Multiple source configuration Use the More settings (Bulk Configuration) tab.
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a) Determine if you want all documents received by this source to be in the Hold state as they enter the Output
Manager Console.
This option is disabled by default.

b) Determine if you want to disable business rule processing for all documents received by this source as they
enter the Output Manager Console.
This option is disabled by default.

c) Use the following options to determine if you want to analyze documents as they are received by a source and
enter the Output Manager Console.
Selecting these options may cause performance degradation. These options are disabled by default.

Option Description

Use quick page counting for PDF documents Enables optimized page counting for PDF jobs. Wh
en this option is enabled, the Count pages, Detect
color, Detect data type, Detect duplex, and Detect
trays options are disabled.

Count pages Performs a page count on all documents received by t
his source.

Detect data type Detects the data type on all documents received by th
is source. The data type will display in the Document
s grid Data Type column.

Detect trays Determines the document paper tray that will print th
e document. This will display in the Documents grid
Input Bin or Output Bin column. You can configure
the Output Bin column to display by using the Admi
nistration Configure Document Properties Utility.

Detect color Detects if the documents received by this source cont
ain color. The Documents grid Color column display
s True or False depending if color is detected.

Detect duplex Detects if the documents received by this source are
configured for duplex printing (that is, printing on b
oth sides of the paper). The Documents grid Duplex
column displays how the document will print, One
Sided, Two Sided Short Edge, or Two Sided Long
Edge.

d) Select the file store that will be used for all documents received by this source as they enter the Output
Manager Console.
The default file store is selected by default. Administrators define file stores and select the default in the Set
General Preferences Utility. If the default file store is changed in the Set General Preferences Utility, all
sources using the default will be automatically updated.

e) Assign a document folder for all documents received by this source as they enter the Output Manager Console.
The default document folder is Un-Filed Documents.

f) To create profiles and enter costs associated with printing, select the Advanced Costing Profiles check box.
If you do not select this option, you can specify only the cost per page for printing.
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g) Determine if you want to send a notification when a document arrives, prints successfully, prints on failover
destination, or is in error state.
The notification can be sent as an email message or pop-up. You can select an existing profile in the list or
create one from the Notification Profile dialog box.

• To create a profile during single source configuration, click New.
• To create during multiple source configuration, click the browse button (...).

8. Configure the following output settings.

Configuration Method

Single source configuration Use the Output settings tab.

Multiple source configuration Use the Output settings (Bulk Configuration) tab.

a) Use the Schedule output option to specify the date and time all documents received by this source will print.
You can choose to print the documents today, on a specific day, or in the future. You can also choose to print as
soon as possible, at a specific time, or in the future.

b) Use the Route to destination option to specify a destination where all documents received by this source can
be routed.
Click the browse button (...) to select one or more destinations in the tree. Use the Shift and Ctrl keys to select
multiple destinations. Destination groups cannot be selected. This option is set to Unrouted by default.

c) To override the default retain settings for all documents received by this source select the Override default
retain settings check box and configure the retain options as necessary.

d) Select the appropriate output process.
Output processes can be created to impact documents as they are being sent to a destination. The processes
contain a set of actions which could be used for search and replace, setting finishing options, editing PJL
commands, inserting overlays, and so on. You can select an existing process in the list or create one using the
Process Designer. To create a process during single source configuration, click New. To create during multiple
source configuration, click the browse button (...).

e) Select the appropriate failover profile.
Failover profiles specify what should happen to documents when they are sent to inaccessible destinations
(they are not able to receive documents). You can select an existing profile in the list or create one from the
Failover Profile dialog box. To create a profile during single source configuration, click New. To create
during multiple source configuration, click the browse button (...).

9. Click OK.

How to add an Email source
Complete this procedure to create email sources. Documents received by the specified email account will be routed to
Nuance Output Manager.

1. In the Sources tree, right-click the source group (folder) where you want to add sources and click New Source.
This opens the Add Source dialog box.

2. In the Type list, select Email.
3. Next to Add new devices, enter the number of sources you want to create.

You can create a single email source or create multiple email sources and configure them simultaneously.
4. Click OK.
5. Configure the general settings.
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For multiple source configuration, this is configured on the General tab.
a) Enter the source Name.
b) In the Server list, click the Nuance Output Manager server where the Nuance Output Manager Input Service is

located for this source.
The source does not have to be on the same server as the Nuance Output Manager Input Service.

c) Enter any Comments or Location information for the source.
d) Optional: To change the large source image that displays when configuring a single source, you can click

Select Image and choose the appropriate image file (BMP, JPEG, or PNG).
The selected image will be compressed and scaled to 96x96 pixels. Changing this image will not change the
smaller image that displays or the image that displays in the source tree. To change the image back to the
default, click Reset Image.

6. Configure the email settings.

Configuration Method

Single source configuration Use the Email settings tab.

Multiple source configuration Use the Email settings (Bulk Configuration) tab.

a) Enter a valid Email server.
You can click the browse button (...) to display the Mail Server Search dialog box and search for one on a
given domain.

b) Specify the Protocol.
You can select from one of the following three options:

• IMAP4
• POP3
• Exchange Web Services

c) For POP3 or IMAP4, specify the Port number.
Port numbers may be different based on the email application that was used to set up the email account. The
default port number is 110.

d) For Exchange Web Service, specify how to discover and connect to the email server using EWS.
Either enter an email address or specify the URI for the Exchange server.

• Autodiscover via an email address
• Service URI

e) Exchange
f) Choose if you want to Use SSL (Secure Socket Layer) when connecting using POP3 or IMAP4.

Using SSL will encrypt the email. This option is unavailable when using Exchange Web Service, as it connects
over TCP/IP.

g) Enter the User name that will be used when logging into the email account.
If the email account does not require a user name, you can leave this blank.

h) Enter the Password that will be used when logging into the email account.
If the email account does not require a password, you can leave this blank.

i) Specify the time Interval for checking the mail account for documents.
The default value is 60 seconds.
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j) This is an optional step. To delete the email messages and their attachments from the server after they have
been received by Output Manager, select the Delete messages check box.
This option is selected by default.

k) Select the email components to include in a separate components document that users can print. When Nuance
Output Manager receives an email, Nuance Output Manager resolves its attachments into documents and
creates the components document. Nuance Output Manager then creates a single package that contains all the
documents from the email, the attachments, and the components document

7. Configure filters depending on the source configuration.

Configuration Method

Single source configuration Use the Filters tab. The filter column lists the filter
criteria.

You can modify the filter values by typing directly in
the Regular Express Value column. Wild card values
of ? or * are accepted as long as the expression's first
character is a numeric or alphabetic character. This
filter will be applied to each document received by the
selected source. Click Regular Expression Tester to
verify the expression syntax is valid.

Multiple source configuration Use the Filters (Bulk Configuration) tab. Sources are c
onfigured in grid format on each tab page. The sources
you choose to create are displayed as rows in the grids
. The configuration options are listed as the column he
adings.

8. Configure the document properties that will be applied to all documents received by the source.

Configuration Method

Single source configuration Use the Document properties tab.

Multiple source configuration Use the Document properties (Bulk Configuration) ta
b.

Determine if you want to use advanced document properties. Advanced document properties facilitate the setting
of document properties from multiple sources. This is a complex feature that only advanced users and professional
service engineers should configure.

To Do this

Use advanced document properties Select Use advanced document properties. This
enables the advanced document properties profile
list. Select the default profile or an existing profile.
To configure document profiles, see the Configuring
document property profiles topic.

Not use advanced document properties If you do not want to use advanced document
properties, leave the check box disabled and configure
the following:
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To Do this
• Select the Document owner. This user will be the

owner of all documents received using this source.
Click the browse button (...) to select a user.

• Configure the document properties by entering
property values directly in the grid. All of the
available property values are listed and grouped
into categories. Expand the appropriate category
by clicking the arrow next to the category name.
The first node level in the category determines
the print preferences for the properties it contains.
On the print preference node, click in the Mode
column and configure how the property should be
applied when a document is sent to a destination.
Select Always Apply to always apply the specified
property value. Select Informational Only to use
the value for informational purposes only. In the
Value column, click in the grid cell to specify the
document property value.

Important:  This can only be configured
during single source configuration.

9. Configure the following configuration settings.

Configuration Method

Single source configuration Use the More settings tab.

Multiple source configuration Use the More settings (Bulk Configuration) tab.

a) Determine if you want all documents received by this source to be in the Hold state as they enter the Output
Manager Console.
This option is disabled by default.

b) Determine if you want to disable business rule processing for all documents received by this source as they
enter the Output Manager Console.
This option is disabled by default.

c) Use the following options to determine if you want to analyze documents as they are received by a source and
enter the Output Manager Console.
Selecting these options may cause performance degradation. These options are disabled by default.

Option Description

Use quick page counting for PDF documents Enables optimized page counting for PDF jobs. Wh
en this option is enabled, the Count pages, Detect
color, Detect data type, Detect duplex, and Detect
trays options are disabled.

Count pages Performs a page count on all documents received by t
his source.
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Option Description

Detect data type Detects the data type on all documents received by th
is source. The data type will display in the Document
s grid Data Type column.

Detect trays Determines the document paper tray that will print th
e document. This will display in the Documents grid
Input Bin or Output Bin column. You can configure
the Output Bin column to display by using the Admi
nistration Configure Document Properties Utility.

Detect color Detects if the documents received by this source cont
ain color. The Documents grid Color column display
s True or False depending if color is detected.

Detect duplex Detects if the documents received by this source are
configured for duplex printing (that is, printing on b
oth sides of the paper). The Documents grid Duplex
column displays how the document will print, One
Sided, Two Sided Short Edge, or Two Sided Long
Edge.

d) Select the file store that will be used for all documents received by this source as they enter the Output
Manager Console.
The default file store is selected by default. Administrators define file stores and select the default in the Set
General Preferences Utility. If the default file store is changed in the Set General Preferences Utility, all
sources using the default will be automatically updated.

e) Assign a document folder for all documents received by this source as they enter the Output Manager Console.
The default document folder is Un-Filed Documents.

f) To create profiles and enter costs associated with printing, select the Advanced Costing Profiles check box.
If you do not select this option, you can specify only the cost per page for printing.

g) Determine if you want to send a notification when a document arrives, prints successfully, prints on failover
destination, or is in error state.
The notification can be sent as an email message or pop-up. You can select an existing profile in the list or
create one from the Notification Profile dialog box.

• To create a profile during single source configuration, click New.
• To create during multiple source configuration, click the browse button (...).

10. Configure the following output settings.

Configuration Method

Single source configuration Use the Output settings tab.

Multiple source configuration Use the Output settings (Bulk Configuration) tab.

a) Use the Schedule output option to specify the date and time all documents received by this source will print.
You can choose to print the documents today, on a specific day, or in the future. You can also choose to print as
soon as possible, at a specific time, or in the future.

b) Use the Route to destination option to specify a destination where all documents received by this source can
be routed.
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Click the browse button (...) to select one or more destinations in the tree. Use the Shift and Ctrl keys to select
multiple destinations. Destination groups cannot be selected. This option is set to Unrouted by default.

c) To override the default retain settings for all documents received by this source select the Override default
retain settings check box and configure the retain options as necessary.

d) Select the appropriate output process.
Output processes can be created to impact documents as they are being sent to a destination. The processes
contain a set of actions which could be used for search and replace, setting finishing options, editing PJL
commands, inserting overlays, and so on. You can select an existing process in the list or create one using the
Process Designer. To create a process during single source configuration, click New. To create during multiple
source configuration, click the browse button (...).

e) Select the appropriate failover profile.
Failover profiles specify what should happen to documents when they are sent to inaccessible destinations
(they are not able to receive documents). You can select an existing profile in the list or create one from the
Failover Profile dialog box. To create a profile during single source configuration, click New. To create
during multiple source configuration, click the browse button (...).

11. Click OK.

How to add an EPIC Source
Complete the following steps to create EPIC sources. Documents received by this source will be routed to Output
Manager.

1. In the Sources tree, right-click the source group (folder) where you want to add sources and click New Source.
This opens the Add Source dialog box.

2. In the Type list, select Epic.
3. Next to Add new devices, enter the number of sources you want to create.

You can create a single Epic source or create multiple Epic sources and configure them simultaneously.
4. Click OK.
5. Configure the general settings.

For multiple source configuration, this is configured on the General tab.
a) Enter the source Name.
b) In the Server list, click the Nuance Output Manager server where the Nuance Output Manager Input Service is

located for this source.
The source does not have to be on the same server as the Nuance Output Manager Input Service.

c) Enter any Comments or Location information for the source.
d) Optional: To change the large source image that displays when configuring a single source, you can click

Select Image and choose the appropriate image file (BMP, JPEG, or PNG).
The selected image will be compressed and scaled to 96x96 pixels. Changing this image will not change the
smaller image that displays or the image that displays in the source tree. To change the image back to the
default, click Reset Image.

6. Configure the Epic settings.

Configuration Method

Single source configuration Use the Epic settings tab.

Multiple source configuration Use the Epic settings (Bulk Configuration) tab.



Output Manager Administration Guide
Version 4.0 SP2

92 © 2016 Nuance Communications, Inc. All rights reserved.

a) Enter a valid Folder.
You can click the browse button (...) to display the Browse for Folder dialog box and select or create a folder.

b) Select whether to Scan Subfolders.
c) Specify the scan Interval in seconds.
d) Specify the order that documents are copied to Output Manager.

• Unspecified
• Alphabetical
• Time

e) For Disposition, specify what to do with documents in the source folder after they have been copied to Output
Manager.

• Delete
• Leave
• Move
• Move/Overwrite

f) For Move or Move/Overwrite, specify the destination folder.
You can click the browse button (...) to display the Browse for Folder dialog box and select or create a folder.

g) Specify the location of the EPS Binaries.
You can click the browse button (...) to display the Browse for Folder dialog box and select the folder where
EPS binaries are located.

h) Specify the location of the EPS Incoming.
You can click the browse button (...) to display the Browse for Folder dialog box and select the folder where
EPS scans for incoming documents.

i) You can select whether to convert ERTF formatted documents to PDF.
7. Configure filters depending on the source configuration.

Configuration Method

Single source configuration Use the Filters tab. The filter column lists the filter
criteria.

You can modify the filter values by typing directly in
the Regular Express Value column. Wild card values
of ? or * are accepted as long as the expression's first
character is a numeric or alphabetic character. This
filter will be applied to each document received by the
selected source. Click Regular Expression Tester to
verify the expression syntax is valid.

Multiple source configuration Use the Filters (Bulk Configuration) tab. Sources are c
onfigured in grid format on each tab page. The sources
you choose to create are displayed as rows in the grids
. The configuration options are listed as the column he
adings.

8. Configure the document properties that will be applied to all documents received by the source.
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Configuration Method

Single source configuration Use the Document properties tab.

Multiple source configuration Use the Document properties (Bulk Configuration) ta
b.

Determine if you want to use advanced document properties. Advanced document properties facilitate the setting
of document properties from multiple sources. This is a complex feature that only advanced users and professional
service engineers should configure.

To Do this

Use advanced document properties Select Use advanced document properties. This
enables the advanced document properties profile
list. Select the default profile or an existing profile.
To configure document profiles, see the Configuring
document property profiles topic.

Not use advanced document properties If you do not want to use advanced document
properties, leave the check box disabled and configure
the following:

• Select the Document owner. This user will be the
owner of all documents received using this source.
Click the browse button (...) to select a user.

• Configure the document properties by entering
property values directly in the grid. All of the
available property values are listed and grouped
into categories. Expand the appropriate category
by clicking the arrow next to the category name.
The first node level in the category determines
the print preferences for the properties it contains.
On the print preference node, click in the Mode
column and configure how the property should be
applied when a document is sent to a destination.
Select Always Apply to always apply the specified
property value. Select Informational Only to use
the value for informational purposes only. In the
Value column, click in the grid cell to specify the
document property value.

Important:  This can only be configured
during single source configuration.

9. Configure the following configuration settings.

Configuration Method

Single source configuration Use the More settings tab.

Multiple source configuration Use the More settings (Bulk Configuration) tab.
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a) Determine if you want all documents received by this source to be in the Hold state as they enter the Output
Manager Console.
This option is disabled by default.

b) Determine if you want to disable business rule processing for all documents received by this source as they
enter the Output Manager Console.
This option is disabled by default.

c) Use the following options to determine if you want to analyze documents as they are received by a source and
enter the Output Manager Console.
Selecting these options may cause performance degradation. These options are disabled by default.

Option Description

Use quick page counting for PDF documents Enables optimized page counting for PDF jobs. Wh
en this option is enabled, the Count pages, Detect
color, Detect data type, Detect duplex, and Detect
trays options are disabled.

Count pages Performs a page count on all documents received by t
his source.

Detect data type Detects the data type on all documents received by th
is source. The data type will display in the Document
s grid Data Type column.

Detect trays Determines the document paper tray that will print th
e document. This will display in the Documents grid
Input Bin or Output Bin column. You can configure
the Output Bin column to display by using the Admi
nistration Configure Document Properties Utility.

Detect color Detects if the documents received by this source cont
ain color. The Documents grid Color column display
s True or False depending if color is detected.

Detect duplex Detects if the documents received by this source are
configured for duplex printing (that is, printing on b
oth sides of the paper). The Documents grid Duplex
column displays how the document will print, One
Sided, Two Sided Short Edge, or Two Sided Long
Edge.

d) Select the file store that will be used for all documents received by this source as they enter Output Manager .
The default file store is selected by default. Administrators define file stores and select the default in the Set
General Preferences Utility. If the default file store is changed in the Set General Preferences Utility, all
sources using the default will be automatically updated.

e) Assign a document folder for all documents received by this source as they enter the Output Manager Console.
The default document folder is Un-Filed Documents.

f) To create profiles and enter costs associated with printing, select the Advanced Costing Profiles check box.
If you do not select this option, you can specify only the cost per page for printing.

g) Determine if you want to send a notification when a document arrives, prints successfully, prints on failover
destination, or is in error state.
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The notification can be sent as an email message or pop-up. You can select an existing profile in the list or
create one from the Notification Profile dialog box.

• To create a profile during single source configuration, click New.
• To create during multiple source configuration, click the browse button (...).

10. Configure the following output settings.

Configuration Method

Single source configuration Use the Output settings tab.

Multiple source configuration Use the Output settings (Bulk Configuration) tab.

a) Use the Schedule output option to specify the date and time all documents received by this source will print.
You can choose to print the documents today, on a specific day, or in the future. You can also choose to print as
soon as possible, at a specific time, or in the future.

b) Use the Route to destination option to specify a destination where all documents received by this source can
be routed.
Click the browse button (...) to select one or more destinations in the tree. Use the Shift and Ctrl keys to select
multiple destinations. Destination groups cannot be selected. This option is set to Unrouted by default.

c) To override the default retain settings for all documents received by this source select the Override default
retain settings check box and configure the retain options as necessary.

d) Select the appropriate output process.
Output processes can be created to impact documents as they are being sent to a destination. The processes
contain a set of actions which could be used for search and replace, setting finishing options, editing PJL
commands, inserting overlays, and so on. You can select an existing process in the list or create one using the
Process Designer. To create a process during single source configuration, click New. To create during multiple
source configuration, click the browse button (...).

e) Select the appropriate failover profile.
Failover profiles specify what should happen to documents when they are sent to inaccessible destinations
(they are not able to receive documents). You can select an existing profile in the list or create one from the
Failover Profile dialog box. To create a profile during single source configuration, click New. To create
during multiple source configuration, click the browse button (...).

11. Click OK.

How to add an FTP Source
Complete this procedure to create FTP sources. Documents received by the specified FTP server will be routed to
Nuance Output Manager.

1. In the Sources tree, right-click the source group (folder) where you want to add sources and click New Source.
This opens the Add Source dialog box.

2. In the Type list, select FTP.
3. Next to Add new devices enter the number of sources you want to create.

You can create a single FTP source or create multiple FTP sources and configure them simultaneously.
4. Click OK.
5. Configure the general settings.

For multiple source configuration, this is configured on the General tab.
a) Enter the source Name.
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b) In the Server list, click the Nuance Output Manager server where the Nuance Output Manager Input Service is
located for this source.
The source does not have to be on the same server as the Nuance Output Manager Input Service.

c) Enter any Comments or Location information for the source.
d) Optional: To change the large source image that displays when configuring a single source, you can click

Select Image and choose the appropriate image file (BMP, JPEG, or PNG).
The selected image will be compressed and scaled to 96x96 pixels. Changing this image will not change the
smaller image that displays or the image that displays in the source tree. To change the image back to the
default, click Reset Image.

6. Configure the FTP settings.

Configuration Method

Single source configuration Use the FTP settings tab.

Multiple source configuration Use the FTP settings (Bulk Configuration) tab.

a) Enter a valid FTP server.
This can be a FTP address or IP address.

b) Enter the Port number on which the FTP host uses to communicate with clients.
The port number must be from 1 through 65536. The default value is 21.

c) Choose if you want to Use passive mode.
This determines if the host mode will be passive or active. Selecting the check box selects passive mode.
Passive mode is where the client creates a session to receive data. Clearing the check box selects active mode.
Active mode is where the host creates a separate or new session to transfer data in response to a request from
the client.

d) Enter the User name that will be used when logging onto the host.
If the host does not require a user name, you can leave this blank.

e) Enter the Password that will be used when logging onto the host.
If the host does not require a password, you can leave this blank.

f) Enter the FTP folder.
This is the location on the host from where the files will be retrieved when receiving files. You must type
the entire path of the folder or the path relative to the FTP user's home directory. For example, if your home
directory is \FTP\UserName, you can specify either \FTP\UserName\MySourceFiles or \MySourceFiles.

g) Choose if you want to Scan subfolders of the specified FTP folder.
h) Choose if you want to Remove subfolders.

This will delete the subfolders within the FTP folder after the files have been transferred into Output Manager.
i) Specify the time Interval for checking the host for documents.

The default value is 60.
j) Specify the Temp folder location where files are transferred into during the FTP session.

When a session is complete, the files are put in the file store.
7. Configure filters depending on the source configuration.

Configuration Method

Single source configuration Use the Filters tab. The filter column lists the filter
criteria.
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Configuration Method

You can modify the filter values by typing directly in
the Regular Express Value column. Wild card values
of ? or * are accepted as long as the expression's first
character is a numeric or alphabetic character. This
filter will be applied to each document received by the
selected source. Click Regular Expression Tester to
verify the expression syntax is valid.

Multiple source configuration Use the Filters (Bulk Configuration) tab. Sources are c
onfigured in grid format on each tab page. The sources
you choose to create are displayed as rows in the grids
. The configuration options are listed as the column he
adings.

8. Configure the document properties that will be applied to all documents received by the source.

Configuration Method

Single source configuration Use the Document properties tab.

Multiple source configuration Use the Document properties (Bulk Configuration) ta
b.

Determine if you want to use advanced document properties. Advanced document properties facilitate the setting
of document properties from multiple sources. This is a complex feature that only advanced users and professional
service engineers should configure.

To Do this

Use advanced document properties Select Use advanced document properties. This
enables the advanced document properties profile
list. Select the default profile or an existing profile.
To configure document profiles, see the Configuring
document property profiles topic.

Not use advanced document properties If you do not want to use advanced document
properties, leave the check box disabled and configure
the following:

• Select the Document owner. This user will be the
owner of all documents received using this source.
Click the browse button (...) to select a user.

• Configure the document properties by entering
property values directly in the grid. All of the
available property values are listed and grouped
into categories. Expand the appropriate category
by clicking the arrow next to the category name.
The first node level in the category determines
the print preferences for the properties it contains.
On the print preference node, click in the Mode
column and configure how the property should be
applied when a document is sent to a destination.
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To Do this
Select Always Apply to always apply the specified
property value. Select Informational Only to use
the value for informational purposes only. In the
Value column, click in the grid cell to specify the
document property value.

Important:  This can only be configured
during single source configuration.

9. Configure the following configuration settings.

Configuration Method

Single source configuration Use the More settings tab.

Multiple source configuration Use the More settings (Bulk Configuration) tab.

a) Determine if you want all documents received by this source to be in the Hold state as they enter the Output
Manager Console.
This option is disabled by default.

b) Determine if you want to disable business rule processing for all documents received by this source as they
enter the Output Manager Console.
This option is disabled by default.

c) Use the following options to determine if you want to analyze documents as they are received by a source and
enter the Output Manager Console.
Selecting these options may cause performance degradation. These options are disabled by default.

Option Description

Use quick page counting for PDF documents Enables optimized page counting for PDF jobs. Wh
en this option is enabled, the Count pages, Detect
color, Detect data type, Detect duplex, and Detect
trays options are disabled.

Count pages Performs a page count on all documents received by t
his source.

Detect data type Detects the data type on all documents received by th
is source. The data type will display in the Document
s grid Data Type column.

Detect trays Determines the document paper tray that will print th
e document. This will display in the Documents grid
Input Bin or Output Bin column. You can configure
the Output Bin column to display by using the Admi
nistration Configure Document Properties Utility.

Detect color Detects if the documents received by this source cont
ain color. The Documents grid Color column display
s True or False depending if color is detected.

Detect duplex Detects if the documents received by this source are
configured for duplex printing (that is, printing on b
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Option Description

oth sides of the paper). The Documents grid Duplex
column displays how the document will print, One
Sided, Two Sided Short Edge, or Two Sided Long
Edge.

d) Select the file store that will be used for all documents received by this source as they enter the Output
Manager Console.
The default file store is selected by default. Administrators define file stores and select the default in the Set
General Preferences Utility. If the default file store is changed in the Set General Preferences Utility, all
sources using the default will be automatically updated.

e) Assign a document folder for all documents received by this source as they enter the Output Manager Console.
The default document folder is Un-Filed Documents.

f) To create profiles and enter costs associated with printing, select the Advanced Costing Profiles check box.
If you do not select this option, you can specify only the cost per page for printing.

g) Determine if you want to send a notification when a document arrives, prints successfully, prints on failover
destination, or is in error state.
The notification can be sent as an email message or pop-up. You can select an existing profile in the list or
create one from the Notification Profile dialog box.

• To create a profile during single source configuration, click New.
• To create during multiple source configuration, click the browse button (...).

10. Configure the following output settings.

Configuration Method

Single source configuration Use the Output settings tab.

Multiple source configuration Use the Output settings (Bulk Configuration) tab.

a) Use the Schedule output option to specify the date and time all documents received by this source will print.
You can choose to print the documents today, on a specific day, or in the future. You can also choose to print as
soon as possible, at a specific time, or in the future.

b) Use the Route to destination option to specify a destination where all documents received by this source can
be routed.
Click the browse button (...) to select one or more destinations in the tree. Use the Shift and Ctrl keys to select
multiple destinations. Destination groups cannot be selected. This option is set to Unrouted by default.

c) To override the default retain settings for all documents received by this source select the Override default
retain settings check box and configure the retain options as necessary.

d) Select the appropriate output process.
Output processes can be created to impact documents as they are being sent to a destination. The processes
contain a set of actions which could be used for search and replace, setting finishing options, editing PJL
commands, inserting overlays, and so on. You can select an existing process in the list or create one using the
Process Designer. To create a process during single source configuration, click New. To create during multiple
source configuration, click the browse button (...).

e) Select the appropriate failover profile.
Failover profiles specify what should happen to documents when they are sent to inaccessible destinations
(they are not able to receive documents). You can select an existing profile in the list or create one from the
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Failover Profile dialog box. To create a profile during single source configuration, click New. To create
during multiple source configuration, click the browse button (...).

11. Click OK.

How to add an IPP Source
Complete this procedure to create IPP (Internet Printing Protocol) connection sources. Documents received by this
source will be routed to Nuance Output Manager.

1. In the Sources tree, right-click the source group (folder) where you want to add sources and click New Source.
This opens the Add Source dialog box.

2. In the Type list, select IPP.
3. Next to Add new devices enter the number of sources you want to create.

You can create a single IPP source or create multiple IPP sources and configure them simultaneously.
4. Click OK.
5. Configure the general settings.

For multiple source configuration, this is configured on the General tab.
a) Enter the source Name.
b) In the Server list, click the Nuance Output Manager server where the Nuance Output Manager Input Service is

located for this source.
The source does not have to be on the same server as the Nuance Output Manager Input Service.

c) Enter any Comments or Location information for the source.
d) Optional: To change the large source image that displays when configuring a single source, you can click

Select Image and choose the appropriate image file (BMP, JPEG, or PNG).
The selected image will be compressed and scaled to 96x96 pixels. Changing this image will not change the
smaller image that displays or the image that displays in the source tree. To change the image back to the
default, click Reset Image.

6. Configure the IPP settings.

Source Displays

Single source configuration Use the IPP settings tab.

Multiple source configuration Use the IPP settings (Bulk Configuration) tab.

a) Enter the Port number.
The default value is 631.

b) Enter the IP address on the local system where the socket device will receive documents.
In most cases, this can be left blank given that most systems have only one IP address. For systems that have
multiple network adapters or support multiple IP addresses, the IP address entered here specifies the IP address
for the appropriate port.

c) Enter the Instance name.
This identifies the source address and extends the connection URL.

7. Configure the document properties that will be applied to all documents received by the source.

Configuration Method

Single source configuration Use the Document properties tab.
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Configuration Method

Multiple source configuration Use the Document properties (Bulk Configuration) ta
b.

Determine if you want to use advanced document properties. Advanced document properties facilitate the setting
of document properties from multiple sources. This is a complex feature that only advanced users and professional
service engineers should configure.

To Do this

Use advanced document properties Select Use advanced document properties. This
enables the advanced document properties profile
list. Select the default profile or an existing profile.
To configure document profiles, see the Configuring
document property profiles topic.

Not use advanced document properties If you do not want to use advanced document
properties, leave the check box disabled and configure
the following:

• Select the Document owner. This user will be the
owner of all documents received using this source.
Click the browse button (...) to select a user.

• Configure the document properties by entering
property values directly in the grid. All of the
available property values are listed and grouped
into categories. Expand the appropriate category
by clicking the arrow next to the category name.
The first node level in the category determines
the print preferences for the properties it contains.
On the print preference node, click in the Mode
column and configure how the property should be
applied when a document is sent to a destination.
Select Always Apply to always apply the specified
property value. Select Informational Only to use
the value for informational purposes only. In the
Value column, click in the grid cell to specify the
document property value.

Important:  This can only be configured
during single source configuration.

8. Configure the following configuration settings.

Configuration Method

Single source configuration Use the More settings tab.

Multiple source configuration Use the More settings (Bulk Configuration) tab.

a) Determine if you want all documents received by this source to be in the Hold state as they enter the Output
Manager Console.
This option is disabled by default.
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b) Determine if you want to disable business rule processing for all documents received by this source as they
enter the Output Manager Console.
This option is disabled by default.

c) Use the following options to determine if you want to analyze documents as they are received by a source and
enter the Output Manager Console.
Selecting these options may cause performance degradation. These options are disabled by default.

Option Description

Use quick page counting for PDF documents Enables optimized page counting for PDF jobs. Wh
en this option is enabled, the Count pages, Detect
color, Detect data type, Detect duplex, and Detect
trays options are disabled.

Count pages Performs a page count on all documents received by t
his source.

Detect data type Detects the data type on all documents received by th
is source. The data type will display in the Document
s grid Data Type column.

Detect trays Determines the document paper tray that will print th
e document. This will display in the Documents grid
Input Bin or Output Bin column. You can configure
the Output Bin column to display by using the Admi
nistration Configure Document Properties Utility.

Detect color Detects if the documents received by this source cont
ain color. The Documents grid Color column display
s True or False depending if color is detected.

Detect duplex Detects if the documents received by this source are
configured for duplex printing (that is, printing on b
oth sides of the paper). The Documents grid Duplex
column displays how the document will print, One
Sided, Two Sided Short Edge, or Two Sided Long
Edge.

d) Select the file store that will be used for all documents received by this source as they enter the Output
Manager Console.
The default file store is selected by default. Administrators define file stores and select the default in the Set
General Preferences Utility. If the default file store is changed in the Set General Preferences Utility, all
sources using the default will be automatically updated.

e) Assign a document folder for all documents received by this source as they enter the Output Manager Console.
The default document folder is Un-Filed Documents.

f) To create profiles and enter costs associated with printing, select the Advanced Costing Profiles check box.
If you do not select this option, you can specify only the cost per page for printing.

g) Determine if you want to send a notification when a document arrives, prints successfully, prints on failover
destination, or is in error state.
The notification can be sent as an email message or pop-up. You can select an existing profile in the list or
create one from the Notification Profile dialog box.

• To create a profile during single source configuration, click New.



Output Manager Administration Guide
Version 4.0 SP2

103 © 2016 Nuance Communications, Inc. All rights reserved.

• To create during multiple source configuration, click the browse button (...).
9. Configure the following output settings.

Configuration Method

Single source configuration Use the Output settings tab.

Multiple source configuration Use the Output settings (Bulk Configuration) tab.

a) Use the Schedule output option to specify the date and time all documents received by this source will print.
You can choose to print the documents today, on a specific day, or in the future. You can also choose to print as
soon as possible, at a specific time, or in the future.

b) Use the Route to destination option to specify a destination where all documents received by this source can
be routed.
Click the browse button (...) to select one or more destinations in the tree. Use the Shift and Ctrl keys to select
multiple destinations. Destination groups cannot be selected. This option is set to Unrouted by default.

c) To override the default retain settings for all documents received by this source select the Override default
retain settings check box and configure the retain options as necessary.

d) Select the appropriate output process.
Output processes can be created to impact documents as they are being sent to a destination. The processes
contain a set of actions which could be used for search and replace, setting finishing options, editing PJL
commands, inserting overlays, and so on. You can select an existing process in the list or create one using the
Process Designer. To create a process during single source configuration, click New. To create during multiple
source configuration, click the browse button (...).

e) Select the appropriate failover profile.
Failover profiles specify what should happen to documents when they are sent to inaccessible destinations
(they are not able to receive documents). You can select an existing profile in the list or create one from the
Failover Profile dialog box. To create a profile during single source configuration, click New. To create
during multiple source configuration, click the browse button (...).

10. Click OK.

How to add an LPD Source
Complete this procedure to create LPD connection sources. Documents received by this source will be routed to
Nuance Output Manager.

1. In the Sources tree, right-click the source group (folder) where you want to add sources and click New Source.
This opens the Add Source dialog box.

2. In the Type list, select LPD.
3. Next to Add new devices, enter the number of sources you want to create.

You can create a single LPD source or create multiple LPD sources and configure them simultaneously.
4. Click OK.
5. Configure the general settings.

For multiple source configuration, this is configured on the General tab.
a) Enter the source Name.
b) In the Server list, click the Nuance Output Manager server where the Nuance Output Manager Input Service is

located for this source.
The source does not have to be on the same server as the Nuance Output Manager Input Service.
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c) Enter any Comments or Location information for the source.
d) Optional: To change the large source image that displays when configuring a single source, you can click

Select Image and choose the appropriate image file (BMP, JPEG, or PNG).
The selected image will be compressed and scaled to 96x96 pixels. Changing this image will not change the
smaller image that displays or the image that displays in the source tree. To change the image back to the
default, click Reset Image.

6. Configure the LPD settings.

Configuration Method

Single source configuration Use the LPD settings tab.

Multiple source configuration Use the LPD settings (Bulk Configuration) tab.

a) Enter the Port number for the host.
The default value is 515.

b) Enter the IP address for the host.
c) In the Default queue list, click the queue which will process all requests made to unrecognized queues.

All defined LPD queues are listed.
d) Specify the Temp folder location where files are transferred into during the LPD session.

When a session is complete, the files are put in the file store.
7. Configure the LPD queues.

The LPD queues table lists all defined LPD queues. Select or clear check boxes in the Enabled column to enable
or disable the LPD queues. To create a new LPD queue, click Add and complete the following steps from the
LPD queue settings tab.
For multiple source configuration, this is configured by clicking on the browse button ....
a) Specify the Queue name.
b) Determine the selections for the following check box options:

Option Description

Enabled Determines if the queue is available to receive docum
ents. This option is selected by default.

Allow Restart Accepts or rejects the restart command to reset a parti
cular queue. This option is selected by default.

Allow LPQ Determines if the LPQ command line can be used to
view the print queue for your current login name.

Allow LPRM Determines if the LPRM command line can be used t
o remove files in the print queue that were submitted
under your current login name.

How to add a Mobile Server source
Complete this procedure to create Mobile Server sources. Documents received by this source will be routed to Nuance
Output Manager.

1. In the Sources tree, right-click the source group (folder) where you want to add sources and click New Source.
This opens the Add Source dialog box.
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2. In the Type list, select Mobile Server.
3. Next to Add new devices enter the number of sources you want to create.

You can create a single Mobile Server source or create multiple Mobile Server sources and configure them
simultaneously.

4. Click OK.
5. Configure the general settings.

For multiple source configuration, this is configured on the General tab.
a) Enter the source Name.
b) In the Server list, click the Nuance Output Manager server where the Nuance Output Manager Input Service is

located for this source.
The source does not have to be on the same server as the Nuance Output Manager Input Service.

c) Enter any Comments or Location information for the source.
d) Optional: To change the large source image that displays when configuring a single source, you can click

Select Image and choose the appropriate image file (BMP, JPEG, or PNG).
The selected image will be compressed and scaled to 96x96 pixels. Changing this image will not change the
smaller image that displays or the image that displays in the source tree. To change the image back to the
default, click Reset Image.

6. Configure the document properties that will be applied to all documents received by the source.

Configuration Method

Single source configuration Use the Document properties tab.

Multiple source configuration Use the Document properties (Bulk Configuration) ta
b.

Determine if you want to use advanced document properties. Advanced document properties facilitate the setting
of document properties from multiple sources. This is a complex feature that only advanced users and professional
service engineers should configure.

To Do this

Use advanced document properties Select Use advanced document properties. This
enables the advanced document properties profile
list. Select the default profile or an existing profile.
To configure document profiles, see the Configuring
document property profiles topic.

Not use advanced document properties If you do not want to use advanced document
properties, leave the check box disabled and configure
the following:

• Select the Document owner. This user will be the
owner of all documents received using this source.
Click the browse button (...) to select a user.

• Configure the document properties by entering
property values directly in the grid. All of the
available property values are listed and grouped
into categories. Expand the appropriate category
by clicking the arrow next to the category name.
The first node level in the category determines
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To Do this
the print preferences for the properties it contains.
On the print preference node, click in the Mode
column and configure how the property should be
applied when a document is sent to a destination.
Select Always Apply to always apply the specified
property value. Select Informational Only to use
the value for informational purposes only. In the
Value column, click in the grid cell to specify the
document property value.

Important:  This can only be configured
during single source configuration.

7. Configure the following configuration settings.

Configuration Method

Single source configuration Use the More settings tab.

Multiple source configuration Use the More settings (Bulk Configuration) tab.

a) Determine if you want all documents received by this source to be in the Hold state as they enter the Output
Manager Console.
This option is disabled by default.

b) Determine if you want to disable business rule processing for all documents received by this source as they
enter the Output Manager Console.
This option is disabled by default.

c) Use the following options to determine if you want to analyze documents as they are received by a source and
enter the Output Manager Console.
Selecting these options may cause performance degradation. These options are disabled by default.

Option Description

Use quick page counting for PDF documents Enables optimized page counting for PDF jobs. Wh
en this option is enabled, the Count pages, Detect
color, Detect data type, Detect duplex, and Detect
trays options are disabled.

Count pages Performs a page count on all documents received by t
his source.

Detect data type Detects the data type on all documents received by th
is source. The data type will display in the Document
s grid Data Type column.

Detect trays Determines the document paper tray that will print th
e document. This will display in the Documents grid
Input Bin or Output Bin column. You can configure
the Output Bin column to display by using the Admi
nistration Configure Document Properties Utility.
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Option Description

Detect color Detects if the documents received by this source cont
ain color. The Documents grid Color column display
s True or False depending if color is detected.

Detect duplex Detects if the documents received by this source are
configured for duplex printing (that is, printing on b
oth sides of the paper). The Documents grid Duplex
column displays how the document will print, One
Sided, Two Sided Short Edge, or Two Sided Long
Edge.

d) Select the file store that will be used for all documents received by this source as they enter the Output
Manager Console.
The default file store is selected by default. Administrators define file stores and select the default in the Set
General Preferences Utility. If the default file store is changed in the Set General Preferences Utility, all
sources using the default will be automatically updated.

e) Assign a document folder for all documents received by this source as they enter the Output Manager Console.
The default document folder is Un-Filed Documents.

f) To create profiles and enter costs associated with printing, select the Advanced Costing Profiles check box.
If you do not select this option, you can specify only the cost per page for printing.

g) Determine if you want to send a notification when a document arrives, prints successfully, prints on failover
destination, or is in error state.
The notification can be sent as an email message or pop-up. You can select an existing profile in the list or
create one from the Notification Profile dialog box.

• To create a profile during single source configuration, click New.
• To create during multiple source configuration, click the browse button (...).

8. Configure the following output settings.

Configuration Method

Single source configuration Use the Output settings tab.

Multiple source configuration Use the Output settings (Bulk Configuration) tab.

a) Use the Schedule output option to specify the date and time all documents received by this source will print.
You can choose to print the documents today, on a specific day, or in the future. You can also choose to print as
soon as possible, at a specific time, or in the future.

b) Use the Route to destination option to specify a destination where all documents received by this source can
be routed.
Click the browse button (...) to select one or more destinations in the tree. Use the Shift and Ctrl keys to select
multiple destinations. Destination groups cannot be selected. This option is set to Unrouted by default.

c) To override the default retain settings for all documents received by this source select the Override default
retain settings check box and configure the retain options as necessary.

d) Select the appropriate output process.
Output processes can be created to impact documents as they are being sent to a destination. The processes
contain a set of actions which could be used for search and replace, setting finishing options, editing PJL
commands, inserting overlays, and so on. You can select an existing process in the list or create one using the
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Process Designer. To create a process during single source configuration, click New. To create during multiple
source configuration, click the browse button (...).

e) Select the appropriate failover profile.
Failover profiles specify what should happen to documents when they are sent to inaccessible destinations
(they are not able to receive documents). You can select an existing profile in the list or create one from the
Failover Profile dialog box. To create a profile during single source configuration, click New. To create
during multiple source configuration, click the browse button (...).

9. Click OK.

How to add a NetWeaver source
Complete this procedure to create NetWeaver sources. Documents received by this source will be routed to Nuance
Output Manager.

1. In the Sources tree, right-click the source group (folder) where you want to add sources and click New Source.
This opens the Add Source dialog box.

2. In the Type list, select NetWeaver.
3. Next to Add new devices enter the number of sources you want to create.

You can create a single NetWeaver source or create multiple NetWeaver sources and configure them
simultaneously.

4. Click OK.
5. Configure the general settings.

For multiple source configuration, this is configured on the General tab.
a) Enter the source Name.
b) In the Server list, click the Nuance Output Manager server where the Nuance Output Manager Input Service is

located for this source.
The source does not have to be on the same server as the Nuance Output Manager Input Service.

c) Enter any Comments or Location information for the source.
d) Optional: To change the large source image that displays when configuring a single source, you can click

Select Image and choose the appropriate image file (BMP, JPEG, or PNG).
The selected image will be compressed and scaled to 96x96 pixels. Changing this image will not change the
smaller image that displays or the image that displays in the source tree. To change the image back to the
default, click Reset Image.

6. Configure the document properties that will be applied to all documents received by the source.

Configuration Method

Single source configuration Use the Document properties tab.

Multiple source configuration Use the Document properties (Bulk Configuration) ta
b.

Determine if you want to use advanced document properties. Advanced document properties facilitate the setting
of document properties from multiple sources. This is a complex feature that only advanced users and professional
service engineers should configure.

To Do this

Use advanced document properties Select Use advanced document properties. This
enables the advanced document properties profile
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To Do this
list. Select the default profile or an existing profile.
To configure document profiles, see the Configuring
document property profiles topic.

Not use advanced document properties If you do not want to use advanced document
properties, leave the check box disabled and configure
the following:

• Select the Document owner. This user will be the
owner of all documents received using this source.
Click the browse button (...) to select a user.

• Configure the document properties by entering
property values directly in the grid. All of the
available property values are listed and grouped
into categories. Expand the appropriate category
by clicking the arrow next to the category name.
The first node level in the category determines
the print preferences for the properties it contains.
On the print preference node, click in the Mode
column and configure how the property should be
applied when a document is sent to a destination.
Select Always Apply to always apply the specified
property value. Select Informational Only to use
the value for informational purposes only. In the
Value column, click in the grid cell to specify the
document property value.

Important:  This can only be configured
during single source configuration.

7. Configure the following configuration settings.

Configuration Method

Single source configuration Use the More settings tab.

Multiple source configuration Use the More settings (Bulk Configuration) tab.

a) Determine if you want all documents received by this source to be in the Hold state as they enter the Output
Manager Console.
This option is disabled by default.

b) Determine if you want to disable business rule processing for all documents received by this source as they
enter the Output Manager Console.
This option is disabled by default.

c) Use the following options to determine if you want to analyze documents as they are received by a source and
enter the Output Manager Console.
Selecting these options may cause performance degradation. These options are disabled by default.
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Option Description

Use quick page counting for PDF documents Enables optimized page counting for PDF jobs. Wh
en this option is enabled, the Count pages, Detect
color, Detect data type, Detect duplex, and Detect
trays options are disabled.

Count pages Performs a page count on all documents received by t
his source.

Detect data type Detects the data type on all documents received by th
is source. The data type will display in the Document
s grid Data Type column.

Detect trays Determines the document paper tray that will print th
e document. This will display in the Documents grid
Input Bin or Output Bin column. You can configure
the Output Bin column to display by using the Admi
nistration Configure Document Properties Utility.

Detect color Detects if the documents received by this source cont
ain color. The Documents grid Color column display
s True or False depending if color is detected.

Detect duplex Detects if the documents received by this source are
configured for duplex printing (that is, printing on b
oth sides of the paper). The Documents grid Duplex
column displays how the document will print, One
Sided, Two Sided Short Edge, or Two Sided Long
Edge.

d) Select the file store that will be used for all documents received by this source as they enter the Output
Manager Console.
The default file store is selected by default. Administrators define file stores and select the default in the Set
General Preferences Utility. If the default file store is changed in the Set General Preferences Utility, all
sources using the default will be automatically updated.

e) Assign a document folder for all documents received by this source as they enter the Output Manager Console.
The default document folder is Un-Filed Documents.

f) To create profiles and enter costs associated with printing, select the Advanced Costing Profiles check box.
If you do not select this option, you can specify only the cost per page for printing.

g) Determine if you want to send a notification when a document arrives, prints successfully, prints on failover
destination, or is in error state.
The notification can be sent as an email message or pop-up. You can select an existing profile in the list or
create one from the Notification Profile dialog box.

• To create a profile during single source configuration, click New.
• To create during multiple source configuration, click the browse button (...).

8. Configure the following output settings.

Configuration Method

Single source configuration Use the Output settings tab.
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Configuration Method

Multiple source configuration Use the Output settings (Bulk Configuration) tab.

a) Use the Schedule output option to specify the date and time all documents received by this source will print.
You can choose to print the documents today, on a specific day, or in the future. You can also choose to print as
soon as possible, at a specific time, or in the future.

b) Use the Route to destination option to specify a destination where all documents received by this source can
be routed.
Click the browse button (...) to select one or more destinations in the tree. Use the Shift and Ctrl keys to select
multiple destinations. Destination groups cannot be selected. This option is set to Unrouted by default.

c) To override the default retain settings for all documents received by this source select the Override default
retain settings check box and configure the retain options as necessary.

d) Select the appropriate output process.
Output processes can be created to impact documents as they are being sent to a destination. The processes
contain a set of actions which could be used for search and replace, setting finishing options, editing PJL
commands, inserting overlays, and so on. You can select an existing process in the list or create one using the
Process Designer. To create a process during single source configuration, click New. To create during multiple
source configuration, click the browse button (...).

e) Select the appropriate failover profile.
Failover profiles specify what should happen to documents when they are sent to inaccessible destinations
(they are not able to receive documents). You can select an existing profile in the list or create one from the
Failover Profile dialog box. To create a profile during single source configuration, click New. To create
during multiple source configuration, click the browse button (...).

9. Click OK.

How to add a Network Folder source
Complete this procedure to create network folder sources. Documents received by the specified network folder will be
routed to Nuance Output Manager.

1. In the Sources tree, right-click the source group (folder) where you want to add sources and click New Source.
This opens the Add Source dialog box.

2. In the Type list, select Network Folder.
3. Next to Add new devices, enter the number of sources you want to create.

You can create a single network folder or create multiple network folders and configure them simultaneously.
4. Click OK.
5. Configure the general settings.

For multiple source configuration, this is configured on the General tab.
a) Enter the source Name.
b) In the Server list, click the Nuance Output Manager server where the Nuance Output Manager Input Service is

located for this source.
The source does not have to be on the same server as the Nuance Output Manager Input Service.

c) Enter any Comments or Location information for the source.
d) Optional: To change the large source image that displays when configuring a single source, you can click

Select Image and choose the appropriate image file (BMP, JPEG, or PNG).
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The selected image will be compressed and scaled to 96x96 pixels. Changing this image will not change the
smaller image that displays or the image that displays in the source tree. To change the image back to the
default, click Reset Image.

6. Configure the network folder settings.

Source Displays

Single source configuration Use the Folder settings tab.

Multiple source configuration Use the Folder settings (Bulk Configuration) tab.

a) Specify the Folder to be monitored.
Enter the path of the network folder. For the specified folder, you must configure the Output Manager Service
logon account user name to have Full Control sharing permissions. Also, verify that the Administrators
group has Full Control security permissions. Right-click the folder and click Sharing and Security to
configure these options.

b) Select the Scan subfolders check box to specify that the subfolders must be scanned.
c) Specify the Interval for checking the folder for files.
d) From the Order drop-down list box, specify the order in which Nuance Output Manager receives files from

the network folder.
e) Select the Disposition.

This will determine what will happen to the original file after it is sent to the Output Manager Console. You
can choose to Delete, Leave, Move or Move/Overwrite.

f) If you selected Move or Move/Overwrite as the file Disposition, in the Move to field, enter the folder path
where the file will be moved.

7. Configure filters depending on the source configuration.

Configuration Method

Single source configuration Use the Filters tab. The filter column lists the filter
criteria.

You can modify the filter values by typing directly in
the Regular Express Value column. Wild card values
of ? or * are accepted as long as the expression's first
character is a numeric or alphabetic character. This
filter will be applied to each document received by the
selected source. Click Regular Expression Tester to
verify the expression syntax is valid.

Multiple source configuration Use the Filters (Bulk Configuration) tab. Sources are c
onfigured in grid format on each tab page. The sources
you choose to create are displayed as rows in the grids
. The configuration options are listed as the column he
adings.

8. Configure the document properties that will be applied to all documents received by the source.

Configuration Method

Single source configuration Use the Document properties tab.
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Configuration Method

Multiple source configuration Use the Document properties (Bulk Configuration) ta
b.

Determine if you want to use advanced document properties. Advanced document properties facilitate the setting
of document properties from multiple sources. This is a complex feature that only advanced users and professional
service engineers should configure.

To Do this

Use advanced document properties Select Use advanced document properties. This
enables the advanced document properties profile
list. Select the default profile or an existing profile.
To configure document profiles, see the Configuring
document property profiles topic.

Not use advanced document properties If you do not want to use advanced document
properties, leave the check box disabled and configure
the following:

• Select the Document owner. This user will be the
owner of all documents received using this source.
Click the browse button (...) to select a user.

• Configure the document properties by entering
property values directly in the grid. All of the
available property values are listed and grouped
into categories. Expand the appropriate category
by clicking the arrow next to the category name.
The first node level in the category determines
the print preferences for the properties it contains.
On the print preference node, click in the Mode
column and configure how the property should be
applied when a document is sent to a destination.
Select Always Apply to always apply the specified
property value. Select Informational Only to use
the value for informational purposes only. In the
Value column, click in the grid cell to specify the
document property value.

Important:  This can only be configured
during single source configuration.

9. Configure the following configuration settings.

Configuration Method

Single source configuration Use the More settings tab.

Multiple source configuration Use the More settings (Bulk Configuration) tab.

a) Determine if you want all documents received by this source to be in the Hold state as they enter the Output
Manager Console.
This option is disabled by default.
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b) Determine if you want to disable business rule processing for all documents received by this source as they
enter the Output Manager Console.
This option is disabled by default.

c) Use the following options to determine if you want to analyze documents as they are received by a source and
enter the Output Manager Console.
Selecting these options may cause performance degradation. These options are disabled by default.

Option Description

Use quick page counting for PDF documents Enables optimized page counting for PDF jobs. Wh
en this option is enabled, the Count pages, Detect
color, Detect data type, Detect duplex, and Detect
trays options are disabled.

Count pages Performs a page count on all documents received by t
his source.

Detect data type Detects the data type on all documents received by th
is source. The data type will display in the Document
s grid Data Type column.

Detect trays Determines the document paper tray that will print th
e document. This will display in the Documents grid
Input Bin or Output Bin column. You can configure
the Output Bin column to display by using the Admi
nistration Configure Document Properties Utility.

Detect color Detects if the documents received by this source cont
ain color. The Documents grid Color column display
s True or False depending if color is detected.

Detect duplex Detects if the documents received by this source are
configured for duplex printing (that is, printing on b
oth sides of the paper). The Documents grid Duplex
column displays how the document will print, One
Sided, Two Sided Short Edge, or Two Sided Long
Edge.

d) Select the file store that will be used for all documents received by this source as they enter the Output
Manager Console.
The default file store is selected by default. Administrators define file stores and select the default in the Set
General Preferences Utility. If the default file store is changed in the Set General Preferences Utility, all
sources using the default will be automatically updated.

e) Assign a document folder for all documents received by this source as they enter the Output Manager Console.
The default document folder is Un-Filed Documents.

f) To create profiles and enter costs associated with printing, select the Advanced Costing Profiles check box.
If you do not select this option, you can specify only the cost per page for printing.

g) Determine if you want to send a notification when a document arrives, prints successfully, prints on failover
destination, or is in error state.
The notification can be sent as an email message or pop-up. You can select an existing profile in the list or
create one from the Notification Profile dialog box.

• To create a profile during single source configuration, click New.
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• To create during multiple source configuration, click the browse button (...).
10. Configure the following output settings.

Configuration Method

Single source configuration Use the Output settings tab.

Multiple source configuration Use the Output settings (Bulk Configuration) tab.

a) Use the Schedule output option to specify the date and time all documents received by this source will print.
You can choose to print the documents today, on a specific day, or in the future. You can also choose to print as
soon as possible, at a specific time, or in the future.

b) Use the Route to destination option to specify a destination where all documents received by this source can
be routed.
Click the browse button (...) to select one or more destinations in the tree. Use the Shift and Ctrl keys to select
multiple destinations. Destination groups cannot be selected. This option is set to Unrouted by default.

c) To override the default retain settings for all documents received by this source select the Override default
retain settings check box and configure the retain options as necessary.

d) Select the appropriate output process.
Output processes can be created to impact documents as they are being sent to a destination. The processes
contain a set of actions which could be used for search and replace, setting finishing options, editing PJL
commands, inserting overlays, and so on. You can select an existing process in the list or create one using the
Process Designer. To create a process during single source configuration, click New. To create during multiple
source configuration, click the browse button (...).

e) Select the appropriate failover profile.
Failover profiles specify what should happen to documents when they are sent to inaccessible destinations
(they are not able to receive documents). You can select an existing profile in the list or create one from the
Failover Profile dialog box. To create a profile during single source configuration, click New. To create
during multiple source configuration, click the browse button (...).

11. Click OK.

How to add an Output Manager source
Complete this procedure to create Nuance Output Manager sources. Documents received by this source will be routed
to Nuance Output Manager.

1. In the Sources tree, right-click the source group (folder) where you want to add sources and click New Source.
This opens the Add Source dialog box.

2. In the Type list, select OM.
3. Next to Add new devices, enter the number of sources you want to create.

You can create a single Nuance Output Manager source or create multiple Nuance Output Manager sources and
configure them simultaneously.

4. Click OK.
5. Configure the general settings.

For multiple source configuration, this is configured on the General tab.
a) Enter the source Name.
b) In the Server list, click the Nuance Output Manager server where the Nuance Output Manager Input Service is

located for this source.
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The source does not have to be on the same server as the Nuance Output Manager Input Service.
c) Enter any Comments or Location information for the source.
d) Optional: To change the large source image that displays when configuring a single source, you can click

Select Image and choose the appropriate image file (BMP, JPEG, or PNG).
The selected image will be compressed and scaled to 96x96 pixels. Changing this image will not change the
smaller image that displays or the image that displays in the source tree. To change the image back to the
default, click Reset Image.

6. Configure the document properties that will be applied to all documents received by the source.

Configuration Method

Single source configuration Use the Document properties tab.

Multiple source configuration Use the Document properties (Bulk Configuration) ta
b.

Determine if you want to use advanced document properties. Advanced document properties facilitate the setting
of document properties from multiple sources. This is a complex feature that only advanced users and professional
service engineers should configure.

To Do this

Use advanced document properties Select Use advanced document properties. This
enables the advanced document properties profile
list. Select the default profile or an existing profile.
To configure document profiles, see the Configuring
document property profiles topic.

Not use advanced document properties If you do not want to use advanced document
properties, leave the check box disabled and configure
the following:

• Select the Document owner. This user will be the
owner of all documents received using this source.
Click the browse button (...) to select a user.

• Configure the document properties by entering
property values directly in the grid. All of the
available property values are listed and grouped
into categories. Expand the appropriate category
by clicking the arrow next to the category name.
The first node level in the category determines
the print preferences for the properties it contains.
On the print preference node, click in the Mode
column and configure how the property should be
applied when a document is sent to a destination.
Select Always Apply to always apply the specified
property value. Select Informational Only to use
the value for informational purposes only. In the
Value column, click in the grid cell to specify the
document property value.
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To Do this
Important:  This can only be configured
during single source configuration.

7. Configure the following configuration settings.

Configuration Method

Single source configuration Use the More settings tab.

Multiple source configuration Use the More settings (Bulk Configuration) tab.

a) Determine if you want all documents received by this source to be in the Hold state as they enter the Output
Manager Console.
This option is disabled by default.

b) Determine if you want to disable business rule processing for all documents received by this source as they
enter the Output Manager Console.
This option is disabled by default.

c) Use the following options to determine if you want to analyze documents as they are received by a source and
enter the Output Manager Console.
Selecting these options may cause performance degradation. These options are disabled by default.

Option Description

Use quick page counting for PDF documents Enables optimized page counting for PDF jobs. Wh
en this option is enabled, the Count pages, Detect
color, Detect data type, Detect duplex, and Detect
trays options are disabled.

Count pages Performs a page count on all documents received by t
his source.

Detect data type Detects the data type on all documents received by th
is source. The data type will display in the Document
s grid Data Type column.

Detect trays Determines the document paper tray that will print th
e document. This will display in the Documents grid
Input Bin or Output Bin column. You can configure
the Output Bin column to display by using the Admi
nistration Configure Document Properties Utility.

Detect color Detects if the documents received by this source cont
ain color. The Documents grid Color column display
s True or False depending if color is detected.

Detect duplex Detects if the documents received by this source are
configured for duplex printing (that is, printing on b
oth sides of the paper). The Documents grid Duplex
column displays how the document will print, One
Sided, Two Sided Short Edge, or Two Sided Long
Edge.
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d) Select the file store that will be used for all documents received by this source as they enter the Output
Manager Console.
The default file store is selected by default. Administrators define file stores and select the default in the Set
General Preferences Utility. If the default file store is changed in the Set General Preferences Utility, all
sources using the default will be automatically updated.

e) Assign a document folder for all documents received by this source as they enter the Output Manager Console.
The default document folder is Un-Filed Documents.

f) To create profiles and enter costs associated with printing, select the Advanced Costing Profiles check box.
If you do not select this option, you can specify only the cost per page for printing.

g) Determine if you want to send a notification when a document arrives, prints successfully, prints on failover
destination, or is in error state.
The notification can be sent as an email message or pop-up. You can select an existing profile in the list or
create one from the Notification Profile dialog box.

• To create a profile during single source configuration, click New.
• To create during multiple source configuration, click the browse button (...).

8. Configure the following output settings.

Configuration Method

Single source configuration Use the Output settings tab.

Multiple source configuration Use the Output settings (Bulk Configuration) tab.

a) Use the Schedule output option to specify the date and time all documents received by this source will print.
You can choose to print the documents today, on a specific day, or in the future. You can also choose to print as
soon as possible, at a specific time, or in the future.

b) Use the Route to destination option to specify a destination where all documents received by this source can
be routed.
Click the browse button (...) to select one or more destinations in the tree. Use the Shift and Ctrl keys to select
multiple destinations. Destination groups cannot be selected. This option is set to Unrouted by default.

c) To override the default retain settings for all documents received by this source select the Override default
retain settings check box and configure the retain options as necessary.

d) Select the appropriate output process.
Output processes can be created to impact documents as they are being sent to a destination. The processes
contain a set of actions which could be used for search and replace, setting finishing options, editing PJL
commands, inserting overlays, and so on. You can select an existing process in the list or create one using the
Process Designer. To create a process during single source configuration, click New. To create during multiple
source configuration, click the browse button (...).

e) Select the appropriate failover profile.
Failover profiles specify what should happen to documents when they are sent to inaccessible destinations
(they are not able to receive documents). You can select an existing profile in the list or create one from the
Failover Profile dialog box. To create a profile during single source configuration, click New. To create
during multiple source configuration, click the browse button (...).

9. Click OK.
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How to add a Socket Connection source
Complete this procedure to create socket sources. Documents received by this source will be routed to Nuance Output
Manager.

1. In the Sources tree, right-click the source group (folder) where you want to add sources and click New Source.
This opens the Add Source dialog box.

2. In the Type list, select Socket.
3. Next to Add new devices, enter the number of sources you want to create.

You can create a single socket source or create multiple socket sources and configure them simultaneously.
4. Click OK.
5. Configure the general settings.

For multiple source configuration, this is configured on the General tab.
a) Enter the source Name.
b) In the Server list, click the Nuance Output Manager server where the Nuance Output Manager Input Service is

located for this source.
The source does not have to be on the same server as the Nuance Output Manager Input Service.

c) Enter any Comments or Location information for the source.
d) Optional: To change the large source image that displays when configuring a single source, you can click

Select Image and choose the appropriate image file (BMP, JPEG, or PNG).
The selected image will be compressed and scaled to 96x96 pixels. Changing this image will not change the
smaller image that displays or the image that displays in the source tree. To change the image back to the
default, click Reset Image.

6. Configure the socket settings.

Source Displays

Single source configuration Use the Socket settings tab.

Multiple source configuration Use the Socket settings (Bulk Configuration) tab.

a) Enter the Portnumber.
The default value is 9100.

b) Enter the IP address of the local system where the socket device will receive documents.
In most cases, this can be left blank given that most systems have only one IP address. For systems that have
multiple network adapters or support multiple IP addresses, the IP address entered here specifies the IP address
for the appropriate port.

c) Choose if you want to enable Support PJL status readback.
This enables the socket source to emulate two-way printer communications. The print job sender can send PJL
commands that prompt a printer to respond with status information. And if it expects a response, it may wait
until that response arrives before continuing with the job.

7. Configure the document properties that will be applied to all documents received by the source.

Configuration Method

Single source configuration Use the Document properties tab.

Multiple source configuration Use the Document properties (Bulk Configuration) ta
b.
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Determine if you want to use advanced document properties. Advanced document properties facilitate the setting
of document properties from multiple sources. This is a complex feature that only advanced users and professional
service engineers should configure.

To Do this

Use advanced document properties Select Use advanced document properties. This
enables the advanced document properties profile
list. Select the default profile or an existing profile.
To configure document profiles, see the Configuring
document property profiles topic.

Not use advanced document properties If you do not want to use advanced document
properties, leave the check box disabled and configure
the following:

• Select the Document owner. This user will be the
owner of all documents received using this source.
Click the browse button (...) to select a user.

• Configure the document properties by entering
property values directly in the grid. All of the
available property values are listed and grouped
into categories. Expand the appropriate category
by clicking the arrow next to the category name.
The first node level in the category determines
the print preferences for the properties it contains.
On the print preference node, click in the Mode
column and configure how the property should be
applied when a document is sent to a destination.
Select Always Apply to always apply the specified
property value. Select Informational Only to use
the value for informational purposes only. In the
Value column, click in the grid cell to specify the
document property value.

Important:  This can only be configured
during single source configuration.

8. Configure the following configuration settings.

Configuration Method

Single source configuration Use the More settings tab.

Multiple source configuration Use the More settings (Bulk Configuration) tab.

a) Determine if you want all documents received by this source to be in the Hold state as they enter the Output
Manager Console.
This option is disabled by default.

b) Determine if you want to disable business rule processing for all documents received by this source as they
enter the Output Manager Console.
This option is disabled by default.
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c) Use the following options to determine if you want to analyze documents as they are received by a source and
enter the Output Manager Console.
Selecting these options may cause performance degradation. These options are disabled by default.

Option Description

Use quick page counting for PDF documents Enables optimized page counting for PDF jobs. Wh
en this option is enabled, the Count pages, Detect
color, Detect data type, Detect duplex, and Detect
trays options are disabled.

Count pages Performs a page count on all documents received by t
his source.

Detect data type Detects the data type on all documents received by th
is source. The data type will display in the Document
s grid Data Type column.

Detect trays Determines the document paper tray that will print th
e document. This will display in the Documents grid
Input Bin or Output Bin column. You can configure
the Output Bin column to display by using the Admi
nistration Configure Document Properties Utility.

Detect color Detects if the documents received by this source cont
ain color. The Documents grid Color column display
s True or False depending if color is detected.

Detect duplex Detects if the documents received by this source are
configured for duplex printing (that is, printing on b
oth sides of the paper). The Documents grid Duplex
column displays how the document will print, One
Sided, Two Sided Short Edge, or Two Sided Long
Edge.

d) Select the file store that will be used for all documents received by this source as they enter the Output
Manager Console.
The default file store is selected by default. Administrators define file stores and select the default in the Set
General Preferences Utility. If the default file store is changed in the Set General Preferences Utility, all
sources using the default will be automatically updated.

e) Assign a document folder for all documents received by this source as they enter the Output Manager Console.
The default document folder is Un-Filed Documents.

f) To create profiles and enter costs associated with printing, select the Advanced Costing Profiles check box.
If you do not select this option, you can specify only the cost per page for printing.

g) Determine if you want to send a notification when a document arrives, prints successfully, prints on failover
destination, or is in error state.
The notification can be sent as an email message or pop-up. You can select an existing profile in the list or
create one from the Notification Profile dialog box.

• To create a profile during single source configuration, click New.
• To create during multiple source configuration, click the browse button (...).

9. Configure the following output settings.
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Configuration Method

Single source configuration Use the Output settings tab.

Multiple source configuration Use the Output settings (Bulk Configuration) tab.

a) Use the Schedule output option to specify the date and time all documents received by this source will print.
You can choose to print the documents today, on a specific day, or in the future. You can also choose to print as
soon as possible, at a specific time, or in the future.

b) Use the Route to destination option to specify a destination where all documents received by this source can
be routed.
Click the browse button (...) to select one or more destinations in the tree. Use the Shift and Ctrl keys to select
multiple destinations. Destination groups cannot be selected. This option is set to Unrouted by default.

c) To override the default retain settings for all documents received by this source select the Override default
retain settings check box and configure the retain options as necessary.

d) Select the appropriate output process.
Output processes can be created to impact documents as they are being sent to a destination. The processes
contain a set of actions which could be used for search and replace, setting finishing options, editing PJL
commands, inserting overlays, and so on. You can select an existing process in the list or create one using the
Process Designer. To create a process during single source configuration, click New. To create during multiple
source configuration, click the browse button (...).

e) Select the appropriate failover profile.
Failover profiles specify what should happen to documents when they are sent to inaccessible destinations
(they are not able to receive documents). You can select an existing profile in the list or create one from the
Failover Profile dialog box. To create a profile during single source configuration, click New. To create
during multiple source configuration, click the browse button (...).

10. Click OK.

How to add a TCP/IP NJE source
Complete this procedure to create TCP/IP NJE sources. Documents received by this source will be routed to Nuance
Output Manager.

1. In the Sources tree, right-click the source group (folder) where you want to add sources and click New Source.
This opens the Add Source dialog box.

2. In the Type list, select TCP/IP NJE.
3. Next to Add new devices enter the number of sources you want to create.

You can create a single TCP/IP NJE source or create multiple TCP/IP NJE sources and configure them
simultaneously.

4. Click OK.
5. Configure the general settings.

For multiple source configuration, this is configured on the General tab.
a) Enter the source Name.
b) In the Server list, click the Nuance Output Manager server where the Nuance Output Manager Input Service is

located for this source.
The source does not have to be on the same server as the Nuance Output Manager Input Service.

c) Enter any Comments or Location information for the source.
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d) Optional: To change the large source image that displays when configuring a single source, you can click
Select Image and choose the appropriate image file (BMP, JPEG, or PNG).
The selected image will be compressed and scaled to 96x96 pixels. Changing this image will not change the
smaller image that displays or the image that displays in the source tree. To change the image back to the
default, click Reset Image.

6. Configure the TCP/IP NJE settings.

Source Displays

Single source configuration Use the TCP/IP NJE settings tab.

Multiple source configuration Use the TCP/IP NJE settings (Bulk Configuration) ta
b.

a) Enter the Host node name of the host to which you will connect.
b) Select the Host type of the spool system on the mainframe.
c) Optional step. Enter the Host password and Confirm password if required.
d) Select the Host codepage that corresponds to the character set used by the host.
e) Optional step. Enter the IP address of the host.
f) Enter the Port number.

The default value is 175.
g) Enter the Local node name.

This must correspond to a remote node defined on the host.
h) Enter the Connect Interval in minutes.

This is the time interval used before attempting to reconnect.
i) Optional step. Enter the Local password and Confirm password.
j) Select the Local codepage.
k) Enter the number of SYSIN Receivers and SYSOUT Receivers.

This value should correspond to the settings for JTNUM and STNUM on the host.
l) Check Multiple streams per buffer to allow buffers to contain data on different streams.
m) Check Multiple headers per buffers to allow buffers to contain more than one header.
n) Check Package by output group to assign documents into separate packages by output group.

7. Configure the document properties that will be applied to all documents received by the source.

Configuration Method

Single source configuration Use the Document properties tab.

Multiple source configuration Use the Document properties (Bulk Configuration) ta
b.

Determine if you want to use advanced document properties. Advanced document properties facilitate the setting
of document properties from multiple sources. This is a complex feature that only advanced users and professional
service engineers should configure.

To Do this

Use advanced document properties Select Use advanced document properties. This
enables the advanced document properties profile
list. Select the default profile or an existing profile.
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To Do this
To configure document profiles, see the Configuring
document property profiles topic.

Not use advanced document properties If you do not want to use advanced document
properties, leave the check box disabled and configure
the following:

• Select the Document owner. This user will be the
owner of all documents received using this source.
Click the browse button (...) to select a user.

• Configure the document properties by entering
property values directly in the grid. All of the
available property values are listed and grouped
into categories. Expand the appropriate category
by clicking the arrow next to the category name.
The first node level in the category determines
the print preferences for the properties it contains.
On the print preference node, click in the Mode
column and configure how the property should be
applied when a document is sent to a destination.
Select Always Apply to always apply the specified
property value. Select Informational Only to use
the value for informational purposes only. In the
Value column, click in the grid cell to specify the
document property value.

Important:  This can only be configured
during single source configuration.

8. Configure the following configuration settings.

Configuration Method

Single source configuration Use the More settings tab.

Multiple source configuration Use the More settings (Bulk Configuration) tab.

a) Determine if you want all documents received by this source to be in the Hold state as they enter the Output
Manager Console.
This option is disabled by default.

b) Determine if you want to disable business rule processing for all documents received by this source as they
enter the Output Manager Console.
This option is disabled by default.

c) Use the following options to determine if you want to analyze documents as they are received by a source and
enter the Output Manager Console.
Selecting these options may cause performance degradation. These options are disabled by default.

Option Description

Use quick page counting for PDF documents Enables optimized page counting for PDF jobs. Wh
en this option is enabled, the Count pages, Detect
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Option Description

color, Detect data type, Detect duplex, and Detect
trays options are disabled.

Count pages Performs a page count on all documents received by t
his source.

Detect data type Detects the data type on all documents received by th
is source. The data type will display in the Document
s grid Data Type column.

Detect trays Determines the document paper tray that will print th
e document. This will display in the Documents grid
Input Bin or Output Bin column. You can configure
the Output Bin column to display by using the Admi
nistration Configure Document Properties Utility.

Detect color Detects if the documents received by this source cont
ain color. The Documents grid Color column display
s True or False depending if color is detected.

Detect duplex Detects if the documents received by this source are
configured for duplex printing (that is, printing on b
oth sides of the paper). The Documents grid Duplex
column displays how the document will print, One
Sided, Two Sided Short Edge, or Two Sided Long
Edge.

d) Select the file store that will be used for all documents received by this source as they enter the Output
Manager Console.
The default file store is selected by default. Administrators define file stores and select the default in the Set
General Preferences Utility. If the default file store is changed in the Set General Preferences Utility, all
sources using the default will be automatically updated.

e) Assign a document folder for all documents received by this source as they enter the Output Manager Console.
The default document folder is Un-Filed Documents.

f) To create profiles and enter costs associated with printing, select the Advanced Costing Profiles check box.
If you do not select this option, you can specify only the cost per page for printing.

g) Determine if you want to send a notification when a document arrives, prints successfully, prints on failover
destination, or is in error state.
The notification can be sent as an email message or pop-up. You can select an existing profile in the list or
create one from the Notification Profile dialog box.

• To create a profile during single source configuration, click New.
• To create during multiple source configuration, click the browse button (...).

9. Configure the following output settings.

Configuration Method

Single source configuration Use the Output settings tab.

Multiple source configuration Use the Output settings (Bulk Configuration) tab.

a) Use the Schedule output option to specify the date and time all documents received by this source will print.
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You can choose to print the documents today, on a specific day, or in the future. You can also choose to print as
soon as possible, at a specific time, or in the future.

b) Use the Route to destination option to specify a destination where all documents received by this source can
be routed.
Click the browse button (...) to select one or more destinations in the tree. Use the Shift and Ctrl keys to select
multiple destinations. Destination groups cannot be selected. This option is set to Unrouted by default.

c) To override the default retain settings for all documents received by this source select the Override default
retain settings check box and configure the retain options as necessary.

d) Select the appropriate output process.
Output processes can be created to impact documents as they are being sent to a destination. The processes
contain a set of actions which could be used for search and replace, setting finishing options, editing PJL
commands, inserting overlays, and so on. You can select an existing process in the list or create one using the
Process Designer. To create a process during single source configuration, click New. To create during multiple
source configuration, click the browse button (...).

e) Select the appropriate failover profile.
Failover profiles specify what should happen to documents when they are sent to inaccessible destinations
(they are not able to receive documents). You can select an existing profile in the list or create one from the
Failover Profile dialog box. To create a profile during single source configuration, click New. To create
during multiple source configuration, click the browse button (...).

10. Click OK.

How to add a WCF API source
Complete this procedure to create WCF API sources.

Documents received by this source will be routed to Nuance Output Manager.

The WCF API source type allows programs to submit documents using the WCF interface to specify the file path and
document metadata.

1. In the Sources tree, right-click the source group (folder) where you want to add sources and click New Source.
This opens the Add Source dialog box.

2. In the Type list, select WCF API.
3. Next to Add new devices enter the number of sources you want to create.

You can create a single WCF API source or create multiple WCF API sources and configure them simultaneously.
4. Click OK.
5. Configure the general settings.

For multiple source configuration, this is configured on the General tab.
a) Enter the source Name.
b) In the Server list, click the Nuance Output Manager server where the Nuance Output Manager Input Service is

located for this source.
The source does not have to be on the same server as the Nuance Output Manager Input Service.

c) Enter any Comments or Location information for the source.
d) Optional: To change the large source image that displays when configuring a single source, you can click

Select Image and choose the appropriate image file (BMP, JPEG, or PNG).
The selected image will be compressed and scaled to 96x96 pixels. Changing this image will not change the
smaller image that displays or the image that displays in the source tree. To change the image back to the
default, click Reset Image.
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6. Configure the WCF API settings.

Source Displays

Single source configuration Use the WCF API settings tab.

Multiple source configuration Use the WCF API settings (Bulk Configuration) tab.

a) Enter the Port number.
The default value is 631.

b) Enter the IP address on the local system where the socket device will receive documents.
In most cases, this can be left blank given that most systems have only one IP address. For systems that have
multiple network adapters or support multiple IP addresses, the IP address entered here specifies the IP address
for the appropriate port.

c) Enter the Instance name.
This identifies the source address and extends the connection URL.

7. Configure the document properties that will be applied to all documents received by the source.

Configuration Method

Single source configuration Use the Document properties tab.

Multiple source configuration Use the Document properties (Bulk Configuration) ta
b.

Determine if you want to use advanced document properties. Advanced document properties facilitate the setting
of document properties from multiple sources. This is a complex feature that only advanced users and professional
service engineers should configure.

To Do this

Use advanced document properties Select Use advanced document properties. This
enables the advanced document properties profile
list. Select the default profile or an existing profile.
To configure document profiles, see the Configuring
document property profiles topic.

Not use advanced document properties If you do not want to use advanced document
properties, leave the check box disabled and configure
the following:

• Select the Document owner. This user will be the
owner of all documents received using this source.
Click the browse button (...) to select a user.

• Configure the document properties by entering
property values directly in the grid. All of the
available property values are listed and grouped
into categories. Expand the appropriate category
by clicking the arrow next to the category name.
The first node level in the category determines
the print preferences for the properties it contains.
On the print preference node, click in the Mode
column and configure how the property should be
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To Do this
applied when a document is sent to a destination.
Select Always Apply to always apply the specified
property value. Select Informational Only to use
the value for informational purposes only. In the
Value column, click in the grid cell to specify the
document property value.

Important:  This can only be configured
during single source configuration.

8. Configure the following configuration settings.

Configuration Method

Single source configuration Use the More settings tab.

Multiple source configuration Use the More settings (Bulk Configuration) tab.

a) Determine if you want all documents received by this source to be in the Hold state as they enter the Output
Manager Console.
This option is disabled by default.

b) Determine if you want to disable business rule processing for all documents received by this source as they
enter the Output Manager Console.
This option is disabled by default.

c) Use the following options to determine if you want to analyze documents as they are received by a source and
enter the Output Manager Console.
Selecting these options may cause performance degradation. These options are disabled by default.

Option Description

Use quick page counting for PDF documents Enables optimized page counting for PDF jobs. Wh
en this option is enabled, the Count pages, Detect
color, Detect data type, Detect duplex, and Detect
trays options are disabled.

Count pages Performs a page count on all documents received by t
his source.

Detect data type Detects the data type on all documents received by th
is source. The data type will display in the Document
s grid Data Type column.

Detect trays Determines the document paper tray that will print th
e document. This will display in the Documents grid
Input Bin or Output Bin column. You can configure
the Output Bin column to display by using the Admi
nistration Configure Document Properties Utility.

Detect color Detects if the documents received by this source cont
ain color. The Documents grid Color column display
s True or False depending if color is detected.
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Option Description

Detect duplex Detects if the documents received by this source are
configured for duplex printing (that is, printing on b
oth sides of the paper). The Documents grid Duplex
column displays how the document will print, One
Sided, Two Sided Short Edge, or Two Sided Long
Edge.

d) Select the file store that will be used for all documents received by this source as they enter the Output
Manager Console.
The default file store is selected by default. Administrators define file stores and select the default in the Set
General Preferences Utility. If the default file store is changed in the Set General Preferences Utility, all
sources using the default will be automatically updated.

e) Assign a document folder for all documents received by this source as they enter the Output Manager Console.
The default document folder is Un-Filed Documents.

f) To create profiles and enter costs associated with printing, select the Advanced Costing Profiles check box.
If you do not select this option, you can specify only the cost per page for printing.

g) Determine if you want to send a notification when a document arrives, prints successfully, prints on failover
destination, or is in error state.
The notification can be sent as an email message or pop-up. You can select an existing profile in the list or
create one from the Notification Profile dialog box.

• To create a profile during single source configuration, click New.
• To create during multiple source configuration, click the browse button (...).

9. Configure the following output settings.

Configuration Method

Single source configuration Use the Output settings tab.

Multiple source configuration Use the Output settings (Bulk Configuration) tab.

a) Use the Schedule output option to specify the date and time all documents received by this source will print.
You can choose to print the documents today, on a specific day, or in the future. You can also choose to print as
soon as possible, at a specific time, or in the future.

b) Use the Route to destination option to specify a destination where all documents received by this source can
be routed.
Click the browse button (...) to select one or more destinations in the tree. Use the Shift and Ctrl keys to select
multiple destinations. Destination groups cannot be selected. This option is set to Unrouted by default.

c) To override the default retain settings for all documents received by this source select the Override default
retain settings check box and configure the retain options as necessary.

d) Select the appropriate output process.
Output processes can be created to impact documents as they are being sent to a destination. The processes
contain a set of actions which could be used for search and replace, setting finishing options, editing PJL
commands, inserting overlays, and so on. You can select an existing process in the list or create one using the
Process Designer. To create a process during single source configuration, click New. To create during multiple
source configuration, click the browse button (...).

e) Select the appropriate failover profile.
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Failover profiles specify what should happen to documents when they are sent to inaccessible destinations
(they are not able to receive documents). You can select an existing profile in the list or create one from the
Failover Profile dialog box. To create a profile during single source configuration, click New. To create
during multiple source configuration, click the browse button (...).

10. Click OK.

How to add a Web Upload source
Complete this procedure to create web upload sources. Documents placed in the source created by this procedure will
be routed to Nuance Output Manager.

1. In the Sources tree, right-click the source group (folder) where you want to add sources and click New Source.
This opens the Add Source dialog box.

2. In the Type list, select Web Upload.
3. Next to Add new devices, enter the number of sources you want to create.

You can create a single web upload source or create multiple web upload sources and configure them
simultaneously.

4. Click OK.
5. Configure the general settings.

For multiple source configuration, this is configured on the General tab.
a) Enter the source Name.
b) In the Server list, click the Nuance Output Manager server where the Nuance Output Manager Input Service is

located for this source.
The source does not have to be on the same server as the Nuance Output Manager Input Service.

c) Enter any Comments or Location information for the source.
d) Optional: To change the large source image that displays when configuring a single source, you can click

Select Image and choose the appropriate image file (BMP, JPEG, or PNG).
The selected image will be compressed and scaled to 96x96 pixels. Changing this image will not change the
smaller image that displays or the image that displays in the source tree. To change the image back to the
default, click Reset Image.

6. Configure the Web upload settings.

Source Displays

Single source configuration Use the Web upload settings tab.

Multiple source configuration Use the Web upload settings (Bulk Configuration) tab
.

a) Select the Web server.
The list displays all of the web servers available to the selected Output Manager server.

b) Select the Source Capabilities Profile.

To Do this

Select an existing profile. Click the arrow.

Create and manage profiles. Click the browse button (...) to open the Manage
Source Properties Profiles dialog box.
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This specifies which print preferences/document properties are supported by this source. Those preferences are
stored in a source property profile.

7. Configure the document properties that will be applied to all documents received by the source.

Configuration Method

Single source configuration Use the Document properties tab.

Multiple source configuration Use the Document properties (Bulk Configuration) ta
b.

Determine if you want to use advanced document properties. Advanced document properties facilitate the setting
of document properties from multiple sources. This is a complex feature that only advanced users and professional
service engineers should configure.

To Do this

Use advanced document properties Select Use advanced document properties. This
enables the advanced document properties profile
list. Select the default profile or an existing profile.
To configure document profiles, see the Configuring
document property profiles topic.

Not use advanced document properties If you do not want to use advanced document
properties, leave the check box disabled and configure
the following:

• Select the Document owner. This user will be the
owner of all documents received using this source.
Click the browse button (...) to select a user.

• Configure the document properties by entering
property values directly in the grid. All of the
available property values are listed and grouped
into categories. Expand the appropriate category
by clicking the arrow next to the category name.
The first node level in the category determines
the print preferences for the properties it contains.
On the print preference node, click in the Mode
column and configure how the property should be
applied when a document is sent to a destination.
Select Always Apply to always apply the specified
property value. Select Informational Only to use
the value for informational purposes only. In the
Value column, click in the grid cell to specify the
document property value.

Important:  This can only be configured
during single source configuration.

8. Configure the following configuration settings.
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Configuration Method

Single source configuration Use the More settings tab.

Multiple source configuration Use the More settings (Bulk Configuration) tab.

a) Determine if you want all documents received by this source to be in the Hold state as they enter the Output
Manager Console.
This option is disabled by default.

b) Determine if you want to disable business rule processing for all documents received by this source as they
enter the Output Manager Console.
This option is disabled by default.

c) Use the following options to determine if you want to analyze documents as they are received by a source and
enter the Output Manager Console.
Selecting these options may cause performance degradation. These options are disabled by default.

Option Description

Use quick page counting for PDF documents Enables optimized page counting for PDF jobs. Wh
en this option is enabled, the Count pages, Detect
color, Detect data type, Detect duplex, and Detect
trays options are disabled.

Count pages Performs a page count on all documents received by t
his source.

Detect data type Detects the data type on all documents received by th
is source. The data type will display in the Document
s grid Data Type column.

Detect trays Determines the document paper tray that will print th
e document. This will display in the Documents grid
Input Bin or Output Bin column. You can configure
the Output Bin column to display by using the Admi
nistration Configure Document Properties Utility.

Detect color Detects if the documents received by this source cont
ain color. The Documents grid Color column display
s True or False depending if color is detected.

Detect duplex Detects if the documents received by this source are
configured for duplex printing (that is, printing on b
oth sides of the paper). The Documents grid Duplex
column displays how the document will print, One
Sided, Two Sided Short Edge, or Two Sided Long
Edge.

d) Select the file store that will be used for all documents received by this source as they enter the Output
Manager Console.
The default file store is selected by default. Administrators define file stores and select the default in the Set
General Preferences Utility. If the default file store is changed in the Set General Preferences Utility, all
sources using the default will be automatically updated.
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e) Assign a document folder for all documents received by this source as they enter the Output Manager Console.
The default document folder is Un-Filed Documents.

f) To create profiles and enter costs associated with printing, select the Advanced Costing Profiles check box.
If you do not select this option, you can specify only the cost per page for printing.

g) Determine if you want to send a notification when a document arrives, prints successfully, prints on failover
destination, or is in error state.
The notification can be sent as an email message or pop-up. You can select an existing profile in the list or
create one from the Notification Profile dialog box.

• To create a profile during single source configuration, click New.
• To create during multiple source configuration, click the browse button (...).

9. Configure the following output settings.

Configuration Method

Single source configuration Use the Output settings tab.

Multiple source configuration Use the Output settings (Bulk Configuration) tab.

a) Use the Schedule output option to specify the date and time all documents received by this source will print.
You can choose to print the documents today, on a specific day, or in the future. You can also choose to print as
soon as possible, at a specific time, or in the future.

b) Use the Route to destination option to specify a destination where all documents received by this source can
be routed.
Click the browse button (...) to select one or more destinations in the tree. Use the Shift and Ctrl keys to select
multiple destinations. Destination groups cannot be selected. This option is set to Unrouted by default.

c) To override the default retain settings for all documents received by this source select the Override default
retain settings check box and configure the retain options as necessary.

d) Select the appropriate output process.
Output processes can be created to impact documents as they are being sent to a destination. The processes
contain a set of actions which could be used for search and replace, setting finishing options, editing PJL
commands, inserting overlays, and so on. You can select an existing process in the list or create one using the
Process Designer. To create a process during single source configuration, click New. To create during multiple
source configuration, click the browse button (...).

e) Select the appropriate failover profile.
Failover profiles specify what should happen to documents when they are sent to inaccessible destinations
(they are not able to receive documents). You can select an existing profile in the list or create one from the
Failover Profile dialog box. To create a profile during single source configuration, click New. To create
during multiple source configuration, click the browse button (...).

10. Click OK.

How to add a WebSphere MQ source
Complete this procedure to create WebSphere MQ sources. This source will receive WebSphere MQ messages.

WebSphere MQ is a message queuing system designed by IBM that runs on many platforms such as Windows, Unix,
Linux, and z/OS. Nuance Output Manager provides an interface into that queuing system. Nuance Output Manager
can then communicate (send and receive messages) with other applications using WebSphere MQ.

1. In the Sources tree, right-click the source group (folder) where you want to add sources and click New Source.
This opens the Add Source dialog box.
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2. In the Type list, select WebSphere MQ.
3. Next to Add new devices, enter the number of sources you want to create.

You can create a single WebSphere MQ source or create multiple WebSphere MQ sources and configure them
simultaneously.

4. Click OK.
5. Configure the general settings.

For multiple source configuration, this is configured on the General tab.
a) Enter the source Name.
b) In the Server list, click the Nuance Output Manager server where the Nuance Output Manager Input Service is

located for this source.
The source does not have to be on the same server as the Nuance Output Manager Input Service.

c) Enter any Comments or Location information for the source.
d) Optional: To change the large source image that displays when configuring a single source, you can click

Select Image and choose the appropriate image file (BMP, JPEG, or PNG).
The selected image will be compressed and scaled to 96x96 pixels. Changing this image will not change the
smaller image that displays or the image that displays in the source tree. To change the image back to the
default, click Reset Image.

6. Configure the WebSphere MQ settings.

Source Displays

Single source configuration Use the WebSphere MQ settings tab.

Multiple source configuration Use the WebSphere MQ settings (Bulk Configuration
) tab.

a) Enter the Queue manager name.
This must match the queue manager specified in WebSphere MQ.

b) Enter the Queue name where received messages will be stored.
This must match the queue name specified in WebSphere MQ.

c) Enter the Channel name for the channel configured for TCP/IP.
You can get this name from the WebSphere MQ list of channels.

Warning:  Make sure the SSL certificate required option is not selected in WebSphere MQ. Output
Manager does not support this at this time.

d) In the Connection name field, enter the IP address and port number or DNS name for the server to which you
are attempting to connect.
Messages are transferred over the connection and placed in the queue.

7. Configure the document properties that will be applied to all documents received by the source.

Configuration Method

Single source configuration Use the Document properties tab.

Multiple source configuration Use the Document properties (Bulk Configuration) ta
b.



Output Manager Administration Guide
Version 4.0 SP2

135 © 2016 Nuance Communications, Inc. All rights reserved.

Determine if you want to use advanced document properties. Advanced document properties facilitate the setting
of document properties from multiple sources. This is a complex feature that only advanced users and professional
service engineers should configure.

To Do this

Use advanced document properties Select Use advanced document properties. This
enables the advanced document properties profile
list. Select the default profile or an existing profile.
To configure document profiles, see the Configuring
document property profiles topic.

Not use advanced document properties If you do not want to use advanced document
properties, leave the check box disabled and configure
the following:

• Select the Document owner. This user will be the
owner of all documents received using this source.
Click the browse button (...) to select a user.

• Configure the document properties by entering
property values directly in the grid. All of the
available property values are listed and grouped
into categories. Expand the appropriate category
by clicking the arrow next to the category name.
The first node level in the category determines
the print preferences for the properties it contains.
On the print preference node, click in the Mode
column and configure how the property should be
applied when a document is sent to a destination.
Select Always Apply to always apply the specified
property value. Select Informational Only to use
the value for informational purposes only. In the
Value column, click in the grid cell to specify the
document property value.

Important:  This can only be configured
during single source configuration.

8. Configure the following configuration settings.

Configuration Method

Single source configuration Use the More settings tab.

Multiple source configuration Use the More settings (Bulk Configuration) tab.

a) Determine if you want all documents received by this source to be in the Hold state as they enter the Output
Manager Console.
This option is disabled by default.

b) Determine if you want to disable business rule processing for all documents received by this source as they
enter the Output Manager Console.
This option is disabled by default.
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c) Use the following options to determine if you want to analyze documents as they are received by a source and
enter the Output Manager Console.
Selecting these options may cause performance degradation. These options are disabled by default.

Option Description

Use quick page counting for PDF documents Enables optimized page counting for PDF jobs. Wh
en this option is enabled, the Count pages, Detect
color, Detect data type, Detect duplex, and Detect
trays options are disabled.

Count pages Performs a page count on all documents received by t
his source.

Detect data type Detects the data type on all documents received by th
is source. The data type will display in the Document
s grid Data Type column.

Detect trays Determines the document paper tray that will print th
e document. This will display in the Documents grid
Input Bin or Output Bin column. You can configure
the Output Bin column to display by using the Admi
nistration Configure Document Properties Utility.

Detect color Detects if the documents received by this source cont
ain color. The Documents grid Color column display
s True or False depending if color is detected.

Detect duplex Detects if the documents received by this source are
configured for duplex printing (that is, printing on b
oth sides of the paper). The Documents grid Duplex
column displays how the document will print, One
Sided, Two Sided Short Edge, or Two Sided Long
Edge.

d) Select the file store that will be used for all documents received by this source as they enter the Output
Manager Console.
The default file store is selected by default. Administrators define file stores and select the default in the Set
General Preferences Utility. If the default file store is changed in the Set General Preferences Utility, all
sources using the default will be automatically updated.

e) Assign a document folder for all documents received by this source as they enter the Output Manager Console.
The default document folder is Un-Filed Documents.

f) To create profiles and enter costs associated with printing, select the Advanced Costing Profiles check box.
If you do not select this option, you can specify only the cost per page for printing.

g) Determine if you want to send a notification when a document arrives, prints successfully, prints on failover
destination, or is in error state.
The notification can be sent as an email message or pop-up. You can select an existing profile in the list or
create one from the Notification Profile dialog box.

• To create a profile during single source configuration, click New.
• To create during multiple source configuration, click the browse button (...).

9. Configure the following output settings.
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Configuration Method

Single source configuration Use the Output settings tab.

Multiple source configuration Use the Output settings (Bulk Configuration) tab.

a) Use the Schedule output option to specify the date and time all documents received by this source will print.
You can choose to print the documents today, on a specific day, or in the future. You can also choose to print as
soon as possible, at a specific time, or in the future.

b) Use the Route to destination option to specify a destination where all documents received by this source can
be routed.
Click the browse button (...) to select one or more destinations in the tree. Use the Shift and Ctrl keys to select
multiple destinations. Destination groups cannot be selected. This option is set to Unrouted by default.

c) To override the default retain settings for all documents received by this source select the Override default
retain settings check box and configure the retain options as necessary.

d) Select the appropriate output process.
Output processes can be created to impact documents as they are being sent to a destination. The processes
contain a set of actions which could be used for search and replace, setting finishing options, editing PJL
commands, inserting overlays, and so on. You can select an existing process in the list or create one using the
Process Designer. To create a process during single source configuration, click New. To create during multiple
source configuration, click the browse button (...).

e) Select the appropriate failover profile.
Failover profiles specify what should happen to documents when they are sent to inaccessible destinations
(they are not able to receive documents). You can select an existing profile in the list or create one from the
Failover Profile dialog box. To create a profile during single source configuration, click New. To create
during multiple source configuration, click the browse button (...).

10. Click OK.

How to add a Windows Queue source
Complete this procedure to create Windows queue sources. Documents received by this source will be routed to
Nuance Output Manager.

1. In the Sources tree, right-click the source group (folder) where you want to add sources and click New Source.
This opens the Add Source dialog box.

2. In the Type list, select Windows Queue.
3. Next to Add new devices, enter the number of sources you want to create.

You can create a single Windows Queue source or create multiple Windows Queue sources and configure them
simultaneously.

4. Click OK.
5. Configure the general settings.

For multiple source configuration, this is configured on the General tab.
a) Enter the source Name.
b) In the Server list, click the Nuance Output Manager server where the Nuance Output Manager Input Service is

located for this source.
The source does not have to be on the same server as the Nuance Output Manager Input Service.

c) Enter any Comments or Location information for the source.



Output Manager Administration Guide
Version 4.0 SP2

138 © 2016 Nuance Communications, Inc. All rights reserved.

d) Optional: To change the large source image that displays when configuring a single source, you can click
Select Image and choose the appropriate image file (BMP, JPEG, or PNG).
The selected image will be compressed and scaled to 96x96 pixels. Changing this image will not change the
smaller image that displays or the image that displays in the source tree. To change the image back to the
default, click Reset Image.

6. Configure the Windows queue settings.

Source Displays

Single source configuration Use the Windows queue settings tab.

Multiple source configuration Use the Windows queue settings (Bulk Configuration
) tab.

a) Select the Converted queue.
The list displays all of the Windows printers that are using the Output Manager Port Monitor but do not have
a source created and associated with it. Once a source has been created and associated, those printers will no
longer be displayed in the list.

b) Select the Source Capabilities Profile.

To Do this

Select an existing profile. Click the arrow.

Create and manage profiles. Click the browse button (...) to open the Manage
Source Properties Profiles dialog box.

This specifies which print preferences/document properties are supported by this source. Those preferences are
stored in a source property profile.

7. Configure the document properties that will be applied to all documents received by the source.

Configuration Method

Single source configuration Use the Document properties tab.

Multiple source configuration Use the Document properties (Bulk Configuration) ta
b.

Determine if you want to use advanced document properties. Advanced document properties facilitate the setting
of document properties from multiple sources. This is a complex feature that only advanced users and professional
service engineers should configure.

To Do this

Use advanced document properties Select Use advanced document properties. This
enables the advanced document properties profile
list. Select the default profile or an existing profile.
To configure document profiles, see the Configuring
document property profiles topic.

Not use advanced document properties If you do not want to use advanced document
properties, leave the check box disabled and configure
the following:
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To Do this
• Select the Document owner. This user will be the

owner of all documents received using this source.
Click the browse button (...) to select a user.

• Configure the document properties by entering
property values directly in the grid. All of the
available property values are listed and grouped
into categories. Expand the appropriate category
by clicking the arrow next to the category name.
The first node level in the category determines
the print preferences for the properties it contains.
On the print preference node, click in the Mode
column and configure how the property should be
applied when a document is sent to a destination.
Select Always Apply to always apply the specified
property value. Select Informational Only to use
the value for informational purposes only. In the
Value column, click in the grid cell to specify the
document property value.

Important:  This can only be configured
during single source configuration.

8. Configure the following configuration settings.

Configuration Method

Single source configuration Use the More settings tab.

Multiple source configuration Use the More settings (Bulk Configuration) tab.

a) Determine if you want all documents received by this source to be in the Hold state as they enter the Output
Manager Console.
This option is disabled by default.

b) Determine if you want to disable business rule processing for all documents received by this source as they
enter the Output Manager Console.
This option is disabled by default.

c) Use the following options to determine if you want to analyze documents as they are received by a source and
enter the Output Manager Console.
Selecting these options may cause performance degradation. These options are disabled by default.

Option Description

Use quick page counting for PDF documents Enables optimized page counting for PDF jobs. Wh
en this option is enabled, the Count pages, Detect
color, Detect data type, Detect duplex, and Detect
trays options are disabled.

Count pages Performs a page count on all documents received by t
his source.
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Option Description

Detect data type Detects the data type on all documents received by th
is source. The data type will display in the Document
s grid Data Type column.

Detect trays Determines the document paper tray that will print th
e document. This will display in the Documents grid
Input Bin or Output Bin column. You can configure
the Output Bin column to display by using the Admi
nistration Configure Document Properties Utility.

Detect color Detects if the documents received by this source cont
ain color. The Documents grid Color column display
s True or False depending if color is detected.

Detect duplex Detects if the documents received by this source are
configured for duplex printing (that is, printing on b
oth sides of the paper). The Documents grid Duplex
column displays how the document will print, One
Sided, Two Sided Short Edge, or Two Sided Long
Edge.

d) Select the file store that will be used for all documents received by this source as they enter the Output
Manager Console.
The default file store is selected by default. Administrators define file stores and select the default in the Set
General Preferences Utility. If the default file store is changed in the Set General Preferences Utility, all
sources using the default will be automatically updated.

e) Assign a document folder for all documents received by this source as they enter the Output Manager Console.
The default document folder is Un-Filed Documents.

f) To create profiles and enter costs associated with printing, select the Advanced Costing Profiles check box.
If you do not select this option, you can specify only the cost per page for printing.

g) Determine if you want to send a notification when a document arrives, prints successfully, prints on failover
destination, or is in error state.
The notification can be sent as an email message or pop-up. You can select an existing profile in the list or
create one from the Notification Profile dialog box.

• To create a profile during single source configuration, click New.
• To create during multiple source configuration, click the browse button (...).

9. Configure the following output settings.

Configuration Method

Single source configuration Use the Output settings tab.

Multiple source configuration Use the Output settings (Bulk Configuration) tab.

a) Use the Schedule output option to specify the date and time all documents received by this source will print.
You can choose to print the documents today, on a specific day, or in the future. You can also choose to print as
soon as possible, at a specific time, or in the future.

b) Use the Route to destination option to specify a destination where all documents received by this source can
be routed.
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Click the browse button (...) to select one or more destinations in the tree. Use the Shift and Ctrl keys to select
multiple destinations. Destination groups cannot be selected. This option is set to Unrouted by default.

c) To override the default retain settings for all documents received by this source select the Override default
retain settings check box and configure the retain options as necessary.

d) Select the appropriate output process.
Output processes can be created to impact documents as they are being sent to a destination. The processes
contain a set of actions which could be used for search and replace, setting finishing options, editing PJL
commands, inserting overlays, and so on. You can select an existing process in the list or create one using the
Process Designer. To create a process during single source configuration, click New. To create during multiple
source configuration, click the browse button (...).

e) Select the appropriate failover profile.
Failover profiles specify what should happen to documents when they are sent to inaccessible destinations
(they are not able to receive documents). You can select an existing profile in the list or create one from the
Failover Profile dialog box. To create a profile during single source configuration, click New. To create
during multiple source configuration, click the browse button (...).

10. Click OK.

How to Modify Sources
Complete the steps in this procedure to modify sources in the Sources application.

1. In the Sources tree, do either of the following:

• Right-click the source you want to modify and click Configure.
• Right-click a source in the grid view and click Configure.

2. In the Configuration dialog box, make the necessary changes.
The configuration options available vary based on the type of source selected.

3. Click OK

How to Remove Sources
Complete this procedure to remove sources from the Sources application.

1. In the Sources tree, right-click the source you want to delete.
2. Click Delete on the shortcut menu.

How to Import Sources
Use the following procedure to import a list of sources into Nuance Output Manager. Importing sources is particularly
useful if you have a database or spreadsheet that lists your existing equipment. You can save that document as a CSV
file and then import it to create matching sources in Nuance Output Manager.

Before you begin, review the following information on configuring/importing CSV files:

• In the CSV file, the header record (first record) determines which fields are defined. You must configure the field
names in the header record to match predefined Nuance Output Manager names. Field names that match are used
to populate the settings associated with that column. Field names that do not match are ignore. Contact Nuance
Support for the list of predefined Nuance Output Manager names.
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• Each record after the header record is created as a device. The device will contain the settings from the recognized
columns for that record. Nuance Output Manager interprets values for text and numeric settings. For settings that
have a fixed list of options, Nuance Output Manager matches the value to the name of the option. Values which
are not recognized, out of bounds, or otherwise invalid are replaced with the default value for that setting.

• Not all settings can be specified through the CSV file. For example, the input/output server, users, destinations,
and profiles cannot be imported.

• A single CSV file can be used to generate multiple device types, sources, and destinations. Nuance Output
Manager only imports the settings which are recognized by the device type you are creating. For example, the
CSV file can contain settings that are common to all devices types, settings for a particular device type, or settings
for several different device types.

Complete the following steps to import sources from a CSV file.

1. From the Sources tree, right-click a source group (folder) and click New Source. The new sources will be created
in this group.

2. From the Add Source dialog box, select the source type.
3. Select Import devices from configuration (.csv) file.
4. In the box, enter the path and file name of the configuration file or click the Browse (...) button to navigate to the

file.
5. When the configuration file is selected, click OK.

This displays tab pages with options specific to the selected source type.
6. Make the necessary changes on each tab.

The following topics provide more information on configuring tabs for source types:

• How to add an AutoStore source on page 83
• How to add an Email source on page 86
• How to add an FTP Source on page 95
• How to add an IPP Source on page 100
• How to add an LPD Source on page 103
• How to add a Mobile Server source on page 104
• How to add a NetWeaver source on page 108
• How to add a Network Folder source on page 111
• How to add an Output Manager source on page 115
• How to add a Socket Connection source on page 119
• How to add a TCP/IP NJE source on page 122
• How to add a WCF API source on page 126
• How to add a Web Upload source on page 130
• How to add a WebSphere MQ source on page 133
• How to add a Windows Queue source on page 137

How to Search for Sources
You can search for sources from the Sources tree and Sources grid.

• You can search for sources from the Destinations tree or the Destinations grid.



Output Manager Administration Guide
Version 4.0 SP2

143 © 2016 Nuance Communications, Inc. All rights reserved.

To search from the: Do this

Destinations tree • In the Search box below the tree, type the text you
want to find and press Enter or click the search
button.

Destinations grid • In the Search box below the grid, type the text you
want to find, click the column in the grid you want
to search, and press Enter or click the Search image.

If the text is found, the focus will move to the first occurrence. New buttons appear near the Search box that allow
you to move to the previous or next occurrence.

How to Configure Security for Sources
Follow steps in this procedure to configure permissions to sources for users or groups.

To begin configuring source security, start by assigning the desired source permissions for the All Sources group. To
view sources in the tree, users or user groups must be assigned the Allow user to view the Source permission in the
All Sources group. Users not assigned this permission in the All Sources group will not see any sources or groups
even though they may have been given permissions for the specific source or group.

Nuance Output Manager security for the Sources application begins at the root of the Sources tree, the All Sources
group. The Sources tree consists of sources and source groups. A source is an input into Nuance Output Manager.
A source group is a way to organize sources. Nuance Output Manager security is provided for both by adding a
Microsoft Windows user or user group to the source or source group and assigning permissions to that user or user
group. These Nuance Output Manager permissions define the type of access users and user groups have to the sources
and source groups. Once the Nuance Output Manager security (Microsoft Windows users, user groups, and source
permissions) is set in a source group, the Nuance Output Manager security is inherited by all the objects in that source
group. When a new source or source group is created, its security is automatically the same as its parent source
group’s security (that is, the new source inherits its security from its parent source group).

1. In the Output Manager Console, select the Sources application in the navigation pane.
2. In the Sources tree, right-click a source or source group and click Security.

To perform this step, a user must be a member of the local Administrators group or be assigned the Allow user to
modify the Source's security configuration permission. Users with this permission can add and remove users or
groups and modify assigned permissions.
Completing this step opens the Security Configuration dialog box. To access this dialog box,
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3. Use the Inherit permissions from the parent option to inherit permissions from a parent group or to remove
inheritance.

• Click the browse button (...) to select a new parent group for inheritance or to remove inheritance.

By default, sources are configured to inherit permissions from the parent folder.

Tip:  It is a recommended practice to assign rights using inheritance, as it allows administrators to easily
assign and manage permissions. Blocking inheritance is useful when a source or source group needs to
be seen by just a few users. If you plan to block inheritance, make sure the users that need access to the
blocked source or group are in the security settings for all of its parent groups, including All Sources. If
this is not done then those users will not be able to see the source. Also remember to remove the users and
user groups that should not have access to the source or group.

4. In the Users and groups with permissions box, select a user or group to manage.

• If a group or user does not appear in the list, click Add to open the User and Group Selection dialog box. See
Adding users and groups to Nuance Output Manager  for detailed procedures on adding users.

The Assigned permissions list box displays permissions that are currently granted to the selected user or group.
5. In the Assigned permissions box, select or clear check boxes to grant or revoke permissions for the selected user

or group.

• You can click Select All or Unselect All to quickly grant or revoke all permissions.

The permissions assigned to a source group will be inherited for all of the objects contained in that group, except
for the ones that have inheritance blocked.

If you notice permissions that are selected and disabled, then the user/group selected has inherited permissions.
Inherited permissions cannot be removed. To remove inherited permissions, you must first block inheritance for
the source.

6. When you are finished configuring security, click OK to save your changes.
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Managing Sources
Documents are received into Nuance Output Manager using Sources. Once received into Nuance Output Manager,
documents are then routed to destinations. You can control sources from the Output Manager Console using the
following procedures.

• Enable a source
• Disable a source
• Open a source
• Move a source
• Rename a source
• Copy a source
• View all messages for a source

How to Enable a Source
Perform this procedure to enable a source.

• Use one of the following methods to enable a source in the Output Manager Console.

• From the Sources grid, right-click a source and click Enable.
• From the Sources tree, right-click a source and click Enable.

How to Disable a Source

• Use one of the following methods to disable a source in the Output Manager Console.

• In the Sources grid, right-click a source and click Disable.
• In the Sources tree, right-click a source and click Disable.

How to Open a Source
Perform one of the methods this procedure to open a source in the current tab or in a new tab.

• Use one of the following methods to open a source in the Output Manager Console.

• From the Sources tree, click a source to open it in the current tab.
• From the Sources tree, right-click a source and click Open to open it in the current tab.
• From the Sources tree, right-click a source and click Open in New Tab to open it in a new tab.

How to Move a Source
Complete this procedure to move a source in the Output Manager Console.

Sources can be organized into source groups. Once groups are created, sources and groups can be easily moved in the
tree as necessary.

1. From the Sources tree, select the source or source group you want to move.
2. Drag the source or group to the desired tree location.

As you drag the item a yellow arrow will appear to the left of the tree to indicate where the item will be placed.
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How to Rename a Source
Complete this procedure to rename a source in the Output Manager Console.

1. From the Sources tree, right-click a source and click Rename.
2. In the edit field, type the new source name and press Enter. To cancel the rename, press Esc.

How to Copy a Source
Complete the following procedure to copy a source in the Output Manager Console.

Sources can be copied into multiple source groups.

1. From the Sources tree, select the source you want to copy and hold down the Ctrl key.
2. While pressing Ctrl, drag the source to the desired tree location.

As you drag the item a yellow arrow will appear to the left of the tree to indicate where the copy will be created.

How to View All Messages for a Source
Complete this procedure to display all messages that are related to a source.

• In the Sources grid, right-click a source and click View messages.

This displays the Message Console listing all messages related to the selected source.

Configuring Document Property Profiles
Advanced document properties facilitate the setting of document properties from multiple sources. Document
properties can be set from Output Manager Print Server headers, LPD headers, job tickets, data contained in the
document, or fixed values, and so on. Advanced document properties is a complex feature that only advanced users
and professional service engineers should configure.

To configure document properties, you must first configure one or more profiles for the desired type of header data.
Your profile options are native header profile, job ticket profile, job parsing profile, and headers from data profile.
The configuration of these profiles includes specifying which headers to use, what Nuance Output Manager document
properties to map them to, and potentially which job ticket values to match to which Nuance Output Manager
property values.

Once the profiles are configured, choose the order in which the configured profiles are used when a document is
received, and what the default static value is if no data is found in the respective header.

The profiles of the individual document information sources (native header, job ticket, job parsing, and headers from
data) can be reused in many different advanced document property profiles, just as the advanced document property
profile can be reused by many different Nuance Output Manager source devices.

Complete the following procedure to configure document profiles during source configuration:

• Configuring Document Profiles During Source Configuration

How to Configure Document Profiles During Source Configuration
Perform this procedure to configure document properties profiles while configuring a source.

1. In the Source Configuration dialog box, click the Document Properties tab.
2. Select the Use advanced document properties check box.
3. Choose the document properties profile for the source.
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To Do this

Use the default properties profile • Make sure that Default is selected in the box.

Use an existing profile Either of the following:

• In the profile box, select the profile that you want to
use.

• Click the Manage button to open the Manage
Document Properties Profiles dialog box and
select a profile.

Create a new profile 1. Click the New button.
2. Enter the Name and Description for the profile.

Edit a profile Either of the following:

• In the profile box, select the profile that you want to
use, and then click Edit.

• Click the Manage button to open the Manage
Document Properties Profiles dialog box to select
and edit a profile.

4. Configure the profile.

• See Configuring Document Properties Profiles.
5. Determine the profile order.

• See Ordering Document Properties Profiles.

How to Configure a Document Properties Profile
Perform this procedure to configure document profiles.

• To configure advanced document properties, you must configure one or more of the following profiles:

• Native header profile
• Job ticket profile
• Job parsing profile
• Headers from data profile

How to Configure Native Header Profiles
Complete this procedure to configure native header profiles.

Native headers contain information that arrives as part of the transmission protocol that is used to receive documents.

1. Open the Document Properties Profile dialog box, if it is not open already.
2. Next to Native header profile, click New to create a native header profile.

You can also select a profile in the list and click Edit to make modifications.
3. Enter the profile Name and Description.
4. On the Native headers tab, select one or more of the Nuance Output Manager device types whose headers should

be available for mapping.

• Email
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• FTP
• LPD
• Network folder
• Socket
• WebSphere MQ
• Windows queue
• BEPS devices

The selected native headers will be available on the Document property mappings tab and the Document owner
mapping tab.

5. Configure the document property mappings.
See Configuring Document Property Mappings.

6. Configure the document owner mappings.
See Configuring Document Owner Mappings.

How to Configure Job Ticket Profiles
Complete this procedure to configure a job ticket profile.

Job tickets contain information about the document, and/or how the document should be treated. Tickets are logically
separate from the document, and in some cases are inserted in front of the document file.

1. Next to Job ticket profile, click New to create a job ticket profile.
You can also select a profile in the list and click Edit to make modifications.

2. Enter the profile Name and Description.
3. On the Job ticket tab, in the Type box, select one of the following job ticket types:

XML Job Ticket An external job ticket template in an XML format.
The XML tags are accessible throughout the job ticket
profile configuration.

NSi Spool Header A group of fields that are associated with Output
Manager Print Server.

Output Statement A list of fields associated with the Nuance RJE header.

4. If you selected XML Job Ticket, click Map job ticket, and in the Open  dialog box, select one or more sample
tickets to create the ticket mappings. If necessary, click Clear mappings to remove any associated job mapping.
This option is not available for NSi Spool Header and Output Statement tickets, as they have fixed mappings.

5. Once one or more sample tickets have been mapped, use one of the following methods to search for the job ticket.
Option Description

Embedded in the document Searches for the job ticket embedded in a document. To
use this option configure the following options:

1. In the Start of job ticket recognition string box,
enter the appropriate string value.

2. In the End of job ticket recognition string box,
enter the appropriate string value.

3. Use the Remove from document check box to
determine if the job ticket data should be removed
from the document.
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Option Description
4. When using job tickets, all lines up to and including

the job ticket are deleted from the file. Select the
Keep data prior check box to prevent data loss.

In a separate file Searches for the job ticket in a separate file. To use this
option, configure the following options:

1. In the Folder to search box, click the browse
button (...) to choose a folder to search or type the
folder location in the box.

2. In the Match job ticket file name using this
document property list, select the appropriate
property.

3. In the Match job ticket extension using this
extension box, enter the appropriate file extension.

4. Use the Delete job ticket file after processing
document to determine if the job ticket profile
should be deleted after processing.

6. In the If the job ticket is not found, take the following action list, select how to process the document if the job
ticket is not found. You can choose to process the document normally, receive the document and place it in error
state, or reject the document.

7. Configure the document property mappings.
See Configuring Document Property Mappings.

8. Configure the document owner mappings.
See Configuring Document Owner Mappings.

How to Configure Job Parsing Profiles
Complete the following procedure to configure a job parsing profile.

1. Next to Job parsing profile, click New to create a job parsing profile.
You can also select a profile in the list and click Edit to make modifications.

2. Enter the profile Name and Description.
3. From the Job parsing tab, select the Originating printer family from the drop-down list.
4. Use one of the following methods to search for the printing instructions/job ticket.

Option Description

Embedded in the document Searches for the printing instructions/job ticket
embedded in a document.

• Use the Remove from document check box to
determine if the job ticket data should be removed
from the document.

• When using job tickets, all lines up to and including
the job ticket are deleted from the file. Select the
Keep data prior check box to prevent data loss.
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Option Description

In a separate file Searches for the printing instructions/job ticket in
a separate file. To use this option, configure the
following options:

• In the Folder to search box, click the browse
button (...) to choose a folder to search or type the
folder location in the box.

• In the Match job ticket file name using this
document property list, select the appropriate
property.

• In the Match job ticket extension using this
extension box, enter the appropriate file extension.

• Use the Delete job ticket file after processing
document to determine if the job ticket profile
should be deleted after processing.

5. In the If the job ticket is not found, take the following action list, select how to process the document if the job
ticket is not found.
You can choose to process the document normally, receive the document and place it in error state, or reject the
document.

6. Configure the document property mappings.
See Configuring Document Property Mappings.

7. Configure the document owner mappings.
See Configuring Document Owner Mappings.

How to Configure Headers from Data Profiles
Complete the following procedure to configure a headers from data profile.

Headers from data profiles consist of information that Nuance Output Manager can extract from specified location
within the actual document data. Nuance Output Manager can extract data from documents in various formats
including ASCII, ASCII with ASA, S/370, and VBM.

1. Next to Headers from data profile, click New to create a headers from data profile.
You can also select a profile in the list and click Edit to make modifications.

2. Enter the profile Name and Description.
3. From the Headers from data tab, select the Data format.

You can choose ASCII, ASCII with ASA, S/370, or VBM.
4. In the Code page list, select the code page for the document.
5. Specify the Extraction method, you can choose one of the following:

Option Description

Line-based Searches for the header based on a particular line.

Record-based Searches for the header based on a particular record,
regardless of page breaks.

6. In the Headers to extract grid, click in the grid to enter the headers to extract.
These variables will appear on the Document property mappings tab and Document owner mapping tab.
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7. Enter the following information in each column.
Option Description

Line-based • Name column — Specifies the header field for the
data to be placed in.

• Page column — Specifies the page where data
extraction will begin.

• Line column — Specifies the line number in the
file that contains the data.

• Column column — Specifies the column where
data extraction will begin. For ASCII with ASA
carriage control files, the first column is not counted
(in other words, the second column is treated as the
first column).

• Length column — Specifies how many characters
to extract.

Record-based • Name column — Specifies the header field for the
data to be placed in.

• Record column — Specifies the record number in
the file that contains the data.

• Position column — Specifies the position where
the header data will begin.

• Length column — Specifies how many characters
to extract.

8. Configure the document property mappings.
See Configuring Document Property Mappings.

9. Configure the document owner mappings.
See Configuring Document Owner Mappings.

How to Configure Document Property Mappings
Complete this procedure to configure the document property mappings for the extraction profile.

1. Click the Document property mappings tab.
2. To enable a document property mapping, click the Map Values check box for the appropriate property.
3. Click in the External Field column, to select the mapping from the list shown.

If necessary, you can use the look up table to adjust the values.
4. Click in the Unmapped Value Action column to select what happens when there is a missing look up table entry.

You can choose to skip the property mapping entirely, assign the external value as-is, or assign the unmapped
value default.

5. Click in the Unmapped Value Default column to specify a default value.

How to Configure Document Owner Mappings
Complete this procedure to specify how the document owner is set.

1. Click the Document owner mapping tab.
2. Choose one of the following options for setting the document owner.



Output Manager Administration Guide
Version 4.0 SP2

152 © 2016 Nuance Communications, Inc. All rights reserved.

Option Description

Use the Windows user id (if available) Sets the document owner to the Windows user ID. This
can be used with the following source types: Windows
queue, network folder, and Web file upload.

Map to the following external field Sets the document owner to external field selected in
the drop-down list.

Note:  For Job ticket tab profiles, the ticket
information fields are expressed as XPath
statements. XPath statements show the
structure of the ticket information. It allows
the ability to specify a specific instance of a
field if that particular information field occurs
more than once in a documents metadata. If a
particular external field is not listed in the list,
the XPath statement can be directly entered.

For Headers from data tab profiles, this list
will be populated with the headers specified.

3. If you chose to map to an external field, use one of the following methods to map the field.
Method Description

Use the external value as the OM user name Uses external document property information as the
Nuance Output Manager user name. Note, when the
document is first received by the source the document
has existing properties. These properties are called
external document property values.

Use the following lookup profile This is not currently implemented. When implemented,
you will be able to use a lookup table to map Personal
Identification Numbers to user names.

Use the following value mappings Uses the values entered in the table for the external
document property value. Click directly in the table to
enter the mapping values. When the external document
property has one of the values listed in the External
Field Value column, the value in the Property Value
column will be used.

4. Optional: If desired, under If unable to determine the document owner, assign the following user, click the
ellipsis button to assign a document owner from the User and Group Selection dialog box.
This user will be assigned if the document owner cannot be determined using the above mapping settings.

5. Click OK.

How to Order Document Property Profiles
Complete this procedure to order document property profiles.

You can determine the order in which the configured profiles are used when a document is received, and what the
default static value is if no data is found in the respective header. The mapping order can be configured for each
document property.
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1. From the Document Properties Profile dialog box, in the grid, click in the Mapping Order column for the
Nuance Output Manager document property.
This displays a configuration grid below the cell.

2. Use the following procedures to configure the mapping order.

• Configure the order in which headers are processed by selecting the appropriate rows and clicking the Up and
Down buttons.

• To enter a default static value, click in the Mapping/Value cell next to Static Value and either type or select
the value.

This static value is used if no data is found in the preceding headers. The static value by default is the value for
that document property in the source’s Document properties tab.

3. Click OK to create the document profile.
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Destinations

Learning About the Destinations Application
Use the Destinations application to manage and monitor destinations. The Destinations navigation pane displays a
configurable tree showing all destinations. You can drag-and-drop destinations to destination groups. Destinations are
used only for outbound data. They route files from Nuance Output Manager to a physical destination, such as a laser
printer, a host, or other location on the LAN.

The console window displays a tabbed view of the Destination tree selection. When a destination is selected in the
tree, a destination home page will display showing the properties and status of the destination. When a destination
group (folder) is selected in the tree, the Destinations grid will display listing all of the destinations in the group. The
Destinations grid is in a tab page control. By default, navigating the tree will replace the information in the active
tab. To open a destination or group in a new tab, right-click the item and click Open in New Tab. Your tree selection,
open tab pages, and console window settings will be saved for the next time you open the application.

By default a Documents grid will display below the Destinations grid. Notice there are two tabs below the grid,
Spooled and Retained. The Spooled tab lists all of the documents currently mapped to the destination selected in the
tree. The Retained tab lists all of the documents that were printed and retained by the selected destination. If a group
is selected, the list will contain documents for all of the destinations in the group. You can switch the tabs to view
either spooled or retained documents. As you select items in the tree, both of the grids will update to show only the
appropriate documents.

The following table describes destination states:

Destination State Description

Offline The destination cannot accept documents.

Ready The destination is ready to accept documents.

Processing The document that is being sent to the destination is bein
g prepared for printing. The destination is waiting to star
t printing.

Printing A document is currently being printed.

Pause Document processing has been paused.

Intervention An error has occurred on the physical printer that require
s user intervention. For example, the printer may be out o
f paper or there could be a printer jam.

Down An error occurred on the printer.

Warning ON This state is used only for Output Manager Print Server
destination printers. This indicates the Output Manager
Print Server destination printer is in an intervention state
(for example, out of paper, cover open, and needs toner).
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Destination State Description

Moving Off-Line A printer destination has been disabled while a documen
t is being printed. The printer will continue to print the d
ocument until completed.

Moving On-Line This is a transitional state that occurs when the printer is
in a Moving Off-Line state, the destination is printing a
large document, and the operator decides to set the desti
nation back to Enabled before the document finishes pri
nting.

How to Manage Destination Groups
Destination groups are used to organize destinations in the Destination tree.

Groups are represented as folders in the tree. From the Output Manager Console Destinations tree, you can create,
move, rename, and delete destination groups.

• Create a destination group
• Move a destination group
• Rename a destination group
• Delete a destination group

To create a destination group

When you create a new group inside of an existing group, it inherits the permissions of the parent group.

1. In the Destinations tree, right-click a destination group (folder) and click New Group. A new group (folder) titled
UnNamed is added to the selected destination group.

2. In the edit field, type the name of the new group and press Enter.

To move a destination group

1. In the Destinations tree, click the destination group you want to move.
2. Drag the group to the desired tree location.

As you drag the group, a yellow arrow will appear to the left of the tree to indicate where the group will be placed.

To rename a destination group

1. In the Destinations tree, right-click a destination group, and click Rename.
2. In the edit field, type the new group name and press Enter. To cancel the rename, press ESC.

To delete a destination group

All of the objects must be removed before the group can be deleted. Groups that contain destinations or destination
groups cannot be deleted.

1. In the Destinations tree, right-click the destination you want to delete.
2. Click Delete on the shortcut menu.
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How to Add Destinations
Complete this procedure to add destinations to the Destinations application.

1. In the Destinations tree, right-click the destination group (folder) where you want to add destinations, and click
New Destination on the shortcut menu.
This opens the Add Destination dialog.

2. In the Type list, choose to create one of the follow destination types:

• Document Library
• Email
• FTP
• IPDS (not available for new sales)
• IPP
• JDF/JMF
• LPR
• Network Folder
• Output Manager
• PRISMAProduction
• SharePoint
• Socket
• WebSphere MQ
• Windows Queue

3. Next to Add new devices enter the number of destinations you want to create.
You can create multiple destinations of the type selected and configure the destinations simultaneously. The
configuration tab pages that displays is different depending on whether you choose to create a single destination or
multiple destinations.

Destination Displays

Single destination configuration Configuration options are listed on the tab pages.

Multiple destination configuration Destinations are configured in grid format on each tab
page.

You will need to configure the options for each destination row. You can use Series Fill to automatically populate
multiple fields in a column. To create a series fill, select the rows you want to automatically fill and then click
inside one of the cells that you are editing. Click Series Fill and enter the text and configure the counter in the
Series Fill dialog box. The series will start with the first selected row.

4. Click OK.
Tab pages will display with options specific to the selected destination type. The configuration options is different
depending on whether you choose to create a single destination or multiple destinations. When configuring one
destination, individual options are listed on the tab pages. When configuring multiple destinations, the options
are listed in grid format to allow for configuring multiple destinations simultaneously. You can add and remove
destinations by clicking Add and Remove below the grid. You can also select destinations and click Copy to
create copies

5. Configure the general settings.
For multiple destination configuration, this is configured on the General tab.
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a) Enter the destination Name.
b) In the Server list, click the Nuance Output Manager server where the Nuance Output Manager Output Service

is located for this destination.
The destination does not have to be on the same server as the Nuance Output Manager Output Service.

c) Enter any Comments or Location information for the destination.
d) Optional: To change the large destination image that displays when configuring a single destination, you can

click Select Image and choose the appropriate image file (BMP, JPEG, or PNG).
The selected image will be compressed and scaled to 96x96 pixels. Changing this image will not change the
smaller image that displays or the image that displays in the source tree. To change the image back to the
default, click Reset Image.

6. Make the necessary changes on each tab.
7. Click OK.

How to Modify Destinations
Complete this procedure to modify destinations in the Destinations application.

1. In the Destinations tree, right-click the destination you want to modify and click Configure.
You can also right-click a destination in the grid view and click Configure.
The dialog box that opens will vary depending on the type of destination selected.

2. In the Configuration dialog box, make any necessary changes.
3. Click OK

How to Remove Destinations
Complete the following steps to remove destinations from the Destinations application.

1. In the Destinations tree, right-click the destination you want to delete.
2. Click Delete on the shortcut menu.

How to Import Destinations
Use this procedure to import a list of destinations into Nuance Output Manager.

Before you begin, review the following information on configuring and importing comma-separated values (CSV)
files:

• In the CSV file, the header record (first record) determines which fields are defined. You must configure the field
names in the header record to match predefined Nuance Output Manager names. Field names that match are used
to populate the settings associated with that column. Field names that do not match are ignored. Contact Nuance
Support for the list of predefined Nuance Output Manager names.

• Each record after the header record is created as a device. The device will contain the settings from the recognized
columns for that record. Nuance Output Manager interprets values for text and numeric settings. For settings that
have a fixed list of options, Nuance Output Manager matches the value to the name of the option. Values which
are not recognized, out of bounds, or otherwise invalid are replaced with the default value for that setting.

• Not all settings can be specified through the CSV file. For example, the input/output server, users, destinations,
and profiles cannot be imported.
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• A single CSV file can be used to generate multiple device types, sources, and destinations. Nuance Output
Manager only imports the settings which are recognized by the device type you are creating. For example, the
CSV file can contain settings that are common to all devices types, settings for a particular device type, or settings
for several different device types.

Importing a destination is particularly useful if you have a database or spreadsheet that lists your existing equipment.
You can save the destination list as a CSV file and then import it to create matching destinations in Nuance Output
Manager.

1. In the Destinations tree, right-click a destination group (folder) and click New Destination.
The new destinations will be created in this group.

2. In the Add Destination dialog box, select the destination Type:

• Email
• OM
• FTP
• IPP LPR
• Network Folder
• Socket
• WebSphere MQ
• Windows Queue

You cannot currently import IPDS destinations.
3. Select Import devices from configuration (.CSV) file.
4. In the box, enter the path and file name of the configuration file, or click the browse (...) button to navigate to the

file.
5. After you specify the configuration file, click OK.

Tab pages will display with options specific to the selected destination type.
6. Make the necessary changes on each tab.

For instructions specific to each destination type, refer to the following topics:

• Sending documents to an email address
• Routing documents to another Nuance Output Manager
• Sending documents to an FTP server
• Sending documents to an IPDS printer (not available for new sales)
• Sending documents to an IPP destination
• Sending documents to an LPR server
• Sending documents to a network folder
• Sending documents to a PRISMAProduction destination
• Sending documents to a SharePoint site
• Sending documents to a socket
• Sending documents to a WebSphere MQ
• Sending documents to a Windows queue

7. Click OK.
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How to Redirect Destinations
Complete this procedure to redirect a destination in the Destinations application.

Destinations can be set in a redirect mode. This causes new documents assigned to a destination to be automatically
reassigned to a different destination.

For example, you can configure Destination A to reassign all received documents to Destination B. Documents
already assigned to Destination A when the redirection occurs, will not be redirected. Documents received for
Destination A while the redirection is in affect, will be assigned to Destination B. This includes Destination A being
assigned by a source as a document is received, Destination A being assigned during business rule processing, and
Destination A being assigned by failover processing. Destination assignments as a result of failover to Destination A
will also be redirected to Destination B.

1. From the Destinations tree or Destination grid, right-click the destination you want to redirect and click
Destination Redirect.
This opens the Select Redirected Destination dialog box.

2. In the tree, select the destination you want to receive the redirected documents.
The destination icon in the tree indicates if the destination is offline. The images for offline destinations are gray
with a red no symbol (for example, an offline folder destination would display as ).

3. Configure the redirect by choosing one of the radio button options. To disable redirect, choose Do not redirect
printer.
You can select to redirect until manually turned off, redirect for a number of hours, redirect for a number of
minutes, or redirect until a specific date and time.

4. Click OK.

How to Search for Destinations
Perform the following procedure to search for destinations.

• You can search for destinations from the Destinations tree or the Destinations grid.
To search from the: Do this

Destinations tree • In the Search box below the tree, type the text you
want to find and press Enter or click the search
button.

Destinations grid • In the Search box below the grid, type the text you
want to find, click the column in the grid you want
to search, and press Enter or click the Search image.

If the text is found, the focus will move to the first occurrence. New buttons appear near the Search box that allow
you to move to the previous or next occurrence.
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How to Configure Security for Destinations
Follow steps in this procedure to configure permissions to destinations for user or groups.

To begin configuring destination security, start by assigning the desired destination permissions for the All
Destinations group. To view destinations in the tree, users or user groups must be assigned the Allow user to view
the Destination permission in the All Destinations group. Users not assigned this permission in the All Destinations
group will not see any destinations or groups even though they may have been given permissions for the specific
destination or group.

Nuance Output Manager security for the Destinations application begins at the root of the Destinations tree, the
All Destinations group. The Destinations tree consists of destinations and destination groups. A destination is an
output from Nuance Output Manager. A destination group is a way to organize destinations. Nuance Output Manager
security is provided for both by adding a Microsoft Windows user or user group to the destination or destination
group and assigning permissions to that user or user group. These Nuance Output Manager permissions define
the type of access users and user groups have to the destinations and destination groups. Once the Nuance Output
Manager security (Microsoft Windows users, user groups, and destination permissions) is set in a destination group,
the Nuance Output Manager security is inherited by all the objects in that destination group. When a new destination
or destination group is created, its security is automatically the same as its parent destination group’s security (that is,
the new destination inherits its security from its parent destination group).

1. In the Output Manager Console, select the Destinations application in the navigation pane.
2. In the Destinations tree, right-click a destination or destination group and click Security.

To complete this step, a user must be a member of the local Administrators group or be assigned the Allow user
to modify the Destination’s security configuration permission. Users with this permission can add and remove
users or groups and modify assigned permissions.
Completing this step opens the Security Configuration dialog box.
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3. Use the Inherit permissions from the parent option to inherit permissions from a parent group or to remove
inheritance.

• Click the browse button (...) to select a new parent group for inheritance or to remove inheritance.

By default, destinations are configured to inherit permissions from the parent folder.

Tip:  It is a recommended practice to assign rights using inheritance, as it allows administrators to easily
assign and manage permissions. Blocking inheritance is useful when a destination or destination group
needs to be seen by just a few users. If you plan to block inheritance, make sure the users that need access
to the blocked destination or group are in the security settings for all of its parent groups, including All
Destinations. If this is not done then those users will not be able to see the destination. Also remember to
remove the users and user groups that should not have access to the destination or group.

4. In the Users and groups with permissions box, select a user or group to manage.

• If a group or user does not appear in the list, click Add to open the User and Group Selection dialog box. See
Adding users and groups to Nuance Output Manager  for detailed procedures on adding users.

The Assigned permissions list box displays permissions that are currently granted to the selected user or group.
5. In the Assigned permissions box, select or clear check boxes to grant or revoke permissions for the selected user

or group.

• You can click Select All or Unselect All to quickly grant or revoke all permissions.

The permissions assigned to a destination group will be inherited for all of the objects contained in that group,
except for the ones that have inheritance blocked.

If you notice permissions that are selected and disabled, then the user/group selected has inherited permissions.
Inherited permissions cannot be removed. To remove inherited permissions, you must first block inheritance for
the destination.

6. When you are finished configuring security, click OK to save your changes.

Routing Documents

Sending Documents to AutoStore
Complete this procedure to define a destination for printing to AutoStore.

1. In the Destinations tree, right-click the destination group (folder) where you want to add destinations, and click
New Destination.

2. In the Type drop-down list box on the Add Destination dialog box, select AutoStore.
3. Click OK.
4. Configure general settings:

a) Enter the destination Name.
b) In the Server list, click the Nuance Output Manager server where the Nuance Output Manager Output Service

is located for this destination.
c) Enter any Comments or Location information.
d) Optional: To change the large destination image that appears when configuring a single destination, click

Select Image and select the image file (BMP, JPEG, or PNG). To change the image back to the default, click
Reset Image.
The selected image is compressed and scaled to 96x96 pixels. Changing this image does not change the
smaller image that displays or the image that displays in the destination tree.
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5. On the AutoStore settings tab, configure settings as described in AutoStore settings tab (Destination
Configuration) on page 497.

You can configure a default value and a dynamic override value for most options. Default values are used to
manage the documents as they are being sent to the destination. You can dynamically override the default values
using document properties and functions. To insert document properties, right-click in the dynamic box and click
Insert Document Property. A menu containing all of the available properties appears. You can select a property
from the list or type the property name. If a property is selected and it contains a value, that value is processed
instead of the default value. To insert functions, right-click in the dynamic box, click Insert Function, and select
the appropriate function. Review the Using Nuance Output Manager Functions help topic for information on
configuring functions.

6. Configure options on the More settings tab:
a) Select the printing cost per page for black and white and color documents.
b) Select Include documents in Green Reports to make documents sent to the destination available for green

reports. The documents appear in green reports once Nuance Output Manager deletes them from the Retained
tab.

c) Select the appropriate Printer family.
Printer families are used to configure commands for print languages and map them to destinations based on
their capabilities. You can select an existing printer family in the list or create one in the Printer Family
Profile dialog box. To create a printer family during single destination configuration, click New. To create
during multiple destination configuration, click the Browse button.

d) Optional: If you select a Printer family, you can configure Destination specific capabilities.
These options determine which print preferences/document properties are supported by the destination. To
configure destination specific capabilities, click Configure to open the Destination Capabilities dialog box.
All of the document properties available to this destination are listed and grouped into categories. Expand the
appropriate category by clicking the arrow next to the category name. Select the check boxes for properties
you want to be available for configuration throughout Nuance Output Manager. Clear the check boxes for
properties you do not want to be available. If a property is configured by selecting from a list of options, those
options will display beneath the property. Select and clear the check boxes to determine the choices that will
be available when those properties are configured. Repeat this step until all properties are configured, and then
click OK.

e) Select the appropriate Output process. You can select an existing process in the list or create one using the
Process Designer.

• To create a process during single destination configuration, click New.
• To create during multiple destination configuration, click the Browse button.

Output processes can be created to impact documents as they are being sent to a destination. The processes
contain a set of actions which could be used for search and replace, setting finishing options, editing PJL
commands, inserting overlays, and so on.

f) Determine if you want to override the output process assigned to the document and use the selected destination
output process.

g) Select the appropriate Failover profile. You can select an existing profile in the list or create one in the
Failover Profile dialog box.

• To create a profile during single destination configuration, click New.
• To create during multiple destination configuration, click the Browse button.

Failover profiles specify what should happen to documents when they are sent to inaccessible destinations
(they are not able to receive documents).
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h) Determine if you want to override the failover profile assigned to the document and use the selected
destination failover profile.

7. On the Error handling tab, configure the error handling options.

• For single destination configuration, use the Error handling tab.
• For multiple destination configuration, use the Error handling tab (Bulk Configuration).

a) Select the appropriate Error handling profile. You can select an existing profile in the list, or create one in the
Error Handling Profile dialog box. To create a profile during single destination configuration, click New. To
create during multiple destination configuration, click the Browse button.
Error handling profiles specify what should happen to destinations when an error is detected via SNMP or
during transmission of a document.

b) Choose the Default failover destination.
This specifies what should happen to documents when they are sent to inaccessible destinations (they are not
able to receive documents). You can choose to route the documents to a parent group or a specific destination
or group. The parent group where the destination currently resides is selected by default.

8. Click OK.

Sending Documents to an Email Address
Complete this procedure to define destinations for printing to an email address. Documents routed to a destination
will be sent to the specified email address.

1. In the Destinations tree, right-click the destination group (folder) where you want to add destinations, and click
New Destination.
This opens the Add Destination dialog box.

2. In the Type list, select Email.
3. In the Add new devices box, enter the number of destinations you want to create.

You can create a single email destination or create multiple email destinations and configure them simultaneously.
4. Click OK.
5. Configure the general settings.

For multiple destination configuration, this is configured on the General tab.
a) Enter the destination Name.
b) In the Server list, click the Nuance Output Manager server where the Nuance Output Manager Output Service

is located for this destination.
The destination does not have to be on the same server as the Nuance Output Manager Output Service.

c) Enter any Comments or Location information for the destination.
d) Optional: To change the large destination image that displays when configuring a single destination, you can

click Select Image and choose the appropriate image file (BMP, JPEG, or PNG).
The selected image will be compressed and scaled to 96x96 pixels. Changing this image will not change the
smaller image that displays or the image that displays in the source tree. To change the image back to the
default, click Reset Image.

6. Configure email settings.

Configuration Method

Single destination configuration Use the Email settings tab.

Multiple destination configuration Use the Email settings (Bulk Configuration) tab.
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a) Select the Email profile that will be used with this destination.
You can select a profile in the list or click the ... button and manage profiles in the Manage Outbound Email
Profiles dialog box. In this dialog box you can create and modify email profiles.

b) In the To, CC, and BCC fields, enter destination email addresses. Separate multiple email addresses with a
comma.

c) In the From field, specify the email address that will be shown as the sender of all documents sent to this
destination.

d) In the Reply to field, specify the email address where replies will be routed. You can enter multiple email
addresses separated by a comma.

e) Enter the Subject that will display for all documents sent to this destination.
f) Enter the Body text that will display in the email message for all documents sent to this destination.

You can configure a default value and a dynamic override value for most options. Default values are used to
manage the documents as they are being sent to the destination. You can choose to dynamically override the
default values using document properties and functions. To insert document properties, right-click in the dynamic
box and click Insert Document Property. A menu containing all of the available properties displays. You
can select a property in the list or type the property name. If a property is selected and it contains a value, that
value is processed instead of the default value. To insert functions, right-click in the dynamic box, click Insert
Function, and choose the appropriate function. Review the Using Nuance Output Manager Functions help topic
for information on configuring functions.

7. Configure options on the More settings tab.

Configuration Method

Single destination configuration Use the More settings tab.

Multiple destination configuration Use the More settings (Bulk Configuration) tab.

a) Select the printing cost per page for black and white and color documents.
b) Select Include documents in Green Reports to make documents sent to the destination available for green

reports. The documents appear in green reports once Nuance Output Manager deletes them from the Retained
tab.

c) Select the appropriate Printer family.
Printer families are used to configure commands for print languages and map them to destinations based on
their capabilities. You can select an existing printer family in the list or create one in the Printer Family
Profile dialog box. To create a printer family during single destination configuration, click New. To create
during multiple destination configuration, click the Browse button.

d) Optional: If you select a Printer family, you can configure Destination specific capabilities.
These options determine which print preferences/document properties are supported by the destination. To
configure destination specific capabilities, click Configure to open the Destination Capabilities dialog box.
All of the document properties available to this destination are listed and grouped into categories. Expand the
appropriate category by clicking the arrow next to the category name. Select the check boxes for properties
you want to be available for configuration throughout Nuance Output Manager. Clear the check boxes for
properties you do not want to be available. If a property is configured by selecting from a list of options, those
options will display beneath the property. Select and clear the check boxes to determine the choices that will
be available when those properties are configured. Repeat this step until all properties are configured, and then
click OK.

e) Select the appropriate Output process. You can select an existing process in the list or create one using the
Process Designer.
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• To create a process during single destination configuration, click New.
• To create during multiple destination configuration, click the Browse button.

Output processes can be created to impact documents as they are being sent to a destination. The processes
contain a set of actions which could be used for search and replace, setting finishing options, editing PJL
commands, inserting overlays, and so on.

f) Determine if you want to override the output process assigned to the document and use the selected destination
output process.

g) Select the appropriate Failover profile. You can select an existing profile in the list or create one in the
Failover Profile dialog box.

• To create a profile during single destination configuration, click New.
• To create during multiple destination configuration, click the Browse button.

Failover profiles specify what should happen to documents when they are sent to inaccessible destinations
(they are not able to receive documents).

h) Determine if you want to override the failover profile assigned to the document and use the selected
destination failover profile.

8. On the Error handling tab, configure the error handling options.

Configuration Method

Single destination configuration Use the Error Handling tab.

Multiple destination configuration Use the Error Handling (Bulk Configuration) tab.

a) Select the appropriate Error handling profile. You can select an existing profile in the list, or create one in the
Error Handling Profile dialog box. To create a profile during single destination configuration, click New. To
create during multiple destination configuration, click the Browse button.
Error handling profiles specify what should happen to destinations when an error is detected via SNMP or
during transmission of a document.

b) Choose the Default failover destination.
This specifies what should happen to documents when they are sent to inaccessible destinations (they are not
able to receive documents). You can choose to route the documents to a parent group or a specific destination
or group. The parent group where the destination currently resides is selected by default.

9. Click OK.

Sending Documents to a Fiery Device
Complete this procedure to define destinations for printing to a fiery device. Documents routed to this destination will
be sent to the fiery device specified.

1. In the Destinations tree, the destination group (folder) where you want to add destinations, right-click the
destination group (folder) where you want to add destinations and click New Destination.
This opens the Add Destination dialog box.

2. In the Type list, select Fiery Device.
3. Next to Add new devices, enter the number of destinations you want to create.

You can create a single destination or create multiple destinations and configure them simultaneously.
4. Click OK.
5. Configure the general settings.
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For multiple destination configuration, this is configured on the General tab.
a) Enter the destination Name.
b) In the Server list, click the Nuance Output Manager server where the Nuance Output Manager Output Service

is located for this destination.
The destination does not have to be on the same server as the Nuance Output Manager Output Service.

c) Enter any Comments or Location information for the destination.
d) Optional: To change the large destination image that displays when configuring a single destination, you can

click Select Image and choose the appropriate image file (BMP, JPEG, or PNG).
The selected image will be compressed and scaled to 96x96 pixels. Changing this image will not change the
smaller image that displays or the image that displays in the source tree. To change the image back to the
default, click Reset Image.

6. Configure fiery device settings.

Configuration Method

Single destination configuration Use the Fiery device settings tab.

Multiple destination configuration Use the Fiery device settings (Bulk Configuration) ta
b.

a) Enter a valid Fiery server.
This can be a server name or IP address.

b) Specify the port number. To use the default fiery port, select the Use default port check box. To specify a port
number, disable the check box and enter the Port number in the spin box.
The port number must be from 1 through 65536. The default value is 8021.

c) Configure the logon for the server. To use the Windows credentials of the Nuance Output Manager Output
Service to logon, select the Use service logon check box. To specify a logon, make sure the check box is
disabled and enter the User name and Password that will be used.

d) Specify the Logical printer on the fiery server where documents will be sent to for printing.

You can configure a default value and a dynamic override value for most options. Default values are used to
manage the documents as they are being sent to the destination. You can choose to dynamically override the
default values using document properties and functions. To insert document properties, right-click in the dynamic
box and click Insert Document Property. A menu containing all of the available properties is displayed. You
can select a property from the list or type the property name. If a property is selected and it contains a value, that
value is processed instead of the default value. To insert functions, right-click in the dynamic box, click Insert
Function, and choose the appropriate function. Review the Using Nuance Output Manager Functions help topic
for information on configuring functions.

7. Configure options on the More settings tab.

Configuration Method

Single destination configuration Use the More settings tab.

Multiple destination configuration Use the More settings (Bulk Configuration) tab.

a) Select the printing cost per page for black and white and color documents.
b) Select Include documents in Green Reports to make documents sent to the destination available for green

reports. The documents appear in green reports once Nuance Output Manager deletes them from the Retained
tab.
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c) Select the appropriate Printer family.
Printer families are used to configure commands for print languages and map them to destinations based on
their capabilities. You can select an existing printer family in the list or create one in the Printer Family
Profile dialog box. To create a printer family during single destination configuration, click New. To create
during multiple destination configuration, click the Browse button.

d) Optional: If you select a Printer family, you can configure Destination specific capabilities.
These options determine which print preferences/document properties are supported by the destination. To
configure destination specific capabilities, click Configure to open the Destination Capabilities dialog box.
All of the document properties available to this destination are listed and grouped into categories. Expand the
appropriate category by clicking the arrow next to the category name. Select the check boxes for properties
you want to be available for configuration throughout Nuance Output Manager. Clear the check boxes for
properties you do not want to be available. If a property is configured by selecting from a list of options, those
options will display beneath the property. Select and clear the check boxes to determine the choices that will
be available when those properties are configured. Repeat this step until all properties are configured, and then
click OK.

e) Select the appropriate Output process. You can select an existing process in the list or create one using the
Process Designer.

• To create a process during single destination configuration, click New.
• To create during multiple destination configuration, click the Browse button.

Output processes can be created to impact documents as they are being sent to a destination. The processes
contain a set of actions which could be used for search and replace, setting finishing options, editing PJL
commands, inserting overlays, and so on.

f) Determine if you want to override the output process assigned to the document and use the selected destination
output process.

g) Select the appropriate Failover profile. You can select an existing profile in the list or create one in the
Failover Profile dialog box.

• To create a profile during single destination configuration, click New.
• To create during multiple destination configuration, click the Browse button.

Failover profiles specify what should happen to documents when they are sent to inaccessible destinations
(they are not able to receive documents).

h) Determine if you want to override the failover profile assigned to the document and use the selected
destination failover profile.

8. On the Error handling tab, configure the error handling options.

Configuration Method

Single destination configuration Use the Error Handling tab.

Multiple destination configuration Use the Error Handling (Bulk Configuration) tab.

a) Select the appropriate Error handling profile. You can select an existing profile in the list, or create one in the
Error Handling Profile dialog box. To create a profile during single destination configuration, click New. To
create during multiple destination configuration, click the Browse button.
Error handling profiles specify what should happen to destinations when an error is detected via SNMP or
during transmission of a document.

b) Choose the Default failover destination.
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This specifies what should happen to documents when they are sent to inaccessible destinations (they are not
able to receive documents). You can choose to route the documents to a parent group or a specific destination
or group. The parent group where the destination currently resides is selected by default.

9. Click OK.

Sending Documents to an FTP Server
Complete this procedure to define destinations for printing to an FTP server. Documents routed to a destination will
be sent to the FTP server specified by the destination.

1. In the Destinations tree, the destination group (folder) where you want to add destinations, right-click the
destination group (folder) where you want to add destinations and click New Destination.
This opens the Add Destination dialog box.

2. In the Type list, select FTP.
3. Next to Add new devices, enter the number of destinations you want to create.

You can create a single destination or create multiple destinations and configure them simultaneously.
4. Click OK.
5. Configure the general settings.

For multiple destination configuration, this is configured on the General tab.
a) Enter the destination Name.
b) In the Server list, click the Nuance Output Manager server where the Nuance Output Manager Output Service

is located for this destination.
The destination does not have to be on the same server as the Nuance Output Manager Output Service.

c) Enter any Comments or Location information for the destination.
d) Optional: To change the large destination image that displays when configuring a single destination, you can

click Select Image and choose the appropriate image file (BMP, JPEG, or PNG).
The selected image will be compressed and scaled to 96x96 pixels. Changing this image will not change the
smaller image that displays or the image that displays in the source tree. To change the image back to the
default, click Reset Image.

6. Configure FTP settings.

Configuration Method

Single destination configuration Use the FTP settings tab.

Multiple destination configuration Use the FTP settings (Bulk Configuration) tab.

a) Enter a valid FTP server. This can be an FTP or IP address.
b) Enter the host's Port number.

The port number must be from 1 through 65536. The default value is 21.
c) Enter the User name that will be used when logging onto the host.

If the host does not require a user name, you can leave this box blank.
d) Enter the Password that will be used when logging onto the host.

If the host does not require a password, you can leave this box blank.
e) Enter the Target folder.

This is the location on the host where the files will be placed. You must type the entire path of the folder or the
path relative to the FTP user home directory (for example, if your home directory is at \FTP\UserName, you
can either specify \FTP\UserName\MyDestFiles or \MyDestFiles).
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f) Choose if you want to Use passive mode.
This determines if the host mode will be passive or active. Selecting the check box selects passive mode,
where the client creates a session to receive data. Clearing the check box will choose active mode, where the
host creates a separate or new session to transfer data in response to a request from the client.

You can configure a default value and a dynamic override value for most options. Default values are used to
manage the documents as they are being sent to the destination. You can choose to dynamically override the
default values using document properties and functions. To insert document properties, right-click in the dynamic
box and select Insert Document Property. A menu containing all of the available properties displays. You can
select a property from the list or type the property name. If a property is selected and it contains a value, that
value is processed instead of the default value. To insert functions, right-click in the dynamic box, select Insert
Function, and choose the appropriate function. Review the Using Nuance Output Manager Functions help topic
for information on configuring functions.

7. Configure options on the More settings tab.

Configuration Method

Single destination configuration Use the More settings tab.

Multiple destination configuration Use the More settings (Bulk Configuration) tab.

a) Select the printing cost per page for black and white and color documents.
b) Select Include documents in Green Reports to make documents sent to the destination available for green

reports. The documents appear in green reports once Nuance Output Manager deletes them from the Retained
tab.

c) Select the appropriate Printer family.
Printer families are used to configure commands for print languages and map them to destinations based on
their capabilities. You can select an existing printer family in the list or create one in the Printer Family
Profile dialog box. To create a printer family during single destination configuration, click New. To create
during multiple destination configuration, click the Browse button.

d) Optional: If you select a Printer family, you can configure Destination specific capabilities.
These options determine which print preferences/document properties are supported by the destination. To
configure destination specific capabilities, click Configure to open the Destination Capabilities dialog box.
All of the document properties available to this destination are listed and grouped into categories. Expand the
appropriate category by clicking the arrow next to the category name. Select the check boxes for properties
you want to be available for configuration throughout Nuance Output Manager. Clear the check boxes for
properties you do not want to be available. If a property is configured by selecting from a list of options, those
options will display beneath the property. Select and clear the check boxes to determine the choices that will
be available when those properties are configured. Repeat this step until all properties are configured, and then
click OK.

e) Select the appropriate Output process. You can select an existing process in the list or create one using the
Process Designer.

• To create a process during single destination configuration, click New.
• To create during multiple destination configuration, click the Browse button.

Output processes can be created to impact documents as they are being sent to a destination. The processes
contain a set of actions which could be used for search and replace, setting finishing options, editing PJL
commands, inserting overlays, and so on.

f) Determine if you want to override the output process assigned to the document and use the selected destination
output process.
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g) Select the appropriate Failover profile. You can select an existing profile in the list or create one in the
Failover Profile dialog box.

• To create a profile during single destination configuration, click New.
• To create during multiple destination configuration, click the Browse button.

Failover profiles specify what should happen to documents when they are sent to inaccessible destinations
(they are not able to receive documents).

h) Determine if you want to override the failover profile assigned to the document and use the selected
destination failover profile.

8. On the Error handling tab, configure the error handling options.

Configuration Method

Single destination configuration Use the Error Handling tab.

Multiple destination configuration Use the Error Handling (Bulk Configuration) tab.

a) Select the appropriate Error handling profile. You can select an existing profile in the list, or create one in the
Error Handling Profile dialog box. To create a profile during single destination configuration, click New. To
create during multiple destination configuration, click the Browse button.
Error handling profiles specify what should happen to destinations when an error is detected via SNMP or
during transmission of a document.

b) Choose the Default failover destination.
This specifies what should happen to documents when they are sent to inaccessible destinations (they are not
able to receive documents). You can choose to route the documents to a parent group or a specific destination
or group. The parent group where the destination currently resides is selected by default.

9. Click OK.

Sending Documents to an IPDS Printer
Complete this procedure to define destinations for printing to an IPDS printer.

Important:  If you use a third-party conversion tool, verify that it is licensed for the necessary input formats
and for IPDS output to use IPDS destinations.

Notice:  Please note that the IPDS output option is not available for new sales.

1. In the Destinations tree, the destination group (folder) where you want to add destinations, right-click the
destination group (folder) where you want to add destinations and click New Destination.
This opens the Add Destination dialog box.

2. In the Type list, select IPDS.
Currently you can configure only one IPDS destination at a time.

3. Click OK.
4. Configure the general settings.

For multiple destination configuration, this is configured on the General tab.
a) Enter the destination Name.
b) In the Server list, click the Nuance Output Manager server where the Nuance Output Manager Output Service

is located for this destination.
The destination does not have to be on the same server as the Nuance Output Manager Output Service.
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c) Enter any Comments or Location information for the destination.
d) Optional: To change the large destination image that displays when configuring a single destination, you can

click Select Image and choose the appropriate image file (BMP, JPEG, or PNG).
The selected image will be compressed and scaled to 96x96 pixels. Changing this image will not change the
smaller image that displays or the image that displays in the source tree. To change the image back to the
default, click Reset Image.

5. Configure the IPDS settings.
a) On the IPDS settings tab, click Create to create an IPDS transform configuration. If an IPDS configuration is

already defined for the printer, click Edit to view or change your configuration settings.
This opens the Configure Transform dialog box.

b) In the Server list, click the Nuance Output Manager server where the conversion tool is installed.
c) In the Transform package list, you can select an existing IPDS transform package or create one. Complete the

following steps to create an IPDS transform package.

1. Click New.

This opens the General tab.
2. Enter the transform package Name.

The transform package Type will display IPDS.
3. Verify the EXE path is set to the correct folder. To change the path, type in the box or click the browse

button (...).

The EXE path for the IPDS transform type is automatically selected, @EOMTransformDir.
4. Set the Logging State.

The logging state determines if transform logs and temp files will be saved in the document folder. By
default, the Logging State is set to Yes.

All log files should be inspected during installation and preproduction testing to insure that fonts are
correctly mapped. In a production system, the logging can be disabled to save disk space. If the transform
operation returns an error (return code not zero), the log and temp files will not be deleted, and are
available for troubleshooting.

5. On the Filter Profiles tab, configure the IPD (IPDS) profile to enter the IPDS printer name and IP address.
Configure/select a filter profile for the remaining formats as necessary.

We recommend that to avoid confusion the same printer name be used within the IPDS profile and for the
Nuance Output Manager destination name. Multiple IPDS printers and connections can be configured in
the same profile.

6. To configure a profile, click the browse button (...) in the Modify/New column for the appropriate formats.
From the Configure Filter Profile dialog box, configure the profile as needed.

The profile contains a communications and printer definition section.
7. To select a profile, click in the Configuration column for the appropriate formats and select the profile

from the list.
8. On the Resources tab, you can control the search order for font resources.

You can add paths by clicking in the top row of the grid or modify the listed paths by clicking directly in
the grid. You will need to verify the Adobe and Ghostscript paths are correct and update if necessary (make
sure to use the path to the fonts, not the path to the EXE file).

9. On the Fonts tab, you can control the font mapping of input fonts to output fonts.
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The defaults are typically correct, but may need to be adjusted for special cases. You can add or modify
fonts directly in the grid.

10. Click OK to create the transform package.
11. Select the Override input filter profile assigned to document check box if you want to use the filter

profile in the transform package.

Use the Override input filter profile assigned to document check box option to determine if you want to
override the input filter profile assigned to the document or if you want to use the filter profile configured
in the transform package.

12. Configure the conversion of each input format in the Input Formats grid and then click OK.

For Do This

All unlicensed input formats and any input
formats you do not want to transform

Click the corresponding grid cell under th
e Configuration column and select Do Not
Transform.

Licensed input formats Select Use Default Options or select a predefined c
onfiguration in the Configuration column. To conf
igure a custom input format, click the browse butto
n (...) in the Modify/New column.

If Use Default Options or Do Not Transformis selected in the Configuration column, a new
configuration will be created. If a predefined configuration is selected, that configuration will be modified.
The custom transform options are configured on the Input options tab, Output options tab, and Page
Layout tab.

13. In the Printer name list, select the IPDS printer to use.

Tip:  We recommend to avoid confusion that the same printer name be used within the IPDS
profile and for the Nuance Output Manager destination name.

You can configure a default value and a dynamic override value for this option. The default value is used
to manage the documents as they are being sent to the destination. You can choose to dynamically override
the default value using document properties and functions. To insert document properties, right-click in
the dynamic box and click Insert Document Property to display a menu containing all of the available
properties. You can select a property from the list or type the property name. If a property is selected and it
contains a value, that value is processed instead of the default value. To insert functions, right-click in the
dynamic box and click Insert Function, then choose the appropriate function. Review the Using Nuance
Output Manager Functions help topic for information on configuring functions.

6. Configure options on the More settings tab.

Configuration Method

Single destination configuration Use the More settings tab.

Multiple destination configuration Use the More settings (Bulk Configuration) tab.

a) Select the printing cost per page for black and white and color documents.
b) Select Include documents in Green Reports to make documents sent to the destination available for green

reports. The documents appear in green reports once Nuance Output Manager deletes them from the Retained
tab.

c) Select the appropriate Printer family.
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Printer families are used to configure commands for print languages and map them to destinations based on
their capabilities. You can select an existing printer family in the list or create one in the Printer Family
Profile dialog box. To create a printer family during single destination configuration, click New. To create
during multiple destination configuration, click the Browse button.

d) Optional: If you select a Printer family, you can configure Destination specific capabilities.
These options determine which print preferences/document properties are supported by the destination. To
configure destination specific capabilities, click Configure to open the Destination Capabilities dialog box.
All of the document properties available to this destination are listed and grouped into categories. Expand the
appropriate category by clicking the arrow next to the category name. Select the check boxes for properties
you want to be available for configuration throughout Nuance Output Manager. Clear the check boxes for
properties you do not want to be available. If a property is configured by selecting from a list of options, those
options will display beneath the property. Select and clear the check boxes to determine the choices that will
be available when those properties are configured. Repeat this step until all properties are configured, and then
click OK.

e) Select the appropriate Output process. You can select an existing process in the list or create one using the
Process Designer.

• To create a process during single destination configuration, click New.
• To create during multiple destination configuration, click the Browse button.

Output processes can be created to impact documents as they are being sent to a destination. The processes
contain a set of actions which could be used for search and replace, setting finishing options, editing PJL
commands, inserting overlays, and so on.

f) Determine if you want to override the output process assigned to the document and use the selected destination
output process.

g) Select the appropriate Failover profile. You can select an existing profile in the list or create one in the
Failover Profile dialog box.

• To create a profile during single destination configuration, click New.
• To create during multiple destination configuration, click the Browse button.

Failover profiles specify what should happen to documents when they are sent to inaccessible destinations
(they are not able to receive documents).

h) Determine if you want to override the failover profile assigned to the document and use the selected
destination failover profile.

7. On the Error handling tab, configure the error handling options.

Configuration Method

Single destination configuration Use the Error Handling tab.

Multiple destination configuration Use the Error Handling (Bulk Configuration) tab.

a) Select the appropriate Error handling profile. You can select an existing profile in the list, or create one in the
Error Handling Profile dialog box. To create a profile during single destination configuration, click New. To
create during multiple destination configuration, click the Browse button.
Error handling profiles specify what should happen to destinations when an error is detected via SNMP or
during transmission of a document.

b) Choose the Default failover destination.
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This specifies what should happen to documents when they are sent to inaccessible destinations (they are not
able to receive documents). You can choose to route the documents to a parent group or a specific destination
or group. The parent group where the destination currently resides is selected by default.

8. Click OK.
The IPDS destination displays the connection status in the Extended Msg destination column.

9. Add the Extended Msg destination column to the destination grid.
For more information, see Configuring columns.

Sending Documents to an IPP Destination
Complete this procedure to define destinations for printing to an IPP (Internet Printing Protocol) connected printer.

1. In the Destinations tree, the destination group (folder) where you want to add destinations, right-click the
destination group (folder) where you want to add destinations and click New Destination.
This opens the Add Destination dialog box.

2. In the Type list, select IPP.
3. Next to Add new devices, enter the number of destinations you want to create.

You can create a single destination or create multiple destinations and configure them simultaneously.
4. Click OK.
5. Configure the general settings.

For multiple destination configuration, this is configured on the General tab.
a) Enter the destination Name.
b) In the Server list, click the Nuance Output Manager server where the Nuance Output Manager Output Service

is located for this destination.
The destination does not have to be on the same server as the Nuance Output Manager Output Service.

c) Enter any Comments or Location information for the destination.
d) Optional: To change the large destination image that displays when configuring a single destination, you can

click Select Image and choose the appropriate image file (BMP, JPEG, or PNG).
The selected image will be compressed and scaled to 96x96 pixels. Changing this image will not change the
smaller image that displays or the image that displays in the source tree. To change the image back to the
default, click Reset Image.

6. Configure IPP settings.

Configuration Method

Single destination configuration Use the IPP settings tab.

Multiple destination configuration Use the IPP settings (Bulk Configuration) tab.

a) Enter the Printer URI (network address).
For example, http://server/printers/myprinter/printer.

b) If necessary, enter the Job name that will be associated with all documents received by this destination.
Typically the default Dynamic override value will be used for the job name.

c) If necessary, enter the User that will be associated with all documents received by this destination.
Typically the default Dynamic override value will be used for the user name.

You can configure a default value and a dynamic override value for most options. Default values are used to
manage the documents as they are being sent to the destination. You can choose to dynamically override the
default values using document properties and functions. To insert document properties, right-click in the dynamic
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box and select Insert Document Property. A menu containing all of the available properties displays. You can
select a property from the list or type the property name. If a property is selected and it contains a value, that
value is processed instead of the default value. To insert functions, right-click in the dynamic box, select Insert
Function, and choose the appropriate function. Review the Using Nuance Output Manager Functions help topic
for information on configuring functions.

7. Configure options on the More settings tab.

Configuration Method

Single destination configuration Use the More settings tab.

Multiple destination configuration Use the More settings (Bulk Configuration) tab.

a) Select the printing cost per page for black and white and color documents.
b) Select Include documents in Green Reports to make documents sent to the destination available for green

reports. The documents appear in green reports once Nuance Output Manager deletes them from the Retained
tab.

c) Select the appropriate Printer family.
Printer families are used to configure commands for print languages and map them to destinations based on
their capabilities. You can select an existing printer family in the list or create one in the Printer Family
Profile dialog box. To create a printer family during single destination configuration, click New. To create
during multiple destination configuration, click the Browse button.

d) Optional: If you select a Printer family, you can configure Destination specific capabilities.
These options determine which print preferences/document properties are supported by the destination. To
configure destination specific capabilities, click Configure to open the Destination Capabilities dialog box.
All of the document properties available to this destination are listed and grouped into categories. Expand the
appropriate category by clicking the arrow next to the category name. Select the check boxes for properties
you want to be available for configuration throughout Nuance Output Manager. Clear the check boxes for
properties you do not want to be available. If a property is configured by selecting from a list of options, those
options will display beneath the property. Select and clear the check boxes to determine the choices that will
be available when those properties are configured. Repeat this step until all properties are configured, and then
click OK.

e) Select the appropriate Output process. You can select an existing process in the list or create one using the
Process Designer.

• To create a process during single destination configuration, click New.
• To create during multiple destination configuration, click the Browse button.

Output processes can be created to impact documents as they are being sent to a destination. The processes
contain a set of actions which could be used for search and replace, setting finishing options, editing PJL
commands, inserting overlays, and so on.

f) Determine if you want to override the output process assigned to the document and use the selected destination
output process.

g) Select the appropriate Failover profile. You can select an existing profile in the list or create one in the
Failover Profile dialog box.

• To create a profile during single destination configuration, click New.
• To create during multiple destination configuration, click the Browse button.

Failover profiles specify what should happen to documents when they are sent to inaccessible destinations
(they are not able to receive documents).
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h) Determine if you want to override the failover profile assigned to the document and use the selected
destination failover profile.

8. On the Error handling tab, configure the error handling options.

Configuration Method

Single destination configuration Use the Error Handling tab.

Multiple destination configuration Use the Error Handling (Bulk Configuration) tab.

a) Select the appropriate Error handling profile. You can select an existing profile in the list, or create one in the
Error Handling Profile dialog box. To create a profile during single destination configuration, click New. To
create during multiple destination configuration, click the Browse button.
Error handling profiles specify what should happen to destinations when an error is detected via SNMP or
during transmission of a document.

b) Choose the Default failover destination.
This specifies what should happen to documents when they are sent to inaccessible destinations (they are not
able to receive documents). You can choose to route the documents to a parent group or a specific destination
or group. The parent group where the destination currently resides is selected by default.

9. Click OK.

Sending Documents to JDF/JMF
Complete this procedure to define destinations for JDF/JMF.

1. In the Destinations tree, the destination group (folder) where you want to add destinations, right-click the
destination group (folder) where you want to add destinations and click New Destination.
This opens the Add Destination dialog box.

2. In the Type list, select JDF/JMF.
3. Next to Add new devices, enter the number of destinations you want to create.

You can create a single destination or create multiple destinations and configure them simultaneously.
4. Click OK.
5. Configure the general settings.

For multiple destination configuration, this is configured on the General tab.
a) Enter the destination Name.
b) In the Server list, click the Nuance Output Manager server where the Nuance Output Manager Output Service

is located for this destination.
The destination does not have to be on the same server as the Nuance Output Manager Output Service.

c) Enter any Comments or Location information for the destination.
d) Optional: To change the large destination image that displays when configuring a single destination, you can

click Select Image and choose the appropriate image file (BMP, JPEG, or PNG).
The selected image will be compressed and scaled to 96x96 pixels. Changing this image will not change the
smaller image that displays or the image that displays in the source tree. To change the image back to the
default, click Reset Image.

6. Configure JDF/JMF settings.

Configuration Method

Single destination configuration Use the JDF/JMF settings tab.
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Configuration Method

Multiple destination configuration Use the JDF/JMF settings (Bulk Configuration) tab.

a) Select the JDF version.
b) Select the Job submission method that will be used to send the document to the printer.

To Do This

Submit ticket and data via folders Enter the Ticket folder and Data folder.

Submit MIME package Enter the URL.

Submit queue entry via folder Enter the Queue folder.

Submit queue entry via web with links Enter the URL.

Submit queue entry via web with folders Enter the URL, Ticket folder and Data folder.

You can configure a default value and a dynamic override value for most options. Default values are used
to manage the documents as they are being sent to the destination. You can choose to dynamically override
the default values using document properties and functions. To insert document properties, right-click in
the dynamic box and select Insert Document Property. A menu containing all of the available properties
displays. You can select a property from the list or type the property name. If a property is selected and it
contains a value, that value is processed instead of the default value. To insert functions, right-click in the
dynamic box, select Insert Function, and choose the appropriate function. Review the Using Nuance Output
Manager Functions help topic for information on configuring functions.

You can configure a default value and a dynamic override value for most options. Default values are used to
manage the documents as they are being sent to the destination. You can choose to dynamically override the
default values using document properties and functions. To insert document properties, right-click in the dynamic
box and select Insert Document Property. A menu containing all of the available properties displays. You can
select a property from the list or type the property name. If a property is selected and it contains a value, that
value is processed instead of the default value. To insert functions, right-click in the dynamic box, select Insert
Function, and choose the appropriate function. Review the Using Nuance Output Manager Functions help topic
for information on configuring functions.

7. Configure options on the More settings tab.

Configuration Method

Single destination configuration Use the More settings tab.

Multiple destination configuration Use the More settings (Bulk Configuration) tab.

a) Select the printing cost per page for black and white and color documents.
b) Select Include documents in Green Reports to make documents sent to the destination available for green

reports. The documents appear in green reports once Nuance Output Manager deletes them from the Retained
tab.

c) Select the appropriate Printer family.
Printer families are used to configure commands for print languages and map them to destinations based on
their capabilities. You can select an existing printer family in the list or create one in the Printer Family
Profile dialog box. To create a printer family during single destination configuration, click New. To create
during multiple destination configuration, click the Browse button.
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d) Optional: If you select a Printer family, you can configure Destination specific capabilities.
These options determine which print preferences/document properties are supported by the destination. To
configure destination specific capabilities, click Configure to open the Destination Capabilities dialog box.
All of the document properties available to this destination are listed and grouped into categories. Expand the
appropriate category by clicking the arrow next to the category name. Select the check boxes for properties
you want to be available for configuration throughout Nuance Output Manager. Clear the check boxes for
properties you do not want to be available. If a property is configured by selecting from a list of options, those
options will display beneath the property. Select and clear the check boxes to determine the choices that will
be available when those properties are configured. Repeat this step until all properties are configured, and then
click OK.

e) Select the appropriate Output process. You can select an existing process in the list or create one using the
Process Designer.

• To create a process during single destination configuration, click New.
• To create during multiple destination configuration, click the Browse button.

Output processes can be created to impact documents as they are being sent to a destination. The processes
contain a set of actions which could be used for search and replace, setting finishing options, editing PJL
commands, inserting overlays, and so on.

f) Determine if you want to override the output process assigned to the document and use the selected destination
output process.

g) Select the appropriate Failover profile. You can select an existing profile in the list or create one in the
Failover Profile dialog box.

• To create a profile during single destination configuration, click New.
• To create during multiple destination configuration, click the Browse button.

Failover profiles specify what should happen to documents when they are sent to inaccessible destinations
(they are not able to receive documents).

h) Determine if you want to override the failover profile assigned to the document and use the selected
destination failover profile.

8. On the Error handling tab, configure the error handling options.

Configuration Method

Single destination configuration Use the Error Handling tab.

Multiple destination configuration Use the Error Handling (Bulk Configuration) tab.

a) Select the appropriate Error handling profile. You can select an existing profile in the list, or create one in the
Error Handling Profile dialog box. To create a profile during single destination configuration, click New. To
create during multiple destination configuration, click the Browse button.
Error handling profiles specify what should happen to destinations when an error is detected via SNMP or
during transmission of a document.

b) Choose the Default failover destination.
This specifies what should happen to documents when they are sent to inaccessible destinations (they are not
able to receive documents). You can choose to route the documents to a parent group or a specific destination
or group. The parent group where the destination currently resides is selected by default.

9. Click OK.
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Sending Documents to an LPR Server
Complete the following steps to define destinations for printing to an LPR server. Documents routed to this
destination will be sent to the specified LPR server and queue.

1. In the Destinations tree, the destination group (folder) where you want to add destinations, right-click the
destination group (folder) where you want to add destinations and click New Destination.
This opens the Add Destination dialog box.

2. In the Type list, select LPR.
3. Next to Add new devices, enter the number of destinations you want to create.

You can create a single destination or create multiple destinations and configure them simultaneously.
4. Click OK.
5. Configure the general settings.

For multiple destination configuration, this is configured on the General tab.
a) Enter the destination Name.
b) In the Server list, click the Nuance Output Manager server where the Nuance Output Manager Output Service

is located for this destination.
The destination does not have to be on the same server as the Nuance Output Manager Output Service.

c) Enter any Comments or Location information for the destination.
d) Optional: To change the large destination image that displays when configuring a single destination, you can

click Select Image and choose the appropriate image file (BMP, JPEG, or PNG).
The selected image will be compressed and scaled to 96x96 pixels. Changing this image will not change the
smaller image that displays or the image that displays in the source tree. To change the image back to the
default, click Reset Image.

6. Configure LPR settings.

Configuration Method

Single destination configuration Use the LPR settings tab.

Multiple destination configuration Use the LPR settings (Bulk Configuration) tab.

a) Enter a valid LPD server.
This can be an IP address or equivalent host name of the print server where documents will be sent.

b) Enter the Port number for this LPR server.
The default value is 515.

c) Enter the name of the print Queue on the LPD server.
d) Enter the Banner Class (-C).

This specifies the class name to be printed on the banner page. To print the banner page, the -L command must
be used.

e) Enter the Banner Job Name (-J).
This specifies the job name to be printed on the banner page. To print the banner page, the -L command must
be used.

f) Enter the Banner User (-L).
This causes the banner page to be printed. The user name can be omitted. The banner class (-C) and banner job
name (-J) commands must precede this command in the control file to be effective.

g) Enter the Mail User (-M).
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This sends mail to the specified mailbox (example, mailbox@hostname) upon completion of the print job.
h) Enter the User (-P).

This specifies the user identification of the entity requesting the printing job. This must be included in the
control file.

i) Enter the Title (-T).
This provides a title for a file that is to be printed with the "p" command code. It is ignored by all other
printing commands.

j) Select the LPR Print command.
The default selection is Plain text (-Of).

k) Use the Control file first check box to determine if you want to send the control file before the data files.
Once the control file has been received, the data files can be printed as they arrive. This is the default
configuration.

l) Select Send copies as separate transmissions to send documents to the destination multiple times (based on
the copy count property of the document).

Note:

When printing a duplex document, select this option if you want each document to print on its own
sheets of paper. If not selected, a duplexed document that has odd number of pages will have its second
copy’s first page print on the back of the first copy’s last page. When a printer is configured to use
a separator page, select this option to allow the separator page to be inserted by the printer. If not
selected, only the first copy would have a separator page. A separator page would not appear between
each of the copies.

You can configure a default value and a dynamic override value for most options. Default values are used to
manage the documents as they are being sent to the destination. You can choose to dynamically override the
default values using document properties and functions. To insert document properties, right-click in the dynamic
box and select Insert Document Property. A menu containing all of the available properties displays. You can
select a property from the list or type the property name. If a property is selected and it contains a value, that
value is processed instead of the default value. To insert functions, right-click in the dynamic box, select Insert
Function, and choose the appropriate function. Review the Using Nuance Output Manager Functions help topic
for information on configuring functions.

7. Configure options on the More settings tab.

Configuration Method

Single destination configuration Use the More settings tab.

Multiple destination configuration Use the More settings (Bulk Configuration) tab.

a) Select the printing cost per page for black and white and color documents.
b) Select Include documents in Green Reports to make documents sent to the destination available for green

reports. The documents appear in green reports once Nuance Output Manager deletes them from the Retained
tab.

c) Select the appropriate Printer family.
Printer families are used to configure commands for print languages and map them to destinations based on
their capabilities. You can select an existing printer family in the list or create one in the Printer Family
Profile dialog box. To create a printer family during single destination configuration, click New. To create
during multiple destination configuration, click the Browse button.

d) Optional: If you select a Printer family, you can configure Destination specific capabilities.
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These options determine which print preferences/document properties are supported by the destination. To
configure destination specific capabilities, click Configure to open the Destination Capabilities dialog box.
All of the document properties available to this destination are listed and grouped into categories. Expand the
appropriate category by clicking the arrow next to the category name. Select the check boxes for properties
you want to be available for configuration throughout Nuance Output Manager. Clear the check boxes for
properties you do not want to be available. If a property is configured by selecting from a list of options, those
options will display beneath the property. Select and clear the check boxes to determine the choices that will
be available when those properties are configured. Repeat this step until all properties are configured, and then
click OK.

e) Select the appropriate Output process. You can select an existing process in the list or create one using the
Process Designer.

• To create a process during single destination configuration, click New.
• To create during multiple destination configuration, click the Browse button.

Output processes can be created to impact documents as they are being sent to a destination. The processes
contain a set of actions which could be used for search and replace, setting finishing options, editing PJL
commands, inserting overlays, and so on.

f) Determine if you want to override the output process assigned to the document and use the selected destination
output process.

g) Select the appropriate Failover profile. You can select an existing profile in the list or create one in the
Failover Profile dialog box.

• To create a profile during single destination configuration, click New.
• To create during multiple destination configuration, click the Browse button.

Failover profiles specify what should happen to documents when they are sent to inaccessible destinations
(they are not able to receive documents).

h) Determine if you want to override the failover profile assigned to the document and use the selected
destination failover profile.

8. On the Error handling tab, configure the error handling options.

Configuration Method

Single destination configuration Use the Error Handling tab.

Multiple destination configuration Use the Error Handling (Bulk Configuration) tab.

a) Select the appropriate Error handling profile. You can select an existing profile in the list, or create one in the
Error Handling Profile dialog box. To create a profile during single destination configuration, click New. To
create during multiple destination configuration, click the Browse button.
Error handling profiles specify what should happen to destinations when an error is detected via SNMP or
during transmission of a document.

b) Choose the Default failover destination.
This specifies what should happen to documents when they are sent to inaccessible destinations (they are not
able to receive documents). You can choose to route the documents to a parent group or a specific destination
or group. The parent group where the destination currently resides is selected by default.

9. Click OK.
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Sending Documents to a Network Folder
Complete this procedure to define destinations for printing to a network folder. Documents routed to this destination
will be saved in a specified folder.

1. In the Destinations tree, the destination group (folder) where you want to add destinations, right-click the
destination group (folder) where you want to add destinations and click New Destination.
This opens the Add Destination dialog box.

2. In the Type list, select Network Folder.
3. Next to Add new devices, enter the number of destinations you want to create.

You can create a single destination or create multiple destinations and configure them simultaneously.
4. Click OK.
5. Configure the general settings.

For multiple destination configuration, this is configured on the General tab.
a) Enter the destination Name.
b) In the Server list, click the Nuance Output Manager server where the Nuance Output Manager Output Service

is located for this destination.
The destination does not have to be on the same server as the Nuance Output Manager Output Service.

c) Enter any Comments or Location information for the destination.
d) Optional: To change the large destination image that displays when configuring a single destination, you can

click Select Image and choose the appropriate image file (BMP, JPEG, or PNG).
The selected image will be compressed and scaled to 96x96 pixels. Changing this image will not change the
smaller image that displays or the image that displays in the source tree. To change the image back to the
default, click Reset Image.

6. Configure network folder settings.

Configuration Method

Single destination configuration Use the Folder settings tab.

Multiple destination configuration Use the Folder settings (Bulk Configuration) tab.

a) Enter the Folder path where documents will be sent.

For the specified folder, you must configure the Nuance Output Manager Services logon account user name to
have Full Control Sharing permissions. Also, verify that the Administrators group has Full Control Security
permissions. To configure these options, right-click the folder in Windows Explorer and click Sharing and
Security.

The default folder is C:\NSi Files\.
b) Enter the Subfolder path where documents will be sent.

If no subfolder path is entered, documents will be sent to the folder path.
c) Select the Create folder check box if you want to automatically create the specified folders and/or subfolders

when they do not exist.
This will apply for default and dynamic values.

d) Enter the File name the document will have when it is routed from Nuance Output Manager to its disk
destination.

e) In the Base length box, specify the maximum length of the file name.
The default length is 40.
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f) In the Extension length box, specify the maximum length of the file name extension.
The default length is 40.

g) Select the Allow spaces check box to allow spaces in file names.
This option is selected by default. If you clear this check box, spaces in file names will be replaced with
exclamation points.

h) Select the Delete exclamation check box to specify that exclamation points will be deleted from the file name.
i) Select the Overwrite check box to overwrite files with the same name. If you clear the check box, the new file

will be saved with a new file name according to the following options.

• Counter type — If a duplicate file name is encountered, a new file name is created using a counter. Set
this to In Base to include the numeric counter in the file base name. Set this to In Extension to include the
counter in the file extension.

• Counter length — Specify the length of the counter that will be placed at the end of the file name.
• Separator — Specify the character that separates the file name from the counter. The default character is #.

The following are invalid characters: \ / : * ? “ < > |.
• Start with counter — Select this check box to apply the counter to the first file. Clear this check box to

start the counter in the first file with a duplicate name. This option is selected by default.

You can configure a default value and a dynamic override value for most options. Default values are used to
manage the documents as they are being sent to the destination. You can choose to dynamically override the
default values using document properties and functions. To insert document properties, right-click in the dynamic
box and click Insert Document Property. A menu containing all of the available properties displays. You can
select a property from the list or type the property name. If a property is selected and it contains a value, that
value is processed instead of the default value. To insert functions, right-click in the dynamic box, click Insert
Function, and choose the appropriate function. Review the Using Nuance Output Manager Functions help topic
for information on configuring functions.

7. Configure options on the More settings tab.

Configuration Method

Single destination configuration Use the More settings tab.

Multiple destination configuration Use the More settings (Bulk Configuration) tab.

a) Select the printing cost per page for black and white and color documents.
b) Select Include documents in Green Reports to make documents sent to the destination available for green

reports. The documents appear in green reports once Nuance Output Manager deletes them from the Retained
tab.

c) Select the appropriate Printer family.
Printer families are used to configure commands for print languages and map them to destinations based on
their capabilities. You can select an existing printer family in the list or create one in the Printer Family
Profile dialog box. To create a printer family during single destination configuration, click New. To create
during multiple destination configuration, click the Browse button.

d) Optional: If you select a Printer family, you can configure Destination specific capabilities.
These options determine which print preferences/document properties are supported by the destination. To
configure destination specific capabilities, click Configure to open the Destination Capabilities dialog box.
All of the document properties available to this destination are listed and grouped into categories. Expand the
appropriate category by clicking the arrow next to the category name. Select the check boxes for properties
you want to be available for configuration throughout Nuance Output Manager. Clear the check boxes for
properties you do not want to be available. If a property is configured by selecting from a list of options, those
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options will display beneath the property. Select and clear the check boxes to determine the choices that will
be available when those properties are configured. Repeat this step until all properties are configured, and then
click OK.

e) Select the appropriate Output process. You can select an existing process in the list or create one using the
Process Designer.

• To create a process during single destination configuration, click New.
• To create during multiple destination configuration, click the Browse button.

Output processes can be created to impact documents as they are being sent to a destination. The processes
contain a set of actions which could be used for search and replace, setting finishing options, editing PJL
commands, inserting overlays, and so on.

f) Determine if you want to override the output process assigned to the document and use the selected destination
output process.

g) Select the appropriate Failover profile. You can select an existing profile in the list or create one in the
Failover Profile dialog box.

• To create a profile during single destination configuration, click New.
• To create during multiple destination configuration, click the Browse button.

Failover profiles specify what should happen to documents when they are sent to inaccessible destinations
(they are not able to receive documents).

h) Determine if you want to override the failover profile assigned to the document and use the selected
destination failover profile.

8. On the Error handling tab, configure the error handling options.

Configuration Method

Single destination configuration Use the Error Handling tab.

Multiple destination configuration Use the Error Handling (Bulk Configuration) tab.

a) Select the appropriate Error handling profile. You can select an existing profile in the list, or create one in the
Error Handling Profile dialog box. To create a profile during single destination configuration, click New. To
create during multiple destination configuration, click the Browse button.
Error handling profiles specify what should happen to destinations when an error is detected via SNMP or
during transmission of a document.

b) Choose the Default failover destination.
This specifies what should happen to documents when they are sent to inaccessible destinations (they are not
able to receive documents). You can choose to route the documents to a parent group or a specific destination
or group. The parent group where the destination currently resides is selected by default.

9. Click OK.

Routing Documents to another Output Manager Instance
Complete this procedure to define destinations for routing to another Nuance Output Manager. Documents routed to
this destination will be sent to the Nuance Output Manager server specified.

1. In the Destinations tree, the destination group (folder) where you want to add destinations, right-click the
destination group (folder) where you want to add destinations and click New Destination.
This opens the Add Destination dialog box.

2. In the Type list, select OM.



Output Manager Administration Guide
Version 4.0 SP2

185 © 2016 Nuance Communications, Inc. All rights reserved.

3. Next to Add new devices, enter the number of destinations you want to create.
You can create a single destination or create multiple destinations and configure them simultaneously.

4. Click OK.
5. Configure the general settings.

For multiple destination configuration, this is configured on the General tab.
a) Enter the destination Name.
b) In the Server list, click the Nuance Output Manager server where the Nuance Output Manager Output Service

is located for this destination.
The destination does not have to be on the same server as the Nuance Output Manager Output Service.

c) Enter any Comments or Location information for the destination.
d) Optional: To change the large destination image that displays when configuring a single destination, you can

click Select Image and choose the appropriate image file (BMP, JPEG, or PNG).
The selected image will be compressed and scaled to 96x96 pixels. Changing this image will not change the
smaller image that displays or the image that displays in the source tree. To change the image back to the
default, click Reset Image.

6. Configure Output Manager settings.

Configuration Method

Single destination configuration Use the OM settings tab.

Multiple destination configuration Use the OM settings (Bulk Configuration) tab.

You can configure a default value and a dynamic override value for this option. The default value is used to
manage the documents as they are being sent to the destination. You can choose to dynamically override the
default value using document properties and functions. To insert document properties, right-click in the dynamic
field and click Insert Document Property. This displays a menu containing all of the available properties.
You can select a property from the list or type the property name. If a property is selected and it contains a
value, that value is processed instead of the default value. To insert functions, right-click in the box, click Insert
Function, and choose the appropriate function. Review the Using Nuance Output Manager Functions help topic
for information on configuring functions.

7. Configure options on the More settings tab.

Configuration Method

Single destination configuration Use the More settings tab.

Multiple destination configuration Use the More settings (Bulk Configuration) tab.

a) Select the printing cost per page for black and white and color documents.
b) Select Include documents in Green Reports to make documents sent to the destination available for green

reports. The documents appear in green reports once Nuance Output Manager deletes them from the Retained
tab.

c) Select the appropriate Printer family.
Printer families are used to configure commands for print languages and map them to destinations based on
their capabilities. You can select an existing printer family in the list or create one in the Printer Family
Profile dialog box. To create a printer family during single destination configuration, click New. To create
during multiple destination configuration, click the Browse button.

d) Optional: If you select a Printer family, you can configure Destination specific capabilities.
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These options determine which print preferences/document properties are supported by the destination. To
configure destination specific capabilities, click Configure to open the Destination Capabilities dialog box.
All of the document properties available to this destination are listed and grouped into categories. Expand the
appropriate category by clicking the arrow next to the category name. Select the check boxes for properties
you want to be available for configuration throughout Nuance Output Manager. Clear the check boxes for
properties you do not want to be available. If a property is configured by selecting from a list of options, those
options will display beneath the property. Select and clear the check boxes to determine the choices that will
be available when those properties are configured. Repeat this step until all properties are configured, and then
click OK.

e) Select the appropriate Output process. You can select an existing process in the list or create one using the
Process Designer.

• To create a process during single destination configuration, click New.
• To create during multiple destination configuration, click the Browse button.

Output processes can be created to impact documents as they are being sent to a destination. The processes
contain a set of actions which could be used for search and replace, setting finishing options, editing PJL
commands, inserting overlays, and so on.

f) Determine if you want to override the output process assigned to the document and use the selected destination
output process.

g) Select the appropriate Failover profile. You can select an existing profile in the list or create one in the
Failover Profile dialog box.

• To create a profile during single destination configuration, click New.
• To create during multiple destination configuration, click the Browse button.

Failover profiles specify what should happen to documents when they are sent to inaccessible destinations
(they are not able to receive documents).

h) Determine if you want to override the failover profile assigned to the document and use the selected
destination failover profile.

8. On the Error handling tab, configure the error handling options.

Configuration Method

Single destination configuration Use the Error Handling tab.

Multiple destination configuration Use the Error Handling (Bulk Configuration) tab.

a) Select the appropriate Error handling profile. You can select an existing profile in the list, or create one in the
Error Handling Profile dialog box. To create a profile during single destination configuration, click New. To
create during multiple destination configuration, click the Browse button.
Error handling profiles specify what should happen to destinations when an error is detected via SNMP or
during transmission of a document.

b) Choose the Default failover destination.
This specifies what should happen to documents when they are sent to inaccessible destinations (they are not
able to receive documents). You can choose to route the documents to a parent group or a specific destination
or group. The parent group where the destination currently resides is selected by default.

9. Click OK.
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Sending Documents to a PRISMAProduction Destination
Complete this procedure to define PRISMAProduction destinations for the Océ PRISMAproduction server.
Documents routed to this destination will be sent to the specified server.

1. In the Destinations tree, the destination group (folder) where you want to add destinations, right-click the
destination group (folder) where you want to add destinations and click New Destination.
This opens the Add Destination dialog box.

2. In the Type list, select PRISMAProduction.
3. Next to Add new devices, enter the number of destinations you want to create.

You can create a single destination or create multiple destinations and configure them simultaneously.
4. Click OK.
5. Configure the general settings.

For multiple destination configuration, this is configured on the General tab.
a) Enter the destination Name.
b) In the Server list, click the Nuance Output Manager server where the Nuance Output Manager Output Service

is located for this destination.
The destination does not have to be on the same server as the Nuance Output Manager Output Service.

c) Enter any Comments or Location information for the destination.
d) Optional: To change the large destination image that displays when configuring a single destination, you can

click Select Image and choose the appropriate image file (BMP, JPEG, or PNG).
The selected image will be compressed and scaled to 96x96 pixels. Changing this image will not change the
smaller image that displays or the image that displays in the source tree. To change the image back to the
default, click Reset Image.

6. Configure PRISMAProduction settings.

Configuration Method

Single destination configuration Use the PRISMAProduction settings tab.

Multiple destination configuration Use the PRISMAProduction settings (Bulk Configur
ation) tab.

a) Specify the Océ PRISMAproduction Server where documents will be sent.
b) Specify the User name that is associated with the documents.
c) If you are configuring a single destination, you can specify the Job queue on the printer where documents will

be routed.
You can configure a default value and a dynamic override value for most options. Default values are used to
manage the documents as they are being sent to the destination. You can choose to dynamically override the
default values using document properties and functions. To insert document properties, right-click in the dynamic
box and click Insert Document Property. A menu containing all of the available properties displays. You
can select a property in the list or type the property name. If a property is selected and it contains a value, that
value is processed instead of the default value. To insert functions, right-click in the dynamic box, click Insert
Function, and choose the appropriate function. Review the Using Nuance Output Manager functions help topic
for information on configuring functions.

7. Configure options on the More settings tab.
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Configuration Method

Single destination configuration Use the More settings tab.

Multiple destination configuration Use the More settings (Bulk Configuration) tab.

a) Select the printing cost per page for black and white and color documents.
b) Select Include documents in Green Reports to make documents sent to the destination available for green

reports. The documents appear in green reports once Nuance Output Manager deletes them from the Retained
tab.

c) Select the appropriate Printer family.
Printer families are used to configure commands for print languages and map them to destinations based on
their capabilities. You can select an existing printer family in the list or create one in the Printer Family
Profile dialog box. To create a printer family during single destination configuration, click New. To create
during multiple destination configuration, click the Browse button.

d) Optional: If you select a Printer family, you can configure Destination specific capabilities.
These options determine which print preferences/document properties are supported by the destination. To
configure destination specific capabilities, click Configure to open the Destination Capabilities dialog box.
All of the document properties available to this destination are listed and grouped into categories. Expand the
appropriate category by clicking the arrow next to the category name. Select the check boxes for properties
you want to be available for configuration throughout Nuance Output Manager. Clear the check boxes for
properties you do not want to be available. If a property is configured by selecting from a list of options, those
options will display beneath the property. Select and clear the check boxes to determine the choices that will
be available when those properties are configured. Repeat this step until all properties are configured, and then
click OK.

e) Select the appropriate Output process. You can select an existing process in the list or create one using the
Process Designer.

• To create a process during single destination configuration, click New.
• To create during multiple destination configuration, click the Browse button.

Output processes can be created to impact documents as they are being sent to a destination. The processes
contain a set of actions which could be used for search and replace, setting finishing options, editing PJL
commands, inserting overlays, and so on.

f) Determine if you want to override the output process assigned to the document and use the selected destination
output process.

g) Select the appropriate Failover profile. You can select an existing profile in the list or create one in the
Failover Profile dialog box.

• To create a profile during single destination configuration, click New.
• To create during multiple destination configuration, click the Browse button.

Failover profiles specify what should happen to documents when they are sent to inaccessible destinations
(they are not able to receive documents).

h) Determine if you want to override the failover profile assigned to the document and use the selected
destination failover profile.

8. On the Error handling tab, configure the error handling options.

Configuration Method

Single destination configuration Use the Error Handling tab.
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Configuration Method

Multiple destination configuration Use the Error Handling (Bulk Configuration) tab.

a) Select the appropriate Error handling profile. You can select an existing profile in the list, or create one in the
Error Handling Profile dialog box. To create a profile during single destination configuration, click New. To
create during multiple destination configuration, click the Browse button.
Error handling profiles specify what should happen to destinations when an error is detected via SNMP or
during transmission of a document.

b) Choose the Default failover destination.
This specifies what should happen to documents when they are sent to inaccessible destinations (they are not
able to receive documents). You can choose to route the documents to a parent group or a specific destination
or group. The parent group where the destination currently resides is selected by default.

9. Click OK.

Sending Documents to a SharePoint Site
Complete this procedure to define destinations for printing to a SharePoint site.

1. In the Destinations tree, the destination group (folder) where you want to add destinations, right-click the
destination group (folder) where you want to add destinations and click New Destination.
This opens the Add Destination dialog box.

2. In the Type list, select SharePoint.
Currently, you can configure only one SharePoint destination at a time.

3. Click OK.
4. Configure the general settings.

a) Enter the destination Name.
b) In the Server list, click the Nuance Output Manager server where the Nuance Output Manager Output Service

is located for this destination.
The destination does not have to be on the same server as the Nuance Output Manager Output Service.

c) Enter any Comments or Location information for the destination.
d) Optional: To change the large destination image that displays when configuring a single destination, you can

click Select Image and choose the appropriate image file (BMP, JPEG, or PNG).
The selected image will be compressed and scaled to 96x96 pixels. Changing this image will not change the
smaller image that displays or the image that displays in the source tree. To change the image back to the
default, click Reset Image.

5. On the SharePoint device settings tab, configure the following options.
a) Specify the SharePoint site where documents will be sent.

http://www.nuance.com/samplesite/
b) Configure the logon for the server.

• To use the Windows credentials of the Nuance Output Manager Output Service to logon, select Use service
logon check box.

• To specify a logon, make sure the check box is disabled and enter the User name and Password that will
be used.

c) If you are using SharePoint 2010 or newer, select the SharePoint 2010 or newer check box.
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If this check box is selected, Nuance Output Manager will use the SharePoint 2010 Client interface to
communicate with the SharePoint site. If this check box is not selected, Nuance Output Manager will use the
SharePoint Copy Web service (Copy.asmx) that is supported by all versions of SharePoint.

Important:  You can configure a default value and a dynamic override for Library, Folder, and
Document Name.

• To insert document properties, right-click in the desired override box and click Insert Document
Property. A menu containing all of the available properties displays. You can select a property
from the list or type the property name. If a property is selected and it contains a value, that value is
processed instead of the default value.

• To insert functions, right-click in the box, click Insert Function, and choose the appropriate
function. Review the Using Nuance Output Manager Functions help topic for information on
configuring functions.

Default values are used to manage the documents as they are being sent to the destination. You can
choose to dynamically override the default values using document properties and functions.

d) In the Library box, type the name of the library in the SharePoint site where the files should be stored.
e) Optional: In the Folder box, type the name of the subfolder under the Library folder where files should be

stored.
This entry is optional. If a folder is not specified, files will be placed in the root folder of the Library.

f) In the Document name box, specify the name to use when naming the document on the SharePoint site.
To pass the Nuance Output Manager name through, use [Document Name].

g) Select the Overwrite check box to overwrite a file with the same name. If you clear the check box a new file
with the same name as an existing file will not be written to the site.

h) Select the Check-in check box to specify that files will be marked as Checked In on the SharePoint site. If
you do not select this check box, files remain checked out by the user specified in the User name field above.

i) Click the SharePoint fields button to specify values to put in SharePoint fields or to map Nuance Output
Manager fields to the SharePoint fields.

To add fields, click SharePoint fields and type the appropriate values directly in the Field Name, Default
Value, and Dynamic Override columns. Click the Add and Remove buttons as necessary to remove fields.
When finished, click OK.

Note:  SharePoint libraries have various fields or columns to describe the files stored in them. They
can also have custom fields to provide further descriptive information. Some of these fields can be
modified by the user.

6. Configure options on the More settings tab.
a) Select the printing cost per page for black and white and color documents.
b) Select Include documents in Green Reports to make documents sent to the destination available for green

reports. The documents appear in green reports once Nuance Output Manager deletes them from the Retained
tab.

c) Select the appropriate Printer family.
Printer families are used to configure commands for print languages and map them to destinations based on
their capabilities. You can select an existing printer family in the list or create one in the Printer Family
Profile dialog box. To create a printer family, click New.

d) Optional: If you select a Printer family, you can configure Destination specific capabilities.
These options determine which print preferences/document properties are supported by the destination. To
configure destination specific capabilities, click Configure to open the Destination Capabilities dialog box.
All of the document properties available to this destination are listed and grouped into categories. Expand the
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appropriate category by clicking the arrow next to the category name. Select the check boxes for properties
you want to be available for configuration throughout Nuance Output Manager. Clear the check boxes for
properties you do not want to be available. If a property is configured by selecting from a list of options, those
options will display beneath the property. Select and clear the check boxes to determine the choices that will
be available when those properties are configured. Repeat this step until all properties are configured, and then
click OK.

e) Select the appropriate Output process. You can select an existing process in the list or create one using the
Process Designer. To create a process, click New.
Output processes can be created to impact documents as they are being sent to a destination. The processes
contain a set of actions which could be used for search and replace, setting finishing options, editing PJL
commands, inserting overlays, and so on.

f) Determine if you want to override the output process assigned to the document and use the selected destination
output process.

g) Select the appropriate Failover profile. You can select an existing profile in the list or create one in the
Failover Profile dialog box. To create a profile, click New.
Failover profiles specify what should happen to documents when they are sent to inaccessible destinations
(they are not able to receive documents).

h) Determine if you want to override the failover profile assigned to the document and use the selected
destination failover profile.

7. On the Error handling tab, configure the error handling options.
a) Select the appropriate Error handling profile. You can select an existing profile in the list, or create one in the

Error Handling Profile dialog box. To create a profile, click New.
Error handling profiles specify what should happen to destinations when an error is detected via SNMP or
during transmission of a document.

b) Choose the Default failover destination.
This specifies what should happen to documents when they are sent to inaccessible destinations (they are not
able to receive documents). You can choose to route the documents to a parent group or a specific destination
or group. The parent group where the destination currently resides is selected by default.

8. Click OK.

Sending Documents to a Socket
Complete this procedure to define destinations for printing to a socket server. Documents routed to this destination
will be sent to a specified IP address and port.

1. In the Destinations tree, the destination group (folder) where you want to add destinations, right-click the
destination group (folder) where you want to add destinations and click New Destination.
This opens the Add Destination dialog box.

2. In the Type list, select Socket.
3. Next to Add new devices, enter the number of destinations you want to create.

You can create a single destination or create multiple destinations and configure them simultaneously.
4. Click OK.
5. Configure the general settings.

For multiple destination configuration, this is configured on the General tab.
a) Enter the destination Name.
b) In the Server list, click the Nuance Output Manager server where the Nuance Output Manager Output Service

is located for this destination.
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The destination does not have to be on the same server as the Nuance Output Manager Output Service.
c) Enter any Comments or Location information for the destination.
d) Optional: To change the large destination image that displays when configuring a single destination, you can

click Select Image and choose the appropriate image file (BMP, JPEG, or PNG).
The selected image will be compressed and scaled to 96x96 pixels. Changing this image will not change the
smaller image that displays or the image that displays in the source tree. To change the image back to the
default, click Reset Image.

6. Configure the socket settings.

Configuration Method

Single destination configuration Use the Socket settings tab.

Multiple destination configuration Use the Socket settings (Bulk Configuration) tab.

a) Enter the IP address or equivalent host name of the print server where the documents will be sent.
b) Enter the Port number for the host.
c) Select Retry on timeout to retry printing to this destination if a timeout occurs.
d) Select Send copies as separate transmissions to send documents to the destination multiple times (based on

the copy count property of the document).

Note:  When printing a duplex document, select this option if you want each document to print on its
own sheets of paper. If not selected, a duplexed document that has odd number of pages will have its
second copy’s first page print on the back of the first copy’s last page.

When a printer is configured to use a separator page, select this option to allow the separator page to
be inserted by the printer. If not selected, only the first copy would have a separator page. A separator
page would not appear between each of the copies.

You can configure a default value and a dynamic override value for most options. Default values are used to
manage the documents as they are being sent to the destination. You can choose to dynamically override the
default values using document properties and functions. To insert document properties, right-click in the dynamic
box and click Insert Document Property. A menu containing all of the available properties displays. You
can select a property in the list or type the property name. If a property is selected and it contains a value, that
value is processed instead of the default value. To insert functions, right-click in the dynamic box, click Insert
Function, and choose the appropriate function. Review the Using Nuance Output Manager Functions help topic
for information on configuring functions.

7. Configure options on the More settings tab.

Configuration Method

Single destination configuration Use the More settings tab.

Multiple destination configuration Use the More settings (Bulk Configuration) tab.

a) Select the printing cost per page for black and white and color documents.
b) Select Include documents in Green Reports to make documents sent to the destination available for green

reports. The documents appear in green reports once Nuance Output Manager deletes them from the Retained
tab.

c) Select the appropriate Printer family.
Printer families are used to configure commands for print languages and map them to destinations based on
their capabilities. You can select an existing printer family in the list or create one in the Printer Family
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Profile dialog box. To create a printer family during single destination configuration, click New. To create
during multiple destination configuration, click the Browse button.

d) Optional: If you select a Printer family, you can configure Destination specific capabilities.
These options determine which print preferences/document properties are supported by the destination. To
configure destination specific capabilities, click Configure to open the Destination Capabilities dialog box.
All of the document properties available to this destination are listed and grouped into categories. Expand the
appropriate category by clicking the arrow next to the category name. Select the check boxes for properties
you want to be available for configuration throughout Nuance Output Manager. Clear the check boxes for
properties you do not want to be available. If a property is configured by selecting from a list of options, those
options will display beneath the property. Select and clear the check boxes to determine the choices that will
be available when those properties are configured. Repeat this step until all properties are configured, and then
click OK.

e) Select the appropriate Output process. You can select an existing process in the list or create one using the
Process Designer.

• To create a process during single destination configuration, click New.
• To create during multiple destination configuration, click the Browse button.

Output processes can be created to impact documents as they are being sent to a destination. The processes
contain a set of actions which could be used for search and replace, setting finishing options, editing PJL
commands, inserting overlays, and so on.

f) Determine if you want to override the output process assigned to the document and use the selected destination
output process.

g) Select the appropriate Failover profile. You can select an existing profile in the list or create one in the
Failover Profile dialog box.

• To create a profile during single destination configuration, click New.
• To create during multiple destination configuration, click the Browse button.

Failover profiles specify what should happen to documents when they are sent to inaccessible destinations
(they are not able to receive documents).

h) Determine if you want to override the failover profile assigned to the document and use the selected
destination failover profile.

8. On the Error handling tab, configure the error handling options.

Configuration Method

Single destination configuration Use the Error Handling tab.

Multiple destination configuration Use the Error Handling (Bulk Configuration) tab.

a) Select the appropriate Error handling profile. You can select an existing profile in the list, or create one in the
Error Handling Profile dialog box. To create a profile during single destination configuration, click New. To
create during multiple destination configuration, click the Browse button.
Error handling profiles specify what should happen to destinations when an error is detected via SNMP or
during transmission of a document.

b) Choose the Default failover destination.
This specifies what should happen to documents when they are sent to inaccessible destinations (they are not
able to receive documents). You can choose to route the documents to a parent group or a specific destination
or group. The parent group where the destination currently resides is selected by default.

9. Click OK.
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Sending Documents to a WebSphere MQ
Complete this procedure to define WebSphere MQ destinations. Documents routed to this destination will be sent as
WebSphere MQ messages.

A WebSphere MQ client must be installed separately before you can use this destination.

WebSphere MQ is a message queuing system designed by IBM that runs on many platforms such as Windows, Unix,
Linux, and z/OS. Nuance Output Manager provides an interface into that queuing system. Nuance Output Manager
can then communicate (send and receive messages) with other applications using WebSphere MQ.

1. In the Destinations tree, the destination group (folder) where you want to add destinations, right-click the
destination group (folder) where you want to add destinations and click New Destination.
This opens the Add Destination dialog box.

2. In the Type list, select WebSphere MQ.
3. Next to Add new devices, enter the number of destinations you want to create.

You can create a single destination or create multiple destinations and configure them simultaneously.
4. Click OK.
5. Configure the general settings.

For multiple destination configuration, this is configured on the General tab.
a) Enter the destination Name.
b) In the Server list, click the Nuance Output Manager server where the Nuance Output Manager Output Service

is located for this destination.
The destination does not have to be on the same server as the Nuance Output Manager Output Service.

c) Enter any Comments or Location information for the destination.
d) Optional: To change the large destination image that displays when configuring a single destination, you can

click Select Image and choose the appropriate image file (BMP, JPEG, or PNG).
The selected image will be compressed and scaled to 96x96 pixels. Changing this image will not change the
smaller image that displays or the image that displays in the source tree. To change the image back to the
default, click Reset Image.

6. Configure the WebSphere MQ settings.

Configuration Method

Single destination configuration Use the WebSphere MQ settings tab.

Multiple destination configuration Use the WebSphere MQ settings (Bulk Configuration
) tab.

a) In the Queue manager box, enter the name of the queue manager.
This must match the queue manager specified in WebSphere MQ.

b) In the Queue name box, enter the queue name where messages sent to this destination will be stored.
This must match the queue name specified in WebSphere MQ.

c) In the Channel name box, enter the channel configured for TCP/IP.
You can get this name from the WebSphere MQ list of channels.

Caution:  Make sure the SSL certificate required option is not selected in WebSphere MQ. Nuance
Output Manager does not support this at this time.

d) In the Connection name box, enter the IP address and port or DNS name for the server to which you are
attempting to connect.
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Messages are transferred over the connection and placed in the queue.

You can configure a default value and a dynamic override value for most options. Default values are used to
manage the documents as they are being sent to the destination. You can choose to dynamically override the
default values using document properties and functions. To insert document properties, right-click in the dynamic
box and click Insert Document Property. A menu containing all of the available properties displays. You
can select a property in the list or type the property name. If a property is selected and it contains a value, that
value is processed instead of the default value. To insert functions, right-click in the dynamic box, click Insert
Function, and choose the appropriate function. Review the Using Nuance Output Manager Functions help topic
for information on configuring functions.

7. Configure options on the More settings tab.

Configuration Method

Single destination configuration Use the More settings tab.

Multiple destination configuration Use the More settings (Bulk Configuration) tab.

a) Select the printing cost per page for black and white and color documents.
b) Select Include documents in Green Reports to make documents sent to the destination available for green

reports. The documents appear in green reports once Nuance Output Manager deletes them from the Retained
tab.

c) Select the appropriate Printer family.
Printer families are used to configure commands for print languages and map them to destinations based on
their capabilities. You can select an existing printer family in the list or create one in the Printer Family
Profile dialog box. To create a printer family during single destination configuration, click New. To create
during multiple destination configuration, click the Browse button.

d) Optional: If you select a Printer family, you can configure Destination specific capabilities.
These options determine which print preferences/document properties are supported by the destination. To
configure destination specific capabilities, click Configure to open the Destination Capabilities dialog box.
All of the document properties available to this destination are listed and grouped into categories. Expand the
appropriate category by clicking the arrow next to the category name. Select the check boxes for properties
you want to be available for configuration throughout Nuance Output Manager. Clear the check boxes for
properties you do not want to be available. If a property is configured by selecting from a list of options, those
options will display beneath the property. Select and clear the check boxes to determine the choices that will
be available when those properties are configured. Repeat this step until all properties are configured, and then
click OK.

e) Select the appropriate Output process. You can select an existing process in the list or create one using the
Process Designer.

• To create a process during single destination configuration, click New.
• To create during multiple destination configuration, click the Browse button.

Output processes can be created to impact documents as they are being sent to a destination. The processes
contain a set of actions which could be used for search and replace, setting finishing options, editing PJL
commands, inserting overlays, and so on.

f) Determine if you want to override the output process assigned to the document and use the selected destination
output process.

g) Select the appropriate Failover profile. You can select an existing profile in the list or create one in the
Failover Profile dialog box.

• To create a profile during single destination configuration, click New.
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• To create during multiple destination configuration, click the Browse button.

Failover profiles specify what should happen to documents when they are sent to inaccessible destinations
(they are not able to receive documents).

h) Determine if you want to override the failover profile assigned to the document and use the selected
destination failover profile.

8. On the Error handling tab, configure the error handling options.

Configuration Method

Single destination configuration Use the Error Handling tab.

Multiple destination configuration Use the Error Handling (Bulk Configuration) tab.

a) Select the appropriate Error handling profile. You can select an existing profile in the list, or create one in the
Error Handling Profile dialog box. To create a profile during single destination configuration, click New. To
create during multiple destination configuration, click the Browse button.
Error handling profiles specify what should happen to destinations when an error is detected via SNMP or
during transmission of a document.

b) Choose the Default failover destination.
This specifies what should happen to documents when they are sent to inaccessible destinations (they are not
able to receive documents). You can choose to route the documents to a parent group or a specific destination
or group. The parent group where the destination currently resides is selected by default.

9. Click OK.

Sending Documents to a Windows Queue
Complete the following steps to define Windows Queue destinations.Documents routed to this destination will be sent
to the designated print server and queue.

1. In the Destinations tree, the destination group (folder) where you want to add destinations, right-click the
destination group (folder) where you want to add destinations and click New Destination.
This opens the Add Destination dialog box.

2. In the Type list, select Windows Queue.
3. Next to Add new devices, enter the number of destinations you want to create.

You can create a single destination or create multiple destinations and configure them simultaneously.
4. Click OK.
5. Configure the general settings.

For multiple destination configuration, this is configured on the General tab.
a) Enter the destination Name.
b) In the Server list, click the Nuance Output Manager server where the Nuance Output Manager Output Service

is located for this destination.
The destination does not have to be on the same server as the Nuance Output Manager Output Service.

c) Enter any Comments or Location information for the destination.
d) Optional: To change the large destination image that displays when configuring a single destination, you can

click Select Image and choose the appropriate image file (BMP, JPEG, or PNG).
The selected image will be compressed and scaled to 96x96 pixels. Changing this image will not change the
smaller image that displays or the image that displays in the source tree. To change the image back to the
default, click Reset Image.
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6. Configure the Windows queue settings.

Configuration Method

Single destination configuration Use the Windows queue settings tab.

Multiple destination configuration Use the Windows queue settings (Bulk Configuration
) tab.

a) Enter the name of the Print server where documents will be sent.
b) Enter the name of the Print queue.

You can configure a default value and a dynamic override value for most options. Default values are used to
manage the documents as they are being sent to the destination. You can choose to dynamically override the
default values using document properties and functions. To insert document properties, right-click in the dynamic
box and select Insert Document Property. A menu containing all of the available properties displays. You
can select a property in the list or type the property name. If a property is selected and it contains a value, that
value is processed instead of the default value. To insert functions, right-click in the dynamic box, select Insert
Function, and choose the appropriate function. Review the Using Nuance Output Manager Functions help topic
for information on configuring functions.

7. Configure options on the More settings tab.

Configuration Method

Single destination configuration Use the More settings tab.

Multiple destination configuration Use the More settings (Bulk Configuration) tab.

a) Select the printing cost per page for black and white and color documents.
b) Select Include documents in Green Reports to make documents sent to the destination available for green

reports. The documents appear in green reports once Nuance Output Manager deletes them from the Retained
tab.

c) Select the appropriate Printer family.
Printer families are used to configure commands for print languages and map them to destinations based on
their capabilities. You can select an existing printer family in the list or create one in the Printer Family
Profile dialog box. To create a printer family during single destination configuration, click New. To create
during multiple destination configuration, click the Browse button.

d) Optional: If you select a Printer family, you can configure Destination specific capabilities.
These options determine which print preferences/document properties are supported by the destination. To
configure destination specific capabilities, click Configure to open the Destination Capabilities dialog box.
All of the document properties available to this destination are listed and grouped into categories. Expand the
appropriate category by clicking the arrow next to the category name. Select the check boxes for properties
you want to be available for configuration throughout Nuance Output Manager. Clear the check boxes for
properties you do not want to be available. If a property is configured by selecting from a list of options, those
options will display beneath the property. Select and clear the check boxes to determine the choices that will
be available when those properties are configured. Repeat this step until all properties are configured, and then
click OK.

e) Select the appropriate Output process. You can select an existing process in the list or create one using the
Process Designer.

• To create a process during single destination configuration, click New.
• To create during multiple destination configuration, click the Browse button.
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Output processes can be created to impact documents as they are being sent to a destination. The processes
contain a set of actions which could be used for search and replace, setting finishing options, editing PJL
commands, inserting overlays, and so on.

f) Determine if you want to override the output process assigned to the document and use the selected destination
output process.

g) Select the appropriate Failover profile. You can select an existing profile in the list or create one in the
Failover Profile dialog box.

• To create a profile during single destination configuration, click New.
• To create during multiple destination configuration, click the Browse button.

Failover profiles specify what should happen to documents when they are sent to inaccessible destinations
(they are not able to receive documents).

h) Determine if you want to override the failover profile assigned to the document and use the selected
destination failover profile.

8. On the Error handling tab, configure the error handling options.

Configuration Method

Single destination configuration Use the Error Handling tab.

Multiple destination configuration Use the Error Handling (Bulk Configuration) tab.

a) Select the appropriate Error handling profile. You can select an existing profile in the list, or create one in the
Error Handling Profile dialog box. To create a profile during single destination configuration, click New. To
create during multiple destination configuration, click the Browse button.
Error handling profiles specify what should happen to destinations when an error is detected via SNMP or
during transmission of a document.

b) Choose the Default failover destination.
This specifies what should happen to documents when they are sent to inaccessible destinations (they are not
able to receive documents). You can choose to route the documents to a parent group or a specific destination
or group. The parent group where the destination currently resides is selected by default.

9. Click OK.

Note:  Output Manager may not be able to detect the actual number of pages spooled to a print driver on the
host machine. The Output Manager Console will then display "1" for Total Pages regardless of the actual
number of spooled pages.

Configuring the Document Library
Complete the following steps to configure the Document Library destination.  Documents routed to this destination
will be sent to the Library application using the assigned library profile settings.

1. In the Destinations tree, right-click the Document Library destination and click Configure.
The document library destination is created by default during software installation.

2. If necessary you can modify the destination Name and enter Commentsand a Location.
3. Optional: You can change the large destination image that displays when configuring a single destination. To do

so, click Select Image and choose the appropriate image file (BMP, JPEG, or PNG). To change the image back to
the default, click Reset Image.
The selected image is compressed and scaled to 96x96 pixels. Changing this image does not change the smaller
image that displays or the image that displays in the destination tree.



Output Manager Administration Guide
Version 4.0 SP2

199 © 2016 Nuance Communications, Inc. All rights reserved.

4. On the Library settings tab, select the appropriate library profile from the list or click the Browse button to
display the Manage Document Library Profiles dialog box.
The library profile contains all of the settings needed to properly “file” the document. All documents sent to the
library destination will be assigned the selected profile. Note, if you route the document using a business rule with
a library profile assigned, the business rule library profile will be used.
From the Manage Document Library Profiles dialog box, you can create, modify, and remove library profiles.

5. Configure a library profile in the Manage Document Library Profiles dialog box.
a) click New.
b) Specify the library profile Name and Description.
c) Determine where documents will be placed in the library. You must first click the Base folder Browse button

to select an existing folder. If desired, you can then specify one or more Dynamic folder levels to be placed
under the selected Base folder. To create dynamic folders, click Add and enter a folder name. The folder name
can consist of text and one or more document properties. To insert document properties, right-click in the text
box, and click Insert Document Property. Some example document properties are date/time, document name,
data type, and so on. Once you have entered the folder name, click OK.
You can add, edit, and remove folders, and change the folder order using the buttons next to the box. Each
level added becomes a sub folder of the folder above it in the list.

d) Choose if you want to Send email notification upon filing. If you want to send an email notification when a
document is sent to the library, select the check box and click Email. Configure the email setting on the Send
Email dialog box.

e) Specify the file store for documents sent to the library.
You can choose to leave them in their current file store or move them to a specified file store.

f) In the Purge documents box, specify how long documents should stay in the library before they are deleted.
6. Configure options on the More settings tab.

a) Enter the printing cost per page for black and white and color documents.
b) Select Include documents in Green Reports to make documents sent to the destination available for green

reports. The documents appear in green reports if Nuance Output Manager deletes the documents from the
server after being spooled but not printed.

c) Select the appropriate Printer family.
Printer families are used to configure commands for print languages and map them to destinations based on
their capabilities. You can select an existing printer family in the list or create one in the Printer Family
Profile dialog box. To create a printer family during single destination configuration, click New. To create
during multiple destination configuration, click the Browse button.

d) Select the appropriate Output process. You can select an existing process in the list or click New to create one
using the Process Designer
Output processes can be created to impact documents as they are being sent to a destination. The processes
contain a set of actions which could be used for search and replace, setting finishing options, editing PJL
commands, inserting overlays, and so on.

You can click Edit to edit the selected profile or click Manage to display the Manage Output Process
Profiles dialog box, which lists all of the defined profiles. When managing profiles, you can create, import,
and export profiles, as well as manage all existing profiles

e) Optional: If you want to use the selected destination output process instead of the output process assigned to
the document, select the Override output process assigned to document check box.

f) Select the appropriate Failover profile. You can select an existing profile in the list or create one in the
Failover Profile dialog box.

• To create a profile during single destination configuration, click New.
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• To create during multiple destination configuration, click the Browse button.

Failover profiles specify what should happen to documents when they are sent to inaccessible destinations
(they are not able to receive documents).

g) If you want to use the selected destination failover profile instead of the failover profile assigned to the
document, select the Override failover profile assigned to document check box.

7. On the Error handling tab, configure the error handling options.
a) Select the appropriate Error handling profile. You can select an existing profile in the list, or create one in the

Error Handling Profile dialog box. To create a profile during single destination configuration, click New. To
create during multiple destination configuration, click the Browse button.
Error handling profiles specify what should happen to destinations when an error is detected via SNMP or
during transmission of a document.

b) Choose the Default failover destination.
This specifies what should happen to documents when they are sent to inaccessible destinations (they are not
able to receive documents). You can choose to route the documents to a parent group or a specific destination
or group. The parent group where the destination currently resides is selected by default.

8. Click OK.

After you complete this procedure, the library destination is configured and ready to receive documents.

How to Send Documents to a Destination Group
Use this procedure to configure how documents are routed within a group of destinations.

1. In the Destinations application, right-click the group and select Configure Group Routing.
2. On the Group Routing Configuration dialog box, select the routing method:

• Do not assign a destination — This is the default method. Documents are assigned to a pending queue within
the group and are not routed. Documents remain in the pending queue until they are manually assigned to a
destination or until they are released from an Nuance Output Manager release station.

• Round robin among available destinations — Documents are assigned to the next available destination in
the group in a round robin fashion:

• Use Require matching document and destination properties to only assign documents to destinations in
the group if selected group property values match between the document and destination.

• Click Configure to select the routing columns that are used by the group. See Global Group Routing Map
dialog box on page 549 for more information.

3. To support using matching document and destination properties to route documents to destinations, set the routing
criteria for the destination group:
a) Right-click the destination group and select Set Routing Criteria.
b) In the Group Routing Criteria dialog box, enter the matching criteria for each property for each destination

in the group.

To match any value for a document property, leave the corresponding group routing criteria column blank. To
match more than one document property value, enter a comma separated list of possible values.

When documents are routed to the group and do not match any destination routing criteria, the documents are
held in the group pending queue until they are manually assigned to a destination or until they are released
from an Nuance Output Manager release station.
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Managing Destinations
Destinations are used only for outbound data. They route files from Nuance Output Manager to a physical destination,
such as a laser printer, a host, or other locations on the LAN. You can control destinations from the Output Manager
Console using the following procedures.

• Enable a destination
• Disable a destination
• View SNMP alerts
• Open a destination
• Move a destination
• Rename a destination
• Copy a destination

• View destination output history
• View all messages for a destination

How to Enable a Destination
Enabling a destination allows it to accept documents for printing.

Use one of the following methods to enable a destination.

• In the Destinations grid, right-click a destination and click Enable.
• In the Destinations tree, right-click a destination and click Enable.

How to Disable a Destination
Disable a destination to prevent it from receiving documents.

Use one of the following methods to disable a destination.

• In the Destinations grid, right-click a destination and click Disable.
• In the Destinations tree, right-click a destination and click Disable.

How to View SNMP Alerts
Perform this procedure to view SNMP alerts.

The Nuance Output Manager SNMP Service uses SNMP to continuously monitor the specific device/printer status
for each destination. The SNMP Alert Level will display in the Destinations grid and home page for the appropriate
destination.

• To quickly view the SNMP alerts and details, right-click a destination in the grid and click Alerts.
The Alerts for Destination dialog box displays all pending SNMP alerts for the selected destination.

Tip:  You can use the Alert Rules Manager to configure Nuance Output Manager to take an action when
specific alerts occur.

How to Open a Destination
Use one of the following methods to open a destination.

• In the Destinations tree, double-click a destination.
The destination will open in the current tab.
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• In the Destinations tree, right-click a destination and click Open.
The destination will open in the current tab.

• In the Destinations tree, right-click a destination and click Open in New Tab.
The destination will open in a new tab.

How to Move a Destination
Complete this procedure to move a destination to a different location in the tree.

Destinations can be organized into destination groups. Once groups are created, destinations and groups can be easily
moved in the Destination tree as necessary.

1. From the Destinations tree, select the destination or destination group you want to move.
2. Drag a destination to the desired tree location.

As you drag an item, a yellow arrow will appear to the left of the tree to indicate where the item will be placed.

How to Rename a Destination
Perform this procedure to rename a destination.

1. From the Destinations tree, right-click a destination and click Rename.
2. In the edit field, type the new destination name and press Enter. To cancel the rename, press Esc.

How to Copy a Destination
Complete the following steps to copy a destination.

Destinations can be copied into multiple destination groups.

1. From the Destinations tree, select the destination you want to copy and hold down the Ctrl key.
2. While pressing the Ctrl key, drag the destination in the desired tree location.

As you drag the item a yellow arrow will appear to the left of the tree to indicate where the copy will be created.

How to View Destination Output History
Complete this procedure to view the output history of destinations or destination folders.

You can choose from one of the predefined output history time frames or create a custom query.

1. In the Destinations tree, select a destination or destination folder.
2. Right-click and click Output History.
3. On the Output History submenu, choose one of the predefined output history time frames or create a custom

query. To create a custom query, complete the following steps:
a) In the submenu, click Custom query. The query tool dialog will display.
b) Click the plus button next to the AND operator.
c) To select the column, click the column name link in the condition and select the appropriate column from the

list.
All available columns will display in the list.

d) Click the operator link in the condition and select the appropriate comparison operator from the list.
The comparison operator list displays only the operators supported by the current column's data type. For
example, the Priority column is of the numeric type so the operator list doesn't display the 'Begins with'
operator and other operators that are related to the string type.

e) Click the <enter a value> link and enter a value in the box.
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f) To add additional conditions, click the plus button next to the group's AND operator.
This will create new conditions below the current one.

g) Repeat the preceding steps to complete each condition statement.
h) Click OK to query data using the new query statement.

To cancel the query, click the Cancel Query Mode button below the grid.

Tip:  You can create more advanced queries containing multiple logical (Boolean) operators. To change
the root logical operator, click the current AND operator and select the appropriate operator from the list.
You can then add a new query statement group by clicking the operator and selecting Add Group. You
can add multiple groups containing multiple conditions. Complete each group using the steps above.

4. In the Destination Output History window, review the output history for the selected destination or folder.
5. Use the following procedures to change the output history as needed.

• In the Destination tree, click destinations and folders as necessary. The grid will update to match the new tree
selection.

• Click a new history time period as necessary. The grid will update to match the new time period selection.
• Click Refresh Query below the grid to update the grid with the latest information.

Tip:

Search the tree: In the Search box below the tree, type the text you
want to find and press Enter or click the Search
button. If the text is found, your focus will be
moved to the first occurrence. New buttons will
appear near the Search box that allow you to move
to the previous occurrence and move to the next
occurrence.

Search the grid: In the Search box below the grid, type the text
you want to find, click the column in the grid you
want to search, and then press Enter or click the
Search button. If the text is found, your focus will
be moved to the first occurrence. New buttons will
appear near the Search box that allow you to stop
searching, move to the previous occurrence, and
move to the next occurrence.

Print the output history: Click the Print button below the grid to print the
output history.

How to View All Messages for a Destination
Perform this procedure to view messages about a destination.

• In the Destinations grid, right-click a destination and click View messages.

The Message Console will display listing all messages related to the selected destination.
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Documents

Learning About the Documents Application
The Documents application is used to manage the flow of documents in Nuance Output Manager. In the navigation
pane, click the Documents button to open the Documents application. The navigation pane displays a configurable
Documents tree showing all of the document folders and saved document queries. From the tree, you can create
document folders for organizing documents. Under the Document Queries folder, you can also create queries for
quickly locating documents based on their properties and query folders for organizing queries. Document folders,
query folders, and queries can be moved using drag-and-drop functionality.

Click the area of the window you want to learn more about.

1. Navigation Pane on page 204
2. Console window on page 205

Navigation Pane

When you right-click an item in the navigation pane, the following options will display. The options listed will vary
depending on if a document folder, query folder, or document query is selected.

Navigation Pane Option Description See

Open Displays a grid view of the selected i
tem. If a document folder is selected
, all of the documents contained in th
e folder will be listed. If a document
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Navigation Pane Option Description See

query is selected, all of the document
s that meet the criteria of the query w
ill be listed.

Open in New Tab Opens the document folder or docum
ent query in a new tab.

• Managing Document Folders

New Folder Creates a new document folder or q
uery folder under the selected folder
. A new folder entry titled UnNamed
will appear in the tree. Type the new
folder name and press enter to create
the folder. By default the new folder
will inherit the security settings of its
parent folder.

• Creating Folders

New Query Creates a new document query under
the selected query folder. Displays th
e Document Query Tool dialog box.

• Create Document Queries

Rename Renames the selected folder. • Rename Folders

Delete Deletes the selected folder or query.
Folders cannot be deleted if they con
tain any documents, queries, or subf
olders.

• Delete Folders

Security Opens the Security Configuration
dialog box for updating the security
settings. This will define the type of
access users and groups have to the d
ocuments either contained in the fold
er or that meet the query criteria.

• Security Configuration dialog
box

• Configure Security for
Documents

Console window

The console window displays a tabbed view of the Documents tree selection. When a document folder is selected in
the tree, the Documents grid will display listing all of the documents in the folder. Retained documents will appear
in a blue shaded row. When a query is selected in the tree, the Documents grid will list all of the documents whose
properties match the query. Notice the Documents grid is in a tab page control. By default, navigating in the tree will
replace the information in the active tab. Document queries can be opened in a new tab, by right-clicking a query in
the tree and clicking Open in New Tab. Your tree selection, open tab pages, and console window settings will be
saved for the next time you open the application.

Grid shortcut menu options

When you right-click a document in the grid, the following options will display.
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Grid Option Description See

View Displays the selected document
in the Viewer of your choice. The
submenu options that display vary
depending on the type of document
selected.

OM Viewer — Displays the selected
document in the Output Manager
Viewer.

Windows Default Viewer — Opens
the application installed in Windows
that Windows has assigned to open
that file type.

• View documents

Properties Displays the properties for the select
ed documents. You can edit the docu
ment properties from the Document
Properties dialog box.

• Edit document properties
• Document Properties dialog box

Delete Deletes the selected document from
Nuance Output Manager.

• Delete documents

Hold Sets the state of the selected docume
nt to Hold. The document cannot be r
outed.

• Change the document state

Ready Sets the state of the selected docume
nt to Ready. The document is ready t
o be routed.

• Change the document state

Reprint Reprints the selected document at a s
cheduled time. You can choose to re
print the document using the origina
l page range, clear the current page r
ange and print the entire document, o
r reprint the document with a new pa
ge range.

• Reprint documents

Restore Restores the selected retained docum
ent to an active status. The documen
t can now be automatically routed to
a destination.

• Restore documents

Route to Destination Sends the selected document to the d
estination of your choice. You can se
lect one or more destinations in the t
ree.

• Manually route documents to a
destination

Assign to Document Folder Sets the location the document will r
eside in Nuance Output Manager. A

• Assign documents to a folder
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Grid Option Description See

dialog box will display listing all of t
he document folders.

Assign Profiles Assign Failover Profile —
 Assigns a failover profile to
documents. Failover profiles
specify what should happen to
documents when they are sent to
inaccessible destinations (they
aren’t able to receive documents).
Assign Library Filing Profile
 — Assigns a library filing profile
for sending documents to the
document library. You will
specify the library folder where
documents will be sent, the file
store, any notifications, and how
long to keep documents before
deleting.
Assign Notification Profile —
 Assigns a notification profile
to documents. This will send
notifications when specific events
occur in the document life cycle.
Assign Output Process —
 Assigns an output process to
documents. Output processes are
used to modify document data
while sending a document to a
destination.

• Assign a failover profile
• Assign a library filing profile
• Assign a notification profile
• Assign an output process

Billing Accounts

Package Management Manages document grouping (or asso
ciation with one another) for purpose
s of merging, zipping, or routing as a
group. The Package Manager dialog
box is displayed.

• Package Manager dialog box

Run Ad hoc Action Configures and performs ad hoc rule
actions on one or more selected docu
ments. These actions have no associa
ted rule or conditions. The configure
d action is performed against the doc
uments unconditionally. You can con
figure the following actions.

Create Package — Configures a
package of documents.

• Create Package dialog box
• Zip Package dialog box
• Merge Package dialog box
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Grid Option Description See

Zip Package — Zips the merged
document or any other documents
in Nuance Output Manager.
Merge Package — Configures
the document properties of the
merged file.

Run Ad hoc Rule Allows you to run any of the rules l
isted in the submenu. Only rules wi
th the Allowed for document right
click option selected on the Ad Hoc
Rule dialog box are displayed.

• Ad Hoc Rule dialog box

View messages Displays all messages related to th
e selected document in the Message
Console.

• Message Console

Schedule Schedules the selected document to
print on the day and time of your cho
ice.

• Schedule output

Set Retain Period Assigns a retain period to documents.
Retain periods determine how long d
ocuments will be retained.

• Assign a retain period

Filters Save Applied Filter — Saves the
applied document filter.
Load Filter — Opens the
Document Filters dialog box for
selecting a saved filter.
Create New Filter — Creates a
new filter for the grid. Displays
the Filter Builder dialog box.

• Filtering on Values

Queries Edit Query — Opens the
Document Query Tool for
modifying the current query.
Load Query — Opens the
Document Queries dialog box
for selecting a saved query.
Create New Query — Opens
the Document Query Tool for
creating a new query.
Save Current Query — Saves
the current query. The Document
Queries dialog box displays. You
can apply saved queries by right-
clicking the grid and selecting
Queries > Load Query.

• Create document queries
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Grid Option Description See

Layouts Important:  Layout files are
saved for the logged in user.
You will only have access
to load and delete the layout
files you create.

Delete layout — Allows for deleting
layout files created by the current
user.

Load layout — Allows for loading
layout files created by the current
user.

Reset layout — Abandons any
unsaved grid changes and resets
the grid to the default settings. The
default settings are configured in the
Configure Document Properties
Utility.

Save layout — Saves the current grid
settings to a layout file for the current
user.

• Use grid layouts
• Configuring Global Document

Properties
• Configure Document Properties

Utility

Grid status bar options

The following are the options that display in the status bar below the grid.

Status bar option Description

Search Searches the grid. To search, type the text you want to fi
nd and press Enter or click the Search image. If the text i
s found, your focus will be moved to the first occurrence.
New buttons will appear near the Search box that allow y
ou to stop searching, move to the previous occurrence, a
nd move to the next occurrence.

Print button Prints the contents of the grid.

Query button Displays the query tool for creating a custom query.

Refresh Query button Refreshes the current query.

Cancel Query Mode button Cancels the current query.

Paging buttons Allows for paging through the grid. Click the double left
arrow button (<<) to go to the first page, the left arrow b
utton (<) to go to the previous page, the right arrow butto
n (>) to go to the next page, and the double right arrow b
utton (>>) to go to the last page.

Number of Records Displays the number of records in the grid.
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Document states

The following are the possible document states.

Document State Description

Hold The document cannot be routed to a destination.

Ready The document is ready to be routed. The document will b
egin printing when its routing criteria matches that of a d
estination and it is the next document in the queue.

Incomplete The document is being received into a source and is goin
g through a transformation (for example, page count) and
/or being scheduled. It will remain in this state until the tr
ansform and/or scheduling is completed.

Error The document cannot be successfully routed to a destinat
ion. The destination may be disabled or unavailable.

Busy The document has begun printing to a destination but wil
l remain in this state until printing is completed

Retry Pending The document has been routed to a destination. If a failo
ver profile has been configured, the document will conti
nue to retry routing to this destination based on the failo
ver criteria.

Scheduled The document is scheduled to be sent to a destination.

Learning About the Library Application
The Library application allows for long-term storage of documents that have been received into Nuance Output
Manager. Based on user permissions, library documents can be viewed, reprinted, and so on. Documents are placed
in the Library by sending them to the Nuance Output Manager Document Library destination that was created by
default for you. Documents are assigned to library folders in a dynamic manner using a library filing profile. The
filing profile can be assigned by the Nuance Output Manager Document Library destination or business rules.

Click the area of the window you want to learn more about.
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1. Navigation pane on page 211
2. Console window on page 212

Navigation pane

In the navigation pane, click the Library button to open the Library application. The navigation pane displays a
configurable Library tree showing all of the library document folders and saved queries. From the tree, you can create
library folders for organizing library documents. Under the Library Document Queries folder, you can also create
queries for quickly locating documents based on their properties and query folders for organizing queries. Library
folders, query folders, and queries can be moved using drag-and-drop functionality.

When you right-click an item in the navigation pane, the following options will display. The options listed will vary
depending on if a library folder, query folder, or query is selected.

Navigation Pane Option Description See

Open Displays a grid view of the selected i
tem. If a library folder is selected, all
of the documents contained in the fo
lder will be listed. If a query is select
ed, all of the documents that meet the
criteria of the query will be listed.

Open in New Tab Opens the library folder or query in a
new tab.

New Folder Creates a new library folder or query
folder under the selected folder. A ne
w folder entry titled UnNamed will a
ppear in the tree. Type the new folde
r name and press enter to create the f
older. By default the new folder will

• Create Folders
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Navigation Pane Option Description See

inherit the security settings of its par
ent folder.

New Query Creates a new query under the select
ed query folder.

• Create document queries

Rename Renames the selected folder. • • Rename Folders

Delete Deletes the selected folder or query.
Folders cannot be deleted if they con
tain any documents, queries, or subf
olders.

• Delete Folders

Security Opens the Security Configuration
dialog box for updating the security
settings. This will define the type of
access users and groups have to the d
ocuments either contained in the fold
er or that meet the query criteria.

• Security Configuration dialog
box

Console window

The console window displays a tabbed view of the Library tree selection. When a library folder is selected in the tree,
the Library grid will display listing all of the documents in the folder. When a query is selected in the tree, the Library
grid will list all of the documents whose properties match the query. Notice the Library grid is in a tab page control.
By default, navigating in the tree will replace the information in the active tab. Queries can be opened in a new tab,
by right-clicking a query in the tree and clicking Open in New Tab. Your tree selection, open tab pages, and console
window settings will be saved for the next time you open the application.

Grid shortcut menu options

When you right-click a document in the grid, the following options will display.

Grid Option Description See

View Displays the selected document
in the Viewer of your choice. The
submenu options that display vary
depending on the type of document
selected.

OM Viewer — Displays the
selected document in the Output
Manager Viewer.
Windows Default Viewer —
 Opens the application installed
in Windows that Windows has
assigned to open that file type.

• View documents

Delete Deletes the selected document from
Nuance Output Manager.

• Delete documents
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Grid Option Description See

Assign to Library Folder Sets the location the document will r
eside in the Library. A dialog box w
ill display listing all of the library fo
lders.

• Assign documents to a folder

Queries Edit Query — Opens the
Document Query Tool for
modifying the current query.
Load Query — Opens the
Document Queries dialog box
for selecting a saved query.
Create New Query — Opens
the Document Query Tool for
creating a new query.
Save Current Query — Saves
the current query. The Document
Queries dialog box displays. You
can apply saved queries by right-
clicking the grid and selecting
Queries | Load Query.

• Create document queries

Layouts Important:  Layout files are
saved for the logged in user.
You will only have access
to load and delete the layout
files you create.

Delete layout — Allows for
deleting layout files created by
the current user.
Load layout — Allows for
loading layout files created by the
current user. The Load Layout
dialog box is displayed.
Reset layout — Abandons
any unsaved grid changes and
resets the grid to the default
settings. The default settings
are configured in the Configure
Columns Utility.
Save layout — Saves the current
grid settings to a layout file for
the current user.

• Delete grid layouts
• Load grid layouts
• Save grid layouts

Grid status bar options

The following are the options that display in the status bar below the grid.
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Status bar option Description

Search Searches the grid. To search, type the text you want to fi
nd and press Enter or click the Search image. If the text i
s found, your focus will be moved to the first occurrence.
New buttons will appear near the Search box that allow y
ou to stop searching, move to the previous occurrence, a
nd move to the next occurrence.

Print button Prints the contents of the grid.

Query button Displays the query tool for creating a custom query.

Refresh Query button Refreshes the current query.

Cancel Query Mode button Cancels the current query.

Paging buttons Allows for paging through the grid. Click the double left
arrow button (<<) to go to the first page, the left arrow b
utton (<) to go to the previous page, the right arrow butto
n (>) to go to the next page, and the double right arrow b
utton (>>) to go to the last page.

Number of Records Displays the number of records in the grid.

Managing Documents
From the Output Manager Console you can start, stop, view, and delete documents. You can route documents to
destinations and schedule documents to print at a specific time. You can control documents from the Output Manager
Console using the following procedures.

To perform these tasks, you must have the appropriate document folder permissions.

• Change the document state
• View documents
• Manually route documents to a destination
• Edit document properties
• Assign documents to a folder
• Delete documents
• Reprint documents
• Restore documents
• Schedule output
• Assign a failover profile
• Assign a library filing profile
• Assign a notification profile
• Assign an output process
• Assign a retain period
• Run an ad hoc rule on documents
• Run an ad hoc action on documents
• Manage document packages
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• View a document's history

How to Change the Document State
Perform this procedure to change the document state.

1. From the Documents grid, right-click the documents you want to change.
You can select one or more documents at a time.

2. Select one of the following state options from the menu.

• Hold — Sets the state of the selected document to Hold. The document cannot be routed.
• Ready — Sets the state of the selected document to Ready. The document is ready to be routed.

How to View Documents
Perform this task to view a document.

1. From the Documents grid, right-click the document you want to view.
2. Click View and then select the appropriate submenu viewing option.

The available options vary depending on the type of document selected.

Note:  You can use the Viewer Configuration dialog box to define and configure the Viewer utilities that
display in the menu. To access the Viewer Configuration dialog box, from the Output Manager Console
menu bar, select Tools > Configure Viewer.

How to Manually Route Documents to a Destination
Use this procedure to manually route documents to destinations from the Output Manager Console.

1. In the Documents grid, select one or more documents
2. Right-click the selection and click Route to destination.
3. Select one or more destinations in the tree.
4. Use the SHIFT and CTRL keys to select multiple destinations.

Destination groups cannot be selected. To quickly locate a destination, you can search using the search box below
tree.

5. Determine if you need to select the Enable offline destinations check box.
If you route a document to a destination that is offline, selecting this option will automatically bring the
destination online to receive the document. You can determine the offline destinations by looking at the images
in the tree. The images for offline destinations are gray with a red no symbol (for example, an offline folder
destination would display as ).

6. Click OK.

Note:  You can automatically route to a destination by including a default destination in the source
configuration and creating a business rule to route to a destination.

How to Edit Document Properties
Perform this procedure to edit properties of a document.

1. From the Documents grid, select one or more documents, right-click and click Properties.
This opens the Document Properties dialog box

2. In the View list, choose the document properties/print preferences that display in the grid. You can select from the
following options:
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Option Description

All Displays all available document properties in the grid.

Standard Displays only the document properties that the
destination is capable of using. This is the default view.

Only Set Values Displays only the document properties that contain
a value (have been configured). This is an easy way
to see the settings that are going to be applied to the
document.

3. In the grid, expand the category of the property you want to configure. The first node level in the category
determines the print preferences for the properties it contains.
The grid lists the property values that can be configured grouped in the following categories: Basic options, Media
selection, Document, Image adjustments, Finishing, and Other properties. To expand a category, click the down
arrow next to a category name. To collapse a category, click the up arrow.

4. In the Mode column, select how the property should be applied when a document is sent to a destination. Click in
the grid cell and choose from the following options:

Option Description

Always Apply Always applies the specified property value. Nuance
Output Manager will add commands to the print stream
to enforce the print preference. If the document already
contains commands for that print preference, Nuance
Output Manager will modify the commands to work
with the printer family where the document is being
sent.

Apply Conditionally Applies the property value conditionally. Nuance
Output Manager will only add or modify commands
for the print preference when the printer family that the
document is destined for is different from the printer
family the document was originally designed for.

Informational Only Nuance Output Manager makes no changes to the print
stream when the document is sent to the destination.
The value is for informational purposes only.

5. In the Value column, specify the document property value.
You can use functions to insert and extract data as necessary. Only the allowed values configured in the Configure
Document Properties utility will be available for selection. If (Excluded) displays next to a value, then that
value was excluded by the currently assigned destination on the Destination Capabilities dialog box.

6. Click OK to save changes.

How to Assign Documents to a Folder
Use this procedure to manually assign documents to document folders.

Assigning document folders allows you to place specific documents in any of the document folders defined in the
Documents or Library tree.

1. Select one or more documents, then:

• In the Documents application, right-click the selection and click Assign to Document Folder.



Output Manager Administration Guide
Version 4.0 SP2

217 © 2016 Nuance Communications, Inc. All rights reserved.

• In the Library application, right-click the selection and click Assign to Library Folder.
2. Select a folder and click OK.

To quickly locate a folder, you can search using the search box below tree.

How to Delete Documents
Perform this procedure to delete a document.

1. In the Documents grid, right-click one or more documents that you want to delete.
2. Click Delete on the shortcut menu.

How to Reprint Documents
Use this procedure to reprint documents.

From the documents grid you can reprint documents that have been retained. Retained documents appear in the
Documents grid with a blue background. You can reprint all or part of the document and schedule the reprint date and
time.

1. From the Documents grid, select one or more retained documents
2. Right-click the selection and click Reprint on the shortcut menu.

You can easily locate retained documents as they are shown with a blue background.
3. In the Destinations and Sources applications, click the Retained tab in the Documents grid.

This opens the Reprint Document dialog box.
4. Under Reprint options, you can reprint using one of the following methods.

• Reprint the document using the original page range specified.
• Clear the current page range and print the entire document.
• Reprint the document by specifying a new page range. If you choose to override the current page range, the

Document page range option becomes available for you to specify the new page range. Enter the pages to
print using the following formats, without quotation marks ("). You can enter one or more page ranges using a
comma to separate the values (for example, 3-6,1,18-).

• "n-n" — To print a specific page range
• "-n" — To print from the beginning of the document to a specific page
• "n-" — To print from a specific page to the end of the document
• "n" — To print a specific page

5. Under Schedule reprint time, specify the date and time the document will reprint.
6. Click Destinations to select the destinations where you want to print the document.
7. In the Route to Destination dialog box, select one or more destinations in the tree.

Use the Shift and Ctrl keys to select multiple destinations. Destination groups cannot be selected. To quickly
locate a destination, you can search using the search box below tree.

8. Determine if you need to select the Enable offline destinations check box.
If you route a document to a destination that is offline, selecting this option will automatically bring the
destination online to receive the document. You can determine the offline destinations by looking at the images
in the tree. The images for offline destinations are gray with a red no symbol (for example, an offline folder
destination would display as ).

9. Click OK.
10. Click Submit.
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How to Restore Documents
Use this procedure to restore documents back to their previous source.

Documents that have been routed to a destination are considered Retained. Within the Documents grid, these records
will show highlighted in blue and have a document state of Hold.

1. In the Documents grid, right-click one or more documents you want to restore.
2. Click Restore on the shortcut menu.

After you complete this procedure, the documents will no longer be retained. They will be restored to their previous
source.

How to Schedule Output
Use this procedure to schedule a document to print at a specified day and time.

You can schedule documents to print at a specific time. For example, you can schedule certain jobs to print on a
specific day of the week or you can schedule large jobs to print at night. Documents become eligible to print at the
specified time. They might not print at the exact time, depending on how many other eligible documents are ahead of
them in the queue.

1. From the Documents grid, select one or more documents.
2. Right-click the selection and click Schedule.
3. From the Schedule dialog box, select the specific day and time to print the documents.
4. Click OK to save the changes.

How to Assign a Failover Profile
Use this procedure to assign a failover profile to documents.

Failover profiles specify what should happen to documents when they are sent to inaccessible destinations (they aren’t
able to receive documents).

1. From the Documents grid, select one or more documents
2. Right-click the selection and click Assign Profiles > Assign Failover Profile.

This opens the Set Failover Profile dialog box.
3. In the Profile list, select the appropriate failover profile, or click New to create one using the Failover Profile

dialog box.
In this dialog box, you can determine what should happen if all of the retries fail and when to place the document
in an error state.

4. You can click Edit to edit the selected profile, or click Manage to display the Manage Failover Profiles dialog
box, which lists all of the defined profiles.
When managing profiles, you can create, import, and export profiles, as well as manage all existing profiles.

5. After you select a profile, click OK.

Assigning a Library Filing Profile

Use the following procedure to send documents to the document library. You will specify the library folder where
documents will be sent, the file store, any notifications, and how long to keep documents before deleting.

1. From the Documents grid, select one or more documents.
2. Right-click the selection and click Assign Profiles > Assign Library Filing Profile.
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This opens the Set Library Filing Profile dialog box.
3. In the Profile list, select the appropriate library filing profile, or click New to create one from the Document

Library Profile dialog box.
4. Complete the following steps to configure a library profile.

a) Click New.
This opens the Document Library Profile dialog box.

b) Specify the library profile Name and Description.
c) To determine where documents will be placed in the library, click the Browse button to select an existing Base

folder.
If desired, you can then specify one or more Dynamic folder levels to be placed under the selected Base
folder. To create dynamic folders, click Add and enter a folder name. The folder name can consist of text, one
or more document properties, and functions.

• To insert document properties, right-click in the text box, click Insert Document Property, and choose the
appropriate properties. Some example document properties are date/time, document name, data type, and
so on.

• To insert functions, right-click in the box, click Insert Function, and choose the appropriate function.

Review the Using Nuance Output Manager Functions help topic for information on configuring functions.

You can add, edit, and remove folders, and change the folder order using the buttons next to the box. Each
level added becomes a sub folder of the folder above it in the list.

d) To send an email notification when a document is sent to the library, select the Send email notification upon
filing check box and click Email.
Configure the email setting in the Send Email dialog box.

e) Specify the file store for documents sent to the library.
You can choose to leave them in their current file store or move them to a specified file store.

f) In the Purge documents box, specify how long documents should stay in the library before they are deleted.
g) Click OK.

5. After you select the profile, click OK.

Assigning a Notification Profile
Use this procedure to assign a notification profile to documents.

Notification profiles will send notifications when specific events occur in the document life cycle. Notifications
are sent according to defined notification profiles. Notification profiles specify which events generate notifications
(document arrives, prints successfully, prints on failover destination, or is in error state), the type of notification for
each event (email or pop-up), the text of notifications for each event, and who should get notified. For example, you
can configure a pop-up to display after a document prints successfully.

1. In the Documents grid, select one or more documents.
2. Right-click the selection and click Assign Profiles > Assign Notification Profile.

This opens the Set Notification Profile dialog box.
3. In the Profile list, select the appropriate notification profile, or click New to create one using the Notification

Profile dialog box.

Complete the following steps to create a notification profile.

a) Click New.
This opens the Notification Profile dialog box.
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b) Specify the library profile Name and Description.
c) If this profile will send email notifications, select the Email profile that will be used with those notifications.

You can select an email profile from the list or click the Browse button and mange profiles from the Manage
Outbound Email Profiles dialog box. From this dialog box you can create and modify email profiles using
the Outbound Email Profile dialog box.

d) Click directly in the Notifications grid to configure the notifications that will be sent. You will need to
configure each grid column. You can add and remove notifications (grid rows) using the Add and Remove
buttons.

• When the document — Select when a notification will be sent. You can choose to send a notification
when a document Arrives, Prints Successfully, Prints on Failover Destination, or Is In Error State.

• Send notification via — Select how the notification will be sent and displayed. You can choose to send
notifications using the Tray Client Pop-up or as an Email Message.

• Notify owner — Choose if the document owner will be sent a notification.
• Recipients — Click the Browse button to select who will receive the notification. You can select users and

groups from the User and Group Selection dialog box. If the user or group you want is not listed, click
More Users to search for additional users. See the Adding users and groups to Nuance Output Manager 
topic for detailed procedures on adding users.

• Message — Enter the notification text. You can insert document properties and functions in the body text.
To insert document properties, right-click in the text box, select Insert Document Property, and choose
the appropriate properties. Document properties will display enclosed in brackets ([]). The values of the
properties will display in the notification. To insert functions, right-click in the box, click Insert Function,
and choose the appropriate function. Review the Using Nuance Output Manager Functions help topic for
information on configuring functions.

e) Click OK.
4. After you have selected your profile, click OK.

How to Assign an Output Process to a Document
Use this procedure to assign an output process to documents.

Output processes can be created to impact documents as they are being sent to a destination. The processes contain a
set of actions which could be used for search and replace, setting finishing options, editing PJL commands, inserting
overlays, and so on.

1. In the Documents grid, select one or more documents.
2. Right-click the selection, and click Assign Profiles > Assign Output Process.

This opens the Set Output Process dialog box.
3. In the Profile list, select the appropriate output process or click New to create one from the Process Designer

window.

See the Working with output processes topic for output process procedures.

You can click Edit to edit the selected profile or click Manage to display the Manage Output Process Profiles
dialog box which lists all of the defined profiles. When managing profiles, you can create, import, and export
profiles, as well as manage all existing profiles.

4. After you have selected your profile, click OK.
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How to Assign a Retain Period
Use this procedure to assign a retain period to documents.

Retain periods determine how long documents will be retained.

1. From the Documents grid, select one or more documents
2. Right-click the selection and click Set Retain Period.

This opens the Set Retain Period dialog box.
3. Set the retain period.

• Use the Retain for options to retain documents for a specified time period. Time periods can be specified in
years, months, days, hours, and minutes.

• Use the Retain until options to retain documents until a specified date and time.
4. Click OK.

How to Run an Ad Hoc Rule on Documents
Use this procedure to run ad hoc rules on documents from the Documents grid.

1. From the Documents grid, select one or more documents.
2. Right-click the selection and click Run Ad hoc Rule.

You can run any of the rules listed in the submenu. Only rules with the Allowed for document right click option
selected on the Ad Hoc Rule dialog box are displayed.

3. When you are prompted whether to run the ad hoc rule on the selected documents, click Yes.

How to Run an Ad Hoc Action on Documents

Use one of the following procedures to configure and perform ad hoc rule actions on documents from the
Documents grid. You can create a package of documents, create a zip package, or create a merge package.

• Create a package of documents
• Create a zip package
• Create a merge package

To create a package of documents
Use this action to create a package of documents. This puts selected documents in a single document package.

1. From the Documents grid, select one or more documents, right-click and click Run Ad hoc Action > Create
Package.
This opens the Create Package dialog box.

2. Enter the Naming prefix for the package document.
This prefix will be added to all documents in the package.

3. If you want to group documents in the package, select Grouping property and select the property to group by in
the drop-down list.

4. In the Ordering properties list, select the document properties that will control the order the documents are
packaged.

Note:  Only the allowed properties selected on the Configure Document Properties Utility will display
in the Ordering properties list.

As you select properties, they are added to the Selected order list.
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5. Select properties in the Selected order list and use the Move up and Move down buttons to configure the
property order.

6. Click OK.

To create a zip package
Use this action to zip the selected documents.

1. In the Documents grid, select one or more documents, right-click and click Run Ad hoc Action > Zip Package.
This opens the Zip Package dialog box.

2. Enter the Zip File Name in the box.
3. If this rule will be used after all documents have been received into Nuance Output Manager, select the Used as a

post-processing action check box.
4. In the Original documents box, select what happens after the zipped file has been created.

You can leave documents in the spooler, move them to retain them, or delete them.
5. Click OK.

To create a merge package
Use this action to create a merged file.

1. In the Documents grid, select one or more documents
2. Right-click the selection, and click Run Ad hoc Action > Merge Package.

This opens the Merge Package dialog box.
3. Next to Transform, click the Configure button to configure the transform.
4. In the Server box, click the licensed transform server that you would like to use.
5. In the Transform package box, you can select an existing transform package or you can complete the following

steps to create a transform package.
a) Click New.
b) On the General tab, enter the transform package Name.
c) Select the transform package type.
d) If you select a third-party conversion tool, verify that the EXE path is set to the correct folder. The default

EXE path is @EOMTransformDir. To change the path, type the new path the box or click the browse button
(...).

e) Set the Logging State.
The logging state determines if transform logs and temp files will be saved in the document folder. By default,
the Logging State is set to Yes. All log files should be inspected during installation and preproduction testing
to insure that fonts are correctly mapped. In a production system, the logging can be disabled to save disk
space. If the transform operation returns an error (return code not zero), the log and temp files will not be
deleted, and are available for troubleshooting.

f) On the Filter Profiles tab, specify how the transform software will handle the formatting for each data type.

• To configure a profile, click the ellipsis button in the Modify/New column for the appropriate formats.
In the Configure Filter Profile dialog box, configure the profile as needed. The profile contains a
communications and printer definition section. See the Configuring a CpMillProfile resource topic for
instructions on configuring a filter profile.

• To select a profile, click in the Configuration column for the appropriate formats and select the profile
from the list.

g) On the Resources tab, specify where the transform software will find the resources needed for the
transformation.
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For example, PDF fonts are usually found at the location of an Adobe installation.
h) On the Fonts tab, you can control the font mapping of input fonts to output fonts.

The defaults are typically correct, but may need to be adjusted for special cases. You can add or modify fonts
directly in the grid.

i) Click OK to create the transform package.
6. Select the Override input filter profile assigned to document  check box to use the filter profile in the transform

package.

• Select this check box override the input filter profile assigned to the document.
• Clear this check box if you want to use the filter profile configured in the transform package.

7. In the Output format list, click the format of the output file.
8. Configure the conversion of each input format in the Input formats grid, and then click OK.

• For all unlicensed input formats and any input formats you don't want to use, click in the Configuration
column and select Do Not Transform.

• For licensed input formats, you can select Use Default Options or select a predefined configuration in the
Configuration column.

To configure a custom input format, click the browse button (...) in the Modify/New column. If Use Default
Options or Do Not Transform is selected in the Configuration column, a new configuration will be created.
If a predefined configuration is selected, that configuration will be modified. The custom transform options are
configured on the Input options tab, Output options tab, and Page Layout tab. If BMP or PDF is selected as
the output format, the Bitmap output tab or PDF output tab will also display.

9. When the transform configuration is complete, click OK.
The Merge Package dialog box indicates the transform has been configured.

10. Complete the following steps to configure Package boundaries.
a) Select Package boundaries and click Configure.

The Package Boundary Fields dialog box is displayed.
b) From the grid, expand the sections to select the document properties that will be used as package boundaries.
c) Click OK.

Boundary fields are only applicable when a merged document will exceed the maximum number of exceptions
(currently set at 1000). Merged documents that exceed the exception count will be split into separate
documents. Boundary fields are used to control where the merged documents will be split. Each split will be
on a boundary that maximizes the number of pages without exceeding the exception threshold. If you do not
specify boundary fields, the split is arbitrary and will occur where the maximum number of pages can be fit.

11. Under Merged Document Properties, determine if you want to use the document properties from the first page in
the documents or the last page in the documents.
Selecting custom properties is not yet available.

12. Complete the following steps to configure Exception fields.
a) Select Exception fields and click Configure.

This opens the Exception Fields dialog box.
b) From the grid, expand the sections to select the document properties that will be used as exception fields.
c) Click OK.
Exception fields specify which document properties to preserve on a per-page basis in the merged document. The
document properties will be analyzed to determine the baseline and the exceptions (page overrides).

13. Determine if you need to Add blank pages for duplexing.
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14. Determine what will happen to the Original documents after the merged file has been created. You can leave
them in the spooler, move them to retain, or delete them.

15. Click OK.

How to Manage Document Packages

The Package Manager is used to manage which documents are contained in a package. “Package” is an Nuance
Output Manager concept used as a means of grouping documents together for the purposes of routing to a destination
as a group, running ad hoc rules on the group, and so forth. By default, each document arriving in Nuance Output
Manager will be the only document in its own package bearing the same name as the document.

1. To open the Package Manager, in the Documents list, first select one or more documents
2. Right-click the selection and click Package Management.

Only the packages associated with the selected documents will be available for management.

Completing this procedure opens the Package Manager dialog box.

Use the following procedure to move documents from one package to another, remove documents from a package to
be in a separate package, and create new packages.

To create packages

1. Click New Package.
2. Type the package name in the dialog that displays and click OK.

The new package is added to the bottom of the Packages list.

To remove documents from packages

1. In the Package documents list, select the documents you want to remove.
2. Click the > button.

The documents are removed from the package and placed in the Removed documents list.

To add documents to packages

1. In the Packages list, select the package to which you want to add documents.
2. Click the < button.

The documents are added to the selected package.

To move documents between packages using drag-and-drop

1. In the Package documents list, select the documents you want to move.
2. Click and drag the selected documents to the desired package in the Packages list.

How to View a Document History
Use this procedure to view a document history.

• In the Documents grid, right-click a document and click View messages.

This displays the Message Console listing all messages related to the selected document.
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Working with Documents
From the Output Manager Console, you can manage the flow of documents from Nuance Output Manager to a
destination.

Nuance Output Manager supports a variety of document types, such as PCL, PS, PDF, Text, TIFF, JPG, PGN, AFP,
IPDS (not available for new sales), LCDS, and so on. The system also supports transforming documents between
these print description languages (PDL).

• Manage document folders
• Configure security for documents
• Create document queries
• Search for documents

How to Manage Document Folders
In both the Documents and Library applications, documents are organized in folders. These folders define the
permissions that users and groups have over documents.

• Create folders
• Move folders
• Rename folders
• Delete folders
• Search for folders

To create folders

1. In the Documents or Library tree, right-click a folder and click New Folder. A new folder titled UnNamed is
added to the selected folder.

2. In the edit field, type the name of the new folder and press Enter.
The new folder automatically inherits the permissions of the parent folder.

To move folders

1. In the Documents or Library tree, select the folder you want to move.
2. Drag the folder in the desired tree location.

As you drag the item a yellow arrow will appear to the left of the tree to indicate where the folder will be placed.

To rename folders

1. In the Documents or Library tree, right-click a folder and click Rename.
2. In the edit field, type the new folder name and press Enter. To cancel the rename, press Esc.

To delete folders

1. In the Documents or Library tree, right-click the folder you want to delete.
2. Click Delete on the shortcut menu.

Note:  All of the objects must be removed before the folder can be deleted.
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To search for folders

1. In the search box below the Documents or Library tree, type the text you want to find and press Enter or click the
Search image.
Nuance Output Manager will start at the top of the tree and search for the text. Each time the text is found the
selected item will be highlighted in the tree and the item will open in the console window.

2. If more than one search result is found, click the next and previous arrow buttons that appear in the search panel to
navigate between search results.

How to Configure Security for Documents
Complete this procedure to assign document permissions.

Nuance Output Manager security for the Documents and Library application begins at the root of the tree, the
Document Folders or Library Document Folders group. The Documents and Library trees consist of folders which are
used to organize documents.

Nuance Output Manager security is provided by adding a Microsoft Windows user or user group to the folder and
assigning permissions to that user or user group. These Nuance Output Manager permissions define the type of
access users and user groups have to the documents within the folders. Once the Nuance Output Manager security
(Microsoft Windows users, user groups, and document permissions) is set in a folder, the Nuance Output Manager
security is inherited by all the objects in that folder. When a new document is added or a folder is created, its security
is automatically the same as its parent folder’s security (that is, the new document inherits its security from its parent
folder).

Note:  To begin configuring document security, start by assigning the desired document permissions in the
Document Folders or Library Document Folders. To view documents in the grid, users or user groups must be
assigned the Allow user to see Documents in list permission in the Document Folders or Library Document
Folders. Users not assigned this permission in that folder will not see any documents or folders even though
they may have been given permissions for the specific folder.

1. In the Output Manager Console, select the Documents and Library application in the navigation pane.
2. In the tree, right-click the folder you want to configure and click Security.

This opens the Security Configuration dialog box. To access this dialog box, you must be a member of the
local Administrators group. Users with these rights can add and remove users or groups and modify the assigned
permissions.
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3. In the Inherit permissions from the parent box, choose whether to inherit permissions from the parent folder or
remove inheritance. Click the browse button (...) to configure inheritance.
By default, folders are configured to inherit permissions from the parent folder.

Tip:  It is good practice to assign rights using inheritance, as it allows administrators to easily assign and
manage permissions. Blocking inheritance is useful when documents need to be seen by just a few users.
If you plan to block inheritance, make sure the users that need access to the blocked document folder
are in the security settings for all of its parent groups, including Document Folders or Library Document
Folders. If this is not done then those users will not be able to see the folder. Also remember to remove the
users and user groups that should not have access to the folder.

4. In the Users and groups with permissions list box, select the appropriate user or group in the list.
If you want to set permissions for a user or group that does not appear in the list, click Add. In the User and
Group Selection dialog box, select the users/groups you want to add and click OK. If the user/group is not listed,
click More Users to locate the user. From the list you can choose to add OM users, LDAP users, or Windows
users. You can also choose to import LDAP users. Once users are added, they are placed in the Nuance Output
Manager database and always be listed in the future.
The Assigned permissions list box will display the assigned permissions for the selected user.
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5. In the Assigned permissions box, select or clear the permissions for the selected user/group. Click Select All or
Unselect All to easily assign or remove all permissions.
If you notice permissions that are selected and disabled, then the user/group selected has inherited permissions.
Inherited permissions cannot be removed. To remove inherited permissions, you must first turn off inheritance for
the folder.
The permissions assigned to a folder will be inherited for all of the objects contained in that folder, except for the
ones that have inheritance blocked.

6. After you complete changes to the permissions, click OK.

Create Document Queries
Perform this procedure to create document queries.

The Documents and Library applications allow you to create document queries. Queries are used to quickly locate
documents based on their properties. Queries can be run from the Documents and Library tree and grid. They can be
run ad hoc or saved for future use.

1. Open the Document Query Tool using one of the following methods.

• In the Documents or Library tree, right-click one of the document query folders and click New Query. The
new query will be created under the selected folder.

• Right-click in the grid and click Queries > Create New Query
• In the grid, click the queries button (Q) below the grid. If a query is currently applied to the grid, the query

statements will be listed.
2. To create a query statement, click the + button next to the AND operator. To select the column, click the column

name link in the condition and select the appropriate column from the list.
All available columns will display in the list.

3. Click the operator link in the condition and select the appropriate comparison operator from the list.
The comparison operator list displays only the operators supported by the current column's data type. For
example, the Priority column is of the numeric type so the operator list doesn't display the 'Begins with' operator
and other operators that are related to the string type.

4. Click the <enter a value> link and enter a value in the box.
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5. To add additional conditions, click the + button next to the group's AND operator. This will create new conditions
below the current one. Complete each condition statement using the steps above.

6. Click OK to query data using the created query statement.

Tip:  You can create more advanced queries containing multiple logical (Boolean) operators. To change
the root logical operator, click the current AND operator and select the appropriate operator from the list.
You can then add a new query statement group by clicking the operator and selecting Add Group. You
can add multiple groups containing multiple conditions. Complete each group using the steps above.

7. If you created the query from the grid, you can save the query by right-clicking in the grid and clicking Queries >
Save Current Query.

• You will select the query folder and enter a query Name.
8. You can load saved queries by right-clicking in the grid and clicking Queries > Load Query.

• From the dialog box, select the query you want to open and click OK.
9. To refresh the query, click the Refresh Query button below the grid.
10. To cancel the query, click the Cancel Query Mode button below the grid.

How to Search for Documents
Complete the following steps to search for documents in the Documents grid. You can also search the Documents
grid that appears in both the Destinations and Sources applications.

1. In the Output Manager Console, select the Documents and Library applications in the navigation pane.
2. In the tree, select the appropriate document folder.
3. In the search box below the grid, type the text you want to find.
4. Click the column in the grid you want to search
5. Press Enter or click the Search image.

If the text is found, your focus will be moved to the first occurrence. New buttons will appear near the Search box that
allow you to stop searching, move to the previous occurrence, and move to the next occurrence.

How to Configure Global Document Properties
Perform this procedure to configure global document properties.

In the Configure Document Properties Utility, you can determine which print preferences/document properties
are supported throughout Nuance Output Manager. You can also select the settings that are allowed for a particular
property. These settings determine what is available to the user in the dialogs where properties are configured. When
properties are disabled, those Document columns are also hidden in the Documents grids.

1. In the Administration application, click Configure Document Properties Utility.
This lists all of the document properties available in Nuance Output Manager grouped into the following
categories:

• Basic options
• Media selection
• Document
• Image adjustments
• Finishing
• Other properties
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To expand a category and view the associated properties, click the down arrow next to a category name. To
collapse a category, click the up arrow

2. Determine the properties you want to be available for configuration throughout Nuance Output Manager.

• Select the Allowed check box for any property you want to be available for configuration throughout Nuance
Output Manager.

• Clear the check box for any property that you do not want to be available.

Properties that are configured by selecting from a list of options will display a drop-down arrow in the property
cell. Click the cell containing the arrow to display a dialog listing the available options. You can select and clear
the check boxes to determine the choices that will be available when those properties are configured.

Note:  Here is an example of how to configure the Resolution property so users can only select a
Resolution of 75, 100, or 150. First, expand the Basic options category by clicking the down arrow next
to the category name. Next, select the check box next to the Resolution property. This will make the
property available for configuration throughout Nuance Output Manager. Finally, under the Resolution
property, select the check boxes next to the options you want to be available for selection. In this example,
you would select the check boxes next to 75, 100, and 150. Clear the check boxes next to the remaining
Resolution options.

3. Repeat step 2 on page 230 until all properties are configured.
4. When all of the properties are configured, click Apply.
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Output Processes and Actions

Output processes
Output processes define actions that Nuance Output Manager takes on documents while routing the documents to
destinations.

You can configure Nuance Output Manager to use an output process to modify documents as they are routed to
destinations. An output process is a sequence of actions to take on the document. You can use output processes to
add banners, perform transformations or changes to the document record format, and other actions such as search and
replace, set finishing options, and insert overlays.

You assign output processes to a destination in the configuration dialog box for a destination. There you also
configure a destination output process to override output processes assigned to documents. You can assign output
processes to documents in the configuration dialog box for a source, using a business rule, or by assigning an output
process profile on the context menu for a document.

Process designer

Use the Output Manager Process Designer to create output processes. The Process Designer can be opened from
the Tools menu on the Output Manager Console menu bar or using the New or Edit buttons for an output process
assignment or in the Manage Output Process Profiles dialog box.

For details about the Process Designer layout, see Process Designer.

Output Process Actions

The following folders contain actions that you can use in an output process. How to Configure Actions on page 235
provides more information on actions.

Action type Description

Append Adds data to the end of the document. The data can be a
set of bytes, a string, a text resource, a binary resource,
or a banner resource.

Code page Changes the encoding of a document from one code page
to another.

DCO Allows for record format changes.

Hex Table Allows single or multiple byte substitutions.

Package Management Configures actions to define or manipulate package
contents.

Post Processing Actions Configures actions to be performed at the end of the
output processing.

Prepend Adds data to the beginning of the document. The data
can be a set of bytes, a string, a text resource, a binary
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Action type Description

resource, an Nuance Output Manager job Ticket, or a
banner resource.

Print Preferences Modifies the document properties or other attributes of
the document to align with what the target printer needs
for the specific document type.

Search/Replace Enables bytes or strings to be searched and then
replaced. The data being replaced can be a set of bytes,
a string, a text resource, a binary resource, or a banner
resource.

Transform Modify the document data before the document is routed
to the destination. The EPS, EPS Advanced, and EPS
Adv W/ Banners actions are used for converting LCDS
documents for use with a Xerox EPS controller. The
Advanced Document Modification action allows
repurposing of documents.

Append

Adds data to the end of the document. The data can be a set of bytes, a string, a text resource, a binary resource, or a
banner resource.

• Append banner — Add a banner resource to the end of a document.
• Append binary — Add a binary resource to the end of a document.
• Append bytes — Add bytes to the end of a document.
• Append string — Add a string to the end of a document.
• Append text — Add a text resource to the end of the document.

Code Page

Changes the encoding of a document from one code page to another.

• Code page translate — To change the encoding of the document from one code page to another.

DCO

Allows for record format changes.

• Record Mode Conversion — To change the record format of the document.

Hex Table

Allows single or multiple byte substitutions.

• Hex Table Allows single or multiple byte substitutions.

Package Management

Configures actions to define or manipulate package contents.

• Merge Package — To direct how an output process merges a package of documents.



Output Manager Administration Guide
Version 4.0 SP2

233 © 2016 Nuance Communications, Inc. All rights reserved.

Post Processing Actions

Configures actions to be performed at the end of the output processing.

• Call Method — To select a method from a DLL file to be called after the document has been transferred to its
destination. This is limited to calling only public methods or instantiating public objects from the DLL which have
no parameters or only basic parameters.

• Email — To send an email after the document has been transferred to its destination.
• Run command — To configure a script to run after the document has been sent to its destination.

Prepend

Adds data to the beginning of the document. The data can be a set of bytes, a string, a text resource, a binary resource,
an Nuance Output Manager job Ticket, or a banner resource.

• Prepend banner — Add a banner resource to the beginning of a document.
• Prepend binary — Add a binary resource to the beginning of the document.
• Prepend bytes — Add a byte resource to the beginning of the document.
• Prepend OM Ticket — Add an Nuance Output Manager ticket to the beginning of the document.
• Prepend string — Add a text string to the beginning of the document.
• Prepend text — Add a text resource to the beginning of the document.

Print Preferences

Modifies the document properties or other attributes of the document to align with what the target printer needs for
the specific document type.

• Apply print preferences — Modifies the document properties or other attributes of the document to align with
what the target printer needs for the specific document type.

• Set Document Properties — Set specific values in selected document properties.

Search/Replace

Enables bytes or strings to be searched and then replaced. The data being replaced can be a set of bytes, a string, a text
resource, a binary resource, or a banner resource.

• S/R binary — Search for and replace binary resources.
• S/R bytes — Search for and replace bytes.
• S/R bytes to banner — Search for bytes and replace with a banner resource.
• S/R bytes to binary — Search for a byte and replace with a binary resource.
• S/R bytes to string — Search for a byte and replace with a text string.
• S/R bytes to text — Search for a byte and replace with a text resource.
• S/R string to banner — Search for a text string and replace with a banner resource.
• S/R string to binary — Search for a text string and replace with a binary resource.
• S/R string to text — Search for a text string and replace with a text resource.
• S/R strings — Search for and replace text strings.
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Transform

Modify the document data before the document is routed to the destination. The EPS, EPS Advanced, and EPS Adv
W/ Banners actions are used for converting LCDS documents for use with a Xerox EPS controller. The Advanced
Document Modification action allows repurposing of documents.

• Adept Transform — Convert Xrx or Afp type documents to PCL5, PDF, or PS.
• Advanced Document Modification — Use the Advanced Document Modification (ADM) action to run the ADM

process.

ADM is a process where each page of the document is read, portions of the document can be changed, or values
extracted, and then the page is written. Documents can be reordered, split, transformed to a different data type, bar
codes added, OMR marks added, and logos changed using ADM.

• EPS — Convert LCDS documents for use with a Xerox EPS controller.
• EPS Adv W/Banners — Convert LCDS documents for use with a Xerox EPS controller and to add banners or

trailers to the output.
• EPS Advanced — Convert LCDS documents for use with a Xerox EPS controller.
• Make Copies of Document — Direct the output process to write the data stream multiple times while sending to

the destination.
• Page Range Via Transform — Use a transform to print a specific page range.
• Transform — Transform the format of the document to a new format or to another data type.
• Transform Office Files — Transform Microsoft Office documents to PDF documents.
• Transform W/Banners — Transform the format of the document to a new format or to another data type.
• Zip Document — Create a zip file from the document to be sent to the destination.

How to Open and Close the Process Designer
Use the methods in this procedure to open and close the Process Designer.

• Open the Process Designer
• Close the Process Designer

To open the Process Designer
You can display the Process Designer using one of the following methods:

• On the Output Manager Console menu bar, click Tools > Process Designer .
• Create a business rule action to set output processes.
• Click New or Edit in the Manage Output Process Profiles dialog box.

You can access the Manage Output Process Profiles dialog box from the More settings tab during destination
configuration, the Output settings tab during source configuration, or when configuring a business rule to set
output processes.

To close the Process Designer

• On the menu bar, click File > Exit.

How to Create an Output Process
Complete this procedure to create an output process.

1. Open the Process Designer.
For more information, see Open and Close the Process Designer

2. In the Actions pane, select an action to use in your output process.
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3. Drag the action to the line linking two actions in the Process panel.
Because the placement and order of actions is important, the Process Editor enforces where actions can be
dropped in landing zones. For more information about zone order and exceptions to the order, see Landing zones.

Tip:  You can remove actions from an output process by selecting the action in the Process panel and
pressing the Delete key. When an action is selected, a green box will display around the action.

4. In the Action Configuration panel, configure the action selected in the Process Editor.
5. Repeat steps 2 on page 234 through 4 on page 235 to add all the actions that are required in an output

process.
6. When complete, in the menu bar, click File > Save.
7. Enter a Process Name and Description.
8. Click Save.
9. To open an output process, select File > Open from the Process Designer.

How to Configure Actions

You configure output process actions in the Process Designer Action Configuration pane. The panel is divided into
the following sections:

• Action Parameters — These parameters are specific to the action that you are configuring. The procedures in this
topic contain more information on action parameters.

• If Action Encounters Error — This parameter is common to all actions. The Workflow error setting specifies
how the process responds to a workflow error. Select Stop to stop the process and send an error to the destination.
Select Skip to skip the action and continue processing the next action.

• Action Executes For The Following — This parameter is common to all actions. The parameter determines if the
action is executed or not according to:

• Printer families — Use the check boxes to determine if the selected action is executed for all printer families
or only for certain printer families. This allows you to set up processes that include actions that only apply to
some destinations.

• Document data types — Use the check boxes to determine if the selected action is executed for all data types
or only for certain data types. This allows you to set up processes that include actions that only apply to some
documents.

• Job Level — This parameter specifies how the action is applied to multi-document packages. Select
Document to perform the action on all documents in the package. Select Package to perform the action on
only the first or last documents of the package.

Job level is only applicable to certain actions. It is useful for example to apply banners and trailers to only the first
and last document of a multi-document package, or to execute an append or prepend action only if it is the first
or last document of a package (or alternately every document in the package). The following actions include this
parameter:

• All Prepend actions except Prepend OM Ticket
• All Append actions
• EPS Adv W/Banners
• Transform W/Banners

Parameter editor notes:
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• Resource selection — When the parameter being configured is the specification of a resource, you can use a
document property (which is expected to hold a resource name) to specify the resource. Select the existing text in
the cell, right-click, and select the document property from the context menu.

• String entries — When the parameter being configured is a string (which defaults to “Enter String”), you can use
a document property (which is expected to hold the desired string) or a function to derive the desired string. Select
the existing text in the cell, right-click, and select the desired document property or function from the context
menu. See Using Output Manager functions for more information on functions.

The steps necessary to configure actions vary depending on the action type. Perform the steps in the appropriate
section to configure output process actions.

• Append or prepend banner
• Append or prepend binary
• Append or prepend bytes
• Append or prepend string
• Append or prepend text
• Prepend OM Ticket — There are no action-specific parameters to configure for this action.
• Code Page - Code page translate
• DCO – Record Mode Conversion
• Hex Table
• Package Management - Merge Package
• Post Processing Actions – Call Method
• Post Processing Actions – Run command
• Post Processing Actions – Email
• Print Preferences
• Search/replace Actions
• Transform Actions

Append or prepend banner
Use the append banner action to add a banner resource to the end of a document. Use the prepend banner action to
add a banner resource before the document.

1. Drag the Append banner or Prepend banner action to the line that connects Start and End in the Process pane.
2. In the Action Configuration pane, configure the following action parameters:

• Banner — Select an existing banner resource or click the browse button (...) to create or manage banner
resources. You can also use a document property as described in the parameter editor note on resource
selection.

See the Configuring a banner resource topic for instructions on creating a banner resource from the Banner
Resource dialog box.

• Code page in — Select the input code page.
• Code page out — Select the output code page.

Append or prepend binary
Use the append binary action to add a binary resource to the end of a document. Use the prepend binary action to add
a binary resource before the document.

1. Drag the Append binary or Prepend binary action to the line that connects Start and End in the Process pane.
2. In the Action Configuration pane, configure the following action parameter:
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• Binary — Select an existing binary resource or click the browse button (...) to create or manage binary
resources. You can also use a document property as described in the parameter editor note on resource
selection.

See the Configuring a binary resource topic for instructions on creating a binary resource from the Binary
Resource dialog box.

Append or prepend bytes
Use the append bytes action to add bytes to the end of a document. Use the prepend bytes action to add bytes before
the document.

1. Drag the Append bytes or Prepend bytes action to the line that connects Start and End in the Process pane.
2. In the Action Configuration pane, click the Bytes browse button (...).
3. In the Hex entry dialog box, enter the necessary value in hexadecimal format.

Append or prepend string
Use the append string action to add a string to the end of a document. Use the prepend string action to add a string
before the document.

1. Drag the Append string or Prepend string action to the line that connects Start and End in the Process pane.
2. In the Action Configuration pane, configure the following action parameters:

• Append string or String — Enter the string that you want to add to the end of the document or the string that
you want to add before the document. You can also use a document property or function as described in the
parameter editor notes on resource selection and string entries.

• Code page out — Select the output code page.

Append or prepend text
Use the append text action to add a text resource to the end of a document. Use the prepend text action to add a text
resource before the document.

1. Drag the Append text or Prepend text action to the line that connects Start and End in the Process pane.
2. In the Action Configuration pane, configure the following action parameters:

• Text — Select an existing text resource or click the browse button (...) to create or manage text resources. You
can also use a document property as described in the parameter editor note on resource selection.

See the Configuring a text resource topic for instructions on creating a text resource from the Text Resource
dialog box.

• Code page in — Select the input code page.
• Code page out — Select the output code page.

Code Page – Code page translate
Use the code page translate action to change the encoding of a document from one code page to another code page.

1. Drag the Code page translate action to the line that connects Start and End in the Process pane.
2. In the Action Configuration pane, configure the following action parameters:

• Code page in — Select the code page that represents how the input document is encoded.
• Code page out — Select the code page that represents how the output document is encoded.
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DCO – Record Mode Conversion
Use the Record Mode Conversion action to change the record format of a document.

1. Drag the Record Mode Conversion action to the line that connects Start and End in the Process pane.
2. In the Action Configuration pane, click the Record Mode Conversion action parameter browse button (…).
3. In the Transform Record Mode (Advanced) dialog box, configure the transform parameters as described in

Transform Record Mode (Advanced) dialog box on page 687.

Hex Table
Use the Hex Table action to allow single or multiple byte substitutions.

1. Drag the HexTable action to the line that connects Start and End in the Process pane.
2. In the Action Configuration pane, click the HexTable action parameter browse button (...).
3. In the Hex Table dialog box, select the bytes in the grid to be substituted and enter the substitute bytes in the Hex

Value column.

Package Management - Merge Package
Use the Package Management - Merge Package action to direct how an output process merges a package of
documents.

1. Drag the Merge Package action to the line that connects Start and End in the Process pane.
2. In the Action Configuration pane, click the Configure action parameter browse button (...).
3. In the Merge Package dialog box, configure merge settings:

a) Next to Transform, click Configure. In the Configure Transform dialog box, specify the merged document
output type and specify how to transform available input document types.

b) If necessary, select Package boundaries and click Configure to open the Package Boundary Fields dialog
box to specify which document properties define where to split packages.

In the grid, expand the sections to select the document properties to be used as package boundaries.

Note:  Boundary fields are only applicable when a merged document exceeds the maximum number
of exceptions (currently set at 1000). Merged documents that exceed the exception count are split into
separate documents. Boundary fields are used to control where the merged documents are split. Each
split is on a boundary that maximizes the number of pages without exceeding the exception threshold.
If you do not specify boundary fields, the split is arbitrary and occurs where the maximum number of
pages can be fit.

c) If package boundaries are enabled, select the On demand boundary field resolver rule if necessary.

Note:  The On demand boundary field resolver rule is an advanced option. The control is a combo
box that is populated with Ad Hoc Business Rules that have been configured in Output Manager. The
selected ad hoc rule is configured to populate the chosen boundary fields that would otherwise not be
populated with meaningful data. The resolver rule is used at the time the merge operation is at a split
(when the exception threshold is reached) and provides useful data in the boundary fields so the split
can be calculated.

d) In the Merged Document Properties group, select which document whose properties are inherited by the
merged document.
Selecting custom properties is not yet available.

e) If necessary, select Exception fields and click Configure to open the Exception Fields dialog box to specify
document properties that are exceptions.
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In the Exception Fields dialog box, expand the sections to select the document properties that are exception
fields. Exceptions are another means of directing package splits based on an accumulation of specified
property values encountered.

f) Select the Add blank pages for duplexing check box to assure front page alignment for duplex printing.
This causes documents to start on an odd page number.

g) If necessary, select Write a manifest file.

Post Processing Actions – Call Method
Use the Call Method action to select a method from a .dll file to be called after the document has been transferred to
its destination. This is limited to calling only public methods or instantiating public objects from the .dll file which
have only basic parameter types.

1. Drag the Call Method action to the line that connects Start and End in the Process pane.
2. In the Action Configuration pane, click the Call method action parameter browse button (...).
3. In the Configure Method Call dialog box, configure method call settings:

a) Click Choose assembly.
b) Navigate to the .dll file that contains the public method (or object to instantiate that has the method).
c) In the Type list, select the object type on which to make the call.
d) In the Constructor list, select the constructor method you want to use to instantiate the object.

The constructor must have either no parameters or only parameters of basic types (string, boolean, and numeric
– Int16, Int32, or Int64).

e) If the selected constructor has parameters to be defined, specify them in the Constructor Parameters grid.
You can also right-click to select document properties or functions in the parameter values.

f) In the Method list, select the method to be called.
The method must have either no parameters or only parameters of basic types (string, boolean, and numeric –
Int16, Int32, or Int64).

g) If the selected method has parameters to be defined, specify them in the Method Parameters grid.
You can also right-click to select document properties or functions in the parameter values.

Post Processing Actions - Run command
Use the Run Command action to configure a script to run after the document has been transferred to its destination.

1. Drag the Run command action to the line that connects Start and End in the Process pane.
2. In the Action Configuration pane, click the Command action parameter browse button (...). to open the Run

Command dialog box.
3. In the Run Command dialog box, enter the command line text.

To insert document properties in the command line, right-click in the text box and click Properties. Some
example document properties are date/time, document name, and data type.

Post Processing Actions - Email
Use the email action to send an email after the document has been transferred to its destination.

1. Drag the Email action to the line that connects Start and End in the Process pane.
2. In the Action Configuration pane, click the Email action parameter browse button (...), and configure the email

options
3. In the Send Email dialog box, configure email settings:

a) In the Profile list, click the appropriate email profile.
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You can also click the Browse button to display the Manage Outbound Email Profiles dialog box. This
dialog box lists all of the defined email profiles. From this dialog box you can create, import, and export
profiles, as well as manage existing profiles. To create a new email profile, click New and configure the email
profile from the Outbound Email Profile dialog box.

b) Select the Priority level of the email message.
You can select an importance level of normal, low, or high.

c) Enter the email addresses you want to be sent notifications in the To, CC, and Bcc boxes.

You can enter multiple email addresses separated by a comma or semicolon.
d) In the Reply to box, enter an email address where replies are routed.

You can enter multiple email addresses separated by a comma or semicolon.
e) Enter the email Subject text.
f) Under Digest, determine if you want to send the notification messages for multiple events concatenated into

one email. To enable the digest feature, in the Send Digest list, choose from the following options:

• Every interval — Sends the digest according to the time interval specified. You receive a message every
interval, even if no alerts were received during the interval.

• At time interval — Sends the digest according to the time interval specified. The time interval will start
when the first notification message is received. You are notified when at least one notification has been
received.

• Every hour — Sends the digest every hour. You receive a message every interval, even if no alerts were
received during the interval.

• Every half hour — Sends the digest every half hour. You receive a message every interval, even if no
alerts were received during the interval.

If necessary, specify the Interval in minutes. In the Max Alerts box, you can specify the maximum number of
alerts to be included in the digest.

g) Enter the body text.
To insert document properties in the body text, right-click in the text box, select Insert Document Property,
and choose the appropriate properties. The values of the properties will display in the email message.

h) Click Validate to validate the body text.
i) Click OK.

Print Preferences
Use Print Preference actions to modify the document properties or other attributes of the document.

• Apply print preferences
• Set Document Properties

Apply print preferences
Use the Apply print preference action to modify the document properties or other attributes of the document to align
with what the target printer needs for the specific document type.

1. Drag the Apply print preferences action to the line that connects Start and End in the Process pane.
2. In the Action Configuration pane, configure the following action parameters:

• Use Existing Ticket — Select Yes or No to specify if you want to use the existing job ticket.
• Allow Unresolved Print Preferences — Select Yes or No.

Unresolved print preferences are ones which have been configured for the document, but the target printer
family does not support the preference or the configured value is not supported. For example, the document
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property Output Bin is configured for Tray 5, and the target printer family does not support Tray 5. Output Bin
is an unresolved print preference.

Warning:  If you set this option to No, and one or more unresolved print preference exists with the
target printer family, the document does not print.

• Convert PDF to PCL — Select Auto, Yes, or No.
• Convert PDF to PS — Select Auto, Yes, or No.

The following rules apply to the Convert PDF options:

• No conversion happens if the data type is not PDF when this action is executed.
• These options are only enabled if the system is properly licensed and applicable conversion software is

installed and available.
• The Auto option only converts if the printer and printer family do not support PDF.
• If both Convert PDF to PCL and Convert PDF to PS are set to Yes or Auto, and the criteria is met for

both to convert, the resulting data type is PCL.

Set Document Properties
Use the Set Document Properties action to modify select properties of the document before it is sent to the printer.

1. Drag the Set Document Properties action to the line that connects Start and End in the Process pane.
2. In the Action Configuration pane, click the Document properties browse button (...).

In the Document Properties dialog box, the grid lists the property values that you can configure. The values are
grouped in the following categories:

• Basic options
• Media selection
• Document
• Image adjustments
• Finishing
• Other properties

3. Expand the category of the property you want to configure. The first node level in the category determines the
print preferences for the properties it contains. In the Mode column, select how the property should be applied
when a document is sent to a destination. You can choose from the following options:

Option Description

Always Apply Always applies the specified property value. Nuance
Output Manager adds commands to the print stream to
enforce the print preference. If the document already
contains commands for that print preference, Nuance
Output Manager modifies the commands to work with
the printer family where the document is sent.

Apply Conditionally Applies the property value conditionally. Nuance
Output Manager only adds or modifies commands
for the print preference when the printer family for
the document destination is different from the printer
family the document was originally designed for.

Informational Only Nuance Output Manager makes no changes to the print
stream when the document is sent to the destination.
The value is for informational purposes only.
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4. In the Value column, specify the document property value. You can use functions to insert and extract data as
necessary.

Search/Replace Actions
Use the search/replace action to allow bytes and strings to be searched and then replaced. The replacement item can
be a set of bytes, a string, a text resource, a binary resource, or a banner.

• Search/Replace binary
• Search/Replace bytes
• Search/Replace bytes to banner
• Search/Replace bytes to binary
• Search/Replace bytes to string
• Search/Replace bytes to text
• Search/Replace string to banner
• Search/Replace string to binary
• Search/Replace string to text
• Search/Replace strings

Search/Replace binary
Use the S/R binary action to search for and replace binary resources.

1. Drag the S/R binary action to the line that connects Start and End in the Process pane.
2. In the Action Configuration pane, configure the following action parameters:

• Search binary — Select an existing binary resource you want to search for or click the browse button (...) to
create or manage binary resources. You can also use a document property as described in the parameter editor
note on resource selection.

See the Configuring a binary resource topic for instructions on creating a binary resource from the Binary
Resource dialog box.

• Replace binary — Select an existing binary resource to use for replacement or click the browse button (...) to
create or manage binary resources. You can also use a document property as described in the parameter editor
note on resource selection.

Search/Replace bytes
Use the S/R bytes action to search for and replace bytes.

1. Drag the S/R bytes action to the line that connects Start and End in the Process pane.
2. In the Action Configuration pane, configure the following action parameters:

• Search — Click the browse button (...) and specify the hex value to search for.
• Replace — Click the browse button (...) and specify the hex value to use as the replacement.

Search/Replace bytes to banner
Use the S/R bytes to banner action to search for bytes and replace with a banner.

1. Drag the S/R bytes to banner action to the line that connects Start and End in the Process pane.
2. In the Action Configuration pane, configure the following action parameters:

• Search — Click the browse button (...) and specify the hex value to search for.
• Replace Banner — Select an existing banner resource to use for replacement or click the browse button (...) to

create or manage banner resources. You can also use a document property as described in the parameter editor
note on resource selection.
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• Replace code page in — Select an input code page to replace the current input code page.
• Replace code page out — Select an output code page to replace the current output code page.

Search/Replace bytes to binary
Use the S/R bytes to binary action to search for bytes and replace with a binary resource.

1. Drag the S/R bytes to file action to the line that connects Start and End in the Process pane.
2. In the Action Configuration pane, configure the following action parameters:

• Search — Click the browse button (...) and specify the hex value to search for.
• Replace binary — Select an existing binary resource to use for replacement or click the browse button (...) to

create or manage binary resources. You can also use a document property as described in the parameter editor
note on resource selection.

Search/Replace bytes to string
Use the S/R bytes to string action to search for bytes and replace with a string.

1. Drag the S/R bytes to string action to the line that connects Start and End in the Process pane.
2. In the Action Configuration pane, configure the following action parameters:

• Search — Click the browse button (...) and specify the hex value to search for.
• Replace String — Enter the replacement string. You can also use a document property or function as

described in the parameter editor notes on resource selection and string entries.
• Replace code page out — Select an output code page to replace the current output code page.

Search/Replace bytes to text
Use the S/R bytes to text action to search for bytes and replace with a text resource.

1. Drag the S/R bytes to text action to the line that connects Start and End in the Process pane.
2. In the Action Configuration pane, configure the following action parameters:

• Search — Click the browse button (...) and specify the hex value to search for.
• Replace Text — Select an existing text resource to use for replacement or click the browse button (...) to create

or manage text resources. You can also use a document property or function as described in the parameter
editor notes on resource selection and string entries.

• Replace code page in — Select an input code page to replace the current input code page.
• Replace code page out — Select an output code page to replace the current output code page.

Search/Replace string to banner
Use the S/R string to banner action to search for a string of data and replace it with a banner resource.

1. Drag the S/R string to banner action to the line that connects Start and End in the Process pane.
2. In the Action Configuration pane, configure the following action parameters:

• Search string — Enter the string that you want to search for. You can also use a document property or function
as described in the parameter editor notes on resource selection and string entries.

• Search code page out — Select the output code page to use in the search.
• Replace Banner — Select an existing banner resource to use for replacement or click the browse button (...) to

create or manage banner resources. You can also use a document property as described in the parameter editor
note on resource selection.

• Replace code page in — Select an input code page to replace the current input code page.
• Replace code page out — Select an output code page to replace the current output code page.
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Search/Replace string to binary
Use the S/R string to binary action to search for a string of data and replace it with a binary resource.

1. Drag the S/R string to binary action to the line that connects Start and End in the Process pane.
2. In the Action Configuration pane, configure the following action parameters:

• Search string — Enter the string that you want to search for. You can also use a document property or function
as described in the parameter editor notes on resource selection and string entries.

• Search code page out — Select the output code page to use in the search.
• Replace binary — Select an existing binary resource to use for replacement or click the browse button (...) to

create or manage binary resources. You can also use a document property as described in the parameter editor
note on resource selection.

Search/Replace string to text
Use the S/R string to text action to search for a string and replace it with a text resource.

1. Drag the S/R string to text action to the line that connects Start and End in the Process pane.
2. In the Action Configuration pane, configure the following action parameters:

• Search string — Enter the string that you want to search for. You can also use a document property or function
as described in the parameter editor notes on resource selection and string entries.

• Search code page out — Select the output code page to use in the search.
• Replace text — Select an existing text resource to use for replacement or click the browse button (...) to create

or manage text resources. You can also use a document property as described in the parameter editor note on
resource selection.

• Replace code page in — Select an input code page to replace the current input code page.
• Replace code page out — Select an output code page to replace the current output code page.

Search/Replace strings
Use the S/R strings action to search for and replace strings of data.

1. Drag the S/R strings action to the line that connects Start and End in the Process pane.
2. In the Action Configuration pane, configure the following action parameters:

• Search string — Enter the string that you want to search for. You can also use a document property or function
as described in the parameter editor notes on resource selection and string entries.

• Replace string — Enter the string you want to use for replacement. You can also use a document property or
function as described in the parameter editor notes on resource selection and string entries.

• Search code page out — Select the output code page to use in the search.
• Replace code page out — Select an output code page to use for the replacement.

Transform Actions
Use the transform actions to modify document data before the document is transferred to the destination. For
example, the EPS, EPS Advanced, and EPS Adv W/Banners actions are used for converting LCDS documents for
use with a Xerox EPS controller. The Advanced Document Modification action allows for the repurposing of the
documents.

• Adept Transform
• Advanced Document Modification
• EPS
• EPS Adv W/ Banners
• EPS Advanced
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• Make copies of document
• Page Range Via Transform
• Transform
• Transform Office Files
• Transform W/ Banners
• User Information Stamping
• Watermarking
• Zip Document

Adept Transform
Use the Adept Transform action to convert  Xrx or Afp type documents to PCL5, PDF, or PS type.

1. Drag the Adept Transform action to the line that connects Start and End in the Process pane.
2. In the Action Configuration pane, click the Transform action parameter browse button (...).
3. In the Transform Adept dialog box, perform the following steps:

a) Set the Xrx and/or Afp check boxes to specify what types of document will be converted.
b) In the to list, select the target document type.
c) In the Ini list, select an existing Ini resource to use for initializing the transform or click the browse button

(…) to create or manage the Ini resources. You can also use a document property as described in the parameter
editor note on resource selection.

d) Use the Ini description drop-down list box to add a description for the transform action.
e) In the Ini default list, select an existing Ini resource to use as a default initialization if there is not an available

Ini resource that matches the evaluated document property or function specified previously.
Otherwise, click the browse button (...) to create or manage the Ini resources.

f) Fill in the EXE path or click the browse button (...) to browse for the executable (.exe) file that performs the
transform.

Advanced Document Modification
Use the Advanced Document Modification (ADM) action to run the ADM process.

ADM is a process where each page of the document is read, portions of the document can be changed, or values
extracted, and then the page is written. Documents can be reordered, split, transformed to a different data type, bar
codes added, OMR marks added, and logos changed using ADM.

1. Drag the Advanced Document Modification action to the line that connects Start and End in the Process pane.
2. In the Action Configuration pane, click the Advanced Document Modification browse button (...).
3. In the Server list on the Configuration tab of the Modify Document dialog box, click the licensed transform

server that you would like to use.
4. In the Transform package list, you can select an existing transform package or create one for ADM.
5. In the Additional Parameters box, specify additional parameters needed for the transform software.
6. Use the Override input filter profile assigned to document check box to determine whether to override the

input filter profile assigned to the document or to use the filter profile configured in the transform package. Select
the check box to use the filter profile in the transform package.

7. In the Unit library list, you can select an existing unit library or create one. Complete the following steps to create
a unit library:
a) Enter the unit library Name, Description, and any Comments.
b) In the Document Properties Needed list, select the document properties needed by the unit library.
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These properties are written to a file called  filename.properties when Nuance Output Manager calls
the document modification software. This file can be opened and read in by the unit library.

c) In the Filters Needed list, select the filters needed for the unit library.
These filters are written to a temporary location which will be sent to the document modification software.

d) Under Unit, specify the unit library.
Enter the unit library code within the <script> </script> tags in the appropriate event handler sections.

Tip:  Review the default comments of a new unit library for descriptions of the parameters sent from
Nuance Output Manager to the unit library and information about how to tell Nuance Output Manager
about the documents modified or created by the unit library.

e) If necessary, click Reload Variables from Unit to populate the Output variables grid with any output
variables defined in the unit library.

Unit libraries are JavaScript modules that CpMill calls at certain known times while processing a document (for
example, begin document, page start, and page end). The modules can modify the contents of the document,
extract information from the document, write the document, or parts of it, to a new location, or perform
many other operations. For more information on configuring unit libraries, contact Nuance Communications
Professional Services.

8. For Output format, select the target output format for the document.

EPS
Use the EPS action to convert LCDS documents for use with an Xerox EPS controller.

1. Drag the EPS action to the line that connects Start and End in the Process pane.
2. In the Action Configuration pane, configure the Queue name by entering the queue name on the EPS device.

You can also use a document property or function as described in the parameter editor notes on resource selection
and string entries.

EPS Adv W/ Banners
Use the EPS Adv W/ Banners action to convert LCDS documents for use with a Xerox EPS controller and to add
banners or trailers to the output.

• To configure this action, refer to the EPS advanced action below. All configuration parameters for this action are
identical to the EPS Advanced settings with the exception of the following additional parameters:
a) Banner — Select an existing banner resource to use for the banner to appear before the document or click

on the browse button (...) to create or manage banner resources. You can also use a document property as
described in the parameter editor note on resource selection.

b) Trailer — Select an existing banner resource to use for the trailer to appear after the document or click on the
browse button (...) to create or manage banner resources. You can also use a document property as described in
the parameter editor note on resource selection.

EPS Advanced
Use the EPS Advanced action to convert LCDS documents for use with a Xerox EPS controller.

1. Drag the EPS Advanced action to the line that connects Start and End in the Process pane.
2. In the Action Configuration pane, configure the following action parameters:

• Job name — Enter the name of the job going to the EPS device. You can also use a document property or
function as described in the parameter editor notes on resource selection and string entries.

• Host name — Enter the host name sending the job to the EPS device. You can also use a document property or
function as described in the parameter editor notes on resource selection and string entries.
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• User name — Enter the name of the user submitting the job. You can also use a document property or function
as described in the parameter editor notes on resource selection and string entries.

• Queue name — Enter the queue name on the EPS device. You can also use a document property or function as
described in the parameter editor notes on resource selection and string entries.

• Code page in — Select the code page that represents how the input document is encoded.
• FCB — Select the FCB resource that controls the vertical format of printed output or click on the browse

button (…) to create or manage FCB resources. You can also use a document property as described in the
parameter editor note on resource selection.

• FCB Override — Enable or disable overriding FCBs.

Selecting Yes causes FCBs in the beginning of the data to be ignored, functioning as if there were no FCBs in
the data.

• Send FCB — Enable or disable sending FCBs to the printer.
• Delimiter — Select None, ASCII, or EBCDIC to be added to each record.
• Length — Specify the record length.
• Pad Record — Enable or disable pad record.
• Pad Skip to channel one — Enable or disable pad skip to channel 1.

Selecting Yes pads blank skip to channel 1 records with a space. Selecting Consecutive pads any blank skip
to channel 1 record following a blank skip to channel 1 record. The first skip to channel 1 remains blank or
unpadded.

• Truncate Trailing Blanks — Enable or disable the truncating of trailing blanks.

Make Copies of Document
Use the Make Copies of Document action to direct the output process to write the data stream multiple times while
sending to the destination.

Note:  Only the data contents are written multiple times, not the header nor any other information.

1. Drag the Make Copies of Document action to the line that connects Start and End in the Process pane.
2. In the Action Configuration pane, configure the Copy count with one of the following settings:

• Leave the default [Copies_Copies] value to let the copy count document property control the copy count.
• Enter a numeric value to override the document property.

Page Range Via Transform
Use the Page Range Via Transform action to print a specific page range. This action may require third-party transform
package software and a license.

1. Drag the Page Range Via Transform action to the line that connects Start and End in the Process pane.
2. In the Action Configuration pane, click the Configure ellipse button (…).
3. In the Page Range Via Transform dialog box, enter additional global, input, or output commands to be used in

transform package command string.

Transform
Use the Transform action to transform the format of a printer-ready document to a new format or to another data type.

1. Drag the Transform action to the line that connects Start and End in the Process pane.
2. Click the Transform browse button (...) to open the Configure Transform dialog box.
3. In the Server list, click the licensed transform server that you want to use.
4. In the Transform package list, you can select an existing transform package or create one.
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5. Use the Override input filter profile assigned to document check box option to determine whether to override
the input filter profile assigned to the document or to use the filter profile configured in the transform package.
Select the check box to use the filter profile in the transform package.

6. In the Output format list, click the format of the output file.
7. Configure the conversion of each input format in the Input formats grid.

• For all unlicensed input formats and any input formats you do not want to use, leave the Configuration
column with the default setting of Do Not Transform.

• For licensed input formats, you can select Use Default Options or select a predefined configuration in the
Configuration column. To configure a custom input format, click the browse button (...) in the Modify/
New column. If Use Default Options or Do Not Transform is selected in the Configuration column, a new
configuration is created. If a predefined configuration is selected, that configuration is modified. The custom
transform options are configured on the Input options tab, Output options tab, and Page Layout tab.

Transform Office Files
Use the Transform Office Files action to convert Microsoft Office files to PDF documents.

1. Drag the Transform Office Files action to the line that connects Start and End in the Process pane.
2. In the Action Configuration pane, configure the following action parameters:

• Office file formats — Click the ellipsis button (…) to select which office formats to convert with this action.
By default, all formats are selected.

• Use Microsoft API if available — By default, Nuance Output Manager uses a collection of third-party
components to perform the conversions. In earlier versions of the Word component, certain complex .rtf files
were not accurately converted to PDF. An alternate method of converting Microsoft Word files was added
using the Microsoft API (if Microsoft Word 2013 is installed on the server). The causes of the inaccuracies
have been corrected in later versions of those third-party components.

Transform W/ Banners
Use the Transform W/Banners action to transform the format of a printer-ready document to a new format or to
another data type and also use banners and trailers.

To configure the Transform W/ Banners action, refer to the Transform action configuration above. All action
configuration parameters for this action are identical to the Transform parameters with the following added
parameters:
1. Drag the Transform W/Banners action to the line that connects Start and End in the Process pane.
2. In the Action Configuration pane, configure the Transform action parameter as described in Transform on page

247 above.
3. For the Banner parameter, select an existing banner resource to use for the banner to appear before the document

or click on the browse button (...) to create or manage banner resources. You can also use a document property as
described in the parameter editor note on resource selection.

4. For the Trailer parameter, select an existing banner resource to use for the trailer to appear after the document or
click on the browse button (...) to create or manage banner resources. You can also use a document property as
described in the parameter editor note on resource selection.

5. For the Orientation parameter, select Portrait or Landscape.
6. For the Text Profile parameter, select an existing text resource to use while creating the banner and trailer text

files or click on the browse button (…) to create or manage text resources. You can also use a document property
as described in the parameter editor note on resource selection.
This text profile needs to be specifically tailored to one of two different media sizes (Letter or A4). To create the
text profile complete the following steps:
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a) Click on the browse button (...) to open the Manage Resources dialog box.
b) In the grid, select the Default – TXT profile and click Edit.
c) Right-click in the Filter Profile edit area, click Select All, then copy the selection.
d) Close the Configure Filter Profile dialog box.
e) In the Manage Resources dialog box, click New.
f) Right-click in the Filter Profile edit area and click Paste.
g) In the Datatype list, select TXT.
h) Enter an appropriate Name (for example Letter size Banner, or A4 size Banner) and Description for the

profile.
i) Under Filter Profile, modify the text as follows:

• Paste the following text inside the <fontlist></fontlist> tags:

For letter size:

<font family="courier new" serifstyle="serif" spacing="monospaced">
     <face weight="medium" width="normal" style="upright" devname="co
urier" fontfile="cour" fontfiletype="truetype" size="8" id="1" pitch=
"17500" />
</font>
                              

For A4 size:

Replace 17500 with 18000 in the preceding text.
• Find any <pagedefinition></pagedefinition> tags and replace all with the following single

one:

For Letter size:

<pagedefinition name="Letter"><papersize format="Letter" orientation=
"portrait" /> 
     <margins left="1 cm" right="1 cm" top="1 cm" bottom="1 cm" />
     <linesperinch value="7" /><linesperpage value="0" />
</pagedefinition> 
                                  

For A4 size:

Replace all instances of “Letter” with “A4”
• At the bottom, remove the comment marks (<!--  and -->) from the line that contains (path="c:\WIN

DOWS\Fonts") as shown below:

<resourcelist>
     ...
<files path="c:\WINDOWS\Fonts" type="TrueType" extension="ttf"/> <!--
 <files path="c:\WINNT\Fonts" type="TrueType" extension="ttf"/> --> <
!-- <files path="c:\fonts" type="TrueType" extension="ttf"/> -->
</resourcelist>                                  
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Tip:  You can use Ctrl+F functionality within the editor to find content.

User Information Stamping
Use the User Information Stamping action to to add user information and a date to documents.

1. Drag the User Information Stamping action to the line that connects Start and End in the Process pane.
2. In the Action Configuration pane, click the User Information Stamping action parameter browse button (...).
3. In the Server list, click the licensed transform server that you want to use.
4. In the Transform package list, you can select an existing transform package or create one.
5. In the Additional Parameters field, specify additional parameters needed for the transform.
6. In the Text to stamp field, do one of the following:

• Type the text to appear on the document.
• Right-click in the field and select Insert Other Property > Other Properties. Select a property from the

document.

You can use PCL, PDF, PS, and Plain Text files. Documents in other formats must be transformed into one of the
supported formats before this feature will work properly.

7. Configure the format and location of the text.
8. Click OK.

Watermarking
Use the watermarking action to add a watermark to indicate the status or security level of a document.

1. Drag the Watermarking action to the line that connects Start and End in the Process pane.
2. In the Action Configuration pane, click the Watermarking action parameter browse button (...).
3. In the Server list, click the licensed transform server that you want to use.
4. In the Transform package list, you can select an existing transform package or create one.
5. You can use an existing watermark or create a new one. Do one of the following:

• In the Watermark/Stamp list, select one of the existing watermarks: Confidential, Do Not Copy, Draft, or
Internal.

• Click New. In the Create Resource dialog box, complete the fields for the new watermark. In the Import
Resource Data section, click Browse and select the file you want to use as a watermark.

You can use PCL, PDF, and PS files. Documents in other formats must be transformed into one of the supported
formats before this feature will work properly.

6. Click OK.

Zip Document
Use the Zip Document action to create a zip file from the document being sent to the destination.

1. Drag the Zip Document action to the line that connects Start and End in the Process pane.
2. In the Action Configuration pane, click the Configure ellipsis button (…).
3. In the Zip Document dialog box dialog box, enter the desired Compression level and an optional password to

access the resulting zip file.
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To create a transform package
Use these steps to create a new transform package, when applicable to new transform actions, instead of using an
existing one.

1. In the Transform Package section, click New.
2. Enter the transform package Name.
3. Select the transform package type.
4. If you selected a third-party transform package, verify the EXE path is set to the correct folder.

The default EXE path is @EOMTransformDir. To change the path, type in the box or click the browse button (...).
5. Set the Logging State.

The logging state determines if transform logs and temp files are saved in the document folder. By default, the
Logging State is set to Yes. All log files should be inspected during installation and pre-production testing to
verify that fonts are correctly mapped. In a production system, the logging can be disabled to save disk space.
If the transform operation returns an error (return code not zero), the log and temp files are not deleted and are
available for troubleshooting.

6. On the Filter Profiles tab, specify how the transform software handles the formatting for each data type.
7. To configure a profile, click the browse button (...) in the Modify/New column for the appropriate formats. From

the Configure Filter Profile dialog box, configure the profile.
The profile affects fonts, resources, and other document transform and formatting attributes. For the IPDS data
type, the profile also contains a communications and printer definition section.

8. To select a profile, click in the Configuration column for the appropriate formats and select the profile from the
list.

9. On the Resources tab, specify where the transform software finds the resources needed for the transformation.
For example, PDF fonts are usually found at the location of an Adobe installation.

10. On the Fonts tab, you can control the font mapping of input fonts to output fonts.
The defaults are typically correct, but may need to be adjusted for special cases. You can add or modify fonts
directly in the grid.

How to Open an Output Process
Complete this procedure to open an output process.

1. Open the Process Designer.
2. In the menu bar, click File > Open.

This opens the Open Process dialog box.
3. Select the process you want to open and click OK.

How to Rename an Output Process
Complete this procedure to rename an output process.

1. Open the Process Designer.
2. On the menu bar, click File > Rename Process.

This opens the Rename Process dialog box.
3. Select the process you want to rename.
4. In the Name box, enter the new name.

You can also change the Description.
5. Click OK.
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How to Delete an Output Process
Complete this procedure to delete an output process.

1. Open the Process Designer.
2. On the menu bar, click File > Delete.

This opens the Delete Process dialog box.
3. Select the process you want to delete.
4. Click OK.

How to Print an Output Process
Complete this procedure to print an output process.

Tip:  Before you print the output process, you can click the File > Print Preview on the menu bar to view
how the process will print.

1. Open the Process Designer.
2. In the menu bar, click File > Print.

This opens the Print dialog box.
3. In the Name list, select the printer you want to print the document.
4. If necessary, under Print range, select the pages you would like to print.
5. Click OK.

How to Search for an Output Process
You can search for output processes from the Process Designer.

1. Open the Process Designer.
2. In the search box below the Actions tree, type the text you want to find and press Enter, or click the Search image.

Nuance Output Manager will start at the top of the tree and search for the text. Each time the text is found the
selected item will be highlighted in the tree.

3. If more than one search result is found, click the next and previous arrow buttons that appear in the search panel.

How to Zoom In or Out of the Process Editor
You can set the magnification level when working with Process Editor. The zoom feature enlarges or reduces the
display of your output process as a percentage of its actual size.

1. Open the Process Designer.
2. Open a new or existing output process.
3. On the menu bar, click View Zoom Canvas.

This opens Process Designer Zoom dialog box.
4. Click the arrow to adjust the magnification level.

You can click Reset to view the output process in its actual size.
5. Click Close.
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Cost Tracking and
Management

Print rules profiles
Rules based printing enforces printing restrictions.

Print rules run after the document has been received by Output Manager, but before business rules are processed.
Restrictions are applied using Print Rule Profiles that are associated with Windows Queue Sources or Users and
Departments.

There are basic and advanced modes for printing:

Basic This mode allows restriction of printing based on page
counts, color, and so forth. The desktop client can
be configured to inform the user of restrictions. The
basic mode also allows some control of picking Billing
Accounts.

Advanced This mode allows finer control over conditions,
and actions. Allows custom messages, re-routing of
jobs to different destinations, and the setting (and/or
enforcement) of document properties.

Each user is a member of a single department. Either Active Directory or the manual assignment of Groups to
Departments should be used to determine each user’s department.

Print rules profiles are defined for users in the Print Rules Profile column on the General tab in Administration >
Manage Users. Click the drop-down list button to select an existing profile or the browse button (...) to create or edit
print rule profiles.

How to Create a Print Rules Profile
To create a print profile, complete these steps.

1. From the grid, click the appropriate Print Rules Profile cell and then click the Browse button.
This opens the Manage User Print Rules Profiles dialog box.

2. Click New.
This opens the User Print Rules Profiles dialog box.

3. Enter a Profile name and Profile description.
4. To control the documents that are printed, select options under Restrictions - Disable Printing.

You can choose to always disallow printing, limit the maximum document page count or byte count to a specified
value, and prohibit the printing of color in a document. You can also choose to disregard any restrictions set for
Windows queues.

5. To define notification options, select one of the check boxes under Restriction Notification Options.
You can notify the user by email or with a pop-up window.
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6. To specify that the client pop-up window be displayed for the user, select Show client pop-up for this user. This
displays configuration options for the pop-up window.
a) Under Client pop-up general options, select the appropriate check box options.
b) To select and configure up to five billing lists to be displayed in the client pop-up window, use the grid under

Select up to five billing lists to be displayed on the client pop-up:

• Select the Active check box for the appropriate rows.
• Click the Caption column and enter the caption text.
• Click the Input Type column to select the input type.
• Click the Billing List column to select a billing list. Billing lists are configured with the Manage Billing

Accounts utility.
c) If you want to display this pop-up window instead of the pop-up window defined for a Windows queue, select

Select this pop-up instead of the pop-up (if any) configured for the Windows queue.
If you have configured a pop-up window for the Windows queue, it is displayed by default. If you select this
check box, this pop-up window will be displayed rather than that for the Windows queue.

7. To convert this profile to an advanced profile and manage the profile using rules, click Advanced. All selected
items will be converted into rules and displayed in the User Print Rules Manager dialog box. Once the profile
has been converted to an advanced profile, it cannot be returned to a basic profile. Complete the following steps to
create an advanced profile.
a) If any items were selected on the previous dialog box, they are now listed as rules on the User Print Rules

Manager dialog box. Click each rule and review it in the preview section.
b) The rules grid lists all of the defined rules in the order that they will be processed. The rules grid is editable.

Use the following procedures from the rules grid:

• To specify whether the rule is enabled or disabled, use the check box in the Enabled column.
• To rename a rule, click the Name cell and make the change.
• To modify the rule description, click the Description cell and make the change.
• To change the follow-on action, click the Follow-on Action cell and select the action that you would like

to take after this rule has been processed. You can continue processing rules or choose not to process any
additional rules.

c) Under the rules grid, use the following procedures to configure rules:

• To create a rule, click Add. The New User Print Rule dialog box is displayed. For instructions about
adding rules, see How to Create User Print Rules on page 254.

• To modify a rule, select a rule and click Modify.
• To delete a rule, select a rule and click Remove.
• To create a copy of a rule, select a rule and click Copy. A copy of the selected rule will be created.
• To reorder the rules, select a rule and click Move Up or Move Down.

d) To save your changes, click OK or Apply.
8. When you have completed your tasks, click Close.

How to Create User Print Rules
Complete this procedure to create user print rules.

Administrators can create user print rules after converting a basic print rules profile to an advanced print rules profile.
Conditions and actions are configured.

1. From the User Print Rules Manager dialog box, click Add.
2. Enter the Name and Description for the rule.
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3. Specify whether the rule will be enabled or disabled with the Enabled check box.
4. To always apply the rule, select the Always execute this rule (no conditions) check box.

If you select this check box, the When box is unavailable because no condition statements are needed. Continue
with step 6 on page 255.

5. If you do not want to always apply the rule, clear the check box and use the When box to create and manage the
rule conditions. Multiple conditions can be created and organized into groups. A blue box is used to indicate a
condition group. To create a rule condition, perform the following steps.
a) In the When box, click the <Target> link. Use the list to select the appropriate condition.
b) Click the Operation link and select the appropriate operation.
c) Click the Value link and select the appropriate value. The condition statement is completed.

d) To include additional condition statements or create groups of conditions:

• Click a condition (inside the box) to enable the Add Condition and Remove Condition buttons for adding
and removing condition statements.

• Select a group radio button (outside the box) to enable the Add Group and Remove Group buttons for
adding and removing groups of conditions. This step will also enable the Add Condition button for adding
a condition to the selected group.

6. Under the Perform the following actions box, use the following procedures to manage actions.

• To create an action, click the <Action> link. To create actions on page 255 provides more information on
configuring actions.

• To create additional actions, click Add Action.
• To modify an action, click the desired action link or click the area next to the link and click Modify Action.
• To delete an action, click the area next to the link and click Remove Action.
• To reorder the actions, click the area next to the action link and click Move Up or Move Down.

7. From the Follow-on Action box, choose whether you want to continue processing rules or process no further
rules.

8. Click OK to save the user quota rule.

To create actions

You can create actions to ignore Windows queue restrictions, override the Windows queue pop-up window, disallow
printing, perform cost accounting, route to a specified destination, set the document owner, set the document state,
and notify about quota management restrictions. The steps necessary to configure these actions types are listed in the
following table.

• Performs these steps to create actions.
Action Description

To ignore Windows queue restrictions Select this action if you want to display the client pop-
up window rather than the pop-up window defined for
a Windows queue.

1. In the Perform the following actions box, click the
<Action> link.

2. Select Ignore Windows queue restrictions.

No further configuration is required.
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Action Description

To override Windows queue pop-up Select this action if you want to display the client pop-
up window rather than the pop-up window defined for
a Windows queue.

1. In the Perform the following actions box, click the
<Action> link.

2. Select Override Windows queue pop-up.

No further configuration is required.

To route to destinations Select this action to add or replace a destination for a
document.

1. In the Perform the following actions box, click the
<Action> link.

2. Select Route to Destinations | Basic.

This opens the Select Destinations dialog box.
3. Select a destination from the tree.
4. Click the box at the bottom to indicate whether this

address is to replace an existing address or added to
the existing address.

5. Click OK.

To disallow printing Select this action if you want to disable printing for this
user or group.

1. In the Perform the following actions box, click the
<Action> link.

2. Select Disallow Printing.

No further configuration is required.

To set a document owner Select this action to specify the owner of a document.

1. In the Perform the following actions box, click the
<Action> link.

2. Select Set Document Owner.

This opens the User and Group Selection dialog
box.

3. Select the appropriate user or group in the grid.
4. If the user or group you want is not listed, click

More Users to search for additional users.

See the Adding users and groups to Output
Manager topic for detailed procedures on adding
users.

5. Click OK.

To set a document state Select this action to change the state of a document.
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Action Description
1. In the Perform the following actions box, click the

<Action> link.
2. Select Set Document State.

This opens the Set Document State dialog box.
3. From the drop-down list, select the appropriate

document state: Hold or Ready.
4. Click OK.

To notify about quota
management restrictions

Select this action to specify that a user or group be
notified about quota management restrictions and the
notification method.

1. In the Perform the following actions box, click the
<Action> link.

2. Select Notify on Quota Management
Restrictions.

This displays the Notify on Quota Management
Restrictions dialog box.

3. You can choose to notify the user or group using
email, with a pop-up window, or both.

• To use email notification, select Notify via
email. Select an email profile from the drop-
down list or click the Browse button to manage
profiles from the Manage Outbound Email
Profiles dialog box.

• To use a pop-up notification, select the Notify
via client pop-up check box.

4. Click OK.

How to Create a Desktop Client Profile
Use this procedure to select an existing profile.

The desktop client profile configures general options for the desktop client and determines how print jobs are handled
in disconnected mode.

1. From the grid, click the appropriate Desktop Client Profile cell and then click the Browse button.
This opens the Manage Desktop Client Profiles dialog box.

2. Click New.
This opens the Desktop Client Profile dialog box.

3. Enter a Profile name and Profile description.
4. Under General Options, determine if you want to display the client in the system tray and if you want to allow

users to shut down the client and stop tracking.
You can also define blacklists for excluding specific applications and specific queues from tracking.

5. Under Handling of print jobs in disconnected mode, choose one of the following options:
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• Disallow print jobs when disconnected
• Allow jobs and enforce quotas using cached information
• Allow all jobs and do not enforce quotas until reconnected

6. Under Client popup options, you can control whether pops are processed in batches, and also if they are to
include previously selected billing accounts.

7. Click OK.
8. Click Close.

Assigning Costs to Billing Accounts
Manage Billing Accounts is used to create lists of billing accounts. PIN numbers can be associated with billing
accounts

In the Administration application, Allowances Profiles can be configured on the Manage Users > Balances tab.
These profiles are used to set initial and recurring balances for print and copies.

Copy/FAX/Scan costs for balance calculations can be assigned in the Devices configuration embedded tab. These are
expressed as cost per page.

Allowances
Users can be restricted to a printing allowance. These allowances can be refreshed via an Allowances profile.

The Print Rules Profile controls information that is displayed on the Windows Client. The estimate print cost can be
shown with the Windows Client.

Estimated print cost is computed using the values specified in Source configuration More Settings tab.

How to Configure Balance Settings
Complete this procedure to assign a print allowance.

Administrators can assign print balances to control costs.

1. Click the Balances tab.
2. Select the Set Balance check box.

This enables grid cells to the right so that you can define the parameters of the allowance.
3. To specify the print allowances, click the browse button (...) for Allowances Profile.
4. Configure the allowances profile, save it, and assign it to the selected user.
5. For users, the current remaining balance is displayed in the Remaining Balance cell. To adjust the balance

amount, click the cell and enter a new amount.
6. For users, you can specify the date that the new accounting period begins. Click the arrow in the Next Refresh

cell and select a date.
You can specify that the balance be refreshed on a particular date or you can specify that it be refreshed today.

7. Click Apply.
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How to Import Billing Accounts
Use this procedure to add billing accounts from a comma separated value (CSV) file into a billing list or update
existing billing accounts in a billing list.

1. From the Administration application, click Manage Billing Accounts.
2. Create a billing list or select an existing billing list from the Name drop-down list box.
3. Click Import.
4. On the Billing Accounts Import Wizard dialog box, click Next.
5. Browse to the CSV file that contains the new or updated billing accounts.
6. If the first row of the file contains column header values, select First row contains column headers.
7. Select the type of delimiter that separates the values in the CSV file and click Next.
8. Map Nuance Output Manager properties to the imported values in the CSV file and click Next.
9. Verify that the information to be imported is correct.
10. Select one of the following options to change a value:

• Change the value on the Preview Import screen and continue with step 11.
• Update the CSV file and restart this procedure.

11. Click Next.

If the billing list is empty, click Next on the Billing Account Import Validation screen to finish importing the
billing accounts.

12. If the billing list contains accounts:

• Select Replace existing list with file import to remove all the accounts in the billing list and replace them
with accounts in the CSV file.

• Select Append new Billing Accounts to add accounts from the CSV file to the list of existing accounts in the
billing list. If the CSV file contains accounts that are already in the billing list, the accounts in the billing list
do not change after the import.

• Select Update Billing Accounts to add new accounts from the CSV file to the billing list. If the CSV file
contains accounts that are already in the billing list, the accounts in the billing list are updated with the account
information in the CSV file.

When updating billing accounts, you can use a value of CLEAR in the CSV file to delete the PIN codes from
the corresponding accounts in the billing list.

13. Click Next and then click Import.

Managing Windows Queues
Administrators can use Manage Windows Queues utility to create and assign quota profiles to converted and
external Windows queues. Quota profiles can be configured to set up restrictions based on the type of document.
Examples include disallowing color printing, requiring documents to be duplex, disabling print from certain
applications, and so on.

• Assign a quota profile
• Create a quota profile



Output Manager Administration Guide
Version 4.0 SP2

260 © 2016 Nuance Communications, Inc. All rights reserved.

How to Assign a Quota Profile
Complete this procedure to assign a quota management profile to a Windows queue.

1. In the Output Manager Console navigation pane, select the Administration application.
2. In the navigation pane, click Manage Windows Queues.
3. Click the Server tab to configure server queues or the Workstation tab to configure workstation queues.

A server queue is a Windows queue that has been converted into a Nuance Output Manager source. Server queues
use the Output Manager Port Monitor so that the data is received into the Nuance Output Manager spool. A
workstation queue is a Windows printer that is not a Nuance Output Manager source (for example, a USB attached
printer on an end user's workstation). The data is not received into Nuance Output Manager.

Note:  Notice the grid is displayed grouped by the Server Name column. This allows you to easily view
all queues for a server. You can remove grouping by right clicking in the group panel and clicking Clear
Grouping.

4. Click in the Quota Profile cell for the appropriate queue.
5. Select a quota management profile from the list, or click the browse button (...) to create or edit one.

Clicking the browse button opens the Manage Windows Queues Quota Profiles dialog box.
6. If you are configuring an workstation queue, you can also specify the cost per page for black and white and color

printing.
7. Once all of the changes have been made, click Apply.

How to Create a Quota Profile
Complete this procedure to create a basic quota management profile and assign it to a Windows queue.

1. From the Output Manager Console navigation pane, select the Administration application.
2. In the navigation pane, click Manage Windows Queues.
3. Select the Server tab to configure server queues or the Workstation tab to configure workstation queues.

A server queue is a Windows queue that has been converted into a Nuance Output Manager source. Server queues
use the Output Manager Port Monitor so that the data is received into the Nuance Output Manager spool. A
workstation queue is a Windows printer that is not a Nuance Output Manager source (for example, a USB attached
printer on an end user's workstation). The data is not received into Nuance Output Manager.

Note:  Notice the grid is displayed grouped by the Server Name column. This allows you to easily view
all queues for a server. You can remove grouping by right clicking in the group panel and selecting Clear
Grouping.

4. Click in the Quota Profile cell for the appropriate queue. You can select a quota management profile from the list
or complete the following steps to create a new profile.
a) In the Quota Profile cell, click the browse button (...).

This opens the Manage Windows Queue Quota Profiles dialog box displays. This dialog box lists all of the
defined profiles. When managing profiles, you can create, import, and export profiles, as well as manage all
existing profiles.

b) Click New to create a new profile.
This opens the Windows Queue Quota Profile dialog box.

c) Enter a Profile name and Profile description.
d) Under Restrictions - Disable Printing, select the options that you want to disable printing.

You can choose to always disable printing, or choose to disable printing if the document is not duplex, if the
document page count or byte count exceeds a specified value, if the document contains color, or if the number
of pages printed in a month exceeds a specified value.
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e) Under Restriction Notification Options, determine if you want to be notified when a restriction occurs.
You can be notified using an email profile or on the client pop-up.

f) You can also configure the client pop-up to display for the Windows queue. To display the pop-up, select the
Show client pop-up for this Windows queue.
Notice the client pop-up configuration options are now available.

g) Under Client pop-up general options, select the appropriate check box options.
h) Under Select up to five billing lists, use the grid to select and configure up to five billing lists to be displayed

in the client pop-up.

• Select the Active check box for the appropriate rows.
• Click in the Caption column and enter the caption text.
• Click in the Input Type column to select the input type.
• Click in the Billing List column to select a billing list.

Billing lists are configured in the Manage Billing Accounts utility.
5. To convert this profile to an advanced profile and manage the profile using rules, click Advanced.
6. Complete the following steps to create an advanced profile.

a) If any items were selected on the previous dialog box, notice they now appear as rules on the Windows Queue
Quota Rules Manager dialog box. Click each rule and review in the preview section.

b) The rules grid lists all of the defined rules in the order they will be processed. The rules grid is editable. Use
the following procedures from the rules grid.

• Use the check box in the Enabled column to determine if the rule is enabled or disabled.
• To rename a rule, click in the Name cell and make the change.
• To modify the rule description, click in the Description cell and make the change.
• To change the follow-on action, click in the Follow-on Action cell and select the action you would like

to take after this rule has been processed. You can continue processing rules or select not to process any
additional rules.

c) Under the rules grid, use the following procedures to configure rules.

• To create a rule, click Add. The Windows Queue Quota Rule dialog box displays.
• To modify a rule, select a rule and click Modify.
• To delete a rule, select a rule and click Remove.
• To create a copy of a rule, select a rule and click Copy. This will create a copy of the selected rule.
• To reorder the rules, select a rule and click Move Up or Move Down.

All selected items will be converted into rules and display in the Windows Queue Quota Rules Manager dialog
box. Once the profile has been converted to an advanced profile, it cannot be returned to a basic profile.

7. Click OK or Apply to save your changes.
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Rules and Tasks

Rules
Nuance Output Manager supports rules for effective document processing, routing and control.

Nuance Output Manager includes rules in the following categories.

Category Description

Business rules Business rules can be used to perform tasks such as to as
sign document ownership, route documents, transform d
ocuments from one printer language to another, split doc
uments, modify the contents of documents, and so forth.

AdHoc rules AdHoc rules run on user-selected documents that are spo
oled. Complete rules can be processed using conditions,
or just actions for unconditional processing. AdHoc rule
s can be scheduled.

Alert rules Alert rules specify actions when certain events occur.

Error handling rules Error handling is controlled using Error Handling Profil
es, which can be assigned to any destination to define th
e behavior in the event of errors occurring at the destinat
ion.

Failover Rules on page 303 Failover and automatic re-routing of a document is contr
olled using settings in the error handling profile in conju
nction with a failover profile.

Business Rules
Administrators can create business rules to assist in automating document processes for unattended operation.
Business rules can be used to perform tasks such as to assign document ownership, route documents, transform
documents from one printer language to another, split documents, modify the contents of documents, and so forth.

Administrators can create business rules to assist in automating document processes for unattended operation. When a
condition is found to be true, the configured action will take effect.

• Manage business rules
• Create business rules
• Create business rule actions

Business rules are processed against each document, after it enters the spool and before it is available for routing. The
rules processor tests the received document against each rule in turn, beginning with the first defined and enabled rule
and ending when a condition match occurs. By default, only actions of a single rule are applied to a document.
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How to set up business rules
Business rules are set up and managed in the Business Rules Manager.

1. To open the Business Rules Manager, click Tools > Business Rules.
In the Business Rules Manager you can create or modify business rules as well as adjust the processing order of
the rules.

2. To create a new rule, click the Add button.
This opens the New Business Rule dialog box.

3. In the Name box, type the name for the rule.
4. Optional: In the Description box you can briefly describe the purpose of the rule.
5. For Rule definition, either select the Always execute this rule, click <Target> in the When box, and define

Document or System conditions to invoke a rule:
Type Defines

Document Document conditions to apply for rule.

System Day and time conditions to apply for rule.

For example, Document lets you specify virtually any property associated with the document. After you select
a target, you click to choose an <Operation>, such as Is Equal To or Begins With, and then click <Value> to
specify a value. The operations and values depend on the selected target.

6. Click the Add Condition button to add another conditions to the current group, or click Remove Condition to
delete the currently selected condition.
Conditions within a group are logically combined by AND or OR. You can click the logical operator on a
condition to switch between AND and OR.

7. Click a group radio button (the left radio button) to select the group. You can then click Remove Group or Add
Group.
Groups are logically combined by AND or OR. You can click a logical operator between groups to switch
between AND and OR.

8. In the Perform the Following Actions, click <Action> to add actions to perform as targeted in the When box.
Actions are performed in the order that they appear in this box. You can click buttons to add, modify, remove, and
reorder actions.

9. For Follow-on Action, specify whether to continue processing rules after completing actions specified by this
rule.

How to Create Business Rules
Use this procedure to create a business rule. You will configure conditions and actions.

1. In the Output Manager Console menu bar, click Tools > Business Rules.
This opens the Business Rules Manager dialog box.

2. To create a new rule, click Add.
This opens the Business Rule dialog box.

3. Enter a rule Name and Description.
4. Use the Enabled check box to determine if the rule is enabled or disabled.
5. If you want to apply the rule to all documents, select the Always execute this rule (no conditions) check box.

This will disable the When box, as no condition statements are needed. If you select this option, skip to step 7.
6. Use the When box to create and manage the rule conditions. Multiple conditions can be created and organized

into groups. A box is used to indicate a condition group. To create a rule condition, perform the following steps.
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a) In the When box, click the <Target> link. Use the list to select a Document or System condition.
b) Click the Operation link and select the appropriate operation.
c) Click the Value link and select the appropriate value to complete the condition.

To include additional condition statements or create groups of conditions:

• Select a condition radio button (inside the box) to enable the Add Condition and Remove Condition
buttons for adding and removing condition statements.

• Select a group radio button (outside the box) to enable the Add Group and Remove Group buttons for
adding and removing groups. This will also enable the Add Condition button for adding a condition to the
selected group.

7. Under Perform the following actions box, use the following procedures to manage actions.

• To create an action, click the <Action> link and select one of the actions.

For more information about configuring actions, see Create business rule actions.
• To create an action, click the <Action> link and select an action.
• To create additional actions, click Add Action.
• To modify an action, click the action link or click the area next to the link, and then click Modify Action.
• To delete an action, click the area next to the link and click Remove Action.
• To reorder the actions, click the area next to the action link and click Move Up or Move Down.

8. From the Follow-on Action list, click the action you would like to take after this rule has been processed. You can
continue processing rules or select not to process any additional rules.

Note:  When new documents are created as a result of a rule action, the processing of the new documents
varies from the processing of the original document. The new documents continue with the next rule
action. The original document, if you choose Continue processing rules, skips the next rule actions
in the current rule, and goes to the next rule. Transform, Burst, and sometimes Advanced Document
Modification actions create new documents. For example, when you transform a document from postscript
to PDF, a new document is created, or when you burst a document into 10 documents, 10 new burst
documents are created.

9. Click OK to save your business rule.

How to Manage Business Rules
This procedure provides the basic steps for managing business rules.

1. On the Output Manager Console menu bar, select Tools > Business Rules.
This opens the Business Rules Manager dialog box displays. The business rules grid lists all of the defined
business rules in the order they will be processed.

2. Selecting a rule will display the rule for preview below the grid. Use the following procedures to edit rules in the
grid.

To Do this

Determine if a rule is enabled or disabled Use the check box in the Enabled column

Change the follow-on action Click in the Follow-on Action cell and select the
action you would like to take after this rule has been
processed. You can continue processing rules or select
not to process any additional rules.

Modify the rule Double-click the row.

3. Under the business rules grid, use the following procedures to configure rules.
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To Do this

Create a rule Click Add to open the Business Rule dialog box.

Modify a rule Select a rule and click Modify.

Delete a rule Select a rule and click Remove.

Create a copy of a rule Select a rule and click Copy.

Rename the rule Double-click the rule or select the new rule and click
Modify.

Reorder the rules Select a rule and click Move Up or Move Down.

4. Click OK or Apply to save your changes.

Create Business Rule Actions
Use this procedure to create business rule actions.

Business rule actions are created to perform actions on documents. Examples include routing to destinations,
transforming to other print languages, assigning to document folders, and editing document properties.

Steps necessary to configure action types are listed by procedures in this section. Perform the steps in the appropriate
procedure to configure business rule actions.

Action Description

Assign Profiles to Document • Set Failover Profile — Specifies what should happen
to documents when they are sent to inaccessible
destinations (they are not able to receive documents).

• Set Filter Profile — Associates a filter profile with
a document. This filter will be used for document
viewing and reprinting.

• Set Library Filing Profile — Sends documents to
the document library. Specifies the library folder
where documents will be sent, the file store, any
notifications, and how long to keep documents before
deleting.

• Set Notification Profile — Sends notifications when
specific events occur in the document life cycle.

• Set Output Process — Performs processing such as
search and replace, setting finishing options, editing
PJL commands, inserting overlays, and so on.

Burst • Line Mode — Bursts line data documents based on:
data contained in the document, desired output size
and size of original document, and number of output
documents desired.

• Page Mode — Splits printer ready documents based
on: data contained in the document (regions are used
to determine burst conditions), desired output size
and size of original document, and number of output
documents desired.
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Action Description

Extract Text • Line Mode — Extracts text from line data documents
using rows and columns.

• Page Mode — Extracts text from printer ready
documents using regions (rectangles).

Modify Document Contents • Advanced Document Modification — Runs the ADM
process. In this process each page of the document
is read, portions of the document can be changed or
values extracted, and then the page is written. This
can be used as an advanced way to extract text, burst,
or perform other operations on the document.

Modify Document Exceptions • Remove All Document Exceptions
• Remove Matching Document Exceptions
• Set All Document Exceptions
• Set Matching Document Exceptions

Set Document Properties • Set Document Properties — Allows you to configure
document properties.

• Set Document Properties from Web Service (REST)

Route to Destinations • Advanced — Allows you to use a CSV file to
dynamically pick destinations based on a document
property.

• Basic — Specifies the destinations where documents
should be sent.

Set Document Owner Configures the document owner.

Transform Document • Adept — Transforms documents using the Adept
transform suite.

• Page Mode — Transforms the format of a printer
ready document to a new format, and/or to another
data type.

• Record Mode (Advanced) — Transforms line data
from one line format to another.

• Record Mode (Basic) — Performs the most common
transforms for data coming from a Output Manager
Print Server device. This converts .tnj to ASCII
text, .anj to AFP, and .bnj to .bin.

Analyze Document Processes documents and populates document properties.

Assign to Document Folder Assigns documents to specific document folders.

Convert Fixed Block to Variable Block Converts FBA to VBA and FBM to VBM. It can be used
when dealing with mainframe tape formats.
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Action Description

Delete Document Deletes documents.

Delete Client Popup

Move Document to File Store Moves documents to another location (file store).

Package Banner Adds a banner to the beginning of the package. The ban
ner will be added as a separate document within the sam
e package.

Power Rule Allows you to build multiple rules inside of one rule.

Remove from Document

Run Ad hoc Rule Runs an existing ad hoc rule.

Run Command Performs a command line operation on the document.

Schedule Output Schedules documents to print at a specific date and time.

Send Email Sends email messages when specific events occur in the
document life cycle.

Set Billing Accounts Documentation coming soon

Set Document State Sets the document state to hold or ready.

Set Retain Period Determines how long documents will be retained.

Unpackage Separates documents that are in a package so they can ac
t as individual documents in Nuance Output Manager.

Unzip Document

User Information Stamping Adds the user name or other value and date to document
s.

Watermarking Adds a watermark from a PNG file to documents.

To set failover profiles
Use this action to determine what should happen to documents when they are sent to inaccessible destinations (they
are not able to receive documents).

1. In the Perform the following actions box, click the <Action> link and then click Assign Profiles to Document >
Set Failover Profile.
This opens the Set Failover Profile dialog box.

2. Select an existing Profile from the list or click New to create a new failover profile.

In the Failover Profile dialog box, you can determine what should happen if all of the retries fail and when to
place the document in an error state.

You can click Edit to edit the selected profile or click Manage to display the Manage Failover Profiles dialog
box which lists all of the defined profiles. When managing profiles, you can create, import, and export profiles, as
well as manage all existing profiles.

3. When you have selected your profile, click OK.



Output Manager Administration Guide
Version 4.0 SP2

268 © 2016 Nuance Communications, Inc. All rights reserved.

To set filter profiles

Use this action to associate a transform filter to a document. This filter tells Nuance Output Manager how to format
fonts and additional information for printing. This filter is used when the document is viewed or printed.

1. In the Perform the following actions box, click the <Action>link, and then click Assign Profiles to Document >
Set Filter Profile.
This opens the Set Filter Profile dialog box.

2. To prevent the filter profile from parsing information, do the following:
a) Click the Calculate profile from parse of a document property browse button (...) to open the @Parse

dialog box.
b) Configure the @parse function as necessary, then click OK.

For instructions on configuring the function, see Configuring the @parse function.
3. In the Format list, select the data type.
4. Select an existing Profile from the list or click New to create a new filter profile in the Configure Filter Profile

dialog box.

See Configuring a CpMillProfile resource for instructions on configuring a filter profile. If you chose to calculate
the profile from the parse of a document property, you must still select a profile. This profile will be used if the
@parse profile does not result in a valid filter profile.

Note:

Xerox and AFP data may require more than one input profile per document. To write multiple filter
profiles for XRX, LCD, MMD, and AFP data types, name the profile in the following format:

MyProfile**Description.

Where "MyProfile" is used for all of the profiles that should be written out together. "Description" is not
used in the comparison, so it can be anything. You must include the "**" for the profiles to be considered.
For example, if you have an LCD profile and you want to write an XRX and an XIF profile with it, you
could name them as follows:

LCD profile: Profile1**MyLcdProfile
XRX profile: Profile1**MyXrxProfile
XIF profile: Profile1**MyXIFProfile

If you have more than one profile of the same type with the same name up to the "**" the last one
overwrites the others.

5. You can click Edit to edit the selected profile or click Manage to display the Resource Manager dialog box,
which lists all of the defined profiles.
When managing profiles, you can create, import, and export profiles, as well as manage all existing profiles.

6. When you have selected your profile, click OK.

To set library filing profiles

Use this action to send documents to the document library. You will specify the library folder where documents will
be sent, the file store, any notifications, and how long to keep documents before deleting.

1. In the Perform the following actions box, click the <Action> link, and then click Assign Profiles to
Document > Set Library Filing Profile.
This opens the Set Library Filing Profile dialog box.



Output Manager Administration Guide
Version 4.0 SP2

269 © 2016 Nuance Communications, Inc. All rights reserved.

2. Select an existing Profile from the list or click New to create a new library profile from the Document Library
Profile dialog box.

3. You can click Edit to edit the selected profile or click Manage to display the Manage Document Library
Profiles dialog box, which lists all of the defined profiles. When managing profiles, you can create, import, and
export profiles, as well as manage all existing profiles. Complete the following steps to configure a library profile.
a) Click New.

This opens the Document Library Profile dialog box.
b) Specify the library profile Name and Description.
c) Determine where documents will be placed in the library.

You must first click the Base folder browse button (...) to select an existing folder. You can then specify one or
more Dynamic folder levels to be placed under the selected Base folder. To create dynamic folders, click Add
and enter a folder name.

The folder name can consist of text, one or more document properties, and functions. To insert document
properties, right-click in the text box and click Insert Document Property. Some example document
properties are date/time, document name, data type, and so on. To insert functions, right-click in the box, click
Insert Function, and choose the appropriate function. Review the Using Nuance Output Manager functions
help topic for information on configuring functions. Once you have entered the folder name, click OK.

You can add, edit, and remove folders, and change the folder order using the buttons next to the box. Each
level added becomes a sub folder of the folder above it in the list.

d) Choose if you want to Send email notification upon filing.
If you want to send an email notification when a document is sent to the library, select the check box and click
Email. Configure the email setting on the Send Email dialog box.

e) Specify the file store for documents sent to the library.
You can choose to leave them in their current file store or move them to a specified file store.

f) In the Purge documents box, specify how long documents should stay in the library before they are deleted.
g) Click OK.

4. When you have selected your profile, click OK.

To set notification profiles
Use this action to send notifications when specific events occur in the document life cycle.

Notifications are sent according to defined notification profiles. Notification profiles specify which events generate
notifications (document arrives, prints successfully, prints on failover destination, or is in error state), the type of
notification for each event (email or pop-up), the text of notifications for each event, and who should get notified. For
example, you can configure a pop-up to display after a document prints successfully.

1. In the Perform the following actions box, click the <Action> link and click Assign Profiles to Document > Set
Notification Profile. This opens the Set Notification Profile dialog box.

2. In the Profile list, click an existing profile or click New to create a new notification profile.
3. You can click Edit to edit the selected profile or click Manage to display the Manage Notification Profiles

dialog box, which lists all of the defined profiles. When managing profiles, you can create, import, and export
profiles, as well as manage all existing profiles. Complete the following steps to configure a notification profile
from the Notification Profile dialog box.
a) Click New.
b) Specify the profile Name and Description.
c) If this profile will send email notifications, select the Email profile that will be used with those notifications.
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You can select an email profile from the list or click the Browse button and mange profiles from the Manage
Outbound Email Profiles dialog box. From this dialog box you can create and modify email profiles using
the Outbound Email Profile dialog box.

d) Click directly in the Notifications grid to configure the notifications that will be sent. You will need to
configure each grid column. You can add and remove notifications (grid rows) using the Add and Remove
buttons.

• When the document — Select when a notification will be sent. You can choose to send a notification
when a document Arrives, Prints Successfully, Prints on Failover Destination, or Is In Error State.

• Send notification via — Select how the notification will be sent and displayed. You can choose to send
notifications using the Tray Client Pop-up or as an Email Message.

• Notify owner — Choose if the document owner will be sent a notification.
• Recipients — Click the Browse button to select who will receive the notification. You can select users and

groups in the User and Group Selection dialog box. If the user or group you want is not listed, click More
Users to search for additional users. See Adding users and groups to Nuance Output Manager  for detailed
procedures on adding users.

• Message — Enter the notification text. You can insert document properties in the body text by right-
clicking in the text box, clicking Insert Document Property, and choosing the appropriate properties.
Document properties will display enclosed in brackets ([]). The values of the properties will display in the
notification. To insert functions, right-click in the box, click Insert Function, and choose the appropriate
function. Review Using Nuance Output Manager Functions for information on configuring functions.

4. Click OK.
5. When you have selected your profile, click OK.

To set output processes
Use this action to impact a document as it is being sent to a destination.

Examples of actions performed on a document include search and replace, setting finishing options, editing PJL
commands, and inserting overlays.

1. In the Perform the following actions box, click the <Action> link, and then click Assign Profiles to
Document > Set Output Process.
This opens the Set Output Process dialog box.

2. Select an existing Profile from the list or click New to create a new output process using the OM Process
Designer.
See Working with output processes for specific output process procedures.

3. You can click Edit to edit the selected profile, or click Manage to display the Manage Output Process Profiles
dialog box, which lists all of the defined profiles.
When managing profiles, you can create, import, and export profiles, as well as manage all existing profiles.

4. When you finish selecting a profile, click OK.

To burst using line mode
Use this action to split line data documents (text documents with or without carriage control) based on data contained
in the document, desired output size, or number of output documents desired.

Bursting creates new documents. For example, when you burst a document into 10 documents, 10 new burst
documents are created. The new burst documents continue with the next rule action. The original document, if you
choose "continue processing rules," skips the next rule actions in the current rule, and goes to the next rule.

1. In the Perform the following actions box, click the <Action> link, and then click Burst > Line Mode.
This displays the Extract Text tab in the Burst - Line Mode dialog box.
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2. In the Server list, click the licensed rules agent server that you would like to use.
3. Under Detect, choose to detect the text to extract by Lines or by Records.

• Choose Lines if you want to use carriage control when specifying the position of variables on the page.
• Choose Records to count records, ignoring carriage control, when specifying the position of variables on the

page.
4. In the Format list, click the data format.
5. In the Code page list, click the associated code page.
6. If desired, select Banner mode.

a) In the Search for box, specify the text that defines the recognition string.
b) In the Page box, specify the page at which to start searching.
c) In the Column box, specify the column at which to start searching.
d) In the Lines boxes, enter the line numbers between which you would like to search.
Selecting this option allows the recognition string location to vary on the page. This will search the document for a
recognition string. The recognition line becomes line 1 and the extraction variables will be relative to it.

7. Under Extraction variables, create one or more variables that will be used for bursting or extraction. You can
add, modify, and remove variables using the buttons above the grid. To add a new variable, complete the following
steps.
a) Click New.

This opens Text Extraction Variable Definition dialog box.
b) Enter the Name, Description, and Type of extraction variable.

There are two types of extraction variables, those used for bursting and those used to extract data.
c) If you want to remove spaces that exist at the start and end of the extracted text, select Trim spaces.
d) Under Location on page, specify the Line/Record number from which the text will be extracted.

If you are using record mode, it will be the record number of the current page (that is, variables on page 2 and
greater are relative to line 1 on that page). If you selected Banner mode, the recognition line becomes line 1
and the extraction variables are relative to it.

e) In the Column box, specify the start column for the extraction.
f) In the Extract box, enter the number of characters to extract.
g) If this is an Extract type variable, under Page selection specify the page of the newly created burst document

from which you want to extract the text.
You can enter a Page number or select First page with non-blank value in selected location.

h) Click OK.
Once a variable of a particular type has been created, it cannot be changed to the other type.

8. On the Burst Conditions tab, specify what how to create the new documents. You can create documents using
one of the following options:

Option Description

Extracted variables Allows for selecting the extraction variables created
from the Extract Text tab as conditions in the Burst
when box. You can choose the extraction variable and
condition that will cause new documents to be created.

Number of pages Allows for splitting documents based on the number of
pages. When you select this option, the Split.Pages in
new document and Split.Pages in current document
variables are available in the Burst when box.
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Option Description

Number of output documents Splits a document into a specified number of equally
sized output documents. For example, if you submit
a document with 99 pages and you set the number
of output documents to 3, you would get 3 output
documents of 33 pages each. If necessary, you can
select extraction variables created from the Extract
Text tab as conditions in the Burst when box. Nuance
Output Manager will find the position in the source
document where the split should occur based on pages
per documents, and then start a new document after the
additional condition is met. This allows the boundary
between split documents to be better controlled based
on the contents of the document.

9. The Burst when box is used to create and manage the burst conditions. Multiple conditions can be created and
organized into groups. A blue box is used to indicate a condition group. To create a burst condition, perform
the following steps. If you chose to split based on the number of output documents, the Burst when box is not
available.
a) In the Burst when box, click the <Target> link and select the appropriate variable. The variables that display

vary depending what the split is based on.

Variable Description

Extracted variables The extraction variables added on the Extract Text ta
b will be listed in the menu.

Number of pages You can choose the following variables:

• Split.Pages in current document — Specifies
the total number of pages in the current
document.

• Split.Pages in new document — Specifies
the number of pages to be contained in each
new burst document. The number of pages is
determined from the beginning of the document
or from the previous burst. If the total number
of pages of the current document is not equally
divisible by this value, the final burst document
will contain fewer pages.

Note:  For example, if you create
a condition [where Split.Pages in
new document is equal to 20 AND
Split.Pages in current document
is between to 0 AND 200, when you
submit a 100 page document, the process
will split it into 5 20 page documents.
Each page is analyzed to determine
if it is the 20th page since a burst or
the beginning of the document. When
the 20th page is reached, a new burst
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Variable Description

document is created containing those
20 pages (that page combined with the
previous 19 pages). The page count
process repeats until the end of the
document.

• Number of output documents — The extraction
variables added on the Extract Text tab will be
listed in the menu.

b) Click the Operation link and select the appropriate operation.
c) Click the Value link and select the appropriate value. This condition statement is completed.
d) To include additional condition statements or create groups of conditions:

• Select a condition radio button (inside the box) to enable the Add Condition and Remove Condition
buttons for adding and removing condition statements.

• Select a group radio button (outside the box) to enable the Add Group and Remove Group buttons for
adding and removing groups.

This will also enable the Add Condition button for adding a condition to the selected group.
e) Under Follow-on action, specify the action you would like the input document (original document) to take

after this rule has been processed.
You can choose to delete, retain, or process the next rule for the original document. The newly created
documents (output documents) continue with the next rule action.

10. On the Set Document Properties tab, configure the document properties for the newly created burst documents.
The grid lists the property values that can be configured grouped in the following categories: Basic options, Media
selection, Document, Image adjustments, Finishing, and Other properties. To expand a category, click the down
arrow next to a category name. To collapse a category, click the up arrow.
a) Expand the category of the property you want to configure. The first node level in the category determines the

print preferences for the properties it contains. In the Mode/Value column, select how the property should be
applied when a document is sent to a destination. You can choose from the following options:

• Always Apply – Always applies the specified property value. Nuance Output Manager will add commands
to the print stream to enforce the print preference. If the document already contains commands for that
print preference, Nuance Output Manager will modify the commands to work with the printer family where
the document is being sent.

• Apply Conditionally – Applies the property value conditionally. Nuance Output Manager will only add
or modify commands for the print preference when the printer family that the document is destined for is
different from the printer family the document was originally designed for.

• Informational Only – Nuance Output Manager makes no changes to the print stream when the document
is sent to the destination. The value is for informational purposes only.

b) Under each print preference are the parameters needed to generate that print preference. In the Mode/Value
column, specify the document property value.
You can use functions to insert and extract data as necessary. See Using Nuance Output Manager Functions.

11. Click OK to save the business rule.

To burst using page mode

Use this action to burst printer ready documents. Regions (rectangles) are used to determine burst conditions. Or
splitting is based on the desired output size of documents or the desired number of output documents.
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1. In the Perform the following actions box, click the <Action> link, and click Burst > Page Mode.
This displays the Extract Text tab in the Burst Document - Page Mode dialog box.

2. In the Server list, click the licensed transform server that you would like to use.
3. In the Transform package list, you can select an existing transform package for bursting or create one.
4. Select the Override input filter profile assigned to document check box if you want to use the filter profile

configured in the transform package.
Selecting this check box overrides the input filter profile assigned to the document. Clearing the check box uses
the filter profile configured in the transform package.

5. In the Additional Parameters box, specify additional parameters needed for the transform software.
6. Under Extraction variables, create one or more variables that will be used for bursting or extraction. You can

add, modify, and remove variables using the buttons above the grid. To add a new variable, complete the following
steps.
a) Click New.

This opens the Text Extraction Variable Definition dialog box.
b) Enter the Name, Description, and Type of extraction variable. There are two types of extraction variables,

those used for bursting and those used to extract data.
c) If you want to remove spaces that exist at the start and end of the extracted text, select Trim spaces.
d) Under Location on page, specify the region (rectangle) from which text will be extracted. This is done by

entering the upper left corners X and Y coordinates, width, and height.

Tip:  The region values can be found by viewing a document with the Nuance Output Manager viewer.
In the viewer, click View > Text Selection Mode in the menu bar. Then, drag the cursor to select the
desired region. The coordinates will appear in the status bar.

e) If this is an Extract type variable, under Page selection specify the page of the newly created burst document
from which you want to extract the text. You can enter a Page number or select First page with non-blank
value in selected location.

f) Click OK.
Once a variable of a particular type has been created, it cannot be changed to the other type.

7. From the Burst Conditions tab, specify what how to create the new documents. You can create documents using
one of the following methods:

Option Description

Extracted variables Allows for selecting the extraction variables created
from the Text Extraction Variable Definition dialog
box as conditions in the Burst when box. You can
choose the extraction variable and condition that will
cause new documents to be created.

Number of pages Allows for splitting documents based on the number of
pages. When you select this option, the Split.Pages in
new document and Split.Pages in current document
variables are available in the Burst when box.

Number of output documents Splits a document into a specified number of equally
sized output documents. For example, if you submit
a document with 99 pages, and you set the number
of output documents to 3, you would get 3 output
documents of 33 pages each.
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8. The Burst when box is used to create and manage the burst conditions. Multiple conditions can be created and
organized into groups. A blue box is used to indicate a condition group. To create a burst condition, perform
the following steps. If you chose to split based on the number of output documents, the Burst when box is not
available.
a) In the Burst when box, click the <Target> link and select the appropriate variable. The variables that display

vary depending what the split is based on.

• If Extracted variables is selected, the extraction variables added from the Text Extraction Variable
Definition dialog box will be listed in the menu.

• If Number of pages is selected, you can choose the following variables:

Split.Pages in current document — Specifies the total number of pages in the current document.
Split.Pages in new document — Specifies the number of pages to be contained in each new burst
document. The number of pages is determined from the beginning of the document or from the previous
burst. If the total number of pages of the current document is not equally divisible by this value, the
final burst document will contain fewer pages.

For example, if you create a condition where Split.Pages in new document is equal to 20 AND Split.Pages
in current document is between to 0 AND 200, when you submit a 100 page document, the process will
split it into 5 20 page documents. Each page is analyzed to determine if it is the 20th page since a burst or the
beginning of the document. When the 20th page is reached, a new burst document is created containing those
20 pages (that page combined with the previous 19 pages). The page count process repeats until the end of the
document.

b) Click the Operation link and select the appropriate operation.
c) Click the Value link and select the appropriate value. This condition statement is completed.
d) To include additional condition statements or create groups of conditions:

• Select a condition radio button (inside the box) to enable the Add Condition and Remove Condition
buttons for adding and removing condition statements.

• Select a group radio button (outside the box) to enable the Add Group and Remove Group buttons for
adding and removing groups. This will also enable the Add Condition button for adding a condition to the
selected group.

e) Under Output format, you can specify if you want to transform the document in this rule action. You can
leave the output format the same as the input format or change it to a format in the list.

f) Under Follow-on action, specify the action you would like the input document (original document) to take
after this rule has been processed. You can choose to delete, retain, or process the next rule for the original
document. The newly created documents (output documents) continue with the next rule action.

9. On the Set Document Properties tab, configure the document properties for the newly created burst documents.
The grid lists the property values that can be configured grouped in the following categories: Basic options, Media
selection, Document, Image adjustments, Finishing, and Other properties. To expand a category, click the down
arrow next to a category name. To collapse a category, click the up arrow.
a) Expand the category of the property you want to configure. The first node level in the category determines the

print preferences for the properties it contains. In the Mode/Value column, select how the property should be
applied when a document is sent to a destination. You can choose from the following options:

• Always Apply — Always applies the specified property value. Nuance Output Manager will add
commands to the print stream to enforce the print preference. If the document already contains commands
for that print preference, Nuance Output Manager will modify the commands to work with the printer
family where the document is being sent.
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• Apply Conditionally — Applies the property value conditionally. Nuance Output Manager will only add
or modify commands for the print preference when the printer family that the document is destined for is
different from the printer family the document was originally designed for.

• Informational Only — Nuance Output Manager makes no changes to the print stream when the document
is sent to the destination. The value is for informational purposes only.

b) Under each print preference are the parameters needed to generate that print preference. In the Mode/Value
column, specify the document property value. You can use functions to insert and extract data as necessary
(see Using Nuance Output Manager Functions ).

10. Click OK to save the business rule.

To extract text using line mode
Use this action to extract text from line data documents (text documents with or without carriage control) using rows
and columns.

1. In the Perform the following actions box, click the <Action> link and then click Extract > Line Mode.
This opens the Extract Text tab in the Burst Document - Line Mode dialog box.

2. In the Server list, click the licensed rules agent server that you would like to use.
3. Under Detect, determine if you want to detect the text to extract by Lines or Records.

Option Description

Lines Select this option if the lines end with carriage controls
and you know the number of lines per page. You will
need to enter the value.

Records Select this option if your document does not have
carriage controls at the ends of the lines or if you do not
know how the lines will appear on the page.

4. In the Format list, click the data format.
5. In the Code page list, click the associated code page.
6. Optional: If desired, select Banner mode. This will search the document for a banner, and the banner text will

become the start of the new document.

• In the Search for box, specify the text that defines the banner.
• In the Page box, specify the page at which to start searching for the banner text.
• In the Column box, specify the column at which to start searching for the banner text.
• In the Lines boxes, enter the line numbers between which you would like to search for the banner text.

7. Under Extraction variables, create one or more variables that will be used for extraction. You can add, modify,
and remove variables using the buttons above the grid. To add a new variable, complete the following steps.
a) Click New.

This opens the Text Extraction Variable Definition dialog box.
b) Enter the Name and Description of extraction variable.
c) If you want to remove spaces that exist at the start and end of the extracted text, select Trim spaces.
d) Under Location on page, specify the Line/Record number from which the text will be extracted. If this is

record mode, it will be the record number of the entire document.
e) In the Column box, specify the start column for the extraction.
f) In the Extract box, enter the number of characters to extract.
g) Under Page selection specify the page of the newly created burst document from which you want to extract

the text. You can enter a Page number or select First page with non-blank value in selected location.
h) Click OK.
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8. On the Set Document Properties tab, configure the document properties for the newly created documents.
a) Expand the category of the property you want to configure. The first node level in the category determines the

print preferences for the properties it contains. In the Mode/Value column, select how the property should be
applied when a document is sent to a destination. You can choose from the following options:

• Always Apply — Always applies the specified property value. Nuance Output Manager will add
commands to the print stream to enforce the print preference. If the document already contains commands
for that print preference, Nuance Output Manager will modify the commands to work with the printer
family where the document is being sent.

• Apply Conditionally — Applies the property value conditionally. Nuance Output Manager will only add
or modify commands for the print preference when the printer family that the document is destined for is
different from the printer family the document was originally designed for.

• Informational Only — Nuance Output Manager makes no changes to the print stream when the document
is sent to the destination. The value is for informational purposes only.

b) Under each print preference are the parameters needed to generate that print preference. In the Mode/Value
column, specify the document property value. You can use functions to insert and extract data as necessary.

9. Click OK to save the business rule.

To extract text using page mode
Use this action to extract text from documents using regions (rectangles).

1. In the Perform the following actions box, click the <Action> link, and then click Extract > Page Mode.
The Extract Text tab displays in the Burst Document - Page Mode dialog box.

2. In the Server list, click the licensed transform server that you would like to use.
3. In the Transform package list, you can select an existing transform package or create one.
4. If you want to override the input filter profile assigned to the document and use the filter profile in the transform

package, select the Override input filter profile assigned to document check box. Clear this check box if you
want to use the filter profile configured in the transform package.

5. In the Additional Parameters box, specify additional parameters needed for the transform software.
6. Under Extraction variables, create one or more variables that will be used for extraction. You can add, modify,

and remove variables using the buttons above the grid. To add a new variable, complete the following steps.
a) Click New.

This opens the Text Extraction Variable Definition dialog box.
b) Enter the Name and Description, and Type of extraction variable.
c) If you want to remove spaces that exist at the start and end of the extracted text, select Trim spaces.
d) Under Location on page, specify the region (rectangle) from which text will be extracted. This is done by

entering the upper left corners X and Y coordinates, width, and height.

Note:  The region values can be found by viewing a document with the Nuance Output Manager
viewer. In the viewer, select View Text Selection Mode in the menu bar. Then, drag the cursor to
select the desired region. The coordinates will appear in the status bar.

e) Under Page selection specify the page of the newly created document from which you want to extract the text.
You can enter a Page number or select First page with non-blank value in selected location.

f) Click OK.
7. On the Set Document Properties tab, configure the document properties for the newly created documents.

The grid lists the property values that can be configured grouped in the following categories: Basic options, Media
selection, Document, Image adjustments, Finishing, and Other properties. To expand a category, click the down
arrow next to a category name. To collapse a category, click the up arrow.
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8. Expand the category of the property you want to configure. The first node level in the category determines the
print preferences for the properties it contains. In the Mode/Value column, choose one of the following options to
determine how the property should be applied when a document is sent to a destination:

Option Description

Always Apply Always applies the specified property value. Nuance
Output Manager will add commands to the print stream
to enforce the print preference. If the document already
contains commands for that print preference, Nuance
Output Manager will modify the commands to work
with the printer family where the document is being
sent.

Apply Conditionally Applies the property value conditionally. Nuance
Output Manager will only add or modify commands
for the print preference when the printer family that the
document is destined for is different from the printer
family the document was originally designed for.

Informational Only Nuance Output Manager makes no changes to the print
stream when the document is sent to the destination.
The value is for informational purposes only.

9. Under each print preference are the parameters needed to generate that print preference. In the Mode/Value 
column, specify the document property value.
You can use functions to insert and extract data as necessary. For more information, see Using Nuance Output
Manager Functions

10. Click OK to save the business rule.

To modify document contents
Use ADM to modify the contents of documents.

ADM (Advanced Document Modification) is a process where each page of the document is read, portions of the
document can be changed, or values extracted, and then the page is written. Documents can be reordered, split,
transformed to a different data type, bar codes added, OMR marks added, and logos changed using ADM. ADM can
be executed in a business rule action or in the output process.

1. In the Perform the following actions box, click the <Action> link, and then click Modify Document Contents >
Advanced Document Modification.
This displays the Configuration tab in the Modify Document dialog box.

2. In the Server list, click the licensed transform server that you would like to use.
3. In the Transform package list, you can select an existing transform package or create one.
4. In the Additional Parameters box, specify additional parameters needed for the transform software.
5. Use the Override input filter profile assigned to document check box option to determine if you want to

override the input filter profile assigned to the document or if you want to use the filter profile configured in the
transform package. Select the check box to use the filter profile in the transform package.

6. In the Unit library list, you can select an existing unit library or create one.
Unit libraries are JavaScript modules that CpMill calls at certain known times while processing a document (for
example, begin document, page start, and page end). The modules can modify the contents of the document,
extract information from the document, write the document, or parts of it, to a new location, or perform
many other operations. For more information on configuring unit libraries, contact Nuance Communications
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Professional Services. See the Configuring a cpMillUnitLibrary resource topic for instructions on creating a unit
library from the Configure Unit Library dialog box.

7. Next to Unit library will create select one of the following options:
Option Description

the same document Select if your unit library is modifying the input
document and writing it to the same location. See the
default comments in unit library for how to tell Nuance
Output Manager the names of the new documents that
are created.

different document(s) Select if your unit library is modifying the current
document and outputting it into a new document, or if
your unit library is bursting the document into many
different documents. See default comments in unit
library for how to tell Nuance Output Manager the
names of the new documents that are created.

multiple documents combined into one Currently not available.

8. Under Follow-on action, specify the action you would like the input document (original document) to take after
this rule has been processed.
You can choose to delete, retain, or process the next rule for the original document. The newly created documents
(output documents) continue with the next rule action.

9. On the Document properties tab, configure the document properties for the newly created documents.
The grid lists the property values that can be configured grouped in the following categories: Basic options, Media
selection, Document, Image adjustments, Finishing, and Other properties. To expand a category, click the down
arrow next to a category name. To collapse a category, click the up arrow.

10. Expand the category of the property you want to configure. The first node level in the category determines the
print preferences for the properties it contains. In the Mode/Value  column, select how the property should be
applied when a document is sent to a destination. You can choose from the following options:

Option Description

Always Apply Always applies the specified property value. Nuance
Output Manager will add commands to the print stream
to enforce the print preference. If the document already
contains commands for that print preference, Nuance
Output Manager will modify the commands to work
with the printer family where the document is being
sent.

Apply Conditionally Applies the property value conditionally. Nuance
Output Manager will only add or modify commands
for the print preference when the printer family that the
document is destined for is different from the printer
family the document was originally designed for.

Informational Only Nuance Output Manager makes no changes to the print
stream when the document is sent to the destination.
The value is for informational purposes only.

11. Under each print preference are the parameters needed to generate that print preference. In the Mode/Value
column, specify the document property value.
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You can use functions to insert and extract data as necessary. For more information, see Using Nuance Output
Manager Functions

12. Click OK.

To route to destinations (Advanced)
Use this action to use a CSV file to dynamically pick destinations based on a document property.

1. In the Perform the following actions box, click the <Action> link and then click Route to Destinations >
Advanced.
This opens the Route to destination (Advanced) dialog box.

2. Select how you want to locate the CSV file. You can use one of the following options:
Option Description

Path Enter the path and file name of the CSV file, or click
the browse button (...) to navigate to the file.

Resource Select the appropriate resource from the list, or click
the browse button to choose the resource from the
Manage CsvDocProp Resources dialog box.

3. In the Lookup data box, right-click and then click the document property that will control the routing.
The value contained in this document property will determine the row used in your .csv file.
For example, the following table shows an example .csv file using the Class property. To route by Class using this
example, select Class in the Lookup data box, enter MyClass in the Key column name box, and MyPrinter in
the Destination column name box. When the document is routed the value of the Class property will determine
which destination is used. For example, if the Class value is A, the document will be routed to printer 1.

MyClass MyPrinter

A printer1

B printer2

C printer3

4. In the Key column name box, enter the column name in your CSV file that corresponds to the selected document
property.

5. In the Destination column name box, enter the column name in your CSV file that contains the destination name
where you want the documents routed.

6. In the list below the tree, choose if you want to replace the destination already assigned to the document or use
multiple destination routing and add to the destination already assigned to the document.

7. Click OK.

A new routing action is shown in the actions box. The action lists all of the selected destinations.
To route to destinations (Basic)
Use this action to specify the destinations where documents should be sent.

1. In the Perform the following actions box, click the <Action> link, and then click Route to Destinations >
Basic.
This opens the Select Destination dialog box.

2. Select the appropriate destinations in the tree.
You can select multiple destinations by pressing the Ctrl or Shift keys and selecting destinations. Selecting a
destination group will select all destinations in that group.
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3. In the list below the tree, choose if you want to replace the destination already assigned to the document or use
multiple destination routing and add to the destination already assigned to the document.

4. Click OK.

A new routing action is shown in the actions box. The action lists all of the selected destinations.
To set document properties
Use this action to configure document properties.

1. In the Perform the following actions box, click the <Action> link, and then click Set Document Properties >
Basic.
This opens the Document Properties dialog box.

2. In the grid, configure the document properties.
The grid lists the property values that can be configured grouped in the following categories: Basic options, Media
selection, Document, Image adjustments, Finishing, and Other properties. To expand a category, click the down
arrow next to a category name. To collapse a category, click the up arrow.

3. In the grid, expand the category of each the property you want to configure. The first node level in the category
determines the print preferences for the properties it contains. In the Mode column, select how the property should
be applied when a document is sent to a destination. Click in the grid cell and choose from the following options:

Option Description

Always Apply Always applies the specified property value. Nuance
Output Manager will add commands to the print stream
to enforce the print preference. If the document already
contains commands for that print preference, Nuance
Output Manager will modify the commands to work
with the printer family where the document is being
sent.

Apply Conditionally Applies the property value conditionally. Nuance
Output Manager will only add or modify commands
for the print preference when the printer family that the
document is destined for is different from the printer
family the document was originally designed for.

Informational Only Nuance Output Manager makes no changes to the print
stream when the document is sent to the destination.
The value is for informational purposes only.

4. In the Value column, specify the document property value.
You can use functions to insert and extract data as necessary. For more information, see Using Nuance Output
Manager Functions.

5. Click OK to save the business rule.

To transform documents using the Adept transform suite
Use this action to transform documents using the Adept transform suite.

Important:  If needed, you can use the Data Conversion Utility to create custom DCOs for converting data
formats. This will not be necessary for most users. If you think this conversion is necessary, please contact
Nuance Support to ensure the data is converted properly.

1. In the Perform the following actions box, click the <Action> link, and then click Transform Document >
Adept.
This opens the Transform Adept dialog box displays.
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2. In the Server list, click the licensed rules agent server that you would like to use.
3. Under Parameters, configure the following options as needed:

To configure Do this

Convert from Select the format you are converting from Xrx and/
or Afp. In the To list, specify the format you are
converting to.

Ini Specify the resource that will control the format of the
printed output. You can select a defined Ini resource
in the list or click Browse to create, modify, or import
Ini resources from the Resource Manager dialog box.
Ini resources are created using the Ini Resource dialog
box.

Ini description Specify the Ini description.

Ini default Select the Ini resource that will be used as the default.

Exe path Click the browse button (...) and select the Adept
executable path.

4. Select the Follow on actions check box for the input document (original document).
You can choose to delete, retain, or process the next rule for the original document. The newly created documents
(output documents) continue with the next rule action.

5. Click OK.

To transform documents using page mode
Use this action to transform the format of a printer ready document to a new format, and/or to another data type.

1. In the Perform the following actions box, click the <Action> link, and then click Transform Document > Page
Mode.
This opens the Configure Transform dialog box.

2. In the Server list, click the licensed transform server that you would like to use.
3. In the Transform package list, you can select an existing transform package or create one.
4. Use the Override input filter profile assigned to document check box option to determine if you want to

override the input filter profile assigned to the document or if you want to use the filter profile configured in the
transform package. Select the check box to use the filter profile in the transform package.

5. In the Output format list, click the format of the output file.
6. Configure the conversion of each input format in the Input formats grid and then click OK.

• For all unlicensed input formats and any input formats you don't want to use, click in the Configuration
column and select Do Not Transform.

• For licensed input formats, you can select Use Default Options or select a predefined configuration in the
Configuration column.

To configure a custom input format, click the ellipsis button in the Modify/New column. If Use Default
Options or Do Not Transform is selected in the Configuration column, a new configuration will be created.
If a predefined configuration is selected, that configuration will be modified. The custom transform options are
configured on the Input options tab, Output options tab, and Page Layout tab. If BMP or PDF is selected as
the output format, the Bitmap output tab or PDF output tab will also be visible.

7. Select the Follow on actions for the input document (original document).
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You can choose to delete, retain, or process the next rule for the original document. The newly created documents
(output documents) continue with the next rule action.

8. Click OK.

To transform documents using record mode (Advanced)
This advanced option is used to perform custom conversions using DCO chains. This provides flexibility to specify
code pages, carriage controls, record formats, and other options for the incoming document and the desired output.

Important:  If needed, you can use the Data Conversion Utility to create custom DCOs for converting data
formats. This will not be necessary for most users. If you think this conversion is necessary, please contact
Nuance Support to ensure that the data is converted properly.

1. In the Perform the following actions box, click the <Action> link and select Transform Document Record
Mode (Advanced).
This opens the Transform Record Mode (Advanced) dialog box.

2. In the Server list, click the licensed rules agent server that you would like to use.
3. Under Parameters, configure the following options as needed:

Option Description

Code page in Specify the code page that represents the current status
of the input document. The default format is 037
(EBCDIC).

Code page out Specify the code page that represents how the file is
being transformed. The default format is 437 (ASCII).

FCB Select the FCB resource that will control the vertical
format of printed output. You can select a defined FCB
in the list or click the browse button (...) to create,
modify, or import FCB resources. See Configuring
an FCB resource for instructions on creating an FCB
resource in the FCB Resource dialog box.

FCB description Click to view/update the description of the selected
FCB.

FCB default Select the default FCB. The default is STD, a
predefined FCB with 66 lines and channel stop 1 on
line 1.

In type Specify the input data type.

Out type Specify the output data type.

Data type after conversion Select the data type of the output documents.

Use block lengths Determine if you want to enable or disable the use
of block lengths in the record. When this option is
selected, records include a block count. The block
count will directly precede the record count. In the
following example,

00 0C 00 00 00 08 00 00 F1 F2 F3 F4
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Option Description
the block count is 00 0C 00 00 and the record count
is 00 08 00 00.

FCB override Use this list to enable or disable overriding FCBs.
Selecting Yes causes FCBs in the beginning of the data
to be ignored, functioning as if there were no FCBs in
the data.

Send FCB Use this list to enable or disable sending FCBs to the
printer.

Delimiter Select the type of delimiter you want to use. Choose
one of the following:

• None — Records do not include delimiter
characters.

• ASCII — Records include an ASCII delimiter.
Each record ends in a carriage return and line feed
character. The actual record length is two bytes
more than the fixed record length specified above.

• EBCDIC — Records include an EBCDIC delimiter.
Each record ends in a carriage return and line feed
character. The actual record length is two bytes
more than the fixed record length specified above.

Truncate trailing blanks Enable or disable the truncating of trailing blanks.

Pad record Enable or disable record padding. Selecting Yes pads
blank records with a space.

Pad skip1 Enable or disable pad skip to channel 1. Selecting Yes
pads blank records with a space.

Length Specify the length of the fixed records. The default
value is 80.

Follow on actions Specify follow on actions for the input document
(original). You can choose to delete, retain, or process
the next rule for the original document. The newly
created documents (output documents) continue with
the next rule action.

4. Click OK.

To transform documents using record mode (Basic)
Use this action to perform the most common transforms for data coming from a Output Manager Print Server device.
This converts .tnj to ASCII text, .anj to AFP, and .bnj to .bin.

1. In the Perform the following actions box, click the <Action> link, and then click Transform Document >
Record Mode (Basic).
This opens the Transform Record Mode (Basic) dialog box.

2. In the Server list, click the licensed rules agent server that you would like to use.
3. Select the Follow on actions for the input document (original document).
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You can choose to delete, retain, or process the next rule for the original document. The newly created documents
(output documents) continue with the next rule action.

4. Click OK.

To analyze documents
Use this action to process documents and populate document properties.

1. In the Perform the following actions box, click the <Action> link and select Analyze Document. The Analyze
Document dialog box displays.

2. In the drop-down list, select the server where the document should be analyzed.
3. Use the check box options to determine the document properties that should be populated. Select the properties

you want populated.
Property Description

Use quick page counting for PDF documents Enables optimized page counting for PDF jobs. When
this option is enabled, the other options are disabled.

Count pages Reads the entire document and sets the total number of
pages for the document.

Detect data type Reads the first portion of the document and attempts to
determine the documents data type. This works well for
postscript, PDF, and PCL files.

Detect trays Looks for input and output tray settings.

Detect color Reads the entire document looking for pages that
contain color information.

Detect duplex Looks for duplex commands in the document.

4. Click OK.

To assign to document folders
Use this action to assign documents to specific document folders.

1. In the Perform the following actions box, click the <Action> link, and then click Assign to Document Folder.
This opens the Select Document Folder dialog box.

2. Select the appropriate folder in the tree.
3. Click OK.

To convert fixed block to variable block
Use this action to convert FBA to VBA and FBM to VBM. It can be used when dealing with mainframe tape formats.

1. In the Perform the following actions box, click the <Action> link and then click Convert Fixed Block To
Variable Block.

2. Specify the fixed block record length in bytes.
3. Click OK.

To delete documents
Use this action to delete documents.

• In the Perform the following actions box, click the <Action> link, and then select Delete Document.

No additional configuration is required.
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To move documents to a file store
Use this action to move documents to another location (file store).

1. In the Perform the following actions box, click the <Action> link, and then click Move Document To File
Store.
This opens the Move Document To File Store dialog box.

2. In the File Store list, select the new file store location.
The list displays all file stores defined in the Set General Preferences Utility.

3. Click OK.

To prepend a banner
Use this rule to add a banner to the beginning of a package. The banner will be added as a separate document within
the same package.

1. In the Perform the following actions box, click the <Action> link, and then click Package Banner.
This opens the Package and Prepend banner dialog box.

2. In the Resource list, select an existing banner resource, or click New to create a banner resource using the Banner
Resource dialog box.
See Configuring a banner resource topic for instructions on creating a banner resource.

3. Click OK.

To create power rules
Use this action to create a power rule for building multiple rules inside of one rule.

1. In the Perform the following actions box, click the <Action> link, and then click Power Rule.
The Power Rule dialog box displays. Each rule contained in the power rule is represented as one row spanning
the Conditions and Actions grids.

2. To manage the condition statements, click Select conditions and use the following procedures from the Select
Conditions dialog. When you are finished working with conditions, click OK.

To Do this

Add conditions to the rule Select the appropriate conditions in the Available
conditions list and click Add. The conditions are
moved to the Selected conditions list. When you click
OK, the new conditions will be displayed as columns
in the Conditions grid.

Remove conditions from the rule Select the appropriate conditions in the Selected
conditions list, and click Remove. The conditions are
moved to the Available conditions list. When you
click OK, these conditions will be removed from the
Conditions grid.

Change the condition processing order Select a condition and click Move up or Move down.
When you click OK, the new order will display in the
Conditionsgrid.

Conditions are processed in the Selected conditions
list order, from top to bottom.

3. Configure the condition statements by clicking directly on the Conditions grid.
For each rule, you must specify the Operator and Value. If you have more than one condition, you will also need
to select the Conjunction, either AND or OR.
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4. To manage the action statements, click Select actions and perform the following procedures in the Select Actions
dialog box.

To Do this

Add actions to the rule Select the appropriate actions in the Available actions
list and click Add. The actions are moved to the
Selected actions list. When you click OK, the new
actions will be displayed as columns in the Actions
grid.

Remove actions from the rule Select the appropriate actions in the Selected actions
list and click Remove.

The actions are moved to the Available actionslist.
When you click OK, these actions will be removed
from the Actions grid.

Change the action processing order Select an action and click Move up or Move down.
When you click OK, the new order will display in the
Actions grid.

Actions are processed in the Selected actions list order,
from top to bottom.

5. When you are finished working with actions, click OK.
6. Click directly in the Actions grid to configure the action statements for each rule.

Statement Description

Route to Destination Click the browse button (... to display the Destinations
dialog box. Select the appropriate destinations in the
tree. You can select multiple destinations by pressing
the Ctrl or Shift keys and selecting the destinations.
Selecting a destination group will select all destinations
in that group. When finished, click OK.

Set Document Folder Click the browse button (...) to display the Document
Folders dialog box. Select the appropriate folders in
the tree. You can select multiple folders by pressing the
Ctrl or Shift keys and selecting folders. When finished,
click OK.

Set Document Library Select an existing profile from the list or click the
browse button (...) to create or manage profiles in the
Manage Document Library Profiles dialog box.

Set Document Owner From the User and Group Selection dialog box, select
the appropriate user or group in the grid. If the desired
user or group is not listed, click More Users to search
for additional users. Click OK.

Set Document State In the list, select one of the following document states:
Any, Ready, Hold, or Error.
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Statement Description

Set Failover Profile Select an existing profile from the list or click the
Browse button to create or manage profiles from the
Manage Failover Profiles dialog box.

Set Notification Profile Select an existing profile from the list or click the
Browse button to create or manage profiles from the
Manage Notification Profiles dialog box.

Set Output Process Select an existing profile from the list or click the
Browse button to create or manage profiles from the
Manage Output Process Profiles dialog box.

Set Schedule Click the browse button (...) to display the Schedule
dialog box. Specify the appropriate values for the
Day and Time options. You can choose to print the
documents today, on a specific day, or in the future.
Click OK.

7. Use the following procedures to control the individual rules contained in the power rule. Each rule is represented
as one row spanning the Conditions and Actions grids.

To Do this

Create a rule Click Add. A row will be added to the bottom of both
grids.

Delete a rule Select a rule and click Remove. The selected row will
be deleted from both grids.

Create a copy of a rule Select a rule and click Copy.

Reorder the rules Select a rule and click Move up or Move down.

8. Click OK.

To run ad hoc rules
Use this action to select an ad hoc rule.

1. In the Perform the following actions box, click the <Action> link, and select Run AdHoc Rule.
2. In the AdHoc rule list, select an existing ad hoc rule.
3. In the Run mode list, choose if you want to run the rule against all documents in the spool or against all newly

received documents since the last time the rule was run.
The rule will not be run against retained documents.

4. Click OK.

To run commands
Use this action to perform a command line operation.

1. In the Perform the following actions box, click the <Action> link and select Run Command.
This opens the Run Command dialog box.

2. Enter the command line.
To insert document properties in the command line, right-click in the text box and click Insert Document
Property. Some example document properties are date/time, document name, data type, and so on. To insert
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functions, right-click in the box, click Insert Function, and choose the appropriate function. Review the Using
Nuance Output Manager Functions help topic for information on configuring functions.

3. Choose the server you want to run the command.
4. Click OK.

To schedule output
Use this action to schedule documents to print at a specific date and time.

1. In the Perform the following actions box, click the <Action> link, and then click Schedule Output.
This opens the Schedule dialog box.

2. Set the appropriate Day option.
You can choose to print the documents today, on a specific day, or in the future.

3. Set the appropriate Time option.
You can choose to print as soon as possible, at a specific time, or in the future.

4. Click OK.

To send emails
Use this action to send email messages when specific events occur in the document life cycle.

1. In the Perform the following actions box, click the <Action> link, and then click Send Email.
This opens the Send Email dialog box.

2. In the Profile list, click the appropriate email profile.
You can also click the browse button (...) to open the Manage Outbound Email Profiles dialog box. This dialog
box lists all of the defined email profiles, so that you can use it to create, import, and export profiles, as well as to
manage all existing profiles. To create a new email profile, click New, and configure the email profile from the
Outbound Email Profile dialog box. When you are finished, click OK, and then click Close.

3. In the Send Email dialog box, select the Priority level of the email message.
You can select an importance level of low, normal, or high.

4. Enter the email addresses you want to be sent notifications in the To, CC, and Bcc boxes.
You can enter multiple email addresses separated by a comma.

5. In the Reply to box, enter an email address where replies will be routed.
You can enter multiple email addresses separated by the comma.

6. Enter the email Subject text.
7. In the Digest group, specify whether to send the notification messages for multiple events concatenated into one

email. To enable the digest feature, in the Send Digest list, choose from the following options:
Option Description

Every interval Sends the digest according to the time interval
specified. You will receive a message every interval,
even if no alerts were received during the interval.

At time interval Sends the digest according to the time interval
specified. The time interval will start when the first
notification messages is received. You will be notified
when at least one notification has been received.

Every hour Sends the digest every hour. You will receive a
message every interval, even if no alerts were received
during the interval.
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Option Description

Every half hour Sends the digest every half hour. You will receive a
message every interval, even if no alerts were received
during the interval.

If necessary, specify the Interval in minutes. In the Max Alerts box, you can specify the maximum number of
alerts to be included in the digest.

8. Enter the body text.
To insert document properties in the body text, right-click in the text box, click Insert Document Property,
and choose the appropriate properties. The values of the properties will display in the email message. To insert
functions, right-click in the box, select Insert Function, and choose the appropriate function. Review the Using
Nuance Output Manager Functions help topic for information on configuring functions.

9. Click Validate to validate the body text.
10. Click OK.

To set document owner
Use this action to configure the document owner.

1. In the Perform the following actions box, click the <Action> link, and then click Set Document Owner.
This opens the User and Group Selection dialog box.

2. Select the appropriate user or group in the grid.
If the desired user or group is not listed, click More Users to search for additional users.

3. Click OK.

To set document states
Use this action to set the state of documents to hold or ready.

1. In the Perform the following actions box, click the <Action> link, and then click Set Document State.
This opens the Set Document State dialog box.

2. In the list, click the appropriate document state, Hold or Ready.
3. Click OK.

To set retain periods
Use this action to determine how long documents will be retained.

1. In the Perform the following actions box, click the <Action> link, and then click Set Retain Period.
This opens the Set Retain Period dialog box.

2. Set the retain period.

• Use the Retain for options to retain documents for a specified time period. Time periods can be specified in
years, months, days, hours, and minutes.

• Use the Retain until options to retain documents until a specified date and time.
3. Click OK.

To unpackage documents
Use this action to separate multidocument packages into individual documents.

• In the Perform the following actions box, click the <Action> link, and then click Unpackage.

No additional configuration is required.



Output Manager Administration Guide
Version 4.0 SP2

291 © 2016 Nuance Communications, Inc. All rights reserved.

To add user information to documents
Use this action to add user information and a date to documents.

1. In the Perform the following actions box, click the <Action> link, and then click User Information Stamping.
The User Information Stamping dialog box opens.

2. In the Server list, click the licensed transform server that you would like to use.
3. In the Transform package list, you can select an existing transform package or create one.
4. In the Additional Parameters field, specify additional parameters needed for the transform.
5. In the Text to stamp field, do one of the following:

• Type the text to appear on the document.
• Right-click in the field and select Insert Other Property > Other Properties. Select a property from the

document.

You can use PCL, PDF, PS, and Plain Text files. Documents in other formats must be transformed into one of the
supported formats before this feature will work properly.

6. Configure the format and location of the text.
7. Click OK.

To add a watermark to documents
Use this action to add a watermark to indicate the status or security level of a document.

1. In the Perform the following actions box, click the <Action> link, and then click Watermarking.
The Watermarking dialog box opens.

2. In the Server list, click the licensed transform server that you would like to use.
3. In the Transform package list, you can select an existing transform package or create one.
4. In the Additional Parameters field, specify additional parameters needed for the transform.
5. You can use an existing watermark or create a new one. Do one of the following:

• In the Watermark/Stamp list, select one of the existing watermarks: Confidential, Do Not Copy, Draft, or
Internal.

• Click New. In the Create Resource dialog box, complete the fields for the new watermark. In the Import
Resource Data section, click Browse and select the file you want to use as a watermark.

You can use PCL, PDF, and PS files. Documents in other formats must be transformed into one of the supported
formats before this feature will work properly.

6. Click OK.

To create a new transform package
Use these steps to create a new transform package, when applicable to new business rules, instead of using an existing
one.

1. In the Transform Package section, click New.
This displays the General tab.

2. Enter the transform package Name.
3. Select the transform package type.
4. If you selected a third-party transform package, verify that the EXE path is set to the correct folder.

The default EXE path is @EOMTransformDir. To change the path, type in the box or click the browse button (...).
5. Set the Logging State.
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The logging state determines if transform logs and temp files will be saved in the document folder. By default,
the Logging State is set to Yes. All log files should be inspected during installation and pre-production testing to
insure that fonts are correctly mapped. In a production system, the logging can be disabled to save disk space. If
the transform operation returns an error (return code not zero), the log and temp files will not be deleted, and are
available for troubleshooting.

6. On the Filter Profiles tab, specify how the transform software will handle the formatting for each data type.

• To configure a profile, click the browse button (...) in the Modify/New column for the appropriate formats, and
then in the Configure Filter Profile dialog box, configure the profile as needed.

The profile contains a communications and printer definition section. For instructions on configuring a filter
profile, see Configuring a CpMillProfile resource.

• To select a profile, click in the Configuration column for the appropriate formats and select the profile from
the list.

7. On the Resources tab, specify where the transform software will find the resources needed for the transformation.
For example, PDF fonts are usually found at the location of an Adobe installation.

8. On the Fonts tab, you can control the font mapping of input fonts to output fonts.
The defaults are typically correct, but may need to be adjusted for special cases. You can add or modify fonts
directly in the grid.

9. Click OK to create the transform package.

Ad Hoc Rules
AdHoc rules run on user-selected documents that are spooled. Complete rules can be processed using conditions, or
just actions for unconditional processing. AdHoc rules can be scheduled.

Ad hoc rules are used for documents that exist in Nuance Output Manager, where business rules are used for
documents as they enter Nuance Output Manager. Ad hoc rules can be initiated by scheduling a task in the Schedule
Manager, by using the Run Now option in the Ad Hoc Rules Manager, or by running a configured rule in the
Documents grid or business rules. An example use for ad hoc rules is to merge a set of documents into a package.

AdHoc rules are built with the Rules Manager, which is opened by clicking Tools > AdHoc Rules on the menu bar.
Rules Manager has a complete list of how AdHoc rules can be used, Uses include modifying document contents,
assigning document ownership, routing documents, running business rules, and setting document state. AdHoc rules
can also be used to create and manage packages, which contain collections of documents.

• Manage ad hoc rules
• Create ad hoc rules
• Create ad hoc actions

How to Manage Ad Hoc Rules
This procedure provides the basic steps for managing ad hoc rules.

1. On the Output Manager Console menu bar, click Tools > Ad Hoc Rules.
This opens the Ad Hoc Rules Manager dialog box. In this dialog box, the ad hoc rules grid lists all of the defined
ad hoc rules in the order they will be processed. Selecting a rule will display the rule for preview below the grid.
To modify the rule, double-click the row.

2. Under the ad hoc rules grid, use the following procedures to configure rules.
To Do this

Create a rule Click Add. This opens the Ad Hoc Rule dialog box.
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To Do this

Modify a rule Select a rule and click Modify.

Delete a rule Select a rule and click Remove.

Create a copy of a rule Select a rule and click Copy. Then, to rename the new
rule, either double-click the rule or select the rule and
click Modify.

Reorder the rules Select a rule and click Move Up or Move Down.

Run a rule now Select a rule and click Run Now. On the menu that
displays, you can choose to run the rule against all
documents in the spool or against all newly received
documents since the last time the rule was run. The rule
will not be run against retained documents.

3. Click OK or Apply to save your changes.

How to Create Ad Hoc Rules
Use this procedure to create an ad hoc rule. You will configure conditions and actions.

1. On the Output Manager Console menu bar, click Tools > Ad Hoc Rules.
This opens the Ad Hoc Rules Manager dialog box.

2. Under the ad hoc rules grid, click Add.
This opens the Ad Hoc Rule dialog box.

3. Enter the Name and Description for the rule.
4. If you want to apply the rule to all documents, select the Always execute this rule (no conditions) check box.

This will disable the When box as no condition statements are needed. If you select this option, skip the steps for
configuring conditions.

5. Use the When box to create and manage the rule conditions. Multiple conditions can be created and organized
into groups. A blue box is used to indicate a condition group. To create a rule condition, perform the following
steps.
a) In the When box, click the <Target> link. Use the list to select the appropriate condition.
b) Click the Operation link and select the appropriate operation.
c) Click the Value link and select the appropriate value. This condition statement is now completed.
d) To include additional condition statements or create groups of conditions:

• Select a condition radio button (inside the box) to enable the Add Condition and Remove Condition
buttons for adding and removing condition statements.

• Select a group radio button (outside the box) to enable the Add Group and Remove Group buttons for
adding and removing groups. This will also enable the Add Condition button for adding a condition to the
selected group.

6. Under Perform the following actions box, use the following procedures to manage actions.
To Do this

Create an action Click the <Action> link and click one of the following
actions.

• Run Business Rules — Specifies if you want to run
business rules against input or output documents.
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To Do this
• Set Document Properties — Configures document

properties.
• Delete Document — Deletes documents.
• Set Priority in Group — Sets the priority (print

order) in a group.
• Assign to Document Folder — Assigns documents

to specific document folders.
• Document Owner — Configures the document

owner.
• Route to Destinations — Specifies the destinations

where documents should be sent.
• Document State — Sets the document state to hold

or ready.
• Create Package — Configures a package of

documents.
• Zip Package — Zips the merged document or any

other documents in Nuance Output Manager.
• Merge Package — Configures the document

properties of the merged file.

For more information about creating actions, see
Create Ad Hoc Actions.

Create additional actions Click Add Action.

Modify an action Click an action link or click the area next to the link,
and then click Modify Action.

Delete an action Click the area next to the link and click Remove
Action.

Reorder the actions Click the area next to the action link and click Move
Up or Move Down.

7. Move the actions to their appropriate position by clicking the area next to the action link and clicking Move Up or
Move Down.

The order of ad hoc rule actions is important, as the action behavior can depend on where it occurs in the sequence
of actions. By default the actions apply to the targeted documents. For example, if your rule contains a Create
Package action, the create package will act upon the targeted documents.

In contrast, actions that follow an action that produces documents, will apply to the produced documents. Using
the previous example, if following the Create Package action you have a Merge Package action followed by a
Set Document Properties action, a Set Document State action, and a Route to Destination action, the merge
package action will apply to the package created by the Create Package action, and the latter three actions will
apply to the resultant merged documents from the Merge Package action. If you had a Set Document Properties
action that preceded the Create Package action, it would apply to the original targeted documents.

8. Click OK to save your ad hoc rule.
9. You can run ad hoc rules using the following procedures.
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• Schedule a task to run the ad hoc rule using the Schedule Manager dialog box. For more information, see
Scheduling Tasks.

• Use the Run Now option in the Ad Hoc Rules Manager dialog box to run a selected rule.

You can run the rule against all documents in the spool or against all newly received documents since the last
time the rule was run. The rule will not be run against retained documents.

• In the Documents grid, select one or more documents, right-click, and then click Run Ad hoc Rule. You can
run any of the rules listed in the submenu.

Only rules with the Allowed for document right click option selected in the Adhoc Rule dialog box are
displayed in the menu.

• From business rules, configure the Run Adhoc Rule action. For more information, see Working with Business
Rules.

How to Create Ad Hoc Actions

You can create the following ad hoc rule actions.

• Run business rules
• Set document properties
• Delete documents
• Set the priority in a group
• Assign to document folder
• Set document owners
• Route to destinations
• Set the document state
• Create a document package
• Create a zip package
• Create a merge package

To run business rules
Use this action to determine if you want to run business rules against input or output documents.

1. In the Perform the following actions box, click the <Action> link, and then click Run Business Rules.
This opens the Run Business Rules dialog box.

2. Select if you want to run business rules against Input documents and/or Output documents.
3. Click OK.

To set document properties
Use this action to configure document properties.

1. In the Perform the following actions box, click the <Action> link, and then click Set Document Properties.
This opens the Document Properties dialog box.

2. In the grid, configure the document properties.
a) Expand the category of the property you want to configure.

The first node level in the category determines the print preferences for the properties it contains.
b) In the Mode column, select how the property should be applied when a document is sent to a destination. Click

in the grid cell and choose from the following options:

• Always Apply — Always applies the specified property value. Nuance Output Manager will add
commands to the print stream to enforce the print preference. If the document already contains commands
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for that print preference, Nuance Output Manager will modify the commands to work with the printer
family where the document is being sent.

• Apply Conditionally — Applies the property value conditionally. Nuance Output Manager will only add
or modify commands for the print preference when the printer family that the document is destined for is
different from the printer family the document was originally designed for.

• Informational Only — Nuance Output Manager makes no changes to the print stream when the document
is sent to the destination. The value is for informational purposes only.

c) In the Value column, specify the document property value.
You can use functions to insert and extract data as necessary. For more information, see Using Nuance Output
Manager Functions

The grid lists the property values that can be configured grouped in the following categories: Basic options, Media
selection, Document, Image adjustments, Finishing, and Other properties. To expand a category, click the down
arrow next to a category name. To collapse a category, click the up arrow.

3. Click OK.

To delete documents
Use this action to delete documents.

In the Perform the following actions box, click the <Action> link, and then click Delete Document.

No additional configuration is required.
To set the priority in a group
Use this action to set the print order when multiple documents are packaged together.

The order of the document properties set by this action determines the print order when sent to the destination.

1. In the Perform the following actions box, click the <Action> link, and then click Set Priority in Group.
This opens the Set Priority In Group dialog box.

2. In the Ordering properties list, select the properties that you want to determine the print order.
As you select properties, they are moved to the Selecting order list.

3. To reorder properties, select properties in the Selecting order list and click Move up and Move down.
4. Click OK.

Example package:

Doc 1: Priority 1 Total Pages: 5
Doc 2: Priority 2 Total Pages: 2
                

If Priority in Group is set to Priority (1st) and Total Pages (2nd), then the documents would print
in Doc 1, Doc 2 order. If Priority in Group is reversed and set to Total Pages, then the documents
would print in Doc 2, Doc 1 order.

To assign to document folder
Use this action to assign documents to specific document folders.

1. In the Perform the following actions box, click the <Action> link, and then click Assign to Document Folder.
This opens the Select Document Folder dialog box.

2. Select the appropriate folder in the tree.
3. Click OK.
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To set document owners
Use this action to configure the document owner.

1. In the Perform the following actions box, click the <Action> link, and then select Set Document Owner.
This opens the Set Document Owner dialog box.

2. You can determine the document owner from a user reference property.
To do this, select Calculate document owner from user reference property and select User, Group, or User or
Group.

3. To specify a default owner, click the browse button (...) and select appropriate the user or group from the User
and Group Selection dialog box.
If the desired user or group is not listed, click More Users to search for additional users.

4. Click OK.

To route to destinations
Use this action to specify the destinations where documents should be sent.

1. In the Perform the following actions box, click the <Action> link and click Route to Destination(s).
This opens the Select Destination dialog box.

2. In the tree, select destinations.
You can select multiple destinations by pressing the Ctrl or Shift keys and selecting destinations. Selecting a
destination group will select all destinations in that group.

3. In the list below the tree, choose whether to replace the destination already assigned to the document or use
multiple destination routing and add to the destination already assigned to the document.

4. Click OK.

A new routing action is shown in the actions box. The action lists all of the selected destinations.
To set the document state
Use this action to set the state of documents to hold or ready.

1. In the Perform the following actions box, click the <Action> link, and then click Set Document State.
The Set Document State dialog box displays.

2. From the list, click the appropriate document state, Hold or Ready.
3. Click OK.

To create a package of documents
Use this action to create a package of documents. This will take all of the documents that meet the criteria and put
them in a multiple document package.

1. In the Perform the following actions box, click the <Action> link, and then click Create Package.
This opens the Create Package dialog box.

2. Enter the Naming prefix for the package document.
This prefix will be added to all packages created by this action. The naming prefix is especially useful when the
create package action will be run by a scheduled rule. Each time the rule runs and generates a new package, the
prefix will added. If you have multiple scheduled rules running that generate different packaging, you will be able
to distinguish the resulting packages based on the original rule. It does not prefix any documents contained within
the packages.

3. If you want to package documents based on document properties, click Grouping property, and then in the drop-
down list, select the property to group by.
For the selected property, documents are grouped into packages by each unique value of that attribute. For
example, you selected Form Name for grouping and you have 20 documents that are being packaged. In
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the documents, 3 have the value of "Form-A", 5 are "Form-B", 10 are "Form-C", and 2 are "Form-X". Once
packaged, you will end up with 4 packages, 1 for each unique form type. All "Form-A" documents will be in their
own package, "Form-B" documents in their own package, and so forth.

4. In the Ordering properties list, select the document properties that will control the order the documents are
packaged. As you select properties, they display in the Selected order list.

Note:  Only the allowed properties selected in the Configure Document Properties Utility will display in
the Ordering properties list.

5. Select properties in the Selected order list and use the Move up and Move down buttons to configure the
property order.

6. Use the following options to configure the closing conditions for the package. This will determine when the
package is complete. You can configure one or more closing conditions.

Option Description

Closing document Select this option to close the package once the
specified closing content is received. In the Closing
document action box, choose if you want to remove
the closing content, add it to the current page, or add
it to the next page. In the When box, configure the
conditions for specifying the content.

Time elapsed since package creation Select this option to close the package when a specified
amount of time has elapsed since the package was
created (the first document was added to the package).
Specify the time period using the options next to
Elapsed time.

Time elapsed since last match Select this option to close the package every period
of time specified. Specify the time period using the
options next to Elapsed time.

Specific time of day has occurred Select this option to close the package at a specified
time each day. Use the Time of day spin box to specify
the time.

Auto close (For "Run Now" or
document right-click configuration)

Select this option to close the package (or packages
when grouping) when the last target document has been
packaged by the action.

Important:  This option is used for running an ad hoc rule using the Run Now button on the Ad Hoc
Rules Manager dialog box, or when right-clicking a document in the Documents grid and selecting a rule
from the Run Ad hoc Rule submenu.

7. Click OK.

To create a zip package
Use this action to zip the merged document or any other document in Nuance Output Manager.

1. In the Perform the following actions box, click the <Action> link and select Zip Package.
This opens the Zip Package dialog box.

2. Enter the Zip File Name in the box.
3. If this rule will be used after all documents have been received into Nuance Output Manager, select Used as a

post-processing action.
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4. Determine what will happen to the Original documents after the zipped file has been created.
You can leave them in the spooler, move them to retain, or delete them.

5. Click OK.

To create a merge package
Use this action to create a merged file. You can use this action after creating a package to merge all of the documents
in to a single document.

1. In the Perform the following actions box, click the <Action> link, and then click Merge Package.
This opens the Merge Package dialog box.

2. Next to Transform, click the Configure button to configure the transform.
This opens the Configure Transform dialog box.

3. In the Server list, click the licensed transform server that you would like to use.
4. In the Transform package list, you can select an existing transform package or create one. Complete the

following steps to create a transform package.
a) Click New.

This opens the General tab.
b) Enter the transform package Name.
c) Select the transform package type.
d) If you selected a third-party transform package, verify that the EXE path is set to the correct folder.

The default EXE path is @NSiTransformDir. To change the path, type in the box or click the browse button
(...).

e) Set the Logging State.
The logging state determines if transform logs and temp files will be saved in the document folder. By default,
the Logging State is set to Yes. All log files should be inspected during installation and preproduction testing
to insure that fonts are correctly mapped. In a production system, the logging can be disabled to save disk
space. If the transform operation returns an error (return code not zero), the log and temp files will not be
deleted, and are available for troubleshooting.

f) On the Filter Profiles tab, specify how the transform software will handle the formatting for each data type.

To Do this

Configure a profile Click the browse button (...) in the Modify/New colu
mn for the appropriate formats. From the Configure
Filter Profile dialog box, configure the profile a
s needed. The profile contains a communications
and printer definition section. See Configuring a
CpMillProfile resource for instructions on configurin
g a filter profile.

Select a profile Click in the Configuration column for the appropriat
e formats and select the profile from the list.

g) On the Resources tab, specify where the transform software will find the resources needed for the
transformation.
For example, PDF fonts are usually found at the location of an Adobe installation.

h) On the Fonts tab, you can control the font mapping of input fonts to output fonts.
The defaults are typically correct, but may need to be adjusted for special cases. You can add or modify fonts
directly in the grid.
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i) Click OK to create the transform package.
5. Use the Override input filter profile assigned to document check box option to determine if you want to

override the input filter profile assigned to the document or if you want to use the filter profile configured in the
transform package. Select the check box to use the filter profile in the transform package.

6. In the Output format list, click the format of the output file.
7. Configure the conversion of each input format in the Input formats grid, and then click OK.

• For all unlicensed input formats and any input formats you don't want to use, click in the Configuration
column and select Do Not Transform.

• For licensed input formats, you can select Use Default Options or select a predefined configuration in the
Configuration column. To configure a custom input format, click the ellipsis button in the Modify/New
column. If Use Default Options or Do Not Transform is selected in the Configuration column, a new
configuration will be created. If a predefined configuration is selected, that configuration will be modified. The
custom transform options are configured on the Input options tab, Output options tab, and Page Layout tab.
If BMP or PDF is selected as the output format, the Bitmap output tab or PDF output tab will also display.

8. When the transform configuration is complete, click OK.
The Merge Package dialog box indicates the transform has been configured.

9. Complete the following steps to configure Package boundaries.
a) Select Package boundaries and click Configure.

This opens the Package Boundary Fields dialog box.
b) From the grid, expand the sections to select the document properties that will be used as package boundaries.
c) Click OK.
Boundary fields are only applicable when a merged document will exceed the maximum number of exceptions
(currently set at 1000). Merged documents that exceed the exception count will be split into separate documents.
Boundary fields are used to control where the merged documents will be split. Each split will be on a boundary
that maximizes the number of pages without exceeding the exception threshold. If you do not specify boundary
fields, the split is arbitrary and will occur where the maximum number of pages can be fit.

10. Under Merged Document Properties, determine if you want to use the document properties from the first page in
the documents or the last page in the documents.
Selecting custom properties is not yet available.

11. Complete the following steps to configure Exception fields.
Exception fields specify which document properties to preserve on a per-page basis in the merged document. The
document properties will be analyzed to determine the baseline and the exceptions (page overrides).
a) Select Exception fields and click Configure.

This opens the Exception Fields dialog box.
b) From the grid, expand the sections to select the document properties that will be used as exception fields.
c) Click OK.
Exception fields specify which document properties to preserve on a per-page basis in the merged document. The
document properties will be analyzed to determine the baseline and the exceptions (page overrides).

12. Determine if you need to Add blank pages for duplexing. This will cause documents to always start on an odd
page number.

13. Determine what will happen to the Original documents after the merged file has been created. You can leave
them in the spooler, move them to retain, or delete them.

14. Click OK.
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Alert Rules

Administrators can create alert rules for configuring alert options when certain events happen. This is particularly
useful for monitoring printer states. Using alert rules, support personnel can be automatically notified when printers
have conditions that could prevent end user printing.

• Create alert rules
• Manage alert rules

How to Create Alert Rules
This procedure demonstrates how to create an alert rule and to configure conditions and actions.

1. From the menu bar click Tools > Alert Rules.
This opens the Alert Rules Manager dialog box.

2. Under the alert rules grid, click Add.
This opens the Alert Rule dialog box.

3. Enter a rule Name and Description.
4. Select or clear the Enabled check box to determine whether the rule is enabled or disabled
5. Use the following steps to create a rule condition from the Whenbox. You must select values for all definitions to

save the rule.
a) In the Destination State statement, click the <Values> link.
b) In the Select Alert dialog box, expand the SNMP Device Alerts tree and the Destination Alerts tree and

select the options that the alert rule should perform the actions on.
Selecting a section will select all conditions it contains.

c) In the Destination statement, click the <Values> link.
d) In the Select Destination dialog box, click the appropriate destination in the tree.

Press Ctrl or Shift while you click to select multiple destinations.
e) In the Fault statement, click the link and choose between the Occurs and Behavior options.

• Occurs — The action will be executed when the fault occurs. The fault condition will not be evaluated.
This is the default selection

• Behavior — This displays a <Values> link. Click the link to configure the fault behavior. From the Fault
Behavior dialog box, configure whether the behavior that triggers the rule action is active for the time
period chosen, or if the fault behavior is repeated so many times before the rule action is fired. If you do
not want this level of granularity for the fault condition, select the Occurs behavior.

f) In the Remainder interval statement, click the link to configure the reminder interval on the Notification
Reminder dialog.
This allows you to repeat the action over a period of time. If you want the action to only send the notification
once, set the value for the notification reminder interval to 0 and the value will change to None. The default
reminder interval is None.

6. Use the following steps to create a send email rule action.
a) In the Perform the following actions box, click the <Action> link and select Send Email.

This opens the Send Email dialog box.
b) Select a Profile from the list.

You can also click the browse button (...) to display the Manage Outbound Email Profiles dialog box. This
dialog box lists all of the defined email profiles. From this dialog box you can create, import, and export
profiles, as well as manage all existing profiles.

c) To create a new email profile, click New.
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d) Configure the email profile from the dialog box. When you are finished, click OK, and then Close.
e) In the Send Email dialog box, enter the email address you want to be sent notifications in the To, CC, and Bcc

boxes.
You can enter multiple email addresses separated by a comma.

f) In the Reply to box, enter an email address where replies will be routed.
You can enter multiple email addresses separated by a comma.

g) Enter the email Subject text.
h) Under Digest, you can enable the digest feature by choosing one of the following options in the Send Digest

list:

Option Description

Every interval Sends the digest according to the time interval specifi
ed. You will receive a message every interval, even if
no alerts were received during the interval.

At time interval Sends the digest according to the time interval specifi
ed. The time interval will start when the first notificat
ion messages is received. You will be notified when a
t least one notification has been received.

Every hour Sends the digest every hour. You will receive a mess
age every interval, even if no alerts were received du
ring the interval.

Every half hour Sends the digest every half hour. You will receive a
message every interval, even if no alerts were receive
d during the interval.

If necessary, specify the Interval in minutes. In the Max Alerts box, you can specify the maximum number of
alerts to be included in the digest.

i) Enter the body text.
To insert document properties in the body text, right-click in the text box, click Insert Document Property,
and choose the appropriate properties. The values of the properties will display in the email message. To insert
functions, right-click in the box, click Insert Function, and choose the appropriate function. Review the Using
Nuance Output Manager Functions help topic for information on configuring functions.

j) Click Validate.
k) Click OK.

7. You can create, organize, and remove rule actions using the buttons below the actions box.
8. From the Follow-on Action list, click the action you would like to take after this rule has been processed. You can

continue processing rules or select not to process any additional rules.
9. Click OK to save your alert rule.

How to Manage Alert Rules
This procedure provides the basic steps for managing alert rules.

The alert rules grid lists all of the defined alert rules in the order they will be processed. Selecting a rule will display
the rule for preview below the grid.

1. On the Output Manager Console menu bar click Tools > Alert Rules.
This opens the Alert Rules Manager dialog box.
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2. Perform the following tasks to edit the rules grid.
To Do this

Enable or disable a rule • Select or clear the check box in the Enabled 
column.

Change the follow-on action • Click in the Follow-on Action cell and select the
action you would like to take after this rule has been
processed.

You can continue processing rules or select not to
process any additional rules.

3. In the alert rules grid, perform any of the following tasks to add, remove, modify, copy or reorder alert rules.
To Do this

Create a rule • Click Add.

This opens the Alert Rule dialog box. For more
information about creating rules, see Create Alert
Rules.

Modify a rule • Select a rule, and click Modify.

Delete a rule • Select a rule and click Remove.

Create a copy of a rule 1. Select a rule and click Copy.

This creates a copy of the selected rule.
2. Click in the Name cell of the copied rule to rename

it.

Reorder the rules • Select a rule and click Move Up or Move Down

4. Click OK or Apply to save your changes.

Error Handling Rules
Error handling is controlled using Error Handling Profiles, which can be assigned to any destination to define the
behavior in the event of errors occurring at the destination.

When an error at the destination occurs during document processing, or if the destination is determined to be in an
error condition (for example, SNMP reports paper), error processing can result in the destination being placed offline
and, if so configured, for any documents routed to that destination to undergo failover processing.

Error handling is configured on the Error Handling tab of the Destination Configuration dialog box.

Failover Rules
Failover rules control how to automatically switch to a different destination when errors occur.

Failover profiles are created with the Failover Profile dialog box, which is accessed by clicking on the More
Settings tab of the Destination Configuration dialog box.
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A failover profile can be assigned to a document at the source, or using business rules. In the absence of a profile
assigned to the document, the default failover profile can be used.

The default failover profile places a document in an error state after all retries fail. You can add and configure a
failover profile to route the document to a destination. The follow options are available for configuring a failover
profile:

• Place a document in error state.
• Reroute a document to the default failover group of the failing destination.
• Reroute the document to a specified location.
• Reroute the document to a destination in a specified property.

Using Output Manager functions

Nuance Output Manager functions are used to insert information into a document property. The @parse,
@dateTimeToString, @schedule, and @stringToDateTime functions allow you to extract data from a document
property and insert it into another document property.

Review the following table for a description of each function. Click the links for steps on how to configure each
function.

Function Description

@dateTimeToString Converts a date/time (usually from another document pro
perty) to a string.

@lookupCsv Looks up the value for a property in a CSV file.

@parse Extracts data from a document property.

@schedule Inserts a time into a document property.

@stringToDateTime Converts a string (usually from another document proper
ty) to a date/time value.

@Counter Specifies the name format for newly created burst docum
ents.

How to Configure the @dateTimeToString Function
This function converts a date/time (usually from another document property) to a string.

Use this procedure to configure the @dateTimeToString function. This function converts a date/time to a string
in the format specified. This string will be inserted in the document property you are configuring.

1. Right-click in the appropriate document property, and then click Insert Function > @datetimeToString.
This opens the @DateTimeToString dialog box.

2. In the FieldSource box, specify the document property that contains the date/time string you want to insert.
a) Right-click in the box.
b) Click Insert Document Property.
c) Select the document property from the list.

3. In the Format box, enter the format the date/time string will use when it is inserted into the document property.
See the Format grids for descriptions of the available formats.

4. In the Culture box, specify the culture name of the data in the document.
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The default is the current culture of the computer where the Nuance Output Manager Console is running. When
culture is not specified, the culture independent CultureInfo.InvariantCulture is used.

5. Click OK.
The function is inserted into the document property using the following format:

@dateTimeToString([FieldSource],"Format",Culture)

How to Configure the @lookupCsv Function
This function looks up the value for a property in a CSV file.

Use this procedure to configure the @LookupCsv function. This function looks up the value for a property in a
comma separated values file. The value will be inserted in the document property you are configuring.

1. Right-click in the appropriate document property and click Insert Function > @lookupCsv.
This opens the @LookupCsv dialog box.

2. Select how you want to locate the CSV file. You can use one of the following options:
Option Description

Path Enter the path and file name of the CSV file, or click
the browse button (...) to navigate to the file.

Resource Select the appropriate resource from the list, or click
the browse button to choose the resource in the
Manage CsvDocProp Resources dialog box. If you
are using a resource, CsvDocProp: will be inserted
before the resource name.

3. In the Lookup data box, specify the data you are looking up. This could be data from another document property
or the results of a @parse function.

To Do this

Select a document property Right-click in the box, click Insert Document
Property, and then select the appropriate property from
the list.

Use the results of a @parse function Right-click in the box, click Insert Function, and then
@parse() from the list.

Configure the @parse function using the @Parse
dialog box.

4. In the Key column name box, enter the column name in your CSV file where Nuance Output Manager should
look for a value that matches the data you entered in the Lookup data box.

5. In the Data column name box, enter the column name in your CSV file that contains the value you want inserted
into the document property.

6. Click OK.
The function is inserted into the document property using the following format:

@lookupCsv("path/resource",lookup data,key column name,data column name)
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How to Configure the @parse Function
This function extracts data from a document property.

Use this procedure to configure the @parse function. The parse function is used to extract data from a document
property (such as Document Name). The parse function will extract data using character offset (specifying a
beginning position and length), single delimiters (specify just the starting delimiter, it will be used as the only
delimiter, field number, and length), and double delimiters (specifying a starting delimiter, ending delimiter, field
number, and length). When you create a business rule action to set document properties, the parsing command should
be entered in the appropriate Value cell in the Document Properties dialog box.

1. Right-click in the appropriate document property, and then click Insert Function @parse.
This opens the @Parse dialog box.

2. Right-click in the FieldSource box, click Insert Document Property, and select the document property from
which data will be extracted.
The document property will appear in brackets in the field source box.

3. Determine if you want to extract data using character offset or double delimiters. Complete the steps in the
appropriate section below.

• Extract using character offset
• Extract using delimiters

To extract using character offset

1. Select Field.
2. In the Position box, specify the first position of the string to be extracted.

The first character of source data is indicated by specifying a 1.
3. In the Length box, specify the length of the string to be extracted.

If the length specified is zero (0) or if the length is greater than the remaining data, then all data to the last
character will be used.

4. Click OK.

The function is inserted into the document property using the following format:

@parse([FieldSource], "delimiter", field number, length)
@parse([
                  FieldSource
               ], "starting delimiter", "ending delimiter", field number, le
ngth)
                

Example extraction using character offset

Data: PRINT100STD0C

Command Result

@parse(documentName,1,8) PRINT100

@parse(documentName,9,4) STD0

@parse(documentName,13,0) C
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To extract using delimiters

1. Select Delimited List.
2. In the Starting delimiter box, specify the character that marks the beginning of the string. If a comma or

backslash is used as the first character of the delimiter, then a backslash must precede the delimiter in the
command. For example, a backslash delimiter will be shown in the command as \\.

3. In the Ending delimiter box, specify the character that marks the end of the string. If a comma or backslash
is used as the first character of the delimiter, then a backslash must precede the delimiter in the command. For
example, a backslash delimiter will be shown in the command as \\. If there is only one delimiter, this field can be
left blank.

4. In the Field number box, specify the position of the field that will be extracted. (1 refers to the first field, 2 to the
second, and so on.)

5. In the Length box, specify the length of the string to be extracted. If the length specified is zero (0) or if the length
is greater than the remaining data, then all data to the last character will be used.

6. Click OK.

The function is inserted into the document property using one of the following formats:

@parse([FieldSource], "delimiter", field number, length)
@parse([FieldSource], "starting delimiter", "ending delimiter", field numbe
r, length)
                

Example extraction using delimiters

Example

Data: CJ,P038,FC=6,F=OCR1,ID=J0006600,ACCOUNT=DC

Command Result

@parse(documentName, \,F=, \,, 1
, 0)

OCR1

@parse(documentName, \,ACCOUNT=,
\,, 1, 0)

DC

@parse(documentName, \,P, \,, 1,
10)

038

How to Configure the @schedule Function

Use this procedure to configure the @schedule function. This function inserts the configured schedule into a string
or date/time document property. Note, that you are not scheduling a document. You are just configuring a date/time
using a schedule. The date/time string will be inserted in the document property you are configuring.

1. Right-click in the appropriate document property and click Insert Function @schedule.
This opens the Schedule dialog box.

2. Set the appropriate Day option.
3. Set the appropriate Time option.



Output Manager Administration Guide
Version 4.0 SP2

308 © 2016 Nuance Communications, Inc. All rights reserved.

4. If you are inserting the schedule into a document property with a string type, you must also configure the
following:
a) In the String format box, enter the format the date/time string will use when it is inserted into the document

property.
See Format grids for descriptions of the available formats.

b) In the Culture box, specify the culture name of the data in the document. The default is the current culture of
the computer where the Nuance Output Manager Console is running. When culture is not specified, the culture
independent CultureInfo.InvariantCulture is used.

5. Click OK.

The function is inserted into the document property using one of the following formats:

For date/time properties: @scheduleDateTime(daytype,dayvalue,timetype,timevalue,,)

For string properties: @scheduleString(daytype,dayvalue,timetype,timevalue,format,cultu
re)

How to Configure the @stringToDateTime Function
This function converts a string (usually from another document property) to a date/time value

Use this procedure to configure the @stringToDateTime function. This function converts a string to a date and
time in the format specified. The string could be an extracted variable or another document property. This function
inserts the configured date/time into a date/time document property.

1. Right-click in the appropriate document property and click Insert Function > @stringToDateTime. This opens
the @StringToDateTime dialog box.

2. In the FieldSource box, specify how you want to retrieve the date/time that will be inserted in the document
property. You can do this using one of the following methods:

Method Description

FieldSource Right-click in the box, click Insert Document
Property, and select the document property from the
list.

Output Variable Right-click in the box, click Insert Variables, and
select the output variable from the list. You can also
enter the output variable directly in the box. The
variable must be surrounded with curly braces {}. The
output variables are from an Advanced Document
Modification rule or an extraction variable from an
extract rule (line mode or page mode) or burst rule (line
mode or page mode).

3. In the Format box, enter the format the date/time string will use when it is inserted into the document property.
See Format grids for descriptions of the available formats.

4. In the Culture box, specify the culture name of the data in the document.
The default is the current culture of the computer where the Nuance Output Manager Console is running. When
culture is not specified, the culture independent CultureInfo.InvariantCulture is used.

5. Click OK.

The function is inserted into the document property using one of the following formats:

@stringToDateTime(FieldSource,Format)
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@stringToDateTime(FieldSource,Format,Culture)
@stringToDateTime({OutputVariable},Format)
@stringToDateTime({OutputVariable},Format,Culture)

How to Configure the @counter Function
This function specifies the name format for newly created burst documents.

Use this procedure to configure the @counter function. This function allows you to specify the name format for
newly created burst documents. When you use the @counter function, you will get the file name with the counter
appended.

The following restrictions apply for the @counter function:

• The @counter function can be used only when configuring a business rule to burst using page mode.
• The @counter function can be entered only in the Document Name property.
• The @counter function is meant to be used by itself. It cannot be used in combination with other variables.

Note:  You cannot add variable data with a counter appended using the @counter function. To do this,
perform the following workaround: First, set the variable data in another field. Then, in a follow on rule
action, use the @parse function combined with the other field to create the document name desired.

1. Right-click in the Document Name property, and then click Insert Function > @counter.
This opens the @Counter dialog box.

2. Specify the Counter length.
3. Specify the Separator you want to use.
4. Click OK.

The function is inserted into the Document Name property using the following format:

@Counter(counter length,separator)

Example

If you burst MyDoc into 5 new documents and you specified @Counter(3,#) in the Document
Name property, the documents would be named as follows:

MyDoc#001
MyDoc#002
MyDoc#003
MyDoc#004
MyDoc#005

Using the Data Conversion Utility
Complete this procedure to convert data formats.

Note:  Most users will not have to convert data formats. If you think this conversion is necessary, please
contact Nuance Support to ensure the data is converted properly.

To convert data formats, you must create a DCO (Data Conversion Object) chain. DCO chains consist of an input
format and an output format. The available output formats vary depending on the input format selected. You can also
set specific DCO parameters depending on your needs.

1. Open the Data Conversion Utility.
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Open Windows Explorer and navigate to the C:\Program Files\NSi\Output Manager folder. Double-
click EomBackupDatabase.exe.

2. Click Select Chain.
This opens the Select DCO Chain dialog box.

3. Select the Input format and Output format from the drop-down lists, and click OK.
Pairing an input format with an output format creates a chain. This chain is displayed in the Current chain box.
The DCOs available for each format are displayed in the Registered DCOs box. Refer to the DCO descriptions
table for a description of each DCO.

4. Under Registered DCOs, select the DCOs you want to add, and then click >.
This will add the selected DCOs to the Current chain box. If necessary, you can import DCOs to appear in the
Registered DCOs box. Click Import and navigate to the appropriate .dll file. This file will be copied to the
DCO Library folder.

5. To remove DCOs, under Current chain, select the DCOs you want to remove, and then click <.
6. Click Move Up and Move Down to modify the processing order.
7. Click Save As to save your changes to the chain.

This opens the Save As  dialog box.
8. To create a new chain, click Create new chain and type an Output format name.

The chain will be saved using the displayed Input format and the specified Output format. To overwrite the
existing chain, click Replace existing chain. Click Save. If you overwrite an Nuance Output Manager default
chain, the default will be modified and all jobs using that chain will be affected. Typically, you will save your
changes to a new chain. You can reapply all of the default settings by clicking Restore Defaults. Restoring the
defaults will not change any new chains you have created.

9. Set DCO parameters as necessary.
Parameter changes will be saved to the active chain.

10. Verify that you have the appropriate chain open before you modify your parameter settings.
a) Click Set Parameters.

This opens the Initialization Parameters dialog box.
b) Under Chain selection, verify that the appropriate chain is selected. If the chain selection is incorrect, click

Cancel and select the correct chain.
c) Click Add to add a new parameter, or click Modify to modify an existing parameter.

This opens the Parameter Settings dialog box.
d) Select an existing parameter Name from the drop-down list, or type a new name.

Refer to the DCO Parameters table for a description of the parameters and their appropriate values and types.
e) Enter the parameter Value.
f) Select the parameter Type from the drop-down list.

If you select an existing parameter Name, this value will be selected for you.
g) Click OK.

This will save your parameter settings to the active DCO chain. To save you changes to a new chain, you must
open the new chain and then reapply your parameter changes.

DCO Descriptions

Name Description Parameters

Afp2PRRDCO Receives AFP data and wraps it
in the PRR format. This process

NONE
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Name Description Parameters

is usually the first step during a
conversion of AFP data when using
DCOs.

ASA2PRRDCO Receives data in ASA carriage
control format and converts it to
Printer Ready Record format.

DCO_ULONG_CP_CURRENT

ASA2noFFPRRDCO The ASA2PRRnoFF DCO ignores
single form feed characters (0x0C)
as record delimiters. With BEPS
version 3.0 and later, any form or
combination of valid CC is treated as
a record delimiter, but this DCO can
be used to replicate the processing
that BEPS performed prior to version
3.0.

DCO_ULONG_CP_CURRENT

Ascii2DosAsciiDCO Takes an ASCII file and treats 0x1A
as an EOF marker. All data after the
0x1A character is ignored.

NONE

Ascii2PRRDCO Receives ASCII data and converts it
to PRRs. This DCO also handles the
1F format (non-DEC).

DCO_BOOL_ASCII_V_FORMAT

DCO_ULONG_CPIN

AsciiDec2PRRDCO Receives ASCII format data with
inline DEC format information.
Converts to PRR. Allows multiple
in-line 1F commands in a single
record.

DCO_ULONG_CPIN

DCO_ULONG_CPOUT

Binary2CompressDCO Accepts binary data and compresses
it.

DCO_ULONG_COMPRESS_LEVEL

DCO_BOOL_COMPRESS

Binary2CompressPRRDCO Accepts binary data and compresses
it, returning PRR records.

DCO_ULONG_COMPRESS_LEVEL

DCO_BOOL_COMPRESS

Binary2EncryptPRRDCO Accepts binary data it is provided
and encrypts it using the cipher key
created by the user in the registry.
The AES Rijndael cipher protocol is
used. The DCO reads the cipher key
from the Registry based on the key
name provided.

DCO_STRING_KEY_NAME

DCO_BOOL_ENCRYPT
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Name Description Parameters

Binary2HostDCO Receives binary data (any data that
is not identified as being some other
format) and converts it to records
in the host format (NJE-wrapped
records). This is the standard format
for data in the Output Manager Print
Server spool.

DCO_ULONG_LRECL

Binary2PRRDCO Wraps portions of binary data in the
PRR record format.

DCO_ULONG_LRECL

BinaryProgramBinaryDCO Accepts binary data and sends the
data to an external program via a
named pipe. Data generated by the
external program is received via a
second named pipe, and outputted
to the rest of the DCO chain. Allows
external programs to process data,
in the same manner as JES exits.
Possible uses include normalizing
data on input and encryption
programs.

DCO_STRING_PROGRAMPATH

DCO_STRING_PROGRAMPARAMETERS

DCO_STRING_PROGRAMFOLDER

DCO_BOOL_PROGRAMHANDLES

CodePage2CodePageDCO Receives PRRs and converts the data
from the given input code page to the
given output code page. If the record
is determined to be ASA (from the
SRCB), the CC byte is converted.
The output records are in the PRR
record format.

DCO_ULONG_CPIN

DCO_ULONG_CPOUT

DCO_ULONG_CP_CURRENT (*)

CodePage2UnicodeDCO Receives PRRs and converts the data
from the given input code page to
Unicode. The output records are in
the PRR record format.

DCO_ULONG_CP_CURRENT

DCO_ULONG_CPIN

DCO_UNICODE_DATA (*)

Compress2DecompressDCO Accepts binary compressed data, and
decompresses it. The compressed
file needs to be in the gzip (.gz)
compression format.

DCO_BOOL_DECOMPRESS

Decrypt2BinaryDCO Accepts encrypted binary data it is
provided and decrypts it using the
cipher key created by the user in the
registry. The AES Rijndael decipher
protocol is used. The DCO reads the

DCO_STRING_KEY_NAME

DCO_BOOL_DECRYPT
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decipher key from the Registry based
on the key name provided.

File802DSDCO Takes records of File80 data wrapped
in the PRR record format and
converts them to data records in the
form specified in the File80 header.
The resulting records are delimited
by the PRR format.

DCO_ULONG_CP_CURRENT

DCO_ULONG_CPIN

DCO_ULONG_CPOUT

DCO_BOOL_VALID_FILE80_DATA

DCO_FILE80_FILENAME

Fixed2PRRDCO Takes input records of a fixed length
and converts them to Printer Ready
Record format. This involves adding
the PRR header to the beginning of
the record.

DCO_STRING_CCTYPE

DCO_ULONG_FIXEDREC

Host2PRRDCO Converts data in the host format
(NJE-wrapped data from theOutput
Manager Print Server spool) to
Printer Ready Records (PRR). This
is usually the first DCO in an output
conversion chain.

DCO_ULONG_CPIN

Host2TruncDCO Provides Blank truncation for Host
mode records.

DCO_ULONG_CP_CURRENT

DCO_ULONG_CPIN

IBM2PRR Receives data in the IBM standard
record format and produces Printer
Ready Records (PRR). The IBM
record format consists of a 2 byte
length word in little Endian format
followed by a carriage control byte
and the actual data. This format is
also recognized by XEROX EPS
printers.

NONE

Interpress2PRRDCO Reads records in Interpress format
and converts them to PRR.

NONE

IRS2HOSTDCO Converts RJE Punch data to Host
(NJE) record format with no carriage
control.

DCO_BOOL_MCC_IN_DATA

DCO_ULONG_MAX_PRINT_POSITION

LPS2PRRDCO Read LPS format records and
converts them to PRR.

NONE
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Machine2P390DCO Wraps PRR records with an
additional PRR header so the records
can be sent directly from the SOP to
the Output Manager 390 port. This
needs to be done because the Output
Manager 390 port is expecting PRR
wrapped records.

DCO_BOOL_CONDITIONAL_START_PB

DCO_BOOL_CONDITIONAL_END_PB

DCO_BOOL_PAGE_DIRTY_FLAG

DCO_BOOL_BINARY_DATA

DCO_BOOL_3800_PRINTER

DCO_BOOL_3800_TRC_ENABLED

DCO_ULONG_SEND_FCB

DCO_STRING_FCB

DCO_BOOL_PAGE_DIRTY_FLAG
(*)

Mixed2ASADCO Receives Printer Ready Records and
converts them into Printer Ready
Records with ASA carriage control.
The input records can have machine,
ASA, or no carriage control.

DCO_BOOL_MARK_INSERTED_RECS

DCO_ULONG_CP_CURRENT

DCO_ULONG_CPIN

Mixed2MachineDCO Receives Printer Ready Records and
converts them into Printer Ready
Records with machine carriage
control. The input records can
have machine, ASA, or no carriage
control.

DCO_BOOL_MARK_INSERTED_RECS

DCO_ULONG_CP_CURRENT

DCO_ULONG_CPIN

Mixed2NoCCDCO Removes carriage control from PRR
Records. Records which are only
carriage control are deleted.

NONE

PRR25ATruncateDCO Truncates trailing blanks from
records with and without 5A carriage
control. If the record does not contain
a 5A carriage control, all trailing
blanks are truncated on the record. If
the record does contain a 5A carriage
control, trailing blanks are truncated
up to the length specified in the 5A
record. The length bytes in the 5A
record are the 2 bytes immediately
following the 5A byte. The Printer
Ready Record length bytes will
be adjusted in accordance with the
truncation performed.

DCO_ULONG_CP_CURRENT

DCO_ULONG_CPIN
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PRR2AddDelimDCO Add the specified delimiter to PRR
record.

DCO_STRING_FIXREC_DELIM

PRR2AsciiDCO Converts data to PRR wrapped
ASCII records with ASCII carriage
control. FCB is used to insert page
breaks when the number of lines
per page is exceeded. If pagination
is disabled then page breaks are
not inserted based on the FCB.
Conditional page breaks are also
inserted at the beginning and end of
the data based on the page dirty flag
and conditional page break settings.

If the output is optimized then a FF
(0x0C) will be used to get to top of
form when a page break is inserted.
Otherwise the required number of
CR LFs (0x0D0A) will be used.

DCO_STRING_FCB

DCO_BOOL_PAGINATE

DCO_BOOL_OPTIMIZE

DCO_BOOL_CONDITIONAL_START_PB

DCO_BOOL_CONDITIONAL_END_PB

DCO_BOOL_PAGE_DIRTY_FLAG

DCO_BOOL_PAGE_DIRTY_FLAG
(*)

PRR2AsciiAsaDCO Returns PRR wrapped ASA records
with CRLF delimiters. Source data
must be all ASA.

NONE

PRR2AsciiRecordDCO Returns PRR wrapped ASCII data
with CRLF delimiters. All ASA and
Machine carriage control is stripped.

NONE

PRR2BinSearchReplaceDCO Searches for all occurrences of either
text or binary data in a data stream
and replaces those occurrences with
a replacement string or replacement
binary data. The data must be
delimited by the Printer Ready
Record (PRR) format.

DCO_BOOL_SEARCH_STRING_MODEn

DCO_STRING_SEARCHn

DCO_STRING_REPLACEn

DCO_BOOL_REMOVE_RECORDn

PRR2CDPXFRMDCO DCO Interfaces with CDP
transformation package. It returns
binary data wrapped with PRR
headers.

DCO_STRING_PAGE_RANGE

DCO_STRING_INPUT_FORMAT

DCO_STRING_OUTPUT_FORMAT

DCO_STRING_CONFIG_FILE

PRR2CondPageBreakDCO Inserts a page break at the beginning
and/or end of the data set based
on the configuration options. The
carriage control type of the first

DCO_BOOL_CONDITIONAL_START_PB

DCO_BOOL_CONDITIONAL_END_PB

DCO_BOOL_PAGE_DIRTY_FLAG
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record (Machine or ASA) determines
the type of page break inserted.

PRR2ExpandDCO Receives Printer Ready Records and
expands them so that the logical and
physical record lengths match. The
expansion is done with spaces. The
output records are in the PRR record
format.

DCO_ULONG_CP_CURRENT

DCO_ULONG_CPIN

PRR2ExpandTabsDCO Receives text data and converts tab
characters to zero or more expansion
character. The default behavior of
this DCO is to search for ASCII
horizontal tabs (0x09) and replace
them with 8 ASCII space characters
(0x20). The tab character to replace,
as well as, the number and type
of the replacement character is
configurable.

DCO_ULONG_TAB_SIZE

DCO_ULONG_SPACE_CHAR

DCO_ULONG_TAB_CHAR

PRR2File80DCO Translates data delimited by the
PRR record format to File80 data
wrapped in the PRR format. During
the translation, there is a one-to-
one correspondence between PRR
records and File80 records.

DCO_STRING_FILE80_RECFM

DCO_ULONG_LRECL

DCO_STRING_FILE80_FILENAME

PRR2File80PrepDCO Prepares data that is about to be sent
into the File802DS DCO. It removes
any carriage control in the data, and
truncates records longer than 80
bytes. The data records are received
with a PRR header, and the records
retain the PRR header when they are
sent.

NONE

PRR2FixedLengthDCO Pad or truncate PRR record to the
specified length.

DCO_ULONG_FIXREC_LENGTH

DCO_ULONG_CP_CURRENT

PRR2HostDCO Receives PRR formatted records and
converts them to the NJE format.
This includes spanning, if necessary.
The input of this DCO shall be data
that is wrapped in PRR records and
the output will be that same data
wrapped in NJE (host) records.

NONE
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PRR2InlineXeroxResourcesDCO Used by NSi/TOOLS and NSi/
TRANSFORM, to handle extraction
and re-insertion of inline Xerox
resources (fonts, images, forms,
logos).

DCO_STRING_IDEN

DCO_STRING_RSTACK

DCO_STRING_DJDESEARCH

DCO_STRING_DJDEREPLACE

DCO_BOOL_REPLACEBLANKFONTINDEX

PRR2InsertLineFeedDCO Replaces all instances of ASCII CC
0x0D0C (CR FF) with 0x0D0A0C
(CR LF FF).

NONE

PRR2MergeOverprintsDCO Searches for line data that has
machine carriage control skip
immediate (0x03) or print and skip
immediate (0x01). When this is
found, that line is stored and the
following line in the stream is
examined. A character-by-character
comparison is done for the two lines.
The character from the first line is
used in all cases except when the
character in the first line is a space
character and when the character in
the first line is an underscore ("_")
and the character in the second line is
NOT a space.

Because the CC must be machine,
this DCO should be used after the
Mixed2Machine DCO in the DCO
chain. This will make sure the search
works properly.

DCO_ULONG_CP_CURRENT

DCO_ULONG_CPIN

PRR2nRECORDSDCO Combines n PRR records into a
single record. It is primarily used for
customers upgrading from the DOS
product who used the receive mode n
ASCII lines.

DCO_ULONG_N_RECORDS

PRR2PadDCO Receives Printer Ready Records and
pads them if padding is turned on.
The padding includes both the pad
skip to channel 1 and pad record
options offered in Output Manager
Print Server. The output records are
in the PRR record format.

DCO_ULONG_CP_CURRENT

DCO_ULONG_CPIN

DCO_STRING_PADSKIP1

DCO_STRING_PADRECORD
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PRR2ProcessTBVDCO Implements the TBV receive option
for files received via Nuance/Tran.
The input data is converted to the
NSi S/370 format and wrapped in
a PRR header. The resultant file is
similar to that generated by the DOS
product.

DCO_ULONG_CP_CURRENT (*)

DCO_ULONG_CPIN

PRR2RawDCO Receives Printer Ready Records and
strips the 5 byte PRR header from
them.

NONE

PRR2S370DCO Receives Printer Ready Records
and outputs them in the NSi S/370
format. Usually this DCO is last in
a DCO chain. The NSi S/370 format
has a double byte record length
(little Endian) at the start and end of
each record. The NSi S/370 format
records have Machine Carriage
Control.

NONE

PRR2SCSDCO Converts a PRR data stream to a
PRR wrapped SCS data stream.

DCO_BOOL_TRANSPARENCY

DCO_MAX_REC_LENGTH

PRR2SearchReplaceDCO Searches for all occurrences of either
text or binary data in a data stream
and replaces those occurrences with
a replacement string or replacement
binary data. The data must be
delimited by the Printer Ready
Record (PRR) format.

DCO_BOOL_SEARCH_STRING_MODEn

DCO_STRING_SEARCHn

DCO_STRING_REPLACEn

DCO_BOOL_REMOVE_RECORDn

PRR2SetFCBDCO Determines the FCB used by DCOs
for pagination later in the chain.
When the DCO is done with the data,
the first record will contain the FCB
to be used.

DCO_STRING_FCB

DCO_STRING_RETURN_LAST_FCB

DCO_BOOL_OVERRIDE_FCB

DCO_ULONG_SEND_FCB

DCO_STRING_RETURN_LAST_FCB
(*)

PRR2SpurDCO Carriage control Conversion DCO.
Converts every data record to a write
without spacing and follows this
with the appropriate space immediate
command. For compatibility with

NONE
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customers who had modified their
data streams or printers to use SPUR
boxes which generated carriage
control like this.

PRR2StripCharsDCO Receives data and removes any
character that is specified during
initialization. The default behavior
of this DCO is to search for NULLs
(0x00) and remove them. The
character to remove is configurable.

DCO_ULONG_STRIPCHAR

PRR2StripLeadPageBreaksDCO Removes all leading page breaks
from a stream of data. The DCO
receives data in the Printer Ready
Record format. The data is assumed
to be in Machine format, so this
translates to all leading records with
0x8B carriage control being stripped.
The output records are in the PRR
record format.

NONE

PRR2StripNonPrintMCCDCO Strips any record which does not
contain a Machine Carriage Control
(MCC) Print Carriage command (for
example, FCB 0x63) from the data
stream.

DCO_ULONG_CP_CURRENT

DCO_BOOL_STRIP_S370_CC

DCO_BOOL_STRIP_NOOP

DCO_BOOL_STRIP_LOAD_FCB

PRR2StripUCSDCO Accepts PRR records as input and
searches for removes UCS buffers.
These buffers are identified by the
channel commands 0xF3 or 0xFB.
Records that are not UCS buffers are
not modified. The output records are
in the PRR record format.

NONE

PRR2StripXeroxDCO Strips DJDE records that begin
with $$XEROX. This is a custom
DCO created for a specific customer
with sample data. In all cases the $
$XEROX occurred after the CC and
first byte of data, so that is where the
DCO searches for the text. The DCO
also removes page breaks associated
with these records, if the record was
on a page of its own and its removal
would cause a blank page to be left.

DCO_ULONG_CP_CURRENT

DCO_ULONG_CPIN
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PRR2SysinDCO Given data in the PRR form, it
removes the carriage control and
creates fixed length or variable
length card records.

DCO_ULONG_LRECL

DCO_BOOL_ASCII_V_FORMAT

PRR2TransformDCO Interfaces with the
ITransformDCOStream COM
interface. For use with 3rd party
transformation packages.

DCO_STRING_CONFIG_FILE

DCO_STRING_PAGE_RANGE

DCO_STRING_INPUT_FORMAT

DCO_STRING_OUTPUT_FORMAT

PRR2TruncateDCO Receives Printer Ready Records and
truncates trailing spaces if truncation
is turned on. Truncation will continue
as long as spaces are encountered
until there is only 1 byte remaining.
The output records are in the PRR
record format.

DCO_STRING_TRUNCATE

DCO_ULONG_CP_CURRENT

DCO_ULONG_CPIN

PRR2VBMDCO Converts PRR records to PRR
wrapped VBM records. Both RDW
(Record Descriptor Words) and
BDWRDW are supported. Block
lengths are added to each record if
configured to do so.

DCO_BOOL_VBMBLOCKLEN

PRR2vRECORDSDCO Combines a variable number of PRR
records into a single record. The
vertical bar | is used as the delimiter
between records. Any data following
| in a PRR record is discarded.

DCO_ULONG_V_RECORDS_CHAR

DCO_ULONG_CP_CURRENT

PRR2XSGFDCO Creates XSGF or EPS records.
Leaves them wrapped in PRR so that
this can be used with existing SOP.

NONE

PRRCompress2Decompress Accepts compressed data in PRR
format, and decompress it into PRR
format.

DCO_BOOL_DECOMPRESS

S3702PRRDCO Receives data in the NSi S/370
format and writes it out in the PRR
format.

NONE

SCB2SCSDCO Converts a SCB data stream to a
SCS data stream. The data stream is
decompressed if SCB compression

DCO_BOOL_COMPACT

DCO_STRING_COMPACT_TABLE
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is used and decompacted if a
compaction table is used.

SCS2HostDCO Converts a SCS data stream to a PRR
data stream.

DCO_BOOL_FCBLOAD

DCO_BOOL_MCC_IN_DATA

DCO_ULONG_MAX_PRINT_POSITION

DCO_BOOL_BINARY_DATA

DCO_BOOL_POWER_HOST

SCS2SCBDCO Converts a PRR wrapped SCS data
stream to a PRR wrapped SCB data
stream.

NONE

VarableRecord2PRRDCO Breaks an incoming stream into a
series of records with a specified
type of carriage control and a
specified Record terminator.

DCO_BOOL_DATA_IS_HEX

DCO_BOOL_SWITCH_CODE_PAGE

DCO_STRING_RECORD_TERMINATOR

DCO_INT_TERM_CODEPAGE

DCO_INT_CC_TYPE_FIXED

DCO_BOOL_SECOND_BYTE_DELIMITER

VBM2PRRDCO Converts VBM records into PRR
records. Allows for both blocked and
unblocked.

NONE

VM2PRRDCO Converts VM into PRR. NONE

XpafTrn2BinaryDCO Strips off SCS transparency
command and returns binary data.

NONE

DCO Parameters

Name Description Value Type

DCO_BOOL_COMPACT Enables or disables data co
mpaction

True, T, Yes, Y

All other characters are
false

Boolean

DCO_BOOL_DATA_IS_
HEX

If the Boolean is true, the d
elimiter is hex; otherwise t
he delimiter is text.

True, T, Yes, Y

All other characters are
false

Boolean
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DCO_BOOL_FCBLOAD Specifies whether or not to
look for an FCBLOAD co
mmand

True, T, Yes, Y

All other characters are
false

Boolean

DCO_BOOL_MARK_INS
ERTED_RECS

Specifies if the records the
DCO inserts are marked

True, T, Yes, Y

All other characters are
false

Boolean

DCO_BOOL_MCC_IN_D
ATA

Specifies if machine carria
ge control is embedded in t
he data

True, T, Yes, Y

All other characters are
false

Boolean

DCO_BOOL_PROGRAM
HANDLES

Specifies if the input strea
m is set to STDIN and outp
ut stream is set to STDOU
T

True, T, Yes, Y

All other characters are
false

Boolean

DCO_BOOL_REMOVE_
RECORDn

Allows the removal of a re
cord that matches the searc
h criteria

True, T, Yes, Y

All other characters are
false

Boolean

DCO_BOOL_REPLACEB
LANKFONTINDEX

Replaces blank font indexe
s with the last known good
one

True, T, Yes, Y

All other characters are
false

Boolean

DCO_BOOL_SEARCH_S
TRING_MODEn

Specifies if the search mod
e is binary or text. If the Bo
olean is true, the search mo
de is text; otherwise the sea
rch mode is binary.

True, T, Yes, Y

All other characters are
false

Boolean

DCO_BOOL_SECOND_B
YTE_DELIMITER

If true, the delimiter is a 2-
byte hex value; otherwise,
a single-byte hex value is u
sed.

True, T, Yes, Y

All other characters are
false

Boolean

DCO_BOOL_SWITCH_C
ODE_PAGE

If true, the text delimiter w
ill be translated into a conf
igured code page; otherwis
e, the system code page wi
ll be used.

True, T, Yes, Y

All other characters are
false

Boolean

DCO_INT_CC_TYPE_FI
XED

Specifies the type of carria
ge control.

0 = ASCII ASA; 1 = EBC
DIC ASA; 2 = Machine; 3
= NONE

Integer
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DCO_INT_TERM_CODE
PAGE

Specifies the code page th
e  delimiter will be translat
ed to.

Any positive number that is
a valid code page (for exam
ple, 37 or 437)

Integer

DCO_STRING_CCTYPE Specifies the record's carria
ge control type

"A" for ASA carriage contr
ol, "M" for machine carriag
e control, and "N" if there i
s no carriage control. If not
hing is specified, the defaul
t value is "A"

String

DCO_STRING_DJDEREP
LACE

Specifies the IDEN string i
n the normalized file

IDEN string in the normali
zed file

String

DCO_STRING_DJDESEA
RCH

Specifies the IDEN string i
n the original LCDS file

IDEN string in the original
LCDS file

String

DCO_STRING_FILE80_F
ILENAME

Specifies the original file n
ame

Filename String

DCO_STRING_FILE80_R
ECFM

Specifies the record format Record format String

DCO_STRING_IDEN Specifies the hex values for
the Xerox IDEN string

Hex values for the Xerox I
DEN string

String

DCO_STRING_PADREC
ORD

Enables or disables pad rec
ord

Y or N String

DCO_STRING_PADSKIP
1

Enables or disables pad-ski
p to channel 1

Y or N String

DCO_STRING_PROGRA
MFOLDER

Specifies the external progr
ams default directory

Path to the current director
y (default folder)

String

DCO_STRING_PROGRA
MPARAMETERS

Specifies parameters for ex
ternal program

"STDIN" is replaced with t
he input pipe name, and "S
TDOUT" is replaced with t
he output pipe name

String

DCO_STRING_PROGRA
MPATH

Specifies the full path to th
e executable

Path to the executable incl
uding the executable file n
ame

String

DCO_STRING_RECORD
_TERMINATOR

Specifies the string used as
the delimiter.

String are as is, but hex, an
d follow the formation “X
X XX” for double byte or “
XX” for single byte.

String

DCO_STRING_REPLAC
En

Replacement string. The
length of characters or
bytes must be in the range
(0 256).

Replacement text for the te
xt search mode and 0x0304
05 for the binary search mo
de. In the binary mode, eac
h two characters after the 0

String
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The n represents the
search-replacement pair.

x represent a byte of data u
sed as a replacement.

DCO_STRING_RSTACK Species the hex values for
the printers RSTACK com
mand.

Hex values for the printers
RSTACK command

String

DCO_STRING_SEARCH
n

Search string. The length of
characters or bytes must be
in the range (1 256).

The n represents the
search-replacement pair.

Search text for the text sea
rch mode and 0x010203 fo
r the binary search mode. I
n the binary mode, each tw
o characters after the 0x re
present a byte of data to se
arch for

String

DCO_STRING_TRUNCA
TE

Enables or disables truncat
ion

Y or N String

DCO_ULONG_CPIN Input code page Input code page number, fo
r example 37

ULong

DCO_ULONG_CPOUT Output code page Output code page number,
for example 437

ULong

DCO_ULONG_FIXEDRE
C

Specifies the length of each
record in the file in bytes

1 32000

The default value is 133.

ULong

DCO_ULONG_LRECL Specifies the record length
in bytes

1 32767 ULong

DCO_ULONG_SPACE_C
HAR

Character to use when expa
nding tabs

Number, for example 20 (A
SCII space)

ULong

DCO_ULONG_STRIPCH
AR

Character to remove when
stripping characters

Number, for example 0 (str
ip NULL characters)

ULong

DCO_ULONG_TAB_CH
AR

Character to look for (tab c
haracter)

Number, for example 9 (A
SCII tab character)

ULong

DCO_ULONG_TAB_SIZ
E

Number of spaces used for
tab expansion

Number, for example 8 ULong

RJE_BOOL_SCB_COMP
RESSION

Specifies if the data will be
SCB compressed

True, T, Yes, Y

All other characters are
false

Boolean

Scheduling Tasks
Administrators can configure a recurring schedule for a task. Tasks can be created to run an ad hoc rule, create and
save a report, or create and email a report.
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Complete the steps in the following procedure to create a schedule.

• Create a Schedule

How to Create a Schedule
Complete the steps in this procedure to create a schedule.

1. From the Output Manager Console menu bar select Tools > Schedule Manager.
This opens the Schedule Manager dialog box.

2. Click Add to create a schedule.
This opens the New Schedule dialog box.

3. Enter a schedule Name and Description.
4. Use the Enabled check box to enable or disable the schedule.
5. From the Schedule tab, click Add.

This adds a new schedule in the Summary box.
6. Under Recurrence pattern, choose if you want to create a Simple, Daily, or Monthly recurrence pattern.

Notice the recurrence options change based on the type of pattern you want to create. Configure these options as
necessary.

7. Under Range of recurrence, determine the Start and End date/time for the schedule.
By default the schedule is configured with no end date. To configure an end date, select the End by check box and
select the appropriate date and time in list boxes.

8. When the schedule is complete, click Save Edit to save the schedule.

Note:  To add multiple schedules, click Add and configure the schedules as necessary.

9. From the Tasks tab, you can create multiple tasks for the schedule.
10. Use the following procedures to configure tasks as necessary.

• Run an Ad Hoc Rule
• Create and Save/Email a Report
• How to Update Output History with Page Counts on page 326
• How to Import Users and Groups on page 326
• How to Synchronize Active Directories on page 327
• How to Synchronize LDAP on page 327

11. Use the buttons below the task grid to add additional tasks to the schedule, modify existing tasks, or remove tasks
from the schedule.

12. When your schedule is complete, click OK. The schedule summary and tasks are listed on the Schedule Manager
dialog box. Use the check box in the Enabled column to determine if the schedule is enabled or disabled.

13. Click OK.

How to Run an Ad Hoc Rule
Perform this topic to use a schedule to run an ad hoc rule.

1. On the Tasks tab of the Schedule Manager, click Add > Perform Rule.
This opens the New Task dialog box.

2. Enter a Name and Description for the task.
3. In the Choose the rule to perform list, select an existing ad hoc rule.
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To create a rule, click the browse button (...) and create a rule from the Ad Hoc Rules Manager dialog box. See
Working with ad hoc rules for instructions on creating rules.

4. In the Run mode list, choose if you want to run the rule against all documents in the spool or against all newly
received documents since the last time the rule was run.
The rule will not be run against retained documents.

5. Once the task is selected, click OK.

The new task is listed in the grid on the Tasks tab.

How to Create and Save/Email a Report
Perform this procedure to use a schedule to create a report and then save or email it.

1. On the Tasks tab of the Schedule Manager, click Add Create Report.
2. Enter a Name and Description for the task.
3. To save the report, select Save report as a and choose to save the report in PDF or comma separated values

(CSV) format.
In the box, either type the folder path where the report will be saved, or click the browse button (...) to select the
folder. If the Nuance Output Manager Database Manager is on a different machine, you must enter the full UNC
path.

4. To email the report, click Email report as a and choose to email the report in PDF or CSV format.
5. Either select an email profile from the list, or click the browse button (...) to create one from the Manage

Outbound Email Profiles dialog box.
6. Configure the email messages that will be sent using the following options:

• Set the Priority level of the email as normal, low, or high.
• Enter the email addresses that will be sent messages in the To, CC, and Bcc boxes. You can enter multiple

email addresses separated by a comma.
• In the Reply to box, enter an email address where replies will be routed. You can enter multiple email

addresses separated by a comma.
7. In the Report to generate list, select the report you want to create.
8. Under Report parameters, configure the parameters for the selected report.

The parameters change depending on the report selected.
9. Once the task is selected, click OK.

The new task is listed in the grid on the Tasks tab.

How to Update Output History with Page Counts
Perform this procedure to use a schedule to count document pages as they are received by Nuance Output Manager
sources. The schedule allows you to batch process page counting during periods of low incoming volume, such as
overnight.

1. On the Tasks tab of the Schedule Manager, click Add Update Output History With Page Counts.
2. Enter a Name and Description for the task.

How to Import Users and Groups
Perform this procedure to use a schedule to import users and groups into Nuance Output Manager. The schedule
ensures that Nuance Output Manager is synchronized with new, removed, and modified Active Directory and LDAP
users.

1. On the Tasks tab of the Schedule Manager, click Add Import Users and Groups.
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2. Click User Import Wizard.
3. Use the User and Group Import and Synchronization Wizard to configure the import settings.

Import users and groups to Output Manager on page 43 provides more information on using the wizard.

How to Synchronize Active Directories
Perform this procedure to use a schedule to synchronize Nuance Output Manager Active Directory users with their
respective domain controllers.

1. On the Tasks tab of the Schedule Manager, click Add Active Directory Synchronization.
2. Enter a Name and Description for the task.

How to Synchronize LDAP
Perform this procedure to use a schedule to synchronize Nuance Output Manager LDAP users with their respective
LDAP server.

1. On the Tasks tab of the Schedule Manager, click Add LDAP Synchronization.
2. Enter a Name and Description for the task.
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Reports

Learning About the Reports Application
The Reporting application can be accessed both through the Output Manager Console and the Nuance Output
Manager Web Interface. There are many sample reports included in Nuance Output Manager. These reports provide
summary and details of activity by user, department, document, and destination. Upon clicking reports in the tree, a
panel displays with parameters. These parameters can be adjusted, after which the report displays up in the right side
of the screen. Summary reports include hyperlinks to detailed reports. The Report Designer is used to edit and create
new reports. It is accessed from the New Report menu.

Click the area of the window you want to learn more about.

1. Navigation pane on page 328
2. Report Preview window on page 329
3. Menu bar on page 329
4. Toolbar on page 330
5. Status bar on page 332
6. Parameters pane on page 332
7. Reports Preview window on page 332

Navigation pane

Reports are organized in folders. These folders define the permissions for users and groups to access reports. When
you right-click an item in the navigation pane, the following options will display. The options listed will vary
depending on if a report or report folder is selected.
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Navigation Pane Option Description

Open

(reports only)

Opens the report in the active tab.

Open in New Tab

(reports only)

Opens the report in a new tab.

New Folder

(report folders only)

Creates a new report folder in the selected folder. A new
folder entry titled “UnNamed” will appear in the tree. Ty
pe the new folder name and press Enter to create the fold
er. By default the new folder will inherit the security sett
ings of its parent folder.

New Report

(report folders only)

Creates a new report in the selected folder. This option di
splays the New Report dialog box.

Rename Renames the selected folder or report.

Copy

(reports only)

Creates a copy of the selected report.

Edit

(reports only)

Edits the selected report in the Report Designer.

Delete Deletes the selected folder or report. Folders cannot be d
eleted if they contain reports or subfolders.

Security Opens the Security Configuration dialog box so that yo
u can update the security settings. This option will define
the type of access that users and groups have to the eithe
r the selected report or the reports contained in the select
ed folder.

Report Preview window

The Report Preview window displays a tabbed view of the Reports tree selection. By default, selecting reports in the
tree will replace the report in the active tab. To open a report in new tab, right-click the report and click Open in New
Tab.

When a report is opened the Parameters pane displays with parameters to configure. Complete the parameters and
click Submit to display the report in the right side of the window. Summary reports include hyperlinks to detailed
reports.

Your tree selection and open tab pages will be saved for the next time you open the application.

Menu bar

The menu bar displays below the tab title.
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Menu Command Description

File Page Setup Allows you to change page orientatio
n, select paper size, choose paper sou
rce, and change page margins.

Print Displays the Print dialog box for pri
nting the active report.

Quick Print Sends the report directly to the defau
lt printer without customizing print s
ettings.

Export Document Exports the active report and saves th
e resulting file on your hard drive. Y
ou can choose one of the following f
ormats: PDF, HTML, MHT, RTF, E
xcel, CSV, text, or image. You may b
e prompted to define format-specific
options.

Send via Email Sends the active report via email. Yo
u can choose one of the following for
mats: PDF, MHT, RTF, Excel, CSV,
text, or image. You may be prompted
to define format-specific options.

View Page Layout Changes the page layout to one of th
e following:

• Facing — Arranges the pages
side by side, displaying only one
or two pages at a time.

• Continuous — Arranges the
pages in a continuous vertical
column.

Toolbar Shows or hides the toolbar.

Status Bar Arranges the pages in a continuous v
ertical column.

Customize Allows for customizing the Report P
review window.

Background Color Changes the background of the repor
t to a specified color.

Watermark Adds a text or picture watermark as t
he background of the report.

Toolbar
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The toolbar displays the following information.

Option Description

Parameters Shows or hides the Parameters pane.

Search Displays the Find dialog box for locating text in the rep
ort.

Print Displays the Print dialog box for printing the active rep
ort.

Quick Print Sends the report directly to the default printer without cu
stomizing print settings.

Page Setup Allows you to change the print settings using the Page
Setup dialog box. You can change page orientation, sele
ct paper size, choose paper source, and change page mar
gins.

Scale Displays scaling options for changing the view of the re
port.

Hand Tool Enables or disables the use of the Hand tool. The Hand t
ool enables you to scroll content by dragging the docume
nt instead of using scroll bars.

Magnifier Enables or disables the use of the Magnifier. The Magnif
ier allows you to switch between 100% and "fit whole pa
ge" views. Click anywhere in the report to toggle views.

Zoom Out Decreases the magnification of the report.

Zoom Allows for selecting the zoom level from the drop-down
list.

Zoom In Increases magnification of the report.

First Page Displays the first page of the report.

Previous Page Displays the previous page of the report.

Next Page Displays the next page of the report.

Last Page Displays the last page of the report.

Multiple Pages Displays options for viewing two or more pages at one t
ime.

Color Changes the background of the report to a specified colo
r.

Watermark Adds a text or picture watermark as the background of th
e report.

Export Document Exports the active report and saves the resulting file on y
our hard drive. You can choose one of the following for
mats: PDF, HTML, MHT, RTF, Excel, CSV, text, or im
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Option Description

age. You may be prompted to define format-specific opt
ions.

Send via Email Sends the active report via email. You can choose one of
the following formats: PDF, MHT, RTF, Excel, CSV, te
xt, or image. You may be prompted to define format-spe
cific options.

Parameters pane

The Parameters pane allows you to control the data that displays in the report by changing the parameter values. The
following parameters display for all reports. Additional parameters may display depending on the report selected.

Option Description

Start date Specifies the start date of the report.

End date Specifies the end date of the report.

Date range Specifies a date range for the report.

You can choose the last 7 days, the last 14 days, the
previous month, month to date, or year to date.

Reset Clicking this button resets the parameters to their defaul
t values.

Submit Clicking this button submits the parameter values and di
splays the report.

Reports Preview window

The Report Preview window displays a tabbed view of the Reports tree selection. By default, selecting a report in
the tree will replace the report that is displayed on the active tab.

Status bar

The status bar displays the following information.

Option Description

Page n of n Displays the current page and the total number of pages i
n the report.

Zoom Factor Displays the current zoom level of the report.
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Working with Reports
From the Output Manager Console, you can access the Reports application where you can view and manage Nuance
Output Manager reports. Several sample reports are included in Nuance Output Manager. These reports provide
summary and details of activity by user, department, document, and destination.

Nuance Output Manager has green reports that show documents that have been automatically deleted from the server
after being spooled but not printed. The green reports provide summary and detailed reports for billing accounts,
departments, and users.

If you generate reports from base reports in the Reports application, Nuance Output Manager allows you to export the
reports. If you export a summary report, Nuance Output Manager allows you to export a linked detail report. You can
import reports into base report folders or into custom folders created by other Nuance Output Manager users.

To enable green reports:

1. In the Administration application, select Set General Preferences and select the General tab.
2. Select Auto delete Spooled documents and set the auto-deletion time.

As a best practice for tracking estimated cost savings with green reports, select the Detect color and Count pages
options and specify Set cost per page values when configuring the settings on the source More settings tab.

Nuance Output Manager enables you to send reporting data from multiple Nuance Output Manager instances to a
remote consolidated database. You configure a task for each instance that sends reporting data to the remote database.

• Manage report folders
• Create reports
• Modify reports
• Remove reports
• Move reports
• Rename reports
• Copy reports
• How to Export Reports on page 335
• How to Import Reports on page 336
• Search for reports
• Configure security for reports
• How to Send Report Data to a Remote Database on page 338

How to Manage Report Folders
This topic describes how to manage report folders.

In the Reports application, reports are organized in folders. These folders define the permissions that users and groups
have over reports

• Create folders
• Move folders
• Rename folders
• Delete folders
• Search for folders
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To create folders

1. In the Reports tree, right-click a folder and click New Folder.
A new folder titled UnNamed is added to the selected folder.

2. In the edit field, type the name of the new folder and press Enter.
The new folder automatically inherits the permissions of the parent folder.

To move folders

1. In the Reports tree, select the folder you want to move.
2. Click and drag the selected folder to the desired tree location.

As you drag the item a yellow arrow will appear to the left of the tree to indicate where the folder will be placed.

To rename folders

1. In the Reports tree, right-click the folder you want to rename.
2. Click Rename on the shortcut menu.
3. In the edit field, type the new folder name and press Enter.

To cancel the rename, press Esc.

To delete folders

All of the objects must be removed from a folder before you can delete it.

1. In the Reports tree, right-click the folder you want to delete.
2. Click Delete on the shortcut menu.

To search for folders

1. In the search box below the Reports tree, type the text you want to find and press Enter or click the Search image.
Nuance Output Manager will start at the top of the tree and search for the text. Each time the text is found the
selected item will be highlighted in the tree.

2. If more than one search result is found, click the next and previous arrow buttons that appear in the search panel.

How to Create Reports
Complete the following steps to create reports in the Reports application.

1. In the Reports tree, select the report folder where you want to add a report. Right-click and click New Report.
This opens the New Report dialog box.

2. In the list, select a report template.
You can choose from summary and detailed reports.

3. Enter a name for the report.
4. If you chose to create a summary report, select the detailed report in the drop-down list.
5. Click OK.

This opens the Report Designer window.
6. Configure the report as necessary and save your changes.
7. Close the Report Designer.
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How to Modify Reports
Complete the following steps to modify reports in the Reports application.

1. From the Reports tree, right-click the report you want to modify, and click Edit.
This displays the report in the Report Designer.

2. Configure the report as necessary and save your changes.
3. Close the Report Designer.

How to Remove Reports
Complete the following steps to remove reports from the Reports application.

1. In the Reports tree, right-click the report you want to delete.
2. Click Delete on the shortcut menu.

How to Move Reports
Complete the following steps to move a report in the Reports application.

Reports can be organized into report folders. Once folders are created, reports and folders can be easily moved in the
tree as necessary.

1. In the Reports tree, select the report or report folder you want to move.
2. Click and drag the item to the desired tree location.

As you drag the item a yellow arrow will appear to the left of the tree to indicate where the item will be placed.

How to Rename Reports
Complete the following steps to rename a report in the Reports application.

1. In the Reports tree, right-click a report and click Rename.
2. In the edit field, type the new report name and press Enter.

To cancel the rename, press Esc.

How to Copy Reports
Complete the following steps to copy a report in the Reports application.

1. In the Reports tree, right-click a report and click Copy.
This creates a copy of the report in the same report folder.

2. Optional: If necessary, you can rename the new copy of the report.
For more information, see Rename Reports.

How to Export Reports
Complete the following steps to export a report from the Reports application.

Nuance Output Manager allows you to export reports that you generate from the base reports in the Reports
application. You cannot export the base reports.

1. In the Reports tree, select reports you want to export.

• Press the Shift key and click a report to extend the selection.
• Press the Ctrl key to click a report to add it to the selection.

2. Right-click and select Export Report(s).



Output Manager Administration Guide
Version 4.0 SP2

336 © 2016 Nuance Communications, Inc. All rights reserved.

3. Select the folder where you want to export the reports.
4. If you are exporting a summary report, indicate if you want to include the linked detail report.
5. Click Ok.

Nuance Output Manager exports the reports with a nrepx file extension.

How to Import Reports
Complete the following steps to import reports into a folder in the Reports application.

1. In the Reports tree, select the folder where you want to import the reports.
2. Right-click and select Import Report(s).
3. Select the folder that contains the reports to be imported, then click Search.
4. To import the reports into the base folders from where they were exported, select Import into original group.

If the reports were exported from a custom folder created by another user, select the custom folder from
Importing into group.

5. Select the reports in the grid, then click Import.

How to Search for Reports
Complete the following steps from the search panel below the Reports tree.

1. In the search box, type the text you want to find and press Enter or click the Search image.
Nuance Output Manager will start at the top of the tree and search for the text. Each time the text is found the
selected item will be highlighted in the tree.

2. If more than one search result is found, click the next and previous arrow buttons that appear in the search panel.

How to Configure Security for Reports
Complete this procedure to assign report permissions.

To perform this procedure, you must be a member of the local Administrators group. Users with administrator
permission can add and remove users or groups and modify the assigned permissions.

Nuance Output Manager security for the Reports application begins at the root of the Reports tree, in the All Reports
group. The Reports tree consists of folders which are used to organize reports. Nuance Output Manager security is
provided by adding a Microsoft Windows user or user group to the folder and assigning permissions to that user or
user group. These Nuance Output Manager permissions define the type of access users and user groups have to the
reports within the folders. Once the Nuance Output Manager security (Microsoft Windows users, user groups, and
document permissions) is set in a folder, the Nuance Output Manager security is inherited by all the objects in that
folder. When a new report is added or a folder is created, its security is automatically the same as its parent folder’s
security (that is, the new report inherits its security from its parent folder).

Tip:  To begin configuring report security, start by assigning the desired report permissions in the All Reports
folder.

1. In the Output Manager Console, select the Reports application in the navigation pane.
2. In the Reports tree, right-click the folder you want to configure and click Security.

This opens the Security Configuration dialog box.
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3. Use the Inherit permissions from the parent option to determine if you want to inherit permissions from the
parent folder or remove inheritance. Click the browse button (...) to configure inheritance.
By default, folders are configured to inherit permissions from the parent folder.

Tip:  It is good practice to assign rights using inheritance, as it allows administrators to easily assign and
manage permissions. Blocking inheritance is useful when reports need to be seen by just a few users. If
you plan to block inheritance, make sure the users that need access to the blocked report folder are in the
security settings for all of its parent groups, including All Reports. If this is not done then those users will
not be able to see the folder. Also remember to remove the users and user groups that should not have
access to the folder.

4. In the Users and groups with permissions list box, select the user or group that you want to configure in the list.
To set permissions for a user or group that does not appear in the list, click Add. Then, in the User and Group
Selection dialog box, select the users/groups you want to add and click OK. If the user/group is not listed, click
More Users to locate the user. From the list you can choose to add Nuance Output Manager users, LDAP users, or
Windows users. You can also choose to import LDAP users. Once users are added, they are placed in the Nuance
Output Manager database, causing them to always be listed in the future.
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The Assigned permissions list box displays the assigned permissions for the selected user.
5. In the Assigned permissions box, select or clear permissions for the selected user or group. Click Select All or

Unselect All to quickly assign or remove all permissions.
If you notice permissions that are selected and disabled, then the user/group selected has inherited permissions.
Inherited permissions cannot be removed. To remove inherited permissions, you must first turn off inheritance for
the folder.
The permissions assigned to a folder will be inherited for all of the objects contained in that folder, except for the
ones that have inheritance blocked.

6. After you finish making changes to the permission, click OK.

How to Send Report Data to a Remote Database
Use this procedure to create a task that sends report data to a remote database.

1. On the Output Manager Console menu bar, select Tools > Schedule Manager.
2. Click Add.
3. On the Schedule tab, click Add.
4. Define the schedule for sending the report data to the remote database.
5. Select the Tasks tab and click Add.
6. Select Push Data to Reporting Database.
7. On the New Task dialog box, specify the task settings for sending the report data to the database.

New/Edit Task (Push Reporting Data to Database) dialog box on page 630 provides information on task
settings.

Using the Report Preview window
When you open a report in the Reports application it displays in the Report Preview window. From this window you
can search for text, print, export, and email reports. You also have full control over the display. You can change the
page layout, background, and magnification level. Review the following procedures for instructions on using the
Report Preview window.
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• View reports
• Print reports
• Scale reports
• Change the zoom level
• Change watermark and background settings
• Search for text in a report
• Export reports
• Email reports

How to View Reports
Use this procedure to open a report in the Preview window.

1. Open the report using one of the following methods from the Reports tree:

• Select a report to open it in the current tab.
• Right-click a report and click Open to open the report in the current tab.
• Right-click a report and click Open in New Tab to open a report in a new tab.

2. In the Parameters pane, specify the parameter values for a report.
The report will be based on the specified parameter values. The following parameters display for all reports:

Parameter Description

Start date Specifies the start date of the report.

End date Specifies the end date of the report.

Date range Specifies a date range for the report. You can choose th
e last 7 days, the last 14 days, the previous month, mon
th to date, or year to date.

You may need to configure additional parameters depending on the report.

Note:  To change the parameter values back to their default values, click Reset.

3. Click Submit.
Completing this step displays the report.

Tip:  To navigate between pages, use the scroll bars or navigation buttons on the toolbar. These buttons
allow you to switch to the first, previous, next, or last page of a report.

You can enable the Hand Tool on the toolbar to scroll content by dragging the report instead of using
scroll bars.

How to Print Reports
Complete this procedure to print a report.

Note:  You can change the print settings using the Page Setup dialog box. To do this, on the toolbar click the
Page Setup button, or on the menu bar click File > Page Setup. You can change the page orientation, select
the paper size, choose the paper source, and change the page margins.

1. View the report that you want to print.
For instructions, see View Reports.

2. Print the report using one of the following methods:
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To Do this

Print to the default printer Do either of the following:

• On the menu bar click File > Print.
• On the toolbar, click the Quick Print button.

Print using the Print dialog box Do either of the following:

• On the menu bar select File > Print.
• On the toolbar, click the Print button.

Then, in the Print dialog box, specify the appropriate
settings and click Print.

How to Scale Reports
Complete this procedure to scale a report.

1. View the report that you want to scale.
For instructions, see View Reports.

2. Click the Scale toolbar button.
This opens the Scale dialog box.

3. You can adjust the scale using one of the following methods.
To scale Do this

Using a zoom factor In the Adjust to box, specify a percent value.

To fit a specified number of pages In the Fit to box, specify the number of pages.

4. Click OK

How to Change the Zoom Level

Use the following procedures to adjust the Preview zoom level for a report.

• To zoom in and out
• To zoom using the Magnifier tool
• To zoom by entering a zoom factor
• To zoom reports to fit page content
• To zoom reports to display whole pages
• To show two or more pages

To zoom in and out

• To zoom in a document, click the Zoom In toolbar button, or press Ctrl+Plus Sign.
• To zoom out of a document, click the Zoom Out toolbar button, or press Ctrl+Minus Sign.
• To zoom in or out of a document, you can also press Ctrl and rotate the mouse wheel.

To use the Magnifier tool
Use the Magnifier tool to switch between 100% and "fit whole page" views.

• Click the Magnifier toolbar button, and then click anywhere in the document to toggle views.
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To zoom by entering a zoom factor

• Click the Zoom drop-down toolbar button and choose one of the zoom levels.
• Manually enter any value into the Zoom toolbar box.

To zoom reports to fit page content

Note:  If the preview window will be resized later, the current zoom factor will also be changed to fit the
current page or text width.

• To zoom to the page width, click the Zoom toolbar box and click Page Width.
• To zoom to the text width, click the Zoom toolbar box and click Text Width.

To zoom reports to display whole pages

Note:  If the preview window will be resized later, the current zoom factor will be also changed in order to fit
one or two pages.

• To display one whole page at a time, click the Zoom toolbar box and click Whole Page.
• To fit two pages into the current view, click the Zoom toolbar box and click Two Pages.

To show two or more pages

1. To preview two or more pages simultaneously, click the Multiple Pages toolbar button.
2. In the dialog that displays, pause on the page icons, depending on the required number of pages to preview.
3. When the required number of pages has been selected, click the pop-up window to close it and apply changes to

the document view.

How to Change Watermark and Background Settings
Perform these procedures to add a text watermark, picture watermark, or background color to a report.

1. Add a text watermark
2. Add a picture watermark
3. Add a background color

To add a text watermark

1. View a report.
For instructions, see View Reports.

2. On the menu bar click Background > Watermark, or on the toolbar click the Watermark button.
This opens the Watermark dialog box.

3. On the Text Watermark tab, enter the watermark text in the Text box.
You can also click and select predefined text in the box.

4. As necessary, define other text properties, such as direction, color, font, size, or transparency.
5. For Position, determine whether the watermark will be in front of or behind the report text.
6. For Page Range, specify the pages to apply the watermark.

Type page numbers and/or page ranges separated by commas. Specify page ranges using a dash. For example, type
1,3,5-12.

7. Click OK.
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To add a picture watermark

1. View a report.
For instructions, see View Reports.

2. On the menu bar click Background > Watermark, or on the toolbar click the Watermark button.
This opens the Watermark dialog box.

3. On the Picture Watermark tab, click Load image, select the watermark picture, and click OK.
4. Customize the image by specifying size mode, horizontal and vertical alignment, tiling, and transparency.
5. For Position, determine whether the watermark will be in front of or behind the report text.
6. For Page Range, specify the pages to apply the watermark.

Type page numbers and/or page ranges separated by commas. Specify page ranges using a dash. For example, type
1,3,5-12.

7. Click OK.

To add a background color

1. View a report.
For instructions, see View Reports.

2. On the menu bar click Background > Color, or click the Color toolbar button.
3. Choose a color from the Custom, Web, or System palette.

How to Search for Text in a Report
Complete this procedure to search for text in a report.

1. View a report.
For instructions, see View Reports.

2. On the toolbar, click the Search button.
This opens the Find dialog box.

3. In the Find what box, type the text you want to locate.
4. For Search Options, you can specify whether to match case or the whole word during the search, or set the search

direction.
5. To start searching or search again, click Find Next or press Enter.

How to Export Reports
Complete this procedure to export a report.

1. View a report.
For instructions, see View Reports.

2. Export the report using one of the following methods:

• On the menu bar, click File > Export Document, and then select the format for exported file.

You can choose one of the following formats: PDF, HTML, MHT, RTF, XLS, CSV, text, or image.
• On the toolbar, click the Export Document arrow, and then select the format for exported file.

You can choose one of the following formats: PDF, HTML, MHT, RTF, XLS, CSV, text, or image.
3. Depending on the format selected, you may be prompted to define format-specific options.
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PDF-specific export options
Page range Defines the pages which

will be included in the
complete file. Separate
the pages with a comma,
set a range of pages with
a dash.

Don't embed these fonts Defines the fonts not
to be embedded in
the complete file, to
get a smaller file size.
Separate the fonts with a
semicolon.

Images quality Specifies the required
document's image quality
level. The higher the
quality, the bigger the
file, and vice versa.

Compressed Select to enable
compression.

Show print dialog on
open

Select, if desired.

• You can also enter values for the Application,
Author, Keywords, Subject, and Title fields.

HTML-specific export options
Export mode The following modes are

available:

• The Single file mode
allows export of
a document to a
single file, without
preserving the page-
by-page breakdown.

• The Single file page-
by-page mode allows
export of a document
to a single file, while
preserving page-by-
page breakdown.
In this mode, the
Page range, Page
border color and
Page border width
options are available.
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• The Different files
mode allows export
of a document to
multiple files, one
for each document
page. In this mode,
the Page range, Page
border color and
Page border width
options are available.

Page range Defines the pages which
will be included in the
complete file. Separate
the pages with a comma,
set a range of pages with
a dash.

Page border color Specifies the color for
the page border from the
available palettes.

Page border width Defines the width of page
borders.

Title Specifies the required
document title.

Character set Defines the character
set for your HTML
document.

• You can also select the appropriate check box to
remove carriage returns.

MHT-specific export options
Export mode The following modes are

available.

• The Single file mode
allows export of a
document to a single
file, without dividing
it into pages.

• The Single file
page-by-page mode
allows export of a
document to a single
file, divided into
pages. In this mode,
the Page range, Page
border color and
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Page border width
options are available.

• The Different files
mode allows export
of a document to
multiple files, one
for each document
page. In this mode,
the Page range, Page
border color and
Page border width
options are available.

Page range Defines the pages which
will be included in the
result. Separate page
numbers with commas;
set page ranges using
hyphens.

Page border color Specifies the color for
the page border from the
available palettes.

Page border width Defines the width of page
borders.

Title Specifies the required
document title.

Character set Defines the character set,
which will be used in the
exported document.

• You can also select the appropriate check box to
remove carriage returns.

RTF-specific export options
Export mode The following modes are

available.

• The Single file mode
allows export of a
document to a single
file, without dividing
it into pages.

• The Single file
page-by-page mode
allows export of a
document to a single
file, divided into
pages. In this mode,
the Page range, Page
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border color and
Page border width
options are available.

• The Different files
mode allows export
of a document to
multiple files, one
for each document
page. In this mode,
the Page range, Page
border color and
Page border width
options are available.

Page range Defines the pages which
will be included in the
result. Separate page
numbers with commas;
set page ranges using
hyphens.

• You can also select the appropriate check box to
include watermarks in the exported document (if
they exist).

XLS-specific export options
Show grid lines Select, if it is required

to show grid lines in the
resulting XLS file.

Export values using
their format

Select, if it is required to
preserve the format of
values.

Export hyperlinks Select this option to
export hyperlinks.

Sheet name Defines the sheet name.

CSV-specific export options
Text separator Defines a text separator

(comma by default).

Encoding Defines the encoding
used in the exported
document.

• You can also specify whether to quote strings with
separators.

TXT-specific export options
Text separator Defines separator text

(TAB by default).
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Encoding Specifies the encoding to
be used in the exported
document.

• You can also specify whether to quote strings with
separators.

Image-specific export options
Image format Specifies one from the

available image formats
to export a document:
BMP, EMF, WMF, GIF,
JPEG, PNG or TIFF.

Resolution (dpi) Defines the required
image resolution.

Export mode The following modes are
available.

• The Single file mode
allows export of a
document to a single
file, without dividing
the output into pages.

• The Single file
page-by-page mode
allows export of a
document to a single
file, divided into
pages. In this mode,
the Page range, Page
border color and
Page border width
options are available.

• The Different files
mode allows export
of a document to
multiple files, one
for each document
page. In this mode,
the Page range, Page
border color and
Page border width
options are available.

Page range Defines the pages which
will be included in the
result. Separate page
numbers with commas;
set page ranges using
hyphens.
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Page border color Specifies page border
color.

Page border width Defines the width of page
borders.

4. In the Save As dialog box, choose where you want to save the exported file and enter a File name.
5. Optional: When prompted whether to open the exported file, click Yes if you want to preview the exported file.

How to Email Reports
Complete this procedure to email a report.

1. View a report.
For instructions, see View Reports.

2. Email the report using one of the following methods:

• On the toolbar, click Send via E-Mail arrow, and then click the format for exported file.

You can choose one of the following formats: PDF, MHT, RTF, XLS, CSV, text, or image.
• On the menu bar, click File > Send via E-Mail, and then click the format for exported file.

You can choose one of the following formats: PDF, MHT, RTF, XLS, CSV, text, or image.

.
3. Depending on the format selected, you may be prompted to define format-specific options.

PDF-specific export options
Page range Defines the pages which

will be included in the
complete file. Separate
the pages with a comma,
set a range of pages with
a dash.

Don't embed these fonts Defines the fonts not
to be embedded in
the complete file, to
get a smaller file size.
Separate the fonts with a
semicolon.

Images quality Specifies the required
image quality for
documents. Increasing
this value increases file
sizes.

Compressed Select to enable
compression.

Show print dialog on
open

Select, if desired.
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• You can also enter values for the Application,
Author, Keywords, Subject, and Title fields.

HTML-specific export options
Export mode The following modes are

available:

• The Single file mode
allows export of
a document to a
single file, without
preserving the page-
by-page breakdown.

• The Single file page-
by-page mode allows
export of a document
to a single file, while
preserving page-by-
page breakdown.
In this mode, the
Page range, Page
border color and
Page border width
options are available.

• The Different files
mode allows export
of a document to
multiple files, one
for each document
page. In this mode,
the Page range, Page
border color and
Page border width
options are available.

Page range Defines the pages which
will be included in the
complete file. Separate
the pages with a comma,
set a range of pages with
a dash.

Page border color Specifies the color for
the page border from the
available palettes.

Page border width Defines the width of page
borders.

Title Specifies the required
document title.
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Character set Defines the character
set for your HTML
document.

• You can also select the appropriate check box to
remove carriage returns.

MHT-specific export options
Export mode The following modes are

available.

• The Single file mode
allows export of a
document to a single
file, without dividing
it into pages.

• The Single file
page-by-page mode
allows export of a
document to a single
file, divided into
pages. In this mode,
the Page range, Page
border color and
Page border width
options are available.

• The Different files
mode allows export
of a document to
multiple files, one
for each document
page. In this mode,
the Page range, Page
border color and
Page border width
options are available.

Page range Defines the pages which
will be included in the
result. Separate page
numbers with commas;
set page ranges using
hyphens.

Page border color Specifies the color for
the page border from the
available palettes.

Page border width Defines the width of page
borders.
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Title Specifies the required
document title.

Character set Defines the character set,
which will be used in the
exported document.

• You can also select the appropriate check box to
remove carriage returns.

RTF-specific export options
Export mode The following modes are

available.

• The Single file mode
allows export of a
document to a single
file, without dividing
it into pages.

• The Single file
page-by-page mode
allows export of a
document to a single
file, divided into
pages. In this mode,
the Page range, Page
border color and
Page border width
options are available.

• The Different files
mode allows export
of a document to
multiple files, one
for each document
page. In this mode,
the Page range, Page
border color and
Page border width
options are available.

Page range Defines the pages which
will be included in the
result. Separate page
numbers with commas;
set page ranges using
hyphens.

• You can also select the appropriate check box to
include watermarks in the exported document (if
they exist).
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XLS-specific export options
Show grid lines Select, if it is required

to show grid lines in the
resulting XLS file.

Export values using
their format

Select, if it is required to
preserve the format of
values.

Export hyperlinks Select this option to
export hyperlinks.

Sheet name Defines the sheet name.

CSV-specific export options
Text separator Defines a text separator

(comma by default).

Encoding Defines the encoding
used in the exported
document.

• You can also specify whether to quote strings with
separators.

TXT-specific export options
Text separator Defines separator text

(TAB by default).

Encoding Specifies the encoding to
be used in the exported
document.

• You can also specify whether to quote strings with
separators.

Image-specific export options
Image format Specifies one from the

available image formats
to export a document:
BMP, EMF, WMF, GIF,
JPEG, PNG or TIFF.

Resolution (dpi) Defines the required
image resolution.

Export mode The following modes are
available.

• The Single file mode
allows export of a
document to a single
file, without dividing
the output into pages.
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• The Single file
page-by-page mode
allows export of a
document to a single
file, divided into
pages. In this mode,
the Page range, Page
border color and
Page border width
options are available.

• The Different files
mode allows export
of a document to
multiple files, one
for each document
page. In this mode,
the Page range, Page
border color and
Page border width
options are available.

Page range Defines the pages which
will be included in the
result. Separate page
numbers with commas;
set page ranges using
hyphens.

Page border color Specifies page border
color.

Page border width Defines the width of page
borders.

4. In the Save As dialog box, choose where you want to save the exported file and enter a File name.
The document created by this procedure is attached to a new empty message in your default mail program.

The Report Designer

Learning About the Report Designer

The Report Designer allows you to create new reports, bind them to data, and even pass them to another workstation
and load them into another instance of the Report Designer. In addition to report editing capabilities, it allows you to
display its Print Preview and send its output to a printer or export it to a file on disk.

Important:  The features of the Reports Designer are constantly changing. Some features described in the
Report Designer help may differ from what you see in your application.

Click the area of the window you want to learn more about.
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1. Menu bar on page 354
2. Toolbars on page 356
3. Tool Box on page 357
4. Report Explorer on page 361
5. Property Grid on page 362
6. Design Panel on page 358
7. Group and Sort on page 360

Menu bar

The menu bar displays below the title bar. Click the following menus to learn about the available commands.

Menu Command Description

File Save Saves the changes to the Nuance
Output Manager database.

Exit Closes the Report Designer.

Edit Undo Undo the last action that you did.

Redo Repeats the last action that you did.
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Menu Command Description

Cut Removes the selection and places it o
n the Clipboard.

Copy Copies the selection to the Clipboard.

Paste Inserts the contents of the Clipboard
at the insertion point.

Delete Deletes the selection.

Select All Selects all items.

View Designer Changes the page layout to one of th
e following:

• Preview — Displays the report
in Print Preview mode. You
will be prompted to enter report
parameters.

• HTML View — Displays the
report in HTML. You will
be prompted to enter report
parameters.

Toolbars Shows or hides the toolbars. Also al
lows for customizing the toolbar and
menu bar.

Windows Shows or hides portions of the wind
ow.

Format Foreground Color Specifies the text color for the contr
ol.

Background Color Specifies the background color for th
e control.

Font Specifies the font settings for the con
trol.

Justify

Align Allows you to change the alignment
of the control's text.

Make Same Size Allows you to choose the control siz
e.

Horizontal Spacing Allows you to choose the horizontal
spacing.

Vertical Spacing

Center in Form Centers the control in the form horiz
ontally or vertically.



Output Manager Administration Guide
Version 4.0 SP2

356 © 2016 Nuance Communications, Inc. All rights reserved.

Menu Command Description

Order Brings the selected controls to the fro
nt or moves the selected controls to t
he back.

Toolbars

The Report Designer contains the following toolbars.

Note:  If one of the toolbars are hidden, you can enable it by selecting View > Toolbars on the menu bar.

Main Toolbar

The Main toolbar contains buttons which provide the capability to save report layouts, cut, copy and paste report
elements, and undo-redo actions in the Report Designer.

Formatting Toolbar

The Formatting toolbar allows you to easily customize an element's font, color and alignment settings.

Layout Toolbar

The Layout toolbar allows you to easily align report elements to one another, change their size to match one another
and customize spacing and z-order.

Zoom Toolbar

The Zoom toolbar allows you to zoom a report in and out, providing easier control over report's layout.

Context Menu

The Context Menu can be invoked by right-clicking a report or its elements. This menu provides quick access to
frequently used commands such as zooming, clipboard operations, inserting bands and invoking the Property grid.
The available action set varies, depending on the element where you invoked the context menu.
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Tool Box

The Tool Box lists all available controls and allows you to add them to your report.

Note:  If the Tool Box panel is hidden, you can show it by selecting View > Windows > Tool Box on the
menu bar.

To add a control from the Tool Box, do one of the following:

• Double-click a tool in the Tool Box for the appropriate control, which will be created at the Detail band's top left
corner.

• Drag and drop a tool from the Tool Box onto the required location within a report.
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• Select a tool in the Tool Box, and then click the required location within a report.
• Select a tool in the Tool Box, and then indicate the bounding rectangle by holding the left mouse button.

Select the Pointer tool when you need to perform selection, repositioning, or resizing. The Pointer tool is
automatically selected after you drop a control onto a report.

Design Panel

The Design Panel provides the following three tabs (switched at the bottom).

Designer tab

This tab allows you to customize a report, manage its report bands and controls, and define their properties.

Smart Tags

From the Designer tab, you can use smart tags. Most report elements have smart tags that provide easy access to the
most frequently used settings. Clicking a smart tag invokes a pop-up window with action links and editors, allowing
you to customize the element.

Report smart tag A report's smart tag icon is located at the top left corner
of the Design Panel. Note that you need to click that
corner twice. The first click selects the report object,
allowing you to change its settings in the Property Grid.
The second click invokes the smart tag's pop-up window.

Important:  You should never change Data
source, Data Member, or Data adapter
settings in the Reports Designer. Data is
automatically pulled from the Nuance Output
Manager database, and changing these could
cause undesirable results.
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Band smart tag A band's smart tag icon is located on the band strip right
next to its caption. For instance, the smart tag for the
Group Head band is shown in the following image.

Control smart tag A control's smart tag icon is located at the top right
corner of the control. For instance, the smart tag for the
Label control is shown in the following image.
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Preview tab

This tab shows a print preview, and enables you to print out your report or export it to a file on disk.

HTML View tab

This tab shows the report output in HTML format.

Group and Sort

Note:  If the Group and Sort panel is hidden, you can show it by selecting View > Windows > Group and
Sort on the menu bar.
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Report Explorer

The Report Explorer shows the report structure in a tree form. This provides easy access to report elements. Once an
element has been selected in the Report Explorer, its settings can be changed using the Property Grid window.

Note:  f the Report Explorer is hidden, you can make it visible it by clicking View > Windows > Report
Explorer on the menu bar.

The Report Explorer contains two tabs, the Report Explorer tab and the Field List tab.

Report Explorer tab

The Report Explorer tab shows the report structure in a tree form. This provides easy access to report elements.
Once an element has been selected on the Report Explorer tab, it's settings can be changed using the Property Grid
window.

Field List tab

The Field List tab serves the following purposes.

• Displays the list of all available data fields (attributes you can show in your report) and allows you to create report
elements that will show information from these fields.

• Allows you to create calculated fields by building expressions based on the values of data fields, report parameter
values, and so forth.

• Shows existing report parameters, and allows you to add parameters to your report.
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Property Grid

The Property Grid allows you to change the settings of the currently selected report element. See the Report settings
topic for a description of each property.

Note:  f the Property Grid is hidden, you can enable it by clicking View > Windows > Property Grid on
the menu bar.

To select an element and show its properties within the Property Grid, do one of the following.

• Click the required element on the Report Designer surface.
• Select an element using the Report Explorer window.
• Select an element from the Property Grid combo box.
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Report Settings

A report is the main object in the Report Designer. While a report's properties can be accessed via the report's Smart
tag, the complete settings list is available in the Property Grid, where all the report's properties are divided into the
following groups.

• Appearance
• Behavior
• Data
• Design
• Misc
• Navigation
• Page Settings
• Parameters
• Structure

Appearance

Property Description

Background Color Specifies the background color of report elements. This o
ption is also available in the Formatting toolbar.

Borders
Border Color
Border Width

Specify border settings for report elements.

Font Specifies the font settings for report elements. Some of t
hese settings are available in the Formatting toolbar.

Foreground Color Specifies the text color for report elements. This option i
s also available in the Formatting toolbar.

Formatting Rule Sheet Invokes the Formatting Rule Sheet Editor, allowing yo
u to manage and customize formatting rules, which can t
hen be defined for a report's bands and controls.

Formatting Rules Invokes the Formatting Rules Editor, allowing you t
o choose which rules should be applied to the report du
ring report generation, and define the precedence of the
applied rules. For more information, see Conditionally
Change a Control's Appearance.

Padding Specifies indent values used to render the contents of a r
eport's controls.

Style Sheet Allows you to invoke the Styles Editor, which is intende
d to manage and customize a report's style sheets. For m
ore information, see Store and Restore Style Sheets.

Style Sheet's Path Allows you to define a path to the style sheet contained i
n a report style sheet file (.REPSS). For more informatio
n, see Store and Restore Style Sheets.
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Property Description

Text Alignment Allows you to change the alignment of a report controls'
text. This option is also available in the Formatting tool
bar.

Watermark Allows you to customize a report's watermark options. F
or more information, see Create or Modify Watermarks
of a Report.

Behavior

Property Description

Export Options Allows you to set the export options for each file type (P
DF, XLS, TXT, and so on). These options vary with the f
ile type.

Measure Units Allows you to choose units of measurement for a report (
one hundredth of an inch or a tenth of a millimeter).

Script Language Allows you to choose the programming language to be u
sed in scripting (C#, Visual Basic or J#).

Script References Allows you to manage the collection of strings that repre
sent the paths to the assemblies used by the scripts in a r
eport.

Scripts This property contains events which you can handle with
the required scripts.

Show Margin Lines in Preview The page margin lines are dotted lines shown on the curr
ently selected page in the report's preview. Use this prop
erty to change the visibility of these lines.

Vertical Content Splitting Allows you to choose whether report controls outside the
right page margin should be split across pages, or moved
in their entirety to the next page.

Visible Specifies whether a report should be created in print pre
view.

Data

Property Description

Calculated Fields Allows you to access a report's calculated fields collecti
on.

Data Adapter Determines a report's data adapter used to populate the r
eport's data source. It is created automatically, and shoul
d not be modified.
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Property Description

Data Member Determines a specific list in a report's Data Source, for w
hich the Report Designer objects display data. It is create
d automatically, and should not be modified.

Data Source Determines a report's data source. It is created automatic
ally, and should not be modified.

Filter String Allows you to invoke the Filter String Editor, which is
intended to easily define a filtering condition for a report
's data. For more information, see Change or Apply Data
Filtering to a Report.

Tag Allows you to add some additional information to a repo
rt; for example its id, by which it can then be accessible
via scripts.

XML Data Path Allows you to define a path to data contained in an exter
nal XML file. The data contained in the file will then be
used as a report's data source.

Design

Property Description

(Name) Determines a report's name, by which it can be accessed
in the Report Explorer, in the Property Grid, or using
scripts.

Data Source's Schema Allows you to load an XML/XSD file, containing the sch
ema of a report's data source.

Draw the Grid Determines whether to draw the grid when a report is be
ing designed.

Grid Size Determines the size of a grid defined by a report's Draw
the Grid property.

Row Count for Preview This property is intended to reduce the time for report pr
eview loading when working with large data sources. For
example, if this property is set to 10, only 10 data rows w
ill be loaded into a data source. If you want to see all dat
a rows, set this property to 0 (as it is by default).

Show Designer's Hints The designer hints are intended to provide tooltips, both
describing the purpose of certain report elements for inex
perienced users, and describing the reasons and solutions
for possible export or printing warnings. By using this pr
operty, these hints can be turned on or off.

Show Export Warnings The export warnings appear when report controls are ov
erlapped, indicating that a report layout may be incorrect
when exporting to certain table-based formats (such as X
LS, HTML or RTF).
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Property Description

Show Printing Warnings The printing warnings are intended to notify you that so
me of a report's controls are placed outside the right page
margin, so that the report contains unnecessary pages.

Snap to Grid This property is intended to place controls on a report pre
cisely when they are located or resized.

Misc

Property Description

Bands Allows you to invoke the Report Editor, intended to man
age and customize a report's bands.

Navigation

Property Description

Bookmark Allows you to define how a report is named in the docu
ment map when the report bookmarks are implemented.
By default, it is synchronized with the report's Name pro
perty.

Page Settings

Property Description

Landscape Determines whether the page orientation is Landscape (
when set to Yes) or Portrait (when set to No).

Margins Determines the width of a report's margins (measured in
report units).

Note:  The report's Margins.Top and
Margins.Bottom properties are tied to the
Height property of the Page Margin Bands.
Changing these the Margins property values for
a band will therefore also change the Height
value and changing the Height value will
change the Margins values.

Page Height Specifies page height, in report units. This property can o
nly be set if the Paper Kind property is set to Custom.

Page Width Specifies page width, in report units. This property can o
nly be set if the Paper Kind property is set to Custom.

Paper Kind Determines the type of paper for a report. Setting this pro
perty to any value different from Custom will prevent th
e Page Height, Page Width, and Paper Name propertie
s from being customized.
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Property Description

Note:  If the Paper Kind property is set to
Custom, then the printer paper will be selected
according to the Paper Name property value.
In this case, it is also necessary to set the Page
Width and Page Height properties to values
that correspond to the selected paper.

Paper Name Determines the name of the custom paper used in the pri
nter that will print the document.

Note:  The Paper Name property value is in
effect only when the Paper Kind property
is set to Custom. If the printer on which a
document is printed does not support the paper
type specified by the Paper Name property
value, then it will default to the Letter paper
size. In this case, it is also necessary to set the
Page Width and Page Height properties to
values that correspond to the selected paper.

Printer Name Determines the name of the printer to use when printing
a report. The specified printer should be installed on the
machine.

Using Settings of the Default Printer Specifies which default printer settings should be used w
hen printing a report.

Parameters

Property Description

Parameters Allows you to access a report's parameters collection.

Request Parameters Allows you to define whether it's required to request the
values of a report's parameters when generating the repo
rt.

Structure

Property Description

Bands Allows you to invoke the Report Editor, intended to ma
nage and customize a report's bands.

Report Bands

The Report Designer creates banded reports, where bands are report sections that can be printed once in a report
(report header and footer), on each report page (page header and footer), for each data entry (detail band), for each
data group (group header and footer), and so forth.

• Band types
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• Manage bands

Band types

The Report Designer supports the following band types.

Detail band The central part of a report. Unlike other report bands,
you cannot delete this band - the present report structure
includes the Detail band in its core. The contents of
the Detail band are repeated for every data entry. If
you're building a report listing, say, employees, it will be
rendered for each employee in the database.

Group Header and Footer The Group Header and Group Footer bands are shown
above and below each group.

You may use the Group Header bands for grouping by
multiple data fields in one of the following ways:

• Add several Group Header bands. Specify one group
field for each of these bands. This results in nested
grouping of the report's data.

• Specify several group fields for the Group Fields
property of the Group Header band. The data will be
grouped by certain combinations of field values.

The Group Footer band is unnecessary without the
corresponding Group Header band. When present, it
allows customization by providing a set of properties
similar to those of the Group Header.

For more information, see Changing or applying data
grouping to a report.

Report Header and Footer The Report Header and Report Footer are the only types
of report bands rendered once per report.

• The Report Header is the first band of a report on the
first page, not counting margins as they are "out-of-
page" zones. The Report Header precedes even the
Page Header band. It is the best place for the report
name, company logo, date of creation, author name
and miscellaneous information. If you plan to add a
chart that visualizes the report's data, then drop the
Chart control onto this band.

• The Report Footer finalizes the informative part of
the report. It is placed before the Page Footer and
Bottom Margin bands on the last page of the report.
Use the Report Footer for report grand totals or
conclusions.

Page Header and Footer The Page Header and Page Footer bands are located at
the top and bottom of every page in a report.
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The Page Header/Footer bands are the best place for
information that should be printed on every page. For
example, use them to display the header of a table which
is continued from the previous page.

Note:  If you insert page break right after the
Report Header (by setting its Page Break
property value to After the Band), the Page
Footer and Page Header bands will not be
printed on the first page.

Page Margin bands The Top Margin and Bottom Margin bands represent
the top and bottom page margins. They are intended for
displaying page numbers, or some sort of supplementary
information (for example, current system time or the user
name).

Managing bands

You can manage a report's bands using the Report Editor, which may be invoked either through the Edit and
Reorder Bands context link of a report's Smart tag actions list or through any band's Smart tag.

The Report Editor allows you to easily add, remove and reorder a report's bands, and to define their properties.

Another way to add a band of a certain type to a report is to invoke the context menu by right-clicking anywhere
on a report's surface. Then on the shortcut menu, point to Insert Band, and then click the appropriate band on the
submenu.

Report Controls

A Report control is an element showing information in your report (for example, static or bound text, line, picture, or
check box).

• Available controls
• Add controls to a report
• Useful key combinations

Available controls

The following controls are available in the designer's Toolbox panel.

• Pointer — Select the Pointer control when you need to perform selection, re-positioning or resizing operations. It
is automatically selected after you drop a control onto a report.

• Label — The Label control is intended to display textual information in a report. For example, the Label may
be used to show static text, as well as data from the bound data source. In addition, you can use it to calculate
a summary function for the specified data field, or to extend its usual functionality by writing scripts for the
available events.

After a Label is added to a report, you can customize its text, appearance and other properties, which can be
accessed in the Property Grid panel. Frequently used properties are also available via a control's Smart Tag and
Formatting Toolbar, which makes it easy to perform common operations.
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• Check Box — The Check Box control is intended to display a True/False or Checked/Unchecked/Indeterminate
states in a report, by displaying a check mark and adjacent text.

• Rich Text — The Rich Text control allows you to display, enter, and manipulate formatted text.

The control has a functionality similar to the Label control, but can also apply formatting to any part of the text.
The formatting options include font face, font styles and sizes, font color.

Rich text files (RTF) can be loaded to this control via its Smart tag.

• Picture Box — The Picture Box control is intended to display images in a report. Typically, an image is loaded
from an image file, or from the bound data source. In addition, an image can be loaded from a web location using
the specified URL. The following image formats are supported by the Picture Box control: BMP, GIF, JPEG,
PNG, TIFF, EMF and WMF.

• Panel — The Panel control is intended to group individual report controls.

The Panel control is a container to keep together any number of report controls. When the controls are placed onto
a Panel, they can be moved, copied and printed as a whole. There are currently several limitations on Panel usage.
One of them is that the Panel control does not have the Can Shrink property, and so cannot suppress the white
space that appears when the controls inside are shrunk or collapsed. Also, the Panel cannot be used in different
bands, unlike a cross-band control.
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The Panel can be used for page decoration — to create borders around the report elements or add a uniform color
background.

• Table — The Table control is designed to arrange the report information in a tabular layout.

When the Table control is dropped onto a report's band from the Toolbox, it becomes a table of one row and three
columns. If you click and drag over several bands, the resulting table will be split by the bands into several tables.
This creates a table header in the header band and the table's body, with one mouse move.

The Table control bound to data is created automatically when you drag and drop a data table from the Field List
window.

You can manage a table's elements by using its context menu.
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The Table control consists of the Table Row controls, each representing one table row. The Table Row, in turn,
consists of Table Cell controls, each representing one table cell. They can be selected and customized individually
(see the appropriate topics).

To select the Table control in the Report Designer, use the Report Explorer or the drop-down selector of the
Property Grid.

• Table Row — The Table Row control represents a single row within a table.

This control is useful for changing the layout of the entire row. Although in this document, a row is described as a
separate control, in fact most of its properties are actually applied to the cells contained within the selected row.

• Table Cell — The Table Cell control represents an individual cell within a table.

In general, the Table Cell control's properties are similar to the properties of the Label control.
• Line — The Line control represents a line used for decoration and visual separation of a report's sections.

• Shape — The Shape control is typically used for embedding simple graphics into a report.

• Bar Code — The Bar Code control inserts a barcode into a report.
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Note:  The barcode quality can degrade when the report is exported to formats other than PDF. To
ensure reliable barcode recognition, print the report directly from an application using the native printing
methods. The Module and Auto-Module properties of a control should be used with care.

• Zip Code — The Zip Code control displays a zip code in a report.

• Chart — The Chart control is used for data visualization in reports. It graphically represents a series of points
using 2D or 3D chart types.

There are many built-in chart view types you can choose from, such as Bar, Point, Line, Pie and Doughnut, Area,
Radar and Polar, Range Bar, Gantt, Candle Stick and Stock.

A Chart control contains multiple elements (diagram, series, series points, axes, legend, titles, labels, strips,
constant lines, and so forth). When any of these elements is selected, the Property Grid shows only the properties
which correspond to the selected item.

The Chart control is data-aware in a different manner than the other report controls. Consider three common
report scenarios:

• Static data for a chart's series is provided manually. It can be done using the Series Collection Editor invoked
by the Chart's Series property. It allows you to manually define values and arguments for each series point.

• Chart's series are created automatically, getting their data from the Chart's Data Source and dependent on the
rules defined by the Series Template property.

• Each series is created and customized manually and has a separate Data Source.

You can customize a created chart using both the Property Grid and the Chart Wizard. To invoke the Chart
Wizard, click a Chart's Smart tag, and in the invoked actions list, click the Run Wizard link.
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Then, the Chart Wizard will guide you through the whole process of customizing the chart, from defining its view
type to providing its data and customizing its appearance.

Note:  To use charts and graphs in your report, it’s best to start with one of the Graphing reports
templates that ships with Nuance Output Manager. Do not modify the data source for the report, as all data
must come from the Nuance Output Manager database.

• Pivot Grid — The Pivot Grid control represents data from an underlying data source in a cross-tabulated form
to create cross-tab reports. It calculates summaries and summary totals against specific fields, and displays the
summary values within data cells.

There is a designer allowing you to easily customize the Pivot Grid. It can be invoked using the control's Smart
tag.

The Pivot Grid displays data in a manner similar to pivot tables in Microsoft Excel. Column headers display
unique values from one data field, say, car models. Row headers display unique values from another field, say,
dates. Each cell displays a summary for the corresponding row and column values. By specifying different data
fields, you can see the total number of cars sold on a particular date, the total number of deals, and so on. This
way, you get a really compact layout for data analysis.

• Page Info — The Page Info control is intended to insert page numbers, current date and time, and the name of the
current user into a report.

• Page Break — The Page Break control is intended to insert a page delimiter, which can be placed at any point
within a report.

This control is visually represented by a short line, attached to the left side of the Design panel, as shown in the
image below.
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The Page Break control is useful when you need to insert a page break between controls within a band — for
example, to divide subreports, so that the second subreport starts printing on a new page.

• Cross-band Line — The specifics of the Cross-band Line control is that it allows you to draw a line through
several bands.

This can be useful if it is required to visually emphasize a section transcending multiple band areas by a line. In
other aspects, this control is similar to the Line control.

• Cross-band Box — The Cross-band Box control allows you to draw a rectangle through several bands.

This can be useful if it is required to visually emphasize a section transcending multiple band areas with a
rectangle.

• Subreport — The Subreport control allows you to include other reports into a current report.

There are several reasons for using subreports. The first is to reuse reports. This can be practical if there is a
particular report structure that has to be included in all reports, and the report must have a consistent appearance
and functionality. A good example is a report header that contains the company information, the logo, the date,
and so on. The second reason for using subreports is a creation of master-detail reports (reports with hierarchically
linked data).
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Adding controls to a report

Use one of the following methods to add controls to a report.

• To create a control, drag it from the Toolbox panel onto the report's area.
• To automatically create a control bound to data, drag a field from the Field List panel, and drop it onto a report's

surface. When dropping a field onto an existing control, this control will be bound to the data field.

If you drag the field with the right mouse button, when the button is released the context menu is invoked. Use this
menu to specify which control should be created.

To learn more about data binding for report controls, see Display Values from a Database (Bind Report Elements to
Data).

Note:  When the controls overlap, the report may be shown incorrectly when exported to HTML, XLS or RTF
formats. Red signs and a report's tooltip indicate this situation. You may switch off the red warning marks via
the report's Show Export Warnings property.

Useful key combinations

To change a control's size and position you can use the following key combinations:

Key Combination Action

Arrow keys Snaps the control to the grid and moves it up, down, left
or right by one grid step, defined by a report's Grid Size
property.

Ctrl + Arrow Moves the control up, down, left or right by one report u
nit.

Shift + Arrow Increases or decreases the control's width or height by on
e grid step, defined by a report's Grid Size property.

Ctrl + Shift + Arrow Increases or decreases the control's width or height by on
e report unit.

Tab Selects the next control in tab order.

Shift + Tab Selects the previous control in tab order.

Using the Report Designer

You can use the Report Designer to edit existing reports, as well as create your own reports from scratch. This topic
describes the most basic tasks you may encounter when editing a report in the Report Designer.

Important:  he features of the Reports Designer are constantly changing. Some features described in the
Report Designer help may differ from what you see in your application.

• Save a report
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• Manually update report output
• Change element layout in your report
• Add or modify static information in your report
• Delete report elements
• Display values from a database (bind report elements to data)
• Use mail merge in report elements
• Change value formatting of report elements
• Change fonts and colors of report elements
• Change or apply data sorting to a report
• Change or apply data filtering to a report
• Change or apply data grouping to a report
• Add totals to a report
• Create or modify watermarks of a report
• Add page numbers and system information to a report
• Add calculated fields to a report
• Add parameters to a report

How to Save Reports
Use this procedure to save a report.

To guarantee that you will be able to revert your report to its original state, you need to create a backup copy. You can
do this by right-clicking on the name of the report in the tree view, and clicking Copy. This allows you to restore your
report to the original state if something breaks.

To save a copy of your report, do one of the following:

• click File > Save.
• Click the Save toolbar button
• Press Ctrl+S on the keyboard.

Completing this procedure saves the report in the Nuance Output Manager database.

How to Manually Update Report Output
Use this procedure to manually update report output.

Sometimes you may need to simply update a couple of values in your report before printing it. In these cases, the
simplest way to correct your report is to export it to an editable file (such as RTF), then use an appropriate editor tool
to edit values and print your report.

1. To export a report, switch to the Preview Tab in the Report Designer.
2. Click the Export button as shown.
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3. Click the export file type on the menu.

How to Change Element Layout in a Report
Use methods shown in this procedure to select multiple elements in a report, reposition elements, resize elements, and
align controls.

Tip:  For information on how to work with tables, see Report controls.

• To select multiple controls:

• Hold down the Ctrl or Shift key and click to add controls to the selection.
• Click on an empty area, and drag the pointer to create a selection frame.

This method clears any previous selection.
• To reposition an element in a report, do either of the following.

• Click and drag an element to another position in the report.
• Click to select an element, and then press an arrow keys to reposition it.

• To resize an element in a report, do either of the following:

• Click to select the element, and then drag one of the small boxes shown on its edges and corners.
• Click to select the element, and then press Shift+Arrow or Ctrl+Shift+Arrow.
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• To align controls in a report, select multiple controls and use the alignment buttons on the Layout Toolbar.

How to Add or Modify Static Information in a Report

Reports display static and dynamic information. Dynamic information is something that changes through a report,
such as values from a database (actual report data) or service information (such as current user name or page
numbers). Static information is text or images that does not change through the report, and does not depend on the
current state on the computer. Information can be printed once (as in a report header), can repeat on each page (as in a
page header), or can repeat with every entry in your report (as in a label describing data).

• To change static information in a report
• To add information to a report

To change static information in a report

1. Locate the desired report element in the designer and invoke the element's Smart tag.
2. Click the link or button in the Smart tag to edit content for the element.

Text elements, such as labels and rich text boxes, also allow in-place editing of their content. Just double-click the
element to activate the editor. If you're working with rich text, you can use Formatting Toolbar.

To add information to a report

To add information to your report, you need to use an appropriate element from the Control Toolbox, such as a Label,
Rich Text Box or Picture Box. Once an element has been placed at the appropriate position, specify its content using
the Smart tag. For instance, the steps in this procedure describe how to add a rich text box into your report.

1. Drop the Rich Text control from the Report Designer Toolbox onto the onto the Detail band.
2. Select the resulting control and click its Smart tag.
3. In the invoked actions list, click the Load File link.
4. Define the path to an RTF or TXT file containing the text of the announcement, and click Open.

Tip:  You can perform additional text formatting using the Formatting Toolbar.

How to Delete Report Elements
Perform this procedure to delete a band or control element from a report.

1. In the Design Panel or Report Explorer, click to select an element or hold down the Shift or Ctrl key and click to
select multiple elements.

2. Do one of the following to delete the selection:

• Press Delete.
• Right-click the selection, and click Delete on the shortcut menu.
• On the Main menu, click Edit > Delete.

Tip:  You can press Ctrl+Z to cancel the operation.
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How to Use Mail Merge in Report Elements
Several report elements support Mail Merge. Use this procedure to apply mail merge to these elements.

1. To use mail merge in report elements, insert field names enclosed by square brackets in the element text.

2. To apply formatting to database values when applying Mail Merge, position the cursor on the field name inside the
square brackets, and click the Smart tag, and then define the formatting in the Format Sting section of the action
list.

How to Display Values from a Database
Use this procedure to display values from a database.

Report elements can either display static information or dynamic data fetched from the bound database. Data-bound
elements are indicated in the Report Designer using a small database icon in the top-right corner.

Sometimes you may work with a report that is missing some information. For instance, you may have an employee
list that does not display birth dates. If the database contains this information, you can easily add it to your report
using one of the methods described below.

• Use the Field List
• Use the Smart Tab
• Use the Property Grid

To use the Field List

• To bind an existing report element, click the desired field item in the Field List window, and then drag and drop it
onto the element. The yellow database icon inside the control will then appear.

• To add a new data-bound report element, simply drag the desired field item from the Field List window onto a
report band. This will create a Label bound to the selected data field.

• A more flexible way to create data-bound elements is to right-click a Field List item, and then drag and drop it
onto a report. This will invoke the context menu. Simply choose the element type that will represent your data,
and it will be automatically created and bound to the selected data field.

To use the Property Grid

1. Click an element's Smart tag.
2. In the menu, expand the Data Binding list.
3. Select the data field.

To use the Property Grid

1. Click an element to show it's properties in the Property Grid.
2. Expand the (Data Bindings) branch that holds the bindable attributes.
3. Specify a data field for the required attribute (for example Text).
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How to Change Value Formatting of Report Elements
Use this procedure to change value formatting of report elements.

1. To change value formatting, locate the required element, click its Smart tag, and then click the browse button (...)
in the Format String box.

This opens the Format String Editor dialog box.
2. Click to select one of the predefined formatting styles.

3. Click OK to save the changes and close the dialog box.

How to Change Fonts and Colors of Report Elements
Use this procedure to changes fonts and colors (as well as paddings, text alignment, and other appearance properties)
of a report control or band.

• Select this element and do one of the following:
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• Use the Formatting Toolbar.

• Use the Property Grid. Note that all appearance-related properties are located under the Appearance
category.

How to Change or Apply Data Sorting to a Report
Use this procedure to sort a report's data.

In this example, we use a report containing a Label control bound to a CategoryID data field. This field will be used
as a sorting criteria.

1. Click the Detail band's Smart tag, and in the menu, click the Sort Fields browse button (...).
2. In the dialog, click Add, to add a new entry.
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3. Set the FieldName property to a data field against which you want to sort your data. You can also define a sorting
order (ascending or descending).

Note:  You can sort data against multiple data fields. For this purpose, add more entries and specify their
data field and sort order settings.

4. Click OK to save your changes and close the dialog box.

This completes the report. Switch to the Preview Tab and view the result.

How to Change or Apply Data Filtering to a Report
Use this procedure to filter report data.

This procedure describes how to add conditions to the filter string for a report. You can also request a filtering
parameter each time a report is previewed. For more information, see Add Parameters to a Report.

1. In the Reports navigation pane of the Reports Application, click to select the report.
2. In the Property Grid, click the browse button (...) in the Filter String box.

This opens the FilterString Editor dialog box.
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3. Click And + to filter criteria.
4. Switch to the Preview tab to view the result.

How to Change or Apply Data Grouping to a Report
This procedure demonstrates how to group a report's data.

Data grouping can only be performed if a report is bound to a data source.

1. Add a Group Header band to the report.
To do this, right-click anywhere over the report's surface, and click Insert Band > GroupHeader.
This creates the GroupHeader1 band.

2. In the Field List, click and drag the field you want to use as a grouping criteria onto the GroupHeader1 band.

3. Drag another field to represent the general report's data onto the report's Detail band.

4. Click the Smart tag of the GroupHeader1 band, and in the actions list click the browse button (...) in the Group
Fields section.
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This opens the GroupField Collection Editor dialog box.
5. Click Add to add a new grouping field, and then set its Field Name property to the required field.

Note:  You can set the Sort Order property to define the sort order for this grouping field as ascending or
descending.

6. Click OK to apply the changes and close the GroupField Collection Editor dialog box.
7. Click the GroupHeader1 band's Smart Tag, and in the Group Union drop-down list, click Whole Page.

This causes a report group to start on a new page if it does not fit entirely on a page.
8. Switch to the Preview Tab to view the result.

How to Add Totals for a Report
Perform this procedure to calculate summaries (totals) within a report.

1. Add the Report Footer band if it is not present in the report.
To do this, right-click anywhere in report's area and click select Insert Band > Report Footer.

2. Hold down the Ctrl button while you click and drag the field for which a summary will be calculated onto the
Report Footer area.
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Tip:  You can also create a new label for your total by dragging it from the Control Toolbox.

Completing this step creates an exact copy of the Label that will display the summary.
3. Select the newly created Label, and in the Property Grid, click the browse button (...) in the Summary box to

open the Summary Editor.
The following image shows an example of how you can set up your total.

Note:  The Summary Running option is set to Report, to ensure that all values from the specified data
field are taken into account.

Tip:  The Ignore NULL values option will not affect the result in this example, because NULL values are
treated like zeros, by default. Therefore, Sum will not change whether these values are taken into account
or not. This option is important for functions like Count or Average that are affected by the number of
values.

4. Click OK to save the settings and close the Summary Editor dialog box.
5. Switch to the Preview Tab to view the result.
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How to Create or Modify Watermarks for a Report
This procedure describes how to add a text watermark to a report, to turn a picture into the background for a report, or
to modify an existing watermark.

Note:  Watermarks are visible only in the Preview and HTML View modes.

1. To select the report, click anywhere over the blank surface surrounding its bands area.
2. Then, in the Property Grid, click Watermark ellipsis button. The Watermark dialog will appear.
3. In the Text Watermark tab of this dialog box, define required properties, such as Text, Direction, Color, Font,

Transparency, and Page Range.

4. Switch to the Picture Watermark tab, to load an image to be used as a watermark, and define its properties, such
as Size mode, Alignment (vertical and horizontal), Tiling, Transparency, and Page Range.
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As you can see here, it is possible to simultaneously use both textual and image watermarks.
5. Optional: You can define all the watermark options in the Property Grid without using the dialog.

To do this, expand the Watermark property in the Property Grid and set the required properties directly.

6. After you configure the watermark, switch to the Preview tab to view the result.

How to Add Page Numbers and System Information to a Report
This procedure describes how to insert page numbers or other system information (such as current date and time and
user name) into a report.

Generally this information is displayed within the Page Header, Footer, or Page Margin bands.
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1. To add page numbers or system information to a report, locate the Control Toolbox and drag the Page Info
control to one of these bands.

2. Follow the instructions below for a specific task:

• Add page numbers
• Add system date and time
• Add the user name

To add page numbers

1. Select the Page Info control.
2. In the Property Grid click the Page Information drop-down list.

You can select whether to display only the page number (Latin or Roman - uppercase or lowercase), or the current
page number of total pages.

3. Define a formatting to the control's text.
For example, in the Property Grid, set the Format property to Page {0} of {1}.

To add system date and time

1. Select the Page Info control
2. In the Property Grid, click the Page Information drop-down list.
3. Click Current Date and Time.

Tip:  You can also define a formatting to the control text using its Format property.

To add the user name

1. Select the Page Info control.
2. Then in the Property Grid, click the Page Information drop-down list.
3. Select User Name.
4. Define a formatting to the control text.

For example, in the Property Grid, set the Format property to Current User: {0}.

How to Add Calculated Fields to a Report
This procedure demonstrates how to add a calculated field to a report.

The main purpose of calculated fields is to perform calculations over different data fields. To learn how to easily
perform calculations within a single data field, refer to Adding totals to a report.

1. To create a calculated field, in the Field List, right-click any item, and click Add Calculated Field.
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2. In the Field List, select the created field to show its properties in the Property Grid.

3. Change the Field Type property setting to an appropriate value.
4. To create an expression for the calculated field, first click the browse button (...) in the Expression section to open

the Expression Editor.
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You can also open this dialog by right-clicking a calculated field within the Field List and clicking Edit
Expression on the shortcut menu.

5. You can now perform any of the following operations:

• Click Fields to see the field list.
• Double-click field names to add them to the expression string.
• Use the toolbar to add operators between field names.

6. Click OK to save the expression and close the dialog box.
7. Drag the calculated field from the Field List onto a control or a table cell.
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8. Switch to the Preview tab to view the with a calculated field.

How to Add Parameters to a Report
Follow this procedure to add parameters and filter your report based on their values.

Sometimes it is useful have parameters in your report. Parameters can help you filter your data.

Tip:  To specify a value that will be used to calculate other values, you can use calculated fields. For more
information, see Add Calculated Fields to a Report.

1. In the Field List window, right-click in the Parameters section, and click Add Parameter. Repeat this action to
create the second parameter.

2. In the Field List, click the FromDate parameter, and in the Property Grid set its properties as follows:
Property Setting

(Name) FromDate

Description From:

Parameter Type Date Time

3. In the Field List, click the ToDate parameter, and in the Property Grid set its properties as follows:
Property Setting

(Name) ToDate

Description To:

Parameter Type Date Time
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You have now created two report parameters. Every time you preview your report, you will be asked to enter their
values. The following instructions explain how to use these values to filter your report's data.
4. In the Report Designer, click anywhere over the blank space to select the report.
5. In the Property Grid, click the browse button (...) in the Filter String box.
6. In the The FilterString Editor, define expressions using the parameters that you just created.

The parameterized report is now ready.
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7. Make sure that the report's Request Parameters property is set to Yes.
This is the default setting for the Request Parameters property. If this property is not set to Yes, the parameters
will not be requested during the preview, and you will get a blank report.

8. Switch to the Preview tab, and in the Parameters section, define the required values and click Submit.

Styles and Conditional Formatting in Reports
This section covers appearance-related information about the Report Designer.

• Understand styles concepts
• Use odd and even styles
• Store and restore style sheets
• Conditionally change a control's appearance
• Conditionally hide bands
• Conditionally change a label's text

Understanding Styles Concepts

Each report element (band or control) and the report itself has a group of properties, specifying the element's
appearance, such as Background Color, Borders, Border Color, Border Width, Font, Foreground Color,
Padding and Text Alignment. By default, these properties are set to empty values, which means that their real values
are obtained from a control's (or band's) parent. In turn, this means that these appearance-related properties, defined
by a parent, are spread to their child elements.

You can also define a control's appearance properties independently from its parent.
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When you need to reset a value assigned to a control's appearance property, you can right-click this property in the
Property Grid, and click Reset. So, the control will be restored to the appearance of its parent.

Note:  Some of these properties are only applicable to certain controls. For example, the Line control ignores
the Text Alignment property, assigned to the Line's container band.

Additionally, there can be styles created in a report. A report's styles live in the report's Style Sheet collection. A style
stored within this collection has a set of the same appearance properties, as a control or a band has. There are two
ways to store a report's style sheets. The first approach is to save them to external files (with REPSS extension), and
then load them to a report using its Style Sheet Path property in the read-only mode (this is described in the topic
Storing and restoring style sheets). The second is to store the style sheets within the report (using the Style Sheet
property), so that they can be modified, if required, and saved with the report itself.

Finally, the styles can be assigned to a report's bands and controls. So, there is an option for the band or control to
obtain its appearance either from a style assigned to it, or from the control's own appearance properties. In this case,
the control's Style Priority property allows you to define the required behavior of the control's final appearance.

By default, except for Use Text Alignment, all the Style Priority options (Style Priority.Use Background Color,
Style Priority.Use Border Color, and so forth), which follow the structure of the style and appearance properties,
are set to Yes. This means that if any style is assigned to a control by its Styles property, all of its properties will have
a higher priority than the properties stored in the control or in its parent. If you want some of the properties to be
determined by a control, rather than its style, set the corresponding Use* property to No.
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Note:  If styles contained in a style sheet loaded in the Style Sheet Path property have the same names as
styles already contained in a report, the latter ones are overridden.

The following image illustrates how the Style Priority property works.

Note:  When a conditional formatting is involved, the appearance defined by the conditional formatting has a
higher priority than the properties described above.

Another commonly used feature is odd-even styles. It allows you to visually delimit alternating data fields in a report,
for better readability. For more information, see Use odd and even styles.

How to Use Odd and Even Styles
This procedure describes the steps to create a report using odd and even styles.

1. Create a new report.
For more information, see Create Reports.

2. Drop the required fields from the Field List onto the report's Detail band.
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3. Select the Detail band, and in the Property Grid, expand the Styles property.
4. On the drop-down list for the Even Style property, click (New).

The xrControlStyle1 setting will be assigned to the Even Style property.
5. Expand the Even Style property, and set the Background Color property to Beige.

You can configure other properties in this section as required.
6. Repeat steps 3 on page 397 through 5 on page 397 for the Odd Style property.

That is, create a new style and set its Background Color property to Ivory.
7. If you switch to the Preview tab now, you will see the following result.

You can observe in the figure that the created styles are applied to all of the controls that are contained in the
Detail band.

8. Suppose that a different style is required for one of the fields. To accomplish this, do the following.
a) Select the required field, and in the Property Grid and expand its Styles property
b) Open the drop-down list for the Style property, and click (New).
c) Expand the Style property, and for the created xrControlStyle3, set the Background Color property to

White.
d) The style of this control has priority over the Detail band's styles. Switch to the Preview tab, and view the

result.
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How to Store and Restore Style Sheets
Follow steps in this procedure to store and restore report style sheets.

Using the Report Designer, it is possible to store a report's style sheet (containing all the report's styles) in an external
REPSS file. This makes it possible to easily restore a report's appearance from this file.

1. Create a new report.
For more information, see Create Reports.

2. Click the report's Smart tag, and in the actions list, locate the Style Sheet property and click its browse button (...).
3. In the Styles Editor, click the Add button to create new styles.
4. Define properties for the new styles and click the Save button.
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5. In the Save File dialog box, define a name for the style sheet file (.REPSS) to be created and click Save.
6. Back in the Styles Editor dialog box, use the Delete button to delete the created styles, and then click Close.
7. Select the report, by clicking anywhere over the blank area around its bands.
8. In the Property Grid, locate the Style Sheet Path property and click its browse button (...).
9. In the Open File dialog box, load the created REPSS file.

If you then click the Style Sheet properties browse button (...) to open the Styles Editor, you'll see that the
properties of the styles are read-only. This is because we used the Style Sheet Path property to load the style
sheet.

If the Style Sheet Path property is then set to None, and a style sheet is loaded into a report using the Style Sheet
property, all the styles loaded from the style sheet file will still be kept in the report, but become editable.

10. Now, assign these styles to the required report controls, by using their Styles property.
In the figure, we assigned the created styles to the control's Odd Style and Even Style properties. For more
information, see Use Odd and Even Styles.
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Note:  Styles loaded from a style sheet file have a higher priority than the styles which exist in a report's
style sheet, returned by the Style Sheet property. This means that if the styles stored in the report have the
same names as the styles loaded from a style sheet file, then the styles in the file will substitute for their
namesakes. And, the styles loaded from a file cannot be edited in a report.

The result of this procedure is shown in the following figure.

How to Conditionally Change the Appearance of a Control
This procedure describes the steps to conditionally change a control's appearance.

1. Create a new report.
For more information, see Create Reports.

2. Drag the required fields from the Field List onto the report's Detail band.
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3. Select the report by clicking anywhere over the blank area around its bands, and in the Property Grid click the
browse button (...) for the Formatting Rules Sheet property.
This opens the Formatting Rule Sheet Editor dialog box, which you can use to manage and customize
formatting rules for the report's bands and controls.

4. In the Formatting Rule Sheet Editor, click the Add button to create a new formatting rule, and click the browse
button (...) for the Condition property.

5. In the Condition Editor, define the required Boolean condition.
In the figure, fields are formatted if the UnitPrice value is greater than 30.
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6. Click OK to save the condition and close the Condition Editor dialog box.
7. Back in the Formatting Rule Sheet Editor, define the formatting to be applied.

8. Select the band or control to which to apply the formatting rule (for example, the Detail band), and in the
Property Grid, click the browse button (...) for the Formatting Rules property.

9. In the Formatting Rules Editor, select the rule and click the > button to move the formatting rule from the
Available Rules box to the Applied Rules box.
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The rules are applied in the same order that they appear in the list. The last rule in the list has the highest priority.
You can move a rule up and down the list with the up and down arrow buttons.

The result is shown in the figure.
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How to Conditionally Hide Bands
This procedure describes the steps to conditionally hide bands.

In this example, we will hide the Group Header and Detail bands when a grouping field meets a certain condition.
Note that this procedure does not use scripts to accomplish this task.

1. Create a new report.
For more information, see Create Reports.

2. Add a Group Header band to the report.
To do this, right-click anywhere over the report's surface, and click Insert Band > GroupHeader.

3. Drag a field that will be used as a grouping criteria from the Field List onto the created GroupHeader1 band.

4. Click the Smart tag of the GroupHeader1 band, and in the invoked actions list, click the browse button (...) in the
Group Fields section.
This opens the GroupField Collection Editor dialog box.

5. Click Add, to add a new grouping field, and set its Field Name property to the required field.
6. Click OK to apply the settings and close the dialog box.
7. Drag fields representing the general report's data onto the report's Detail band.
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8. Select the Group Header band's strip, then in the Property Grid, click the Formatting Rules browse button.
9. In the Formatting Rules Editor, click the Edit Rule Sheet button.
10. In the Formatting Rule Sheet Editor, click the Add button, to create a new rule.
11. Set the new properties Visible property to No, and for the Condition property, click the browse button (...).
12. Construct the required Boolean expression to be met (for example, [ShipCountry] == 'Argentina').

Then click OK and Close to close the Formatting Rule Sheet Editor.
13. In the Formatting Rules Editor, activate the new rule by moving it to the Applied Rules box.

Repeat this step for the report's Detail band (click its Formatting Rules property's ellipsis button, and in the
invoked dialog, apply the same rule to this band). If you do not do this, the Group Header band will not be
displayed when the rule's condition is met while the detailed section of this group will still be visible.

14. Switch to the Preview Tab to view the result.
In the figure, you can see that there is no Argentina section in the report, while it's the first record in our database.
So, the conditional formatting was applied properly.
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How to Conditionally Change Label Text
This procedure demonstrates how to change label text if a certain condition is met.

1. Create a new report.
For more information, see Create Reports.

2. In the Field List, right-click any item inside the new dataset, and click Add Calculated Field.

3. In the Property Grid, set the field's Field Type property to String, then click the browse button (...) for the
Expression property.
This opens the Expression Editor dialog box.

4. In the Expression Editor dialog box, define the required condition for the calculated field, and then click OK.
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For example, Iif([UnitsOnOrder] == 0, 'None', [UnitsOnOrder], which specifies that if the
UnitsOnOrder data field's value is equal to 0, the appropriate control's text will be replaced with None.

5. Drag the required data fields (and the created calculated field as well) from the Field List onto the report's Detail
band.

6. The report is now ready. Switch to the Preview tab, and view the result.

Navigation in Reports

This topic covers the navigation-related features of the Report Designer.

• Add bookmarks
• Create hyperlinks
• Add a cross-reference

How to Add Bookmarks
Follow steps in this procedure to create a report with bookmarks.

This procedure describes the steps to create a report with bookmarks (or a so-called Document Map). This feature
allows you to easily navigate through the report during its print preview.

1. Create a new report.
For more information, see Create Reports.

2. Add a Group Header band to the report.
To do this, right-click anywhere over the report's surface, and click Insert Band > GroupHeader.
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3. From the Field List, drag data-fields onto the new GroupHeader1 band.

4. Click the Smart tag of the GroupHeader1 band, and in the actions list, click the browse button (...) in the Group
Fields property.
a) In the GroupField Collection Editor dialog box, click Add to add a new grouping field, and set its

FieldName property to the required field.
b) Click OK to apply the settings and close the dialog.

5. To add a Report Header band to the report, right-click anywhere on its surface, and click Insert Band >
ReportHeader.

6. Drag a Label from the Toolbox panel onto the new Report Header band, and set its text to Products by
Categories.

7. Drop a field representing the general report's data onto the new Detail band.

8. Click the label in the Report Header band, to select it, and in the Property Grid, set its Bookmark property to the
same value as its text (that is, Products by Categories).

9. Select the label in the report's Group Header band. As this control is bound to data, we will bind its Bookmark
property to the same data field, using the (Data Bindings) property.
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10. For this field, set the Parent Bookmark property to the Report Header's label to define the document map
hierarchy.

11. The report with bookmarks is now ready. Switch to the Preview tab, and view the result.

How to Create Hyperlinks
This procedure demonstrates how to create a hyperlink in a report.

Note:  A label will behave as a hyperlink both in a report's Print preview, HTML preview and when the report
is exported to PDF, HTML, MHT, RTF and XLS formats.

1. Create a new report.
For more information, see Create Reports.

2. Drag a Label onto the report and change its Text to the one which is required for the link.
3. In the Property Grid, set its Navigation Target property to the required value (_blank, _parent, _search, _self, or

_top), and for the Navigation URL property, define the URL.
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4. The hyperlink is now ready. Switch to the Preview tab to view the result.

How to Add a Cross Reference
Perform this procedure to create a report with a cross-reference.

A cross-reference is a link whose target is located within the current document. This allows you to establish easy
navigation through a report. In this example, we create a grouped report with a link at the bottom of each group,
leading to the beginning of the report.

1. Create a report with grouping.
For more information, see Change or Apply Data Grouping to a Report.

2. To add a Report Header band to the report, right-click anywhere over the report's surface, click Insert Band >
ReportHeader.

3. Drag a label onto the new ReportHeader band to serve as the report's headline. Click the label, to type the desired
contents into it. Then, in the Property Grid, set its Name property to reportTop.

4. Add a Group Footer band to the report.
To do this, right-click anywhere over the report's surface, and click Insert Band > GroupFooter.

5. Again, drag a label onto the band.
As the band will be the link, change its text to Top of Report, and apply the common formatting to it (blue color
and underlined text).

6. Finally, set the band's Navigation Target property to _self.
Now, if you click the drop-down list of the Navigation URL property, you can see the controls available in your
report. Choose the one named reportTop.
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7. The cross-reference is now ready. Switch to the Preview tab to view the result.

Miscellaneous Topics in Reports

This topic covers the Report Designer features that do not belong in other categories.

• Show the current row index
• Count the number of records in a report or group
• Cancel printing if a report does not contain any records
• Limit the number or records per page

How to Show the Current Row Index
Perform this procedure to show the current row index in a report.

1. Create a new report or open an existing one.
For more information, see Create Reports

2. Drag required fields from the Field List onto the report's Detail band.
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3. To create an exact copy of the Label that will display the index, press Ctrl on the keyboard while you drag the
field for which the current row index will be displayed.

4. Select the new Label, and in the Property Grid, click the browse button (...) in the Summary property box.
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This opens the Summary Editor dialog box. In this dialog box, the Bound field is already set to the required data
field.

5. For Summary function, click RecordNumber.
6. To avoid null data fields from affecting the calculation, select the Ignore NULL values check box.
7. Finally, for Summary Running, click Report (Group or Page if required)
8. Click OK to save your changes and close the dialog box.

How to Count the Number of Records in a Report or Group
Perform this procedure to count the number of records in a report or a group.

1. Create a new report or open an existing one.
For more information, see Create Reports

2. Add a Report Footer band to a report.
To do this, right-click anywhere over the report's area and click Insert Band > ReportFooter.

3. In the same manner, add GroupHeader and GroupFooter bands to the report.
4. Drag the required data fields from the Field List onto the report bands.
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5. To create an exact copy of the Label that will display the number of records for a group, press Ctrl while you drag
the field for which the number of records will be calculated onto the Group Footer area.

6. In the same way, create a copy of this field in the Report Footer area to display the number of records for the
report.

7. Click the Smart tag of the GroupHeader1 band, and in the invoked actions list, click the browse button (...) in the
Group Fields box.

This opens the GroupField Collection Editor dialog box.
8. Click the Add button to add a new grouping field, set its FieldName property to the required field, and click OK.
9. Select the Label in the Group Footer area, and in the Property Grid, expand the Summary property.



Output Manager Administration Guide
Version 4.0 SP2

415 © 2016 Nuance Communications, Inc. All rights reserved.

10. Set the Summary property values for the Group Footer as follows:
Property Value

Running Group

Function Count

Ignore Null Values Yes

Format String Products in the Group: {0}

11. Similarly, select the Label in the Report Footer area, and in the Property Grid, expand the Summary property.

12. Set the Summary property values for the Report Footer as follows:
Property Value

Running Report

Function Count

Ignore Null Values Yes

Format String Products in the Report: {0}

13. The report is now ready. Switch to the Preview tab and view the result.
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How to Cancel Printing when a Report Does Not Contain Any Records
Perform this procedure to cancel printing for a report that does not contain any records.

• Set the Detail band's Print when Data Source is Empty property to No.

Tip:  You can quickly perform step this with the band's Smart tag.

How to Limit the Number of Records per Page
Use this procedure to limit the number of records shown on pages of a report.

This procedure demonstrates how the number of records shown in a report can be limited by means of conditional
formatting. In particular, a formatting rule is applied to the Visible property of the Page Break control. In this
example, the number of data rows is passed to the report as a parameter.

1. Create a new report or open an existing one.

In this procedure, a table report is used as a starting point.

2. To add a parameter to the report, in the Field List, right-click the Parameters section, and click Add Parameter.
3. For the new parameter, set property values as follows:

Property Value

(Name) rowsNumber
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Property Value

Parameter Type Int32

Description Rows per Page:

4. From the Tool Box, drag the Page Break control onto the report's Detail band at the top of the detail table.

5. For the new control, set the Visible property to No, and click the browse button (...) in the Formatting Rules
property box to open the Formatting Rule Editor dialog box.

6. Click the Edit Rule Sheet button to open the Formatting Rule Sheet Editor
7. Click the add button (+), to create a new formatting rule.
8. Set The new rules Visible property to Yes, and click the browse button (...) in the Condition property box to open

the Condition Editor dialog box.

9. In the Condition Editor dialog box, define the following expression for the rule:

• ([DataSource.CurrentRowIndex] % [Parameters.rowsNumber] == 0) And ([DataSo
urce.CurrentRowIndex] != 0)

10. Click OK to save the changes and close the dialog box, and then click Close to close the Formatting Rule Sheet
Editor.

11. In the Formatting Rules Editor, first select the new rule in the Available Rules box, then click the > button to
move it to the Applied Rules box.

12. Click OK to close the Formatting Rules Editor dialog box.
13. The report is now ready. Switch to the Preview tab, and in the Parameters section, define the required value, and

click Submit.
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Resources

Managing Resources
You can manage all Nuance Output Manager resources in the Resource Manager dialog box. Resources are available
to any Nuance Output Manager service, running on any server. For example, 2 Nuance Output Manager Output
Services running on 2 different servers, could use the same resources. The following are the available resource types:
CpMillUnitLibrary, CpMillProfile, banner, PrinterControlFile, FCB, CsvDocProp, binary, text, and Ini. Resources are
used in business rule and output process actions.

• Add resources
• Modify resources
• Remove resources
• Import resources
• Export resources
• Configure Resources

• CpMillUnitLibrary resource
• CpMillProfile
• Banner resource
• PrinterControlFile resource
• FCB resource
• CsvDocProp resource
• Binary resource
• Text resource
• Ini resource

How to Add Resources
Complete the steps in this procedure to create Nuance Output Manager resources.

The resources created in the Resource Manager dialog box can be used in business rule and output process actions.

1. On the Output Manager Console menu bar click Tools > Resource Manager.
This opens the Resource Manager dialog box.

2. In the Resource type list, select the resource type you want to create.
3. Click New. This opens a dialog box that displays options depending on the selected Resource type.

Resource Options

CpMillUnitLibrary Javascript programs used for Advanced Document
Modification. Displays the Configure Unit Library
dialog box.

CpMillProfile Text files describing transform configuration data for
specific file formats. Displays the Configure Filter
Profile dialog box.
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Resource Options

Banner Text files used for banners or trailers that may contain
document properties. Displays the Banner Resource
dialog box.

PrinterControlFile Reserved for printer control files, not presently used.
Displays the PrinterControlFile Resource dialog box.

FCB Form Control Block used by DCOs for various record
conversions. Displays the FCB Resource dialog box.

CsvDocProp Comma separated values representing document
properties. Displays the CsvDocProp Resource dialog
box.

Binary Binary files used by output process actions. Displays
the Binary Resource dialog box.

Text Text files used by output process actions. Displays the
Text Resource dialog box.

Ini Displays the Ini Resource dialog box.

4. Click OK.

How to modify resources
Complete the steps in this procedure to modify a resource.

1. On the Output Manager Console menu bar, click Tools > Resource Manager.
This opens the Resource Manager dialog box.

2. In the Resource type list, select the appropriate resource type.
3. In the grid, select the resource you want to change and click Modify.

The dialog box that opens depends on the type of resource selected.
4. Make the necessary resource changes and click OK.
5. Click OK.

How to Remove Resources
Complete the steps in this procedure to remove a resource.

1. On the Output Manager Console menu bar, click Tools > Resource Manager.
This opens the Resource Manager dialog box.

2. In the Resource type list, select the appropriate resource type.
3. In the grid, select the resource you want to delete and click Delete
4. Click OK.

How to Import Resources
Complete the steps in this procedure to import a resource.

1. On the Output Manager Console menu bar, click Tools > Resource Manager.
This opens the Resource Manager dialog box.

2. In the Resource type list, select the resource type you want to import.
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3. Click Import.
4. Select the resource file you want to import and click Open.

You can import previously exported Nuance Output Manager resources.
5. The resource will appear in the grid.

Note:  If a resource of that type and name already exists in the grid, the newly imported resource will have
a sequence number appended to its name.

6. Click OK.

How to Export Resources
Complete the steps in this procedure to export a resource.

1. On the Output Manager Console menu bar, click Tools > Resource Manager.
This opens the Resource Manager dialog box.

2. In the Resource type list, select the resource type you want to export.
3. In the grid, select the resource you want to export.
4. Click Export.
5. Choose the location you want to save the resource file and enter a File name.
6. Click Save.

Exported resource files contain the resource name, type, description, and the resource data in an XML format.
7. Click OK.

Configure Resources

How to Configure the CpMillUnitLibrary Resource
Complete the steps in this procedure to create a unit library.

Unit libraries are JavaScript modules that CpMill calls at certain known times while processing a document (for
example, begin document, page start, and page end). The modules can modify the contents of the document,
extract information from the document, write the document, or parts of it, to a new location, or perform many
other operations. For more information on configuring unit libraries, contact Nuance Communications Professional
Services.

1. In the Configure Unit Library dialog box, enter the unit library Name, Description, and any Comments.
2. In the Document Properties Needed list, select the document properties needed by the unit library.

These properties will be written to a file called <filename>.properties when Nuance Output Manager
calls the document modification software. This file can be opened and read in by the unit library.

3. In the Filters Needed list, select the filters needed for the unit library.

Tip:  Tips on selecting filters:

• Select any expected input types and output types
• If any interim data types are to be used in the script, include those types as well
• It is recommended to include the NUL file type

These filters will be written to a temporary location which will be sent to the document modification software.
4. If you want to import the unit resource data, under Import Resource Data, click Browse and select the

appropriate resource file. Specify the Code page to be used with the resource data.
The resource data will display in the Unit box.
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5. Under Unit, specify the unit library. Enter the unit library code within the <script> </script> tags in the
appropriate event handler sections.

Tip:  Review the default comments of a new unit library for descriptions of the parameters sent from
Nuance Output Manager to the unit library and information about how to tell Nuance Output Manager
about the documents modified or created by the unit library.

6. If necessary, click Reload Variables from Unit to populate the Output variables grid with any output variables
defined in the unit library.

7. Click OK.

How to Configure a CpMillProfile Resource
Complete the steps in this procedure to configure a filter profile.

1. In the Configure Filter Profile dialog box, specify the Data type of the filter profile.
2. Enter the resource Name, Description, and any Comments.
3. For a custom filter profile, copy the profile data from the appropriate default CpMillProfile resource for the

desired data type. Then modify it as necessary in the new profile being created.
The Filter Profile box, contains the data for the transform software to use during transform operations. We
recommend that you copy and modify profile data from an existing profile rather than creating a new profile from
scratch.

4. Click OK.

How to Configure a Banner Resource
Complete the steps in this procedure to create a banner resource.

1. In the Banner Resource dialog box, enter the resource Name, Description, and any Comments.
2. In the Printer Family list, use the check boxes to determine if the resource will be used for all printer families or

only for certain printer families.
3. In the Data Type list, use the check boxes to determine if the resource will be used for all data types or only for

certain data types.
4. If you want to import the banner resource data, under Import Resource Data, click Browse and select the

appropriate resource file. Specify the Code page to be used with the resource data.
The resource data will display in the Resource Editor box.

5. In the Resource Editor box, enter the text to be used for the banner data.
You may also embed document properties and functions within the text using the editor’s context menu.

Note:  You may alternately use the Nuance Output Manager BDL (Banner Definition Language) that was
employed in the legacy product (Output Manager Print Server). This results in a neatly formed banner
page.

6. Click OK.

How to Configure a PrinterControlFile Resource
Complete the steps in this procedure to create a PrinterControlFile resource.

1. In the PrinterControlFile Resource dialog box, enter the resource Name, Description, and any Comments.
2. In the Printer Family list, use the check boxes to determine if the resource will used for all printer families or

only for certain printer families.
3. In the Data Type list, use the check boxes to determine if the resource will be used for all data types or only for

certain data types.
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4. If you want to import the PrinterControlFile resource data, under Import Resource Data, click Browse and then
select the appropriate resource file. Specify the Code page to be used with the resource data.
The resource data will display in the Resource Editor box.

5. In the Resource Editor box, enter the control codes for a specific printer to enable or disable features.
This is normally created using a Hex editor.

6. Click OK.

How to Configure an FCB Resource
Complete the steps in this procedure to create an FCB resource.

The forms control buffer (FCB) defines the page layout for output sent to a printer. FCBs apply to laser and impact
printers. A default FCB is associated with each form used for printed output.

1. In the FCB Resource dialog box, enter the resource Name, Description, and any Comments.

Note:  The FCB name is important since the FCB selection from the output process or business rule
action will select an FCB resource based on the Document Property field used. In most cases the
Document.Property.Form Name field is used as the variable in selecting the FCB resource. For example, if
you receive a file from the mainframe via RJE the PDIR record is processed and any form name found is
mapped to the Form Name document property. Then during conversion, the corresponding FCB resource
will be used to format the report. A PDIR form name of CHKS would expect that there was an FCB
resource defined named CHKS and would apply the CHKS FCB resource. If the action cannot find the
FCB resource it will apply STD.

2. In the Printer Family list, use the check boxes to determine if the resource will used for all printer families or
only for certain printer families.

3. In the Data Type list, use the check boxes to determine if the resource will be used for all data types or only for
certain data types.

4. If you want to import the FCB resource data, under Import Resource Data, click Browse and select the
appropriate resource file.
The resource data will show in the Resource Editor box.

5. In the Lines/Inch list, determine the line spacing.
You can change the value to 8 to tighten the line spacing and enable more data to fit on a page. The default is 6
lines per inch.

Tip:  You can set the top margin by reviewing the Lines/Inch value and adding a channel stop at the
desired line number. For example, if you want a half-inch top margin and the FCB is configured with the
defaults (6 lines per inch, 66 lines per page), you would set channel stop 1 at line 3.

6. In the Printable lines/page box, enter the number of lines that will print per page.
For example, if there are 66 Lines/Page and you enter 60 Printable lines/page, then you will print lines 1 through
60 on each page of the document.

Tip:  You can set the bottom margin by changing the Printable lines/page value. By default the Printable
lines/page value is equal to the Lines/page value. For example, if you want a half-inch bottom margin
and the FCB is configured with the defaults (6 lines per inch, 66 lines per page), you would set Printable
lines/page value to 63 lines per page.

7. In the Lines/page box, determine the page length.
The page length is calculated by multiplying the length of the paper (usually 11 inches) by the number of lines per
inch (usually 6). The default is 66 lines per page. This will change the size of the FCB that is sent with the data.

8. To add a channel stop, click Add.
This opens the Add Channel dialog box.
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9. Enter the channel stop and line number, and then click OK.
Channel stops must be entered as a decimal value from 1 to 12. To enter hexadecimal values for A, B, and C, enter
10, 11, and 12 respectively. The hexadecimal value is written correctly as 0A, 0B, and 0C when the FCB file is
saved.

Tip:  Channel stops are used to define vertical spacing. When a printer encounters a command to advance
to a channel stop, the print head moves to the specified line and the data is printed. Channel stop 1 usually
indicates the top of the form or the first line where the printer will begin printing.

10. To change the FCB’s sort order, click the Channel or Line Number column headings.
When you click a column heading, the data of both columns will sort in ascending order based on the column
selected.

11. Click OK.

How to Configure a CsvDocProp Resource
Complete the steps in this procedure to create a CsvDocProp resource.

1. In the CsvDocProp Resource dialog box, enter the resource Name, Description, and any Comments.
2. In the Printer Family list, use the check boxes to determine if the resource will used for all printer families or

only for certain printer families.
3. In the Data Type list, use the check boxes to determine if the resource will be used for all data types or only for

certain data types.
4. If you want to import the CsvDocProp resource data, under Import Resource Data, click Browse and select the

appropriate resource file. Specify the Code page to be used with the resource data.
The resource data will show in the Resource Editor box.

5. In the Resource Editor box, enter comma separated values (CSV) or text.
You can also create a resource with a table of information using the CSV format.

6. Click OK.

How to Configure a Binary Resource
Complete the steps in this procedure to create a binary resource.

1. From the Binary Resource dialog box, enter the resource Name, Description, and any Comments.
2. In the Printer Family list, use the check boxes to determine if the resource will used for all printer families or

only for certain printer families.
3. In the Data Type list, use the check boxes to determine if the resource will be used for all data types or only for

certain data types.
4. If you want to import the binary resource data, under Import Resource Data, click Browse and select the

appropriate resource file.
The resource data will show in the Resource Editor box.

5. In the Resource Editor box enter the binary data without regard to spacing. The spacing is taken care of
automatically by the editor.
The Resource Editor box is a special edit area that accepts only hexadecimal digits (0-9 and A – F).

6. You can enter a number in the Create Hex Size box to set the data capacity. This has the following effect:

• If there is already data in the edit area, any data at or below the new size will remain intact. Any data beyond
the new specified size will be erased from the editor.

• If existing data is smaller than the new size, the space after existing data is padded with empty bytes (00) up to
the requested size.



Output Manager Administration Guide
Version 4.0 SP2

424 © 2016 Nuance Communications, Inc. All rights reserved.

• If no data currently exists in the editor when setting the size, the editor is filled with empty bytes (00) up to the
requested size.

7. Click OK.

How to Configure a Text Resource
Complete the steps in this procedure to create a text resource.

1. In the Text Resource dialog box, enter the resource Name, Description, and any Comments.
2. In the Printer Family list, use the check boxes to determine if the resource will used for all printer families or

only for certain printer families.
3. In the Data Type list, use the check boxes to determine if the resource will be used for all data types or only for

certain data types.
4. If you want to import the text resource data, under Import Resource Data, click Browse and select the

appropriate resource file. Specify the Code page to be used with the resource data.
The resource data will display in the Resource Editor box.

5. In the Resource Editor box, enter the text data.
6. Click OK.

How to Configure an Ini Resource
Complete the steps in this procedure to create an Ini resource.

1. In the Ini Resource dialog box, enter the resource Name, Description, and any Comments.
2. In the Printer Family list, use the check boxes to determine if the resource will used for all printer families or

only for certain printer families.
3. In the Data Type list, use the check boxes to determine if the resource will be used for all data types or only for

certain data types.
4. If you want to import the text resource data, under Import Resource Data, click Browse and select the

appropriate resource file. Specify the Code page to be used with the resource data.
The resource data will display in the Resource Editor box.

5. In the Resource Editor box, enter text, document properties, and functions as necessary.
To Do this

Insert document properties Right-click in the box, click Insert Document
Property, and choose the appropriate properties.

The document properties will display enclosed in
brackets ([]).

Insert functions Right-click in the box, click Insert Function, and
choose the appropriate function.

For information on configuring functions, see Using
Nuance Output Manager functions.

6. Click OK.
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Server and Database
Administration

The Message Console

Learning About the Message Console

The Message Console can be used to gather information about program activity and to view all messages for a
selected destination, source, or document.

To view program activity Click Tools > Message Console on the Output Manager
Console menu bar. The console will display activity that
occurs during normal program operation. The console
effectively traces program code by recording a priority
level and filtering modules and messages.

To view all messages for a
destination, source, or document

In the appropriate grid, right-click a destination, source,
or document and click View messages. The console will
display all messages related to the selected item.

Click the portion of the window you want to learn more about.

1. Toolbar on page 426
2. Message Grid on page 426
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3. Status bar on page 427
4. Message Panel on page 427

Toolbar

The toolbar displays below the title bar and provides quick access to commands.

Button Description

File Commands on this menu Open and Save message logs,
Load all messages, and Close the Message Console.

Configure Specifies the message priority for each program module
s and sets the module-specific priority levels of the recor
ds that will appear on the console. Records will be displ
ayed for selected modules which have a priority level les
s than or equal to the value selected. Displays the Adjust
Message Priority dialog box.

Resume Resumes scrolling in the Message Console window. Use
this after the Pause option.

Pause Pauses the console scroll in the Message Console windo
w. Allows you to pause the console to view messages.

Clear Messages Clears the message currently displaying in the Message
Console window.

Message Panel Displays a message preview panel. Details of the selecte
d message will display in the panel.

Message Grid

You can customize the message grid view by sorting, filtering, and grouping by columns. These actions are useful
when trying to quickly find messages in the Message Console. You can also add and remove columns and change the
order in which the columns display. The messages are sorted by the date and time they are received. The most recent
messages appear at the top of the window.

Tip:  From the Message Console, you can copy and export messages. To copy messages, select the rows you
want to copy and then right-click and click Copy. You can then paste the contents into Microsoft Excel. This
will paste the contents of the entire row. To export specific messages, select the rows you want to export and
then right-click and click Export. Export the file as necessary from the Preview window that displays.

Column Description

Message Id A unique identification number for each message.

Client Time The date and time that an activity occurred.

Message Details about the activity.

Server Name The server where the activity occurred.

Message Module The module name where the activity occurred.

Name The name of the user who generated the message.
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Column Description

Dialog Result This column is only populated for messages that were al
so displayed as a message box. The choice that was mad
e on the message box (the button that was clicked) displ
ays in this column. For these types of messages, you can
view the message box text in the Message column and t
hen view the action the user took in the Dialog Result c
olumn.

Message Priority The priority level of the message. Colors are used to repr
esent different priority levels. See the following table.

Table 3: Message Priorities

Level Color Description

Operator Failure light red Errors that halt execution.

Operator Warning light yellow Warns of a potential problem.

Operator Information white Informs of normal operation.

Support Trace light orange Messages for troubleshooting that tra
ck normal process flow and protocol
execution.

Development Failure red Informs programmer of infrequent, b
ut important, task.

Development Warning yellow Informs programmer of infrequent, b
ut less critical, task.

Development Information gray Informs programmer of regular oper
ation.

Development Trace orange Informs programmer of detailed ope
ration.

Message Panel

Displays the details of the selected message. Click the Message Panel toolbar button to show/hide the message panel.
You can also double-click a message in the grid to display the panel.

Status bar

Button Description

Print Prints the contents of the console window.

Help Displays help for the Message Console. The Help windo
w incorporates contents, index, search, favorites, and glo
ssary tabs to make it easy for you to find answers to you
r questions.
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Button Description

Search Not currently available.

Navigation Allows for paging through the grid. Click first page (<<),
previous page (<), next page (>), or last page (>>).

Records Displays the number of messages in the console window.

Using the Message Console

The Message Console gathers information about program activity. The console is used as a tool to record and display
activity that occurs during normal program operation. It also generates comprehensive information that can be used by
Nuance developers and support staff to troubleshoot program operation if necessary. Once the program begins, data is
automatically traced according to defined priorities and servers/modules selected.

• Capture trace data
• View message for a destination, source, or document
• Show/hide the message panel
• Clear messages from the console
• Copy messages to Microsoft Excel
• Export/import messages
• Pause and resume automatic refresh

How to Capture Trace Data
To trace activity, select the modules and set the priority level for each module. Records with a priority level less than
or equal to the set priority level will display in the Message Console.

Warning:

Performance tuning Setting the priority level higher than Operator
Information can cause performance degradation.
Because the Message Console continues to process
information after you close the utility, you must
check the priority level setting before you close.
If you experience any problems, we recommend
changing the priority level setting to Operator
Information.

1. In the Output Manager Console, click Tools > Message Console to open the Message Console utility.
2. On the toolbar, click Configure.

This opens the Adjust Message Priority dialog box.
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3. Set the priority level for the appropriate modules. The console will display records that have a priority level less
than or equal to the selected priority level. There are several ways to set the module's priority level.

To Do this

To set a module's priority • Click the Priority cell for the appropriate server/
module row and select the priority level from the
list.

Note:  The Server column lists all servers
with Nuance Output Manager services
installed. For each server, the Message
Module column lists each module. Use the
server/module row to specify a priority for
each module on a specific server.

To set all modules on a server
to the same priority level

1. In the Message Module column locate the All
Modules on this Server cell for the appropriate
server.

2. In that row, click the Priority cell and select the
priority level from the list.

All messages for the selected server to be set to
the specified priority level. All of the other rows
will remain unchanged in the grid, but the Message
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To Do this
Console messages will be set at the priority specified in
the All Modules on this Server row.

4. Click OK to save changes close the Message Priority dialog box.

How to View Messages for Destination, Source, or Document
Use this procedure to view messages.

From the Destinations, Sources, or Documents grid, right-click the item you want to view messages for and click
View messages.
The console will display all messages related to the selected item.

How to Show/Hide the Message Panel
Use this procedure to show or hide the message panel in the Message Console.

• Click the Message Panel toolbar button or double-click a message in the grid.

The message panel will display below the message grid. The details of the selected message will display in the panel.

How to Clear Messages from the Console
Use this procedure to clear messages currently displaying in the Message Console.

• Click the Clear Messages toolbar button.

How to Copy Messages to Microsoft Excel
Complete the following steps to copy messages and paste them into Microsoft Excel.

1. From the Message Console utility, select the rows you want to copy.
2. Right-click in the selected rows and click Copy.
3. Open Microsoft Excel and paste the messages.

Completing this step will paste the contents of the entire row.

How to Export/Import Messages
Use these procedure to export messages or the message log file.

From the Message Console you can export specific messages and the message log file. You can also import message
log files that were previously exported.

• Export specific messages
• Export a message log file
• Import a message log file

To export/import messages

1. In the Message Console utility, select the rows you want to export.
2. Right-click the selected rows and click Export.

This opens the Preview window.
3. Export files as needed from the Preview window.

To export a message log file

1. On the Message Console toolbar, click Tools > Export.
2. Select the location where you want to save the log file and click Export.
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3. Click OK.

To import a message log file

1. On the Message Console toolbar, click Tools > Import.
2. In the Open dialog box, select the log file you want to import.
3. Click OK.

The log file displays in the Message Console window.

How to Pause and Resume Automatic Refresh
You can use the toolbar buttons to pause and resume the automatic refresh feature.

The Message Console automatically refreshes to always display newly received messages.

• To pause automatic refresh, click the Pause button on the toolbar.
• To resume automatic refresh, click the Resume button on the toolbar.

How to Set General Preferences
Use this procedure to configure general administrative options.

The Set General Preferences utility allows an administrator to set operational parameters that apply globally to an
instance of Nuance Output Manager. The utility is divided into six tab pages that set General, Destination, Security,
Reporting, Kiosks, and Client options.

1. In the Output Manager Console navigation pane, click the Administration application.
2. Click the Set General Preferences link.

This opens the Set General Preferences utility in the console window.
3. Configure settings on the tabs in this window. You can click in the following table to view options for a table.

Tab Description

General tab Sets general options in the preferences.

Destination tab Specifies which print preferences/document properties
are supported throughout Nuance Output Manager.

Security tab Configures security settings.

Reporting tab Configures reporting settings.

Kiosks tab Add, Remove and Configure kiosks associated with
devices and optional MFP/Kiosk profiles.

Clients tab Configures settings for client web servers.

4. Click the Apply button to save changes to the general preferences.

System Health utility
This utility shows current status for the Output Manager applications.

The System Health utility is located in the Administration application. It shows the current support status for Output
Manager as well as the status for application objects. You can click an of the application boxes in this utility to drill
down to the application.
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Option Description

Manage OM Server This section shows the system and support agreement st
atus for Output Manager. Click the Manage OM Server
button to open the Server Manager. In the Server
Manager you can perform tasks to manage the Output
Manager server.

Destinations This cell shows status statistics for destinations. The cou
nts show numbers of destinations with errors, or that are
down, disabled, and online. Click anywhere in this cell to
open the Destinations application.

Sources This cell shows status statistics for sources. The counts s
hows numbers of sources that are disabled and enabled.
Click anywhere in this cell to open the Sources applicati
on.

Services This cell shows status statistics for services. The count
s shows numbers of services that are online and offline
. Click anywhere in this cell to open Manage Product
Components utility.

Total Documents This cell shows the number of status of all documents.

Problem Documents This cell shows the numbers of problem documents.

Database This cell shows used/free space utilization in the Output
Manager database.

Document file stores This cell status for file stores.

• Location - The physical path to the file store
location.

• Default - This is selected if a file store is the default
file store for the Output Manager server.

• Status - Shows whether a file store is in use.
• Capacity Remaining - Shows the percent remaining

capacity for the file store.
• Condition - Shows the color code for the condition

of the file store (green, amber, or red).

Other statistics • Library document count
• Output history count
• Message console count
• Pending job status count

Managing Services through Microsoft Windows
You can use the Microsoft Windows Services utility to manage Nuance Output Manager services. The services appear
as follows in the Microsoft Windows Services dialog box:
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• Nuance Output Manager DBM Service
• Nuance Output Manager Input Service
• Nuance Output Manager Output Service
• Nuance Output Manager Rules Agent Service
• Nuance Output Manager SNMP Service

See Microsoft Windows documentation for more information on configuring services.

The following topics provide more information on configuring log on credentials for Nuance Output Manager
services:

• Configure services to log on as a system account
• Configure services to log on as a user account

How to Configure Services to Log on Using the Local System Account
Use this procedure to configure Nuance Output Manager services to use the Local System account to log on.

Warning:  The account type is specified during installation of the software. If you must change your account
type, we recommend you uninstall and then reinstall the software selecting the appropriate account type.

If you are unable to uninstall and reinstall the software, you can also use one the following procedure to configure a
service to use the Local System account to log on.

1. Open the Windows Services utility.
For more information, see Opening the Windows Services Utility

2. Right-click the desired Nuance Output Manager service, and then click Properties, or select the service and on the
menu bar click Action > Properties.
This opens the Properties dialog box.

3. On the Log On tab, under Log on as, click Local System account, and then click OK.
4. Right-click the Nuance Output Manager service, and then click Start, or select the service and on the menu bar

click Action > Start.
5. Close the Services utility.

How to Configure Services to Log On Using a User Account
Use this procedure to configure Nuance Output Manager services to use a user account to log on.

Warning:  The account type is specified during installation of the software. If you must change your account
type, we recommend you uninstall and then reinstall the software selecting the appropriate account type.

If you are unable to uninstall and reinstall the software, you can also use the following procedure to configure a
service to log on as a user account.

1. Add the user account as a member of the Administrators group.
2. Open the Windows Services utility.

For more information, see Opening the Windows Services Utility
3. Right-click the Nuance Output Manager service, and then click Properties, or select the service and on the menu

bar click Action > Properties.
This opens the Properties dialog box.

4. On the Log On tab, under Log on as, click This account, and then type the desired user account name or click
Browse to select a user account.
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5. In the Password and Confirm Password boxes, type and confirm the password that is associated with the user
account, and then click OK.

6. Right-click the Nuance Output Manager service, and then click Start, or select the service and on the menu bar
click Action > Start.

7. Close the utility.
8. If this is a network account, grant the user access to the service by setting up DCOM.

a) On the taskbar, click Start > Run.
b) In the Open box, type dcomcnfg, and then click OK to run the Distributed COM Configuration Properties

utility (DCOM).
c) On the Applications tab, select the desired spool service, and then click Properties.
d) On the Identity tab, click This user.
e) Click Browse to select a user that is already defined, or define a new user by entering values in the User,

Password, and Confirm Password boxes.
f) Click OK twice.
g) Restart the desired Nuance Output Manager service through the Microsoft Windows Services utility.

Note:  If you are using the Output Manager Print Utility service to access network drives, you do not need
to set up DCOM access.

Managing the Output Manager Console License
Procedures in this section describe how to install, activate, and manage licenses for Nuance Output Manager.

Use the Manage License Utility to install, activate, and manage licenses for the Nuance Output Manager software.
After Nuance Output Manager is installed, you must install and activate the license. Later, the license details such
as license file location or the updating of license information can be managed. The Manage License Utility can be
used by any Output Manager Console user that has been given permission on the Security Configuration dialog box.
Nuance Output Manager administrators have permission by default.

The following procedures describe how to install, activate, and deactivate the license.

• Install the license
• Activate the license
• Deactivate DBM components/Uninstall the license

Selecting the license file location

You select a location for the license file; it is not automatically stored at a certain location. Because the license file
is so important, choose a location that is memorable and secure. For example, rather than storing the file in the temp
folder, you might store it in the application folder (C:\Program Files\NSi\Output Manager).

Important:  License files cannot be modified. The license file contains a digital signature, and if the file
is edited the file will no longer match the digital signature. This is true even if a space is entered and then
deleted. The license file can be opened in Internet Explorer or in Notepad without destroying the license
functionality, as long as Notepad is closed without saving. If you edit the license file, it will not install. If you
edit a license file that is already installed and activated, Nuance Output Manager will no longer function.
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Refreshing license information

In some organizations, more than one person might have the Manage License Utility displayed at a time. When an
administrator installs a new license, the new license data is displayed on that administrator’s screen. If other users
have the Manage License Utility opened, the new information will be displayed within a minute. If other users want
to check the license status immediately click Refresh or close and reopen the utility. We recommend administrators
notify the other users to refresh the dialog box so they can view the new license data.

How to Install the Output Manager License
Complete this procedure to install an Nuance Output Manager license.

You will typically install the Nuance Output Manager license during the software installation procedure.

1. In the Output Manager Console navigation pane, select the Administration application.
2. In the navigation pane, click Manage License.

This displays the Manage License Utility in the right panel.
3. Click License Wizard.

This opens the License Wizard.
4. In the License Operation dialog box, select Install and activate a new license, and click Next.
5. In the License File Installation dialog box, determine if you want to install the license automatically using an

Internet connection or manually by selecting the license file.

• To install the license automatically, select the radio button next to Install License Automatically. An internet
connection is required to install automatically. Enter the License key for this Nuance Output Manager system.

Tip:  During Nuance Output Manager order processing an Nuance Output Manager license was
created that matches the options ordered. The license key was sent in an email to the ordering
customer. If you cannot locate your license key, contact Nuance Communications Technical Support or
Sales for assistance.

• To install the license manually, select the radio button next to Install License Manually. In the License file
box, type the path and file name of your license file or click the browse button to locate the file and select it.

6. Click Next.
7. In the License Confirmation dialog box, confirm the license information is correct and click Next.

Note:  The Next button will not activate if the License key is not recognized.

8. In the Activate OM License dialog box, you can choose to activate the software at this time.

• To activate the software, refer to Activating the license to complete the activation.
• To complete the installation without activating the license, select Skip activation at this time, then click Next,

and Finish.

You can activate the license at a later time using the License Wizard.

How to Activate the License
Use one of the procedures in this section to activate a license file.

You can activate all DBM components via the Internet or perform a custom activation by selecting the individual
Nuance Output Manager DBM components you want to activate.

1. Activate all DBM components via the Internet
2. Perform custom DBM activation via the Internet
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3. Perform custom DBM activation manually

To activate all DBM components via the Internet
This method will automatically activate all DBM components using an Internet connection.

An internet connection is required to use this method.

1. In the Activate License dialog box, click Activate all DBM components via the Internet, and click Next.
A confirmation dialog box will display that the activation is complete.

2. Click Next, and then click Finish.

To perform custom DBM activation via the Internet
This method allows you to activate selected Nuance Output Manager components via the Internet.

An internet connection is required to use this method.

1. In the Activate License dialog box, select Custom DBM activation and click Next.
2. In the Custom DBM Activation dialog box, select the Nuance Output Manager DBM components you want to

activate.
3. Select the Use Internet connection check box.
4. Click Next.

This displays the activation confirmation.
5. Click Next, and then click Finish.
6. In the Manage License Utility, verify that the License Status shows the license is activated with the proper

version number.
If some Nuance Output Manager DBM components are activated and some are not, the license status will show
Partial Activation.

To perform custom DBM activation manually
This method allows you to choose the Nuance Output Manager components you want to activate and activate the
license manually. Use this method if you do not have an Internet connection.

1. In the Activate License dialog box, select Custom DBM activation and click Next.
2. On the Custom DBM Activation dialog box, select the components you want to activate.

Important:  Do not select the Use Internet connection check box.

3. On a computer that is connected to the Internet, open Internet Explorer and browse to the  Notable Solutions Web
License (/weblicense.nsiautostore.com) web page.

4. Click Activation in the left column.
5. In the Product type list, select OM.
6. In the Serial box, enter the license serial number.
7. In the Version box, enter the Nuance Output Manager software version number.
8. In the HW Code box, enter the value from the Hardware Code column on the Custom DBM Activation dialog

box.
9. Click Get Code.
10. Copy the activation code and paste into the Activation Code column on the Custom DBM Activation dialog

box.
This will need to be pasted into the row that corresponds to the Hardware Code used in step 8 on page 436.

11. Click Next.

http://weblicense.nsiautostore.com/
http://weblicense.nsiautostore.com/
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A selection confirmation will display saying which Nuance Output Manager DBM components were selected and
the activation method.

12. Click Next.
The activation confirmation will display.

13. Click Next, and then click Finish.
14. In the Manage License Utility, verify the License Status shows the license is activated with the proper version

number.
If some Nuance Output Manager DBM components are activated and some are not the license status will show
Partial Activation.

How to Deactivate DBM Components/Uninstall the License
Use this procedure to deactivate Nuance Output Manager DBM components.

If you deactivate all Nuance Output Manager DBM components, the license will be uninstalled and all Nuance Output
Manager processing will stop.

1. In the Output Manager Console navigation pane, select the Administration application.
2. In the navigation pane, click Manage License.

The Manage License Utility is displayed in the right panel.
3. Click License Wizard.

This opens the License Wizard.
4. In the License Operation dialog box, click Deactivate DBM components/Uninstall license, and then click Next.
5. In the Deactivate DBM Components dialog box, select the components you want to deactivate.

Deactivating all components will uninstall the license.
6. To deactivate using the Internet, select the Use Internet connection check box.

Important:  If you do not deactivate via the Internet, the activation database at Nuance Communications
will not be updated. Please contact  Notable Solutions Web License (/weblicense.nsiautostore.com) directly
to keep the license in the correct activation status.

7. Click Next.
A warning message will appear prompting whether you are sure you want to uninstall the license and stop any
active Nuance Output Manager operations.

8. Verify all Nuance Output Manager operations have finished, and click Yes.
9. A confirmation will display saying the deactivation is complete. Click Next and then click Finish.

Managing Product Components
From the Manage Product Components Utility, you can view the current status of each Nuance Output Manager
component. You can also authorize servers and configure services to be monitored from the OM Console.

• View product components
• Monitor services from the Output Manager Console
• Authorize servers

http://weblicense.nsiautostore.com/
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How to View Product Components
Complete the this procedure to view the current product components.

1. From the Output Manager Console navigation pane, select the Administration application.
2. Click the Manage Product Components link.

This opens the Manage Product Components Utility window.
3. You can review all of the installed Nuance Output Manager components, including status, component type, server

for each component.

How to Monitor Services from the Output Manager Console
Complete this procedure to configure Nuance Output Manager services to display in the service status lights in the
Output Manager Console.

1. In the Output Manager Console navigation pane, select the Administration application.
2. Click the Manage Product Components link.

This displays the Manage Product Components Utility in the console window.
3. To enable/disable monitoring, select or clear the appropriate check boxes in the Monitored column.

Monitoring is only available for service components.
4. Click Apply.

Service status lights display to the right of the menu bar.
5. Move the pointer over a service status light to identify the service and status.

How to Authorize Servers
Complete this procedure to authorize Nuance Output Manager servers.

Servers that are not authorized appear in red text in the Manage Product Components Utility.

1. In the Output Manager Console navigation pane, click the Administration application.
2. Click the Manage Product Components link.

This opens the Manage Product Components Utility in the console window.
3. To authorize a server, select the check box in the Authorized column.

This will authorize the server and automatically select the check boxes for all components that are using the
server.

4. Click Apply.

SSL Certificate Manager
Use the SSL Certificate Manager to configure SSL certificates and bind them to ports for selected web services on
Nuance Output Manager server.

See the following topics for more information on configuring SSL for Nuance Output Manager:

Topic Description

Enable SSL for the Web service on an OM Server Follow steps in this procedure to enable SSL for the Web
service on an Output Manager server.

Disable SSL for the Web service on an OM Server Follow steps in this procedure to disable SSL for the
Web service on an Output Manager server.
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Topic Description

Assign certificate and binding for OM service port 8069 Follow steps in this procedure to assign certificate and
binding for an Output Manager Service port.

Unassign certificate and binding for OM service port
8069

Follow steps in this procedure to unassign certificate and
binding for an Output Manager service port.

Simultaneously assign a certificate and bind a port Follow steps in this procedure to simultaneously assign
a certificate and bind a port to enable SSL for the web
service on an Output Manager server.

Simultaneously unassign a certificate and unbind a port Follow steps in this procedure to simultaneously
unassign a certificate and unbind a port to disable SSL
for the web service on an Output Manager server.

Enabling or disabling SSL for the web service

How to enable SSL for Web service on an OM server
Follow steps in this procedure to enable SSL for the Web service on an Output Manager server.

1. Open the Output Manager Console.

• To do this, on the Windows desktop, click Start > All Programs > Output Manager > Output Manager
Console > Output Manager Console.

2. Verify that the SSL certificate is not already created.
a) Click the Administration application, click Set General Preferences, and then click the Clients tab.
b) Make sure that the Use SSL check box is not already selected.
c) Continue with step 2 if this check box is not selected.

3. Open the Output Manager Server Configuration Utility.

• To do this, right-click Start > All Programs > Output Manager > Output Manager Server > OM Server
Configuration, and click Run as administrator.

Running the utility as an administrator ensures elevated privileges required to write all information correctly to
the system registry.

4. In the Output Manager Server Configuration Utility window, click the SSL Certificate Manager tab.
5. In the Choose Certificate box, choose <New self signed> to create a new certificate.
6. In the Certificate Password box, enter a password for the certificate.

This enters a certificate name in the Certificate Name box and displays the Confirm Password box.
7. In the Confirm Password box, retype the password.

Tip:  Be sure to record the password for future use.

8. In the Web Service ports group, in the Select column, select the check box for the Service Key that you want to
use.

9. In the Port column, you can edit the port number to change the port number that Output Manager server uses to
communicate with the Web service.

10. In the same row of the table, select the Use SSL check box.
11. Click the Generate button
12. Click the Output Manager services configuration tab.
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13. Click the Select all services button, and then click Stop selected services.
This changes Status for all of the services to Stopped.

14. Click Start selected services to start all of the services.
This restarts all of the services. In the OM DBM Configuration, make sure that database server also shows as Ru
nning-SQL connected.

15. The SSL certificate is now created and functional, so you can close the Output Manager Server Configuration
Utility.

16. Verify that the certificate was created successfully.
a) Open the Output Manager Server Console.
b) In the Administration application, click Set General Preferences, and then click the Clients tab.
c) In the Configuration for client web servers group, confirm that the Use SSL check box is selected and that it

is shaded and unavailable.

SSL for the Web service was enabled successfully if the Use SSL check box is selected and unavailable after you
complete this procedure.

How to disable SSL for the Web service on an OM Server
Follow steps in this procedure to disable SSL for the Web service on an Output Manager server.

1. Open the Output Manager Console.

• To do this, on the Windows desktop, click Start > All Programs > Output Manager > Output Manager
Console > Output Manager Console.

2. Verify that the SSL certificate exists.
a) Click the Administration application, click Set General Preferences, and then click the Clients tab.
b) In the Configuration for client web servers groups, confirm that the Use SSL check box is selected and

shaded.
3. Open the Output Manager Server Configuration Utility.

• To do this, right-click Start > All Programs > Output Manager > Output Manager Server > OM Server
Configuration, and click Run as administrator.

Running the utility as an administrator ensures elevated privileges required to write all information correctly to
the system registry.

4. In the Output Manager Server Configuration Utility window, click the Output Manager services
configuration tab.

5. Start the services if they are stopped.

• To do this, select the Selected check box services that show Stopped in the Status column, and then click the
Start selected service button.

Notice:  In the Web service ports box, the Use SSL check box is selected for the Service Key that you
want to configure.

6. Click in the Choose Certificate box, and click the <browse> item in the list.
7. In the Open dialog box, select the certificate that was used to enable SSL, and click Open.
8. In the Certificate Password box, enter the password for the certificate.
9. In the Web service ports list, select the Select check box for the Service Key that you want to configure.
10. Clear the Use SSL check box for the Service Key.
11. Click the Un-assign button to unassign the certificate from the selected Service Key.

After you complete this step, the utility should display a status message at the bottom of the tab:
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Status: The SSL certificate has been successfully unassigned.
12. Click the Reset button.

This hides the Use SSL button for the selected Service Key.
13. Click the Output Manager services configuration tab.
14. Click the Select all services button, and then click the Stop selected services button.

This changes the Status for all of the services to Stopped.
15. Click Start selected services to start all of the services.

This restarts all of the services. In the OM DBM Configuration, make sure that database server also shows as Ru
nning-SQL connected.

16. Click on the OK button to close the Output Manager Server Configuration Utility.
17. Verify that the certificate was deleted successfully.

a) Open the Output Manager Server Console.
b) In the Administration application, click Set General Preferences, and then click the Clients tab.
c) In the Configuration for client web servers group, confirm that the Use SSL check box is cleared and not

shaded.

SSL for the Web service was disabled successfully if the Use SSL check box is cleared and available after you
complete this procedure.

Assigning or Unassigning a Certificate for a service port

How to assign certificate and binding for an Output Manager service port
Follow steps in this procedure to assign certificate and binding for an Output Manager Service port.

1. Open the Output Manager Server Configuration Utility.

• To do this, right-click Start > All Programs > Output Manager > Output Manager Server > OM Server
Configuration, and click Run as administrator.

Running the utility as an administrator ensures elevated privileges required to write all information correctly to
the system registry.

2. Click the SSL Certificate Manager tab.
3. In the Web service ports box, verify that there is no SSL certificate created for the Service Key that you want to

configure.

• The Use SSL check box will be cleared for the Service Key.
4. In Output manager service ports, in the Ports to bind list, select the check box next to the port that you want to

bind to the Output Manager service.
5. In the Choose Certificate box, click <New Self Signed> to create a new certificate.
6. In the Certificate Password box, type the password that you want to use for the certificate, and then type it again

in the Confirm Password box.

Tip:  Make sure that you record the password for future use.

7. Click the Generate button.
The certificate is now bound to the selected Output Manager service port.

8. Click the Output Manager services configuration tab.
9. Click the Select all services button, and then click Stop selected services.

This changes Status for all of the services to Stopped.
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10. Click Start selected services to start all of the services.
This restarts all of the services. In the OM DBM Configuration, make sure that database server also shows as Ru
nning-SQL connected.

11. Click the OK button to save your changes and close the Output Manager Server Configuration Utility.

How to unassign certificate and binding for an Output Manager service port
Follow steps in this procedure to unassign certificate and binding for an Output Manager service port.

1. Open the Output Manager Server Configuration Utility.

• To do this, right-click Start > All Programs > Output Manager > Output Manager Server > OM Server
Configuration, and click Run as administrator.

Running the utility as an administrator ensures elevated privileges required to write all information correctly to
the system registry.

2. Click the SSL Certificate Manager tab.
3. In the Web service ports box, verify that there is no SSL certificate created for the Service Key that you want to

configure.

• The Use SSL check box will be cleared for the Service Key.
4. In Output manager service ports, in the Ports to bind list, select the check box next to the port that you want to

unbind from the Output Manager service.
5. In the Choose Certificate box, click <browse> and select the certificate that was bound to the selected port.
6. In the Certificate Password box, enter the password for the certificate.
7. Click the Un-assign button.

At the bottom of the tab, the status message should show
Status: The SSL certificate has been successfully unassigned.

8. Click the Output Manager services configuration tab.
9. Click the Select all services button, and then click Stop selected services.

This changes Status for all of the services to Stopped.
10. Click Start selected services to start all of the services.

This restarts all of the services. In the OM DBM Configuration, make sure that database server also shows as Ru
nning-SQL connected.

11. Click the OK button to save your changes and close the Output Manager Server Configuration Utility.

Simultaneously assigning/unassigning a certificate and binding/unbinding a port

How to simultaneously assign a certificate and bind a port to enable SSL
Follow steps in this procedure to simultaneously assign a certificate and bind a port to enable SSL for the web service
on an Output Manager server.

1. Open the Output Manager Server Configuration Utility.

• To do this, right-click Start > All Programs > Output Manager > Output Manager Server > OM Server
Configuration, and click Run as administrator.

Running the utility as an administrator ensures elevated privileges required to write all information correctly to
the system registry.

2. Click the SSL Certificate Manager tab.
3. In the Choose Certificate box, choose <New self signed> to create a new certificate.
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4. In the Certificate Password box, type a password for the certificate, and in the Confirm Password box, retype
the password.

Tip:  Be sure to record the password for future use.

5. In Output manager service ports, in the Ports to bind list, select the check box next to the port that you want to
bind to the Output Manager service.

6. In Web Service ports, select the check box in the Select column for the Service Key that you want to configure.
7. In the Port column, enter the port number that you want to use, and then select the check box in the Use SSL

column.
8. Click the Generate button.

The SSL certificate is created for the web service and bound to the selected service port.
9. Click the Output Manager services configuration tab.
10. Click the Select all services button, and then click Stop selected services.

This changes Status for all of the services to Stopped.
11. Click Start selected services to start all of the services.

This restarts all of the services. In the OM DBM Configuration, make sure that database server also shows as Ru
nning-SQL connected.

12. Click the OK button to save your changes and close the Output Manager Server Configuration Utility.
13. Verify that the certificate was created successfully.

a) Open the Output Manager Server Console.
b) In the Administration application, click Set General Preferences, and then click the Clients tab.
c) In the Configuration for client web servers group, confirm that the Use SSL check box is selected and that it

is shaded and unavailable.

SSL for the Web service was enabled successfully if the Use SSL check box is selected and unavailable after you
complete this procedure.

How to simultaneously unassign a certificate and unbind a port
Follow steps in this procedure to simultaneously unassign a certificate and unbind a port to disable SSL for the web
service on an Output Manager server.

1. Open the Output Manager Server Configuration Utility.

• To do this, right-click Start > All Programs > Output Manager > Output Manager Server > OM Server
Configuration, and click Run as administrator.

Running the utility as an administrator ensures elevated privileges required to write all information correctly to
the system registry.

2. Click the SSL Certificate Manager tab.
In Web service ports, notice that the Use SSL check box is selected for the Service Key that you want to
configure.

3. In the Choose Certificate box, choose <browse>.
4. In the Open dialog box, select the certificate that was used for enabling SSL, and then click the Open button.
5. In the Certificate Password box, enter the password for the certificate.
6. In Output manager service ports, in the Ports to bind list, select the check box next to the port that you want to

unbind from the Output Manager service.
7. In Web Service ports, select the check box in the Select column for the Service Key that you want to configure.
8. Clear the check box in the Use SSL column.
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9. Click the Un-assign button.
The status message at the bottom of the tab should show:
Status: The SSL certificate has been successfully unassigned.

10. Click the Reset button.
The Use SS check box is no longer visible after you complete this step.

11. Verify that the certificate was deleted successfully.
a) Open the Output Manager Server Console.
b) In the Administration application, click Set General Preferences, and then click the Clients tab.
c) In the Configuration for client web servers group, confirm that the Use SSL check box is not selected and

that it is available.

SSL for the Web service was disabled successfully if the Use SSL check box is not selected and available after you
complete this procedure.

Back Up and Restore the Output Manager Database
You can configure Nuance Output Manager to backup and restore the Nuance Output Manager database. You should
make periodic database backups in case something causes the Nuance Output Manager database to become unusable.
If necessary, you could restore your database from a list of backups according to the date the backup was completed.

• Schedule periodic backups
• Restore a backup
• Back up files from the command prompt

How to Schedule Periodic Backups
Complete the steps in this procedure to automate the database backup.

The Windows Scheduled Tasks utility automates the process of periodically performing SQL database backups using
the Nuance Output Manager command line backup utility (OmBackupDatabase.exe).

1. Open the Windows Scheduled Tasks utility. Click Start > All Programs > Accessories > System Tools >
Scheduled Tasks.

2. On the menu bar, click File New Scheduled Task.
A new task will display in the grid.

3. Type a name for the task.
For example, Backup Output Manager Database.

4. Complete the following steps to configure the task.
a) Double-click the new task or right-click the task and click Properties.
b) On the Task tab, enter the command line in the Run box.

The following is an example command:

EomBackupDatabase -database=EOM_2.0.604.4 -Server=Serverxp2 -Folder="C:\Pr
ogram Files\NSi\Output Manager\Database\Backup" -Keep=10

Test the command from a command prompt first to verify you get the expected results. See Back up from a
Command Prompt.

c) In the Start in box, enter the folder where the program is located (C:\Program Files\NSi\Output M
anager).

d) In the Run as box, enter the appropriate user information.
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e) Click Set password and enter and confirm the password for the user in the Run as box.
f) On the Scheduled tab, set the desired schedule.

Creating a SQL backup puts some load on SQL Server, so you should scheduling the backup during periods
when there is low demand on the system.

5. Click OK.

The task will appear in the grid. The Next Run Time column will display the date and time the backup will be
performed.

Restore a Backup
Complete the steps in this procedure to restore a database using SQL Server Management Studio.

The database version must match the product version. Under some circumstances a previous version of the database
can be restored and then upgraded using the database creation utility. Typically, however, the most recent backup will
result in minimal data loss. Backups of older data from previous versions will represent result in the greatest data loss.

1. Stop all Nuance Output Manager services that use the database.
2. Open SQL Server Management Studio to restore the database from a backup file.
3. Right-click the Databases folder and click Restore Database.
4. In the To database box, select the database you want to restore or type the name in the box.
5. Select From device and browse to the desired backup file.

You will normally want to select the latest backup file unless there is a configuration problem you are trying to
avoid.
The file will show in the Select the backup sets to restore grid.

6. In the grid, select the check box next to the database you want to restore.
7. Click OK.

SQL Server Management Studio will show success or failure.
8. After the database is restored successfully, restart the Nuance Output Manager services.

Any configuration or activity that occurred after the backup was performed will be lost. The documents and their
respective states will only be current as of the backup date and time.

How to Back Up from a Command Prompt
Use this procedure to perform a backup from the Windows command prompt.

You can use the OmBackupDatabase.exe command line utility to manually backup an SQL database to a folder.
You can enter parameters to limit the number of backup files that will be saved by deleting the oldest backups. The
following table lists the available parameters. Executing the command without any parameters causes it to display
usage information.

1. Open a Windows command prompt windows.
2. Enter the following command at the command prompt to perform a backup.

• EOMBackupDatabase.exe  - Database = database_name  - optional_parameters
3. After the database name, you can type any of the parameters listed in the following table. Separate parameters

with a space.
Parameter Description

- Database = database_name Specifies the database. This parameter is required.
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Parameter Description

- Server = SQLServer / instance Where  SQLServer / instance  is the instance name of
SQL Server where the database is located. The default
server is localhost\SqlExpress.

The server name is required if SQL Server is installed
on a different computer from where the backup is being
performed and SQL Express is not being used.

An instance name is not used for the default instance
of SQL Server, but the instance name is required to
specify a named instance of SQL Server. By default,
SQL Express installs a named instance with the
instance name of SQLEXPRESS.

- Folder = backup_folder Where  backup_folder  is the path for the backup
folder. If the location does not exist, the folder will
be automatically created. File shares and any path
containing spaces must be enclosed between quotation
marks ("). If a backup folder is not specified, the
backup file will be saved in the default path for the
installation, for example C:\Program Files\NSi
\Output Manager\Database\Backup.

The backup file will be saved with a unique file name
using the database name, date, and time. This makes it
easy to see when a backup was created.

If you want to configure the software to automatically
purge older backup files, always use the same backup
folder. Using a folder on another computer will provide
additional security that data will not be lost due to a
disk failure at the cost of additional network usage

- Keep = number Where  number  is the maximum number of backups to
keep in the backup folder. After a backup is performed
for a database, the backup files are sorted and the oldest
files are deleted until the number of files to keep is
reached. The default number of backup files to be kept
is 30.

To disable purging, specify  Keep=0 . This will retain
all backup files.

How to configure NetWeaver integration
Perform this procedure to configure NetWeaver integration.

In the Configure NetWeaver Integration Utility, you can enable and configure properties for SAP NetWeaver
integration in Output Manager. You can enable multiple NetWeaver servers in Output Manager.
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1. To add a NetWeaver server for integration with Output Manager, configure settings in each column of the first
empty row.

Option Description

Name The name of the Output Manager Remote Function
Call (RFC) server.

Enabled Select this check box to enable the Output Manager
RFC server.

Application Server The SAP application server host name or IP address
that the RFC service will use to communicate with SAP
NetWeaver.

System Number The SAP application server host system number.

Callback Instance The name of the RFC callback instance corresponding
to the SAP callback receiving server.

Client The client identifier to use for communicating with the
SAP application server.

User Name User name that is authorized for the connection
between the RFC server and the SAP application
server.

Password The password associated with the specified User
Name.

Real OMS The name of the SAP Real OMS configured in SAP
that provides the printing link between SAP and Output
Manager.

Gateway service The name of the SAP gateway service utilized for this
RFC service communication.

OM Responds Via Callback Select this check box to specify that Output Manager
actively posts status updates to SAP through the RFC
service. If you clear this check box, then SAP must
utilize polling calls for status updates.

Description Provides space to describe the Output Manager RFC
server.

2. When all of the properties are configured, click Apply to save your changes.
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User Interface Reference

@DateTimeToString dialog box
Use this dialog box to configure the  @dateTimeToString  function. This function converts a date/time (usually
from another document property) to a string in the format specified. This string will be inserted in the document
property you are configuring.

Once created, the function command syntax is as follows,

@dateTimeToString ( FieldSource , Format )

@dateTimeToString ( FieldSource , Format , Culture )

FieldSource

Specifies the document property that contains the date/time string you want to insert. Right-click in the box, click
Insert Document Property, and select the document property from the list.

Format

Specifies the format of the date/time string when it is inserted into the document property. You can specify a value or
combination of values from the grids below.

Table 4: Standard DateTime format patterns

Format Pattern Associated Property/Description

d ShortDatePattern

D LongDatePattern

f Full date and time (long date and short time)

F FullDateTimePattern (long date and long time)

g General (short date and short time)

G General (short date and long time)

m, M MonthDayPattern

o, O Round-trip date/time pattern; with this format pattern, th
e formatting or parsing operation always uses the invaria
nt culture

r, R RFC1123Pattern; with this format pattern, the formatting
or parsing operation always uses the invariant culture
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Format Pattern Associated Property/Description

s SortableDateTimePattern (based on ISO 8601) using loc
al time; with this format pattern, the formatting or parsin
g operation always uses the invariant culture

t ShortTimePattern

T LongTimePattern

u UniversalSortableDateTimePattern using the format for
universal time display; with this format pattern, the form
atting or parsing operation always uses the invariant cult
ure

U Full date and time (long date and long time) using unive
rsal time

y, Y YearMonthPattern

Table 5: Custom DateTime format patterns

Format Description

d, %d The day of the month. Single-digit days do not have a lea
ding zero. The application specifies "%d" if the format p
attern is not combined with other format patterns.

dd The day of the month. Single-digit days have a leading z
ero.

ddd The abbreviated name of the day of the week.

dddd The full name of the day of the week.

f, %f The fraction of a second in single-digit precision. The re
maining digits are truncated. The application specifies "
%f" if the format pattern is not combined with other for
mat patterns.

ff The fraction of a second in double-digit precision. The re
maining digits are truncated.

fff The fraction of a second in three-digit precision. The rem
aining digits are truncated.

ffff The fraction of a second in four-digit precision. The rem
aining digits are truncated.

fffff The fraction of a second in five-digit precision. The rema
ining digits are truncated.

ffffff The fraction of a second in six-digit precision. The remai
ning digits are truncated.

fffffff The fraction of a second in seven-digit precision. The re
maining digits are truncated.
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Format Description

F, %F Displays the most significant digit of the seconds fractio
n. Nothing is displayed if the digit is zero. The applicatio
n specifies "%F" if the format pattern is not combined wi
th other format patterns.

FF Displays the two most significant digits of the seconds fr
action. However, trailing zeros, or two zero digits, are no
t displayed.

FFF Displays the three most significant digits of the seconds f
raction. However, trailing zeros, or three zero digits, are
not displayed.

FFFF Displays the four most significant digits of the seconds f
raction. However, trailing zeros, or four zero digits, are n
ot displayed.

FFFFF Displays the five most significant digits of the seconds f
raction. However, trailing zeros, or five zero digits, are n
ot displayed.

FFFFFF Displays the six most significant digits of the seconds fr
action. However, trailing zeros, or six zero digits, are no
t displayed.

FFFFFFF Displays the seven most significant digits of the seconds
fraction. However, trailing zeros, or seven zero digits, ar
e not displayed.

gg The period or era. This pattern is ignored if the date to b
e formatted does not have an associated period or era str
ing.

h, %h The hour in a 12-hour clock. Single-digit hours do not ha
ve a leading zero. The application specifies "%h" if the f
ormat pattern is not combined with other format patterns.

hh The hour in a 12-hour clock. Single-digit hours have a le
ading zero.

H, %H The hour in a 24-hour clock. Single-digit hours do not ha
ve a leading zero. The application specifies "%H" if the f
ormat pattern is not combined with other format patterns.

HH The hour in a 24-hour clock. Single-digit hours have a le
ading zero.

K Different values of the Kind property, that is, Local, Utc
, or Unspecified.

m, %m The minute. Single-digit minutes do not have a leading z
ero. The application specifies "%m" if the format pattern
is not combined with other format patterns.
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Format Description

mm The minute. Single-digit minutes have a leading zero.

M, %M The numeric month. Single-digit months do not have a le
ading zero. The application specifies "%M" if the format
pattern is not combined with other format patterns.

MM The numeric month. Single-digit months have a leading
zero.

MMM The abbreviated name of the month.

MMMM The full name of the month.

s, %s The second. Single-digit seconds do not have a leading z
ero. The application specifies "%s" if the format pattern i
s not combined with other format patterns.

ss The second. Single-digit seconds have a leading zero.

t, %t The first character in the AM/PM designator, if any. The
application specifies "%t" if the format pattern is not co
mbined with other format patterns.

tt The AM/PM designator defined, if any. Your application
should use this format pattern for languages for which it
is necessary to maintain the distinction between AM and
PM. An example is Japanese, for which the AM and PM
designators differ in the second character instead of the f
irst character.

y, %y The year without the century. If the year without the cen
tury is less than 10, the year is displayed with no leading
zero. The application specifies "%y" if the format pattern
is not combined with other format patterns.

yy The year without the century. If the year without the cen
tury is less than 10, the year is displayed with a leading z
ero.

yyy The year in three digits. If the year is less than 100, the y
ear is displayed with a leading zero.

yyyy The year in four or five digits (depending on the calendar
used), including the century. Pads with leading zeros to g
et four digits. Thai Buddhist and Korean calendars have f
ive-digit years. Users selecting the "yyyy" pattern see all
five digits without leading zeros for calendars that have f
ive digits. Exception: the Japanese and Taiwan calendars
always behave as if "yy" is selected.

yyyyy The year in five digits. Pads with leading zeros to get fiv
e digits. Exception: the Japanese and Taiwan calendars al
ways behave as if "yy" is selected.
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Format Description

yyyyyy The year in six digits. Pads with leading zeros to get six
digits. Exception: the Japanese and Taiwan calendars alw
ays behave as if "yy" is selected. The pattern can be cont
inued with a longer string of "y"s padding with more lea
ding zeros.

z, %z The time zone offset ("+" or "-" followed by the hour on
ly). Single-digit hours do not have a leading zero. For ex
ample, Pacific Standard Time is "-8". The application sp
ecifies "%z" if the format pattern is not combined with o
ther format patterns.

zz The time zone offset ("+" or "-" followed by the hour on
ly). Single-digit hours have a leading zero. For example,
Pacific Standard Time is "-08".

zzz The full time zone offset ("+" or "-" followed by the hour
and minutes). Single-digit hours and minutes have leadin
g zeros. For example, Pacific Standard Time is "-08:00".

: The default time separator.

/ The default date separator.

% c Where c is a format pattern if used alone. To use format
pattern "d", "f", "F", "h", "m", "s", "t", "y", "z", "H",
or "M" by itself, the application specifies "%d", "%f",
"%F", "%h", "%m", "%s", "%t", "%y", "%z", "%H", or
"%M".

The "%" character can be omitted if the format pattern is
combined with literal characters or other format patterns.

\ c Where c is any character. Displays the character literally
. To display the backslash character, the application shou
ld use "\\".

Culture

Specifies the culture name of the data in the document. The default is the current culture of the computer
where the Nuance Output Manager Console is running. When culture is not specified, the culture independent
CultureInfo.InvariantCulture is used.

@LookupCsv dialog box
Use this dialog box to configure the @LookupCsv function. This function looks up the value for a property in a
comma separated values file. The value will be inserted in the document property you are configuring.

Once created, the function command syntax is as follows,

@lookupCsv ( " path / resource " , lookup data , key column name , data column name )
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Path/Resource

Specifies how you want to locate the .csv file. You can use one of the following options:

• Path — Enter the path and file name of the .csv file, or click the browse button (...) to navigate to the file.
• Resource — Select the appropriate resource from the list, or click the Browse button to choose the resource from

the Manage CsvDocProp Resources dialog box. If you are using a resource, "CsvDocProp:" will be inserted
before the resource name.

Lookup data

Specifies the data you are looking up, this could be data from another document property or the results of an 
@parse  function.

• To select a document property, right-click in the box, click Insert Document Property, and then select the
appropriate property from the list.

• To use the results of an  @parse  function, right-click in the box, click Insert Function, and then @parse().
Configure the  @parse  function using the @Parse dialog box.

Key column name

Specifies the column name in your CSV file where Nuance Output Manager should look for a value that matches the
data you entered in the Lookup data box.

Data column name

Specifies the column name in your CSV file that contains the data you want inserted into the document property.

@Parse dialog box
Use this dialog to configure the  @parse  function. This function is used to extract data from a document property
(for example, Document Name). You can extract data using character offset (specifying a beginning position and
length), single delimiters (specify just the starting delimiter, it will be used as the only delimiter, field number, and
length), and double delimiters (specifying a starting delimiter, ending delimiter, field number, and length). When you
create a business rule action to set document properties, the parsing command should be entered in the appropriate
Value cell on the Document Properties dialog box.

Once created, the function command syntax is as follows,

For character offset:  @parse ( [ FieldSource ] , position , length )

For single delimiter:  @parse ( [ FieldSource ] , " delimiter " , field number, length )

For double delimiters:  @parse ( [ FieldSource ] , " starting delimiter " , " ending delimiter " , field number , l
ength )

Fieldsource

Specifies the document property from which data will be extracted. Right-click in the box, click Insert Document
Property, and select the document property from the list. The document property will appear in brackets in the field
source box.
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Field

Specifies that you are going to extract data using character offset. To do this you will need to specify a beginning
position and length.

• Position — Specifies the first position of the string to be extracted. The first character of source data is indicated
by specifying a 1.

• Length — Specifies the length of the string to be extracted. If the length specified is zero (0) or if the length is
greater than the remaining data, then all data to the last character will be used.

Delimited List

Specifies that you are going to extract data using single delimiters or double delimiters. If you are using a single
delimiter you will specify just the starting delimiter, it will be used as the only delimiter, field number, and length. If
you are using double delimiters you will specify a starting delimiter, ending delimiter, field number, and length.

• Starting delimiter — Specifies the character that marks the beginning of the string. If a comma or backslash
is used as the first character of the delimiter, then a backslash must precede the delimiter in the command. For
example, a backslash delimiter will be shown in the command as \\.

• Ending delimiter — Specifies the character that marks the end of the string. If a comma or backslash is used as
the first character of the delimiter, then a backslash must precede the delimiter in the command. For example, a
backslash delimiter will be shown in the command as \\. If you are using a single delimiter, this field can be left
blank.

• Field number — Specifies the position of the field that will be extracted. (1 refers to the first field, 2 to the
second, and so on.)

• Length — Specifies the length of the string to be extracted. If the length specified is zero (0) or if the length is
greater than the remaining data, then all data to the last character will be used.

@StringToDateTime dialog box
Use this dialog box to configure the  @stringToDateTime  function. This function converts a string (usually from
another document property) to a date and time in the format specified. The string could be an extracted variable or
another document property. This function inserts the configured date/time into a date/time document property.

Once created, the function command syntax is as follows,

@stringToDateTime ( FieldSource,Format )

@stringToDateTime ( FieldSource,Format , Culture)

@stringToDateTime ( { OutputVariable } , Format )

@stringToDateTime ( { OutputVariable } , Format , Culture )

FieldSource

Specifies how you want to retrieve the date/time that will be inserted in the document property. You can do this using
one of the following methods:

• FieldSource — The document property that contains the string you want converted to a date/time. Right-click in
the box, click Insert Document Property, and click the document property from the list.

• Output Variable — The output variable that contains the string you want converted to a date/time. Right-click
in the box, click Insert Variables, and select the output variable from the list. You can also enter the output
variable directly in the box. The variable must be surrounded with curly braces {}. The output variables are from
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an Advanced Document Modification rule or an extraction variable from an extract rule (line mode or page mode)
or burst rule (line mode or page mode).

Format

Specifies the format of the date/time value when it is inserted into the document property. You can specify a value or
combination of values from the grids below.

Table 6: Standard DateTime format patterns

Format Pattern Associated Property/Description

d ShortDatePattern

D LongDatePattern

f Full date and time (long date and short time)

F FullDateTimePattern (long date and long time)

g General (short date and short time)

G General (short date and long time)

m, M MonthDayPattern

o, O Round-trip date/time pattern; with this format pattern, th
e formatting or parsing operation always uses the invaria
nt culture

r, R RFC1123Pattern; with this format pattern, the formatting
or parsing operation always uses the invariant culture

s SortableDateTimePattern (based on ISO 8601) using loc
al time; with this format pattern, the formatting or parsin
g operation always uses the invariant culture

t ShortTimePattern

T LongTimePattern

u UniversalSortableDateTimePattern using the format for
universal time display; with this format pattern, the form
atting or parsing operation always uses the invariant cult
ure

U Full date and time (long date and long time) using unive
rsal time

y, Y YearMonthPattern
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Table 7: Custom DateTime format patterns

Format Description

d, %d The day of the month. Single-digit days do not have a lea
ding zero. The application specifies "%d" if the format p
attern is not combined with other format patterns.

dd The day of the month. Single-digit days have a leading z
ero.

ddd The abbreviated name of the day of the week.

dddd The full name of the day of the week.

f, %f The fraction of a second in single-digit precision. The re
maining digits are truncated. The application specifies "
%f" if the format pattern is not combined with other for
mat patterns.

ff The fraction of a second in double-digit precision. The re
maining digits are truncated.

fff The fraction of a second in three-digit precision. The rem
aining digits are truncated.

ffff The fraction of a second in four-digit precision. The rem
aining digits are truncated.

fffff The fraction of a second in five-digit precision. The rema
ining digits are truncated.

ffffff The fraction of a second in six-digit precision. The remai
ning digits are truncated.

fffffff The fraction of a second in seven-digit precision. The re
maining digits are truncated.

F, %F Displays the most significant digit of the seconds fractio
n. Nothing is displayed if the digit is zero. The applicatio
n specifies "%F" if the format pattern is not combined wi
th other format patterns.

FF Displays the two most significant digits of the seconds fr
action. However, trailing zeros, or two zero digits, are no
t displayed.

FFF Displays the three most significant digits of the seconds f
raction. However, trailing zeros, or three zero digits, are
not displayed.

FFFF Displays the four most significant digits of the seconds f
raction. However, trailing zeros, or four zero digits, are n
ot displayed.
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Format Description

FFFFF Displays the five most significant digits of the seconds f
raction. However, trailing zeros, or five zero digits, are n
ot displayed.

FFFFFF Displays the six most significant digits of the seconds fr
action. However, trailing zeros, or six zero digits, are no
t displayed.

FFFFFFF Displays the seven most significant digits of the seconds
fraction. However, trailing zeros, or seven zero digits, ar
e not displayed.

gg The period or era. This pattern is ignored if the date to b
e formatted does not have an associated period or era str
ing.

h, %h The hour in a 12-hour clock. Single-digit hours do not ha
ve a leading zero. The application specifies "%h" if the f
ormat pattern is not combined with other format patterns.

hh The hour in a 12-hour clock. Single-digit hours have a le
ading zero.

H, %H The hour in a 24-hour clock. Single-digit hours do not ha
ve a leading zero. The application specifies "%H" if the f
ormat pattern is not combined with other format patterns.

HH The hour in a 24-hour clock. Single-digit hours have a le
ading zero.

K Different values of the Kind property, that is, Local, Utc
, or Unspecified.

m, %m The minute. Single-digit minutes do not have a leading z
ero. The application specifies "%m" if the format pattern
is not combined with other format patterns.

mm The minute. Single-digit minutes have a leading zero.

M, %M The numeric month. Single-digit months do not have a le
ading zero. The application specifies "%M" if the format
pattern is not combined with other format patterns.

MM The numeric month. Single-digit months have a leading
zero.

MMM The abbreviated name of the month.

MMMM The full name of the month.

s, %s The second. Single-digit seconds do not have a leading z
ero. The application specifies "%s" if the format pattern i
s not combined with other format patterns.

ss The second. Single-digit seconds have a leading zero.
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Format Description

t, %t The first character in the AM/PM designator, if any. The
application specifies "%t" if the format pattern is not co
mbined with other format patterns.

tt The AM/PM designator defined, if any. Your application
should use this format pattern for languages for which it
is necessary to maintain the distinction between AM and
PM. An example is Japanese, for which the AM and PM
designators differ in the second character instead of the f
irst character.

y, %y The year without the century. If the year without the cen
tury is less than 10, the year is displayed with no leading
zero. The application specifies "%y" if the format pattern
is not combined with other format patterns.

yy The year without the century. If the year without the cen
tury is less than 10, the year is displayed with a leading z
ero.

yyy The year in three digits. If the year is less than 100, the y
ear is displayed with a leading zero.

yyyy The year in four or five digits (depending on the calendar
used), including the century. Pads with leading zeros to g
et four digits. Thai Buddhist and Korean calendars have f
ive-digit years. Users selecting the "yyyy" pattern see all
five digits without leading zeros for calendars that have f
ive digits. Exception: the Japanese and Taiwan calendars
always behave as if "yy" is selected.

yyyyy The year in five digits. Pads with leading zeros to get fiv
e digits. Exception: the Japanese and Taiwan calendars al
ways behave as if "yy" is selected.

yyyyyy The year in six digits. Pads with leading zeros to get six
digits. Exception: the Japanese and Taiwan calendars alw
ays behave as if "yy" is selected. The pattern can be cont
inued with a longer string of "y"s padding with more lea
ding zeros.

z, %z The time zone offset ("+" or "-" followed by the hour on
ly). Single-digit hours do not have a leading zero. For ex
ample, Pacific Standard Time is "-8". The application sp
ecifies "%z" if the format pattern is not combined with o
ther format patterns.

zz The time zone offset ("+" or "-" followed by the hour on
ly). Single-digit hours have a leading zero. For example,
Pacific Standard Time is "-08".
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Format Description

zzz The full time zone offset ("+" or "-" followed by the hour
and minutes). Single-digit hours and minutes have leadin
g zeros. For example, Pacific Standard Time is "-08:00".

: The default time separator.

/ The default date separator.

% c Where c is a format pattern if used alone. To use format
pattern "d", "f", "F", "h", "m", "s", "t", "y", "z", "H",
or "M" by itself, the application specifies "%d", "%f",
"%F", "%h", "%m", "%s", "%t", "%y", "%z", "%H", or
"%M".

The "%" character can be omitted if the format pattern is
combined with literal characters or other format patterns.

\ c Where c is any character. Displays the character literally
. To display the backslash character, the application shou
ld use "\\".

Culture

Specifies the culture name of the data in the document. The default is the current culture of the computer
where the Nuance Output Manager Console is running. When culture is not specified, the culture independent
CultureInfo.InvariantCulture is used.

Activate License dialog box
Use this dialog box to determine how you want to activate the Nuance Output Manager license file. You can activate
all components over the Internet, perform a custom activation by selecting the individual components you want to
activate, or skip activation.

Activate all DBM components via the Internet

Automatically activates all Nuance Output Manager DBM components. An internet connection is required to use this
method.

Custom DBM activation

Allows you to choose the Nuance Output Manager components you want to activate.

Skip activation at this time

Completes the license file installation without activating the license. You can activate the license at a later time using
the OM License wizard.
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Add Columns dialog box
This dialog box allows you to edit columns that will display by default in the Destinations, Sources, Library, Devices
application views. You can also edit columns for the Output History and Document Owner.

Open the Add Columns dialog box by clicking the Add button on any of the tabs in the Administration - Configure
Columns utility. Select check boxes in the first column to add columns to a grid view, and then click OK to save your
changes.

Column Description

Click a button in the first row to select a column. You ca
n drag across buttons in this column to select adjacent ch
eck boxes. Press Shift and click to extend selection of ch
eck boxes. Press Ctrl and click to add columns to a selec
tion.

Select the check box in this column to add a column to a
grid. Click the button at the top of this column to clear al
l check boxes.

Column Name This name identifies the column.

Display Name This name is the initial Display Name for a column. Thi
s is the name that appears in a destination, source, library
, or device grid view. You can edit the Display Name aft
er you click OK to close the dialog box.

Add Destination (from Devices) dialog box
Use this dialog box to create a destination from the selected device. The Add Destination dialog box is opened by
right-clicking a device and then clicking Create Destination.

Type

Selects the type of destination or source you want to create.

Server

Specifies the Nuance Output Manager server where the Nuance Output Manager Output Service is located for this
destination or source.

Assign to group

Selects the source or destination group where the destination or source will be created.

Use DNS name if available

Select this check box to allow the source or destination to be accessed by its DNS name when available. Clear this
check box to require that the source or destination always be accessed using its IP address.
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Add Destination dialog box
Use this dialog box to select the type of destination you want to add. After you select the destination type, a window
will display showing all of the configuration options.

Type

Selects the type of destination you want to add.

Add new devices

Specifies the number of destinations you want to create. Administrators can create thousands of destinations and
configure them simultaneously using bulk configuration. The destinations will be created in the selected destination
group.

Import devices from configuration (.CSV) file

Imports a list of destinations into Nuance Output Manager. This is particularly useful if you have a database,
spreadsheet, and so forth, that lists your existing equipment. You can save that document as a CSV file and then
import it to create matching destinations in Nuance Output Manager.

To import, enter the path and file name of the configuration file or click the browse button (...) to navigate to the file.
The imported destinations will be added to the selected destination group.

Add Source dialog box
Use this dialog box to select the type of source you want to add. After you select the source type, a window will
display showing all of the configuration options.

Type

Selects the type of source you want to add. The available source types are Email, Nuance Output Manager, FTP, LPD,
Network Folder, Socket, Web Upload, WebSphere MQ, and Windows Queue.

Add new devices

Specifies the number of sources you want to create. Administrators can create thousands of sources and configure
them simultaneously using bulk configuration. The sources will be created in the selected source group.

Import devices from configuration (.CSV) file

Imports a list of sources into Nuance Output Manager. This is particularly useful if you have a database, spreadsheet,
and so on, that lists your existing equipment. You can save that document as a CSV file and then import it to create
matching sources in Nuance Output Manager.

To import, enter the path and file name of the configuration file or click the Browse (...) button to navigate to the file.
The imported sources will be added to the selected source group.
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Ad Hoc Rule dialog box
Use this dialog box to create and modify ad hoc rules. You can access this dialog box from the Ad Hoc Rules
Manager dialog box.

Name

Enter the name of the ad hoc rule.

Description

Enter a description of the ad hoc rule. This will display in the Ad Hoc Rules Manager dialog box.

Rule definition

Always execute this rule (no conditions) — Use this option to apply the rule to all documents. This will disable the
When box as no condition statements are needed.

When

The When box is used to create and manage the rule conditions. Multiple conditions can be created and organized
into groups. A blue box is used to indicate a condition group.

To create a condition, click the <Target> link and then click the appropriate condition. Click the Operation link to
select the appropriate operation. Click the Value link to select the appropriate value. This will complete the condition
statement.

You can select the condition statement and use the buttons below the box to add and remove conditions.

• Select a condition radio button (inside the box) to enable the Add Condition and Remove Condition buttons for
adding and removing condition statements.

• Select a group radio button (outside the box) to enable the Add Group and Remove Group buttons for adding
and removing groups. This will also enable the Add Condition button for adding a condition to the selected
group.

Perform the following actions

The Perform the following actions box is used to create and manage rule actions.

The order of ad hoc rule actions is very important, as the action behavior can depend on where it occurs in the
sequence of actions. By default the actions apply to the targeted documents. For example, if your rule contains a
Create Package action, the create package will act upon the targeted documents. In contrast, actions that follow an
action that produces documents, will apply to the produced documents. Using the previous example, if following the
Create Package action you have a Merge Package action followed by a Set Document Properties action, followed
by a Set Document State action, and finally followed by a Route to Destination action, the merge package action
will apply to the package created by the Create Package action, and the latter three actions will apply to the resultant
merged documents from the Merge Package action. If you had a Set Document Properties action that preceded the
Create Package action, it would apply to the original targeted documents.

• To create an action, click the <Action> link and select the appropriate action type. You can create the following
actions:

• Run Business Rules — Specifies if you want to run business rules against input or output documents.
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• Delete Document — Deletes documents.
• Set Priority in Group — documentation coming soon
• Assign to Document Folder — Assigns documents to specific document folders.
• Set Document Owner — Configures the document owner.
• Route to Destinations — Specifies the destinations where documents should be sent.
• Set Document State — Sets the document state to hold or ready.
• Create Package — Configures a package of documents. This opens the Create Package dialog box.
• Zip Package — Zips the merged document or any other documents in Nuance Output Manager. This opens the

Zip Package dialog box.
• Merge Package — Configures the document properties of the merged file. This opens the Merge Package

dialog box.
• Modify Document Content — Configures. This opens the ABC dialog box.
• Modify Document Properties — Configures. This opens the ABC dialog box.
• Package Banner — Configures. This opens the ABC dialog box.
• Run Command — Configures. This opens the ABC dialog box.
• Unzip Document — Configures. This opens the ABC dialog box.

• To create additional actions, click Add Action.
• To modify an action, click the desired action link or click the area next to the link and click Modify Action.
• To delete an action, click the area next to the link and click Remove Action.
• To reorder the actions, click the area next to the action link and click Move Up or Move Down.

Allowed for document right click

Use the check box to determine if the rule will be available to apply directly to documents from the Documents grid.
When selected, the rule will be available as an option when you right-click a document and click Run Ad hoc Rule.
Rules with this option enabled will display in the submenu.

Ad Hoc Rules Manager dialog box
Administrators can use the Ad Hoc Rules Manager to create ad hoc rules. Ad hoc rules are used for documents that
exist in Nuance Output Manager, where business rules are used for documents as they enter Nuance Output Manager.
Ad hoc rules can be initiated by scheduling a task in the Schedule Manager, by using the Run Now option in the Ad
Hoc Rules Manager, or by running a configured rule from the Documents grid or business rules. An example use for
ad hoc rules is to merge a set of documents into a package.

Ad hoc rules grid

The ad hoc rules grid lists all of the defined ad hoc rules. Selecting a rule will display the rule for preview below the
grid.

The following buttons display below the grid.

• Add button — Creates a new ad hoc rule. This opens the Ad Hoc Rule dialog box.
• Modify button — Modifies the selected ad hoc rule. This opens the Ad Hoc Rule dialog box.
• Remove button — Deletes the selected ad hoc rule.
• Copy button — Creates a copy of the selected rule. To rename the rule, double-click the rule, or select the new

rule and click Modify. This opens the Ad Hoc Rule dialog box.
• Move Up button — Reorders the ad hoc rules by moving the selected rule up.
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• Move Down button — Reorders the ad hoc rules by moving the selected rule down.
• Run Now button — Allows you to run the currently selected rule now. You can choose to run the rule using one

of the following options:
• All documents — Runs the selected rule against all documents in the spool that are not currently in retain.
• New documents since last run — Runs the selected rule against any documents that have arrived into the spool

since the last time the rule was run.

Preview for rule

Displays a preview of the selected ad hoc rule.

Adjust Message Priority dialog box
Use this dialog box to set server and module-specific priority levels for trace activity. Records will appear in the
Message Console for modules that have a priority level less than or equal to the set value. You can access this dialog
box by clicking Configure on the Message Console toolbar.

Warning:  Performance Tuning: Setting the priority higher than Operator Information can cause
performance degradation. Because the Message Console continues to process information after you close the
utility, you must check the priority settings before you close. If you experience any problems, we recommend
changing the priority setting to Operator Information.

Server/Message Module Column

The Server column lists the servers with Nuance Output Manager services installed. The Message Module column
lists the individual modules for each server. This allows you to specify a priority for each module on a specific server.

Notice, the Message Module column also contains an All Modules on this Server cell for each server. Selecting a
priority level in this cell will cause all messages for the selected server to be set to the same priority level. All of the
other rows will remain unchanged in this dialog box, but the Message Console messages will be set at the priority
specified in the All Modules on this Server row.

Message Priority

Sets the module's priority level. Module activity that meets or exceeds the selected priority level will appear on
the console and will be stored to disk. For example, the default priority level setting is Operator Information. This
means messages will display with a priority of Operator Failure, Operator Warning, and Operator Information. The
priority level identifies the type of activity that has occurred in a selected program module. Messages that appear in
the Message Console window also have color coding. See the following table for a detailed description of the priority
levels.

Warning:  We recommend setting your priority level to Operator Information. Only select a development
priority level if advised to do so by a Nuance Output Manager support analyst.

Table 8: Message Priorities

Level Color Description

Operator Failure light red Errors that halt execution.

Operator Warning light yellow Warns of a potential problem.
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Level Color Description

Operator Information white Informs of normal operation.

Support Trace light orange Messages for troubleshooting that
track normal process flow and
protocol execution.

Development Failure red Informs programmer of infrequent,
but important, task.

Development Warning yellow Informs programmer of infrequent,
but less critical, task.

Development Information gray Informs programmer of regular
operation.

Development Trace orange Informs programmer of detailed
operation.

Adjust User Custom Properties dialog box
Use this dialog box to enable and specify values for custom user properties.

This dialog allows you to enable and set values for five custom string properties, five custom integer properties,
and five custom Boolean properties. This dialog box is opened by clicking Set Custom Properties in the Output
Manager User dialog box.

Advanced Costing Profile dialog box
Use this dialog when you need to create an advanced costing profile for assigning specific printing costs to sources.

You can access this dialog box when you configure a source from the More settings tab.

Name

Specifies the advanced costing profile name.

Description

Includes a description of the profile.

Grid

Lists the printing options and the cost associated with each option. Click directly in the grid to configure the cost for
each printing option.
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Alert Rule dialog box
Use this dialog box to create and modify alert rules. You can configure alert options that will occur when certain
events happen. This is particularly useful for monitoring printer states. You can access this dialog box from the Alert
Rules Manager dialog box.

Name

Enter the name of the alert rule.

Enabled

Use the check box to enable or disable the rule. This option is enabled by default.

Description

Enter a description of the alert rule. This will display in the Alert Rules Manager.

Rule definition

When

The When box is used to create and manage the rule conditions. Rule conditions are based on the Destination State,
Destination, and Fault selections. To create a condition, click the <Values> link to select the appropriate values.

Destination state — Click the <Values> link to configure the destination state condition. From the Select Alert
dialog box, expand the SNMP Device Alerts tree and the Destination Alerts tree and select the options that the alert
rule should perform the actions on.

Destination — Click the <Values> link to configure the destination condition. From the Select Destination dialog
box, you can select multiple destinations by pressing the Ctrl or Shift keys and selecting destinations. When finished,
click OK.

Fault — Click the link to choose between the Occurs and Behavior options.

• Occurs — The action will be executed when the fault occurs. The fault condition will not be evaluated. This is the
default selection.

• Behavior — If you select this option, a <Values> link will display. Click this link to configure the fault behavior.
From the Fault Behavior dialog box, configure whether the behavior that triggers the rule action is active for the
time period chosen, or if the fault behavior is repeated so many times before the rule action is fired. If you do not
want this level of granularity for the fault condition select the Occurs behavior.

Reminder interval — Allows you to repeat the action over a period of time. Click the link to configure the reminder
interval on the Notification Reminder dialog box. If you want the action to only send the notification once, set the
value for the notification reminder interval to 0 and the value will change to None. The default reminder interval is
None.

You must select values for all definitions in order to save the rule.

Perform the following actions

The Perform the following actions box is used to create and manage rule actions.
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• To create an action, click the <Action> link and select Send Email.
• To create additional actions, click Add Action.
• To modify an action, click the desired action link or click the area next to the link and click Modify Action.
• To delete an action, click the area next to the link and click Remove Action.
• To reorder the actions, click the area next to the action link and click Move Up or Move Down.

Follow-on action

Select the action you would like to take after this rule has been processed. You can continue processing rules or select
not to process any additional rules.

Alert Rules Manager dialog box
Administrators can use the Alert Rules Manager to create alert rules. Alert rules are configured by selecting an
event and then configuring the alert option that will be performed when that event occurs. This is particularly useful
for monitoring printer states. Using alert rules, support personnel can be automatically notified when printers have
conditions that could prevent end user printing.

Alert rules grid

The alert rules grid lists all of the defined alert rules, in the order they will be processed. Selecting a rule will display
the rule for preview below the grid. The alert rules grid is editable. Use the following procedures from the rules grid.

• Use the check box in the Enabled column to determine if the rule is enabled or disabled.
• To change the follow-on action, click in the Follow-on Action cell and select the action you would like to take

after this rule has been processed. You can continue processing rules or select not to process any additional rules.

The following buttons display below the grid.

• Add button — Creates a new alert rule. This opens the Alert Rule dialog box.
• Modify button — Modifies the selected alert rule. This opens the Alert Rule dialog box.
• Remove button — Deletes the selected alert rule.
• Copy button — Creates a copy of the selected rule. To rename the rule, double-click the rule, or select the new

rule and click Modify. This opens the Alert Rule dialog box.
• Move Up button — Reorders the alert rules by moving the selected rule up.
• Move Down button — Reorders the alert rules by moving the selected rule down.

Preview for rule

Displays a preview of the selected alert rule.

Allowances Profile dialog box
An allowances profile restricts users to a printing allowance.

Display this dialog box when working in Administration - Manage Users. On the Users tab, click the browse button
(...) for a user in the Allowances Profile column. Then in the Manage Allowances Profiles dialog box, click either
New or Edit to create or edit an allowance profile.
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Option Description

Profile name Identifies the profile. This name shows in the
Allowances Profile list.

Profile description Provides space to provide information about a profile.

Initial printing balance The amount that users that are assigned this profile
are allowed to expend on printing or both printing and
copying during the interval specified by Refresh Period.

Copy balance type Describes the balance type:

Unlimited
copying allowed

No limit on the number
of copies that a user can
make.

Maximum pages (total) User is allowed to create a
combined number of both
black and white and color
pages.

Maximum pages
(separate Color/BW

User is allowed to create
specified numbers of color
and black and white pages.

Balance (share
printing balance)

Printing and copying
consume the same balance.

Balance (separate) Printing and copying
consume separate
balances.

Total pages Specifies the total number of both color and black and
white pages that a user can print during a refresh period.

This field is available when Maximum pages (total) is
specified for Copy balance type.

Color pages Specifies the number of color pages that a user can print
during a refresh period.

This field is available when Maximum pages (separate
Color/BW) is specified for Copy balance type.

BW pages Specifies the number of black and white pages that a user
can print during a refresh period.

This field is available when Maximum pages (separate
Color/BW) is specified for Copy balance type.
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Option Description

Initial copying balance The amount that users who are assigned this profile
are allowed to expend on copying during the interval
specified by Refresh Period.

This option is available when Balances (separate) is
specified for Copy balance type.

Important:  This option should not be set to
0 for Remaining Copy Balance to display the
correct information when a user performs a
copy job.

Refresh Period (all) Specifies that period in which initial balances or page
numbers are consumed. Balances or page numbers are
renewed at the beginning of each new period.

Assign Access Control dialog box
Use this dialog box to configure access control profiles that allow users, groups, and departments to access device
functionality. When access is controlled for a device, users must have user, group, or department level permissions to
access the device.

This dialog box configures access control for selected MFP devices.

Users tab

Settings on this tab configure user access to MFP devices.

Select the check box next to a user account to specify access for a user.

Option Description

User Name Shows a user on the machine or network.

Type Shows the type of user account.

Access Control Protocol Click in this box to select an access control profile.

An access control profile defines whether a user has
basic Full Access or No Access access, or Specified
Access or advanced manufacture specific access. Click
the browse button ... to create or edit profiles.

Select All Selects check boxes for all users in the table.

Clear All Clears check boxes for all users in the table.

Groups tab

Settings on this tab configure group access to MFP devices.

Select the check box next to a group specify access for all users in a group.
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Option Description

group ID Shows the Output Manager group ID.

Group Name Shows the group name.

Type Shows the type of group.

Access Control Protocol Click in this box to select an access control profile.

An access control profile defines whether a user has
basic Full Access or No Access access, or Specified
Access or advanced manufacture specific access. Click
the browse button ... to create or edit profiles.

Select All Selects check boxes for all groups in the table.

Clear All Clears check boxes for all groups in the table.

Departments tab

Settings on this tab configure department access to MFP devices.

Select the check box next to a department to specify access for all users in a department.

Option Description

group ID Shows the Output Manager department ID.

Group Name Shows the department name.

Access Control Protocol Click in this box to select an access control profile.

An access control profile defines whether a user has
basic Full Access or No Access access, or Specified
Access or advanced manufacture specific access. Click
the browse button ... to create or edit profiles.

Select All Selects check boxes for all departments in the table.

Clear All Clears check boxes for all departments in the table.

Bitmap Output tab
Use this tab to configure bitmap output transform options. You can access this dialog box when you configure a
transform with a BMP output format. Transforms can be configured for business rule or output process actions or
IPDS destinations (not available for new sales).

Click an option you want to learn more about.

• Input Options tab on page 553
• Output Options tab on page 590
• Page Layout tab on page 595
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Extract bitmaps to multipage file

Extracts bitmaps to a multipage file. The output type must be a multipage image format (for example, TIF).

Size and resolution

• Bitmap output size — Specifies the height and width of the output file in x and y directions (in pixels).
• Bitmap maximum size — Specifies the maximum size of the output file in x and y directions (in pixels).
• Bitmap resolution — Specifies the resolution of output file in x and y directions. The resolution is specified in

dpi (dots per inch).

Browse LDAP Server dialog box
When adding LDAP users to Nuance Output Manager, you must specify the LDAP server you will searching.
Use this dialog box to specify the LDAP server that contains the users you want to add. Once the users are added,
permissions and quotas can be assigned as needed. You can access this dialog box when adding LDAP users from the
LDAP User dialog box.

Base DN

Specifies the DN (distinguished name) of the entry at which the search begins.

Filter

Specifies criteria to use in the search.

Search button

Performs a search of the specified server

Tree

Displays the LDAP directory in a tree view. When you click an entry in the tree, its attributes and values are displayed
in the grid.

Grid

Displays the attributes and values for a user or group that you have selected from the LDAP directory.

Burst Document - Line Mode dialog box
Use this dialog box to configure the settings that split line data documents into separate documents.

You access the dialog box through the New Business Rule dialog box when you choose to configure a Burst Line
Mode action.

Tab options

Options in this dialog box are grouped on the tabs described in the following table:
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Tab Description

Extract Text tab on page 472 Use this tab to define the settings that extract text from
line data documents.

Burst Conditions tab on page 473 Use this tab to define the settings that split line data
documents.

Set Document Properties tab on page 474 Use this tab to set the document properties for the
documents created from splitting line data documents.

Extract Text tab
Use this tab to define the settings that extract text from line data documents.

This tab is used when you create business rule actions to extract and burst using line mode. The Extract - Line Mode
business rule action extracts text from line data documents using rows and columns. The Burst - Line Mode business
rule action splits line data documents (text documents with or without carriage control) based on data contained in
the document. Use this tab to configure variables that are populated with data from the document or the document’s
banner.

Server

Specifies the licensed rules agent server that you would like to use.

Detect

Use — Specifies how you want to detect the text to extract. You can use one of the following methods:

• Lines — Select if your lines end with carriage controls and you know the number of lines per page. You will need
to enter this value.

• Records — Select if your document does not have carriage controls at the ends of the lines or if you do not know
how the lines will appear on the page.

Lines per page — Specifies the number of lines per page. This is only available if you select to detect text using
Lines. Standard lines per page values are 66 or 88 for an 11-inch page with either 6 or 8 lines per inch, respectively.
The default value is 66 lines per page.

Format — Specifies the data format. You can choose VBM, ASCII, ASCII w/ASA, or S370.

Code page — Specifies the associated code page.

Banner mode

Selecting this option allows the recognition string location to vary on the page. This will search the document for a
recognition string. The recognition line becomes line 1 and the extraction variables will be relative to it.

Search for — Specifies the text that defines the banner.

Page — Specifies the page number to start searching for banner text.

Column — Specifies the column at which to start searching for banner text.

Lines — Specifies the starting and ending line numbers to search for banner text.
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Extraction Variables

The variables grid lists all of the defined extraction variables. You can add, modify, and remove variables using the
buttons above the grid. There are two types of extraction variables, those used for bursting and those used to extract
data.

New button — Creates a new extraction variable from the Text Extraction Variable Definition dialog box.

Modify button — Modifies the selected extraction variable from the Text Extraction Variable Definition dialog box.
Note, once a variable of a particular type has been created, it cannot be changed to the other type.

Remove button — Deletes the selected extraction variable.

Burst Conditions tab
Use this tab to define the settings that split line data documents.

This tab is used with Burst - Line Mode and Burst - Page Mode business rule actions. Line mode splits text
documents based on data contained in the document. Page mode uses regions (rectangles) to determine burst
conditions. Use this tab to control how the document is split.

Split based on

Specifies how to create the new documents. You can choose to create documents by bursting (new documents are
based on Extracted variables) or by splitting (new documents are based on Size or the desired Number of output
documents).

Extracted variables — Allows for selecting the extraction variables created from the Text Extraction Variable
Definition dialog box as conditions in the When box. You can choose the extraction variable and condition that will
cause new documents to be created.

Number of pages — Allows for splitting documents based on the number of pages. When you select this option the
Split > Pages in new document and Split > Pages in current document variables are available in the When box.
See descriptions below.

Number of output documents — Splits a document into a specified number of equally sized output documents. For
example, if you submit a document with 99 pages, and you set Number of output documents to 3, you would get
3 output documents of 33 pages each. If the number of pages of the document is not equally divisible, the document
will be split as close as possible to even numbers. For example, a document with 24 pages split into 5 documents will
return 4 documents that are 5 pages, and 1 document that is 4 pages.

If necessary, you can select extraction variables created from the Extract Text tab as conditions in the When box.
Output Manager will find the position in the source document where the split should occur based on pages per
documents, and then start a new document after the additional condition is met. This allows the boundary between
split documents to be better controlled based on the contents of the document.

Burst when

Important:  To enable the Burst when box when splitting on extracted variables, you must create extraction
variables from the Extract Text - line mode tab or Extract Text - page mode tab.

The Burst when box is used to create and manage burst conditions. Multiple conditions can be created and organized
into groups. A blue box is used to indicate a condition group. To create a condition, click the <Target> link and then
click the appropriate variable. The variables that display vary depending what the split is based on.

• If the split is based on Extracted variables, the extraction variables added from the Extract Text tab will be
listed in the menu.
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• If the split is based on Number of pages, you can choose the following variables to split the document based on
the number of pages:

• Split > Pages in current document — Specifies the total number of pages in the current document.
• Split > Pages in new document — Specifies the number of pages to be contained in each new burst document.

The number of pages is determined from the beginning of the document or from the previous burst. If the total
number of pages of the current document is not equally divisible by this value, the final burst document will
contain fewer pages.

Note:  For example, if you create a condition where "Pages in new document is divisible by 20 AND Pages
in current document is between to 0 AND 200", when you submit a 100 page document, the process will
split it into 5 20 page documents. Each page is analyzed to determine if it is the 20th page since a burst or the
beginning of the document. When the 20th page is reached, a new burst document is created containing those
20 pages (that page combined with the previous 19 pages). The page count process repeats until the end of the
document.

• If the split is based on Number of output documents, the extraction variables added on the Extract Text tab will
be listed in the menu.

Once the target is selected, click the Operation link to select the appropriate operation. Click the Value link to select
the appropriate value. This will complete the condition statement.

You can select the condition statement and use the buttons below the box to add and remove conditions.

• Select a condition radio button (inside the box) to enable the Add Condition and Remove Condition buttons for
adding and removing condition statements.

• Select a group radio button (outside the box) to enable the Add Group and Remove Group buttons for adding
and removing groups. This will also enable the Add Condition button for adding a condition to the selected
group.

Output format (Page Mode Only)

Bursting using page mode allows you to transform the document in this rule action. You can choose to leave the
output format the same as the input format or change it to a format in the list.

Follow on actions

Input document — Specifies the follow on actions for the input document (original document). You can choose to
delete, retain, or process the next rule for the original document. The newly created documents (output documents)
continue with the next rule action.

Set Document Properties tab
Use this tab to set the document properties for the documents created from splitting line data documents.

This tab is used with extracting and bursting business rule actions.

• Extract — Line mode extracts text from line data documents using rows and columns. Page mode extracts text
from printer ready documents using regions (rectangles).

• Burst — Line mode splits text documents based on data contained in the document. Page mode uses regions
(rectangles) to determine burst conditions. Use this tab to configure the document properties on the new
documents created by bursting.

Properties

Configure the document properties by clicking directly in the grid.
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Document Property column — Lists the property values that can be configured. The properties are grouped into the
following categories: Basic options, Media selection, Document, Image adjustments, Finishing, and Other properties.
To expand a category, click the down arrow next to a category name. To collapse a category, click the up arrow.

Under each category are the print preferences/document properties that belong to that group. The first node level in
the categories determine the print preferences for the properties it contains. On the print preference node, you select
how the property should be applied when a document is sent to a destination. Under each print preference are the
parameters needed to generate that print preference.

Mode column — Specifies how to apply the property value. Click in the cell and choose one of the following options:

• Always Apply — Always applies the specified property value. Output Manager will add commands to the print
stream to enforce the print preference. If the document already contains commands for that print preference,
Output Manager will modify the commands to work with the printer family where the document is being sent.

• Apply Conditionally — Applies the property value conditionally. Output Manager will only add or modify
commands for the print preference when the printer family that the document is destined for is different from the
printer family the document was originally designed for.

• Informational Only — Output Manager makes no changes to the print stream when the document is sent to the
destination. The value is for informational purposes only.

• Value Not Set — No value is set for the property.

Value column — Specifies the document property value. Click directly in the cell to change the value. You can use
functions to insert and extract data as necessary.

Burst Document - Page Mode dialog box
Use this dialog box to configure the settings that split printer-ready documents into separate documents.

You access the dialog box through the New Business Rule dialog box when you choose to configure a Burst Page
Mode action.

Tab options

Options in this dialog box are grouped on the tabs described in the following table:

Tab Description

Extract Text tab on page 475 Use this tab to define the settings that extract text from
page regions.

Burst Conditions tab on page 476 Use this tab to define the settings that split printer-ready
documents.

Set Document Properties tab on page 478 Use this tab to set the document properties for the
documents created from splitting printer-ready
documents.

Extract Text tab
Use this tab to define the settings that extract text from page regions.

This tab is used when you create business rule actions to extract and burst using page mode. The Extract - Page Mode
business rule action extracts text from printer ready documents using regions (rectangles). The Burst - Page Mode
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business rule bursts printer ready documents. Regions (rectangles) are used to determine burst conditions, or splitting
is based on the desired output size of documents or the desired number of output documents.

Server

Click the server to configure.

Server configuration

Transform package — Specifies the transform package. You can select a transform package from the list or click
New to create one. You can also select a transform package and modify or remove it.

Override input filter profile assigned to document — Determines if you want to use the filter profile assigned to
the document or if you want to use the filter profile configured in the transform package. Select the check box to use
the filter profile in the transform package.

Additional parameters — Specifies any additional parameters needed for the document modification software.

Extraction Variables

The variables grid lists all of the defined extraction variables. You can add, modify, and remove variables using the
buttons above the grid. There are two types of extraction variables, those used for bursting and those used to extract
data.

New button — Creates a new extraction variable from the Text Extraction Variable Definition dialog box.

Modify button — Modifies the selected extraction variable from the Text Extraction Variable Definition dialog box.
Note, once a variable of a particular type has been created, it cannot be changed to the other type.

Remove button — Deletes the selected extraction variable.

Burst Conditions tab
Use this tab to define the settings that split printer-ready documents.

This tab is used with Burst - Line Mode and Burst - Page Mode business rule actions. Line mode splits text
documents based on data contained in the document. Page mode uses regions (rectangles) to determine burst
conditions. Use this tab to control how the document is split.

Split based on

Specifies how to create the new documents. You can choose to create documents by bursting (new documents are
based on Extracted variables) or by splitting (new documents are based on Size or the desired Number of output
documents).

Extracted variables — Allows for selecting the extraction variables created from the Text Extraction Variable
Definition dialog box as conditions in the When box. You can choose the extraction variable and condition that will
cause new documents to be created.

Number of pages — Allows for splitting documents based on the number of pages. When you select this option the
Split > Pages in new document and Split > Pages in current document variables are available in the When box.
See descriptions below.

Number of output documents — Splits a document into a specified number of equally sized output documents. For
example, if you submit a document with 99 pages, and you set Number of output documents to 3, you would get
3 output documents of 33 pages each. If the number of pages of the document is not equally divisible, the document
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will be split as close as possible to even numbers. For example, a document with 24 pages split into 5 documents will
return 4 documents that are 5 pages, and 1 document that is 4 pages.

If necessary, you can select extraction variables created from the Extract Text tab as conditions in the When box.
Output Manager will find the position in the source document where the split should occur based on pages per
documents, and then start a new document after the additional condition is met. This allows the boundary between
split documents to be better controlled based on the contents of the document.

Burst when

Important:  To enable the Burst when box when splitting on extracted variables, you must create extraction
variables from the Extract Text - line mode tab or Extract Text - page mode tab.

The Burst when box is used to create and manage burst conditions. Multiple conditions can be created and organized
into groups. A blue box is used to indicate a condition group. To create a condition, click the <Target> link and then
click the appropriate variable. The variables that display vary depending what the split is based on.

• If the split is based on Extracted variables, the extraction variables added from the Extract Text tab will be
listed in the menu.

• If the split is based on Number of pages, you can choose the following variables to split the document based on
the number of pages:

• Split > Pages in current document — Specifies the total number of pages in the current document.
• Split > Pages in new document — Specifies the number of pages to be contained in each new burst document.

The number of pages is determined from the beginning of the document or from the previous burst. If the total
number of pages of the current document is not equally divisible by this value, the final burst document will
contain fewer pages.

Note:  For example, if you create a condition where "Pages in new document is divisible by 20 AND Pages
in current document is between to 0 AND 200", when you submit a 100 page document, the process will
split it into 5 20 page documents. Each page is analyzed to determine if it is the 20th page since a burst or the
beginning of the document. When the 20th page is reached, a new burst document is created containing those
20 pages (that page combined with the previous 19 pages). The page count process repeats until the end of the
document.

• If the split is based on Number of output documents, the extraction variables added on the Extract Text tab will
be listed in the menu.

Once the target is selected, click the Operation link to select the appropriate operation. Click the Value link to select
the appropriate value. This will complete the condition statement.

You can select the condition statement and use the buttons below the box to add and remove conditions.

• Select a condition radio button (inside the box) to enable the Add Condition and Remove Condition buttons for
adding and removing condition statements.

• Select a group radio button (outside the box) to enable the Add Group and Remove Group buttons for adding
and removing groups. This will also enable the Add Condition button for adding a condition to the selected
group.

Output format (Page Mode Only)

Bursting using page mode allows you to transform the document in this rule action. You can choose to leave the
output format the same as the input format or change it to a format in the list.
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Follow on actions

Input document — Specifies the follow on actions for the input document (original document). You can choose to
delete, retain, or process the next rule for the original document. The newly created documents (output documents)
continue with the next rule action.

Set Document Properties tab
Use this tab to set the document properties for the documents created from splitting printer-ready documents.

This tab is used with extracting and bursting business rule actions.

• Extract — Line mode extracts text from line data documents using rows and columns. Page mode extracts text
from printer ready documents using regions (rectangles).

• Burst — Line mode splits text documents based on data contained in the document. Page mode uses regions
(rectangles) to determine burst conditions. Use this tab to configure the document properties on the new
documents created by bursting.

Properties

Configure the document properties by clicking directly in the grid.

Document Property column — Lists the property values that can be configured. The properties are grouped into the
following categories: Basic options, Media selection, Document, Image adjustments, Finishing, and Other properties.
To expand a category, click the down arrow next to a category name. To collapse a category, click the up arrow.

Under each category are the print preferences/document properties that belong to that group. The first node level in
the categories determine the print preferences for the properties it contains. On the print preference node, you select
how the property should be applied when a document is sent to a destination. Under each print preference are the
parameters needed to generate that print preference.

Mode column — Specifies how to apply the property value. Click in the cell and choose one of the following options:

• Always Apply — Always applies the specified property value. Output Manager will add commands to the print
stream to enforce the print preference. If the document already contains commands for that print preference,
Output Manager will modify the commands to work with the printer family where the document is being sent.

• Apply Conditionally — Applies the property value conditionally. Output Manager will only add or modify
commands for the print preference when the printer family that the document is destined for is different from the
printer family the document was originally designed for.

• Informational Only — Output Manager makes no changes to the print stream when the document is sent to the
destination. The value is for informational purposes only.

• Value Not Set — No value is set for the property.

Value column — Specifies the document property value. Click directly in the cell to change the value. You can use
functions to insert and extract data as necessary.

Business Rule dialog box
Use this dialog box to create and modify business rules. You can configure business rules for managing automated
document processes. You can access this dialog box in the Business Rules Manager dialog box.

Name

Enter the name of the business rule.
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Enabled

Use the check box to enable or disable the rule. This option is enabled by default.

Description

Enter a description of the business rule. This will show in the Business Rules Manager dialog box.

Rule definition

Always execute this rule (no conditions) — Use this option to apply the rule to all documents. This will disable the
When box as no condition statements are needed.

When

The When box is used to create and manage the rule conditions. Multiple conditions can be created and organized
into groups. A blue box is used to indicate a condition group.

To create a condition, click the <Target> link and then click the appropriate condition. Click the Operation link to
select the appropriate operation. Click the Value link to select the appropriate value. This will complete the condition
statement.

You can select the condition statement and use the buttons below the box to add and remove conditions.

• Select a condition radio button (inside the box) to enable the Add Condition and Remove Condition buttons for
adding and removing condition statements. The new condition will be added after the currently selected condition.

• Select a group radio button (outside the box) to enable the Add Group and Remove Group buttons for adding
and removing groups. This will also enable the Add Condition button for adding a condition to the selected
group. The new condition will be added to the end of the current list of conditions.

Perform the following actions

The Perform the following actions box is used to create and manage rule actions.

• To create an action, click the <Action> link and select the appropriate action type. You can create actions to do the
following:

Action Description

Assign Profiles to Document • Set Failover Profile — Specifies what should happen
to documents when they are sent to inaccessible
destinations (they are not able to receive documents).

• Set Filter Profile — Associates a filter profile with
a document. This filter will be used for document
viewing and reprinting.

• Set Library Filing Profile — Sends documents to
the document library. Specifies the library folder
where documents will be sent, the file store, any
notifications, and how long to keep documents before
deleting.

• Set Notification Profile — Sends notifications when
specific events occur in the document life cycle.
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Action Description

• Set Output Process — Performs processing such as
search and replace, setting finishing options, editing
PJL commands, inserting overlays, and so on.

Burst • Line Mode — Bursts line data documents based on:
data contained in the document, desired output size
and size of original document, and number of output
documents desired.

• Page Mode — Splits printer ready documents based
on: data contained in the document (regions are used
to determine burst conditions), desired output size
and size of original document, and number of output
documents desired.

Extract Text • Line Mode — Extracts text from line data documents
using rows and columns.

• Page Mode — Extracts text from printer ready
documents using regions (rectangles).

Modify Document Contents Runs the ADM (Advanced Document Modification)
process. In this process each page of the document is
read, portions of the document can be changed or values
extracted, and then the page is written. This can be used
as an advanced way to extract text, burst, or perform
other operations on the document.

Route to Destinations • Advanced — Allows you to use a CSV file to
dynamically pick destinations based on a document
property.

• Basic — Specifies the destinations where documents
should be sent.

Set Document Properties Configures document properties.

Transform Document • Adept — Transform documents using the Adept
transform suite.

• Page Mode — Transforms the format of a printer
ready document to a new format, and/or to another
data type.

• Record Mode (Advanced) — Transforms line data
from one line format to another.

• Record Mode (Basic) — Performs the most common
transforms for data coming from a Output Manager
Print Server device. This converts .tnj to ASCII
text, .anj to AFP, and .bnj to .bin.

Analyze Document Processes documents and populates document properties.



Output Manager Administration Guide
Version 4.0 SP2

481 © 2016 Nuance Communications, Inc. All rights reserved.

Action Description

Assign to Document Folder Assigns documents to specific document folders.

Convert Fixed Block to Variable Block Converts FBA to VBA and FBM to VBM. It can be used
when dealing with mainframe tape formats.

Delete Document Deletes documents.

Move Document to File Store Moves documents to another location (file store).

Package Banner Adds a banner to the beginning of the package. The
banner will be added as a separate document within the
same package.

Power Rule Allows you to build multiple rules inside of one rule.

Run Ad hoc Rule Allows you to select an ad hoc rule.

Run Command Performs a command line operation on the document.

Schedule Output Schedules documents to print at a specific date and time.

Send Email Sends email messages when specific events occur in the
document life cycle.

Set Billing Accounts Documentation coming soon

Set Document Owner Configures the document owner.

Set Document State Sets the document state to hold or ready.

Set Retain Period Determines how long documents will be retained.

Unpackage Separates documents that are in a package so they can
act as individual documents in Nuance Output Manager.
Once documents are separated, rules can be run on them
individually, they can be routed individually, and so on.

• To create additional actions, click Add Action.
• To modify an action, click the desired action link or click the area next to the link and click Modify Action.
• To delete an action, click the area next to the link and click Remove Action.
• To reorder the actions, click the area next to the action link and click Move Up or Move Down.

Follow-on action

Select the action you would like to take after this rule has been processed. You can continue processing rules or select
not to process any additional rules.
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Business Rules Manager dialog box
Administrators can use the Business Rules Managerto create business rules. Business rules are configured by
selecting an event and then configuring the document process that will be performed when that event occurs. Example
business rules include routing to destinations, transforming to other print languages, assigning to document folders,
and editing document properties.

Business rules grid

The business rules grid lists all of the defined business rules, in the order they will be processed. Selecting a rule will
display the rule for preview below the grid. The business rules grid is editable. Use the following procedures from the
rules grid.

• Use the check box in the Enabled column to determine if the rule is enabled or disabled.
• To change the follow-on action, click in the Follow-on Action cell and select the action you would like to take

after this rule has been processed. You can continue processing rules or select not to process any additional rules.

The following buttons display below the grid.

• Add button — Creates a new business rule. Opens the Business Rule dialog box.
• Modify button — Modifies the selected business rule. Opens the Business Rule dialog box.
• Remove button — Deletes the selected business rule.
• Copy button — Creates a copy of the selected rule. To rename the rule, double-click the rule, or select the new

rule and click Modify. Opens the Business Rule dialog box.
• Move Up button — Reorders the business rules by moving the selected rule up.
• Move Down button — Reorders the business rules by moving the selected rule down.

Preview for rule

Displays a preview of the selected business rule.

Configuration tab
Use this tab to configure Advanced Document Modification settings for business rules and output process actions.

In Advanced Document Modification, each page of the document is read, portions of the document can be changed or
values extracted, and then the page is written. Documents can be reordered, split, transformed to a different data type,
barcodes added, OMR marks added, and logos changed using ADM. ADM can be executed in a business rule action
or in the output process.

Server configuration

Server — Specifies the licensed transform server that you would like to use.

Transform package — Specifies the transform package. You can select a transform package from the list or click
New to create one. You can also select a transform package and modify or remove it.

Additional parameters — Specifies any additional parameters needed for the document modification software.

Override input filter profile assigned to document — Determines if you want to use the filter profile assigned to
the document or if you want to use the filter profile configured in the transform package. Select the check box to use
the filter profile in the transform package.
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Unit library configuration

Unit library — Unit libraries are JavaScript modules that CpMill calls at certain known times while processing
a document (for example, begin document, page start, or page end). The modules can modify the contents of the
document, extract information from the document, write the document, or parts of it, to a new location, or perform
many other operations.

• New button — Creates a unit library from the Configure Unit Library dialog box.
• Modify button — Modifies the selected unit library.
• Remove button — Deletes the selected unit library.

Unit library will create:

Important:  This option is only available when configuring ADM actions for business rules.

• the same document — Select if your unit library is modifying the input document and writing it to the same
location. See the default comments in unit library for how to tell Nuance Output Manager the names of the new
documents that are created.

• different documents — Select if your unit library is modifying the current document and outputting it into a new
document, or if your unit library is bursting the document into many different documents. See default comments in
unit library for how to tell Nuance Output Manager the names of the new documents that are created

• multiple documents combined into one — Currently not available.

Follow on actions

Input document — Specifies the follow on actions for the input document (original document). You can choose to
delete, retain, or process the next rule for the original document. The newly created documents (output documents)
continue with the next rule action.

Important:  Follow on actions are only available when configuring ADM actions for business rules.

Configure Columns Utility
Use the Administration application Configure Columns Utility to configure the columns that will display by default
in the destination, source, library, and device grid views. You can add, remove, and reorder columns as necessary
from the grids.

Tab pages

Displays tab pages representing the Destinations, Sources, Library, Device, Output History and Document Owner
grids. Each tab displays a grid listing all of the columns that currently display in the appropriate grid. The grids are
editable. Use the following procedures from the grid.

• To change the display name, click the appropriate cell in the Display Name column and enter the new name. Cells
with a gray background cannot be edited.

• Use the Visible in Grid and Editable in Grid columns to specify if the column will display in the grid and if it
will be editable. Cells with a gray background cannot be edited.

• Use the Visible in Rules and Editable in Rules columns to specify if the column will be available and editable
from the Alert Rules Manager and the Business Rules Manager. Cells with a gray background cannot be edited.
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Add button

Adds columns to the grid. Displays the Add Column dialog box.

Remove button

Removes the selected column from the grid

Move Up button

Reorders the columns by moving the selected column up.

Move Down button

Reorders the columns by moving the selected column down.

Configure Device dialog box
Use this dialog box to configure a device in the Devices application.

Configure Document Properties Utility
Use the Administration application Configure Document Properties utility to select which print preferences/
document properties are supported throughout Nuance Output Manager. You can also select the settings that are
allowed for a particular property. These settings determine what is available to the user in the dialogs where properties
are configured. When properties are disabled, those Document columns are also hidden in the Documents grids.

Grid

The Document property column lists the print preferences/document properties that are available to Nuance
Output Manager. They are grouped into the following categories: Basic options, Media selection, Document, Image
adjustments, Finishing, and Other properties. To expand a category, click the down arrow next to a category name. To
collapse a category, click the up arrow.

Under each category are the document properties that belong to that group. In each group, you can determine the
properties that are supported throughout Nuance Output Manager. Select the check boxes in the Allowed column
for properties you want to be available for configuration. Clear the check boxes for properties you do not want to be
available.

If a property is configured by selecting from a list of options, those properties will display a drop-down arrow. Click
the cell containing the arrow to display a dialog listing the available options. Select and clear the check boxes in the
Allowed column to determine the choices that will be available when those properties are configured.

Note:  Here is an example of how to configure the Resolution property so users can only select a Resolution
of 75, 100, or 150. First, expand the Basic options category by clicking the down arrow next to the category
name. Next, select the Allowed check box next to the Resolution property. This will make the property
available for configuration throughout Nuance Output Manager. To configure the Resolution options, click
the Resolution cell containing the drop-down arrow. In the dialog that displays, select the Allowed check
boxes next to the options you want to be available for selection. In this example, you would select the check
boxes next to 75, 100, and 150. Clear the check boxes next to the remaining Resolution options. Click OK.
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Use the Visible in grid and Editable in grid columns to specify if the column will display in the grid and if it will be
editable. Cells with a shaded background cannot be edited.

Use the Visible in rules and Editable in rules columns to specify if the column will be available and editable from
the Alert Rules Manager and the Business Rules Manager. Cells with a shaded background cannot be edited.

Set view order button

Sets the order that document properties will appear in grids. The View Order dialog box is displayed.

Refresh button

Sets all check boxes to the last saved configuration. Any unsaved changes will be lost.

Configure IP Ranges dialog box

Use this dialog box to configure IP address ranges for auto-detecting devices through SNMP. You can access the
dialog box when configuring SNMP server settings through Administration - Manage Devices.

You configure the ranges that are associated with specific SNMP services. These are the ranges that Nuance Output
Manager uses to automatically detect devices. When you manually detect devices, you can select these ranges.
Detecting devices using SNMP on page 62 provides more information on manually detecting devices.

Import ranges from file button

Adds IP address ranges that are defined in a comma separated values (CSV) file. Verify that the values in the file are
formatted as follows:

startAddress,endAddress,optionalComment
startAddress,endAddress,optionalComment
startAddress,endAddress,optionalComment

The following example shows values from a CSV file:

10.16.16.0,10.16.16.255,
10.16.17.0,10.16.17.255,
10.16.18.0,10.16.18.255,My favorite range
10.16.28.0,10.16.28.255,
10.16.30.0,10.16.30.255,
10.16.80.0,10.16.80.255,Common Color range
10.201.4.0,10.201.4.255,
10.201.8.0,10.201.8.255,
10.201.9.0,10.201.9.255,

Add single IP range

Use this section to add a single IP address range. Specify the start and end addresses and click Add.
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Discover domain IP ranges

Use this section to discover IP address ranges in a domain. The current domain appears by default. Network size
determines how long it takes Nuance Output Manager to discover IP ranges on a domain. Discovering IP ranges takes
longer on a large network.

Discover button

Change the current domain if necessary and click this button to scan the domain for IP address ranges.

The Status indicator shows the number of computers found in the Active Directory. While the scan is in progress, the
indicator shows the approximate remaining scan time. The discovered IP addresses are grouped into ranges of 256
addresses (xxx.xxx.xxx.0 – xxx.xxx.xxx.255).

Stop button

Stops scanning the domain for IP address ranges.

Grid

Shows the detected IP address ranges on the domain.

Clear selected button

Clears all the ranges selected in the grid.

Clear all button

Clears all the ranges in the grid.

Export ranges to file button

Save the ranges to a CSV file. The format of the file is the same as the format described in Import ranges from file
button on page 485.

Save button

Saves the current IP address ranges configured in the grid.

Configure Method Call dialog box
Use this dialog select a method from a DLL file to be called after the document has been transferred to its destination.
This is limited to calling only public methods or instantiating public objects from the DLL file which have only basic
parameter types.

You can access this dialog when configuring a Call Method output process action.

Assembly

Specifies a DLL file which contains the public method (or object to instantiate which has the method) you wish to
call. You can type the path and file name in the box or click Choose file to locate a file.
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Type

Displays the object types. Select the type on which to make the call.

Constructor

Displays the constructors in the selected type. Select the constructor method you want to use to instantiate the object
(if any). The constructor chosen must have either no parameters or only parameters of basic types (string, Boolean,
and numeric – Int16, Int32, or Int64).

If the chosen constructor has parameters to be defined, specify them in the Constructor Parameters grid. You can
also right click to select document properties or functions in the parameter values. Review the Using Nuance Output
Manager functions help topic for information on configuring functions.

Method

Displays the methods in the selected type. Select the method to be called. The method chosen must have either no
parameters or only parameters of basic types (string, Boolean, and numeric – Int16, Int32, or Int64).

If the chosen method has parameters to be defined, specify them in the Method Parameters grid. You can also right
click to select document properties or functions in the parameter values. Review the Using Nuance Output Manager
functions help topic for information on configuring functions.

Configure Transform dialog box
Use this dialog box for selecting and updating a transform. You can access this dialog box when you configure a
transform action for business rules, ad hoc rules, or output processes, or when configuring an IPDS destination (not
available for new sales).

Important:  Nuance recommends installing Ghostscript (available as a freeware download) and Adobe
Acrobat PDF Reader (or the full version of Adobe Acrobat if available) on servers that are using Nuance
Output Manager transforms. These packages provide access to certain Postscript and PDF Type 1 fonts. The
associated viewers are also useful for Postscript and PDF troubleshooting.

Server configuration

Server — Specifies the licensed transform server.

Transform package — Specifies the transform package. Select a transform package from the list or click New to
create one. You can also select a transform package and modify or remove it.

Format configuration

Override input filter profile assigned to document — Determines if you want to use the filter profile assigned to
the document or if you want to use the filter profile configured in the transform package. Select the check box to use
the filter profile in the transform package.

Output format — Specifies the output format. Once this is selected, the input formats grid populates with the
available input formats. All of the input types can also be created as output formats except LCDS, MMD, and SAP
formats.

Input formats grid — Specifies the conversion for each input format. Click directly in the columns to configure the
transform.
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• Format column — Shows the input format.

Type File Extension Record Format Transform Package

PCL5 .pcl, .pcl5 Binary All

PCL6 .pcl6 Binary All

PDF and PDF/A .pdf Binary All

Postscript .ps, .pos Binary All

Text .txt Text* All

Images — TIFF, JPEG, GI
F, BMP, IOCA, TGA, PC
X, PNG

.tiff, .jpg, .gif, .bmp, .ioca
, .tga, .pcx, .png

Binary All

AFP .afp AFP data in 5A records Third party

ANJ .anj NJE wrapped AFP Third party

MMD .mmd AFP as mixed mode data* Third party

LCDS .lcds, .lcd Xerox LCDS as VBM, S/3
70, or TNJ

Third party

SAP .sap Text* Third party

XRX .xrx Xerox metacode in VBM Third party

* Text and mixed mode AFP (MMD) documents may have a number of different record structures. Possibilities
include standard ASCII text, fixed-length records (FBA or FBM) with defined record lengths, variable length
records with defined delimiters, VBM, VBA, S/370, and NJE wrapped. Nuance Output Manager attempts to
automatically detect the record format to perform the transform.

• Configuration column — Specifies if you want to use the default conversion options, use a custom set of options,
or not to transform data.

• Modify/New column — Specifies custom transform options and command line switches. Clicking this cell
displays the following tab pages listing all of the available transform options: Input options tab, Output options
tab, and Page Layout tab. If BMP or PDF is selected as the output format, the Bitmap output tab or PDF output
tab will also display. Once the transform settings are configured, the new transform configuration will be selected
in the Configuration column.

Follow on actions

Input document — Specifies the follow on actions for the input document (original document). You can choose
to delete, retain, or process the next rule for the input document. The newly created documents (output documents)
continue with the next rule action. If Process next rule is selected for the input document, the input document will
skip the rest of the actions in the current rule and begin processing at the start of the next rule.

Warning:  Follow on actions are only available when configuring transform actions for business rules.
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Configuring administrative options
The Administration application is used to configure administrative options in Nuance Output Manager. In the
navigation pane, click the Administration button to open the Administration application. The navigation pane
displays the following list of links used to configure the administrative options.

• Configure Columns
• Configure Document Properties
• Configure NetWeaver Integration
• Manage License
• Manage Product Components
• Manage SNMP
• Manage Users
• Manage Windows Queues
• Set General Preferences
• System Health

Connect to Output Manager Server dialog box
Use the Connect to Output Manager Server dialog box to select the Nuance Output Manager server you want to
connect to. This dialog box displays when you open the Output Manager Console and when you open a new Nuance
Output Manager Console connection.

OM server

Enter the Nuance Output Manager server where the Nuance Output Manager DBM Service is started. If you have
previously connected to a server, you can select that server from the list.

Connection mode

Select the protocol for the connection between the Output Manager Console and the Nuance Output Manager
server. In a high availability environment, the Output Manager Console and other clients use HTTP or HTTPS to
communicate with the single Nuance Output Manager logical server through a load balancer.

Logon as

Select if you want to log on to Nuance Output Manager as the Current Windows user, an Output Manager user, an
LDAP user, or for a Windows user account, a Different Windows user. If you select to log on as an OM user, LDAP
user, or Different Windows user, you must complete the User name and Password boxes. The Domain box must be
completed for the Different Windows user selection.

Remember settings

Select this check box to remember the selected configuration setting the next time you open this dialog box.
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Create Package dialog box
Use this dialog box to create a package of documents for an ad hoc rule. If you create the action from the Ad Hoc
Rule dialog box, all of the documents that meet the specified criteria will be put in a multiple document package.
If you create and run the action against documents in the Documents grid, all selected documents will be put in the
package.

Naming prefix

Specifies the naming prefix for the package. This prefix will be added to all packages created by this action.

The naming prefix is especially useful when the create package action will be run by a scheduled rule. Each time
the rule runs and generates a new package, the prefix will added. If you have multiple scheduled rules running that
generate different packaging, you will be able to distinguish the resulting packages based on the original rule. It does
not prefix any documents contained within the packages.

Grouping property

Specifies if a grouping property will be used to further divide the packaging. For the selected property, documents are
grouped into packages by each unique value of that attribute. For example, you selected Form Name for grouping
and you have 20 documents that are being packaged. In the documents, 3 have the value of "Form-A", 5 are "Form-
B", 10 are "Form-C", and 2 are "Form-X". Once packaged, you will end up with 4 packages, 1 for each unique form
type. All "Form-A" documents will be in their own package, "Form-B" documents in their own package, and so forth.

Ordering properties

Specifies the document properties that will control the order the documents are packaged. Expand the sections in
the Ordering properties list to view the available document properties. As you select properties, they display in the
Selected order list.

Note:  Only the allowed properties selected in the Configure Document Properties Utility will display in
the Ordering properties list.

Select properties in the Selected order list and use the Move up and Move down buttons to configure the property
order.

Closing conditions

Important:  This section is available only when the action is created from the Ad Hoc Rule dialog box.

Configures the closing conditions for the package. This will determine when the package is complete. You can
configure one or more closing conditions.

• Closing document – Closes the package once the specified closing content is received. In the Closing document
action box, choose whether to remove the closing content, add it to the current page, or add it to the next page. In
the When box, configure the conditions for specifying the content.

• Time elapsed since package creation – Closes the package when a specified amount of time has elapsed since the
package was created (the first document was added to the package). Specify the time period using the options next
to Elapsed time.

• Time elapsed since last match – Closes the package every period of time specified. Specify the time period using
the options next to Elapsed time.



Output Manager Administration Guide
Version 4.0 SP2

491 © 2016 Nuance Communications, Inc. All rights reserved.

• Specific time of day has occurred – Closes the package at a specified time each day. In the Time of day box,
specify the time.

• Auto close (For "Run Now" or document right-click configuration) – Closes the package (or packages when
grouping) when the last target document has been packaged by the action.

Important:  This option is used for running an ad hoc rule using the Run Now button in the Ad Hoc Rules
Manager dialog box, or when right-clicking a document in the Documents grid and clicking a rule on the
Run Ad hoc Rule shortcut menu.

Custom DBM Activation dialog box
Use this dialog box to select the individual Nuance Output Manager components you want to activate.

Components grid

Displays the Nuance Output Manager components available to be activated.

Select all DBM components

Selects all Nuance Output Manager components listed in the grid.

Via the Internet

Activates the Nuance Output Manager components using an Internet connection.

Deactivate DBM Components dialog box
Use this dialog box to select the individual Nuance Output Manager components you want to deactivate. If all Nuance
Output Manager components are deactivated, then the license file will be uninstalled.

Components grid

Displays the installed Nuance Output Manager components. Select the components you want to deactivate.

Select all DBM components

Select this check box to select all Nuance Output Manager components listed in the grid.

Use Internet connection

Select this check box to deactivate the Nuance Output Manager components using an Internet connection.

Important:  If you do not select this check box, the activation database at Nuance will not be updated. Please
contact Nuance Support directly to keep the license in the correct activation status.

Department dialog box
Use this dialog box to add departments to Nuance Output Manager. Departments are particularly useful for reporting,
as each user can only belong to one department. Departments are used to group Nuance Output Manager users,
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Windows users, and LDAP users. For Windows users, department membership can be retrieved from Active
Directory.

Department name

Specifies the department name.

Select the users you want to add to the department

Displays all of the Nuance Output Manager users. Select the check box column for the users you want to add to this
department and click the right arrow (>) button. This moves the selected users to the Department members grid.

Tip:  To search for a name, click one of the cells in the Name column and then start typing the name you
are searching for. You can type one letter or more letters. As you type, the first name that matches will be
highlighted.

Arrow buttons

Right arrow (>) button — Moves the selected users into the Department members grid.

Double right arrow (>>) button — Moves all users into the Department members grid.

Left arrow (<) button — Removes the selected users from the department and places them back in the Select users
grid.

Double left arrow (<<) button — Removes all users from the department and places them back in the Select users
grid.

Department members

Displays the users that are a member of the department. To remove users from the department, select the check box
column for the appropriate users and click the left arrow (<) button. This moves the selected users back into the in the
Select users grid.

Departments tab
Use this tab to manage departments, which are network management entities used by LDAP and UNIX networks.
You can specify a quota management profile to disable printing for a department under certain circumstances, set up
a desktop client profile, and set a print balance for a department to control costs. Departments cannot be assigned
security permissions.

Click an option you want to learn more about.

• Users tab on page 698
• Groups tab on page 550

Departments grid

From this grid, you can add and manage departments.

Full Name — Specifies the name of the department.

Quota Profile — Specifies the name of the quota management profile assigned to this department. The quota
profile sets up restrictions based on the type of document, for example, precluding color printing and requiring
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that documents be duplexed. It is not required that all users in the department use the quota profile assigned to the
department.

To select a profile, click the cell and select a profile from the list. To manage profiles, click the Browse button to open
the Manage User Quota Profiles dialog box.

Desktop Client Profile — Specifies the name of the client profile assigned to this department. To select a profile,
click the cell and select a profile from the list. To manage profiles, click the Browse button to display the Manage
Desktop Client Profiles dialog box. The column is only visible when the Desktop Client is licensed.

Set Balance — Indicates whether a print allowance is assigned to users in this department. It is not required that
all users in the department have an allowance or that they have the same allowance. From the Users tab, you can
specify that a user not be governed by inheritance, that a user be assigned an unlimited balance (by not selecting Set
Balance), or that a user have a different balance than the department.

Initial Balance — Specifies the print allowance for the department at the beginning of an accounting period. It is not
required that all users in a department have the same initial balance. From the Users tab, you can specify that a user
not be governed by inheritance, that a user be assigned an unlimited balance (by not selecting Set Balance for that
user), or that a user have a different initial balance from the department. In addition, if you reset the initial balances of
all department members, you can then choose whether to reset the remaining balances.

Refresh Period — Specifies the number of days in an accounting period.

Add button

Opens the Department dialog box so that you can add a department that is not listed.

Modify button

Displays the Department dialog box so that you can change information.

Remove button

Deletes the selected department.

Desktop Client Installation dialog box
This dialog box allows the Administrator to create a custom MSI (installer) file for deploying the Desktop Client to
all end user machines.

You can access this dialog by clicking Tools > Desktop Client Installation on the Output Manager Console menu
bar.

DBM Server Name

Specifies the DBM server name. Click the browse button (...) to search for a DBM server on a specific domain.

DBM Server Port

Specifies the DBM server port number.
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Backup DBM Server Name

Specifies the backup DBM server name. Click the browse button (...) to search for a DBM server on a specific
domain.

Create Custom MSI button

Creates the MSI (installer) file. This opens the Browse for Folder dialog box, so you can select where you want to
save the file.

Desktop Client Profile dialog box
Use this dialog box to configure desktop client profiles.

You can access this dialog box when you configure users or departments in the Manage Users utility on the Users tab
or on the Departments tab.

Profile name

Specifies the document client profile name.

Profile description

Specifies a description of the document client profile.

General options

• Wait for final page count before allowing printing to start — Specifies if you want to wait for the final page
count before printing.

• Display client in system tray — Determines if the client will display in the system tray.
• Allow users to shut down the client and end tracking — Gives users the ability to shut down the client and stop

all tracking.

Handling of print jobs in disconnected mode

Determines how print jobs should be processed when in disconnected mode. You can choose from the following
options:

• Disallow print jobs when disconnected
• Allow jobs and enforce quotas using cached information
• Allow all jobs and do not enforce quotas until reconnected

Client popup options

• Allow batch processing of popups — Determines if users can submit popup responses in "batch." When this
check box is selected, users can specify that their responses to the Client Popup should be applied to the next x
print jobs as well. (Where x is the number in the Maximum number of jobs in this batch box).

For example, you need to print 10 different documents and you want to bill them all to the same account. When you
print the first one, you get a popup that asks you to select which account to bill this to. After you select the billing
account from the drop-down, on the popup there will be an option that asks you to specify the number of print jobs to
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apply the same selections. You would specify 10. Then, for the next 9 things you print, you will not get a popup, and
it will automatically bill it to that account.

• Batch timeout(seconds) — Specifies the batch timeout in seconds. If this timeout expires, the batch job is
canceled and you will have to enter billing accounts again.

• Batch automatically (subject to timeout) — Specifies if you want the batch to happen automatically until the
timeout expires.

• Maximum number of jobs in batch — Specifies a maximum number of jobs in batch.
• Display previously selected billing accounts on popup — Specifies if you want to display previously selected

billing accounts on popup. The billing accounts you selected on your previous popup will automatically be
selected in advance in the drop-down lists on the next popup. This is added for convenience if you use the same
billing account many times.

Destination Capabilities dialog box
Use this dialog box to select which print preferences/document properties are supported by the destination. You can
also select the settings that are allowed for a particular property. These settings determine what is available to the
user in the dialogs where properties are configured for this destination. You can access this dialog box by selecting
Destination specific capabilities on the More settings tab.

Print preferences

Lists the print preferences/document properties that are available for this destination. They are grouped into the
following categories: Basic options, Media selection, Document, Image adjustments, Finishing, and Other properties.
To expand a category, click the down arrow next to a category name. To collapse a category, click the up arrow.

Under each category are the document properties that belong to that group. In each group, you can determine the
properties that are supported by this destination. Select the check boxes for properties you want to be available for
configuration. Clear the check boxes for properties you do not want to be available.

If a property is configured by selecting from a list of options, those options will display beneath the property. You can
select and clear the check boxes to determine the choices that will be available when those properties are configured
for this destination.

Note:  Here is an example of how to configure the Resolution property so users can only select a Resolution
of 75, 100, or 150. First, expand the Basic options category by clicking the down arrow next to the category
name. Next, select the check box next to the Resolution property. This will make the property available for
configuration for this destination. Finally, under the Resolution property select the check boxes next to the
options you want to be available for selection. In this example, you would select the check boxes next to 75,
100, and 150. Clear the check boxes next to the remaining Resolution options.

Destination Configuration dialog box
Use this dialog box to configure a destination.

To open this dialog box, right-click a destination and click Configure on the shortcut menu.
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Options

Option Description

Name  Specifies the name of the destination.

Server Specifies the Output Manager server where the Output M
anager Output Service is located for this destination.

Comments Provides space to enter comments about the destination.

Location  Specifies any specific location information for the destin
ation.

Image  Displays a destination image. To change the destination i
mage, click Select Image and choose the appropriate im
age file (BMP, JPEG, or PNG). The selected image will
be compressed and scaled to 96x96 pixels. Changing this
image will not change the smaller destination type image
that displays in this dialog box or the image that displays
in the destination tree. To change the image back to the d
efault, click Reset Image.

General tabs

The following tabs specify settings for any type of destination.

Tab Description

More settings tab (Destination Configuration) on page
506

Use this tab to configure common configuration options
that available to all destination types.

Error Handling tab (Destination Configuration) on page
499

Use this tab to configure error handling options that are
available to all destination types.

Source specific tabs

The following tabs provide settings for specific types of sources.

Icon Source Description

AutoStore settings tab (Destination
Configuration) on page 497

Configure settings on this tab for an
AutoStore destination.

Email settings tab (Destination
Configuration) on page 498

Settings on this tab configure an
email destination.

Fiery device settings tab (Destination
Configuration) on page 499

Use this tab to configure a fiery
device destination.

FTP settings tab (Destination
Configuration) on page 501

Use this tab to configure an FTP
destination.
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Icon Source Description

IPDS settings tab (Destination
Configuration) on page 502*

Use this tab to configure an IPDS
destination.

IPP settings tab (Destination
Configuration) on page 503

Use this tab to configure an
IPP (Internet Printing Protocol)
destination.

JDF/JMF settings tab (Destination
Configuration) on page 504

Use this tab to configure an JDF/JMF
job ticket settings.

LPR settings tab (Destination
Configuration) on page 504

Use this tab to configure an LPR
destination.

Folder settings tab (Destination
Configuration) on page 500

Use this tab to configure a network
folder destination.

OM settings tab (Destination
Configuration) on page 508

Use this tab to configure an Nuance
Output Manager destination.

PRISMAProduction settings tab
(Destination Configuration) on page
508

Use settings on this tab to configure
a PRISMAProduction destination for
an Océ PRISMAproduction server.

SharePoint device settings tab
(Destination Configuration) on page
509

Use this tab to create or configure a
SharePoint destination.

Socket settings tab (Destination
Configuration) on page 511

Use this tab to configure a socket
destination.

WebSphere MQ settings tab
(Destination) on page 512

Use this tab to configure a
WebSphere MQ destination.

Windows queue settings tab
(Destination Configuration) on page
513

Use this tab to configure a Windows
queue destination.

AutoStore settings tab (Destination Configuration)
Configure settings on this tab for an AutoStore destination.

Option Description

IP address Specifies the IP address for the AutoStore server.

• Default value
• Dynamic override

Port The port that AutoStore uses to communicate with clien
ts.

• Default value

* IPDS not available for new sales.
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Option Description

• Dynamic override

Email settings tab (Destination Configuration)
Settings on this tab configure an email destination.

Documents routed to an email destination will be sent to the email address specified. You can access this tab when
you create or configure an email destination.

You can configure a default value and a dynamic override value for email field settings on this tab. The dynamic
override setting allows you to specify a document property or a function that returns a value at run time.

• Default value — Specifies a static value that is used when no override value is returned at run time.
• Dynamic override — Specifies a property or function to define an email field at run time:

• To insert a document property, right-click this box and click Insert Document Property and select a property
from one of the submenus. When the specified property contains a value, the value is used instead of the
default value.

• To insert a function, right-click in this box, click Insert Function, and choose the function.

Option Description

Email profile Select the email profile that will be used with this rule. Y
ou can select a profile from the list or click the browse b
utton (...) and mange profiles in the Manage Outbound
Email Profiles dialog box. From this dialog box you can
create and modify email profiles.

To Specifies the email address that will receive all documen
ts sent to this destination. You can enter multiple email a
ddresses separated by a comma.

CC Specifies the email address that will be copied on this m
essage. You can enter multiple email addresses separated
by a comma

BCC Specifies the email address that will be blind copied on t
his message. You can enter multiple email addresses sep
arated by a comma.

From Specifies the email address that will be shown as the sen
der of all documents sent to this destination.

Reply to Specifies the email address where replies will be routed.
You can enter multiple email addresses separated by a c
omma.

Subject Specifies the email message subject that will display for
all documents sent to this destination.

Body Specifies the text that will display in the email message f
or all documents sent to this destination.
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Error Handling tab (Destination Configuration)
Use this tab to configure error handling options that are available to all destination types.

Use this tab to configure error handling options that are available to all destination types. You can access this tab
when you create or configure a destination.

Click an option you want to learn more about.

• Folder settings tab (Destination Configuration) on page 500
• More settings tab (Destination Configuration) on page 506

Error handling profile

Error handling profiles specify what should happen to destinations when an error is detected via SNMP or during
transmission of a document.

Use the list to select an existing error handling profile.

New — Displays the Error Handling Profile dialog box for creating a new error handling profile. You can configure
what will happen if specific types of errors are detected via SNMP or occur while transmitting documents. You can
select how many times to retry a document, determine what should happen if all of the retries fail, and whether or not
to initiate document failover.

Edit — Displays the selected error handling profile’s properties for modification.

Manage — Displays the Manage Error Handling Profiles dialog box, which lists all of the defined error handling
profiles. From this dialog box you can create, import, and export profiles, as well as manage all existing profiles.

Default failover destination

Failover specifies what should happen to documents when they are sent to inaccessible destinations (they aren’t able
to receive documents) or destinations that have reported specific SNMP conditions. You can choose to route the
documents to a destination group or specific destination. The parent group where the destination currently resides is
selected by default.

Use parent group — Select a parent group from the list.

Use this group or destination — Use the Browse button to select a destination group or a specific destination.

Fiery device settings tab (Destination Configuration)
Use this tab to configure a fiery device destination.

Documents routed to this destination will be sent to the fiery server specified. You can access this tab when you create
or configure a fiery device destination.

You can configure a default value and a dynamic override for each option. Default values are used to manage the
documents as they are being sent to the destination. You can choose to dynamically override the default values using
document properties and functions.

• To insert document properties, right-click in the desired override box and click Insert Document Property.
A menu containing all of the available properties displays. You can select a property from the list or type the
property name. If a property is selected and it contains a value, that value is processed instead of the default value.

• To insert functions, right-click in the box, click Insert Function, and choose the appropriate function. Review the
Using Nuance Output Manager Functions help topic for information on configuring functions.
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Option Description

Fiery server Specifies the IP address or computer name for a Fiery se
rver.

Use default port Specifies if you want to use the default fiery port. Disabl
e this option if you want to enter a specific port number.

Port Specifies the fiery server's port number. The port numbe
r must be from 1 through 65536. The default value is 80
21.

Use service logon Specifies if you want to use the Windows credentials of t
he Nuance Output Manager Output service to logon. Thi
s option is disabled by default.

User name Specifies the user name that will be used when logging o
n to the fiery server.

Password Specifies the password that will be used when logging o
n to the fiery server.

Confirm password Confirms the password entered in the Password box.

Logical printer Specifies the logical printer on the fiery server that docu
ments will be sent to for printing.

Folder settings tab (Destination Configuration)
Use this tab to configure a network folder destination.

Documents routed to this destination will be saved in the folder specified. You can access this tab when you create or
configure a network folder destination.

You can configure a default value and a dynamic override for each option. Default values are used to manage the
documents as they are being sent to the destination. You can choose to dynamically override the default values using
document properties and functions.

• To insert document properties, right-click in the desired override box and click Insert Document Property.
A menu containing all of the available properties displays. You can select a property from the list or type the
property name. If a property is selected and it contains a value, that value is processed instead of the default value.

• To insert functions, right-click in the box, click Insert Function, and choose the appropriate function.

Folder settings

Folder — Specifies the path where documents will be sent. The default folder is C:\NSi Files\.

For the folder selected, you must configure the Nuance Output Manager Services logon account user name to have
Full Control Sharing permissions. Also verify the Administrators group has Full Control Security permissions. Right-
click the folder in Windows Explorer and click Sharing and Security to configure these options.

Subfolder — Specifies the subfolder path where documents will be sent. If no subfolder path is entered, documents
will be sent to the folder path.

Create folder — Automatically creates the specified folder and/or subfolder if it does not exist. This will apply for
default and dynamic values.
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File name — Specifies the file name the document will have when it is routed from Nuance Output Manager to its
disk destination.

The following are the restrictions for the file name:

• Base file name max = 255
• Base file name min = 1
• Extension length max = 253
• Extension length min = 0 (extension is not required)

Base length — Determines the maximum length of the file name. The default length is 40.

Extension length — Determines the maximum length of the file name extension. The default length is 3.

Allow spaces — Specifies how file names that contain spaces will be written, either with the spaces or replacing the
spaces with exclamation points (!). When selected and the file name contains spaces, the spaces will be preserved.
When this is not selected and the file name contains spaces, the spaces will be replaced with exclamation points. This
option is selected by default.

Delete exclamation — Specifies if exclamation points will be deleted from the file name.

Overwrite — Specifies how to handle duplicate file names. Selecting the check box will cause the new file to
overwrite the existing file. This choice might be useful if you receive a file with the same name every day and you do
not want a large number of files to accumulate on the disk. This choice saves you the work of manually deleting old
files.

If you clear the check box the new file will be saved with a new file name according to the options below.

Counter type — If a duplicate file name is encountered, a new file name is created using a counter. The counter can
be added to the file name In Base or In Extension.

Counter length — If a duplicate file name is encountered, this value determines the length of the numeric counter
that will be placed at the end of the file name base or extension. The default length is 3.

Separator — Specifies the character that separates the file name from the counter. The default character is #. The
following are invalid characters: \ / : * ? “ < > |.

Start with counter — Applies the counter to the first file. This option is selected by default. If the numeric counter is
specified as In Base, the counter will be used in the base of the file name. If the numeric counter is specified as the In
Extension, the counter will be used in the file name extension.

FTP settings tab (Destination Configuration)
Use this tab to configure an FTP destination.

Documents routed to an FTP destination will be sent to a specified FTP server. You can access this tab when you
create or configure an FTP destination.

You can configure a default value and a dynamic override for each option on this tab. Default values are used to
manage the documents as they are being sent to the destination. You can choose to dynamically override the default
values using document properties and functions.

• To insert document properties, right-click in the desired override box and click Insert Document Property.
A menu containing all of the available properties displays. You can select a property from the list or type the
property name. If a property is selected and it contains a value, that value is processed instead of the default value.

• To insert functions, right-click in the box, click Insert Function, and choose the appropriate function.
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Option Description

FTP server Specifies the FTP server, which can be an FTP or IP add
ress.

Port Specifies the host's port number. The port number must b
e from 1 through 65536. The default value is 21.

User name Specifies the user name that will be used when logging o
n to the host. If the host does not require a user name, yo
u can leave this box blank.

Password Specifies the user password that will be used when loggi
ng on to the host. If the host does not require a user pass
word, you can leave this box blank.

Confirm password Confirms the password entered in the Password box.

Target folder Specifies the location on the host where the files will be
placed. You must type the entire path of the folder or the
path relative to the FTP user home directory (for exampl
e, if your home directory is at \FTP\UserName, you c
an specify either \FTP\UserName\MyDestFiles o
r \MyDestFiles).

Use passive mode Determines if the host mode will be passive or active. Se
lecting the check box selects passive mode, where the cli
ent creates a session to receive data. Clearing the check b
ox will choose active mode, where the host creates a sep
arate or new session to transfer data in response to a requ
est from the client.

IPDS settings tab (Destination Configuration)
Use this tab to configure an IPDS destination.

Notice:  IPDS is not available for new sales.

The IPDS destination is actually a transform operation, where the input file is transformed to an IPDS data stream and
sent to an IPDS printer. You can access this tab when you create or configure an IPDS destination.

Warning:  You must have a transform package licensed for the necessary input formats and for IPDS output
to use IPDS destinations.

Option Description

IPDS configuration Click the Create button to create a new IPDS transform
configuration. If a configuration is already selected, an
Edit button displays. Creating or editing the configuratio
n displays the Configure Transform dialog box.

Printer name Displays the printers contained in the IPDS transform
package. The printers are defined in the IPD (IPDS) filter
profile on the Filter profiles tab. Multiple IPDS printers
and connections can be configured in the same profile.
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Option Description

You can configure a Default value and a Dynamic
override value. A default value are used to manage the
documents as they are being sent to the destination. You
can choose to dynamically override the default values
using document properties and functions.

• Dynamic override — Specifies a property or
function to define the server at run time:

• To insert a document property, right-click this box
and click Insert Document Property and select
a property from one of the submenus. When the
specified property contains a value, the value is
used instead of the default value.

• To insert a function, right-click in this box, click
Insert Function, and choose the function.

IPP settings tab (Destination Configuration)
Use this tab to configure an IPP (Internet Printing Protocol) destination.

Documents routed to this destination will be sent to the specified IPP connected printer. You can access this tab when
you create or configure an IPP destination.

You can configure a default value and a dynamic override for each option. Default values are used to manage the
documents as they are being sent to the destination. You can choose to dynamically override the default values using
document properties and functions.

To Do this

Insert document properties Right-click in the desired override box and click Insert
Document Property. This displays a menu containing a
ll of the available properties. You can select a property fr
om the list or type the property name. If a property is sel
ected and it contains a value, that value is processed inste
ad of the default value.

Insert functions Right-click in the box, click Insert Function, and choos
e the appropriate function.

IPP settings

Option Description

Printer URI Specifies the network address of the IPP printer (for exa
mple, http://server/printers/myprinter/p
rinter).

Job name Specifies the job name that will be associated with all do
cuments received by this destination. Normally, the defa
ult Dynamic override value will be used for the job nam
e.
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Option Description

User Specifies the user name (document owner) that will be as
sociated with all documents received by this destination.
Normally, the default Dynamic override value will be u
sed for the user name.

JDF/JMF settings tab (Destination Configuration)
Use this tab to configure an JDF/JMF job ticket settings.

Documents routed to this destination will be sent to the JDF/JMF ticket and data folders.

Option Description

JDF version Specifies the version of JDF used on your system.

Job submission method • Submit ticket and data via folders, without a queue
entry

• Submit MIME package with queue entry, ticket and
data

• Submit queue entry via folder with links to ticket and
data

• Submit queue entry via web with links to ticket and
data

• Submit queue entry via web with folders for tickets
and data

Ticket folder Specifies the ticket folder for the destination.

Data folder Specifies the data folder for the destination.

LPR settings tab (Destination Configuration)
Use this tab to configure an LPR destination.

Documents routed to this destination will be sent to the server and queue specified. You can access this tab when you
create or configure an LPR destination.

You can configure a default value and a dynamic override for each option. Default values are used to manage the
documents as they are being sent to the destination. You can choose to dynamically override the default values using
document properties and functions.

To Do this

Insert document properties Right-click in the desired override box, and click Insert
Document Property. This displays a menu listing all of
the available properties. You can select a property from t
he list or type the property name. If a property is selected
and it contains a value, that value is processed instead of
the default value.

Insert functions Right-click in the box, click Insert Function, and choos
e the appropriate function.
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LPR settings

Option Description

LPD server Specifies the IP address or equivalent host name of the pr
int server where documents will be sent.

Port Specifies the port number for this LPR server. The defau
lt value is 515.

Queue Specifies the name of the print queue on the LPD server.

Retry on timeout Specifies if you want to retry printing to this destination i
f a timeout occurs.

Banner Class (-C) Specifies the class name to be printed on the banner pag
e. To print the banner page, the -L command must be us
ed.

Banner Job Name (-J) Specifies the job name to be printed on the banner page.
To print the banner page, the -L command must be used.

Banner User (-L) Causes the banner page to be printed. The user name can
be omitted. The banner class (-C) and banner job name (
-J) commands must precede this command in the control
file to be effective.

Mail User (-M) Sends mail to the specified mailbox (example, mailbox@
hostname) upon completion of the print job.

User (-P) Specifies the user identification of the entity requesting t
he printing job. This must be included in the control file.

Title (-T) Provides a title for a file that is to be printed with the "p"
command code. It is ignored by all other printing comm
ands.

Print command Specifies the LPR print command. You can choose one o
f the following:

• CIF file (-Oc) — Plots the data file while treating the
data as a CIF (CalTech Intermediate Form) graphics
language.

• DVI file (-Od) — Prints the data file while treating
the data as a DVI (TeX output) file.

• Plain text (-Of) — Prints the data file as plain text,
providing page breaks as necessary. Some ASCII
control characters may be discarded. This is the
default configuration.

• Plot file (-Og) — Plots the data file while treating the
data as output from the Berkeley UNIX plot library.

• Literal (-Ol) — Prints the data file without filtering
the control characters.

• Pr (-Op) — Prints the data file with a heading, page
numbers, and pagination.
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Option Description

• FORTRAN/ASA (-Or) — Prints the data file
while interpreting the first column of each line as
FORTRAN carriage control. The command also
supports ASA.

• Verbatim (-Ov) — Sends the data file directly to the
printer without additional processing. The behavior
of the directive is dependent upon the printer that the
queue feeds.

Control file first Sends the control file before the data files. Once the cont
rol file has been received, the data files can be printed as
they arrive. This is the default configuration.

Send copies as separate transmissions Select this option to send documents to the destination m
ultiple times (based on the copy count property of the do
cument).

When printing a duplex document, select this option if
you want each document to print on its own sheets of
paper. If not selected, a duplexed document that has odd
number of pages will have its second copy’s first page
print on the back of the first copy’s last page.

When a printer is configured to use a separator page,
select this option to allow the separator page to be
inserted by the printer. If not selected, only the first copy
would have a separator page. A separator page would not
appear between each of the copies.

More settings tab (Destination Configuration)
Use this tab to configure common configuration options that available to all destination types.

You can access this tab in the Destination Configuration dialog box when you create or configure a destination.

Use advanced costing profile for reports

Advanced costing profiles define the costs associated with advanced document media and finishing options, such as
stapling and folding, for reporting purposes.

Use the list to select an existing failover profile.

New — Shows the New Advanced Costing Profile dialog box. You can create a profile and define the costs for a
specific option.

Edit — Shows the Edit Advanced Costing Profile dialog box for editing the profile selected in the drop-down list
box.

Manage — Shows the Manage Failover Profiles dialog box which lists all of the defined costing profiles. From this
dialog box you can create, import, and export profiles, as well as manage all existing profiles.
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Cost per page

Sets the printing cost per page for black and white and color documents. Use the spin boxes to select the printing cost.

If you want to bill less than 1 cent per page, you must change the Windows currency settings to display more than 2
decimal places. To do this, open Windows Control Panel and click Regional and Language. On the Formats tab,
click Additional Settings. Click the Currency tab and change the No. of digits after decimal option to either 3 or 4.

Include documents in Green Reports

Makes documents sent to the destination available for green reports. The documents appear in green reports once
Nuance Output Manager deletes them from the Retained tab.

Associated device

Selects the SNMP device that will be associated with the destination. This opens the Select Device dialog box.

This option is available for IPP, LPR, and socket destinations.

Warning:  Do not change the associated device for destinations that were created automatically.

Printer family

Printer families are used in Nuance Output Manager to configure commands for print languages and map them to
destinations based on their capabilities.

Use the list to select an existing printer family.

New — Displays the Printer Family Profile dialog box for creating a printer family.

Edit — Displays the selected printer family properties for modification.

Manage — Displays the Manage Printer Family Profiles dialog box which lists all of the defined printer families.
From this dialog box you can create, import, and export printer families, as well as manage all existing printer
families.

Destination specific capabilities — Specifies which print preferences/document properties are supported by the
destination. You can also select the settings that are allowed for a particular property. These settings determine what is
available to the user in the dialogs where properties are configured for this destination. Click Configure to display the
Destination Capabilities dialog box.

Warning:  To apply print preferences, you must create an output process to apply the print preferences to the
destination.

Output process

Output processes can be created to impact documents as they are being sent to a destination. The processes contain a
set of actions which could be used for search and replace, setting finishing options, editing PJL commands, inserting
overlays, and so on.

Use the list to select an existing output process.

New — Displays the Process Designer window for creating a new output process. The visual flowchart style designer
makes it easy and intuitive to create complex, powerful processes.

Edit — Displays the selected output process properties for modification.
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Manage — Displays the Manage Output Process Profiles dialog box which lists all of the defined output processes.
From this dialog box you can create, import, and export processes, as well as manage all existing processes.

Override output process assigned to document — Determines if the selected output process will be used when an
output process is assigned to the document.

Failover profile

Failover profiles specify what should happen to documents when they are sent to inaccessible destinations (they aren’t
able to receive documents).

Use the list to select an existing failover profile.

New — Displays the Failover Profile dialog box for creating a new failover profile. You can determine what should
happen if all of the retries fail and when to place the document in an error state.

Edit — Displays the selected failover profile properties for modification.

Manage — Displays the Manage Failover Profiles dialog box which lists all of the defined failover profiles. From
this dialog box you can create, import, and export profiles, as well as manage all existing profiles.

Override failover profile assigned to document — Determines if the selected failover profile will be used when a
failover profile is assigned to the document.

OM settings tab (Destination Configuration)
Use this tab to configure an Nuance Output Manager destination.

Documents routed to this destination will be sent a specified the Nuance Output Manager server. You can access this
tab when you create or configure an Nuance Output Manager destination.

OM server

Enter the Nuance Output Manager server that will receive all documents sent to this destination.

You can configure a default value and a dynamic override value for the setting on this tab. The dynamic override
allows you to specify a document property or a function that returns a value at run time.

• Default value — Enter an IP address or server name for the Nuance Output Manager server that will receive all
documents sent to this destination.

• Dynamic override — Specifies a property or function to define the server at run time:

• To insert a document property, right-click this box and click Insert Document Property and select a property
from one of the submenus. When the specified property contains a value, the value is used instead of the
default value.

• To insert a function, right-click in this box, click Insert Function, and choose the function.

PRISMAProduction settings tab (Destination Configuration)
Use settings on this tab to configure a PRISMAProduction destination for an Océ PRISMAproduction server.

Documents routed to this destination will be sent to the specified server. You can access this tab when you create or
configure a PRISMAProduction destination.

You can configure a default value and a dynamic override value for all of the settings on this tab. The dynamic
override allows you to specify a document property or a function that returns a value at run time.
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Option Description

Server Specifies the Océ PRISMAproduction server where docu
ments will be sent.

• Default value — Enter the IP address for the server.
• Dynamic override — Specifies a property or

function to define the server at run time:

• To insert a document property, right-click this box
and click Insert Document Property and select
a property from one of the submenus. When the
specified property contains a value, the value is
used instead of the default value.

• To insert a function, right-click in this box, click
Insert Function, and choose the function.

User name Specifies the user name that is associated with the docum
ents.

• Default value — Enter a user name.
• Dynamic override — Specifies a property or

function to define the user name at run time:

• To insert a document property, right-click this box
and click Insert Document Property and select
a property from one of the submenus. When the
specified property contains a value, the value is
used instead of the default value.

• To insert a function, right-click in this box, click
Insert Function, and choose the function.

Job queue Specifies the name of the job queue where documents w
ill be routed.

• Default value — Enter a job queue name.
• Dynamic override — Specifies a property or

function to define the job queue at run time:

• To insert a document property, right-click this box
and click Insert Document Property and select
a property from one of the submenus. When the
specified property contains a value, the value is
used instead of the default value.

• To insert a function, right-click in this box, click
Insert Function, and choose the function.

SharePoint device settings tab (Destination Configuration)
Use this tab to create or configure a SharePoint destination.

Documents routed to this destination will be sent to the SharePoint site specified.
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Option Description

SharePoint site Specifies the web address of the target SharePoint site (f
or example, http://www.nuanceautostore.com/samplesite
/).

Use service logon Select this check box to use the Windows credentials of t
he Nuance Output Manager Output service to log on. Thi
s option is disabled by default.

User name Specifies a user name to be used when logging on to the
SharePoint site.

Password Specifies the password that is associated with User
name.

Confirm password Confirms the password entered in the Password box.

SharePoint 2010 or newer Select this check box if you are using SharePoint 2010 or
newer. If selected, Nuance Output Manager will use the
SharePoint 2010 Client interface to communicate with
the SharePoint site. If not, Nuance Output Manager will
use the SharePoint Copy Web service (Copy.asmx)
that is supported by all versions of SharePoint.

You can configure a default value and a dynamic
override for each of the following options. Default
values are used to manage the documents as they
are being sent to the destination. You can choose to
dynamically override the default values using document
properties and functions.

• To insert document properties, right-click in the
desired override box and click Insert Document
Property. A menu containing all of the available
properties displays. You can select a property from
the list or type the property name. If a property
is selected and it contains a value, that value is
processed instead of the default value.

• To insert functions, right-click in the box, click
Insert Function, and choose the appropriate
function. Review the Using Nuance Output Manager
Functions help topic for information on configuring
functions.

Library Specifies the name of the library in the SharePoint site w
here the files should be stored.

Folder Specifies the name of the subfolder in the Library, wher
e the files should be stored. If a folder is not specified, th
e files will be placed in the root folder of the Library. T
his field is optional.
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Option Description

Document name Specifies the name to use when naming the document on
the SharePoint site. To pass the Nuance Output Manager
name through, use [Document Name].

Overwrite Select this check box to overwrite a document if a docum
ent with the same name is found. If a document of the sa
me name already exists at that location, and you choose
not to overwrite, the new document will not be written t
o the site.

Check-in Select this check box to mark the file as Checked In on t
he SharePoint site. If you clear this check box, a docume
nt remains checked out by the user specified in the User
name field above.

SharePoint fields Click this button to specify values to put in SharePoint fi
elds or to map Nuance Output Manager fields to the Sha
rePoint fields.

SharePoint libraries have various fields or columns to
describe the files stored in them. They can also have
custom fields to provide further descriptive information.
Some of these fields can be modified by the user.

Socket settings tab (Destination Configuration)
Use this tab to configure a socket destination.

Documents routed to this destination will be sent to the IP address and port specified. You can access this tab when
you create or configure a socket destination.

Socket settings

You can configure a default value and a dynamic override for each option. Default values are used to manage the
documents as they are being sent to the destination. You can choose to dynamically override the default values using
document properties and functions.

• To insert document properties, right-click in the desired override box and click Insert Document Property.
A menu containing all of the available properties displays. You can select a property from the list or type the
property name. If a property is selected and it contains a value, that value is processed instead of the default value.

• To insert functions, right-click in the box, click Insert Function, and choose the appropriate function. Review the
Using Nuance Output Manager Functions help topic for information on configuring functions.

IP address — Specifies the IP address or equivalent host name of the print server where the documents will be sent.

Port — Specifies the number that enables IP packets to be sent to a particular process on a computer. The default
number is 9100.

Retry on timeout — Specifies if you want to retry printing to this destination if a timeout occurs.

Send copies as separate transmissions — Select this option to send documents to the destination multiple times
(based on the copy count property of the document).



Output Manager Administration Guide
Version 4.0 SP2

512 © 2016 Nuance Communications, Inc. All rights reserved.

When printing a duplex document, select this option if you want each document to print on its own sheets of paper.
If not selected, a duplexed document that has odd number of pages will have its second copy’s first page print on the
back of the first copy’s last page.

When a printer is configured to use a separator page, select this option to allow the separator page to be inserted
by the printer. If not selected, only the first copy would have a separator page. A separator page would not appear
between each of the copies.

WebSphere MQ settings tab (Destination)
Use this tab to configure a WebSphere MQ destination.

WebSphere MQ is a message queuing system designed by IBM that runs on many platforms such as Windows, Unix,
Linux, and z/OS. Nuance Output Manager provides an interface into that queuing system. Nuance Output Manager
can then communicate (send and receive messages) with other applications using WebSphere MQ.

Documents routed to this destination will be sent as WebSphere MQ messages. You can access this tab when you
create or configure a WebSphere MQ destination.

Important:  To use this destination, you must install a WebSphere MQ client separately.

WebSphere MQ settings

You can configure a default value and a dynamic override for each option. Default values are used to manage the
documents as they are being sent to the destination. You can choose to dynamically override the default values using
document properties and functions.

• To insert document properties, right-click in the desired override box and click Insert Document Property.
A menu containing all of the available properties displays. You can select a property from the list or type the
property name. If a property is selected and it contains a value, that value is processed instead of the default value.

• To insert functions, right-click in the box, click Insert Function, and choose the appropriate function. Review the
Using Nuance Output Manager Functions help topic for information on configuring functions.

Queue manager — Specifies the name of the queue manager. This must match the queue manager specified in
WebSphere MQ. The queue manager administers the queues that have been created on it (these are known as local
queues).

Queue name — Specifies the queue name where messages sent to this destination will be stored. This must match
the queue name specified in WebSphere MQ. The queue name along with the name of its queue manager, provides a
unique address where messages can be sent.

Channel name — Each WebSphere MQ queue manager has different types of connectivity options. Since Nuance
Output Manager uses TCPIP for the channel connection, you must specify the channel configured for TCPIP. You can
get this name from the WebSphere MQ list of channels.

Warning:  Make sure the SSL certificate required option is not selected in WebSphere MQ. Nuance Output
Manager does not support this at this time.

Connection name — Specifies the connection name. The connection name is the IP address and (port) or DNS name
for the server to which you are attempting to connect. Messages are transferred over the connection and placed in the
queue.



Output Manager Administration Guide
Version 4.0 SP2

513 © 2016 Nuance Communications, Inc. All rights reserved.

Windows queue settings tab (Destination Configuration)
Use this tab to configure a Windows queue destination.

Documents routed to this destination will be sent to the print server and queue specified. You can access this tab when
you create or configure a Windows queue destination.

Option Description

Print server Specifies the print server where documents will be sent.

Print queue Specifies the name of the print queue.

Destination Configuration (bulk settings) dialog box
Use bulk destination settings to simultaneously configure multiple devices with the same destination settings.

The bulk destination settings are displayed on tabs in the Destination Configuration dialog box when you specify to
add more than one device in the Add Destination dialog box. Bulk destination settings allow you to simultaneously
configure the same values for settings for multiple devices.

General tabs

The following tabs provide general settings for any type of destination.

Tab Description

General tab (Destination Bulk Configuration) on page
521

Use settings on this tab to configure general destination
information when creating multiple destinations.

More settings tab (Destination Bulk Configuration) on
page 525

Configure common configuration options that available
to all destination types.

Error Handling tab (Bulk Configuration) on page 516 Use this tab to configure error handling options that
available to all destination types.

Buttons

Button Description

Select all Selects all of the destinations listed in the grid.

Unselect all Clears any selected destinations in the grid.

Add Adds a destination to the grid. A new row will appear at t
he bottom of the grid.

Copy Creates a copy of the destination selected in the grid. A n
ew row will appear at the bottom of the grid.

Remove Deletes the selected destination.

Series Fill Fills multiple selected fields in a column with the
specified text and counter. This option is useful when
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Button Description

you have several destinations using similar naming
conventions (such as name, folder, and location).

To create a series fill, select the rows you want to
automatically fill, and then click inside one of the cells
that you are editing. Click Series Fill and enter the text
and configure the counter in the Series Fill dialog box.
The series will start with the first selected row.

Configure device Click this button to open the Device Configuration dialo
g box to configure a selected device.

Source specific tabs

The following tabs provide settings for specific types of sources.

Icon Source Description

Email settings tab (Destination Bulk
Configuration) on page 515

Use settings on this tab to
simultaneously create multiple
email. Documents routed to these
destinations will be sent to the email
addresses specified.

Fiery Device settings tab (Bulk
Configuration) on page 517

Use this tab to simultaneously
configure multiple fiery device
destinations.

Folder settings tab (Destination Bulk
Configuration) on page 518

Configure settings on this tab to
simultaneously create multiple
network folder destinations.
Documents routed to this destination
will be saved in the folder specified.

FTP settings tab (Destination Bulk
Configuration) on page 520

Use this tab to create multiple FTP
destinations at once. Documents
routed to this destination will be sent
to the FTP servers specified.

IPP settings tab (Destination Bulk
Configuration) on page 521

Configure settings on this tab to
simultaneously create multiple
IPP (Internet Printing Protocol)
destinations. Documents routed to
this destination will be sent to the
specified IPP connected printer.

JDF/JMF settings tab (Destination
Bulk Configuration) on page 522

Use this tab to configure bulk
destination settings for JDF/JMF job
ticket settings.

LPR settings tab (Destination Bulk
Configuration) on page 523

Use this tab to create multiple LPR
destinations at once. Documents
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Icon Source Description

routed to this destination will be sent
to the server and queue specified.

OM Settings tab (Destination Bulk
Configuration) on page 526

Use this tab to configure multiple
Nuance Output Manager destinations
at once.

PRISMAProduction settings tab
(Destination Bulk Configuration) on
page 526

Use this tab to configure multiple
PRISMAProduction destinations at
once.

Socket settings tab (Destination Bulk
Configuration) on page 527

Configure settings on this tab to
create simultaneously multiple socket
destinations. Documents routed to
these destinations will be sent to the
IP address and port specified.

WebSphere MQ settings tab
(Destination Bulk Configuration) on
page 527

Use settings on this tab to
simultaneously create multiple
WebSphere MQ destinations.
Documents routed to these
destinations will be sent as
WebSphere MQ messages.

Windows Queue settings tab
(Destination Bulk Configuration) on
page 528

Use settings on this tab to create
multiple Windows queue destinations
at once. Documents routed to these
destinations will be sent to the print
server and queue specified.

Email settings tab (Destination Bulk Configuration)
Use settings on this tab to simultaneously create multiple email. Documents routed to these destinations will be sent to
the email addresses specified.

Click on cells in the table to configure a destination.

You can configure a default value and a dynamic override for most options. Default values are used to manage the
documents as they are being sent to the destination. You can choose to dynamically override the default values using
document properties and functions.

• To insert document properties, right-click in the desired override box and click Insert Document Property.
A menu containing all of the available properties displays. You can select a property from the list or type the
property name. If a property is selected and it contains a value, that value is processed instead of the default value.

• To insert functions, right-click in the box, click Insert Function, and choose the appropriate function. Review the
Using OM functions help topic for information on configuring functions.

Column Description

Name column Specifies the name of the email destination.

Email profile Selects the email profile that will be used with this rule.
You can select a profile from the list or click the Browse
button and mange profiles from the Manage Outbound
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Column Description

Email Profiles. From this dialog box you can create and
modify email profiles.

To Specifies the email address that will receive all documen
ts sent to this destination. You can enter multiple email a
ddresses separated by a comma.

CC Specifies the email address that will be copied on this m
essage. You can enter multiple email addresses separated
by a comma.

BCC Specifies the email address that will be blind copied on t
his message. You can enter multiple email addresses sep
arated by a comma

From Specifies the email address that will be shown as the sen
der of all documents sent to this destination.

Reply to Specifies the email address where replies will be routed.
You can enter multiple email addresses separated by a c
omma.

Subject Specifies the email message subject that will display for
all documents sent to this destination.

Body Specifies the text that will display in the email message f
or all documents sent to this destination.

Error Handling tab (Bulk Configuration)
Use this tab to configure error handling options that available to all destination types.

You can access this tab when you create multiple destinations simultaneously.

Click in the table cells to configure values for a destination.

Column Description

Name Specifies the name of the destination.

Error Handling Profile Specifies the error handling profile. Error handling profil
es specify what should happen to destinations when an e
rror is detected via SNMP or during transmission of a do
cument.  You can select an error handling profile from t
he list or click the Browse button to create or manage pr
ofiles from the Manage Error Handling Profiles dialo
g box.

Default Failover Destination Type Specifies the type of failover to use for the destination. F
ailover specifies what should happen to documents when
they are sent to inaccessible destinations (they are not ab
le to receive documents). You can choose to route the do
cuments to a destination group or specific destination. T
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Column Description

he parent group where the destination currently resides i
s selected by default.

Default Failover - Parent Specifies failover documents will be routed to a parent gr
oup. Select a group in the list.

Default Failover - Specific Specifies failover documents will be routed to a specific
destination or destination group. Use the Browse button t
o select a destination or group.

Set Ready Documents to Hold On Startup

Fiery Device settings tab (Bulk Configuration)
Use this tab to simultaneously configure multiple fiery device destinations.

Documents routed to this destination will be sent to the fiery server specified. You can access this tab when you create
or configure multiple fiery device destinations.

You can configure a default value and a dynamic override for most options. Default values are used to manage the
documents as they are being sent to the destination. You can choose to dynamically override the default values using
document properties and functions.

To Do this

Insert document properties Right-click in the desired override box and click Insert
Document Property. This displays a menu containing a
ll of the available properties. You can select a property fr
om the list or type the property name. If a property is sel
ected and it contains a value, that value is processed inste
ad of the default value.

Insert functions Right-click in the box, click Insert Function, and cho
ose the appropriate function. Review the Using Nuance
Output Manager Functions help topic for information on
configuring functions.

Click in columns to configure values for a destination.

Column Description

Name Specifies the name of the fiery device destination.

Fiery Server Specifies the fiery server, which can be a server name or
IP address.

Use Default Port Select the Default check box to use the default port. Dis
able this option to configure the port settings. When this
check box is cleared, you can enter a document property
or function that returns a true or false value (1/0 or True/
False).
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Column Description

Port Specifies the fiery server's port number. The port numbe
r must be from 1 through 65536. The default value is 80
21.

Use Service Logon column Specifies if you want to use the Windows credentials of t
he Nuance Output Manager Output service to logon. Thi
s option is disabled by default.

User name column Specifies the user name that will be used when logging o
n to the fiery server.

Password column Specifies the password that will be used when logging o
n to the fiery server.

Confirm Password column Confirms the password entered in the Password column.

Logical Printer column Specifies the logical printer on the fiery server that docu
ments will be sent to for printing.

Folder settings tab (Destination Bulk Configuration)
Configure settings on this tab to simultaneously create multiple network folder destinations. Documents routed to this
destination will be saved in the folder specified.

You can configure a default value and a dynamic override for most options. Default values are used to manage the
documents as they are being sent to the destination. You can choose to dynamically override the default values using
document properties and functions.

To Do this

Insert document properties Right-click in the desired override box and click Insert
Document Property. This displays a menu containing a
ll of the available properties. You can select a property fr
om the list or type the property name. If a property is sel
ected and it contains a value, that value is processed inste
ad of the default value.

Insert functions Right-click in the box, click Insert Function, and cho
ose the appropriate function. Review the Using Nuance
Output Manager Functions help topic for information on
configuring functions.

Click in table cells to configure values for a destination.

Column Description

Name column Specifies the name of the network folder destination.

Folder column Specifies the path where documents will be sent. The de
fault folder is C:\NSi Files\. Click the browse butt
on (...) to select a folder. For the folder selected, you mu
st configure the Nuance Output Manager Services logon
account user name to have Full Control Sharing permissi
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Column Description

ons. Also verify the Administrators group has Full Contr
ol Security permissions. Right-click the folder in Windo
ws Explorer and click Sharing and Security to configur
e these options.

Subfolder column Specifies the subfolder path where documents will be se
nt. If no subfolder path is entered, documents will be sen
t to the folder path.

Create folder Automatically creates the specified folder and/or subfold
er if it does not exist. This will apply for default and dyn
amic values.

File Name column Specifies the file name the document will have when it i
s routed from Nuance Output Manager to its disk destina
tion.

Base Length column Determines the maximum length of the file name. The de
fault length is 40.

Extension Length column Determines the maximum length of the file name extensi
on. The default length is 3.

Allow Spaces column Specifies how file names that contain spaces will be writ
ten, either with the spaces or replacing the spaces with e
xclamation points (!). When selected and the file name c
ontains spaces, the spaces will be preserved. When this i
s not selected and the file name contains spaces, the spac
es will be replaced with exclamation points. This option i
s selected by default.

Delete Exclamation column Specifies if exclamation points will be deleted from the f
ile name.

Overwrite column Specifies how to handle duplicate file names. Selecting t
he check box will cause the new file to overwrite the exi
sting file. This choice might be useful if you receive a fil
e with the same name every day and you do not want a la
rge number of files to accumulate on the disk. This choic
e saves you the work of manually deleting old files. If yo
u clear the check box the new file will be saved with a ne
w file name according to the options below.

Counter Type column If a duplicate file name is encountered, a new file name i
s created using a counter. The counter can be added to th
e file name base or extension.

Counter Length column If a duplicate file name is encountered, this value determ
ines the length of the numeric counter that will be placed
at the end of the file name base or extension. The defaul
t length is 3.
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Column Description

Separator column Specifies the character that separates the file name from t
he counter. The default character is #. The following are
invalid characters: \ / : * ? “ < > |.

Start With Counter column Applies the counter to the first file. If the numeric count
er is specified as the base, the counter will be used in the
base of the file name. If the numeric counter is specified
as the extension, the counter will be used in the file nam
e extension.

FTP settings tab (Destination Bulk Configuration)
Use this tab to create multiple FTP destinations at once. Documents routed to this destination will be sent to the FTP
servers specified.

You can configure a default value and a dynamic override for most options. Default values are used to manage the
documents as they are being sent to the destination. You can choose to dynamically override the default values using
document properties and functions.

To Do this

Insert document properties Right-click in the desired override box, and click Insert
Document Property. This displays a menu containing a
ll of the available properties. You can select a property fr
om the list or type the property name. If a property is sel
ected and it contains a value, that value is processed inste
ad of the default value.

Insert functions Right-click in the box, click Insert Function, and cho
ose the appropriate function. Review the Using Nuance
Output Manager Functions help topic for information on
configuring functions.

Click directly in table cells to configure values for a destination.

Column Description

Name Specifies the name of the FTP destination.

FTP Server Specifies the FTP server, which can be an FTP or IP add
ress.

Port Specifies the host's port number. The port number must b
e from 1 through 65536. The default value is 21.

User Name Specifies the user name that will be used when logging o
n to the host. If the host does not require a user name, yo
u can leave this cell blank.

Password Specifies the user password that will be used when loggi
ng on to the host. If the host does not require a user pass
word, you can leave this cell blank.
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Column Description

Target Folder Specifies the location on the host where the files will be
placed. You must type the entire path of the folder or the
path relative to the FTP user home directory (for exampl
e, if your home directory is at \FTP\UserName, you c
an specify either \FTP\UserName\MyDestFiles o
r \MyDestFiles).

Use Passive Mode Determines if the host mode will be passive or active. Se
lecting the check box selects passive mode, where the cli
ent creates a session to receive data. Clearing the check b
ox will choose active mode, where the host creates a sep
arate or new session to transfer data in response to a requ
est from the client.

General tab (Destination Bulk Configuration)
Use settings on this tab to configure general destination information when creating multiple destinations.

Click in table cells to configure values for a destination.

Column Description

Name Specifies the name of the destination.

Server Specifies the Nuance Output Manager server where the
Nuance Output Manager Output Service is located for th
is destination.

Location Specifies any specific location information for the destin
ation.

Comments Lists any general comments about the destination.

IPP settings tab (Destination Bulk Configuration)
Configure settings on this tab to simultaneously create multiple IPP (Internet Printing Protocol) destinations.
Documents routed to this destination will be sent to the specified IPP connected printer.

You can configure a default value and a dynamic override for most options. Default values are used to manage the
documents as they are being sent to the destination. You can choose to dynamically override the default values using
document properties and functions.

To Do this

Insert document properties Right-click in the desired override box and click Insert
Document Property. A menu containing all of the avail
able properties displays. You can select a property from t
he list or type the property name. If a property is selected
and it contains a value, that value is processed instead of
the default value.

Insert functions Right-click in the box, click Insert Function, and cho
ose the appropriate function. Review the Using Nuance
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To Do this

Output Manager Functions help topic for information on
configuring functions.

Click in table cells to configure vales for a destination.

Column Description

Name column Specifies the name of the IPP destination.

Printer URI column Specifies the network address of the IPP printer (for exa
mple, http://server/printers/myprinter/p
rinter).

Job Name column Specifies the job name that will be associated with all do
cuments received by this destination. Normally, the defa
ult Dynamic value will be used for the job name.

User column Specifies the user name (document owner) that will be a
ssociated with all documents received by this destination
. Normally, the default Dynamic value will be used for t
he user name.

JDF/JMF settings tab (Destination Bulk Configuration)
Use this tab to configure bulk destination settings for JDF/JMF job ticket settings.

Documents routed to this destination will be sent to the JDF/JMF ticket and data folders.

Click on table cells to edit values for a destination.

Column Description

JDF version Specifies the version of JDF used on your system.

Job submission method • Submit ticket and data via folders, without a queue
entry

• Submit MIME package with queue entry, ticket and
data

• Submit queue entry via folder with links to ticket and
data

• Submit queue entry via web with links to ticket and
data

• Submit queue entry via web with folders for tickets
and data

URL

Ticket folder Specifies the ticket folder for the destination.

Data folder Specifies the data folder for the destination.
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LPR settings tab (Destination Bulk Configuration)
Use this tab to create multiple LPR destinations at once. Documents routed to this destination will be sent to the
server and queue specified.

You can configure a default value and a dynamic override for most options. Default values are used to manage the
documents as they are being sent to the destination. You can choose to dynamically override the default values using
document properties and functions.

To Do this

Insert document properties Right-click in the desired override box, and click Insert
Document Property. This displays a menu listing all of
the available properties. You can select a property from t
he list or type the property name. If a property is selected
and it contains a value, that value is processed instead of
the default value.

Insert functions Right-click in the box, click Insert Function, and cho
ose the appropriate function. Review the Using Nuance
Output Manager Functions help topic for information on
configuring functions.

Click in table cells to configure values for a destination.

Column Description

Name Specifies the name of the LPR destination.

Print Command Specifies the LPR print command. You can choose one o
f the following.

• CIF file (-Oc) — Plots the data file while treating the
data as a CIF (CalTech Intermediate Form) graphics
language.

• DVI file (-Od) — Prints the data file while treating
the data as a DVI (TeX output) file.

• Plain text (-Of) — Prints the data file as plain text,
providing page breaks as necessary. Some ASCII
control characters may be discarded. This is the
default configuration.

• Plot file (-Og) — Plots the data file while treating the
data as output from the Berkeley UNIX plot library.

• Literal (-Ol) — Prints the data file without filtering
the control characters.

• Pr (-Op) — Prints the data file with a heading, page
numbers, and pagination.

• FORTRAN/ASA (-Or) — Prints the data file
while interpreting the first column of each line as
FORTRAN carriage control. The command also
supports ASA.

• Verbatim (-Ov) — Sends the data file directly to the
printer without additional processing. The behavior
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Column Description

of the directive is dependent upon the printer that the
queue feeds.

Send copies as separate transmissions Select this option to send documents to the destination m
ultiple times (based on the copy count property of the do
cument).

When printing a duplex document, select this option if
you want each document to print on its own sheets of
paper. If not selected, a duplexed document that has odd
number of pages will have the first page of its second
copy print on the back of the last page of its first copy.

When a printer is configured to use a separator page,
select this option to allow the separator page to be
inserted by the printer. If not selected, only the first copy
would have a separator page. A separator page would not
appear between each of the copies.

Control File First Sends the control file before the data files. Once the cont
rol file has been received, the data files can be printed as
they arrive. This is the default configuration.

Server Specifies the IP address or equivalent host name of the pr
int server where documents will be sent.

Port Specifies the port number for this LPR server. The defau
lt value is 515.

Queue Specifies the name of the print queue on the LPD server.

Retry On Timeout Specifies if you want to retry printing to this destination i
f a timeout occurs.

Banner Class (-C) Specifies the class name to be printed on the banner pag
e. To print the banner page, the -L command must be us
ed.

Banner Job Name (-J) Specifies the job name to be printed on the banner page.
To print the banner page, the -L command must be used.

Banner User (-L) Causes the banner page to be printed. The user name can
be omitted. The banner class (-C) and banner job name (
-J) commands must precede this command in the control
file to be effective.

Mail User (-M) Sends mail to the specified mailbox (example, mailbox@
hostname) upon completion of the print job.

User (-P) Specifies the user identification of the entity requesting t
he printing job. This must be included in the control file.
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Column Description

Title (-T) Provides a title for a file that is to be printed with the "p"
command code. It is ignored by all other printing comm
ands.

More settings tab (Destination Bulk Configuration)
Configure common configuration options that available to all destination types.

You can access this tab when you simultaneously configure multiple destinations.

Click in table cells to configure values for a destination.

• Name column — Specifies the name of the destination.
• Use advanced costing — Determines if Nuance Output Manager applies advanced costing to the destination.

Examples of advanced costing include costs associated with stapling documents.
• Advanced Costing — Specifies the advanced costing profile that Nuance Output Manager applies to the

destination. Select a profile or create one from the Manage Advanced Costing Profiles dialog box.
• B&W Cost column — Specifies the printing cost per page for black and white documents.

If you want to bill less than 1 cent per page, change the Windows currency settings to display more than 2 decimal
places. To do this, open Control Panel and click Region and Language. On the Formats tab, click Additional
settings. Click the Currency tab and change the No. of digits after decimal option to either 3 or 4.

• Color Cost column — Specifies the printing cost per page for color documents.

If you want to bill less than 1 cent per page, change the Windows currency settings to display more than 2 decimal
places. To do this, open Control Panel and click Region and Language. On the Formats tab, click Additional
settings. Click the Currency tab and change the No. of digits after decimal option to either 3 or 4.

• Include Documents In Green Reports column — Specifies if documents sent to the destination are available
for green reports. The documents appear in green reports once Nuance Output Manager deletes them from the
Retained tab.

• Associated Device column — Selects the SNMP device that will be associated with the destination. This opens
the Select Device dialog box. This option is available for IPP, LPR, and socket destinations.

Warning:  Do not change the associated device for destinations that were created automatically.

• Printer Family column — Specifies the printer family profile to use. Printer families are used in Nuance Output
Manager to configure commands for print languages and map them to destinations based on their capabilities. You
can select a printer family profile from the list or click the browse button (...) to create or manage profiles from the
Manage Printer Family Profiles dialog box.

• Output Process column — Specifies if you want to use an output process. Output processes can be created to
impact documents as they are being sent to a destination. The processes contain a set of actions which could be
used for search and replace, setting finishing options, editing PJL commands, inserting overlays, and so on. You
can select an output process from the list or click the browse button (...) to create or manage profiles from the
Manage Output Process Profiles dialog box.

• Override Document Output Process column — Determines if the selected output process will be used when an
output process is assigned to the document.

• Failover Profile column — Specifies if you want to use a failover profile. Failover profiles specify what should
happen to documents when they are sent to inaccessible destinations (they are not able to receive documents).
You can select a failover profile from the list or click the browse button (...) to create or manage profiles from the
Manage Failover Profiles dialog box.
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• Override Document Failover Profile column — Determines if the selected failover profile will be used when a
failover profile is assigned to the document.

OM Settings tab (Destination Bulk Configuration)
Use this tab to configure multiple Nuance Output Manager destinations at once.

Documents routed to these destinations will be sent to the specified Nuance Output Manager server.

Column Description

Name Specifies the name of the Nuance Output Manager desti
nation.

Server Specifies the Nuance Output Manager server that will rec
eive all documents sent to this destination. You can confi
gure a default value and a dynamic override value for thi
s option. The Default value is used to manage the docum
ents as they are being sent to the destination. You can ch
oose to dynamically override the default value using doc
ument properties and functions.

• To enter an dynamic override value, right-click in the
Dynamic cell and click Insert Document Property.
This displays a menu containing all of the available
properties. You can select a property from the list or
type the property name. If a property is selected and
it contains a value, that value is processed instead of
the default value.

• To insert functions, right-click in the Dynamic cell,
click Insert Function, and choose the appropriate
function. Review the Using Nuance Output Manager
Functions help topic for information on configuring
functions.

PRISMAProduction settings tab (Destination Bulk Configuration)
Use this tab to configure multiple PRISMAProduction destinations at once.

These destinations are configured for the Océ PRISMAproduction server. Documents routed to these destinations will
be sent to the servers specified.

You can configure a default value and a dynamic override for most options. Default values are used to manage the
documents as they are being sent to the destination. You can choose to dynamically override the default values using
document properties and functions.

• To insert document properties, right-click in the desired override box and click Insert Document Property.
A menu containing all of the available properties displays. You can select a property from the list or type the
property name. If a property is selected and it contains a value, that value is processed instead of the default value.

• To insert functions, right-click in the box, click Insert Function, and choose the appropriate function. Review the
Using Nuance Output Manager Functions help topic for information on configuring functions.

Click in table cells to configure values for a destination.
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Column Description

Name Specifies the name of the PRISMAProduction destinatio
n.

Server Specifies the Océ PRISMAproduction server where docu
ments will be sent.

User name Specifies the user name that is associated with the docum
ents.

Socket settings tab (Destination Bulk Configuration)
Configure settings on this tab to create simultaneously multiple socket destinations. Documents routed to these
destinations will be sent to the IP address and port specified.

You can configure a default value and a dynamic override for most options. Default values are used to manage the
documents as they are being sent to the destination. You can choose to dynamically override the default values using
document properties and functions.

• To insert document properties, right-click in the desired override box and click Insert Document Property.
A menu containing all of the available properties displays. You can select a property from the list or type the
property name. If a property is selected and it contains a value, that value is processed instead of the default value.

• To insert functions, right-click in the box, click Insert Function, and choose the appropriate function. Review the
Using Nuance Output Manager Functions help topic for information on configuring functions.

Click in table cells to configure values for a destination.

• Name column — Specifies the name of the socket destination.
• Send copies as separate transmissions — Select this option to send documents to the destination multiple times

(based on the copy count property of the document).

When printing a duplex document, select this option if you want each document to print on its own sheets of paper.
If not selected, a duplexed document that has odd number of pages will have its second copy’s first page print on the
back of the first copy’s last page.

When a printer is configured to use a separator page, select this option to allow the separator page to be inserted
by the printer. If not selected, only the first copy would have a separator page. A separator page would not appear
between each of the copies.

• IP Address column — Specifies the IP address or equivalent host name of the print server where the documents
will be sent.

• Port column — Specifies the number that enables IP packets to be sent to a particular process on a computer. The
default number is 9100.

• Retry On Timeout column — Specifies if you want to retry printing to a destination if a timeout occurs.

WebSphere MQ settings tab (Destination Bulk Configuration)
Use settings on this tab to simultaneously create multiple WebSphere MQ destinations. Documents routed to these
destinations will be sent as WebSphere MQ messages.

WebSphere MQ is a message queuing system designed by IBM that runs on many platforms such as Windows, Unix,
Linux, and z/OS. Nuance Output Manager provides an interface into that queuing system. Nuance Output Manager
can then communicate (send and receive messages) with other applications using WebSphere MQ.

Important:  To use this destination, you must install a WebSphere MQ client separately.
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You can configure a default value and a dynamic override for most options. Default values are used to manage the
documents as they are being sent to the destination. You can choose to dynamically override the default values using
document properties and functions.

• To insert document properties, right-click in the desired override box and click Insert Document Property.
A menu containing all of the available properties displays. You can select a property from the list or type the
property name. If a property is selected and it contains a value, that value is processed instead of the default value.

• To insert functions, right-click in the box, click Insert Function, and choose the appropriate function. Review the
Using Nuance Output Manager Functions help topic for information on configuring functions.

Click in table cells to configure values for a destination.

• Name column — Specifies the name of the WebSphere MQ destination.
• Queue manager column — Specifies the name of the queue manager. This must match the queue manager

specified in WebSphere MQ. The queue manager administers the queues that have been created on it (these are
known as local queues).

• Queue name column — Specifies the queue name where messages sent to this destination will be stored. This
must match the queue name specified in WebSphere MQ. The queue name along with the name of its queue
manager, provides a unique address where messages can be sent.

• Channel name column — Each WebSphere MQ queue manager has different types of connectivity options. Since
Nuance Output Manager uses TCPIP for the channel connection, you must specify the channel configured for
TCPIP. You can get this name from the WebSphere MQ list of channels.

Note:  Make sure the SSL certificate required option is not selected in WebSphere MQ. Nuance Output
Manager does not support this at this time.

• Connection name column — Specifies the connection name. The connection name is the IP address and (port) or
DNS name for the server to which you are attempting to connect. Messages are transferred over the connection
and placed in the queue.

Windows Queue settings tab (Destination Bulk Configuration)
Use settings on this tab to create multiple Windows queue destinations at once. Documents routed to these
destinations will be sent to the print server and queue specified.

You can configure a default value and a dynamic override for most options. Default values are used to manage the
documents as they are being sent to the destination. You can choose to dynamically override the default values using
document properties and functions.

• To insert document properties, right-click in the desired override box and click Insert Document Property.
A menu containing all of the available properties displays. You can select a property from the list or type the
property name. If a property is selected and it contains a value, that value is processed instead of the default value.

• To insert functions, right-click in the box, click Insert Function, and choose the appropriate function. Review the
Using Nuance Output Manager Functions help topic for information on configuring functions.

Click in table cells to configure values for a destination.

Column Description

Name Specifies the name of the Windows queue destination.

Print Server Specifies the print server where documents will be sent.

Print Queue Specifies the name of the print queue.
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Destination/Device Output and SNMP Alert History window
Use the Destination/Device Output and SNMP Alert History window to view the following:

• From the Destinations application, the output history of destinations and folders
• From the Devices application,

• The output history of devices and folders
• The SNMP alert history of devices and folders

You can choose from one of the predefined history time frames or create a custom query. You can limit the data saved
in history in the Set General Preferences Utility.

Tree

Displays all destinations and destination folders or devices and devices folders. Selecting a destination/device or
folder will display the history in the grid according to the selected history time frame.

You can search the tree using the controls in the search panel below the tree. To search, type the text you want to find
and press Enter or click the Search button.

History time frame

Specifies the history time frame. You can select to view the output in the last hour, today, last 24 hours, last 7 days,
last 14 days, this month, this year, or create a custom query. Selecting custom query displays the query tool.

Grid

Displays the history for the selected destination/device or folder according to the time frame specified. The grid view
can display a maximum of 5000 records. If more than 5000 records exist, navigation images below the grid will
enable to allow paging through the records.

The following options are available below the grid:

• Search — Searches the grid columns. To search, type the text you want to find in the search box, click the column
in the grid you want to search, and then press Enter or click the Search button. If the text is found, your focus will
be moved to the first occurrence. New buttons will appear near the Search box that allow you to stop searching,
move to the previous occurrence, and move to the next occurrence.

• Print — Prints the output/alert history.
• Query — Displays the query tool for creating a custom query.
• Help — Displays help.
• Refresh Query — Updates the history data.
• Page navigation — Allows for paging through the records. You can select to view the first page, previous page,

next page, or last page.
• Records — Displays the number of records in the grid.

Detect Readers dialog box
Use this dialog box to search for any Ethernet Card Readers within an IP address range.



Output Manager Administration Guide
Version 4.0 SP2

530 © 2016 Nuance Communications, Inc. All rights reserved.

Start

Specifies the start of the IP address range. The search begins with this IP address.

End

Specifies the end of the IP address range. The search ends at this IP address.

Device Configuration dialog box
Use the device configuration dialog box to configure properties for a device.

Open this dialog box by right-clicking a device in the Devices application and then clicking Configure on the
shortcut menu.

Table 9: Dialog options

Option Description

Device name Shows the current network (DNS) name for the device. T
his is a read-only field.

Manufacture Shows the manufacture for the device. This is a read-onl
y field.

Model Shows the model for the device. This is a read-only field.

IP Address Specifies the IP address for the device.

DNS Name Specifies the DNS name for the device.

Serial number Specifies the serial number for the device.

Dialog tabs

Click in this table to view information about a tab.

Table 10: Tabs

Tab Description

SNMP Use options on this tab to configure updates Output
Manager destinations that are auto-detected SNMP
devices.

Device Details Use this tab to configure embedded client setting for a
device.

Kiosk This tab associates kiosks to a device.

Job Status This tab allows you to enable and configure options for
tracking jobs. Not displayed for Konica Minolta devices.
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SNMP tab (Device Configuration)
Use options on this tab to configure updates Output Manager destinations that are auto-detected SNMP devices.

You can determine whether the Output Manager SNMP Service will automatically update destinations that are auto-
detected SNMP devices. The service can update dynamic, static, and meter values. Dynamic values are values that
can change while the printer is being used, such as out of paper and low on toner. Static values are values that do not
change or change very infrequently, such as the printers name and IP address. In most cases, updating static values
is less important than updating dynamic values, as static values change less frequently. Dynamic value updates are
needed to maintain timely alerts so a device can stay operational. Meter values track information about how many
copies, prints, faxes, scans, and so forth have been made.

Option Description

SNMP server Specifies the network (DNS) name for the server.

SNMP community The SNMP community name used to communicate with
the server.

Update dynamic values Select this check box to automatically update dynamic v
alues for a device.

Update static values Select this check box to automatically update static value
s for a device.

Update meter values Select this check box to automatically update SNMP me
tering values.

Use PJL during update Use PJL (Printer Job Language) for the update. You can
select this option if PJL is supported on a device.

Code page The code page used by the hardware.

Override global SNMP v3 settings Select this check box to override the global settings for t
he SNMP server. After you select this check box, config
ure the Device SNMP v3 settings.

Device SNMP v3 settings

Option Description

User A valid user name for authenticating the user on the SN
MP server.

Context name The context name to use for the SNMP user.

Authentication password The authentication password the SNMP user.

Protocol The authorization protocol to use for authenticating the u
ser (MD5 or SHA).

Encryption password The encryption password for the user.

Algorithm The algorithm used to encrypt the password (DES, AES,
DES3, AES192, or AES256).
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Device Details tab (Device Configuration)
Use this tab to configure embedded client setting for a device.

You can access this tab from the Devices application when you right-click a device and click Configure device.

Secure release type

Specifies the client type for the device.

SN

Specifies the serial number of the client type for the device.

IP addr

Specifies the IP address of the client type for the device.

Firmware

Specifies the firmware version for the device.

Update

Allows you to browse and update the firmware for the device.

Cost Management

These options configure cost management for the embedded client.

Option Description

Track Select the check box for each type of usage you want to t
rack. Some options may not be available for a device.

• Prints (unavailable for Konica Minolta devices)
• Scans
• Copies
• Fax Transmissions (unavailable for Konica Minolta

devices)

Polling interval Specifies the interval in hh:mm:ss that Output Manager q
ueries the device for information.

Use SSL Select this check box to use the Secure Sockets Layer (S
SL) protocol instead of an unencrypted connection to qu
ery the device.

Cost per page Specifies the page cost for scans, copies (B&W and Col
or), and faxes. Some options may not be available for a d
evice.

• Scans
• Copies B&W
• Copies Color
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Option Description

• Faxes (unavailable for Konica Minolta devices)

3rd party card reader

The 3rd party card reader check box is selected when a RF IDeas Ethernet 241 Card Reader is configured and
licensed to Output Manager for the device.

Unified Client

Select the Unified client check box to enable the Unified Client for the device.

Option Description

Configure access control Select this check box to configure access control for the
device.

Access control enables an administrator to configure
access to specific features of an MFD, such as restricting
a users to making only black and white copies on a
particular MFD. To support this feature, an MFD must
provide API support for access control.

Print Preferences Specify a Kiosk preference profile for the device. You c
an click New to create a new profile, Edit to edit the cur
rently selected profile, or Manage to work with all profi
les.

Kiosk tab (Device Configuration)
This tab associates kiosks to a device.

When a kiosk is associated with a device, users using the kiosk are able to route documents to the associated device.

Option Description

Associated kiosks with this device Select the check box next to a kiosk in this list to associa
te the kiosk with the device.

Job Status tab (Device Configuration)
This tab allows you to enable and configure options for tracking jobs.

Note:  This tab is not displayed for Konica Minolta devices.

Option Description

Track job status Select this check box to enable tracking for the destinati
on if this feature is supported for the destination, usually
destinations for devices that support JBA (job based acc
ounting).
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Option Description

Polling interval for job status information Specifies the interval in hh:mm:ss between queries to the
server for job status information.

Re-cost document based on accounting feedback from
printer

Use accounting information from the printer to calculate
costs shown in the logging information.

Assign job status profile Specifies the job status profile that maps status values to
columns in the status logs. The default mapping is used i
f you do not select a profile.

Click the New button to map values to columns in a new
profile. Click Manage to open the Manage Job Status
Mapping Profiles dialog box to manage all job status
profiles.

Job status via private MIB Clear the Disabled check box to auto-detect the manage
ment information base on your system to monitor objects
provided Output Manager.

Read job status from printer Specifies to read job status information from the printer s
upplied in a Logfile or in a Database. Choosing either of
these options enables additional options that you must co
nfigure so that Output Manager can access information fr
om the log file or database.

Konica Minolta iOption devices

You only need to configure settings on this tab for Konica Minolta iOption devices when IPP destinations are used
and you wish to track print job status via IPP.

This only works with printers that support RFC 2910, RCF 2911, and IPP/1.1.

In that case, use the following settings:

• Select the Track job status check box.
• Select the IPP Default Job Status profile.
• Clear the Read job status from printer check box.

The easiest way to confirm that this feature is working correctly is to clear the Track Print check box on the Device
Details tab, and to enable the IPP job status on this tab. Then, send a print job to the printer, and run a report to see
that the job accounting data was captured. If it does not get captured, clear the Track job status check box on this tab,
and select the Track Print check box on the Device Details tab.

Restriction:  Output Manager tracks and reports on all documents it sends to Konica Minolta devices, but the
Job Status tab is hidden by default for these devices due to potential inconsistencies in the information we
receive when print tracking is enabled.

Device Profile dialog box
Use this dialog box to configure a device profile. Device profiles consist of configuring billing account prompts.
Billing account prompts can be configured to occur at login or before releasing jobs.
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Option Description

Profile name Enter a name to identify the profile in this box. This n
ame will appear as a selectable item for the user in the
Device Profile column of the general user properties and
in in the Manage Device Profiles dialog box.

Profile description Provides space to briefly document the purpose of the pr
ofile. This description shows for a profile in the Manage
Device Profiles dialog box.

Immediately release user's documents when
authenticated via Card swipe at MFP

Select this check box to print all pending documents that
belong to a user immediately after the user authenticates
using the card reader attached to an MFP. The user will
not be able to select individual documents to print while
this option is selected.

Prompt for billing accounts before releasing jobs Select this check box to prompt for billing accounts befo
re releasing jobs. You can select up to three billing lists t
o be displayed before releasing print jobs.

Prompt for billing accounts at login Select this check box to prompt for billing accounts whe
n a user logs into Output Manager. You can select up to t
hree billing lists to be displayed at login.

Active Select this check box to make a list active and available t
o users.

Caption Specifies the caption that identifies the account to users.

Input type Specifies how users specify a billing account.

• Drop Down — User selects the billing account
caption account on a drop-down list.

• Write In — User types in the name of the billing
account caption.

• Drop Dow with Write In — User can type a billing
account caption or click a caption on a drop-down
list.

Billing list Specifies the default billing list displayed to a user.

Device wizard
Use the device wizard to convert Windows queues to sources or destinations, to detect devices, or to restore
previously converted Windows queues.

Click the links on this page for detailed instructions.

Task Description

Convert Windows Queues on one or more Print Servers Converts Windows queues to sources and/or destinations
. All documents sent to the Windows queue will be recei
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Task Description

ved in Nuance Output Manager through the new source,
rather than going to the printer. If desired, you can choos
e to create an Nuance Output Manager destination for th
e queue. Nuance Output Manager will automatically conf
igure the source to route to the destination. This is useful
because no change will appear to the end users - they wil
l print and receive their documents as usual.

Convert using Advanced mode Converts Windows queues to sources and/or destinations
using an advanced configuration method.

Detect devices via SNMP Detects printers using SNMP. Printers can be detected on
all servers that have the Output Manager SNMP Service
installed. Once printers are detected, they can then be co
nfigured as Nuance Output Manager destinations.

Restore previously converted Windows Queues Restores Windows queues that were converted to
Nuance Output Manager sources.

Document Library Profile dialog box
Use this dialog box to configure library profiles. Library profiles specify what to do with associated documents when
they are routed to the Nuance Output Manager library. The profile specifies the library folder where documents will
be sent, the file store, any notifications, and how long to keep documents before deleting.

You can access this dialog box when you configure the document library destination, create a business rule with a
library filing profile, or assign a library filing profile from the Documents grid.

Name

Specifies the library profile name.

Description

Specifies a description of the library profile.

File documents in library

Specifies where documents will be stored in the document library. Click the browse button (...) to specify an existing
Base folder. If desired, you can then specify one or more Dynamic folder levels to be placed under the selected Base
folder. To create dynamic folders, click Add and enter a folder name. The folder name can consist of text, one or
more document properties, and functions.

• To insert document properties, right-click in the text box, click Insert Document Property, and choose the
appropriate properties. Some example document properties are date/time, document name, data type, and so on.

• To insert functions, right-click in the box, click Insert Function, and choose the appropriate function. Review the
Using Nuance Output Manager functions help topic for information on configuring functions.
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You can add, edit, and remove folders, and change the folder order using the buttons next to the box. Each level added
becomes a sub folder of the folder above it in the list. If the folders already exist, the document will be filed there,
otherwise the folders will be created.

Send email notification upon filing

Specifies if an email notification will be sent when a document is sent to the library. To configure the email
notification, select the check box and click Email. This opes the Send Email dialog box.

When filing documents in the library

Determines the file store for documents sent to the library. You can choose to leave them in their current file store or
move them to a specified file store.

Purge documents after X days

Determines how long documents should stay in the library before it is deleted.

Document Owner Mapping tab
Use the Document owner mapping tab to control how the document owner is set. This tab is available for all of
the extraction profiles. You can access this tab from the Document Properties Profile dialog box during source
configuration.

Click an option you want to learn more about.

• Job Ticket tab on page 557
• Document Property Mappings tab on page 541

Name

Specifies the name of the profile.

Description

Specifies a description of the profile.

Set the document owner using the following method

Use the Windows user id (if available) Sets the document owner to the Windows user ID. This can be used with the
following source types: Windows queue, network folder, and Web file upload.

Map to the following external field Sets the document owner to a mapped external field.

Note:  For job ticket profiles, the ticket information fields are expressed as XPath statements. XPath
statements show the structure of the ticket information. It allows the ability to specify a specific instance
of a field if that particular information field occurs more than once in a documents metadata. If a particular
external field is not listed in the list, the XPath statement can be directly entered. For headers from data
profiles, this list will be populated with the headers specified.

You can map the external field's value using the following method.
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• Use the external value as the OM user name — Allows external document property information to be used for
the Nuance Output Manager user name. Note, when the document is first received by the source the document has
existing properties. These properties are called external document property values.

• Use the following lookup profile — This is not currently implemented. When implemented, you will be able to
use a lookup table to map Personal Identification Numbers to user names.

• Use the following value mappings — Allows for entering values for the external document property. When the
external document property has one of the values listed in the External Field Value column, the value in the
Property Value column will be used.

If you are unable to determine the document owner, assign the following user

Assigns a document owner from the User and Group Selection dialog box. This user will be assigned in the
document owner cannot be determined using the above settings.

Document Properties dialog box
Use this dialog box to configure document properties. You can access this dialog box when you view/edit the
properties of a document in a Documents grid or create a business rule action to set document properties.

View

Important:  This option is only available when you are viewing/editing the properties of a document in a
Documents grid.

Controls the document properties/print preferences that display in the grid. You can change the view based on the
capabilities of the printer family and the specific destination where the document is being routed.

All — Displays all available document properties in the grid.

Standard — Displays only the document properties that the destination is capable of using. This is the default view.

Only Set Values — Displays only the document properties that contain a value (have been configured). This is an
easy way to see the settings that are going to be applied to the document.

Properties grid

Configure the document properties by clicking directly in the grid.

Document Property column – Lists the property values that can be configured. The properties are grouped into the
following categories: Basic options, Media selection, Document, Image adjustments, Finishing, and Other properties.
To expand a category, click the down arrow next to a category name. To collapse a category, click the up arrow.

Under each category are the print preferences/document properties that belong to that group. The first node level in
the categories determine the print preferences for the properties it contains. On the print preference node, you select
how the property should be applied when a document is sent to a destination. Under each print preference are the
parameters needed to generate that print preference.

Mode column – Specifies how to apply the property value. Click in the cell and choose one of the following options:

• Always Apply — Always applies the specified property value. Nuance Output Manager will add commands to the
print stream to enforce the print preference. If the document already contains commands for that print preference,
Nuance Output Manager will modify the commands to work with the printer family where the document is being
sent.



Output Manager Administration Guide
Version 4.0 SP2

539 © 2016 Nuance Communications, Inc. All rights reserved.

• Apply Conditionally — Applies the property value conditionally. Nuance Output Manager will only add or modify
commands for the print preference when the printer family that the document is destined for is different from the
printer family the document was originally designed for.

• Informational Only - Nuance Output Manager makes no changes to the print stream when the document is sent to
the destination. The value is for informational purposes only.

Value column — Specifies the document property value. Click directly in the cell to change the value. You can use
functions to insert and extract data as necessary.

Only the allowed values configured in the Configure Document Properties Utility will be available for selection. If
(Excluded) displays next to a value, that value was excluded by the currently assigned destination on the Destination
Capabilities dialog box.

Document Properties Profile dialog box
Document properties profiles is a complex feature that allows the mapping of header data to Nuance Output Manager
document properties. Only advanced users and professional service engineers should configure this. You can access
this dialog box from the Document properties tab during source configuration.

Name

Specifies the document properties profile name.

Description

Specifies a description of the document properties profile.

Native header profile

Specifies the native header profile. This profile configures information received when the document arrives as part
of the transmission protocol. This includes email fields, FTP transmission data, LPD control file fields, watch folder
information, socket transmission data, WebSphere MQ transmission data, Windows queue print job data, and Output
Manager Print Server header fields.

Use the list to select an existing profile.

New — Displays the New Native Header Profile dialog box for creating a new native header profile. You can
configure the profile using the Native headers tab, Document property mappings tab, and Document owner
mapping tab.

Edit — Displays the selected profile properties for modification.

Manage — Displays the Manage Native Header Profiles dialog box which lists all of the defined profiles. From this
dialog box you can create, import, and export profiles, as well as manage all existing profiles.

Job ticket profile

Specifies the job ticket profile. This profile configures information extracted from several types of job tickets,
including Nuance Spool Header, Output Statement, or XML.

Use the list to select an existing profile.

New — Displays the New Job Ticket Profile dialog box for creating a new job ticket profile. You can configure the
profile using the Job ticket tab, Document property mappings tab, and Document owner mapping tab.
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Edit — Displays the selected profile properties for modification.

Manage — Displays the Manage Job Ticket Profiles dialog box, which lists all of the defined profiles. From this
dialog box you can create, import, and export profiles, as well as manage all existing profiles.

Job parsing profile

Specifies the job parsing profile. This profile configures information extracted from Postscript, PDF, and PCL
documents.

Use the list to select an existing profile.

New — Displays the New Job Parsing Profile dialog box for creating a new job parsing profile. You can configure
the profile using the Job parsing tab, Document property mappings tab, and Document owner mapping tab.

Edit — Displays the selected profile properties for modification.

Manage — Displays the Manage Job Parsing Profiles dialog box, which lists all of the defined profiles. From this
dialog box you can create, import, and export profiles, as well as manage all existing profiles.

Headers from data profile

Specifies the headers from data profile. This profile controls information extracted from specified locations within the
actual document data. Data can be extracted from documents in various formats including ASCII, ASCII with ASA,
S/370, and VBM.

Use the list to select an existing profile.

New — Displays the New Headers From Data Profile dialog box for creating a new headers from data profile. You
can configure the profile using the Headers from data tab, Document property mappings tab, and Document
owner mapping tab.

Edit — Displays the selected profile properties for modification.

Manage — Displays the Manage Headers From Data Profiles dialog box, which lists all of the defined profiles.
From this dialog box you can create, import, and export profiles, as well as manage all existing profiles.

Property grid

Determines the order in which the configured profiles are used when a document is received, and what the default
static value is if no data is found in the respective header. The mapping order can be different for each document
property.

Property column — Displays the Nuance Output Manager document property name.

Mapping Order column — Controls the sequence the designated profiles are processed to find a value for that
document property. Note the static value by default is the value for that document property in the source’s Document
properties tab.

Click in the cell to display a configuration menu. Configure the order in which headers are processed by selecting
the appropriate rows and clicking the Up and Down buttons. To enter a default static value, click in the Mapping/
Value cell next to Static Value and either type or select the value. This static value is used if no data is found in the
preceding headers.
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Document Property Mappings tab

Use the Document property mappings tab to configure document property mappings for all of the extraction
profiles. You can access this tab from the Document Properties Profile dialog box during source configuration.

Click an option you want to learn more about.

• Native Headers tab on page 580
• Document Owner Mapping tab on page 537

Name

Specifies the name of the profile.

Description

Specifies a description of the profile.

Document property mappings grid

Configures document property mapping directly in the grid. To enable document property mapping, select the Map
Values check box for the property and then click in the External Field column.

Property column — Displays the document property to be mapped.

External Field column — Selects the mapping from the list. If a look up table is needed to adjust the values, click
the [+] in front of the property to create or revise a lookup table. Enter the values in the Value Mappings grid as
necessary.

Note:  For job ticket profiles, the ticket information fields are expressed as XPath statements. XPath
statements show the structure of the ticket information. It allows the ability to specify a specific instance
of a field if that particular information field occurs more than once in a documents metadata. If a particular
external field is not listed in the list, the XPath statement can be directly entered. For headers from data
profiles, this list will be populated with the headers specified.

Map Values column — Enables document property mapping.

Unmapped Value Action column — Specifies what happens when there is a missing look up table entry. You can
choose to skip the property mapping entirely, assign the external value as-is, or assign the unmapped value default.

Unmapped Value Default column — Specifies a default value.

Edit LDAP User dialog box
Use this dialog box to modify the information about an LDAP user. You can access this dialog box when you are
managing users, managing Nuance Output Manager security roles, and configuring security for the Output Manager
Console, destinations, sources, and documents.

LDAP server

Specifies the LDAP server. You cannot modify this field.
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Distinguished name

Identifies the DN (distinguished name) of this LDAP user. You cannot modify this field.

User name

Specifies the user name that will be used when logging in to the server.

Display name

Specifies the LDAP display name.

Email address

Specifies the email address of the user.

Department

Specifies whether the user is a member of a department. You can select one of the departments from the list or click
New to create a department from the Department dialog box.

Update from LDAP Server

Restores the user detail information to the values in the LDAP server if you chose to override the data for the Nuance
Output Manager environment.

Edit Windows User dialog box
Use this dialog box assign a Windows user to a new or existing department. Only the Department field is editable.
This dialog box is displayed when you click Modify from the Users tab in the Manage Users utility.

User name

Specifies the user name for the selected Windows user.

Display name

Specifies the display name for the selected Windows user.

Email address

Specifies the email address for this Windows user.

Department

Indicates the department for this Windows user. Use the list to select an existing profile. To create a new department,
click New. This opens the Department dialog box.
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License Operation dialog box
Use this dialog box to determine if you want to install and activate a new license, activate an installed license, or
deactivate DBM components.

Install and activate a new license

Installs and activates a new license file. You can install the license automatically via the Internet or manually by
selecting the license file.

Activate license

Activates an installed license file. You can activate all DBM components or select which DBM components to
activate. You can also choose the activation method: automatic activation via the Internet or manual activation using 
Notable Solutions Web License (/weblicense.nsiautostore.com).

Deactivate DBM components/uninstall license

Deactivates DBM components.

Important:  Before deactivating a license, you must stop all Nuance Output Manager work. Currently,
deactivating a license will halt the Nuance Output Manager functionality on all systems.

Error Handling Profile dialog box
Error handling profiles specify what should happen to destinations when an error is detected via SNMP or during
transmission of a document. Use this dialog box to configure error handling profiles.

You can access this dialog box when you configure a destination.

Name

Specifies the error handling profile name.

Description

Specifies a description of the error handling profile.

Check box options

• Use two-stage error handling — This feature will be implemented in a future release.
• Use detailed system errors — Enables more granular control of system error handling.
• Use detailed SNMP errors — Enables error handling control for specific SNMP conditions. Once the option

is selected, click the Select errors button to select the SNMP conditions you want to process. The selected
conditions will be listed in the grid where error handling is configured.

• Time between retries — Sets the time between transmission retries.
• Attempt error recovery after — Sets the time to wait before attempting error recovery.

http://weblicense.nsiautostore.com/
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Grid options

Click directly in the grid to configure error handling for the listed errors.

• Error reported column — Displays the error type or SNMP condition type (or message) for which to configure
error handling. More granular options can be made available by selecting the Use detailed system errors and Use
detailed SNMP errors check boxes.

• Interval before assigning state column — Sets the number of retries (system errors) or time interval (SNMP
conditions) to wait before assigning the destination state.

• Interval type column — Sets the type of interval for retries.
• State to assign column — Sets the state to which the destination should be assigned when all retries have failed.

• Ignore — Ignores the error and leaves the destination in a Ready state.
• Error — Sets the destination to Error state. Error recovery will be attempted based on the time interval set in the

Attempt error recovery after field.
• Down — Sets the destination to a Down state.  The destination must be manually moved out of this state.

• Failover documents column — Initiates the failover process for documents that have encountered error
conditions when transmitted to the destination.

Exception Fields dialog box
Use this dialog box to select the exception fields for an ad hoc merge package rule.

Exceptions fields are applicable only if the documents that you are merging have job tickets specifying a baseline
for how each page should print or have rules or input configuration overrides that set specific document properties
(print preferences) AND you want to preserve some of these attributes on a per-page basis in the resultant merged
document.

Use this dialog box to specify which document properties to preserve on a per-page basis in the merged document.
The document properties will be analyzed to determine the baseline and the exceptions (page overrides). For instance,
you have multiple documents you want to merge that each have document property values specified for media type,
media color, and duplex. All three of these are important in the final merged document, such that it will specify a
baseline that is most common for media type, media color, and duplex, and will contain exceptions for each sequence
of pages that does not conform to the baseline.

If you do not select these document properties as exceptions, they will not be considered in the merge, and no
exceptions will be generated for any differing value of document properties not specified. For example, if you did not
select any exceptions document properties, then the merged document will contain a baseline without any exceptions
based solely on the model document. (The model document is determined when you choose if you want to use the
first or last document properties in the Merge Package dialog box.) Assuming the model document was the first
document, is a cover page, and is single-sided and green, the merged document will thus print with all pages single-
sided and green. By specifying duplex and media color as exception fields, the merged document will instead specify
each page accordingly as to whether it should print single-sided or double-sided, and on green or white paper.

Let's say you want media type and media color to be preserved from the constituent documents into the merged
document, but you want the whole job to print single-sided regardless of whether a constituent document specifies
itself to be double-sided or not. In this case, you would only select media type and media color as exception fields and
you would not select duplex. You would also have to insure that your model document is single sided, or add a Set
Document Properties action to your rule to set this property on the merged document.
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Properties grid

Lists the document properties that can be selected as exception fields. Exception fields specify which document
properties to preserve on a per-page basis in the merged document. The document properties will be analyzed to
determine the baseline and the exceptions (page overrides).

The properties are grouped into the following categories: Basic options, Media selection, Document, Image
adjustments, Finishing, and Other properties. To expand a category, click the down arrow next to a category name. To
collapse a category, click the up arrow.

Export Reports dialog box
Use this dialog box to export reports that you generate from base reports in the Reports application. Nuance Output
Manager does not allow you to export base reports. When you export a summary report, Nuance Output Manager
allows you to export a linked detail report.

Export Folder

Specifies the folder where Nuance Output Manager exports the report files.

Grid

The grid shows report details for all the reports to be exported. The grid shows the following details:

• Report Id — System-generated identification number for the report.
• Name — Name of the report to be exported.
• Report Type — Type of report to be exported.
• Linked to Report Id — System-generated identification number for the detail report to which a summary report is

linked.
• Last Update — Indicates the date and time the report to be exported was last updated.

Failover Profile dialog box
Failover profiles specify what should happen to documents if errors occur when they are sent to a destination that is
configured to allow document failover. Use this dialog box to configure failover profiles.

You can access this dialog box when you configure a source or destination, create a business rule with a failover
profile, or assign a failover profile from the Documents grid.

Name

Specifies the failover profile name.

Description

Specifies a description of the failover profile.

If all retries fail...

Specifies what will happen when an error occurs and the failover process has been initiated. You can choose to
perform one of the following actions.
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• Place the document in an error state.
• Reroute the document to the failing destinations default failover group. This is specified on the Error handling

tab.
• Reroute the document to the destination of your choice.

Number of failover destinations to try — Specifies the number of destinations to try before placing the document in
an error state. You can try an Unlimited number or specify Up to a specific number of times.

File Store dialog box
Use this dialog box to configure Nuance Output Manager file stores. Nuance Output Manager only stores the
properties of a document. The actual files are stored in network folders, called file stores.

Enter the file store path

Specifies the network folder path where the Nuance Output Manager files are stored. You can type the path or click
the browse button (...) to select a folder. The NSi DBM Service will need to have permissions assigned to access the
selected network folder.

Verify the file store folder does not contain any empty folders. Empty folders in the file store folder will be deleted
with the Nuance Output Manager cleanup process runs.

Filter Profiles tab
Use this tab to define and select configurations for each format. You can access this tab when you create or modify a
transform package on the Configure Transform dialog box.

Click an option you want to learn more about.

• General tab (Transform Package) on page 548
• Resources tab on page 617
• Fonts tab on page 547

Format grid

Use the grid to select or create a filter profile for each format.

• Format column — Displays all available formats. The formats that display vary depending on the transform
package selected on the General tab.

• Configuration column — Specifies the configuration to be used with each format. Click in the column to select
a configuration from the drop-down list. The default profile is selected by default for all formats. All previously
created configurations will be listed in the drop-down list.

• Modify/New column — Modifies the selected configuration or creates a new configuration from the Configure
Filter Profile dialog box. Because the default configurations cannot be modified, if you click the browse button
(...) for a default configuration, a new configuration will be created when you save.
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Font Face Configuration dialog box
Use this dialog box to configure the font face.

You can access this dialog when you are configuring a transform package from the Fonts tab.

General

• Style — Specifies the font style, upright or italic.
• Weight — Specifies how thick or thin characters in text should be displayed.
• Width — Specifies if the characters in text should be condensed or expanded.

Dev

• Override Embedded Font — Specifies whether an embedded font resource should be replaced with the font to
which the input font is mapped.

• No Hinting — Specifies if you want to use font hinting (screen optimized fonts). Font hinting is the process by
which fonts are adjusted for maximum readability on computer monitors.

• Dev Name — 

Font File

• Fixed Symbol Set — Determines if you wan to use a specific collection of symbols provided by a font.
• Name — Specifies the font name.
• Type — Specifies if the font is TrueType or Type 1.
• Size — Specifies the font size.
• Id — 
• Pitch — Specifies the number of characters per inch (for fixed-spaced fonts only) common values are 10, 12,

16.67. Used to calculate height for fixed-spaced scalable fonts.Embed — Specifies how to embed the font. You
can choose to always embed, embed on input, or embed on output.

AFTP

This section is only available for AFP.

• Baseline Increment — .
• Rasterize — .
• Raster — .

Fonts tab
Use this tab to control the font mapping of input fonts to output fonts. The defaults are typically correct, but may need
to be adjusted for special cases. You can add or modify fonts directly in the grid. You can access this tab when you
create or modify a transform package on the Configure Transform dialog box.

Click an option you want to learn more about.

• General tab (Transform Package) on page 548
• Filter Profiles tab on page 546
• Resources tab on page 617
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Fonts grid

Displays the fonts for each data type. The defaults are typically correct and do not need to be modified. If necessary,
you can add fonts by clicking on the top row of the grid or modify the listed fonts by clicking directly in the grid.

Used by — Specifies the data type.

Family column — Specifies the font family.

Serif Style column — Specifies the serif style, either serif or sans serif. Serif fonts have small lines at the ends on
some characters. Sans serif fonts do not have the lines at the ends of characters.

Spacing column — Specifies the spacing, either proportional or monospaced. A proportional typeface contains
characters of varying widths, while a monospaced (fixed-width) typeface uses a single standard width for all
characters.

Ref Type column — Specifies a reference type of TrueType or Type1.

Type Face column — Specifies the number that corresponds to the typeface for the font family (for example, Arial is
16602 and Courier is 4099).

Font Face column — Specifies the font face details. Click the browse button (...) to open the Font Face
Configuration dialog box.

General tab (Transform Package)
Use this tab to specify the transform package you want to use. You can access this tab when you create or modify a
transform package on the Configure Transform dialog box.

Notice:  IPDS mentioned in here is not available for new sales.

Click an option you want to learn more about.

• Filter Profiles tab on page 546
• Resources tab on page 617
• Fonts tab on page 547

Server

Displays the transform server name.

Name

Specifies the transform package name.

Type

Specifies the type of transform package that Nuance Output Manager uses to convert print stream data or the IPDS
transform package that Nuance Output Manager uses to send print data to IPDS printers. The Nuance Output Manager
transform package allows you to convert to and from PCL, Postscript, PDF, Text, and common image formats. The
IPDS transform package is available only when configuring an IPDS destination. IPDS destinations are licensed on a
per-printer basis and are not available for new sales.
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EXE path

Specifies the EXE path. For the Nuance Output Manager and IPDS transform types the executable path is
automatically selected, @EOMTransformDir. For a third-party transform package, enter the path to the appropriate
transform package directory.

Nuance Output Manager Transform package configurations can be reused on different servers. The installation of
third-party transform packages, Ghostscript, and Adobe Acrobat readers should be in the same locations on all servers
if possible.

You cannot point a third-party transform package to an Nuance Output Manager transform executable because
licensing is different for each type. The Nuance Output Manager license is part of Nuance Output Manager. Third-
party transform package licenses may need to be installed separately.

Logging state

Specifies if all transform logs and temp files will be saved in the document folder. By default, the Logging State is
set to Yes. This will save all transform logs and temp files in the document folder. These log files should be inspected
during installation and preproduction testing to insure that fonts are correctly mapped. In a production system, the
Logging State can be set to No to save disk space. If the transform operation returns an error (return code not zero),
the log and temp files will not be deleted, and are available for troubleshooting.

Global Group Routing Map dialog box
Use this dialog box to define the document properties that you can use as group routing criteria for this instance of
Nuance Output Manager. Routing documents to a destination group operates in one of two basic modes. If you use
round robin routing, you can assign documents to destinations by matching document properties with values assigned
to destinations in the group. After you define global properties in this dialog box, you configure individual destination
groups to use one or more of the properties in their own routing configuration.

You can access this dialog box through Set General Preferences on the Destinations tab in the Administration
application.

Available properties

Select the document properties that a destination group can use in its routing configuration.

Routing map

Use the Move up and Move down buttons to set the order in which the properties appear when configuring group
routing.

Group Routing Configuration dialog box
Use this dialog box to configure how Nuance Output Manager routes documents to a destination within a destination
group. You can access the dialog box by right-clicking a destination group in the Destinations application.
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Do not assign a destination

The default setting that Nuance Output Manager uses to assign documents to a pending queue within the group.
Documents remain in the queue until a user manually assigns the documents to a destination or releases them from an
Nuance Output Manager release station.

Round robin among available destinations

Nuance Output Manager routes documents to the next available destination in the destination group.

Require matching document and destination properties

When you select Round robin among available destinations, you can select this option to assign a document to a
destination in the group only if one or more document properties match corresponding routing column properties for
the destination.

Groups tab
Use this tab to add, remove, and manage groups of users. You can access this tab from the Manage Users utility.

Click an option you want to learn more about.

• Users tab on page 698
• Departments tab on page 492

Include removed groups

Displays groups that were previously removed by an administrator.

Groups grid

From this grid, you can add and manage groups.

Full Name — Specifies the name of the group of users.

Type — Indicates whether this group is an Nuance Output Manager group, an LDAP group, or a Windows group.

Email — Specifies the email address for this group.

More Groups button

If the group is not listed, click More Groups to add that group. Once groups are added, they are placed in the Nuance
Output Manager database and will always be listed in the future. Choose one of the following options from the list:

• Add OM Group — Opens the OM Group dialog box for adding Nuance Output Manager users.
• Add LDAP Group — Opens the LDAP Group dialog box for adding LDAP users.
• Add Windows Users and Groups — Opens the Users and Groups dialog box for adding Windows users and

groups.
• Import LDAP Users and Groups — Opens the LDAP Import Utility for importing LDAP users.
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Modify button

Depending on the type of group selected, opens the OM Group dialog box or the LDAP Group dialog box so that
you can change information. You cannot modify a Windows group from the Output Manager Console; you must
modify it from the Windows operating system.

Remove button

Deletes the selected group.

Headers from Data tab
Use the Headers From Data tab to configure headers from data profiles. Headers from data profiles consist of
information that Nuance Output Manager can extract from specified location within the actual document data. Nuance
Output Manager can extract data from documents in various formats including ASCII, ASCII with ASA, S/370, and
VBM.

Only advanced users and professional service engineers should configure these profiles. You can access this dialog
box from the Document Properties Profile dialog box during source configuration.

Click an option you want to learn more about.

• Document Property Mappings tab on page 541
• Document Owner Mapping tab on page 537

Name

Specifies the name of the headers from data profile.

Description

Specifies a description of the headers from data profile.

Data format

Specifies the document data format. You can choose ASCII, ASCII with ASA, S/370, or VBM.

Code page

Specifies the code page for the document.

Extraction method

Line-based — Searches for the header based on a particular line.

Record-based — Searches for the header based on a particular record, regardless of page breaks.

Headers to extract

Specifies the headers to extract. These variables will appear on the Document property mappings tab and the
Document owner mapping tab. Click directly in the grid to edit.

Name column — Specifies the header field for the data to be placed in.
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Page column — Specifies the page where data extraction will begin.

Line column — Specifies the line number in the file that contains the data.

Column column — Specifies the column where data extraction will begin. For ASCII with ASA carriage control
files, the first column is not counted (in other words, the second column is treated as the first column).

Length column — Specifies how many characters to extract.

Import Reports dialog box
Use this dialog box to import reports into folders in the Reports application.

Import Folder

The folder that contains the report files to be imported.

Import into original group

Imports the report files into the same base reports folder from where the report files were exported. If the report files
were exported from a custom folder that another Nuance Output Manager user created, select the folder from Import
into group.

Import into group

Specifies the custom reports folder where Nuance Output Manager imports the report files.

Select all

Selects all the report files in the grid.

Unselect all

Clears report files selected in the grid.

Grid

The grid shows all the report files in the folder that you selected for Import Folder. The grid shows the following
details:

• Name — Name of the report to be imported.
• Report Type — Type of report to be imported.
• Original Id — System-generated identification number for the report at the time of export.
• Linked to Report Id — System-generated original identification number for the detail report to which a summary

report is linked.
• Time Exported — Indicates the date and time the report file was exported.

Ini Resource dialog box
Use this dialog box to configure an Ini resource. You can access this dialog box when you configure an Ini resource in
the Resource Manager dialog box or an Adept transform action in the Process Designer.
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Name

Specifies the name of the Ini resource.

Description

Provides a description of the Ini resource.

Comments

Displays any comments about the resource.

Printer Family

Use the check boxes to determine if the resource will be used for all printer families or only for certain printer
families.

Data Type

Use the check boxes to determine if the resource will be used for all data types or only for certain data types.

Import Resource Data

Browse button — Allows for importing resource data. Imported files must contain text data.

Code page — Specifies the code page to be applied to the resource data.

Resource Editor

You can enter text, document properties, and functions in the Resource Editor.

To insert document properties, right-click in the box, click Insert Document Property, and choose the appropriate
properties. The document properties will display enclosed in brackets ([]).

To insert functions, right-click in the box, click Insert Function, and choose the appropriate function. Review the
Using Nuance Output Manager Functions help topic for information on configuring functions.

To go to a specific line in the resource, right-click in the box and click Go To (or press Ctrl+G). In the box that
displays, enter the line number and click OK. The line will be highlighted in the Resource Editor.

To find specific text, right-click in the box and click Find and Replace (or press Ctrl+F) to display the search dialog
box.

Export button

Allows for exporting the resource data. Unlike the Export button on the Resource Manager dialog box, this exports
only the text data from the Resource Editor box to a text file.

Input Options tab
When using a custom input configuration, a large number of options are available to control the transform operation.
Input options control which items appear in the output file and how images are processed. Typically these options
should be left at the default settings.
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You can access this dialog box when you configure a transform action for business rules or output processes or when
configuring an IPDS destination.

Notice:  Please note that the IPDS output option is not available for new sales.

Click an option you want to learn more about.

• Output Options tab on page 590
• Page Layout tab on page 595
• PDF Output tab on page 596

General input options

• Convert to image — Converts and stores the page contents as an image on input.
• Invert duplex — Inverts duplex information (back to front and front to back).
• Copy comments — Copies the comments stored in the input file.

Note:  There is no guarantee that all of the comments specified in the input file can be copied to the output
file. For example, TIFF files accept only one comment.

• Obfuscate text — Changes the text to be unreadable when reading the page (input). This is helpful if you are
dealing with sensitive customer documents. Obfuscate text does not work for documents where the text is stored
in a custom encoding or as part of an image.

• Enable full printable area for PCL input — Specifies that logical page matches physical page (page margins are
not ignored).

• Convert and append attachments (PDF 1.6) — Only available when using PDF input file.

Remove

Specifies the items in the input file you want removed. The items will not appear in the output file.

Dithering method

Specifies the dithering method that will be used.

• Default — The software attempts to determine the best dithering method to use.
• Clustered order — Clustered order dithering with specification of matrix size. Values are 2 to 8, with a default

value of 3.
• Dispersed order — Dispersed order dithering with specification of matrix size. Values are 2 to 8, with a default

value of 4.
• Floyd-Steinberg — Dithering with error diffusion algorithm Floyd-Steinberg, It examines a small neighborhood of

four pixels surrounding the central pixel, and distributes the error in a defined structure.
• Jarvis-Judice-Ninke — Dithering with error diffusion algorithm Jarvis-Judice-Ninke. It uses substantially larger

neighborhoods that contain a greater number of pixels in order to spread the error distribution.
• Stucki — Dithering with error diffusion algorithm Stucki. It uses substantially larger neighborhoods that contain a

greater number of pixels in order to spread the error distribution.
• Monochrome threshold — Monochrome conversion with specification of threshold percent value (0 — 100). The

default value is 50.

Image depth

Specifies the image color depth in bits of the input file. You can select one of the following:
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• 1: Monochrome
• 8: Grayscale, Palette
• 24: RGB
• 32: CMYK

Image type

Specifies the image type of the input file, RGB, CMYK, Grayscale, or Palette.

Password

Specifies the password for password protected input files.

To insert document properties, right-click in the text box, click Insert Document Property, and choose the
appropriate properties. The document properties will display enclosed in brackets ([]).

To insert functions, right-click in the box, click Insert Function, and choose the appropriate function.

Render on conversion to image

Specifies the items you want to be rendered on conversion to image.

Advanced additional options

• Additional global commands — Specifies parameters that you want to pass to profiles. Typically would be used
to pass JSL/JDE values to a LCDS profile, or PAGEDEF and FORMDEF values to a MMD profile.

• Additional input commands — Specifies additional parameters for handling the input file. Input commands can
consist of text and one or more document properties. Contact Nuance Support for more information on advanced
transform configuration.

To Do this

Insert document properties in these fields Right-click in the text box, click Insert Document
Property, and choose the appropriate properties. The do
cument properties will display enclosed in brackets ([]).

Insert functions in these fields Right-click in the box, click Insert Function, and choos
e the appropriate function.

Filter profile

Specifies a filter profile to override the profile configured in the transform package for this input/output combination.

The filter profile can consist of text and one or more document properties. To insert document properties, right-click
in the text box, click Insert Document Property, and choose the appropriate properties. The document properties
will display enclosed in brackets ([]).

To insert functions, right-click in the box, click Insert Function, and choose the appropriate function.

Job Parsing tab
Use the Job Parsing tab to configure job parsing profiles. This profile configures information extracted from
Postscript, PDF, and PCL documents. The job parsing method of extracting meta-data relies on printer-specific data
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streams that can include Postscript and PCL, but can also contain ticketing information or job level commands that are
not part of the print data itself. The distinction is that the format of this information within the print stream is already
defined, by the manufacturer or some standards body, and Nuance Output Manager has a profile that defines how the
information is mapped to the Nuance Output Manager print properties.

You can access this dialog box from the Document Properties Profile dialog box during source configuration.

Click an option you want to learn more about.

• Document Property Mappings tab on page 541
• Document Owner Mapping tab on page 537

Name

Specifies the name of the job parsing profile.

Description

Specifies a description of the job parsing profile.

Originating printer family

Specifies the printer family template to use as the parsing guide. Select the printer family from the drop-down list.

Search for printer instructions/job ticket in the following location

Use the following options to specify the location of the ticket. The available options vary depending on the printer
family selected.

Embedded in the document

Searches for the printer instructions/job ticket embedded in a document.

• Remove from document — Removes the job ticket data from the document.
• Keep prior data — When using job tickets, all lines up to and including the job ticket are deleted from the file.

Select this option to keep all data before the job ticket. The job ticket information will be removed.

In a separate file

Searches for the printer instructions/job ticket in a separate file. You can choose a folder to search and then match
the job ticket file name using a specified document property, and/or match the job ticket extension using a specified
extension.

• Delete job ticket file after processing document — Deletes the job ticket file after processing.

If the job ticket is not found, take the following action

Specifies how to process the document if the job ticket is not found. You can choose to process the document
normally, receive the document and place it in error state, or reject the document.
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Job Ticket tab
Use the Job Ticket tab to configure job ticket profiles. Job tickets contain information about the document, and/
or how the document should be treated. Tickets are logically separate from the document, and in some cases are
inserted in front of the document file. Tickets can be processed in several formats, including NSi Spool Header,
Output Statement, and XML.

Only advanced users and professional service engineers should configure these profiles. You can access this dialog
box from the Document Properties Profile dialog box during source configuration.

Click an option you want to learn more about.

• Document Property Mappings tab on page 541
• Document Owner Mapping tab on page 537

Name

Specifies the name of the job ticket profile.

Description

Specifies a description of the job ticket profile.

Type

Specifies the type of job ticket. You can select one of the following types: XML Job Ticket, NSi Spool Header, or
Output Statement.

• Map job ticket button — Establishes the job mapping for XML Job Tickets. Click Map job ticket to open the
Open dialog box, in which you can select one or more sample tickets to create the ticket mappings.

This option is not available for NSi Spool Header and Output Statement tickets, as they have fixed mappings.
• Clear mappings button — Removes any associated job mapping.

Search for job ticket in the following location

Once one or more sample tickets have been mapped, use the following options to specify the location of the ticket.
The available options vary depending on the type of job ticket selected.

Embedded in the document

Searches for the job ticket embedded in a document. You can search based on the start and/or end of the job ticket
recognition string.

• Remove from document — Removes the job ticket data from the document.
• Keep prior data — When using job tickets, all lines up to and including the job ticket are deleted from the file.

Select this option to keep all data before the job ticket. The job ticket information will be removed.

In a separate file

Searches for the job ticket in a separate file. You can choose a folder to search and then match the job ticket file name
using a specified document property, and/or match the job ticket extension using a specified extension.

• Delete job ticket file after processing document — Deletes the job ticket file after processing.



Output Manager Administration Guide
Version 4.0 SP2

558 © 2016 Nuance Communications, Inc. All rights reserved.

If the job ticket is not found, take the following action

Specifies how to process the document if the job ticket is not found. You can choose to process the document
normally, receive the document and place it in error state, or reject the document.

LDAP Group dialog box
Use this dialog box when you are adding LDAP groups to Nuance Output Manager for assigning quotas. You access
this dialog box when you are managing groups with the Manage Users utility Groups tab.

LDAP server

Specifies the LDAP server. Click New to define an LDAP server using the LDAP Server dialog box. Click Modify
to make changes to the selected server.

LDAP group DN

Identifies the DN (distinguished name) of this LDAP user. You select this user in the Browse LDAP Server dialog
box, which is opened when you click the Browse button.

LDAP Group Detail

Displays the information contained in the LDAP directory. The information can be overridden for the Nuance Output
Manager environment. To change the group name, display name, or email address, select Override LDAP data. The
fields will then be made available for entry.

• Group name — Specifies the LDAP group name
• Display name — Specifies the LDAP display name. This name is displayed on the Manage Users Utility Groups

tab.
• Email address — Specifies the email address of the group.
• Override LDAP data — Specifies that you want to override the LDAP group details. When you select this check

box, the data is changed only in Nuance Output Manager, not in the network LDAP directory.

LDAP Server dialog box
When you are adding LDAP users or an LDAP group to Nuance Output Manager, you must specify the LDAP server
that you will search. Use this dialog box to specify the LDAP server that contains the users or the group that you want
to add. Once the users or group are added, permissions and quotas can be assigned as needed. You can access this
dialog box from the LDAP User dialog box or from the LDAP Group dialog box.

Server type

Specifies a server type of either Microsoft Active Directory Server or Generic LDAP Server. A server type of Generic
LDAP Server operates in a Microsoft Active directory environment. However, if you are connecting to an Active
Directory Server (ADS), selecting Microsoft Active Directory Server utilizes the Active Directory security and
relationships.

Server description

Indicates the name by which you want to identify this server.



Output Manager Administration Guide
Version 4.0 SP2

559 © 2016 Nuance Communications, Inc. All rights reserved.

Server address

Specifies the DNS (Domain Name System) name of the server. In most cases, you can simply specify the server
address in domain name format, for example, nuanceautostore.com/.

Port

Identifies the standard IP port for the LDAP server.

Login ID (DN format)

Specifies the DN (distinguished name) of a user with administrative rights.

Password

Contains this user’s password.

Verify Connection button

Confirms that a connection can be established with the information you have entered. You will see either Success or
Failure to the right of the button.

LDAP User dialog box
Use this dialog box to add LDAP users to Nuance Output Manager so that you can assign permissions and quotas.
You can access this dialog box when you are managing users, managing Nuance Output Manager security roles, and
configuring security for the Output Manager Console, destinations, sources, and documents.

LDAP server

Specifies the LDAP server. Click New to define an LDAP server using the LDAP Server dialog box. Click Modify
to make changes to the selected server.

LDAP user DN

Identifies the DN (distinguished name) of this LDAP user. You select this user from the Browse LDAP Server dialog
box, which is displayed when you click the Browse button.

LDAP User Detail

Displays the information contained in the LDAP directory. The information can be overridden for the Nuance Output
Manager environment. To change the user name, display name, or email address, or to select an existing department,
select Override LDAP data. The fields will then be made available for entry. If you only want to define a new
department, you do not need to activate the override function.

• User name — Specifies the user name that will be used when logging in to the server.
• Display name — Specifies the LDAP display name.
• Email address — Specifies the email address of the user.
• Department — Specifies whether the user is a member of a department. You can select one of the departments in

the list, or click New to create a department from the Department dialog box. You can create a new department
without selecting Override LDAP data.
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• Override LDAP data — Specifies that you want to override the LDAP user details. When you select this check
box, the data is changed only in Nuance Output Manager, not in the network LDAP directory.

Learning About the Audit Console
Use the Audit Console to view detailed information about actions performed by users. You can choose to save or
discard audit information using the Set General Preferences Utility.

You can access this utility by selecting Tools Audit Console on the Output Manager Console menu bar.

Audit Grid

You can customize the audit grid view by sorting, filtering, and grouping by columns. These actions are useful when
trying to quickly find records in the Audit Console. You can also add and remove columns and change the order in
which the columns display. The records are sorted by the date and time they are received. The most recent records
appear at the top of the window.

AuditId — A sequence number corresponding to the specific action occurrence.

AuditTime — The date and time the activity occurred.

AuditAction — The user's action.

UserLoggedOn — The date and time the user logged on.

UserLoggedOff — The date and time the user logged off.

ApplicationDisplayName — The name of the program that was being used.

UserName — The user name that performed the action. Actions that display without names were performed by
Nuance Output Manager services.

ObjectValue1 through ObjectValue4 — Action-specific information. For example, when adding a source, the source
name is displayed.

Filter options

The audit grid can contain many rows. To make the grid more useful and responsive, you can filter the audit records
that display. By default the audit grid displays audit actions that occurred in the last hour. The time period can be
increased up to a year.

You can also filter the grid using a custom query. Custom queries filter the grid based on the audit grid columns.

Status bar

Search — Searches the grid columns. To search, type the text you want to find in the search box, click the column
in the grid you want to search, and then press Enter or click the Search button. If the text is found, your focus will be
moved to the first occurrence. New buttons will appear near the Search box that allow you to stop searching, move to
the previous occurrence, and move to the next occurrence.

Print button — Prints the contents of the console window.

Query button — Displays the query tool for creating a custom query.

Help button — Displays help for the Audit Console. The Help window incorporates contents, index, search,
favorites, and glossary tabs to make it easy for you to find answers to your questions.
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Refresh Query button — Updates the Audit Console data.

Cancel Query Mode button — Cancels the current custom query.

Paging buttons — Allows for paging through the grid. Click the double left arrow button (<<) to go to the first page,
the left arrow button (<) to go to the previous page, the right arrow button (>) to go to the next page, and the double
right arrow button (>>) to go to the last page.

Records — Displays the number of records in the console window.

Library Settings tab
Use the Library settings tab to configure the Document Library destination. The Document Library destination was
created by default during installation, but you must select the library profile before it can be used. Once configured,
documents routed to this destination will be placed in the Nuance Output Manager Library application. You can use
the Library for long-term storage or to organize and present documents. You can access this tab when you configure
the library destination.

Click an option you want to learn more about.

• More settings tab (Destination Configuration) on page 506
• Error Handling tab (Destination Configuration) on page 499

Name

Specifies the name of the Library destination.

Server

Not available.

Comments

Lists any general comments about the destination.

Location

Specifies any specific location information for the destination.

Image

Displays a Library destination image. To change the destination image, click Select Image and choose the appropriate
image file (BMP, JPEG, or PNG). The selected image will be compressed and scaled to 96x96 pixels. Changing this
image will not change the smaller image that displays or the image that displays in the destination tree. To change the
image back to the default, click Reset Image.

Library profile

To be accepted into the Nuance Output Manager library, a document must be assigned a library profile. This profile
contains all of the settings needed to properly “file” the document. Documents sent to the library destination will be
assigned the selected profile. If a document was sent using a business rule with a library profile assigned, the business
rule library profile would be used.
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Select the appropriate library profile from the list. You can also click the Browse button to display the Manage
Document Library Profiles dialog box. From this dialog box, you can create, modify, and remove library profiles.

License Confirmation dialog box
Use this dialog box to review the Nuance Output Manager license information before installing.

Issued to

Displays the customer information for the installed Nuance Output Manager license.

Serial

Displays the serial number for the installed Nuance Output Manager license.

Order

Displays the order number for the installed Nuance Output Manager license.

License File Installation dialog box
Use this dialog box to install the Nuance Output Manager license. There are two methods:

• You can install the license using an Internet connection by entering the license key for this Nuance Output
Manager system.

• You can manually install the license using the license file.

Install License Automatically

To install the license automatically, you must have an active internet connection.

License key — Specifies the license key for your Nuance Output Manager system. During Nuance Output Manager
order processing an Nuance Output Manager license was created that matches the options ordered. The license key
was sent in an email to the ordering customer. If you cannot locate your license key, contact Nuance Communications,
Inc. Technical Support or Sales for assistance.

Install License Manually

License file — Specifies the name of your license file. Either type the path and file name or use the browse button (...)
to locate it.

Mail Server Search dialog box
Use this dialog box to locate a valid email server.

Domain

Specifies the domain you want to search for mail exchange servers. After entering the domain, click Locate  to
search the domain.



Output Manager Administration Guide
Version 4.0 SP2

563 © 2016 Nuance Communications, Inc. All rights reserved.

Mail exchange servers

Displays all exchange servers located on the specified domain.

Manage Billing Accounts Utility
Use Manage Billing Accounts to in the Administration application create lists of billing accounts. A billing list can
keep either descending or ascending balances. In the list properties you can also define whether a list keeps balances
for accounts and whether the balances are ascending or descending.

To open Manage Billing Accounts, either click Manage Billing Accounts in the Administration application, or
click Tools > Administration > Manage Billing Accounts.

Billing lists

In the Select primary billing list to display box, you can create billing lists and edit billing properties for any
existing list.

Option Description

Name Click a list to edit properties or accounts. Accounts are di
splayed for the currently selected list.

Description You can briefly describe the purpose of a billing list in t
his box.

New Click to create a billing list. Clicking this button opens th
e Billing List dialog box.

Edit Click to edit properties for a billing list. Clicking this but
ton opens the Billing List dialog box.

Remove Click to remove the currently displayed billing list. This
deletes the list and its accounts.

Import Click to import account information from a comma separ
ated values (CSV) file.

Accounts

The accounts table shows accounts that are defined in a billing list.

Column Description

Account Name Specifies the name for an account. Click in this column t
o edit the name for an account.

PIN Code Allows you to associate a pin code with an account. Clic
k this box to define a pin code for an account or to remov
e a pin code from an account.

Current balance Shows the current balance for an account with an ascend
ing balance. You can click to change this value. This col
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Column Description

umn only shows for an account with an ascending balan
ce.

Remaining balance Shows the current balance for an account with a declinin
g balance. You can click to change this value. This colu
mn only shows for an account with a declining balance.

Next refresh Show the date for the next refresh of the balance value. T
his column shows for any account with an ascending or d
eclining balance.

Initial balance Shows the balance at the beginning of an account refresh
period. You can click to change this period. The initial se
tting is the same as the default balance upon refresh valu
e for a billing list. This column only shows for an accoun
t with a declining balance.

Max allowed balance Shows the maximum allowed balance for an account wit
h an ascending balance. You can click to change value p
eriod. The initial setting is the same as the default maxim
um allowed value for a billing list with ascending balanc
es. This column only shows for an account with an ascen
ding balance.

Refresh period Shows the refresh period for an account. You can click t
o change this setting. The initial refresh period is the def
ault refresh period for a billing list. This column shows f
or any account with an ascending or declining balance.

The following commands are available by clicking buttons at the bottom of this form.

Option Description

Add secondary accounts Click an existing account and then click this button to ad
d secondary accounts under the selected account. After y
ou add the secondary account, enter the Account Name
and Pin Code just as you would for a primary account.

Remove selected accounts Click and existing account and then click this button rem
ove the account. For a primary account, this also remove
s any secondary accounts that have been added under it.

Billing List dialog box
Use this dialog box to configure the billing list options.

You can access this dialog box when you create a billing list from Administration - Manage Billing Accounts.

Billing list name

Specifies the billing list name.
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Description

Provides a description of the billing list.

Balance option

Specifies if accounts have a declining balance, an ascending balance, or if a balance is not kept for this billing list.
You can specify an ascending balance for postpaid accounts or a declining balance for prepaid accounts.

Balance refresh period

Specifies the default balance refresh period. Click the drop-down list button to specify properties for a refresh period.
You can specify that a balance is refreshed after a certain number of days or on a particular day of each week or
month. You can also specify a time for the refresh. When you are finished, click Apply.

You can configure the refresh period separately for any account in a billing list.

Balance upon refresh

Specifies the default balance amount upon refresh when defining a list that keeps accounts with a declining balance.
You can change this value for any account in a billing list.

Maximum allowed balance

Specifies the default maximum balance amount upon refresh when defining accounts with an ascending balance. You
can change this value for any account in a billing list.

Manage CsvDocProp Resources dialog box
This dialog box is used to manage CsvDocProp resources.

Resource grid

Lists all of the defined CsvDocProp resources.

Buttons

New button — Creates a new CsvDocProp resource. Opens the CsvDocProp Resource dialog box.

Edit button — Opens the selected CsvDocProp resource for modification. Opens the CsvDocProp Resource dialog
box.

Delete button — Deletes the selected CsvDocProp resource.

Import button — Allows for importing CsvDocProp resources.

Export button — Allows for exporting CsvDocProp resources.

Manage License Utility
Use this utility to install and manage the licenses for the Nuance Output Manager software. You do not manually enter
data in this window; the data is displayed by the utility.
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Before the software has been activated, all fields on the Manage License window are blank. After the license is
installed, all fields are populated. The license status below the grid shows if the license is activated or not. The
Nuance Output Manager components contained in the license are listed in the grid.

License key

Once the software has been activated, the license key for this Nuance Output Manager system displays.

License Wizard button

Displays the Nuance Output Manager License Wizard for activating or deactivating the Nuance Output Manager
license.

The following methods are available for installing and activating a license:

• Internet activation — The Internet method requires a computer with an Output Manager Console connected to
the Internet and the Output Manager Console communicating with the Nuance Output Manager DBM Service.
Both the installation and the activation occurs quickly and does not require a license file. This is the recommended
way to install and activate the Nuance Output Manager license.

• Manual activation — The manual method requires a license file accessible from an Output Manager Console
system.

The license can be upgraded. The upgraded license will install over the existing license using the same serial number
and different invoice number. This will automatically deactivate the old license.

Important:  Before deactivating a license, you must stop all Nuance Output Manager work. Currently,
deactivating a license will halt the Nuance Output Manager functionality on all systems.

Serial number

Specifies the serial number for your Nuance Output Manager system.

License Status

Indicates if the license is activated and displays the version number.

Customer

Displays the name and address of your company.

License grid

Description — Describes the product component.

Quantity — Indicates the number of licenses for a specific component.

Expires — Specifies the date that the license for a specific component ends. Dates are entered in the format yyyymmd
d.

Licensed Behavior — Determines the behavior of licensed Nuance Output Manager components. For each
component you can determine if the feature will be Hidden, Enabled, or Disabled.

Unlicensed Behavior — Determines the behavior of unlicensed Nuance Output Manager components. For each
component you can determine if the feature will be Hidden, Enabled, or Disabled.
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Refresh button

Updates the grid with any changes.

Manage Product Components Utility
Use the Manage Product Components administration application to view the Nuance Output Manager components
that are or have been installed and connected to this Nuance Output Manager database.

Grid

Displays all of the installed Nuance Output Manager components and their status, component type, and server.

Component column — Lists all supported components.

Status column — Indicates whether the component is active or stopped.

Component Type column — Specifies a component type of Client or Service.

Server column — Names the server on which the component is installed.

Domain column — Names the domain on which the component is installed.

Credentials column — Specifies the Microsoft Windows logon account for the component.

Monitored column — Indicates whether the component status is accounted for in the status light representing that
service type. The service status lights display to the right of the menu bar in the Output Manager Console. Move the
pointer over the lights to identify the service type and status. To control monitoring, select or clear the check boxes in
the Monitored column. Monitoring is available only for service components.

Note:  When a server is deauthorized, if an input on that server attempts to spool in documents, the DBM
rejects them and disables the input service. The DBM does not route documents to destinations on the
deauthorized server and disables the output service.

DBM Activation Status column — Indicates if the Nuance Output Manager DBM Service is activated. This column
will display Activated or Not Activated for DBM components, depending on the activation status.

Add server button

Option not available

Edit server button

Option not available

Remove server button

Option not available

Refresh button

Updates the list of installed components.
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Manage Profiles dialog box
Profiles are used in to configure many different Output Manger settings. This dialog provides a central place for
managing all Output Manager profiles.

Profiles are available to any Output Manager service running on any server. Two Output Manager Output Services
running on separate different servers can use the same profiles.

You can access this dialog box by click Tools > Profile Manager in the Output Manager Console. This dialog is also
launched to manage specific profile types from various configuration dialogs.

Option Description

Profile type This option displays the profile types. Once a profile typ
e is selected, all profiles of that type are displayed in the
grid. You can create and manage the profiles as necessar
y. The following are the available profile types.

• Advanced Costing — Used to associate costs with
specific printing material and options.

• Allowances — Used to restrict users to specific
printing and copying balances and how often they are
refreshed.

• Desktop Client — Used to configure how users may
interact with the Desktop Client.

• Device — Used to configure billing account prompts
that can occur before releasing jobs or at login.

• Document Library — Used to specify what library
folder to use when documents are sent to the
Document Library. Additionally, specifies the file
store, any notifications, and how long to keep the
documents before deleting.

• Document Owner Mapping — 
• Document Properties — Used to map header data to

Output Manager document properties. Only advanced
users and professional service engineers should
configure this.

• Error Handling — Used to specify what should
happen to destinations when an error is detected via
SNMP or during transmission of a document.

• Failover — Used to specify what should happen
to documents if they are sent to an inaccessible
destination. Included in the failover profiles is
the ability to pick alternate destinations where the
documents can be routed.

• Headers From Data — This profile consists of
information that Output Manager can extract from
specified locations within the actual document data.
This is used in conjunction with the Document
Properties Profile and only advanced users and
professional service engineers should configure this.
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• Job Parsing — This profile configures information
to be extracted from Postscript, PDF, and PCL
documents. This is used in conjunction with the
Document Properties Profile and only advanced users
and professional service engineers should configure
this.

• Job Status Mapping — Used to map job status
columns and values to known Output Manager
columns and values

• Job Ticket — These profiles contain information
about the document and/or how the document should
be treated. This profile is used in conjunction with
the Document Properties Profile and only advanced
users and professional service engineers should
configure this.

• MFP ACL — Used to specify what MFP
functionality is allowed.

• MFP Kiosk Preferences — Used to specify what
document properties are available on the kiosk and in
what order.

• Native Header — These profiles contain information
that arrives as part of the transmission protocol
used to receive documents. This profile is used in
conjunction with the Document Properties Profile
and only advanced users and professional service
engineers should configure this.

• Notification — Used to specify which events
generate notifications (document arrives, prints
successfully, prints on failover destination, or is in
error state), the type of notification for each event
(email or pop-up), the text of notifications for each
event, and who should get notified.

• Outbound Email — Used to configure how email
notifications are to connect to the email server, and
specify how the sender and Reply to address appears.
These profiles are used business rules, alert rules, and
in Notification Profiles.

• Output Process — Used to modify document data
while sending a document to a destination. An
output process contain a predefined set of actions
which impacts a document as it is being sent to a
destination. Examples include search and replace,
setting finishing options, inserting overlays, and
so on. Output processes can be associated with
destinations or documents. If associated with
a destination, any document being sent to the
respective destination goes through the process. If
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Option Description

associated with the document, the process is executed
no matter which destination the document goes to.

• Printer Family —  Output Manager includes printer
families. Printer family profiles are used to group
printers of the same type. These profiles can be
selected in Output Manager to have an action only
occur for the printers in that specific printer family.
This allows Output Manager to use printer specific
commands that are associated with our common
commands.

• Source Properties — Used to configure what print
preferences/document properties are supported
by AutoStore, Windows queues, and Web Upload
sources. You can also select the settings that are
allowed for a particular property. These settings
determine what is available to the user in the dialogs
where properties are configured for the source.

• User Print Rules — Used to configure restrictions
for users and groups based on the type of document
being printed. For example, precluding color printer,
or documents that exceed a certain number of pages.

• Windows Queue Print Rules — Used to configure
restrictions for Windows Queues based on the type
of document being printed. For example, precluding
color printer, or documents that exceed a certain
number of pages.

• Workstation Advanced Costing — Used to associate
costs with specific printing material and options for a
workstation.

Profiles grid Lists all of the defined profiles for the selected profile ty
pe.

• Profile Name column — Displays the name of the
profile.

• Description column — Displays a description of the
profile.

New Click this button to create a new profile. The dialog box t
hat opens varies depending on the selected profile type:

• Advanced Costing  Profile
• Allowances Profile
• Desktop Client Profile
• Device Profile
• Document Library  Profile
• Document Owner Mapping  Profile
• Document Properties Profile
• Error Handling Profile
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• Failover  Profile
• Headers From Data Profile
• Job Parsing Profile
• Job Status Mapping Profile
• Job Ticket Profile
• MFP ACL Profile
• MFP Kiosk  Profile
• Native Header Profile
• Notification Profile
• Outbound Email Profile
• Output Process Profile
• Printer Family Profile
• Source Properties Profile
• User Print Rules Profile
• Windows Queue Print Rules Profile
• Workstation Advanced Costing Profile

Edit Click this button to open the selected profile for modifica
tion. The dialog box that opens varies depending on the s
elected profile type.

Delete Click this button to delete the selected profile. This is on
ly enabled if the selected profile is not a system (or defau
lt) profile.

Rename Click this button to rename the selected profile. This is o
nly enabled if the selected profile is not a system (or def
ault) profile.

Copy Click this button to create a copy of the selected profile a
nd adds it to the Profiles grid.

Import Click this button to import a profile. The file must be a p
reviously exported Output Manager profile in XML form
at.

Export Click this button to export a profile. Exported profile file
s contain the profile name, type, description, and the prof
ile data in an XML format. The exported profiles can be i
mported into another Output Manager

Manage Resources dialog box
Use this dialog box to manage output process resources of a selected type (Banner, Binary, CpMillUnitLibrary,
CPMillProfile, CsvDocProp, FCB, Ini, PrinterControlFile, Text). You can access this dialog when you configure the
action parameter in the Action Configuration pane of the Process Designer.
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Resource list The table lists currently defined resources for the selecte
d resource type. Columns in the table show the current se
ttings for a resource:

• Resource Name — Displays the name of the
resource.

• Resource Description — Displays a description of
the resource.

• Resource Comments — Displays any additional
comments about the resource.

• Data Type — Displays the data types associated with
the resource.

• Printer Family — Displays the printer families
associated with the resource.

New Click this button to create a new resource. The dialog bo
x that opens varies depending on the selected resource ty
pe.

• CpMillUnitLibrary — Opens the Configure Unit
Library dialog box.

• CPMillProfile — Opens the Configure Filter Profile
dialog box.

• Banner — Opens the Create Banner Resource
dialog box.

• PrinterControlFile — Opens the Create
PrinterControlFile Resource dialog box.

• FCB — Opens the Create FCB Resource dialog
box.

• CsvDocProp — Opens the Create CsvDocProp
Resource dialog box.

• Binary — Opens the Create Binary Resource dialog
box.

• Text — Opens the Create Text Resource dialog box.
• Ini — Opens the Create Ini Resource dialog box.

Edit Click this button to open the selected resource for mod
ification. This opens the Edit Resource (or Configure
Resource for CpMill resources) dialog box, which allow
s you to edit options for the selected resource type.

Delete Click this button to delete the selected resource.

Import Click this button to import a resource. The file must be a
previously exported Nuance Output Manager resource in
XML format.

Export Click this button to export the currently selected resourc
e to an XML export file. Exported resources can then be
imported into Nuance Output Manager. The XML marku



Output Manager Administration Guide
Version 4.0 SP2

573 © 2016 Nuance Communications, Inc. All rights reserved.

Option Description

p construct consists of name/value pairs that correspond t
o property settings for a resource. For example:

<?xml version="1.0"?>
<EomResource>
  <ResourceName ResourceName="resour
ce_name" />
  <ResourceDescription ResourceDescr
iption="resource_description" />
  <ResourceComments ResourceComments
="optional_comments" />
  <ResourceType ResourceType="Printe
rControlFile" />
  <ResourceXML ResourceXML="Unicode
 (UTF-8)" />
  <ResourcePrinterFamily PrinterFami
ly="101" />
  <ResourceDataType ResourceDataType
="999" /><![CDATA[printer]]></EomRes
ource>

Manage Devices Utility
Use the Administration application Manage Devices to configure and manage each Nuance Output Manager SNMP
Service. You can determine how frequently the Nuance Output Manager SNMP Service will update Nuance Output
Manager destinations that are auto-detected SNMP printers.

SNMP services

The SNMP services grid lists all of the servers with the Nuance Output Manager SNMP Service installed and the
configuration parameters for each service. From this grid you configure how often the Nuance Output Manager
SNMP Service will update Nuance Output Manager destinations that are auto-detected SNMP printers. The SNMP
update has two types of values, dynamic and static, each with their own frequency setting.

Note:  The Last Dynamic Update and Last Static Update columns will always display recent values
because the printer is being checked for alert status. This occurs even if dynamic and static updates are
disabled during configuration.

Configure button — Configures the selected SNMP server. This opens the SNMP Server Configuration dialog box.

Detect devices button — Starts the autodetection process for each selected SNMP server. The Autodetected Devices
grid will update to list any newly detected printers. Note, a printer may be listed multiple times, once from each server
where auto-detection was run.

Detect readers button — Opens the Detect readers dialog box to search for Ethernet Card Readers for each selected
SNMP server.

Autodetected devices

The Autodetection Devices grid lists all of the previously detected devices. Notice there are five tabs below the grid,
Unused devices, OM devices, Ignored devices, All devices, and Merged devices.
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Unused devices tab — Lists all of the devices that have not been promoted as Nuance Output Manager devices.

• Update button — Updates the selected Nuance Output Manager devices.
• Promote to OM button — Promotes the selected devices to Nuance Output Manager Devices and optionally

creates new Nuance Output Manager destinations. You can choose from the following destination types: IPP, LPR,
and socket. These printers are moved to the OM devices tab.

• Ignore button — Ignores the selected devices. This will move the selected devices to the Ignored devices tab.
• Delete button — Deletes the selected devices. This will remove the devices from the Manage SNMP Utility.

OM devices tab — Lists all of the devices that have been added as Nuance Output Manager socket or Nuance Output
Manager LPR destinations.

• Update button — Updates the selected Nuance Output Manager devices.
• Merge button — Allows for merging multiple Nuance Output Manager devices into a single Nuance Output

Manager device. You will select the main device from the Merge Devices dialog box. This is the device that will
display after the merge.

• Demote button — Removes the device from the Nuance Output Manager devices tab and places it back on the
Unused devices tab.

Ignored devices tab — Lists all of the devices that have been ignored on the Unused devices tab.

• Update button — Updates the selected Nuance Output Manager devices.
• Restore button  — Restores the selected devices to the Unused devices tab.
• Delete button — Deletes the selected devices. This will remove the devices from the Manage Devices Utility.

All Devices tab — Lists all of the SNMP devices.

• Update button — Updates the selected Nuance Output Manager devices.
• Delete button — Deletes the selected devices. This will remove the devices from the Manage Devices Utility.

Merged devices tab — Lists all of the merged Nuance Output Manager devices.

• Update button — Updates the selected Nuance Output Manager devices.
• Unmerge button — Unmerges the selected devices.
• Delete button — Deletes the selected devices. This will remove the devices from the Manage Devices Utility.

Manage Windows Queue Quota Profiles dialog box
Nuance Output Manager includes quota management for Windows queues. Quota management is used to set up
restrictions based on the document properties. Examples include disallowing color printing, requiring documents to
be duplex, disabling print from certain applications, and so on. Use this dialog box to manage Windows queue quota
profiles.

Profiles

Lists all of the defined Windows queues quota profiles. The Default profile can be edited and copied, but cannot be
deleted.

Buttons

New button — Creates a new Windows queue quota profile. Displays the Windows Queue Quota Profile dialog box.
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Edit button — Opens the selected Windows queue profile for modification.  Displays the Windows Queue Quota
Profile dialog box for basic profiles. If the profile was converted to an advanced profile, the Windows Queue Quota
Rules Manager dialog box displays.

Delete button — Deletes the selected Windows queue quota profile.

Rename button — Allows for renaming the selected Windows queue quota profile. You will type the new name
directly in the grid.

Copy button — Creates a copy of the selected profile. The new profile will be named "Copy of profile_name".

Import button — Allows for importing Windows queue quota profiles.

Export button — Allows for exporting Windows queue quota profiles.

Manage Windows Queues Utility
Use the Manage Windows Queues utility to assign quota management profiles to Windows queues on servers and to
assign quota management profiles and printing costs to Windows queues on workstations.

This utility is opened in the Output Manager Console by clicking Applications > Administration > Manage
Windows Queues. Options are configured on the Server tab for Windows queues on servers and on the on the
Workstation tab for Windows queues on workstations.

Tab Description

Server tab on page 575 Use this tab in the Manage Windows Queues utility to
assign quota management profiles to server Windows
queues.

Workstation tab on page 576 Use this tab in the Manage Windows Queues utility to
assign quota management profiles and printing costs to
workstation Windows queues.

Server tab
Use this tab in the Manage Windows Queues utility to assign quota management profiles to server Windows queues.

A server queue is a Windows queue that has been converted into a Nuance Output Manager source. Server queues use
the Output Manager Output Service so that the data is received into the Nuance Output Manager spool.

Quota management profiles can be configured to set up restrictions based on document properties. Examples include
disallowing color printing, requiring documents to be duplex, disabling print from certain applications, and so on.

Windows queues grid

Use this grid to assign quota profiles to server Windows queues.

Server Name — Displays the server name where the source (Windows queue) is located. By default the grid is
grouped by the server name. This allows you to easily view all queues for a server. You can remove grouping by right
clicking in the group panel and selecting Clear Grouping.

Source/Windows Queue — Displays the source (Windows queue) name.

Source Group — Displays the group that contains the source.
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Quota Profile — Specifies the quota management profile assigned to this source (Windows queue). The quota profile
sets up restrictions based on the type of document, for example, disallowing color printing, requiring documents to
be duplex, disabling print from certain applications, and so on. To select a profile, click in the cell and select a profile
from the list. To manage profiles, click the Browse button to display the Manage Windows Queue Quota Profiles
dialog box.

Refresh button

Updates the grid with any changes.

Workstation tab
Use this tab in the Manage Windows Queues utility to assign quota management profiles and printing costs to
workstation Windows queues.

A workstation queue is a Windows printer that is not a Nuance Output Manager source (for example, a USB attached
printer on an end user's workstation). The data is not received into Nuance Output Manager, but print jobs can be
tracked by the Output Manager Desktop Client for billing purposes.

Quota management profiles can be configured to set up restrictions based on document properties. Examples include
disallowing color printing, requiring documents to be duplex, disabling print from certain applications, and so on.

Windows queues grid

Use this grid to assign quota profiles and printing costs to external Windows queues.

Server Name — Displays the server name where the source (Windows queue) is located. By default the grid is
grouped by the server name. This allows you to easily view all queues for a server. You can remove grouping by right
clicking in the group panel and selecting Clear Grouping.

Source/Windows Queue — Displays the source (Windows queue) name.

Source Group — Displays the group that contains the source.

Quota Profile — Specifies the quota management profile assigned to this source (Windows queue). The quota profile
sets up restrictions based on the type of document, for example, disallowing color printing, requiring documents
to be duplex, disabling print from certain applications, and so on. To select a profile, click in the cell and select a
profile from the list. To manage profiles, click the browse button (...) to display the Manage Windows Queue Quota
Profiles dialog box.

Cost per Page (B&W) — Sets the printing cost per page for black and white documents.

Cost per Page (Color) — Sets the printing cost per page for color documents.

Do not track — Specifies that you do not want to track jobs from the Windows queue.

Refresh button

Updates the grid with any changes.

Merge Package dialog box
Use this dialog box to configure a merge package ad hoc rule action. You can access this dialog when you configure
the action from the Ad Hoc Rule dialog box or when you create and run the action against documents in the
Documents grid.
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Transform

Click the Configure button to configure the transform. The Configure Transform dialog box displays.

Package boundaries

Specifies the boundary fields for the merged document. Boundary fields are only applicable when a merged document
will exceed the maximum number of exceptions (currently set at 1000). Merged documents that exceed the exception
count will be split into separate documents. Boundary fields are used to control where the merged documents will be
split. Each split will be on a boundary that maximizes the number of pages without exceeding the exception threshold.
If you do not specify boundary fields, the split is arbitrary and will occur where the maximum number of pages can be
fit.

Click Configure to select the fields from the Package Boundary Fields dialog box.

Merged Document Properties

Determine if you want to use the document properties from the first page in the documents or the last page in the
documents. You cannot select custom properties.

Exception fields

Specifies the exception fields for the merged document. Exception fields specify which document properties to
preserve on a per-page basis in the merged document. The document properties will be analyzed to determine the
baseline and the exceptions (page overrides).

Click Configure to select the fields from the Exception Fields dialog box.

Add blank pages for duplexing

Specifies if you need to add blank pages to the merged document for duplexing purposes. This will cause documents
to always start on an odd page number.

Original documents

Determines what will happen to the original documents after the merged file has been created. You can leave them in
the spooler, move them to retain, or delete them.

MFP Kiosk Preferences Profile dialog box
This dialog box creates or edits a profile for a kiosk and specifies items that are available in the kiosk.

Option Description

Name Specifies the name for the profile.

Description Provides space to describe the purpose of the kiosk.

Available items Lists items that are available to add to the kiosk. The ite
ms shown here depend on the device features and option
s.
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Expand a category to view available items. Select or
clear the check box next to an item to add or remove it in
the Selected items box.

Selected items Displays a flat list of items that are currently selected in t
he Available items box.

The order shown here is the same that will show in the
kiosk. To change the order, select an item and click
Move up or Move down.

Modify Document dialog box
Use this dialog box to define the settings that modify a document for a business rule action or an Advanced Document
Modification (ADM) output process action.

You can access the dialog box through the New Business Rule dialog box when you configure the Modify Document
Contents action for Advanced Document Modification. You can also acccess the dialog box through the Process
Designer when you configure the Advanced Document Modification output process action.

Tab options

Options in this dialog box are grouped on the tabs described in the following table:

Tab Description

Configuration tab on page 482 Use this tab to configure Advanced Document
Modification settings for business rules and output
process actions.

Document Properties tab (Modify Document) on page
579

Use this tab to configure the document properties during
Advanced Document Modification for a business rule.

Configuration tab
Use this tab to configure Advanced Document Modification settings for business rules and output process actions.

In Advanced Document Modification, each page of the document is read, portions of the document can be changed or
values extracted, and then the page is written. Documents can be reordered, split, transformed to a different data type,
barcodes added, OMR marks added, and logos changed using ADM. ADM can be executed in a business rule action
or in the output process.

Server configuration

Server — Specifies the licensed transform server that you would like to use.

Transform package — Specifies the transform package. You can select a transform package from the list or click
New to create one. You can also select a transform package and modify or remove it.

Additional parameters — Specifies any additional parameters needed for the document modification software.
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Override input filter profile assigned to document — Determines if you want to use the filter profile assigned to
the document or if you want to use the filter profile configured in the transform package. Select the check box to use
the filter profile in the transform package.

Unit library configuration

Unit library — Unit libraries are JavaScript modules that CpMill calls at certain known times while processing
a document (for example, begin document, page start, or page end). The modules can modify the contents of the
document, extract information from the document, write the document, or parts of it, to a new location, or perform
many other operations.

• New button — Creates a unit library from the Configure Unit Library dialog box.
• Modify button — Modifies the selected unit library.
• Remove button — Deletes the selected unit library.

Unit library will create:

Important:  This option is only available when configuring ADM actions for business rules.

• the same document — Select if your unit library is modifying the input document and writing it to the same
location. See the default comments in unit library for how to tell Nuance Output Manager the names of the new
documents that are created.

• different documents — Select if your unit library is modifying the current document and outputting it into a new
document, or if your unit library is bursting the document into many different documents. See default comments in
unit library for how to tell Nuance Output Manager the names of the new documents that are created

• multiple documents combined into one — Currently not available.

Follow on actions

Input document — Specifies the follow on actions for the input document (original document). You can choose to
delete, retain, or process the next rule for the original document. The newly created documents (output documents)
continue with the next rule action.

Important:  Follow on actions are only available when configuring ADM actions for business rules.

Document Properties tab (Modify Document)
Use this tab to configure the document properties during Advanced Document Modification for a business rule.

Properties grid

Configure the document properties by clicking directly in the grid.

Document Property column — Lists the property values that can be configured. The properties are grouped into the
following categories: Basic options, Media selection, Document, Image adjustments, Finishing, and Other properties.
To expand a category, click the down arrow next to a category name. To collapse a category, click the up arrow.

Under each category are the print preferences/document properties that belong to that group. The first node level in
the categories determine the print preferences for the properties it contains. On the print preference node, you select
how the property should be applied when a document is sent to a destination. Under each print preference are the
parameters needed to generate that print preference.

Mode column — Specifies how to apply the property value. Click in the cell and choose one of the following options:
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• Always Apply — Always applies the specified property value. Nuance Output Manager will add commands to the
print stream to enforce the print preference. If the document already contains commands for that print preference,
Nuance Output Manager will modify the commands to work with the printer family where the document is being
sent.

• Apply Conditionally — Applies the property value conditionally. Nuance Output Manager will only add or
modify commands for the print preference when the printer family that the document is destined for is different
from the printer family the document was originally designed for.

• Informational Only — Nuance Output Manager makes no changes to the print stream when the document is sent
to the destination. The value is for informational purposes only.

• Value Not Set — No value is set for the property.

Value column — Specifies the document property value. Click directly in the cell to change the value. You can use
functions to insert and extract data as necessary.

Native Headers tab
Use the Native Headers tab to configure native header profiles. Native headers contain information that arrives as
part of the transmission protocol that is used to receive documents.

Click an option you want to learn more about.

• Document Property Mappings tab on page 541
• Document Owner Mapping tab on page 537

Name

Specifies the name of the native header profile.

Description

Specifies a description of the native header profile.

Select the OM device types whose headers should be available for mapping

Specifies the native headers that are available for mapping. The selected native headers will be available on the
Document property mappings tab and the Document owner mapping tab.

• Email
• FTP
• LPD
• Network folder
• Socket
• WebSphere MQ
• Windows queue  
• BEPS devices (NJE, RJE, Print Channel, and so on)

New Device dialog box
Use this dialog box to add a new device to the Devices application.
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Name

Specifies the device name.

Server

Specifies the Nuance Output Manager server where the Nuance Output Manager Output Service is located for this
device.

IP Address

Specifies the IP address of the device you are adding.

Notification Profile dialog box
Nuance Output Manager allows you to send notifications when specific events occur in the document life cycle.
Notifications are sent according to defined notification profiles. Notification profiles specify which events generate
notifications (document arrives, prints successfully, prints on failover destination, or is in error state), the type of
notification for each event (email or pop-up), the text of notifications for each event, and who should get notified. For
example, you can configure a pop-up to display after a document prints successfully. Use this dialog box to create and
configure notification profiles.

You can access this dialog box when you configure a source, create a business rule with a notification profile, or
assign a notification profile in the Documents grid.

Name

Specifies the notification profile name.

Description

Specifies a description of the notification profile.

Email profile

Specifies the email profile that will be used with email notifications within this profile. You can select an email profile
from the list or click the Browse button and mange profiles in the Manage Outbound Email Profiles dialog box.
From this dialog box you can create and modify email profiles using the Outbound Email Profile dialog box.

Notifications grid

Configures the notifications that will be sent. Click directly in the grid to configure the notification.

When the document — Specifies when a notification will be sent. You can choose to send a notification when a
document Arrives, Prints Successfully, Prints on Failover Destination, or Is In Error State.

Send notification via — Specifies how the notification will be sent and displayed. You can send notifications using
the Tray Client Popup or as an Email Message.

Notify owner — Determines if the document owner will be sent a notification.

Recipients — Specifies the who will receive the notification. Click the browse button (...) to select users and groups
in the User and Group Selection dialog box. If the user or group you want is not listed, click More Users to search
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for additional users. See the Adding users and groups to Nuance Output Manager  topic for detailed procedures on
adding users.

Message — Specifies the notification text. By default text is provided specific to each notification type. You can
click the grid cell to make any text changes. The message can consist of text, one or more document properties, and
functions.

To insert document properties, right-click in the text box, click Insert Document Property, and choose the
appropriate properties. The document properties will display enclosed in brackets ([]). This allows notifications to
contain text relevant to the specific document that is generating the notification.

To insert functions, right-click in the box, click Insert Function, and choose the appropriate function. Review the
Using Nuance Output Manager Functions help topic for information on configuring functions.

Add/Remove buttons

Adds and removes notifications in the Notifications grid.

OM Group dialog box
Use this dialog box to add Nuance Output Manager groups to Nuance Output Manager. Once the groups are added,
quotas can be assigned to the group as needed. Once quotas are assigned to a group, all members of the group will be
assigned the quota. You can override the group quota assignment by adjusting the individual Nuance Output Manager
users settings on the Users tab in the Manage Users utility. You can access this dialog box when configuring group
quotas from the Groups tab.

Group name

Specifies the Nuance Output Manager group name.

Email address

Specifies the email address of the group.

Select the users you want to add to the group

Displays all of the Nuance Output Manager users. Select the check box column for the users you want to add to this
group and click the right arrow (>) button. This moves the selected users into the Group members grid.

Arrow buttons

Right arrow (>) button — Moves the selected users into the Group members grid.

Double right arrow (>>) button — Moves all users into the Group members grid.

Left arrow (<) button — Removes the selected users from the group and places them back in the Select users grid.

Double left arrow (<<) button  — Removes all users from the group and places them back in the Select users grid.

Group members

Displays the users that are a member of the group. To remove users from the group, select the check box column for
the appropriate users and click the left arrow (<) button. This moves the selected users back into the into the Select
users grid.
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OM Server Configuration Utility
Use this utility to configure services, security, SSL certificates for the Output Manager server.

The Output Manager Server Configuration Utility is opened from the Windows desktop by clicking Start > All
Programs > Output Manager > Output Manager Server > OM Server Configuration. Configure options on the
following tabs:

Tab Description

Output Manager services configuration Use this tab to manage Nuance Output Manager services.

Output Manager security administration Use this tab to configure Nuance Output Manager
administrators.

SSL Certificate Manager Use this tab to configure SSL certificates and bind them
to ports for selected web services on Output Manager
server.

Output Manager Services Configuration tab
Use this tab to manage Nuance Output Manager services.

You will use this tab when installing and removing the Nuance Output Manager software. You can access this utility
by clicking Start > All Programs > NSi > NSi Output Manager Server > OM Server Configuration.

Click on the option to learn more about it.

• OM Security Administration tab on page 585
• SSL Certificate Manager tab on page 585

High availability options

Use HA — Select to use the physical Nuance Output Manager server in a high availability configuration. In a high
availability configuration, multiple back-end physical Nuance Output Manager servers function as a single logical
Nuance Output Manager server that receives client requests through a load balancer.

HA name — Specifies the name of the single logical Nuance Output Manager server. The load balancer physical
server can use this name as a DNS alias to facilitate communication between clients and the single logical Nuance
Output Manager server.

OM DBM Configuration

Displays the configuration for the Nuance Output Manager DBM Service. There can be only one Nuance Output
Manager DBM Service per server. Configure the service by clicking in the column cells.

Use SQL Server Express LocalDB — Configures the DBM Service to connect to the local instance of SQL Server
Express.

Use MultiSubnetFailover — For implementations that have SQL Server multi-subnet failover cluster configurations,
select this option to configure the DBM Service to connect to the availability group listener of a SQL Server 2012
(or later) availability group or a SQL Server 2012 (or later) Failover Cluster Instance. Refer to Microsoft SQL Server
Help for more information on multi-subnet failover clustering.



Output Manager Administration Guide
Version 4.0 SP2

584 © 2016 Nuance Communications, Inc. All rights reserved.

Failover partner — Specifies the principal or mirror SQL Server instance to which the DBM Service connects.
The instance acts as a role-switching partner for a mirrored database. Refer to Microsoft SQL Server Help for more
information on database mirroring and failover partners.

SQL Server Instance column — Specifies the SQL Server\Instance.

SQL Authentication Type column — Specifies the SQL authentication type. You can select SQL or Windows.
Selecting SQL displays the Specify SQL User dialog box where you enter an SQL authenticated user name and
password.

Database Name column — Specifies the Nuance Output Manager database.

Service Logon Credentials column — Specifies how the service will log on. You can decide if it will log on as a
local system account or you can enter a specific account. Use Local System Account if the DBM will communicate
with the local SQL database, local Nuance Output Manager services, and local file resources. All other cases use a
Windows Service account for the log on. In most cases, you will choose This account and select the service logon
account. Selecting an account will require you to complete the password boxes.

Status column — Displays the status of the Nuance Output Manager DBM Service.

OM Service Configuration

Service column — Displays the Nuance Output Manager Input Service, Nuance Output Manager Output Service,
Nuance Output Manager SNMP Service, and the Nuance Output Manager Rules Agent Service. Configure the
services by clicking in the Selected column and then the other column cells.

OM DBM Host Name column — Specifies the name of the computer that is running the Output Manager DBM
Service. You will need to select the domain and computer.

If you selected Use HA and specified a high availability configuration name for HA name, you cannot change the
OM DBM Host Name values for the Output Service and the Rules Agent Service because those services use the high
availability DBM server.

Service Logon Credentials column — Specifies how the service will log on. You can decide if it will log on as a
local system account or you can enter a specific account. Use Local System Account if the DBM will communicate
with the local SQL database, local Nuance Output Manager services, and local file resources. All other cases use a
Windows Service account for the log on. In most cases, you will choose This account and select the service logon
account. Selecting an account will require you to complete the password boxes.

Status column — Displays the status of each Nuance Output Manager service.

Protocol column — Displays the protocol for the connection between the Output Manager service and the DBM
Service.

Select all services

Selects all services listed in the grid.

Start Selected Service button

Starts all selected services.

Stop Selected Service button

Stops all selected services.
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OM Security Administration tab
Use this tab to configure Nuance Output Manager administrators.

When installing the Nuance Output Manager software, you can use this tab to add users that will have full
administrative rights to the Output Manager Console. These users must be a member of the Administrative group
on the server and have administrative rights to the database. It is important to remember that the users added
here will have unrestricted rights to Start > All Programs > NSi > NSi Output Manager Server > OM Server
Configuration

Click on the option to learn more about it.

• Output Manager Services Configuration tab on page 583

Initialize Security Configuration

SQL Server\Instance — Specifies the SQL Server\Instance name.

Database — Specifies the database name.

Authentication — Specifies if you will use Windows authentication or SQL Server authentication. If you select SQL
Server authentication, you will need to enter the appropriate Login and Password.

Connect button — Connects to the specified database. The connection status will display in the text box.

Users and Groups

Lists users with unrestricted rights to Nuance Output Manager. These users must be a member of the Administrative
group on the server and have administrative rights to the database. It is important to remember that the users added
here will have unrestricted rights to Nuance Output Manager.

Add button — Adds users that will have full administrative rights to the Output Manager Console. Users are selected
from the Users and Groups dialog that is displayed.

Add Current User — Adds the currently signed in user to list. The user will have full administrative rights to the
Output Manager Console.

Remove button — Removes the selected user.

SSL Certificate Manager tab
Use this tab to configure SSL certificates and bind them to ports for selected web services on Output Manager server.

Use this tab to create and assign certificates and bind ports to enable SSL on selected web servers on an Output
Management server

Option Description

Choose Certificate Specifies a certificate to use for configuring SSL. To cre
ate a new certificate, choose <New self signed...> and en
ter a password in the Certificate Password box. To bro
wse for an existing certificate, choose the <browse>, and
in the Open dialog box, find an existing certificate (.pfx)
file. You can click the browse button (...) to specify or cr
eate a folder location.

Certificate Name Show the name of a specified certificate.
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Option Description

Certificate Password Type the password for a certificate in this box. When yo
u are creating a new certificate you will need to retype th
e password in the Confirm Password box.

Output manager service ports Allows you to select a port number for binding or unbind
ing a port to a server.

Web service ports Configures certificate assignments and binding for a part
icular web service specified by the Service Key.

Generate Click to generate a new certificate.

Assign Click to assign a certificate to a selected Service Key.

Un-assign Click to unassign a certificate from a selected Service
Key.

OM User dialog box
Use this dialog box to add Nuance Output Manager users to the Nuance Output Manager database. Once the users are
in the database, permissions can be assigned as needed. You can access this dialog box by clicking the More Users
button and selecting Add OM User on the User and Group Selection dialog box or Users tab.

User name

Specifies the user name that will be used when logging in to the server.

Full name

Specifies the user's complete name. This is the name that will display on the User and Group Selection dialog box.

Password

Specifies the user password that will be used when logging in to the server.

Confirm password

Confirms the password entered in the Password box.

Email address

Specifies the email address of the user.

Department

Specifies if the user is a member of a department. You can select one of the departments in the list, or click New to
create a department from the Department dialog box.
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User must change password at next logon

Allows you to require the user to change the password at the next logon. If selected, the user will be prompted to enter
a new password.

Password never expires

Allows you to determine if the password for this user will expire.

Account is disabled

Allows you to disable this account.

Opening Windows Utilities
Several Windows utilities are used to configure and manage Nuance Output Manager. The method of displaying the
utility may vary depending on your operating system.

• Open the Add Printer Wizard
• Open the Event Viewer
• Open Microsoft SNA Manager
• Open the Network utility
• Open the devices utility
• Open the Windows Printers folder
• Open the Services utility
• Open the user utility
• Open Windows Explorer
• Open Windows Notepad
• Open the Add or Remove Programs

Opening the Add Printer Wizard

You need to define Windows printers to use with Nuance Output Manager. Windows printers are defined with the
Windows Add Printer wizard.

• On the Windows taskbar, click Start > Printers & Faxes. Under Printer Tasks, click Add a printer, or right-
click in the window and click Add Printer.

Opening the Event Viewer

The Event Viewer maintains logs about programs, security, and systems events on your computer. With Event Viewer,
you can troubleshoot various hardware and software problems.

• On the Windows taskbar, click Start > Control Panel > Administrative Tools Event Viewer.

Opening Microsoft SNA Manager

For SNA Server • On the Windows taskbar, click Start > Programs >
Microsoft SNA Server > Manager.
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For the Host Integration Server • On the Windows taskbar, click Start > Programs >
Host Integration Server > Manager.

Opening the Network utility

The Network utility configures network hardware and software.

• On the Windows taskbar, click Start > Control Panel > Network Connections.

Opening the Devices Utility

The devices utility starts and stops device drivers.

• On the Windows taskbar, click Start > Control Panel > System.

This opens the System Properties dialog box. On the Hardware tab click Device Manager. If you need additional
instructions, refer to the Microsoft device manager Help.

Opening the Windows Printers folder

You need to define Windows printers to use with Nuance Output Manager. The printers consist of a port and a device
driver, which can be configured in the Printers folder.

• On the Windows taskbar, click Start Printers and Faxes.

Opening the Services utility

Output Manager Print Server implements several services that run under Microsoft Windows. Starting and stopping
these services is an essential part of operating the Output Manager Print Server. Use one of the following methods to
open the Services utility.

• On the Windows taskbar, click Start > Control Panel > Administrative Tools > Component Services. In the
Console Root tree, click Services.

Opening the user utility

You can use the user utility to assign individual users to a group account. The user utility is a Windows program that
is used to create and manage user accounts, create and manage groups, and manage security policies.

1. On the Windows taskbar, click Start > Control Panel > User Accounts.
2. In the User Accounts dialog box, click Advanced on the Advanced tab to access Local Users and Groups.

Opening Windows Explorer

Windows Explorer displays the hierarchical structure of files, folders, and drives on your computer. You can use
Windows Explorer for tasks such as copying, moving, and deleting files.

• On the Windows taskbar, click Start > All Programs > Accessories > Windows Explorer.

Opening Windows Notepad

Windows Notepad creates and edits text files using basic text formatting. You can use Notepad to edit files.

• On the taskbar, click Start > All Programs > Accessories > Notepad.
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Opening the Add or Remove Programs

The Add or Remove Programs utility adds and removes software on your computer.

• On the Windows taskbar, click Start > Control Panel > Add or Remove Programs.

Organizational Units Container Specification dialog box
After you have specified an LDAP server, you must specify the Organizational Unit (OU) container to search. You
will choose users, groups, or both users and groups to import from this container.

Container for groups

Specifies the Distinguished Name (DN) of the LDAP container from which to import groups.

Group object class

Specifies the object class within the container from which to import groups. The administrator can click the arrow in
the box to choose a value or enter another value.

Container for users

Specifies the Distinguished Name (DN) of the LDAP container from which to import users.

Outbound Email Profile dialog box
This dialog box is used when you create business rules or alert rules that will send an email message. Use this dialog
box to create and configure email profiles.

Name

Specifies the name of the email profile.

Description

Specifies a description of the email profile.

Configuration settings

Email server — Specifies the mail exchange server. You can type in the box or click the Browse button to display the
Mail Server Search dialog box and search for one on a given domain.

Port — Specifies the POP3 port number. Port numbers may be different based on the email application that was used
to set up the email account. The default port number is 25.

Log into server check box — Determines if you want to log in to the server. When this option is selected the User
name, Password, and Confirm password boxes are available.

User name — Specifies the user name that will be used when logging in to the server.

Password — Specifies the user password that will be used when logging in to the server.

Confirm password — Confirms the password entered in the Password box.
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Connection security — Specifies the type of connection security to use. You can choose None, Auto, TLS, or SSL.

From address — Specifies the email address that will be shown as the sender.

Reply to address — Specifies the email address where replies will be routed.

Output Options tab
Use this tab to configure transform output options. These options will be applied when writing the file (output).
Typically these options should be left at the default settings.

You can access this dialog box when you configure a transform action for business rules, ad hoc rules, or output
processes, or when configuring an IPDS destination.

Notice:  Please note that the IPDS output option is not available for new sales.

Note:  Most text fields allow document properties to be entered, using a right click menu. The document
properties are converted to the current document property values when the transform is executed.

Click an option you want to learn more about.

• Input Options tab on page 553
• Page Layout tab on page 595
• PDF Output tab on page 596

General output options

• Convert to image — Converts each page to an image on output.
• Copy comments — Copies the comments stored in the input file.

Note:  It is not guaranteed that all of the comments specified in the input file can be copied to the output file.
For example, TIFF files accept only one comment.

• Replace patterns with grayscale — Replaces fill patterns with grayscale to reduce the file size and improve
appearance in some cases, for example, when input and output files have different resolutions and the fill patterns
would have to be rendered to images otherwise.

• No binary copy — Disables binary copying. This should be set with same-to-same transforms that need to adjust
the pages in the document.

• Convert to grayscale — Converts color documents to black and white documents.
• Add empty blank page for duplex — Adds an empty page at the end of the input document, if the page number

is odd.
• Complete duplex — Generates the output file using duplex.
• Delete duplicate items on page — Deletes any duplicate items on the page.
• Suppress blank pages in output file — Removes all blank pages from the output file. This is useful when

converting duplex documents into PDF for viewing.
• Send duplicate images as overlays — Decreases the file size by sending repeated images as overlay files, which

are called as needed, rather than including the entire image each time.
• Embed fonts based on profile — Embeds fonts in the output file according to profile specification.
• Adjust overlay size — Adjusts the size of the overlay to the size of the overlay contents.
• Obfuscate text — Changes the text to be unreadable when writing the page (output). This is helpful if you are

dealing with sensitive customer documents. Obfuscate does not work for documents where the text is stored in a
custom encoding or as part of an image.
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• Merge overlapping font subsets — Minimizes the number of fonts used in a document by merging overlapping
subsets into a single font.

Remove

Specifies the items you want to be removed on output.

Page count for PPML page flush

Specifies Personalized Print Markup Language (PPML) page count for each page flush.

Image depth

Specifies the image color depth in bits of the output file. You can select one of the following:

1: Monochrome

8: Grayscale, Palette

24: RGB

32: CMYK

Image type

Specifies the image type of the output file, RGB, CMYK, Grayscale, or Palette.

Render on conversion to image

Specifies the items you want to be rendered on conversion to image.

Transform colors with ICC profile

Transforms all colors using the specified ICC profile to harmonize colors. Enter the ICC profile in the text box.

The ICC profile name can consist of text and one or more document properties. To insert document properties, right-
click in the text box, click Insert Document Property, and choose properties. The document properties will display
enclosed in brackets ([]).

To insert functions, right-click in the box, click Insert Function, and choose a function.

Additional output commands

Specifies additional parameters for handling the output file. Output commands can consist of text and one or more
document properties. To insert document properties, right-click in the text box, click Insert Document Property, and
choose properties. The document properties will display enclosed in brackets ([]).

To insert functions, right-click in the box, click Insert Function, and choose a function.

Stamp file

Specifies the stamp file name and path. Stamp files can have multiple pages. The last page of a stamp is used for the
remaining pages.
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The path can be specified using text and one or more document properties. To insert document properties, right-
click in the text box, click Insert Document Property, and choose properties. The document properties will display
enclosed in brackets ([]).

To insert functions, right-click in the box, click Insert Function, and choose a function.

Note:  If there is a need for additional changes to the output document, you can create a business rule action
to modify document contents.

Watermark file

Specifies the watermark file name and path.

The path can be specified using text and one or more document properties. To insert document properties, right-
click in the text box, click Insert Document Property, and choose properties. The document properties will display
enclosed in brackets ([]).

To insert functions, right-click in the box, click Insert Function, and choose a function.

Note:  If there is a need for additional changes to the output document, you can create a business rule action
to modify document contents.

Macro path

Specifies the path where macros are stored.

The path can consist of text and one or more document properties. To insert document properties, right-click in the
text box, click Insert Document Property, and choose properties. The document properties will display enclosed in
brackets ([]).

To insert functions, right-click in the box, click Insert Function, and choose a function.

Filter profile

Specifies a filter profile to override the profile configured in the transform package for this input/output combination.

The filter profile can consist of text and one or more document properties. To insert document properties, right-
click in the text box, click Insert Document Property, and choose properties. The document properties will display
enclosed in brackets ([]).

To insert functions, right-click in the box, click Insert Function, and choose a function.

Package Boundary Fields dialog box
Use this dialog box to select the boundary fields for an ad hoc merge package rule. Boundary fields are applicable
only if you expect that your merged document contains more than the allowed amount of exceptions in a given
document. This maximum number of exceptions is 1000.

Here is an example when you could easily exceed this maximum. You have a merge job where the constituent
documents are sets of documents for specific individuals that you are bundling together in a single print job. For each
individual there are three documents.

• The first is a mailer page that is intended to be folded around the other two and will show the individual’s name
and address through a glassine mailer envelope. This document is to be printed white, single-sided, letter paper.
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• The second document is an account summary. This document is to be printed white, double-sided, landscape
orientation.

• The third document is a return payment stub. This document is to be printed light blue, single sided, and custom
size.

Let us say the system chooses an optimal baseline of white, double-sided, landscape. This means every first document
complies with the baseline, but every second and third document is an exception. You have 2300 individuals for
which you are creating this bundle. You will end up with a merge job that has 4600 exceptions.

When merging, if the merged document will exceed this maximum number of exceptions, it is split into multiple
resultant documents, with each split on a boundary that attempts to maximize the number of pages without exceeding
the exception threshold. If you do not specify boundary fields using this dialog box, then the split is arbitrary and will
occur where the maximum number of pages can be fit.

By specifying boundary fields you exercise a little more control over where this splitting can occur. In the example
scenario above, you will end up with a merge job split into 5 merge documents, each of the first 4 containing pages
that comprise roughly 1000 exceptions. For this scenario each merged document will be sent to a high speed printer/
processing station. Since the client has five of these high speed processing stations, each merged document is sent to a
different one to be printed, folded, and inserted.

The problem with arbitrary splits is that a split may occur on document 1 of a given document set, meaning that
merge document 1 has the mailer page for individual X, and merge document 2 has the account summary and return
payment stub for individual X. Since these 2 documents go to different processing stations, there is a problem because
these 3 items need to be together in a given merge document and cannot be split. This is where boundary fields are
used. Assuming that each individual is defined by a client identifier, and that client identifier is attributed for each
constituent document, then you will use that client identifier as a boundary field, so that when the documents are
merged, the merge action knows to always keep all pages for documents that are for the same client identifier together
when splitting.

Properties grid

Lists the document properties that can be selected as package boundary fields. Boundary fields are only applicable
when a merged document will exceed the maximum number of exceptions (currently set at 1000). Merged documents
that exceed the exception count will be split into separate documents. Boundary fields are used to control where
the merged documents will be split. Each split will be on a boundary that maximizes the number of pages without
exceeding the exception threshold. If you do not specify boundary fields, the split is arbitrary and will occur where
the maximum number of pages can be fit.

The properties are grouped into the following categories: Basic options, Media selection, Document, Image
adjustments, Finishing, and Other properties. To expand a category, click the down arrow next to a category name. To
collapse a category, click the up arrow.

Package Manager dialog box
The Package Manager is used to manage which documents are contained in a package. Package is an Nuance Output
Manager concept used to group documents together for the purpose of routing to a destination as a group, running ad
hoc rules on the group, and so forth. By default, each document arriving in Nuance Output Manager will be the only
document in its own package bearing the same name as the document.

You can use the Package Manager to move documents from one package to another, remove documents from a
package to be in a separate package, and create new packages.
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To open the Package Manager, in the Documents list select one or more documents, right-click and click Package
Management. Only the packages associated with the selected documents will be available for management. For
example, if you select 10 documents that were just spooled into Nuance Output Manager, and open the Package
Manager, you will be managing 10 packages. Likewise, if you select 10 documents, and 5 out of the 10 are already
associated with the same package, and the remaining are single document packages, the utility will be managing 6
packages.

Packages

Lists all of the packages currently being managed by the Package Manager.

Package documents

Lists all of the documents associated with the selected package in the Packages list.

Removed documents

Lists all documents that have been removed from the package using the > button. If documents remain in this list
when Apply or OK is clicked, they will be repackaged in their own single document packages using the same name
as the documents.

New Package button

Creates a new package in the Packages list. This opens the Enter Package Name dialog box.

Rename button

Renames the selected package in the Packages list. This opens the Enter Package Name dialog box.

> button

Removes documents from a package. To remove documents, select one or more documents in the Package
documents list and click the > button. The documents will be moved to the Removed documents list.

< button

Adds removed documents to the package. To add documents, select one or more documents in the Removed
documents list and click the < button. The documents will be moved to the Package documents list.

Up button

Reorders the Package documents list by moving the currently selected document up in order.

Down button

Reorders the Package documents list by moving the currently selected document down in order.

Save Order button

Saves the currently displayed order of documents in the Package documents list. The last saved order will be used
when applying the changes to indicate a priority in group value assigned to each document of the group.
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Page Layout tab
Use this tab to configure transform page layout options such as paper size, tray calls, simplex/duplex settings, and
some rotation and scaling control of the output document.

You can access this dialog box when you configure a transform action for business rules or output processes or when
configuring an IPDS destination.

Click an option you want to learn more about.

• Input Options tab on page 553
• Output Options tab on page 590
• PDF Output tab on page 596

Set page size by

Specifies the page size. This does not scale the page. It crops or expands the page size.

• Default page size — Specifies that you want to use the default page size.
• Paper size — Specifies the paper size for the output file, with no page scaling. You can insert document properties

by right-clicking in the text box, clicking Insert Document Property, and choosing the appropriate properties.
The document properties will display enclosed in brackets ([]). To insert functions, right-click in the box, click
Insert Function, and choose a function.

• Height/Width — Specifies the page height and width for the output file. You can insert document properties by
right-clicking in the text box, clicking Insert Document Property, and choosing the properties. The document
properties will display enclosed in brackets ([]). To insert functions, right-click in the box, click Insert Function,
and choose the appropriate function.

Input tray

Specifies the tray name containing the paper to be used.

You can specify the tray name using text and document properties. To insert document properties, right-click in the
text box, click Insert Document Property, and choose the appropriate properties. The document properties will
display enclosed in brackets ([]).

To insert functions, right-click in the box, click Insert Function, and choose the appropriate function.

Output tray

Specifies the tray name where the output file will be printed.

You can specify the tray name using text and document properties. To insert document properties, right-click in the
text box, click Insert Document Property, and choose the appropriate properties. The document properties will
display enclosed in brackets ([]).

To insert functions, right-click in the box, click Insert Function, and choose the appropriate function.

Rotate page on input

Rotates the page on input according to the selected value. Use this option to rotate the page before any modifications
have been made.
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Rotate page on output

Rotates the page on output according to the selected value. The rotation will be applied after all document
modifications have been made.

Simplex/Duplex

Determines if single-sided or duplex printing will be performed.

• Simplex — Performs single-sided printing.
• Duplex (front) — Performs duplex printing - front page.
• Duplex (back) — Performs duplex printing - back page.

Reduce page to

Reduces the page height and width to a specified pixel value. This option is only available when Convert to image is
selected on the Output options tab.

Shift page

• On input — Shifts the page contents after the page has been read from the file (before any modifications have
been made). You will specify how far to shift the contents horizontally and vertically.

• On output — Shifts the page contents after all page modifications have been applied. You will specify how far to
shift the contents horizontally and vertically.

If you choose to shift the contents on output, you can select which items should be shifted: the entire page (default),
only those items within the specified rectangle, or all items that are partially within (intersecting with) the given
rectangle. If you choose an option other than the default, you will need to specify the rectangle parameters in inches.

PDF Output tab
Use this tab to configure PDF output transform options. You can access this dialog box when you configure a
transform with a PDF output format. Transforms can be configured for business rule or output process actions or
IPDS destinations.

Notice:  Please note that the IPDS output option is not available for new sales.

Click an option you want to learn more about.

• Input Options tab on page 553
• Output Options tab on page 590
• Page Layout tab on page 595

General PDF options

• Write PDF data stream uncompressed — Writes the PDF data stream uncompressed in the output file.
• Disable content extraction for accessibility — Disables access for content extraction in the output file.
• Disable document assembly — Disables document assembly in the output file.
• Disable copy and paste of contents — Disables copy and paste operations in the output file.
• Disable digital copies — Disables digital copies in the output file.
• Disable filling of form fields — Disables filling out form fields in the output file.
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• Disable printing of document contents — Disables printing the contents of the output file.
• Disable changing of comments — Disables changing the comments in the output file.
• Disable changing of file data — Disables changing the output file data.
• Generate a web-enabled (linearized) PDF — Generates a web-enabled PDF output file.
• Generate thumbnails — Generates thumbnails in the output file.
• Copy description property info during binary copy — Copies the contents of the description properties fields,

like title and author, to the output file.
• Generate table of contents if input AFP file contains TLEs — Creates a table of contents in the output PDF file

using information in AFP Tag Logical Element (TLE) structured fields.

Information fields

These fields can consist of text and one or more document properties. You can insert document properties by right-
clicking in the text box, clicking Insert Document Property, and choosing the appropriate properties. The document
properties will display enclosed in brackets ([]). To insert functions, right-click in the box, click Insert Function, and
choose the appropriate function.

This will override any copied information.

• Title — Specifies the title for the output file.
• Subject — Specifies the subject for the output file.
• Author — Specifies the author information for the output file.
• Keywords — Specifies any keywords for the output file.

Page scaling factor

Scales the logical page in output file, for example:

0.5 = 50% of original size

1 = original size (default)

2 = double size

Encryption key length

Specifies the key length (in bits) for encryption of PDF files. Valid values are 40 and 128.

Owner password

Specifies an owner password for the PDF output file.

To insert document properties, right-click in the text box, clicking Insert Document Property, and choosing the
appropriate properties. The document properties will display enclosed in brackets ([]).

To insert functions, right-click in the box, click Insert Function, and choose the appropriate function.

User password

Specifies a user password for the PDF output file.

To insert document properties, right-click in the text box, clicking Insert Document Property, and choosing the
appropriate properties. The document properties will display enclosed in brackets ([]).

To insert functions, right-click in the box, click Insert Function, and choose the appropriate function.
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Power Rule dialog box
Power rules allow you to create multiple rules with their own conditions and actions inside of one rule. While all of
these rules could be created separately, using power rules allows you to easily group a set of related conditions/actions
into a single power rule. For example, you can add as many conditions as necessary referencing multiple fields that
will perform multiple actions.

Use this dialog box to configure power rules.

Select conditions

Allows for adding multiple conditions to the rules. When you add a condition, a new column is added to the
Conditions grid. You will then specify the conjunction, operator, and value for the new condition. Do this by clicking
directly in the column for the appropriate rows.

Select actions

Allows for adding multiple actions to the rules. When you add an action, a new column is added to the Actions grid.
Click in the new action column to configure the action in the appropriate rows.

Rules grid

Each rule contained in the power rule is represented as one row spanning the Conditions and Actions grids. Click
directly in the grids to configure the condition and action statements. Multiple conditions and actions can be created
using the buttons above the grid. The conditions and actions are shown as columns in the grids. Use the buttons to the
right of the grid to create and manage rules.

Buttons

Use the following buttons to control the individual rules contained in the power rule. Each rule is represented as one
row spanning the Conditions and Actions grids.

Add button — Creates a new rule. A row will be added to the bottom of both grids.

Remove button — Deletes the selected rule. The selected row will be deleted from both grids.

Copy button — Creates a copy of the selected rule.

Move Up button — Reorders the rules by moving the selected rule up.

Move Down button — Reorders the rules by moving the selected rule down.

Preview window
The preview window allows you to preview the contents of the user grid and print the preview or export the grid to a
document, data, or text file.

This window is opened in the Administration - Manage Users application by clicking the  button on the Users
tab.
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Tool Name Description

Customize Search for text in the user records.

Customize Configure options for viewing user re
cords in the Preview window.

Open Opens a previously save preview doc
ument file (*.prnx).

Save Saves a preview document file (*.p
rnx) to continue working with the sa
me preview later.

File > Print... Prints using the print dialog box to sp
ecify print options.

File > Quick Print Quick print uses Windows default pr
inter settings.

File > Page Setup

Header and Footer Edits header and footer for print or e
xport.

Scale Menu to Adjust to % of normal size
or Fit to # pages wide.



Output Manager Administration Guide
Version 4.0 SP2

600 © 2016 Nuance Communications, Inc. All rights reserved.

Tool Name Description

Hand Tool Hand tool to drag elements of the vi
ew.

Magnifier Click image with this tool to change
magnification.

Zoom Click +/- or type or select a percentag
e to change magnification.

Navigation button Click First | Previous | Next | Last b
uttons to navigate pages.

Multiple Pages Click page number on menu to go to
a specific page.

Background > Color Click menu to select a background c
olor.

Background > Watermark Click to add or edit a watermark ima
ge.

File > Export Document Export user records to a document, i
mage, or data file.

File > Send via E-Mail Export user records to a document, i
mage, or data file and send it using th
e default email application.

File > Exit

View > Page Layout Specifies Facing or Continuous vie
w for multiple pages.

View > Toolbar Click to display or hide the toolbar.

View > Status Bar Click to display or hide the status ba
r.

View > Customize Opens dialog box to control display f
eatures of the Preview window.

• Toolbars-Display or hide
Toolbar, Status Bar, and Main
Menu. You can also create,
rename, or delete custom
toolbars.

• Commands-Lists Categories and
Commands.

• Options-Options to personalize
menus and toolbars.
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Printer Family Profile dialog box
Use this dialog box to configure printer family profiles. Only a name and description is required.

Name

Specifies the printer family name.

Description

Specifies the printer family description.

Process Designer
The Process Designer is a utility used by administrators to create and edit output processes. Output processes are
used to modify document data while sending a document to a destination. Banners can be added, transforms can be
processed, and various other changes made to the document record format.

The process designer is separated into three panels:

Actions panel This panel is a tree list of all actions that are available
to build the process. The tree’s top level nodes represent
groupings of similar type actions. Expanding a top level
node reveals all the available actions for that group.

Process panel This panel is where the process is built. An empty
process will contain a start and end action image (which
are not configurable and cannot be moved or deleted)
with a link between representing the flow of the process.
To build a process, you drag actions from the tree list and
drop them on the link between two existing actions.

Action Configuration panel This is where you configure an individual action. It is
populated with all the parameters associated with the
action that is currently (or most recently) selected in the
Process panel.

Output processes can either be associated with a destination or with a document. If associated with a destination,
any document being sent to the respective destination goes through the process. If associated with the document, the
process is executed no matter which destination the document goes to. The document’s process takes precedence
over the destinations, unless the check box Override output process assigned to document is selected on the
Destination's More settings tab. This is also where you would associate the output process with a destination. Output
processes can be associated with documents through source configuration on the Output settings tab, business rules,
or by assigning an output process profile from the Document right-click menu.

The Process Designer can be accessed by selecting Tools > Process Designer from the Output Manager Console
menu bar or from any area where output processes can be managed using the Manage Output Process Profiles
dialog box.

Click the area of the window you want to learn more about.
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1. Menu bar on page 602
2. Actions panel on page 603
3. Process panel on page 605
4. Action Configuration panel on page 606

Menu bar

The menu bar displays below the title bar.

Menu Command Description

File New Starts a new output process in the Pro
cess Editor pane.

Open Displays the Open Process dialog b
ox for selecting the process you wan
t to open.

Save Saves the current process. If you are
modifying an existing output process
, you will enter a process name and d
escription.

Save As Saves the current process with a new
name. You will enter a process name
and description.

Rename Process Displays the Rename Process dialog
box for renaming processes.

Delete Displays the Delete Process dialog b
ox for selecting the processes you wa
nt to delete.
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Menu Command Description

Print Preview Displays the contents of the Process
Editor pane as it looks when printed.
From the Print Preview window, yo
u can specify the number of pages to
view at a time, page through the doc
ument, zoom in and out of pages, an
d print.

Print Prints the contents of the Process
Editor pane.

Exit Closes the Process Designer window
. When you exit, you are prompted to
save any changes.

View Zoom Canvas Allows for setting the zoom level of t
he Process Editor pane. Displays the
Process Designer Zoom dialog box.

Help Help Displays Help for the Process
Designer window.

About Displays program information, versio
n number, and copyright.

Actions panel

The Actions panel shows a tree view of all available actions. These actions are available for use in output processes.
Click and drag actions from this panel to the Process panel. Actions can be configured as necessary after they are
added to the Process panel.

The top-level folders in the Actions tree are used to group related actions. These folders cannot be moved or renamed.

Action types The following table describes the Nuance Output
Manager action types:

Action type Description

Append Places data at the end of th
e document. The item bein
g appended can be a set of
bytes, a string, a text resou
rce, a binary resource, or a
banner resource.

Code Page Changes the encoding of a
document from one code p
age to another.

DCO Allows for record format c
hanges.
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Action type Description

Hex Table Allows single or multiple
byte substitutions.

Package Management Configures actions to defi
ne or manipulate package
contents.

Post Processing Actions Configures actions to be p
erformed at the end of the
output processing.

Prepend Inserts data at the beginni
ng of the document. The i
tem being inserted can be
a set of bytes, a string, a t
ext resource, a binary res
ource, an Nuance Output
Manager job ticket, or a ba
nner resource.

Print Preferences Modifies document proper
ties and other document at
tributes to satisfy printer r
equirements for a specific
document.

Search/Replace Enables bytes and/or strin
gs to be searched and then
replaced. The item being r
eplaced can be a set of byt
es, a string, a text resource
, a binary resource, or a ba
nner resource.

Transform Performs document trans
forms. The EPS and EPS
Advanced actions are use
d for converting LCDS d
ocuments for use with an
Xerox EPS controller. T
he Advanced Document
Modification action allow
s repurposing of documen
ts.

For more details, see Output Process Actions.

Search box

A search box is provided in the Actions pane below the tree. To search, type the text you want to find in the box and
press Enter or click the search button next to the box.
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Process panel

The Process panel is where the output process is created. The Start and End images are initially displayed in this
pane. You can click and drag actions into a process from the Actions tree. All you have to do is drag the actions
on top of the line linking two actions. Because the placement and order of actions is important, the Process editor
enforces where actions can be dropped using drop zones. When an action is placed on top of a line linking two
actions, it can only be dropped if the line turns green. If the line remains black, the action is not accepted in that
location. Actions can be reordered within the drop zone by dragging them to a new position.

Processes are built with a sequence of actions. Some actions must be performed in specific sequences when combined
with other actions within the same process. Therefore landing zones are enforced within the Process panel. Actions
are processed in zone order, and the Process editor will only allow new actions to be dropped into the proper zones.
The following table lists the processing order dependency for actions.

Table 11: Landing zones

Number Zone Allowed actions or groups

1 Before processing a document Prepend

2a Document conversions Transforms and DCOs in any order

2b Document conversions Search/Replace, Hex Table, and Cod
e Page

3 After processing the document Append

4 Currently not used

5 Post processing Email, Call Method, and Script

There are five exceptions that will override the standard landing zone rules.

Table 12: Landing zone exceptions

Number Exception

1 Transform, Transform with Banners, Adept Transform, a
nd Advanced Document Modification actions are not all
owed anywhere in the workflow after an Apply Print Pre
ferences action.

2 None of the EPS type actions are permitted to be in the s
ame output process workflow with an Apply Print Prefer
ences action.

3 Merge, Set Document Properties, and Make Copies shou
ld always occur in that order.

4 If the Set Document Properties action passes all previous
exception rules, it is allowed to be anywhere in the outpu
t process workflow.
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You can remove actions from an output process by selecting the action in the Process panel and pressing Delete.
When an action is selected, a green box will display around the action.

Action Configuration panel

The Action Configuration panel allows for configuring the action selected in the Process panel. The configuration
options that display vary depending an action. This panel is divided into the following three sections.

Action Parameters Configures the parameters of a selected action. These
vary depending on the action it represents.

If Action Encounters Error This is common to all actions. It contains a single
parameter:

• Workflow error: It sets what to do in case the action
encounters an error. Specify Stop to end the process
and send an error to the destination, or Skip to skip
the action and continue executing the remaining
process actions.

Action Executes For The Following This contains the following parameters:

• Printer families: Common to all actions, it specifies
whether or not the action is to be executed depending
on the printer family of the destination. Select one or
more. The default is All.

• Document data types: Common to all actions,
it specifies whether or not the action is to be
executed depending on the document data type being
processes. Select one or more. The default is All.

• Job level: Currently only available for Append,
Prepend, and EPS Adv W/Banners actions.
Specifies if the action is to be executed at the
package or document level. (see Package concept
below). Specifying document level would execute
the action on each document within a multidocument
package. Specifying package level would execute the
action on only the first and last document within the
package. Thus, the result would be the same if the
package contains only one document.

Rename Process dialog box
Use this dialog box to rename output processes from Process Designer. You can access this dialog by selecting File >
Rename Process on the Process Designer menu bar.

Select a process

Displays all of the saved output processes. Select the grid row that contains the process you want to rename. You can
then enter a new name and description using the fields below.
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Name

Specifies a new name for the selected output process.

Description

Specifies a new description for the selected output process.

Resource Manager dialog box
The Resource Manager provides a central place for managing all Nuance Output Manager resources. Resources are
available to any Nuance Output Manager service, running on any server. For example, 2 Nuance Output Manager
Output Services running on 2 different servers, could use the same resources. Resources are used in business rule
and output process actions. You can access this dialog box by selecting Tools > Resource Manager in the Output
Manager Console.

Option Description

Resource type Displays the resource types. Once a resource type is
selected, all resources of that type are displayed in
the grid. You can create and manage the resources as
necessary. You can choose from the following available
resource types:

• Banner — Text files used for banners or trailers that
may contain document properties.

• Binary — Binary files used by output process
actions.

• CPMillProfile — XML files used to define
formatting such as fonts and resource locations
for a particular file format. This is used when
transforming, bursting, extracting data, performing
ADM, viewing documents, or reprinting documents.

• CpMillUnitLibrary — Javascript programs used for
Advanced Document Modification.

• CsvDocProp — Comma separated values
representing document properties.

• FCB — Form Control Block used by DCOs for
various record conversions.

• Ini — Ini files used by output process actions.
• PrinterControlFile — Reserved for printer control

files, not presently used.
• Text — Text files used by output process actions.

Resource list The table lists currently defined resources for the selecte
d resource type. Columns in the table show the current se
ttings for a resource:

• Resource Name — Displays the name of the
resource.
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Option Description

• Resource Description — Displays a description of
the resource.

• Resource Comments — Displays any additional
comments about the resource.

• Data Type — Displays the data types associated with
the resource.

• Printer Family — Displays the printer families
associated with the resource.

New Click this button to create a new resource. The dialog bo
x that opens varies depending on the selected resource ty
pe.

• CpMillUnitLibrary — Opens the Configure Unit
Library dialog box.

• CPMillProfile — Opens the Configure Filter Profile
dialog box.

• Banner — Opens the Create Banner Resource
dialog box.

• PrinterControlFile — Opens the Create
PrinterControlFile Resource dialog box.

• FCB — Opens the Create FCB Resource dialog
box.

• CsvDocProp — Opens the Create CsvDocProp
Resource dialog box.

• Binary — Opens the Create Binary Resource dialog
box.

• Text — Opens the Create Text Resource dialog box.
• Ini — Opens the Create Ini Resource dialog box.

Edit Click this button to open the selected resource for mod
ification. This opens the Edit Resource (or Configure
Resource for CpMill resources) dialog box, which allow
s you to edit options for the selected resource type.

Delete Click this button to delete the selected resource.

Import Click this button to import a resource. The file must be a
previously exported Nuance Output Manager resource in
XML format.

Export Click this button to export the currently selected resourc
e to an XML export file. Exported resources can then be
imported into Nuance Output Manager. The XML marku
p construct consists of name/value pairs that correspond t
o property settings for a resource. For example:

<?xml version="1.0"?>
<EomResource>
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Option Description
  <ResourceName ResourceName="resour
ce_name" />
  <ResourceDescription ResourceDescr
iption="resource_description" />
  <ResourceComments ResourceComments
="optional_comments" />
  <ResourceType ResourceType="Printe
rControlFile" />
  <ResourceXML ResourceXML="Unicode
 (UTF-8)" />
  <ResourcePrinterFamily PrinterFami
ly="101" />
  <ResourceDataType ResourceDataType
="999" /><![CDATA[printer]]></EomRes
ource>

Banner Resource dialog box

Use this dialog box to configure a banner resource. You can access this dialog box when you create or configure a
banner resource in the Process Designer or the Resource Manager dialog box.

Name

Specifies the name of the banner resource.

Description

Provides a description of the banner resource.

Comments

Displays any comments about the resource.

Printer Family

Use the check boxes to determine if the resource will be used for all printer families or only for certain printer
families.

Data Type

Use the check boxes to determine if the resource will be used for all data types or only for certain data types.

Import Resource Data

Browse button — Allows for importing resource data. Imported files must contain text data.

Code page — Specifies the code page to be applied to the resource data.

Resource Editor

You can enter text, document properties, and functions in the Resource Editor.
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To insert document properties, right-click in the box, click Insert Document Property, and choose the appropriate
properties. The document properties will display enclosed in brackets ([]).

To insert functions, right-click in the box, click Insert Function, and choose the appropriate function. Review the
Using Nuance Output Manager functions help topic for information on configuring functions.

To go to a specific line in the resource, right-click in the box and click Go To (or press Ctrl+G). In the box that
displays, enter the line number and click OK. The line will be highlighted in the Resource Editor.

To find specific text, right-click in the box and click Find and Replace (or press Ctrl+F) to display the search dialog
box.

Export button

Allows for exporting the resource data. Unlike the Export button in the Resource Manager dialog box, this exports
only the text data from the Resource Edit area to a text file.

Binary Resource dialog box

Use this dialog box to configure a binary resource. You can access this dialog box when you configure a binary
resource in the Process Designer or the Resource Manager dialog box.

Name

Specifies the name of the binary resource.

Description

Provides a description of the binary resource.

Comments

Displays any comments about the resource.

Printer Family

Use the check boxes to determine if the resource will be used for all printer families or only for certain printer
families.

Data Type

Use the check boxes to determine if the resource will be used for all data types or only for certain data types.

Import Resource Data

Browse button — Allows for importing resource data. Imported files can be of any type and will be interpreted as
byte data.

Resource Editor

The Resource Editor box is a special edit area that accepts only hexadecimal digits (0 – 9 and A – F). Enter the
binary data without regard to spacing. The spacing is taken care of automatically by the editor.
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To go to a specific line in the resource, right-click in the box and click Go To (or press Ctrl+G). In the box that
displays, enter the line number and click OK. The line will be highlighted in the Resource Editor.

To find specific text, right-click in the box and click Find and Replace (or press Ctrl+F) to display a find and replace
dialog box.

Create Hex Size

The Create Hex Size area can be used to set the data capacity. Entering a number in the text box and clicking the
Create Hex Size button has the following effect:

• If there is already data in the edit area, any data at or below the new size will remain intact. Any data beyond the
new specified size will be erased from the editor.

• If existing data is smaller than the new size, the space after existing data is padded with empty bytes (00) up to the
requested size.

• If no data currently exists in the editor when setting the size, the editor is filled with empty bytes (00) up to the
requested size.

Export button

Allows for exporting the resource data. Unlike the Export button on the Resource Manager dialog box, this exports
only the text data from the Resource Editor area to a text file.

Configure Filter Profile dialog box

Use this dialog when you need to create a custom profile for handling a specific data format. You can access this
dialog box on the Filter profiles tab of the Transform Package dialog box, or when you configure a CpMillProfile
in the Resource Manager dialog box.

Datatype

Specifies the data type of the filter profile.

Create new profile

Specifies if you want to create a new filter profile or modify the selected profile. When a default profile is displayed,
this option is selected by default. Check the box and rename the profile to create.

Name

Specifies the filter profile name.

Description

Includes a description of the filter profile.

Comments

Includes any comments to be stored with the filter profile. Click in the box to enter and view comments.



Output Manager Administration Guide
Version 4.0 SP2

612 © 2016 Nuance Communications, Inc. All rights reserved.

Filter profile

Defines the filter profile. In most cases, it is best to use the default filter profiles. If you use a third-party transform
package to convert formats, refer to the third-party documentation for more information. We recommend contacting
Nuance Support for assistance with advanced configuration of filter profiles.

To go to a specific line, right-click in the box and click Go To (or press Ctrl+G). In the box that displays, enter the
line number and click OK. The line will be highlighted in the Resource Editor.

To find specific text, right-click in the box and click Find and Replace (or press Ctrl+F) to display the search dialog
box.

Configure Unit Library dialog box

Use this dialog to configure a unit library. Unit libraries are JavaScript modules that CpMill calls at certain known
times while processing a document (for example, begin document, page start, and page end). The modules can modify
the contents of the document, extract information from the document, write the document, or parts of it, to a new
location, or perform many other operations.

You can access this dialog when configuring a business rule to modify document contents or when using the
Resource Manager.

Name

Displays the name of the unit library configuration.

Description

Displays text describing the unit library configuration.

Comments

Displays any comments. Click in the drop-down list to enter/view comments.

Document Properties Needed

Specifies the document properties needed by the unit library. These properties will be written to a file called <filena
me>.properties when Nuance Output Manager calls the document modification software. This file is then opened and
read in by the unit library.

Filters Needed

Specifies the filters needed for the unit library. The filters indicate document types that the unit library needs to be
aware of in order to fulfill its intent. This includes all expected input, output, and interim document types. These
filters will be written to a temporary location which will be sent to the document modification software.

Import Resource Data

Browse button — Allows for importing resource data. Imported files must contain text data.

Code page — Specifies the code page to be applied to the resource data.
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Unit

Specifies the unit library. Review the default comments of a new unit library for descriptions of the parameters sent
from Nuance Output Manager to the unit library and information about how to tell Nuance Output Manager about the
documents modified or created by the unit library. Enter the unit library code within the <script> </script>
tags in the appropriate event handler sections.

Tip:  Review the default comments of a new unit library for descriptions of the parameters sent from Nuance
Output Manager to the unit library and information about how to tell Nuance Output Manager about the
documents modified or created by the unit library.

For more information on configuring unit libraries, contact Nuance Communications Professional Services.

To go to a specific line, right-click in the box and click Go To (or press Ctrl+G). In the box that displays, enter the
line number and click OK. The line will be highlighted in the Resource Editor.

To find specific text, right-click in the box and click Find and Replace (or press Ctrl+F) to display the search dialog
box.

Reload Variables from Unit button

Reloads the variables in the unit library and lists any output variables in the Output variables grid.

Output variables grid

Displays the output variables in the unit library. This grid is shown for reference only. It cannot be edited.

CsvDocProp Resource dialog box

Use this dialog box to configure a CsvDocProp resource. You can access this dialog box when you configure a
CsvDocProp resource in the Resource Manager dialog box.

Name

Specifies the name of the CsvDocProp resource.

Description

Provides a description of the CsvDocProp resource.

Comments

Displays any comments about the resource.

Printer Family

Use the check boxes to determine if the resource will be used for all printer families or only for certain printer
families.

Data Type

Use the check boxes to determine if the resource will be used for all data types or only for certain data types.
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Import Resource Data

Browse button – Allows for importing resource data. Imported files must contain text data.

Resource Editor

Enter comma separated values (CSV) or text in the box. You can also create a resource with a table of information
using the CSV format.

To go to a specific line in the resource, right-click in the box and click Go To (or press Ctrl+G). In the box that
displays, enter the line number and click OK. The line will be highlighted in the Resource Editor.

To find specific text, right-click in the box and click Find and Replace (or press Ctrl+F) to display the search dialog
box.

Example:

The following example shows columns names and several rows of data (an entry for each column).

"Class Values", "My Test Forms", "Res - Settings", "Other Values",

"A", "short form", "100", "sample string 1",

"B", "long form", "200", "sample string 2",

"C", "std form", "300", "sample string 3"

You can then use the  @LookupCsv  function to look up a value for a field you are configuring.

For example, let’s assign a value to a property. Configure a business rule with a Set Document Properties Basic
action. Using this rule, we will assign a value to the "Custom String1" property. Right-click in the value field for that
property, and click the @LookupCsv function. Configure the function to supply a value.

1. Choose to locate the CSV file using a Path or a Resource. In this example, the data for either choice would be in
the format described above.

2. Set the Lookup data to [Resolution].
3. Set the Key column name to Res - Settings.
4. Set the Data column name to Class Values.
5. Click OK. This configuration will look up the [Resolution] property of the document we’re working with and then

find that value in the Res - Settings column of the lookup data. It will then get the value from the same lookup
row in the Class Values column.

Running this business rule on a document whose [Resolution] property is "300" would set the CustomString1
property to "C".

Export button

Allows for exporting the resource data. Unlike the Export button in the Resource Manager dialog box, this exports
only the text data from the Resource Editor area to a text file.

FCB Resource dialog box

Use this dialog box to configure an FCB resource. You can access this dialog box when you configure an FCB
resource in the Process Designer or the Resource Manager dialog box.
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Name

Specifies the name of the FCB resource.

The FCB name is important since the FCB selection from the output process or business rule action will select an
FCB resource based on the Document Property field used. In most cases the Document Property Form Name field
is used as the variable in selecting the FCB resource. For example, if you receive a file from the mainframe via RJE
the PDIR record is processed and any form name found is mapped to the Form Name document property. Then during
conversion, the corresponding FCB resource will be used to format the report. A PDIR form name of CHKS would
expect that there was an FCB resource defined named CHKS and would apply the CHKS FCB resource. If the action
cannot find the FCB resource it will apply STD.

Description

Provides a description of the FCB resource.

Comments

Displays any comments about the resource.

Printer Family

Use the check boxes to determine if the resource will be used for all printer families or only for certain printer
families.

Data Type

Use the check boxes to determine if the resource will be used for all data types or only for certain data types.

Import Resource Data

Browse button — Allows for importing resource data. Imported files must be a binary FCB resource, such as those
used by the Output Manager Print Server.

Resource Editor

Lines/Inch — Specifies the line spacing, either 6 or 8 lines-per-inch. You can change the value to 8 to tighten the line
spacing and enable more data to fit on a page. The default is 6 lines per inch.

Printable lines/page — Specifies the number of lines that will print per page. For example, if there are 66 Lines/
Page and you enter 60 Printable lines/page, then you will print lines 1 through 60 on each page of the document.

Lines/page — Specifies the page length. This number is calculated by multiplying the length of the paper (usually 11
inches) by the number of lines per page (usually 6). The default is 66 lines per page. This will change the size of the
FCB that is sent with the data.

Grid — Lists the currently defined channel stops. Channel stops are used to define vertical spacing. When a printer
encounters a command to advance to a channel stop, the print head moves to the specified line and the data is printed.
Channel stop 1 usually indicates the top of the form or the first line where the printer will begin printing.

You can change the grid’s sort order by clicking the Channel or Line Number column headings. When you click a
column heading, the data of both columns will sort in ascending order based on the column selected.

Add button — Adds a channel stop.
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Remove button — Deletes the selected channel stop.

Export button

Allows for exporting the resource data. Unlike the Export button on the Resource Manager dialog box, this exports
only the text data from the Resource Editor area to a text file.

PrinterControlFile Resource dialog box

Use this dialog box to configure a printer control file resource. You can access this dialog box when you configure a
printer control file resource in the Resource Manager dialog box.

Name

Specifies the name of the printer control file resource.

Description

Provides a description of the printer control file resource.

Comments

Displays any comments about the resource.

Printer Family

Use the check boxes to determine if the resource will used for all printer families or only for certain printer families.

Data Type

Use the check boxes to determine if the resource will be used for all data types or only for certain data types.

Import Resource Data

Browse button — Allows for importing resource data. Imported files must contain text data.

Resource Editor

To go to a specific line in the resource, right-click in the box and click Go To (or press Ctrl+G). In the box that
displays, enter the line number and click OK. The line will be highlighted in the Resource Editor.

To find specific text, right-click in the box and click Find and Replace (or press Ctrl+F) to display the search dialog
box.

Export button

Allows for exporting the resource data. Unlike the Export button on the Resource Manager dialog box, this exports
only the text data from the Resource Editor area to a text file.
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Resources tab
Use this tab to control the search order for font resources. You can access this tab when you create or modify a
transform package in the Configure Transform dialog box.

Important:  You will need to verify the Adobe and Ghostscript paths are correct and update if necessary.

Click an option you want to learn more about.

• General tab (Transform Package) on page 548
• Filter Profiles tab on page 546
• Fonts tab on page 547

Resources grid

Displays the paths to available resources, primarily font resources, for each data type except AFP and LCDS. AFP
and Xerox LCDS resource locations are specified within the filter profile settings. You can add or modify the paths
directly in the grid. To add paths, click in the top row of the grid.

Used by column — Specifies the data type. Click in the grid cell to select the data type.

Path column — Specifies the path where the resources are located. Either click in grid cell and type the path or click
the browse button (...) to navigate to the proper folder.

Type column — Specifies the resource type. Type the resource type in the grid cell. If no type is entered, the
extension column should also be left blank and the software will search for resources of all types in the location.

Extension column — Specifies the file extension. Type the extension in the grid cell.

Resolution column — Displays the resolution. This is only used for certain data types, like AFP. If the resolution is
specified, resources with that resolution will be searched in that path. If the resolution is not specified, resources of
any resolution will be searched in the path.

Role Manager dialog box
Use this dialog box to define and modify the security roles of users and groups. The Role Manager utility consists of
different types of roles and corresponding security-related permissions that can be granted or denied to each role.

There are three roles defined in Nuance Output Manager: Document Owner, System Administrators, and Security
Administrators. The role of Document Owner defines the rights of individual document owners and is limited to
Documents and Library applications. The role of System Administrators defines the rights to configure security and
includes all applications, that is, Destinations, Sources, Documents, Library, Reports, and Administration. The role
of Security Administrator is identical to System Administrator except that a subset of permissions is unavailable for
modification to insure that security can always be configured.

Warning:  These permissions are set for the role and cannot vary for users or groups within a role.

You can add and remove users and groups from the System Administrator and Security Administrator roles as
needed to manage security access; for example, you might want add a system administrator to serve as backup to an
established system administrator.

Tip:  Permissions can also be set through the Destinations, Sources, and Documents applications, and for the
Output Manager Console.
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Access this dialog box by clicking Tools > Security Roles on the Output Manager Console menu bar.

Role name

Specifies the role. You can choose from the following Nuance Output Manager roles:

• Document Owner — Defines the rights, or permissions, of document owners. You can limit or extend the
permissions of document owners as appropriate. For example, an administrator who wants to prohibit document
owners from assigning documents to destinations would remove this permission. This role is limited to
Documents and Library applications.

• System Administrators — Defines the members and permissions for system administrators. System
administrators can configure and manage all of the security permissions. As with the Document Owner role,
you can limit or extend the permissions of system administrators as needed. By default, all permissions are
granted to the System Administrators role at the time of installation; you can modify permissions as appropriate
for the installation. A company might have several system administrators. This role defines permissions for all
applications, that is, Destinations, Sources, Documents, Library, Reports, and Administration.

• Security Administrators — Is identical to the role of System Administrator except that a subset of permissions
is always unavailable for modification; this safeguard insures that an installation does not accidentally lock itself
out of Nuance Output Manager, preventing the configuration of security permissions. A company typically would
have only one Security Administrator.

To add members to or remove them from a role, click the arrow and select the role; the Add button and Remove
button will become available. To modify permissions assigned to a role, click the browse button (…). This opens the
Manage Roles dialog box.

Members grid

Displays the members of the selected role. You can add or remove members.

Add — Adds a user or group to the selected role. Click Add to open the User and Group Selection dialog box.
You use this dialog box to add members. If the user or group you want is not listed, click More Users to search for
additional users. See Adding users and groups to Nuance Output Manager  for detailed procedures on adding users.

Route to Destination (Advanced) dialog box
This dialog is used when you create business rule actions to route to destinations. This advanced method allows you
to use a comma-separated values (CSV) file to dynamically pick destinations based on a document property.

Path/Resource

Specifies how you want to locate the CSV file. You can use one of the following options:

• Path — Enter the path and file name of the CSV file, or click the browse button (...) to navigate to the file.
• Resource — Select the appropriate resource from the list, or in the Manage CsvDocProp Resources dialog box,

click the browse button (...) to choose the resource.

Lookup data

Specifies the document property that will control the routing. The value contained in this document property will
determine the row used in the CSV file.
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Tip:  For example, the following table shows an example CSV file using the Class property. To route by Class
using this example, select Class in the Lookup data box, enter MyClass in the Key column name box,
and MyPrinter in the Destination column name box. When the document is routed the value of the Class
property will determine which destination is used. For example, if the Class value is A, the document will be
routed to printer 1.

MyClass MyPrinter

A printer1

B printer2

C printer3

Key column name

Specifies the column name in the CSV file that corresponds to the selected document property.

Destination column name

Specifies the column name in your CSV file that contains the destination name where you want the documents routed.

Drop-down list

Determines if you want to replace the destination already assigned to the document or use multiple destination routing
and add to the destination already assigned to the document.

Schedule dialog box
You can schedule documents to print at a specific time. For example, you can schedule certain jobs to print on a
specific day of the week or you can schedule large jobs to print at night. Documents become eligible to print at the
specified time. They might not print at the exact time, depending on how many other eligible documents are ahead of
them in the queue.

You can access this dialog box by right-clicking documents in the Documents grid and clicking Schedule,
configuring a business rule to schedule output, or using the @schedule function.

Day

Specifies the day you want to print the document. You can choose to print the documents today, on a specific day, or
in the future.

Time

Specifies the time you want to print the document. You can choose to print as soon as possible, at a specific time, or in
the future.

String format

Warning:  This option is only available when using the @schedule function to insert a time into a string type
document property.
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Specifies the format of the date/time string when it is inserted into the document property. You can specify a value or
combination of values from the grids below.

Table 13: Standard DateTime format patterns

Format Pattern Associated Property/Description

d ShortDatePattern

D LongDatePattern

f Full date and time (long date and short time)

F FullDateTimePattern (long date and long time)

g General (short date and short time)

G General (short date and long time)

m, M MonthDayPattern

o, O Round-trip date/time pattern; with this format pattern, th
e formatting or parsing operation always uses the invaria
nt culture

r, R RFC1123Pattern; with this format pattern, the formatting
or parsing operation always uses the invariant culture

s SortableDateTimePattern (based on ISO 8601) using loc
al time; with this format pattern, the formatting or parsin
g operation always uses the invariant culture

t ShortTimePattern

T LongTimePattern

u UniversalSortableDateTimePattern using the format for
universal time display; with this format pattern, the form
atting or parsing operation always uses the invariant cult
ure

U Full date and time (long date and long time) using unive
rsal time

y, Y YearMonthPattern

Table 14: Custom DateTime format patterns

Format Description

d, %d The day of the month. Single-digit days do not have a lea
ding zero. The application specifies "%d" if the format p
attern is not combined with other format patterns.

dd The day of the month. Single-digit days have a leading z
ero.

ddd The abbreviated name of the day of the week.
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Format Description

dddd The full name of the day of the week.

f, %f The fraction of a second in single-digit precision. The re
maining digits are truncated. The application specifies "
%f" if the format pattern is not combined with other for
mat patterns.

ff The fraction of a second in double-digit precision. The re
maining digits are truncated.

fff The fraction of a second in three-digit precision. The rem
aining digits are truncated.

ffff The fraction of a second in four-digit precision. The rem
aining digits are truncated.

fffff The fraction of a second in five-digit precision. The rema
ining digits are truncated.

ffffff The fraction of a second in six-digit precision. The remai
ning digits are truncated.

fffffff The fraction of a second in seven-digit precision. The re
maining digits are truncated.

F, %F Displays the most significant digit of the seconds fractio
n. Nothing is displayed if the digit is zero. The applicatio
n specifies "%F" if the format pattern is not combined wi
th other format patterns.

FF Displays the two most significant digits of the seconds fr
action. However, trailing zeros, or two zero digits, are no
t displayed.

FFF Displays the three most significant digits of the seconds f
raction. However, trailing zeros, or three zero digits, are
not displayed.

FFFF Displays the four most significant digits of the seconds f
raction. However, trailing zeros, or four zero digits, are n
ot displayed.

FFFFF Displays the five most significant digits of the seconds f
raction. However, trailing zeros, or five zero digits, are n
ot displayed.

FFFFFF Displays the six most significant digits of the seconds fr
action. However, trailing zeros, or six zero digits, are no
t displayed.

FFFFFFF Displays the seven most significant digits of the seconds
fraction. However, trailing zeros, or seven zero digits, ar
e not displayed.
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Format Description

gg The period or era. This pattern is ignored if the date to b
e formatted does not have an associated period or era str
ing.

h, %h The hour in a 12-hour clock. Single-digit hours do not ha
ve a leading zero. The application specifies "%h" if the f
ormat pattern is not combined with other format patterns.

hh The hour in a 12-hour clock. Single-digit hours have a le
ading zero.

H, %H The hour in a 24-hour clock. Single-digit hours do not ha
ve a leading zero. The application specifies "%H" if the f
ormat pattern is not combined with other format patterns.

HH The hour in a 24-hour clock. Single-digit hours have a le
ading zero.

K Different values of the Kind property, that is, Local, Utc
, or Unspecified.

m, %m The minute. Single-digit minutes do not have a leading z
ero. The application specifies "%m" if the format pattern
is not combined with other format patterns.

mm The minute. Single-digit minutes have a leading zero.

M, %M The numeric month. Single-digit months do not have a le
ading zero. The application specifies "%M" if the format
pattern is not combined with other format patterns.

MM The numeric month. Single-digit months have a leading
zero.

MMM The abbreviated name of the month.

MMMM The full name of the month.

s, %s The second. Single-digit seconds do not have a leading z
ero. The application specifies "%s" if the format pattern i
s not combined with other format patterns.

ss The second. Single-digit seconds have a leading zero.

t, %t The first character in the AM/PM designator, if any. The
application specifies "%t" if the format pattern is not co
mbined with other format patterns.

tt The AM/PM designator defined, if any. Your application
should use this format pattern for languages for which it
is necessary to maintain the distinction between AM and
PM. An example is Japanese, for which the AM and PM
designators differ in the second character instead of the f
irst character.
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Format Description

y, %y The year without the century. If the year without the cen
tury is less than 10, the year is displayed with no leading
zero. The application specifies "%y" if the format pattern
is not combined with other format patterns.

yy The year without the century. If the year without the cen
tury is less than 10, the year is displayed with a leading z
ero.

yyy The year in three digits. If the year is less than 100, the y
ear is displayed with a leading zero.

yyyy The year in four or five digits (depending on the calendar
used), including the century. Pads with leading zeros to g
et four digits. Thai Buddhist and Korean calendars have f
ive-digit years. Users selecting the "yyyy" pattern see all
five digits without leading zeros for calendars that have f
ive digits. Exception: the Japanese and Taiwan calendars
always behave as if "yy" is selected.

yyyyy The year in five digits. Pads with leading zeros to get fiv
e digits. Exception: the Japanese and Taiwan calendars al
ways behave as if yy is selected.

yyyyyy The year in six digits. Pads with leading zeros to get six
digits. Exception: the Japanese and Taiwan calendars alw
ays behave as if "yy" is selected. The pattern can be incl
ude "yy" to for more than six digits, with a longer paddin
g of leading zeros.

z, %z The time zone offset ("+" or "-" followed by the hour on
ly). Single-digit hours do not have a leading zero. For ex
ample, Pacific Standard Time is "-8". The application sp
ecifies "%z" if the format pattern is not combined with o
ther format patterns.

zz The time zone offset ("+" or "-" followed by the hour on
ly). Single-digit hours have a leading zero. For example,
Pacific Standard Time is "-08".

zzz The full time zone offset ("+" or "-" followed by the hour
and minutes). Single-digit hours and minutes have leadin
g zeros. For example, Pacific Standard Time is "-08:00".

: The default time separator.

/ The default date separator.

% c Where c is a format pattern if used alone. To use format
pattern "d", "f", "F", "h", "m", "s", "t", "y", "z", "H",
or "M" by itself, the application specifies "%d", "%f",
"%F", "%h", "%m", "%s", "%t", "%y", "%z", "%H", or
"%M".
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Format Description

The "%" character can be omitted if the format pattern is
combined with literal characters or other format patterns.

\ c Where c is any character. Displays the character literally
. To display the backslash character, the application shou
ld use "\\".

Culture

Warning:  This option is only available when using the @schedule function to insert a schedule into a string
type document property.

Specifies the culture name of the data in the document. The default is the current culture of the computer
where the Nuance Output Manager Console is running. When culture is not specified, the culture independent
CultureInfo.InvariantCulture is used.

Clear button

Returns the dialog to the default schedule of printing today, as soon as possible.

Schedule Manager dialog box
You can use the Schedule Manager to configure a recurring schedule for a task. Tasks can be created to run an ad hoc
rule, create and save a report, or create and email a report.

You can access this dialog box by selecting Tools > Schedule Manager on the Output Manager Console menu bar.

Schedule list

Lists all defined schedules.

Use the check box in the Enabled column to determine if the schedule is enabled or disabled.

Add button — Creates a new schedule. You can configure the schedule on the Schedule tab and the tasks on the
Tasks tab.

Modify button — Modifies the selected schedule.

Remove button — Deletes the selected schedule.

Summary

Displays a summary of the selected schedule.

Tasks

Lists the tasks that will be performed in the selected schedule.

Schedule tab (New/Edit Schedule dialog box)

You can use this tab to configure multiple schedules for a set of tasks. You can access this tab when you create or
modify a schedule on the Schedule Manager dialog box.
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Name

Displays the name of the schedule.

Enabled

Use the check box to enable or disable the schedule. This option is enabled by default.

Description

Displays a description of the schedule.

Summary

Lists the summaries of each schedule. The summary automatically updates as you configure the recurrence pattern
and range of recurrence. You can add multiple schedules as needed. The details of the selected schedule will display
under Schedule Entry Detail .

Schedule Entry Detail

Allows for configuring the recurrence pattern and the range of recurrence for each schedule.

Add button — Creates a new schedule.

Modify button — Modifies the selected schedule.

Remove button — Removes the selected schedule.

Save Edit button — Saves the changes to the selected schedule.

Cancel Edit button — Cancels the changes to the selected schedule.

Recurrence pattern

Configures a Simple, Daily, or Monthly recurrence pattern.

Range of recurrence

Configures the start and end date/time for the schedule. By default the schedule is configured with no end date.

Tasks tab (New/Edit Schedule dialog box)

You can use this tab to configure the tasks that will be included in the scheduled job. You can select a rule to perform,
create and save a report, or create and email a report.

You can access this tab when you create or modify a job on the Schedule Manager dialog box.

Click on the option to learn more about it.

• Schedule tab (New/Edit Schedule dialog box) on page 624

Name

Displays the name of the schedule.



Output Manager Administration Guide
Version 4.0 SP2

626 © 2016 Nuance Communications, Inc. All rights reserved.

Description

Displays a description of the schedule.

Enabled

Use the check box to enable or disable the schedule. This option is enabled by default.

Task grid

Lists all of the tasks that will be performed in the schedule.

Add button — Adds a task to the schedule. You can choose to add a task to perform a rule or create a report.
Depending on the option selected the New Task (Perform Rule) dialog box or New Task (Create Report) dialog
box is displayed.

Task Description

Active Directory Synchronization Synchronize all Active Directory users known to Output
Manager using the attribute mapping configurable from
Manage Users.

Create Report Configure a task that will create and save a report or
create and email a report. This task will be included in a
scheduled job.

Import Users and Groups Configure a task that imports users and groups.

LDAP Synchronization Synchronize all LDAP users known to Output Manager
using the attribute mapping configurable from Manage
Users.

Output History to Equitrac Import Configure a task that exports print reporting data for
import by Equitrac.

Perform Rule Configure a task that will perform an ad hoc rule. This
task will be included in a scheduled job.

Push Data to Reporting Database Configure a task that sends report data to a remote
database.

Update Output History with Page Counts Update output history with page counts or any entries
that do not have already have a page count.

Modify button — Modifies the selected task.

Remove button — Deletes the selected task from the schedule.

New/Edit Task (Active Directory Synchronization) dialog box
Synchronize all Active Directory users known to Output Manager using the attribute mapping configurable from
Manage Users.

To access these settings, click Add > Active Directory Synchronization on the Tasks tab of the Schedule Manager
dialog box.
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Name

Specifies the name of the task. You can change the default task name to something specific to your installation.

Description

Provides space to describes the purpose of the task.

New/Edit Task (Create Report) dialog box
Configure a task that will create and save a report or create and email a report. This task will be included in a
scheduled job.

To access these settings, click Add > Create Report on the Tasks tab of the Schedule Manager dialog box.

Name

Specifies the name of the task. You can change the default task name to something specific to your installation.

Description

Provides space to describes the purpose of the task.

Save report as a

Saves the report as a PDF or comma separated values (CSV) file in a specified folder. In the box, either type the path
where you want the report saved in the box, or click the browse button (...) to select the folder. If the Nuance Output
Manager Database Manager is on a different machine, you must enter the full UNC path.

Email report as a

Emails the report as a PDF or CSV file. You can either select an email profile from the list, or click the browse button
(...) to create one in the Manage Outbound Email Profiles dialog box.

Use the following options to configure the email messages that will be sent:

Priority — Set the priority level of the email as normal, low, or high.

Subject — Type a subject for the email.

To, Cc, Bcc — Enter the email addresses that will be sent messages in these. You can enter multiple email addresses
separated by a comma.

Reply to — Enter an email address where replies will be routed. You can enter multiple email addresses separated by
a comma.

Report to generate

Selects the report that you want to generate.

Report parameters

Configures the parameters for the selected report. The parameters will change depending on the report selected.
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New/Edit Task (Import Users and Groups) dialog box
Configure a task that imports users and groups.

To access these settings, click Add > Import Users and Groups on the Tasks tab of the Schedule Manager dialog
box.

Name

Specifies the name of the task. You can change the default task name to something specific to your installation.

Description

Provides space to describes the purpose of the task.

User Import Wizard

Click this button to launch the User and Group Import Synchronization Wizard. This wizard configures options to
import user data from a file, from a database, from an Active Directory server or from an LDAP server. Selections in
this wizard may affect options displayed in this dialog box.

Mapped OM Properties

Shows imported value mappings to Output Manager properties.

Users and groups to synchronize

Lists users and groups that will be syncronized with imported data.

Additional options
Describes additional options selected in the User and Group Import Synchronization Wizard.

New/Edit Task (LDAP Synchronization) dialog box
Synchronize all LDAP users known to Output Manager using the attribute mapping configurable from Manage
Users.

To access these settings, click Add > LDAP Synchronization on the Tasks tab of the Schedule Manager dialog box.

Name

Specifies the name of the task. You can change the default task name to something specific to your installation.

Description

Provides space to describes the purpose of the task.

New/Edit Task (Output History to Equitrac Import) dialog box
Configure a task that exports print reporting data for import by Equitrac.

To access these settings, click Add > Output History to Equitrac Import on the Tasks tab of the Schedule
Manager dialog box.
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Name

Specifies the name of the task. You can change the default task name to something specific to your installation.

Description

Provides space to describes the purpose of the task.

Equitrac Import File Info

Specifies information about the file to which to export print reporting data.

Option Description

Equitrac Import CSV File Specifies the full path to the file that that will contain ex
ported print reporting data in a comma separated values (
CSV) formatted text file. If the Equitrac location is on a
different machine, enter a full UNC path.

File mode Specifies whether to overwrite the destination file.

Time range Specifies the time interval over with data will be exporte
d.

Equitrac CAS Import Info

Specifies CAS server information for Equitrac.

Option Description

Import to CAS server Select this check box to import data to a Core Accountin
g Server (CAS).

CAS server The name of the CAS server.

Rules Agent server to run on The rules agent server to run the task.

Equitrac Import Application The Equitrac CAS utility that will import data to the CA
S server.

Delete CSV file upon success Select this check box to delete the exported data file after
a successful import. Only the file will be created and an e
xternal schedular will run the import logic.

Cmd option Provides space to add command line options for the imp
ort process. This option is typically unnecessary, but it m
ay be used by product support personnel.

New/Edit Task (Perform Rule) dialog box
Configure a task that will perform an ad hoc rule. This task will be included in a scheduled job.

To access these settings, click Add > Perform Rule on the Tasks tab of the Schedule Manager dialog box.

Name

Specifies the name of the task. You can change the default task name to something specific to your installation.
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Description

Provides space to describes the purpose of the task.

Choose the rule to perform

Selects the ad hoc rule you want this task to perform. You can select a rule from the list or click the browse button (...)
to create an ad hoc rule using the AdHoc Rules Manager dialog box.

Run mode — You can choose to run the rule using one of the following options:

• New documents since last run — Runs the selected rule against any documents that have arrived into the spool
since the last time the rule was run.

• All documents — Runs the selected rule against all documents in the spool that are not currently in retain.

New/Edit Task (Push Reporting Data to Database) dialog box
Configure a task that sends report data to a remote database.

To access these settings, click Add > Push Data to Reporting Database on the Tasks tab of the Schedule Manager
dialog box.

Name

Specifies the name of the task. You can change the default task name to something specific to your installation.

Description

Provides space to describes the purpose of the task.

Remote SQL Server instance

Identifies the Microsoft SQL Server instance that hosts the database where you want to send the report data.

Remote SQL authentication type

Specifies whether the system uses Microsoft Windows or Microsoft SQL Server credentials to connect to the database
on the server instance.

User name

Specifies the user name for connecting to the database with Microsoft SQL Server credentials.

Password

Specifies the user name password for connecting to the database with Microsoft SQL Server credentials.

Confirm Password

Confirms the password for connecting to the database with Microsoft SQL Server credentials.

Remote database name

Specifies the name of the database that stores the report data.
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Rules Agent server to run on

Specifies the Nuance Output Manager server that hosts the Rules Agent service that runs the task.

New/Edit Task (Update Output History with Page Counts) dialog box
Update output history with page counts or any entries that do not have already have a page count.

To access these settings, click Add > Update Output History with Page Counts on the Tasks tab of the Schedule
Manager dialog box.

Name

Specifies the name of the task. You can change the default task name to something specific to your installation.

Description

Provides space to describes the purpose of the task.

Security Configuration dialog box
Use the Security Configuration dialog box to define the type of access users and groups have to areas of the Output
Manager Console, destinations, sources, and documents. How you open the dialog box, determines the type of
permissions you are assigning.

• OM Console permissions — From the Output Manager Console menu bar, select Tools > Configure Security.
This will allow you to define the type of access users and groups have to areas of the Output Manager Console.
For example, you can assign permissions so that certain users can access the Destinations, Sources, and
Documents applications, but are restricted from the Administration application.

• Destination permissions — In the Destinations navigation pane, right-click the appropriate destination or group
and click Security. This will allow you to define the type of access users and groups have to destinations and
destination groups. For example, you can assign permissions on destinations so that certain users can configure the
destination and other users can only print to it.

• Source permissions — In the Sources navigation pane, right-click the appropriate source or group and click
Security. This will allow you to define the type of access users and groups have to sources and source groups. For
example, you can assign permissions on sources so that certain users can configure the source and other users can
only view it.

• Document folder permissions — In the Documents navigation pane, right-click the appropriate document folder
and click Security. This will allow you to define the type of access users and groups have to documents within
document folders. For example, you can assign permissions on document folders so that certain users can only
view the list documents in a folder and other users can view each document.

• Report permissions — In the Reports navigation pane, right-click the appropriate report or folder and click
Security. This will allow you to define the type of access users and groups have to reports and report folders. For
example, you can assign permissions on reports so that certain users can edit the report and other users can only
view it.

Inherit permissions from the parent (for destinations, sources, and document folders)

When a destination, source, or document folder is created, it automatically inherits permissions from its parent object.
You can assign additional permissions to inherited permissions, but you cannot selectively clear inherited permissions.

To remove inheritance for an object, you can click the browse (...) button to open the Security Configuration -
Change inheritance dialog box and then choose the Do not inherit option in the drop-down list. At the time that you
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choose this option, you can choose to Copy permissions from the parent. This allows you to use the previously
inherited settings as the basis for configuring permissions for the object. Removing inheritance for an object will
affect all of its descendant objects.

It is good practice to assign permissions using inheritance, as it allows administrators to easily assign and manage
permissions for many different descendant objects. Blocking inheritance should only be used to limit access to
selected users or to configure special settings for a particular object.

Users and groups with permissions

Lists the users and groups who have permissions assigned to them for the Output Manager Console. The permissions
for the selected item are displayed in the Assigned permissions list.

Add button

Adds a user or group to the dialog box so that you can assign permissions to the user or group. This opens the User
and Group Selection dialog box. You can add an Nuance Output Manager user, an LDAP user, or Windows user or
group.

Remove button

Removes the selected user or group. Removing the user or group will remove all assigned permissions, but it will not
remove the user or group from Output Manager. When you remove a user or group from an object, it will still retain
any inherited permission that are assigned to it for an ancestor in the object hierarchy.

Assigned permissions

Lists the permissions that can be assigned to the selected user or group. The type of security being configured
determines the permissions that display. To view the permissions, see User or Group Permissions.

Select All button

Selects all permissions for the selected user or group.

Unselect All button

Removes all permissions from the selected user or group.

User or Group Permissions

Security Type Permissions

Output Manager Console Allow user to run the Output Manager Console

Allow user to access the Destinations Application

Allow user to access the Sources Application

Allow user to access the Documents Application

Allow user to access the Library Application

Allow user to access the Reports Application

Allow user to access the Administration Application
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Security Type Permissions

Allow user to access the Message Console

Allow user to access the Audit Console

Allow user to view the Output History

Allow user to execute Ad hoc Rules

Allow user to manage Ad hoc Rules

Allow user to edit Business Rules

Allow user to access Schedule Manager

Allow user to edit Alert Rules

Allow user to configure Console Security

Allow user to configure Security Roles

Allow user to access the Process Designer

Allow user to Manage Resources

Allow user to save Document Queries

Allow user to Configure Columns

Allow user to configure desktop client

Allow user to Configure SNMP

Allow user to Detect Printers

Allow user to Manage Billing Accounts

Allow user to Manage the Nuance Output Manager Lice
nse

Allow user to Manage Users

Allow user to Manage Windows Queues

Allow user to Set General Preferences

Allow user to View Product Components

Allow user to run the Nuance Output Manager Web Con
sole

Allow user to access the Web Console Release Station

Allow user to access the Web Console Library

Allow user to access the Web Console Reports

Allow user to access the Web Console Document Submi
ssion Application

Destination Allow user to see the Destination
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Security Type Permissions

Allow user to print directly to the Destination

Allow user to enable, disable, pause, initialize, reset, and
refresh the Destination

Allow user to redirect output to another Destination

Allow user to change the Destination's runtime propertie
s

Allow user to modify the Destination’s configuration

Allow user to modify the Destination’s security configur
ation

Allow user to remove the Destination

Allow user to add Destinations (only applies to groups)

Allow user to add Groups (only applies to groups)

Allow user to remove the Group (only applies to groups)

Source Allow user to see the Source

Allow user to enable and disable the Source

Allow user to modify the Source’s configuration

Allow user to modify the Source’s security configuration

Allow user to remove the Source

Allow user to add Sources (only applies to groups)

Allow user to add Groups (only applies to groups)

Allow user to remove the Group (only applies to groups)

Document folder Allow user to see Folder

Allow user to see Document in lists

Allow user to change Document states

Allow user to restore Document from Retain

Allow user to change Document print ranges

Allow user to view and modify Document property valu
es

Allow user to modify Print Preferences

Allow user to modify security configuration

Allow user to view Document contents

Allow user to delete Documents
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Security Type Permissions

Allow user to assign Documents to destinations

Allow user to schedule Document output

Allow user to invoke Ad Hoc Rules

Allow user to add Folders below this Folder

Allow user to assign Document to a Folder

Library document folder Allow user to see Library Folder

Allow user to see Document in lists

Allow user to modify security configuration

Allow user to view Document contents

Allow user to delete Documents

Allow user to assign Documents to a different Library F
older

Allow user to add Folders below this Library Folder

Allow user to rename this Library Folder

Allow user to remove this Library Folder

Report Allow user to see the Report in the tree

Allow user to view the Report content

Allow user to edit the Report

Allow user to modify the Report security configuration

Allow user to remove the Report

Allow user to add Reports (only applies to folders)

Allow user to add Folders (only applies to folders)

Allow user to remove the Folder (only applies to folders)

Select Detection Options dialog box

Use this dialog box to configure settings for manually detecting devices through SNMP. Access the dialog box by
clicking Manage Devices > Detect now from the Administration application.

Use SNMP detection

Nuance Output Manager uses the SNMP service to search for devices on the network.
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SNMPv1

Nuance Output Manager searches for SNMPv1-enabled devices.

SNMPv3

Nuance Output Manager searches for SNMPv3-enabled devices.

Broadcast

Nuance Output Manager uses a broadcast query to search for devices.

IP Ranges

Nuance Output Manager searches IP address ranges for devices. You can import the ranges from a file, add a single IP
address range, or scan a domain for IP address ranges.

Use web (HTTP) detection (requires IP Range configuration)

If you use SNMP detection to query IP ranges, and devices do not respond to the SNMP queries, select this option to
query through HTTP as a backup. If Nuance Output Manager detects devices through HTTP, Nuance Output Manager
retrieves only the device manufacturer and model.

Import ranges from file button

Adds IP address ranges that are defined in a comma separated values (CSV) file. Verify that the values in the file are
formatted as follows:

startAddress,endAddress,optionalComment
startAddress,endAddress,optionalComment
startAddress,endAddress,optionalComment

The following example shows values from a CSV file:

10.16.16.0,10.16.16.255,
10.16.17.0,10.16.17.255,
10.16.18.0,10.16.18.255,My favorite range
10.16.28.0,10.16.28.255,
10.16.30.0,10.16.30.255,
10.16.80.0,10.16.80.255,Common Color range
10.201.4.0,10.201.4.255,
10.201.8.0,10.201.8.255,
10.201.9.0,10.201.9.255,

Add single IP range

Use this section to add a single IP address range. Specify the start and end addresses and click Add.

Discover domain IP ranges

Use this section to discover IP address ranges in a domain. The current domain appears by default. Network size
determines how long it takes Nuance Output Manager to discover IP ranges on a domain. Discovering IP ranges takes
longer on a large network.
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Discover button

Change the current domain if necessary and click this button to scan the domain for IP address ranges.

The Status indicator shows the number of computers found in the Active Directory. While the scan is in progress, the
indicator shows the approximate remaining scan time. The discovered IP addresses are grouped into ranges of 256
addresses (xxx.xxx.xxx.0 – xxx.xxx.xxx.255).

Select Organizational Units dialog box
Use this dialog box to select Organizational Units (OUs) from the container specified earlier. The utility will list
groups or users in these OUs.

Grid

Lists, in tree form, all the OUs in the container you specified.  Select check boxes for the OUs that you want to
search.

Do not import disabled accounts (User accounts only)

Specifies that you want to exclude disabled user accounts from being imported. This check box is not displayed when
you are importing groups.

Select Redirected Destination dialog box
Destinations can be set in a redirect mode. This causes new documents assigned to a destination to be automatically
reassigned to a different destination.

For example, you can use this dialog box to configure documents intended for Destination A to be redirected to
Destination B. Documents already assigned to Destination A when the redirection occurs, will not be redirected.
Documents received for Destination A while the redirection is in affect, will be assigned to Destination B. This
includes Destination A being assigned by a source as a document is received, Destination A being assigned during
business rule processing, and Destination A being assigned by failover processing. Destination assignments as a result
of failover to Destination A will also be redirected to Destination B.

You can access this dialog box by right-clicking a destination in the Destination tree or Destination grid.

Tree

Displays the Destination tree. From the tree, select the destination you want to receive the redirected documents.

Redirect options

Do not redirect printer — Disables destination redirect. Documents are sent to the destination.

Redirect until manually turned off — Enables destination redirect. Documents will be routed to the selected
destination until this option is disabled.

Redirect for number of hours — Enables destination redirect for a specified number of hours.

Redirect for number of minutes — Enables destination redirect for a specified number of minutes.

Redirect until — Enables destination redirect until a specific date and time.
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Select User Accounts/Groups to Import dialog box
After you specify the Organizational Unit (OU) to search, use this dialog box to select the groups or users to import.

Grid

Common name column — Specifies the common name (CN) attribute of this group or user.

Email Address column — Specifies the email address of this group or user.

Distinguished Name column — Specifies the DN (distinguished name) of the group or user.

Select All button

Selects all groups or users for import.

Unselect All button

Clears all selected groups or users.

Select User dialog box
During Nuance Output Manager service configuration, use this dialog to specify how the Nuance Output Manager
service will log on, as a local system account or a specific account. You can access this dialog box from the OM
services configuration tab.

Local System Account

Specifies the service will log on as a local system account. Use this option if the Nuance Output Manager DBM
Service will communicate with the local SQL database, local Nuance Output Manager services, and local file
resources.

This account

Specifies a specific service logon account. Click the browse button (...) to select the account.

Password/Confirm Password — Specifies the password for the service logon account.

Send Email dialog box
This dialog box is used when you create business rules, alert rules, or output processes that will send an email
message. You will also use this dialog box to configure email notification for the document library. Use this dialog
box to configure the email message.

Profile

Selects the email profile that will be used with this rule or output process. You can select a profile from the list or
click the Browse button and mange profiles from the Manage Outbound Email Profiles dialog box. From this dialog
box you can create and modify email profiles.
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Priority

Determines if the importance level of the email message. You can choose High Importance, Normal Importance, or
Low Importance. Normal importance is selected by default.

To

Specifies the email address that will receive notifications. You can enter multiple email addresses separated by a
comma. You can also right-click to select Document Properties to use within the address line.

Cc

Specifies email address that will be copied on the notifications. You can enter multiple email addresses separated by a
comma. You can also right-click to select Document Properties to use within the address line.

Bcc

Specifies email address that will be blind copied on the notifications. You can enter multiple email addresses
separated by a comma. You can also right-click to select Document Properties to use within the address line.

Reply to

Specifies the email address where replies will be routed. You can enter multiple email addresses separated by a
comma. You can also right-click to select Document Properties to use within the address line.

Subject

Specifies the subject of the email message. You can also right-click to select Document Properties to use within the
subject line.

Digest

Allows you to send the notification messages for multiple events concatenated into one email.

Send Digest — Specifies how often to send the email digest. You can choose from the following options:

• None — Does not send an email digest. All notification messages will be sent separately.
• Every interval — Sends the digest according to the time interval specified. You will receive a message every

interval, even if no alerts were received during the interval.
• At time interval — Sends the digest according to the time interval specified. The time interval will start when the

first notification messages is received. You will be notified when at least one notification has been received.
• Every hour — Sends the digest every hour. You will receive a message every interval, even if no alerts were

received during the interval.
• Every half hour — Sends the digest every half hour. You will receive a message every interval, even if no alerts

were received during the interval.

Interval — Specifies the time interval in minutes.

Max Alerts — Specifies the maximum number of alerts to be included in the digest.

Body

Specifies the text that will appear in the email message. The message can consist of text, one or more document
properties, and functions.



Output Manager Administration Guide
Version 4.0 SP2

640 © 2016 Nuance Communications, Inc. All rights reserved.

• To insert document properties, right-click in the text box, click Insert Document Property, and choose the
appropriate properties. The document properties will display enclosed in brackets ([]). The values of the properties
will display in the email message.

• To insert functions, right-click in the box, click Insert Function, and choose the appropriate function. Review the
Using Nuance Output Manager Functions help topic for information on configuring functions.

Validate button

Validates the body text.

Set General Preferences Utility
Use this utility to configure general administrative options such as setting the document file store path and the
document retention period.

The Set General Preferences utility is opened by clicking Applications > Administration > Set General
Preferences. Configure options on the following tabs:

Tab Description

General Sets general options in the preferences.

Destination Specifies which print preferences/document properties
are supported throughout Nuance Output Manager.

Security Configures security settings.

Reporting Configures reporting settings.

Kiosks Add, Remove and Configure kiosks associated with
devices and optional MFP/Kiosk profiles.

Clients Configures settings for client web servers.

General tab (Set General Preferences Utility)
Sets general options in the preferences.

Option Description

OM instance name Changes the Nuance Output Manager instance name.
The default name is Nuance Output Manager. The
instance name is used with licensing and association with
an SQL server.

System notification profile Set the Notification profile that allows the setting of noti
fications for items that affect operation of the system and
the administrator would like to be notified when a specif
ied event occurs:

• Administrative user added
• ASA expiration
• Business rules modified
• Database use exceeds threshold
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Option Description

• Destination configuration modified
• File store exceeds threshold
• General preferences modified
• Login failure count exceeded
• Output process modified
• Profile modified
• Resource modified
• Source error
• Source state changed
• Service is down
• Source configuration modified
• Specific message posted to message log

Retain documents Select this check box to retain documents globally and s
ets period and number for the OM instance. When you e
nable the retain feature, documents are saved to the reta
in folder after they print or are deleted from the Output
Manager Console. If you do not want to save deleted or p
rinted documents, disable the retain feature. Documents
are retained by default

Default retention period Specifies the number of days documents will be retained
when the Retain documents check box is selected. The
default period is 7 days.

Maximum retain size Specifies the maximum amount of documents that can b
e retained when the Retain documents check box is sele
cted.

The default value is 100,000 documents. If the maximum
value is reached, Nuance Output Manager performs a
cleanup routine to remove the oldest documents. This
will reduce the document count to match the maximum
number of documents.

Refresh external resources Select this check box to refresh of external resources use
d by Nuance Output Manager. External resources are any
resource (for example, a CSV file or banner) not stored i
n the Resource Manager. When this check box is select
ed, can specify the External resource refresh period, w
hich is the number of minutes between refreshes. The de
fault setting is 360 minutes. A value of 0 indicates no ref
resh.

External resource refresh period Specifies the time period (in minutes) to reload external r
esources used by Nuance Output Manager. The default v
alue is 360, and a value of 0 indicates no refresh. This op
tion is only available when Refresh external resources i
s selected.
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Option Description

Desktop client refresh period Specifies how often the complete list of billing accounts
is passed down to all the clients. If you create new billing
accounts, these will not be available until the next refresh
. The default value is 1440 minutes.

Desktop client popup timeout Period in minutes after which popups time out on the clie
nt. The default is 30 minutes.

Desktop client communication ports Set desktop client communication ports ranges. Specifie
s a range of port numbers. The default setting is 8100 to
8125.

Auto delete Spooled documents Enable or disable the automatic deletion of spooled docu
ments from the server. If this is enabled, you can set the
delete period in hours. The default is 24. Enable this opti
on to use green reports that show documents that have be
en automatically deleted from the server after being spoo
led but never printed.

Document file store path Lists all configured file stores on this Nuance Output
Manager database. The Nuance Output Manager
database only stores the properties of a document. The
actual files are stored in network folders, called file
stores. You can define multiple file stores that will be
available for selection from individual sources on the
More settings tab. The default file store is selected by
default.

• Location column — Displays the file store path.
• Default column — Selects the default file store. The

default file store will be used when a file store has
not been specified. By default sources are configured
to use the default file store on the More settings tab.
If you change the default file store in the grid, all
sources using the default will also be updated.

• Status column — Displays the current status for the
file store:

• In-use — Indicates this Nuance Output Manager
database has submitted documents to the file
store.

• Empty — Indicates no documents have been
placed in the file store from this Nuance Output
Manager database. The Windows folder could
have folders in it from other Nuance Output
Manager database activity.

• New — Indicates the file store has not been
entered into the Nuance Output Manager
database. You will need to click Apply to add the
file store to the database.
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Option Description

The command buttons allow you to add, edit, view
details for, and remove paths from the table.

• Add button — Adds a file store. This opens the Add
File Store dialog box in which you can specify a
UNC path ( \\hostname\share). You can click
the browse (...) button to create a folder or locate an
existing folder.

Verify the file store folder does not contain any
empty folders. Empty folders in the file store folder
will be deleted when the Nuance Output Manager
cleanup process runs.

Note:  The Nuance Output Manager DBM
service must have any necessary permissions
that are required to access the selected
network folder.

• Edit button — Allows you modify the UNC path for
the selected file store. This opens the Edit File Store
dialog box. You cannot edit a file share that with an
In-Use status.

• Remove button — Removes the selected file stores.
You can only remove file stores with a New status.

• Details button — Displays the usage details of the
drive where the file store is located. This opens the
File Store Details dialog box.

Destination tab (Set General Preference Utility)
Specifies which print preferences/document properties are supported throughout Nuance Output Manager.

Option Description

Printer family definitions Click the Import button to import an existing PFD (printe
r family definition) that contains the settings you want to
apply to Nuance Output Manager.

Set destination to unspecified printer family This option specifies the default printer families on desti
nations where the default has not been configured. Click
the Set button to set default printer families on destinatio
ns where default has not been configured.

Global group routing map This option configures the global group routing ma
p with document properties to routing columns. The
Configure button opens a dialog box that allows the con
figuration for mapping of routing columns to document p
roperties .

Domains Use this to configure the default domain to use or to hide
a domain.
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You can manually select the print preferences/document properties from the Configure Document Properties
Utility, which is opened by clicking Applications > Administration > Configure Document Properties. From
this utility you can also select the settings that are allowed for a particular property. These settings determine what is
available to the user in the dialogs where properties are configured.

Note:  You can further restrict these options for individual destinations by configuring destination specific
capabilities from the More settings tab in the configuration dialog box for a destination. (To open the
configuration dialog box for destination, right-click a destination in the Destinations application and click
Configure.)

Security tab (Set General Preference Utility)
Configures security settings.

Option Description

Require strong passwords Select this check box to enable strong password
composition. If this option is enabled, passwords must
meet the following requirements:

• Minimum of 8 characters
• Contain at least 1 upper case alpha character
• Contain at least 1 lower case alpha character
• Contain at least one number
• Contain at least one special character
• Not contain the same character more than twice

Password expiration period Specifies the password expiration period in days. When t
he expiration period is reached, you must create a new p
assword. Passwords must not be changed more than onc
e in a 24-hour period without intervention by a security a
dministrator.

Passwords to save in history Specifies the number of passwords to save in history. Wh
en changing passwords, any passwords saved history are
not allowed to be reused.

Use automatic account lockout Select this check box to lock out users who repeatedly tr
y but fail to enter the correct password. This can reduce t
he risk of unauthorized intrusions by password guessing
. Configure the Lockout threshold settings to specify th
e number of tries in a specified number of minutes that w
ill lock out a user. The default is 5 tries within a 5 minut
e period.

Automatically unlock account Select this check box to automatically unlock accounts th
at reach the Lockout threshold after the number of minut
es specified by Lockout period. An administrator will h
ave to unlock locked accounts if you do not select this ch
eck box. The default period is 15 minutes.

Save auditing information Saves or discards auditing information in the Audit
Console. Audit information focuses on security-related a
ctions performed by users. Auditing information is saved



Output Manager Administration Guide
Version 4.0 SP2

645 © 2016 Nuance Communications, Inc. All rights reserved.

Option Description

by default. For a complete list of actions that will be save
d, see Actions Saved in Auditing Information.

Configure AD/LDAP sync Click the Configure button to open a dialog box to allow
the mapping of appropriate Output Manager Properties t
o the Active Directory attributes.

External client login Options in this group configures embedded MFP client u
ser logins. Select or clear check boxes to enable or disabl
e the following settings:

• Allow user name / password — The user can log
in by entering user name, password, and selecting a
domain.

• Allow card swipe — The user can log in through a
card swipe. The user must also enter a pin if Require
PIN with card swipe is also selected.

• Allow manual card ID entry — The user can log in
by entering an ID. The user must also enter a pin if
Require PIN with manual entry is also selected.

• Allow unmasked card ID — The card ID will be
readable as it is entered. If you clear this check box,
the card ID will be masked.

• Default manual login method — Select the default
login method users will see. It can be either of the
following:

• Card ID Entry
• User Name/Password

• Require PIN with card swipe — Users must also
enter a pin when using a card swipe.

• Require PIN with card ID entry — Users must also
enter a pin when using manual card ID entry.

Actions Saved in Auditing Information

This topic lists actions that are saved when the Save auditing information check box is selected in the Set Preferences
Utility dialog box.

Note:  More actions may be added in later versions of this application.

Audit action disabled
Audit action enabled
Console security permission added
Console security permission removed
Destination added
Destination changed
Destination deleted
Destination security parent changed
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Destination security permission added
Destination security permission removed
Document deleted
Document folder changed
Document security parent changed
Document security permission added
Document security permission removed
Document status changed
Document uploaded
Document viewed
Library document deleted
Library document folder changed
Library document status changed
Library document viewed
Library security parent changed
Library security permission added
Library security permission removed
Logon
Query security parent changed
Query security permission added
Query security permission removed
Report security parent changed
Report security permission added
Report security permission removed
Report viewed
Security role permission added
Security role permission removed
Security role user added
Security role user removed
Source added
Source changed
Source deleted
Source security parent changed
Source security permission added
Source security permission removed

Reporting tab (Set General Preference Utility)
Configures reporting settings.

Option Description

Save accounting information Select or clear this check box to save or discard accounti
ng information. The default setting is to save accounting
information.

Maximum message log size Specifies the maximum entries that will be logged in the
Message Console. The default value is 10,000 entries. If
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Option Description

the maximum value is reached, Nuance Output Manager
performs a cleanup routine to remove the oldest message
s. This will reduce the message count to match the maxi
mum number of messages.

Use the Configure button to adjust the message priority
level for logging and the display level for any user that
configures logging.

Output history period Specifies the number of days that will be saved in the
Destination Output History window. The default perio
d is 1095 days (3 years). The maximum period is 3650 d
ays (10 years) Limiting the amount of data stored in the
output history table is particularly important if you are u
sing SQL Server Express, as there is a 4 GB limitation o
n the data file.

Reporting query timeout Specifies the reporting query timeout period. Reporting q
ueries by default time out in 30 seconds. If you have a re
port that is timing out, and you do not mind waiting long
er you can increase this timeout period.

Generally, a better solution is to determine why the query
is taking so long to complete. For example, decreasing
the Output History Period setting will reduce the
number of rows in the output history table and will cause
most reports to run faster.

Maximum report size Specifies the maximum number of records in a report. Th
e default value is 10,000 records.

Kiosks tab (Set General Preference Utility)
Add, Remove and Configure kiosks associated with devices and optional MFP/Kiosk profiles.

Option Description

Kiosk name This column shows the name for a kiosk.

Enabled You can select or clear the check box in this column to e
nable or disable a kiosk.

Add Click this button to add a kiosk. This button opens the
Configure Kiosk dialog box in which you specify the na
me and associate devices for a new kiosk.

Remove Click this button to remove the selected kiosk.

Configure Click this button to or configure the preferences profile t
he selected kiosk.
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Clients tab (Set General Preference Utility)
Configures settings for client web servers.

Options in this dialog box are grouped in three sections:

• Unified Client document display limit on page 648
• Device Registration Service on page 648
• Configuration for client web servers on page 648

Unified Client document display limit

Option Description

Client document display limit Specifies the maximum number of documents that appea
r in the list of documents to be released from the device.
The list appears on the device panel. Enter a value betwe
en 1 and 999. The default value is 40.

Device Registration Service

Option Description

Device registration server Specifies the server that runs the device registration servi
ce. Specify the localhost if it is run on the same machine
as Output Manager.

Services port The port used by the services.

Web client port The port used by the web client.

Use SSL Specifies to use SSL to communicate with web clients.

Launch Device Registration Client Launches the Device Registration Client.

Configuration for client web servers

Option Description

Client web server Select the client web server to configure in this box.

Server host Specifies the host for the selected client web server.

Application directory Specifies the relative path to the application directory on
the web server.

Server port The server port can be configured unless the port is using
SSL configured on the SSL Certification Manager tab i
n the Output Manager Server Configuration Utility.

Virtual root Specifies the relative path to the virtual root directory fo
r the web server.

Application Open API port Enter the port number on which the Open API service wi
ll be running. The default is 13351.
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Option Description

An Output Manager device registration requires the
OpenAPI port setting to be configured. If the device
has problems communicating, ensure the port setting
configured here matches the value that is set for the
device through Device Registration Service. Also ensure
there is no firewall software or hardware blocking the
specified port and that IP-routing has been set up to
allow communication on this port.

Authority Open API port Enter the port number through which Open API user aut
hentication and authorization requests are handled. The d
efault is 13353.

Groups for user based licensing

These settings license usage for all users in a specified group.

Option Description

Printing Specifies group licensing for printing.

Scanning Specifies group licensing for scanning.

Mobile Specifies group licensing for mobile.

Set Priority in Group dialog box
Use this dialog box to configure the Set Priority in Group Ad Hoc rule action. The settings define how to arrange
the order of documents in a package (group) based on document property values.

You can access the dialog box when configuring an Ad Hoc rule using the Ad Hoc Rules Manager. You can also
access the dialog box by right-clicking on a document and selecting Run AdHoc Action > Set Priority In Group,
which re-orders the documents in an existing package.

Ordering properties

Specifies the document properties that control the document order in the package. Expand the sections and select the
document properties.

Selected order

Shows the order of the selected properties.

Move up button

Moves a property up in the order.

Move down button

Moves a property down in the order.
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SNMP Server Configuration dialog box
Use this dialog box to configure an Output Manager SNMP Service installation in the Manage Devices Utility. You
can determine the SNMP detection method and determine how frequently to update SNMP metering, dynamic values,
and static values.

The following limitations apply when specifying date and time values in fields on the dialog box:

• The format for date and time fields is dd.hh:mm:ss (days.hours:minutes:seconds).
• Date and time fields do not accept values that are not valid.

For example, you cannot specify more than 14 days, more than 23 hours, more than 59 minutes, or more than 59
seconds.

• The maximum value in a date and time field is 14 days (14.00:00:00).

If you set the days value to 14, you cannot enter hours, minutes or seconds, as doing so would create a period
longer than 14 days.

Tip:  To specify hours, minutes, or seconds, set days to a value that is less than 14.

Default IP detection Ranges

Click Configure ranges to define the IP address ranges that Nuance Output Manager searches when automatically
detecting devices on the network.

Autodetection

Option Description

Auto-detection period Specifies the interval Nuance Output Manager uses to
automatically search the network for new devices.

For example, if you type 00.04:00:00, Nuance
Output Manager searches the network every four hours.

Use SNMP detection Nuance Output Manager uses the SNMP service to
search for devices on the network.

SNMPv1 Nuance Output Manager searches for SNMPv1-enabled
devices.

SNMPv3 Nuance Output Manager searches for SNMPv3-enabled
devices.

Broadcast Nuance Output Manager uses a broadcast query to search
for devices.

IP Range(s) Nuance Output Manager searches ranges of IP addresses
for devices. Click Configure ranges to define the IP
address ranges.
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Option Description

Use web (HTTP) detection (requires IP Range
configuration)

If you use SNMP detection to query IP ranges, and
devices do not respond to the SNMP queries, select this
option to query through HTTP as a backup. If Nuance
Output Manager detects devices through HTTP, Nuance
Output Manager retrieves only the device manufacturer
and model.

SNMP update and meter parameters

Option Description

Use DNS printer names if available Specifies if you want to use the Domain Name System
(DNS) instead of the IP address when communicating
with a printer.

Default community name Specifies the community name for communication
through SNMPv1 or SNMP2 during device detection.
Nuance Output Manager uses public as the default
community name. If you change the Nuance Output
Manager default community name, update SNMPv1-
or SNMP2-enabled devices to use the new community
name.

Default SNMP version Specifies the SNMP version. You can choose Auto,
SNMPv1, SNMPv2c, or SNMPv3. The default is
SNMPv2c.

Nuance Output Manager dynamically determines the
actual SNMP version used to communicate with the
device as follows:

• If the default version is SNMPv1, SNMPv2c, or
SNMPv3 and the specific device supports that
version, the SNMP service uses the selected default
version.

• If the default version is set to Auto or the device does
not support the selected default version, the SNMP
service uses the highest version supported by the
device.

• If the default version is SNMPv3, the SNMP service
checks for SNMPv3 security settings. If the services
does not find security settings, the service uses
the next highest version supported by the device
(SNMPv2c or SNMPv1).

Allow SNMPv1/v2c queries Specifies if Nuance Output Manager queries the network
for SNMPv1- and SNMPv2c-enabled devices. Selecting
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Option Description

this option and Allow SNMPv3 queries increases the
time it takes Nuance Output Manager to detect devices.

Allow SNMPv3 queries Specifies if Nuance Output Manager queries the network
for SNMPv3-enabled devices. Selecting this option and
Allow SNMPv1/v2c queries increases the time it takes
Nuance Output Manager to detect devices.

SNMP metering

SNMP metering periodically gathers information from a device about how many copies, prints, faxes, scans, and so
on, have been made and saves the data. It is not by user, just overall counts for the device. You can run SNMP Meter
History reports on the data in the Reports application. SNMP metering is only available for certain devices.

Option Description

Update metering values Specifies if you want to automatically update metering v
alues.

SNMP metering period Specifies how often you want to automatically perform S
NMP metering. The default period is one day (01.00:0
0:00).

SNMP metering timeout Specifies the amount of time Nuance Output Manager w
aits for a response from the device. The default is 3600 s
econds. If the device does not respond after 3600 second
s, Nuance Output Manager sends the next update reques
t according to the SNMP metering period that you specif
ied.

Static update

Static values are values that do not change or change very infrequently, such as the printers name and IP address.

Option Description

Update static values Specifies if you want to automatically update static valu
es.

Static update period Specifies how often you want to automatically update de
stinations. By default the static update frequency is set to
7 days (07.00:00:00).

Static update timeout Specifies the amount of time in seconds Nuance Output
Manager waits for a response from the device. The def
ault is 0, meaning there is no timeout. If the device doe
s not respond after the timeout period, Nuance Output
Manager sends the next update request according to the s
tatic update period that you specified.
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Dynamic update

Dynamic values are values that can change while the printer is being used, such as out of paper and low on toner. In
most cases, dynamic values should be configured to update more frequently than static values. Dynamic value updates
are needed to maintain timely alerts so the printer can stay operational.

Option Description

Update dynamic values Specifies if you want to automatically update dynamic v
alues.

Dynamic update period Specifies how often you want to automatically update de
stinations. By default the dynamic update frequency is se
t to five minutes (00:00:05:00).

Dynamic update timeout Specifies the time in seconds Nuance Output Manager w
aits for a response from the device. The default is 0, mea
ning there is no timeout. If the device does not respond a
fter the timeout period, Nuance Output Manager sends th
e next update request according to the dynamic update pe
riod that you specified.

Alert Monitor

By default, the Alert Monitor polls the DBM service every 60 seconds for devices in an alert condition and queries
them through SNMP for updated status information. The monitor sends query results back to the DBM service. The
monitor collects status information separately to provide more frequent updates to devices that are in an alert status
for prompt delivery to the Nuance Output Manager Console. You can increase the interval to reduce network traffic.

Option Description

Allow alert checks Select to enable the monitor feature for custom polling i
ntervals.

Check current alerts every <interval> minutes Specifies the interval after which the monitor polls the D
BM service and queries devices for updated status infor
mation.

Global SNMPv3 settings

Nuance Output Manager supports SNMP version 3 (SNMPv3) for increased security when communicating with
devices. You can configure Nuance Output Manager and devices to communicate through SNMPv3 with matching
global security settings as described in the following table:

Option Description

User Specifies the user name that Nuance Output Manager use
s to communicate with SNMPv3-enabled devices.

Authentication Password Specifies the password that Nuance Output Manager use
s to authenticate devices.

Protocol Specifies the protocol for authenticating devices.
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Option Description

Encryption password An optional setting for specifying a password to encrypt
data exchanged between Nuance Output Manager and de
vices.

Algorithm Specifies the protocol that Nuance Output Manager
uses to encrypt data. Data encryption is optional. If you
encrypt data, verify that the encryption values in Nuance
Output Manager match the SNMPv3 settings on the
devices.

Remote engine context name Specifies the name of a specific context for SNMPv3
communication between Nuance Output Manager and
SNMPv3-enabled devices.

Not all devices require a context name to communicate
through SNMPv3. If Nuance Output Manager cannot
communicate with a device using the context name,
Nuance Output Manager does not use the context name
on subsequent attempts to communicate with the device.

Not all devices display the engine context name in their
configuration pages. Some devices do not communicate
with SNMP v3 if the engine context name is not
specified.

If you want Nuance Output Manager to communicate with a device with different SNMPv3 settings, you can override
the global SNMP settings for the device.

Source Properties Profile dialog box
Use this dialog box to configure the source properties profiles that are available to AutoStore, Windows queues, and
Web Upload sources.

Source properties profiles contain the print preferences/document properties that are supported by a specific source.
You can also select the settings that are allowed for a particular property. These settings determine what is available to
the user in the dialogs where properties are configured for this source.

Name

Specifies the profile name.

Description

Specifies a description of the profile.
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Print preferences

Lists the print preferences/document properties that are available for this source. They are grouped into the following
categories: Basic options, Media selection, Document, Image adjustments, Finishing, and Other properties. To expand
a category, click the down arrow next to a category name. To collapse a category, click the up arrow.

Under each category are the document properties that belong to that group. In each group, you can determine the
properties that are supported by this source. Select the check boxes for properties you want to be available for
configuration. Clear the check boxes for properties you do not want to be available.

If a property is configured by selecting from a list of options, those options will display beneath the property. You can
select and clear the check boxes to determine the choices that will be available when those properties are configured
for this source.

Source Configuration dialog box
Use this dialog box to configure sources.

Create a source by right-clicking a folder in the Sources application and clicking New Source on the shortcut menu.

Options

Option Description

Name Specifies the name of the source.

Server Specifies the Nuance Output Manager server where the
Nuance Output Manager Input Service is located for this
source. The source does not have to be on the same serve
r as the Nuance Output Manager Input Service.

Comments Lists any general comments about the source.

Location Specifies any specific location information for the sourc
e.

Select Image Displays an email source image. To change the source i
mage, click Select Image and choose the appropriate im
age file (BMP, JPEG, or PNG). The selected image will
be compressed and scaled to 96x96 pixels. Changing this
image will not change the smaller image that displays or
the image that displays in the source tree. To change the i
mage back to the default, click Reset Image.

General tabs

The following tabs provide general settings for any type of source.

Tab Description

Document Properties tab (Source Configuration) on
page 657

Settings on this tab configure document properties that
will be applied to all documents received by this source.

Filters tab on page 662 Use this tab to configure filters for the selected source.
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Tab Description

More Settings tab (Source Configuration) on page 666 Use this tab to configure common configuration options
that available to all source types. You can access this tab
when you create or configure a source.

Output Settings tab (Source Configuration) on page
667

Use this tab to configure output options that available to
all source types. You can access this tab when you create
or configure a source.

Source specific tabs

The following tabs provide settings for specific types of sources.

Icon Source Description

AutoStore Settings tab (Source
Configuration) on page 657

Configure settings on this tab for an
AutoStore source.

Email settings tab (Source
Configuration) on page 659

Use this tab to configure an email
source.

FTP Settings tab (Source
Configuration) on page 662

Use this tab to configure an FTP
source.

IPP Settings tab (Source
Configuration) on page 664

Use this tab to configure an IPP
(Internet Printing Protocol) source.
You can access this tab when you
create or configure an IPP source.

LPD Settings tab (Source
Configuration) on page 665

Use this tab to configure an LPD
source.

OM source (no source specific settin
gs)

NetWeaver source (no source specifi
c settings)

PRISMAProduction settings tab
(Destination Configuration) on page
508

Use settings on this tab to configure
a PRISMAProduction destination for
an Océ PRISMAproduction server.

Folder Settings tab on page 663 Use this tab to configure a network
folder source.

Output Manger source (no source spe
cific settings)

Socket settings tab (Sources) on page
668

Use this tab to configure a socket
source.

WCF API source (no source specific
settings)
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Icon Source Description

Web Upload Settings tab (Source
Configuration) on page 669

Use this tab to configure a Web
upload source.

WebSphere MQ settings tab (Source)
on page 670

Use this tab to configure a
WebSphere MQ source.

Windows Queue Settings tab (Source
Configuration) on page 670

Use settings on this tab to configure a
Windows queue source.

AutoStore Settings tab (Source Configuration)
Configure settings on this tab for an AutoStore source.

Option Description

Source capabilities profile Specifies the capabilities profile for an AutoStore source.
Select a capabilities profile or click the browse button ...
to create or edit a source properties profile.

A source properties profile specifies print preferences
and settings that will be available to a source. You
can select a profile for an AutoStore source, or the
Default profile, or All Capabilities. The All Capabilities
option selects to make all print preferences and settings
available to the source.

Document Properties tab (Source Configuration)
Settings on this tab configure document properties that will be applied to all documents received by this source.

Option Description

Use advanced document properties Enables the use of advanced document properties.
Advanced document properties facilitate the setting of
document properties from multiple sources. Document
properties can be set from Output Manager Print Server
headers, LPD headers, job tickets, data contained in the
document, or fixed values, and so on.

Advanced document properties is a complex feature that
only advanced users and professional service engineers
should configure.

Use the Advanced document properties check box
to enable or disable the feature. Use the drop-down list
to select the default document properties profile or an
existing profile.

• New — Displays the Document Properties Profile
dialog box for creating a new document properties
profile.

• Edit — Displays the selected profile for modification.
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Option Description

• Manage — Displays the Manage Document
Properties Profiles dialog box, which lists all of
the defined document properties profiles. From
this dialog box you can create, import, and export
profiles, as well as manage all existing profiles.

Document owner Specifies the Nuance Output Manager user that will be
the owner of all documents received using this source.
Click the browse button (...) to select a user.

Document properties grid

Entries in this grid specify document property values. Modify the properties directly in the Mode and Value columns.

Column Description

Document Property Lists the property values that can be configured. The
properties are grouped into the following categories:
Basic options, Media selection, Document, Image
adjustments, Finishing, and Other properties. To expand
a category, click the down arrow next to a category
name. To collapse a category, click the up arrow.

Under each category are the print preferences/document
properties that belong to that group. The first node level
in the categories determine the print preferences for
the properties it contains. On the print preference node,
you select how the property should be applied when
a document is sent to a destination. Under each print
preference are the parameters needed to generate that
print preference.

Note:  The document properties that display
are controlled using the Configure Document
Properties Utility.

Mode Specifies how to apply the property value. Click in the
cell and choose one of the following options:

• Always Apply — Always applies the specified
property value. Nuance Output Manager will
add commands to the print stream to enforce the
print preference. If the document already contains
commands for that print preference, Nuance Output
Manager will modify the commands to work with the
printer family where the document is being sent.

• Informational Only — Nuance Output Manager
makes no changes to the print stream when the
document is sent to the destination. The value is for
informational purposes only.
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Column Description

Value Specifies the document property value. Click directly in
the cell to change the value.

Email settings tab (Source Configuration)
Use this tab to configure an email source.

Documents received by the specified email account will be routed to Nuance Output Manager. You can access this tab
when you create or configure an email source.

Email settings

Option Description

Protocol Select POP3 to use a Post Office Protocol connection
between the Output Manager server and the email
server. Select IMAP4 to use an Internet Message Access
Protocol connection.

Email server Enter a valid mail exchange server. You can also click
the browse button (...) to display the Mail Server Search
dialog box and search for an email server on a given
domain.

• POP3 — Specifies to use the POP3 protocol to access
the email server.

• IMAP4 — Specifies to use the IMAP4 protocol to
access the email server.

• Exchange Web Services — Use Exchange Web
Services (EWS) to access the email server. EWS
must be active on the email server to support this
option.

Port  Specifies the port number for the selected protocol. The
following table lists common port assignments for the
protocols that Output Manager supports:

Protocol Port

POP3 110

POP3 (SSL enabled) 995

IMAP4 143

IMAP4 (SSL enabled) 993

EWS 443/TCP (HTTPS)

The port number for your environment may vary. Refer
to an email server administrator for more information.
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Option Description

Note:  This setting is unavailable and the port
number is configured by the application when
Exchange Web Services is selected for Email
server.

EWS connection Select the option to use to discover and connect to the Ex
change server when Exchange Web Services is selected f
or Protocol:

• Autodiscover via email address — Specify an email
address.

• Service URI — Specify the service URI (such as
mail.domain.com).

Use SSL Select to use SSL (Secure Sockets Layer) to encrypt
the connection between the email server and Output
Manager.

User name Specifies the user name that will be used when logging
in to the email account. If the email account does not
require a user name, you can leave this box blank.

Password/Confirm Password Specifies the user password that will be used when
logging in to the email account. If the email account does
not require a password, you can leave these boxes blank.

Interval Specifies the time interval for checking the email
account for documents. The default value is 60 seconds.

Delete messages Deletes the email messages and their attachments from
the email server once they have been received into
Nuance Output Manager. This option is selected by
default.

Include the following email components in a
secondary document

Select the email components to include in a separate
components document that users can print. When
Nuance Output Manager receives an email, Nuance
Output Manager resolves its attachments into documents
and creates the components document. Nuance Output
Manager then creates a single package that contains all
the documents from the email, the attachments, and the
components document.

Epic Settings tab (Source Configuration)
Use this tab to configure an Epic health information source.

Epic documents located in a specified folder will be routed to Nuance Output Manager. You can access this tab when
you create or configure an Epic source.
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Option Description

Folder Specifies the path of the network folder to be monitored.

For the selected folder, you must configure the Nuance
Output Manager services logon account user name to
have Full Control Sharing permissions. Also verify
the Administrators group has Full Control Security
permissions. Right-click the folder in Windows Explorer
and click Sharing and Security to configure these
options.

Scan subfolders Select the check box to monitor subfolders within specif
ied network folder.

Interval Specifies how often to check the selected folder for files.
The default time interval is 10 seconds.

Order Specifies the order in which Nuance Output Manager rec
eives files from the network folder.

Disposition Specifies what happens to a file in the network folder aft
er it is sent to Nuance Output Manager.

• Delete — Deletes the original file after sending it to
the Nuance Output Manager. This option is selected
by default.

• Leave — Does not delete or move the original file
after it is sent Nuance Output Manager. This causes
the file to be sent repeatedly (once each polling
Interval) until you delete it.

• Move — Saves the file in another folder after it is
sent Nuance Output Manager. If a file by the same
name already exists in the folder, the new file will be
saved with an incrementing number. For example, if
file ABC is sent to a folder that already contains a file
named ABC, the new file will be saved as ABC_001.
Enter the folder path in the Move to box.

• Move/Overwrite — Saves the file in another folder
after it is sent Nuance Output Manager. If a file
by the same name already exists in the folder, the
existing file will be replaced by the new file. Enter
the folder path in the Move to box.

Move to Specifies the path for the folder to which documents a
re moved when Move or Move/Overwrite is selecte
d for Disposition. This option is available only when
Disposition is set to Move or to Move/Overwrite.

EPS binaries The path of the EPS (Epic Print Service) binaries folder.
An example, for a default installation, would be C:\Epi
c\bin\8.1\Epic Print Service.



Output Manager Administration Guide
Version 4.0 SP2

662 © 2016 Nuance Communications, Inc. All rights reserved.

Option Description

EPS incoming The path of the EPS watch folder. An example for a defa
ult installation would be C:\Epic\Jobs\Incoming
\8.1\Epic Print Service. Output Manager will
monitor the configured watch Folder. Any unrecognized
file will be moved it to this folder for EPS handle. Outpu
t Manager currently supports .ERTF files and .ERAW fil
es. Other file types will be moved to this folder.

Convert ERTF To PDF Select this check box to convert Epic ERTF formatted fi
les to PDF.

Delete files not intended for print Select this check box to delete ERTF files that specify in
document header specifies that a document is not to be p
rinted.

Filters tab
Use this tab to configure filters for the selected source.

Filters restrict documents from the source by including or excluding certain groups.

The Filters tab is only available when configuring email, network folder, and LPD sources.

Filter grid

Allows you to restrict documents from a source by including or excluding certain groups.

The Filter column lists the filter criteria, specific to the selected source type. You can modify the filter values by
typing directly in the Regular Expression Value column. Wild card values of ? or * are accepted, as long as the
expressions first character is a numeric or alphabetic character. This filter will be applied to each document received
by the selected source.

Show tags

Shows or hides a Tag column in the grid.

Show descriptions

Shows or hides a Description column in the grid.

Regular Expression Tester

Verifies the expression syntax is valid.

FTP Settings tab (Source Configuration)
Use this tab to configure an FTP source.

Documents received by this source will be routed to Nuance Output Manager. You can access this tab when you
create or configure an FTP source.

FTP server — Specifies the FTP server, which can be an FTP or IP address.

Port — Specifies the host's port number. The port number must be from 1 through 65536. The default value is 21.
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Use passive mode — Determines if the host mode will be passive or active. Selecting the check box selects passive
mode, where the client creates a session to receive data. Clearing the check box will specify active mode, where the
host creates a separate or new session to transfer data in response to a request from the client.

User name — Specifies the user name that will be used when logging on to the server. If the server does not require a
user name, you can leave this box blank.

Password/Confirm Password — Specifies the user password that will be used when logging on to the server. If the
server does not require a password, you can leave these boxes blank.

FTP folder — Specifies the location on the host from which the files will be retrieved when receiving files. You
must type the entire path of the folder or the path relative to the FTP user home directory (for example, if your home
directory is at \FTP\UserName, you can specify either \FTP\UserName\MySourceFiles or \MySourceFi
les).

Scan subfolders — Determines if you want to scan any subfolders of the specified FTP folder.

Remove subfolders — Determines if you want to delete the subfolders of the FTP folder, after the files are
transferred into Nuance Output Manager.

Interval — Specifies the time interval for checking the host for documents. The default value is 60 seconds.

Temp folder — Specifies the location files are transferred into during the FTP session. When the session is complete
they are put in the file store.

Folder Settings tab
Use this tab to configure a network folder source.

Documents received by this source will be routed to Nuance Output Manager. You can access this tab when you
create or configure a network folder source.

Option Description

Folder Specifies the path of the network folder to be monitored.

For the selected folder, you must configure the Nuance
Output Manager services logon account user name to
have Full Control Sharing permissions. Also verify
the Administrators group has Full Control Security
permissions. Right-click the folder in Windows Explorer
and click Sharing and Security to configure these
options.

Scan subfolders Select this check box to monitor subfolders within the sp
ecified network folder.

Interval Specifies how often to check the selected folder for files.
The default time interval is 10 seconds.

Order Specifies the order in which Nuance Output Manager rec
eives files from the network folder.

Disposition Specifies what happens to a file in the network folder aft
er it is sent to Nuance Output Manager.
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Option Description

• Delete — Deletes the original file after sending it to
the Nuance Output Manager. This option is selected
by default.

• Leave — Does not delete or move the original file
after it is sent Nuance Output Manager. This causes
the file to be sent repeatedly (once each polling
Interval) until you delete it.

• Move — Saves the file in another folder after it is
sent Nuance Output Manager. If a file by the same
name already exists in the folder, the new file will be
saved with an incrementing number. For example, if
file ABC is sent to a folder that already contains a file
named ABC, the new file will be saved as ABC_001.

• Move/Overwrite — Saves the file in another folder
after it is sent Nuance Output Manager. If a file
by the same name already exists in the folder, the
existing file will be replaced by the new file.

Move to Specifies the path for the folder to which documents a
re moved when Move or Move/Overwrite is selecte
d for Disposition. This option is available only when
Disposition is set to Move or to Move/Overwrite.

IPP Settings tab (Source Configuration)
Use this tab to configure an IPP (Internet Printing Protocol) source. You can access this tab when you create or
configure an IPP source.

The settings on this tab configure the URL that is used to communicate with an IPP printer. The URL is formed as
follows:

http://ipaddress:port/instancename

Make sure that the network and firewall are configured to allow incoming traffic to the specified IP address and port
number.

Option Description

IP address Specifies the IP address for the IPP printer.

Enable SSL Select this check box to use SSL to communicate with th
e printer.

Port Specifies the port that the server uses to communicate wi
th the printer. The default port setting is 631.

Instance name Specifies the instance name for the printer.
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LPD Settings tab (Source Configuration)
Use this tab to configure an LPD source.

Documents received by this source will be routed to Nuance Output Manager. You can access this tab when you
create or configure an LPD source.

Port — Specifies the host's port number. The default value is 515.

IP address — Specifies the host’s IP address. Click the Browse button to select one of the available connections, or
enter the IP address directly in the box.

Temp folder — Specifies the location files are transferred into during the LPD session. When the session is complete
they are put in the file store.

LPD queues — Lists all defined LPD queues. Select the check boxes in the Enabled column to enable/disable the
LPD queues.

• Add button — Adds an LPD queue using the Add Queue Subdevice tab pages. You will need to configure the
options on the LPD queue settings tab.

• Modify button — Modifies the selected LPD queue.
• Remove button — Removes the selected LPD queue.

Default queue — Selects the default queue which will process all requests made to unrecognized queues. All defined
LPD queues are listed.

LPD Queue Settings tab

Use this tab to configure an LPD queue. You can access this tab when you add or modify an LPD queue from the
LPD settings tab.

Queue name

Specifies the LPD queue name. The underscore character is not allowed to be part of the queue name.

Enabled

Determines if the queue is available to receive documents.

Allow restart

Accepts or rejects the restart command, to reset a particular queue.

Allow LPQ

Determines if the LPQ command line can be used to view the print queue for your current logon name.

Allow LPRM

Determines if the LPRM command line can be used to remove files in the print queue that were submitted under your
current logon name.
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More Settings tab (Source Configuration)
Use this tab to configure common configuration options that available to all source types. You can access this tab
when you create or configure a source.

When documents arrive

Set state to hold — Sets all documents received by this source to the Hold state as they enter the Output Manager
Console. This option is disabled by default.

Do not process business rules — Disables business rule processing for all documents received by this source as they
enter the Output Manager Console. This option is disabled by default.

Analyze documents

Use quick page counting for PDF documents — Enables optimized page counting for PDF jobs. When this option
is enabled, the Count pages, Detect color, Detect data type, Detect duplex, and Detect trays options are disabled.

Count pages — Performs a page count on all documents received by this source as they enter the Output Manager
Console. Selecting this option may cause performance degradation. This option is disabled by default.

Detect data type — Detects the document data type and displays it in the Documents grid Data Type column.

Detect trays — Detects the document paper tray that will print the document and displays it in the Documents grid
Input Bin or Output Bin column. You can use the Configure Document Properties Utility to display the Output
Bin column.

Detect color — Detects if the document contains color. The Documents grid Color column displays True or False
depending if color is detected.

Detect duplex — Detects if the document is configured for duplex printing. The Documents grid Duplex column
displays how the document will print, One Sided, Two Sided Short Edge, or Two Sided Long Edge.

Set file store

Sets a file store for all documents received by this source as they enter the Output Manager Console. The default file
store is selected by default. Administrators define file stores and select the default in the Set General Preferences
Utility. If the default file store is changed in the Set General Preferences Utility, all sources using the default will be
automatically updated.

Set document folder

Assigns a document folder for all documents received by this source as they enter the Output Manager Console. The
default document folder is Un-Filed Documents.

Use advanced costing

Determines if you want to use Advanced Costing Profiles, where you can enter more specific costs associated with
printing. If you do not select this option, you can specify only the cost per page for printing.

• Set cost per page — Sets the printing cost per page for black and white and color documents. Use the spin boxes
to select the printing cost.

If you want to bill less than 1 cent per page, you must change the Windows currency settings to display more than
2 decimal places. To do this, open Control Panel and click Region and Language. On the Formats tab, click
Additional settings. Click the Currency tab and change the No. of digits after decimal option to either 3 or 4.
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• Advanced costing profile — Specifies the Advanced Costing Profile that will be associated with the source. You
can select one of the existing profiles from the list, or click New to create a new profile on the Advanced Costing
Profile dialog box. These options are only available if Use advanced costing is selected.

Assign notifications profile

Allows for sending a notification when a document arrives, prints successfully, prints on failover destination, or is
in error state. The notification can be sent as an email message or a pop-up. Notification profiles are used to send
notifications. You can use the list to select an existing notification profile or click New to create one.

New — Create a new notifications profile. Opens the Notification Profile dialog box.

Edit — Displays the selected notifications profile properties for modification.

Manage — Opens the Manage Notification Profiles dialog box which lists all of the defined notifications profiles.
From this dialog box you can create, import, and export profiles, as well as manage all existing profiles.

Output Settings tab (Source Configuration)
Use this tab to configure output options that available to all source types. You can access this tab when you create or
configure a source.

Schedule output

Schedules all documents received by this source to print at your selected date and time. From the list, you can choose
to print the documents today, on a specific day, or in the future. You can also choose to print as soon as possible, at a
specific time, or in the future.

Route to destination

Specifies a destination where all documents received by this source can be routed. Click the browse button (...) to
select one or more destinations in the tree. Use the Shift and Ctrl keys to select multiple destinations. Destination
groups cannot be selected. This option is set to Unrouted by default.

Set retention period

Allows for overriding the default retain settings for all documents received by this source. To override the default
settings, select the Override default retain settings check box and configure the retain options as necessary.

Set auto delete Spooled documents

Allows for overriding the default automatic deletion settings for all spooled documents received by this source. To
override the default settings, select the Override default auto delete settings check box and configure the options as
necessary.

Assign output process

Output processes can be created to impact documents as they are being sent to a destination. The processes contain a
set of actions which could be used for search and replace, setting finishing options, editing PJL commands, inserting
overlays, and so on.

Use the list to select an existing output process.

New — Displays the Process Designer for creating an output process. The visual flowchart style designer makes it
easy and intuitive to create complex, powerful processes.
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Edit — Displays the selected output process properties for modification.

Manage — Displays the Manage Output Process Profiles dialog box, which lists all of the defined output processes.
In this dialog box you can create, import, and export processes, as well as manage all existing processes.

Assign failover profile

Failover profiles specify what should happen to documents when they are sent to inaccessible destinations (they aren’t
able to receive documents).

Use the list to select an existing failover profile.

New — Displays the Failover Profile dialog box for creating a new failover profile. You can determine what should
happen if all of the retries fail and when to place the document in an error state.

Edit — Displays the selected failover profile properties for modification.

Manage — Displays the Manage Failover Profiles dialog box which lists all of the defined failover profiles. From
this dialog box you can create, import, and export profiles, as well as manage all existing profiles.

Socket settings tab (Sources)
Use this tab to configure a socket source.

Documents received by the IP address and port specified will be received into Nuance Output Manager. You can
access this tab when you create or configure a socket source.

Port — Specifies the port number. The default number is 9100.

IP address — Specifies the IP address on the local system where the socket device will receive documents. In most
cases, this can be left blank, as most systems only have one IP address. For systems with multiple adapters or if
multiple IP addresses are supported (that is, when using a VPN), this specifies the IP address for the appropriate port.

Click the browse button (...) to select one of the available connections, or enter the IP address directly in the box.

Support PJL status readback — Enables the socket source to emulate two way printer communications. The print
job sender can send PJL commands that prompt a printer to respond with status information, and if it expects a
response, it may wait until that response arrives before continuing with the job.

TCP/IP NJE settings tab (Source Configuration)

Use this dialog box to configure the settings for receiving data from a mainframe computer.

Option Description

Host node name The mainframe node name. The name identifies the node
in the NJE network.

Host type The mainframe operating system component that receive
s jobs, schedules them for processing, and controls their
output processing. Nuance Output Manager supports JES
2, JES3, and VSE/Power.

Host password The password required to connect to the host node.

Confirm password Password confirmation.
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Option Description

Host codepage Specifies the table of values that define the encoding for
data on the mainframe.

IP address The TCP/IP address used to connect to the mainframe.

Port The TCP/IP port to used to connect to the mainframe.

Local node name The node name defined on the mainframe for the Nuance
Output Manager source. Multiple Nuance Output
Manager sources (nodes) can connect to the same mainf
rame.

Connect interval (in minutes) Specifies the intervals Nuance Output Manager uses to c
onnect to the mainframe to receive data.

Local password The password required to connect to the Nuance Output
Manager source node.

Confirm password Password confirmation.

Local codepage Specifies the table of values that define the encoding for
data received in Nuance Output Manager.

SYSIN receivers The number of SYSIN receivers (JRNUM) in the mainfr
ame node definition for the Nuance Output Manager sour
ce. This value must match the number of SYSIN transmit
ters (JTNUM) in the mainframe node definition.

SYSOUT receivers The number of SYSOUT receivers (SRNUM) in the mai
nframe node definition for the Nuance Output Manager s
ource. This value must match the number of SYSOUT tr
ansmitters (STNUM) in the mainframe node definition.

Multiple streams per buffer Indicates that the mainframe is configured to send data f
or multiple streams within the same network buffer.

Multiple headers per buffer Indicates that the mainframe is configured to send heade
rs for multiple transmissions within the same network bu
ffer.

Package by output group Indicates that datasets in a multi-dataset job are grouped
together in Nuance Output Manager packages based on n
ormal output group properties. Datasets in the same job
with the same form and class are packaged together.

Web Upload Settings tab (Source Configuration)
Use this tab to configure a Web upload source.

Documents received by this source will be routed to Nuance Output Manager.

Web Server — Specifies the web server for this source. The list is populated with the web servers available to the
selected server.
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Source capabilities profile — Specifies which print preferences/document properties are supported by this source.
Those preferences are stored in a source property profile. Click the arrow to select an existing profile, or click the
browse button (...) to create and manage profiles from the Manage Source Properties Profiles dialog box.

WebSphere MQ settings tab (Source)
Use this tab to configure a WebSphere MQ source.

WebSphere MQ is a message queuing system designed by IBM that runs on many platforms such as Windows, Unix,
Linux, and z/OS. Nuance Output Manager provides an interface into that queuing system. Nuance Output Manager
can then communicate (send and receive messages) with other applications using WebSphere MQ.

This source will receive WebSphere MQ messages. You can access this tab when you create or configure a
WebSphere MQ source.

Important:  To use this destination, you must install a WebSphere MQ client separately.

Queue manager — Specifies the name of the queue manager. This must match the queue manager specified in
WebSphere MQ. The queue manager administers the queues that have been created on it (these are known as local
queues).

Queue name — Specifies the queue name where messages received by this source will be stored. This must match
the queue name specified in WebSphere MQ. The queue name along with the name of its queue manager, provides a
unique address where messages can be received.

Channel name — Each WebSphere MQ queue manager has different types of connectivity options. Since Nuance
Output Manager uses TCPIP for the channel connection, you must specify the channel configured for TCPIP. You can
get this name from the WebSphere MQ list of channels.

Warning:  Make sure the SSL certificate required option is not selected in WebSphere MQ. Nuance Output
Manager does not support this at this time.

Connection name — Specifies the connection name. The connection name is the IP address and (port) or DNS name
for the server to which you are attempting to connect. Messages are transferred over the connection and placed in the
queue.

Windows Queue Settings tab (Source Configuration)
Use settings on this tab to configure a Windows queue source.

You can access this tab when you create or configure a Windows queue source.

Converted queue — Lists the Windows printers that are using the Output Manager Port Monitor, but have not had a
Source created and associated with it. Once a Source has been created and associated, those printers will be removed
from the list.

Source capabilities profile — Specifies which print preferences/document properties are supported by this source.
Those preferences are stored in a source property profile. Click the arrow to select an existing profile, or click the
browse button (...) to create and manage profiles from the Manage Source Properties Profiles dialog box.

Source Configuration (bulk settings) dialog box
Use bulk source settings to simultaneously configure multiple devices with the same source settings.

Create a source by right-clicking a folder in the Sources application and clicking New Source on the shortcut menu.
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General settings

Click an option you want to learn more about.

Tab Description

Document Properties tab (Source Bulk Configuration) on
page 672

Use the Document properties tab to configure
document properties that will be applied to all documents
received by this source.

Filters tab (Source Bulk Configuration) on page 675 Use this tab to configure filters for sources.

More Settings tab (Source Bulk Configuration) on page
678

Use this tab to configure common configuration options
that available to all source types.

Output Settings tab (Source Bulk Configuration) on page
679

Use this tab to configure output options that available to
all source types.

Buttons

Button Description

Select all Selects the check boxes for all of the listed sources.

Unselect all Clears check boxes for any selected sources.

Add Adds a source to the grid. A new row will appear at the b
ottom of the grid.

Copy Creates a copy of each of the selected source in the grid.
New rows are added at the bottom of the grid.

Remove Deletes selected sources.

Series Fill Fills multiple selected fields in a column with the
specified text and counter. This option is useful
when you have several sources using similar naming
conventions (such as source name, folder, and location).

To create a series fill, select the rows you want to
automatically fill and then click inside one of the cells
that you are editing. Click Series Fill and enter the text
and configure the counter in the Series Fill dialog box.
The series will start with the first selected row.

Source specific settings tabs

Settings tabs show for specific source sources. Click below to learn more about these settings.

Icon Source

Email source settings Use this tab to simultaneously create
multiple email sources.

FTP settings Use this tab to simultaneously
configure multiple FTP sources.
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Icon Source

Documents received by this source
will be routed to Nuance Output
Manager.

IPP source settings Use this tab to simultaneously
configure multiple IPP (Internet
Printing Protocol) sources. You
can access this tab when you create
multiple IPP sources.

LPD source settings Use this tab to simultaneously create
multiple LPD sources.

NetWeaver source (no source specifi
c settings)

Folder source settings Use this tab to simultaneously create
multiple network folder sources.

Output Manager source (no source sp
ecific settings)

Socket source settings Use this tab to simultaneously create
multiple socket sources.

WCF API source (no source specific
settings)

Web Upload source settings Use this tab to simultaneously create
multiple Web upload sources.

WebSphere MQ source settings Use this tab to simultaneously create
multiple WebSphere MQ sources.
This source will receive WebSphere
MQ messages.

Windows Queue source settings Use this tab to simultaneously create
multiple Windows queue sources.

Document Properties tab (Source Bulk Configuration)
Use the Document properties tab to configure document properties that will be applied to all documents received by
this source.

You will use this tab when simultaneously creating multiple sources.

Click directly in the grid to configure the source.

Column Description

Name column Specifies the name of the source.

Use Advanced Document Properties column Enables the use of advanced document properties. Docu
ment properties is a complex feature that allows the ma
pping of header data to Nuance Output Manager docum



Output Manager Administration Guide
Version 4.0 SP2

673 © 2016 Nuance Communications, Inc. All rights reserved.

Column Description

ent properties. Only advanced users and professional se
rvice engineers should configure this feature. Selecting t
his option enables the Advanced Document Properties
Profile column and disables all other columns.

Advanced Document Properties Profile column Specifies the document properties profile you want to us
e. You can select a profile from the list or click the Brow
se button to create or manage profiles from the Manage
Document Properties Profiles dialog box.

Remaining Document Property Specifies the document property values. Modify the prop
erties by clicking in the appropriate columns. These colu
mns are not available when using advanced document pr
operties.

Email settings tab (Source Bulk Configuration)
Use this tab to simultaneously create multiple email sources.

Documents received by the specified email accounts will be routed to Nuance Output Manager.

Click in a cell to configure the value for a setting in a source.

• Name — Specifies the name of the source.
• Email Server — Specifies the mail exchange server. You can click the Browse button to display the Mail Server

Search dialog box and search for one on a given domain.
• Port — Specifies the port number for the selected protocol. The following table lists common port assignments for

the protocols that Output Manager supports:

Protocol Port

POP3 110

POP3 (SSL enabled) 995

IMAP4 143

IMAP4 (SSL enabled) 993

The port number for your environment may vary. Refer to an email server administrator for more information.
• Use SSL — Select to use SSL (Secure Sockets Layer) to encrypt the connection between the email server and

Output Manager.
• User Name — Specifies the user name that will be used when logging in to the email account. If the email

account does not require a user name, you can leave this box blank.
• Password — Specifies the user password that will be used when logging in to the email account. If the email

account does not require a password, you can leave this blank.
• Interval (sec) — Specifies the time interval for checking the email account for documents. The default value is 60

seconds.
• Delete Messages — Deletes the email messages and their attachments from the email server once they have been

received into Nuance Output Manager. This option is selected by default.

Specify email components that you want to include in a separate components document that users can print:

• Include From In Secondary Document — Includes the email From value.
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• Include To In Secondary Document — Includes the email To value.
• Include CC In Secondary Document — Includes the email CC value.
• Include BCC In Secondary Document — Includes the email BCC value.
• Include Subject In Secondary Document — Includes the email Subject value.
• Include Body In Secondary Document — Includes the email Body value.

When Nuance Output Manager receives an email, Nuance Output Manager resolves its attachments into documents
and creates the components document. Nuance Output Manager then creates a single package that contains all the
documents from the email, the attachments, and the components document.

Epic Settings tab (Source Bulk Configuration)
Use this tab to configure an Epic health information sources.

You will use this tab when simultaneously creating multiple sources.

Click directly in the grid to configure the source.

Column Description

Name column Specifies the name of the source.

Folder Specifies the path of the network folder to be monitored.

For the selected folder, you must configure the Nuance
Output Manager services logon account user name to
have Full Control Sharing permissions. Also verify
the Administrators group has Full Control Security
permissions. Right-click the folder in Windows Explorer
and click Sharing and Security to configure these
options.

Scan subfolders Select the check box to monitor subfolders within specif
ied network folder.

Interval (sec) Specifies how often in seconds to check the selected fold
er for files. The default time interval is 10 seconds.

Order Specifies the order in which Nuance Output Manager rec
eives files from the network folder.

Disposition Specifies what happens to a file in the network folder aft
er it is sent to Nuance Output Manager.

• Delete — Deletes the original file after sending it to
the Nuance Output Manager. This option is selected
by default.

• Leave — Does not delete or move the original file
after it is sent Nuance Output Manager. This causes
the file to be sent repeatedly (once each polling
Interval) until you delete it.

• Move — Saves the file in another folder after it is
sent Nuance Output Manager. If a file by the same
name already exists in the folder, the new file will be
saved with an incrementing number. For example, if
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Column Description

file ABC is sent to a folder that already contains a file
named ABC, the new file will be saved as ABC_001.
Enter the folder path in the Move to box.

• Move/Overwrite — Saves the file in another folder
after it is sent Nuance Output Manager. If a file
by the same name already exists in the folder, the
existing file will be replaced by the new file. Enter
the folder path in the Move to box.

Move to Specifies the path for the folder to which documents a
re moved when Move or Move/Overwrite is selecte
d for Disposition. This option is available only when
Disposition is set to Move or to Move/Overwrite.

EPS binaries The path of the EPS (Epic Print Service) binaries folder.
An example, for a default installation, would be C:\Epi
c\bin\8.1\Epic Print Service.

EPS incoming The path of the EPS watch folder. An example for a defa
ult installation would be C:\Epic\Jobs\Incoming
\8.1\Epic Print Service. Output Manager will
monitor the configured watch Folder. Any unrecognized
file will be moved it to this folder for EPS handle. Outpu
t Manager currently supports .ERTF files and .ERAW fil
es. Other file types will be moved to this folder.

Convert ERTF To PDF Select this check box to convert Epic ERTF formatted fi
les to PDF.

Filters tab (Source Bulk Configuration)
Use this tab to configure filters for sources.

Filters restrict documents from a source by including or excluding certain groups. You will use this tab when creating
multiple sources at once.

The Filters tab is only available when configuring email, network folder, and LPD sources.

Click directly in the grid to configure the source.

Specifies the name of the source and applies filters to the source. Filters allow you to restrict documents from a source
by including or excluding certain groups. The filter columns that display are specific to the selected source type. You
can modify the filter values by typing directly in the grid column. Wild card values of ? or * are accepted, as long
as the expressions first character is a numeric or alphabetic character. This filter will be applied to each document
received by the selected source.

Folder Settings tab (Source Bulk Configuration)
Use this tab to simultaneously create multiple network folder sources.

Documents received by this source will be routed to Nuance Output Manager.

Click directly in the grid to configure the source.
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• Name column — Specifies the name of the network folder source.

• Folder column — Specifies the path of the network folder that will be monitored. For the folder selected, you
must configure the Nuance Output Manager service logon account user name to have Full Control Sharing
permissions. Also verify the Administrators group has Full Control Security permissions. Right-click the folder in
Windows Explorer and click Sharing and Security to configure these options.

• Scan Subfolders column — Specifies if you want to check the subfolders of the network folder.
• Interval (sec) column — Specifies the time interval for checking selected folder for files. The default time interval

is 10 seconds.
• Order — Specifies the order in which Nuance Output Manager receives files from the network folder.
• Disposition column — Specifies what will happen to the original file after it is sent to the Output Manager

Console.

• Delete — Deletes the original file after sending it to the Output Manager Console. This option is selected by
default.

• Leave — Does not delete or move the original file after sending it to the Output Manager Console. This causes
the file to be sent repeatedly (once at each occurrence of the spooling Interval) until you delete it.

• Move — Saves the file in another folder after it is sent to the Output Manager Console. If a file by the same
name already exists in the folder, the new file will be saved with an incrementing number. For example, if file
ABC is sent to a folder that already contains a file named ABC, the new file will be saved as ABC_001. Enter
the folder path in the Move to box.

• Move/Overwrite — Saves the file in another folder after it is sent to the Output Manager Console. If a file by
the same name already exists in the folder, the existing file will be replaced by the new file. Enter the folder
path in the Move to box.

• Move To column — If Move or Move/Overwrite is selected as the file Disposition, this column becomes
available. Specify the folder path where the file will be moved.

FTP Settings tab (Source Bulk Configuration)
Use this tab to simultaneously configure multiple FTP sources. Documents received by this source will be routed to
Nuance Output Manager.

You can access this tab when you create or configure multiple FTP sources.

Click in a cell to configure the value for a setting in a source.

• Name column — Specifies the name of the FTP source.
• FTP Server column — Specifies the FTP server, which can be an FTP or IP address.
• Port column — Specifies the host's port number. The port number must be from 1 through 65536. The default

value is 21.
• Use Passive Mode column — Determines if the host mode will be passive or active. Selecting the check box

selects passive mode, where the client creates a session to receive data. Clearing the check box will choose active
mode, where the host creates a separate or new session to transfer data in response to a request from the client.

• User Name column — Specifies the user name that will be used when logging on to the host account. If the host
account does not require a user name, you can leave this cell blank.

• Password column — Specifies the user password that will be used when logging in to the account. If the account
does not require a password, you can leave this cell blank.

• FTP Folder column — Specifies the location on the host from which the files will be retrieved when receiving
files. You must type the entire path of the folder or the path relative to the FTP user home directory (for example,
if your home directory is at \FTP\UserName, you can specify either \FTP\UserName\MySourceFiles or
\MySourceFiles).

• Scan Subfolders column — Determines if you want to scan any subfolders of the specified FTP folder.
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• Remove Subfolders column — Determines if you want to delete the subfolders of the FTP folder, after the files
are transferred into Nuance Output Manager.

• Interval (sec) column — Specifies the time interval for checking the host for documents. The default value is 60
seconds.

• Temp Folder column — Specifies the location files are transferred into during the FTP session. When the session
is complete they are put in the file store.

General tab (Source Bulk Configuration)
Use this tab to specify general source information when creating multiple sources at once.

Column Description

Name Specifies the name of the source.

Server Specifies the Nuance Output Manager server where the
Nuance Output Manager Input Service is located for this
source. The source does not have to be on the same serve
r as the Nuance Output Manager Input Service.

Location Specifies any specific location information for the sourc
e.

Comments Lists any general comments about the source.

IPP settings tab (Source Bulk Configuration)
Use this tab to simultaneously configure multiple IPP (Internet Printing Protocol) sources. You can access this tab
when you create multiple IPP sources.

The settings on this tab configure URLs that are used to communicate with IPP printers. The URL is formed as
follows:

http://ipaddress:port/instancename

Make sure that the network and firewall are configured to allow incoming traffic to the specified IP addresses and port
numbers.

Column Description

Name Specifies the name for IPP source.

IP address Specifies the IP address for the IPP printer.

Port Specifies the port that the server uses to communicate wi
th the printer. The default port setting is 631.

Instance name Specifies the instance name for the printer.

Enable SSL Select this check box to use SSL to communicate with th
e printer.

LPD Settings tab (Source Bulk Configuration)
Use this tab to simultaneously create multiple LPD sources.

Documents received by these sources will be routed to Nuance Output Manager.
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Click directly in the grid to configure the source.

• Name column — Specifies the name of the LPD source.
• Port column — Specifies the host's port number. The default value is 515.
• IP Address column — Specifies the host’s IP address.
• Default Queue column — Specifies the default queue which will process all requests made to unrecognized

queues. All defined LPD queues are listed.
• Temp Folder column — Specifies the location files are transferred into during the LPD session. When the session

is complete they are put in the file store.
• LPD Queue column — Click the browse button (...) to add LPD queues using the Manage LPD Queue

Subdevice tab pages. You will need to configure the options on the LPD queue settings tab.

More Settings tab (Source Bulk Configuration)
Use this tab to configure common configuration options that available to all source types.

You will use this tab when simultaneously creating multiple sources.

Click directly in the grid to configure the source.

• Hold column — Sets all documents received by this source to the Hold state as they enter the Output Manager
Console.

• Do Not Process Business Rules column — Disables business rule processing for all documents received by this
source as they enter the Output Manager Console.

• Use PDF Quick Count column — Enables optimized page counting for PDF jobs. When this option is enabled,
the Count Pages, Detect Color, Detect Data Type, Detect Duplex, and Detect Trays options are disabled.

• Count Pages column — Performs a page count on all documents received by this source as they enter the Output
Manager Console. Selecting this option may cause performance degradation.

• Detect Color column — Detects if the document contains color. The Documents grid Color column displays True
or False depending if color is detected.

• Detect Data Type column — Detects the document data type and displays it in the Documents grid Data Type
column.

• Detect Duplex column — Detects if the document is configured for duplex printing. The Documents grid Duplex
column displays how the document will print (One Sided, Two Sided Short Edge, or Two Sided Long Edge).

• Detect Trays column — Detects the document paper tray that will print the document and displays it in the
Documents grid Input Bin or Output Bin column. You can configure the Output Bin column to display by using
the Administration Configure Document Properties Utility.

• File Store column — Sets a file store for all documents received by this source as they enter the Output Manager
Console. The default file store is selected by default. Administrators define file stores and select the default in the
Set General Preferences Utility. If the default file store is changed in the Set General Preferences Utility, all
sources using the default will be automatically updated.

• Document Folder column — Assigns a document folder for all documents received by this source as they enter
the Output Manager Console. The default document folder is Un-Filed Documents. Click the browse button (...)
to select a different folder.

• Use Advanced costing — Enables the use of Advanced Costing Profiles, in which you can enter specific costs
associated with printing.

• Advanced Costing — Specifies the Advanced Costing Profile that will be associated with the source. You
can select one of the existing profiles from the list, or click the browse button (...) to manage or create a new
profile. Profiles are configured on the Advanced Costing Profile dialog box. This option is only available if Use
advanced costing is selected.

• B&W Cost column  — Specifies the printing cost per page for black and white documents.
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If you want to bill less than 1 cent per page, you must change the Windows currency settings to display more than
2 decimal places. To do this, open Windows Control Panel and click Regional and Language. On the Formats
tab, click Additional Settings. Click the Currency tab and change the No. of digits after decimal option to either
3 or 4.

• Color Cost column  — Specifies the printing cost per page for color documents.

If you want to bill less than 1 cent per page, you must change the Windows currency settings to display more than
2 decimal places. To do this, open Windows Control Panel and click Regional and Language. On the Formats
tab, click Additional Settings. Click the Currency tab and change the No. of digits after decimal option to either
3 or 4.

• Notification profile column — Allows for sending a notification when a document arrives, prints successfully,
prints on failover destination, or is in error state. The notification can be sent as an email message or a pop-up.
Notification profiles are used to send notifications. You can use the list to select an existing notification profile or
click the browse button (...) to create or manage profiles from the Manage Notification Profiles dialog box.

Output Settings tab (Source Bulk Configuration)
Use this tab to configure output options that available to all source types.

You will use this tab when simultaneously creating multiple sources.

Column Description

Schedule Output Schedules all documents received by this source to print
at your selected date and time. From the list, you can cho
ose to print the documents today, on a specific day, or in
the future. You can also choose to print as soon as possib
le, at a specific time, or in the future.

Route To Destination Specifies a destination where all documents received by
this source can be routed. Click the Browse button to sel
ect one or more destinations in the tree. Use the Shift an
d Ctrl keys to select multiple destinations. Destination gr
oups cannot be selected. This option is set to Unrouted b
y default.

Override default retain settings Determines if you want to override default retention peri
od and configure the retain options as necessary. Selecti
ng this option enables the Retain and Retain Period col
umns.

Retain Determines if you want to retain documents received by t
his source.

Retain Period Specifies the retain period in days.

Output Process Specifies if you want to use an output process. Output pr
ocesses can be created to impact documents as they are b
eing sent to a destination. The processes contain a set of
actions which could be used for search and replace, setti
ng finishing options, editing PJL commands, inserting ov
erlays, and so on. You can select an output process from
the list or click the browse button (...) to create or manag
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Column Description

e profiles from the Manage Output Process Profiles di
alog box.

Failover Profile Specifies if you want to use a failover profile. Failover p
rofiles specify what should happen to documents when t
hey are sent to inaccessible destinations (they are not ab
le to receive documents). You can select a failover profi
le from the list or click the browse button (...) to create o
r manage profiles from the Manage Failover Profiles di
alog box.

Override Default Auto Delete Settings Specifies if you want to override the default automatic d
eletion settings for all spooled documents received by th
is source.

Auto Delete Specifies if you want to automatically delete spooled doc
uments received by this source.

Auto Delete Hours Specifies the interval in hours that spooled documents ar
e automatically deleted if you enabled Override Default
Auto Delete Settings.

Socket settings tab (Source Bulk Configuration)
Use this tab to simultaneously create multiple socket sources.

Documents received by the IP address and port specified will be received into Nuance Output Manager.

Click directly in the grid to configure the source.

• Name column — Specifies the name of the socket source.
• Port column — Specifies the port number. The default number is 9100.
• IP Address column — Specifies the IP address on the local system where the socket device will receive

documents. In most cases, this can be left blank, as most systems only have one IP address. For systems with
multiple adapters or if multiple IP addresses are supported (that is, when using a VPN), this specifies the IP
address for the appropriate port.

• Support PJL Status Readback column — Enables the socket source to emulate two way printer
communications. The print job sender can send PJL commands that prompt a printer to respond with status
information, and if it expects a response, it may wait until that response arrives before continuing with the job.

Web Upload Settings tab (Source Bulk Configuration)
Use this tab to simultaneously create multiple Web upload sources.

Documents received by these sources will be routed to Nuance Output Manager.

Click directly in the grid to configure the source.

• Name column — Specifies the name of the Web upload source.
• Web Server — Specifies the web server for this source. The list is populated with the web servers available to the

selected server.
• Source Capabilities Profile — Specifies which print preferences/document properties are supported by this

source. Those preferences are stored in a source property profile. Click the arrow to select an existing profile, or
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click the browse button (...) to create and manage profiles from the Manage Source Properties Profiles dialog
box.

WebSphere MQ settings tab (Source Bulk Configuration)
Use this tab to simultaneously create multiple WebSphere MQ sources. This source will receive WebSphere MQ
messages.

WebSphere MQ is a message queuing system designed by IBM that runs on many platforms such as Windows, Unix,
Linux, and z/OS. Nuance Output Manager provides an interface into that queuing system. Nuance Output Manager
can then communicate (send and receive messages) with other applications using WebSphere MQ.

Important:  To use this source, you must install a WebSphere MQ client separately.

Click directly in the grid to configure the source.

• Name column — Specifies the name of the WebSphere MQ source.
• Queue Manager column — Specifies the name of the queue manager. This must match the queue manager

specified in WebSphere MQ. The queue manager administers the queues that have been created on it (these are
known as local queues).

• Queue Name column — Specifies the queue name where messages received by this source will be stored. This
must match the queue name specified in WebSphere MQ. The queue name along with the name of its queue
manager, provides a unique address where messages can be received.

• Channel Name column — Each WebSphere MQ queue manager has different types of connectivity options. Since
Nuance Output Manager uses TCPIP for the channel connection, you must specify the channel configured for
TCPIP. You can get this name from the WebSphere MQ list of channels.

Warning:  Make sure the SSL certificate required option is not selected in WebSphere MQ. Nuance Output
Manager does not support this at this time.

• Connection Name column — Specifies the connection name. The connection name is the IP address and (port)
or DNS name for the server to which you are attempting to connect. Messages are transferred over the connection
and placed in the queue.

Windows Queue Settings tab (Source Bulk Configuration)
Use this tab to simultaneously create multiple Windows queue sources.

Click directly in the grid to configure the source.

• Name column — Specifies the name of the Windows queue source.
• Output Manager Port Associated With column — Lists the Windows printers that are using the Output Manager

Port Monitor, but have not had a Source created and associated with it. Once a Source has been created and
associated, those printers will be removed from the list.

• Source Capabilities Profile column — Specifies which print preferences/document properties are supported by
this source. Those preferences are stored in a source property profile. Click the arrow to select an existing profile,
or click the browse button (...) to create and manage profiles from the Manage Source Properties Profiles dialog
box.
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Specify LDAP Server Connection dialog box
Use the LDAP Import Utility to import users and groups from an LDAP source. You can access the LDAP Import
Utility when you import LDAP users or groups from the User and Group Selection dialog box, Users tab, or
Groups tab.

To import LDAP users or LDAP groups into Nuance Output Manager, you must specify an existing LDAP server
or a new server. Use this dialog box to define the LDAP server that contains the users or the groups that you want to
import.

Choose LDAP Server

Specifies the server. To choose an existing server, click the arrow in the box and select a server. To define a new
LDAP server, click New. The LDAP Server Details grid becomes available for entry.

LDAP Server Details

Server type — Specifies a server type of either Microsoft Active Directory Server or Generic LDAP Server. A server
type of Generic LDAP Server operates correctly in a Microsoft Active directory environment. However, specifying
Microsoft Active Directory Server if you are connecting to an ADS (Active Directory Server) offers the benefits of
established security and relationships.

Modify Server Details — Enables the LDAP Server Details boxes if you want to modify information about an
existing server.

Server name — Indicates the name by which you want to identify this server.

Server address — Specifies the DNS (Domain Name System) name of the server. In most cases, you can simply
specify the server address in domain name format, for example, nuance.com.

Port — Identifies the standard IP port for the LDAP server.

Login ID (DN Format) — Specifies the DN (distinguished name) of a user with administrative rights.

Password — Contains this user’s password.

Save Changes button — Saves the changes that you have made to the LDAP information.

Cancel Changes button — Cancels any changes that you have made to the LDAP information.

Verify Connection button

Confirms that a connection can be established with the information you have entered. After clicking this button, you
will see either Success or Failure to the right of the button.

Specify SQL User dialog box
Use this dialog box to specify the SQL user to be used when connecting using SQL authentication.

You can access this dialog when you configure the SQL authentication type on the OM services configuration tab.
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User

Specifies the SQL user to be used during SQL authentication. This user must be a member of the sysadmin server role
for the SQL Server instance.

Password/Confirm password

Specifies and confirms the password for the user.

Text Extraction Variable Definition dialog box
Use this dialog box to create one or more variables that will be used for bursting or extraction. You can access this
dialog when you configure Burst - Line Mode and Burst - Page Mode business rule actions.

Name

Specifies the name of the extraction variable.

Description

Provides a description of the extraction variable.

Type

Specifies the type of extraction variable, Burst or Extract. The Burst variable is used to set the burst conditions on
the Burst Conditions tab. The Extract variable is used to extract text from the document. It becomes an extraction
variable available on the Set Document Properties tab. You can set a document property from the value extracted in
the extraction variable.

Once a variable of a particular type has been created, it cannot be changed to the other type.

Trim Spaces

Specifies if you want to remove spaces found at the start and end of the extracted text. To remove the spaces, select
the Trim spaces check box.

Location on page

Determining location is different for bursting using line mode and bursting using page mode. See the descriptions in
the appropriate sections of Working with Business Rules.

Line mode

Line/Record — Specifies the line/record number from which the text will be extracted. If you are detecting using
records, it will be the record number of the current page (that is, variables on page 2 and greater are relative to line
1 on that page). If you selected Banner mode, the recognition line becomes line 1 and the extraction variables are
relative to it.

Column — Specifies the start column for the extraction.

Extract — Specifies the number of characters to extract.
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Page mode

Specifies the region (rectangle) from which text will be extracted.

Tip:  The region values can be found by viewing a document with the Nuance Output Manager viewer. In the
viewer, click View > Text Selection Mode on the menu bar. Then, drag the cursor to select the desired region.
The coordinates will appear in the status bar.

Upper left corner X coordinate — Specifies the upper left corner X coordinate.

Upper left corner Y coordinate — Specifies the upper left corner Y coordinate.

Width — Specifies the width of the region in millimeters (mm).

Height — Specifies the height of the region in millimeters (mm).

Page selection

These options are only available for Extract type variables.

Specifies the page of the newly created burst document from which you want to extract the text. You can enter a Page
number or select First page with non-blank value in selected location.

Text Resource dialog box
Use this dialog box to configure a text resource. You can access this dialog box when you configure a text resource in
the Process Designer or the Resource Manager dialog box.

Name

Specifies the name of the text resource.

Description

Provides a description of the text resource.

Comments

Displays any comments about the resource.

Printer Family

Use the check boxes to determine if the resource will be used for all printer families or only for certain printer
families.

Data Type

Use the check boxes to determine if the resource will be used for all data types or only for certain data types.

Import Resource Data

Browse button — Allows for importing resource data. Imported files must contain text data.

Code page — Specifies the code page to be applied to the resource data.
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Resource Editor

Enter the resource data text.

To go to a specific line in the resource, right-click in the box and click Go To (or press Ctrl+G). In the box that
displays, enter the line number and click OK. The line will be highlighted in the Resource Editor.

To find specific text, right-click in the box and click Find and Replace (or press Ctrl+F) to display the search dialog
box.

Export button

Allows for exporting the resource data. Unlike the Export button on the Resource Manager dialog box, this exports
only the text data from the Resource Editor area to a text file.

Transform Adept dialog box
Use this dialog box to configure a business rule action to transform documents using the Adept transform suite.

Tip:  If needed, you can use the Data Conversion Utility to create custom DCOs for converting data formats.
This will not be necessary for most users. If you think this conversion is necessary, please contact Nuance
Support to ensure the data is converted properly.

Server

Specifies the licensed rules agent server that you would like to use.

Parameters

Convert from — Specifies if you want to convert from the Xrx or Afp format.

to — Specifies the format you want to convert to.

Ini — Specifies the Ini resource that will control the format of the printed output. You can select a defined Ini
resource in the drop-down list or click the browse button (...) to create, modify, or import Ini resources from the
Resource Manager dialog box. Ini resources are created using the Ini Resource dialog box.

Ini description — Provides a description of the selected Ini resource.

Ini default — Specifies the default Ini resource.

EXE path — Specifies the Adept executable path.

Follow on actions

Input document — Specifies the follow on actions for the input document (original document). You can choose to
delete, retain, or process the next rule for the original document. The newly created documents (output documents)
continue with the next rule action.
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Transform Office Files dialog box
Use this dialog box when you create a business rule action to convert Microsoft Office files to PDF documents.

Server

Select the server with the Rules Agent service that runs the business rule.

Office file formats to convert

Specifies the types of Microsoft Office files that you want to convert. Click the drop-down list and select the file
formats.

Use Microsoft API if available

Specifies if Nuance Output Manager uses the Microsoft API component when converting the following file formats:

• DOC
• DOCX
• XML
• ODT
• OOXML
• RTF
• HTML
• XHTML
• MHTML
• TXT

Complex RTF documents were not accurately converted with the third-party product in earlier versions of Nuance
Output Manager. Enabling this option used the Microsoft API to improve conversion accuracy. To use this option,
verify that Microsoft Word 2013 is installed on the same server that hosts the Rules Agent Service that processes the
action. Newer versions of Nuance Output Manager contain an improved third-party conversion product.

Follow on actions

Input document — Specifies how Nuance Output Manager processes the original input Microsoft Office file. You
can delete, retain, or process the next rule for the input document. If you select Process next rule, the input document
skips the rest of the actions in the current rule and is processed at the start of the next rule.

Follow-on actions are available only when configuring transform actions for business rules.

Transform Package dialog box
Use this dialog box to specify the transform package you want to use.

You can access this dialog box when you create or modify a transform package in the Configure Transform dialog
box.
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Transform package name

Specifies the transform package name.

Transform package type

Specifies the type of transform package.

• EXE path — Specifies the exe path.
• Profile path — Specifies the profile path.

Transform Record Mode (Advanced) dialog box
Use this dialog box to configure a business rule action to transform documents using record mode (advanced). This
advanced option is used to perform custom conversions using DCO chains. This provides flexibility to specify code
pages, carriage controls, record formats, and so forth. for the incoming document and the output desired.

Tip:  If needed, you can use the Data Conversion Utility to create custom DCOs for converting data formats.
This will not be necessary for most users. If you think this conversion is necessary, please contact Nuance
Support to ensure the data is converted properly.

Server

Specifies the licensed rules agent server that you would like to use.

Parameters

Code page in — Specifies the code page that represents the current status of the input document. The default format
is 037 (EBCDIC).

Code page out — Specifies the code page that represents how the file is being transformed. The default format is 437
(ASCII).

FCB — Specifies the FCB resource that will control the vertical format of printed output. You can select a defined
FCB in the drop-down list or click the browse button (...) to create, modify, or import FCBs in the Resource
Manager dialog box. FCBs are created using the FCB Resource dialog box.

FCB description — Provides a description of the selected FCB.

FCB default — Specifies the default FCB. The default is STD, a predefined FCB with 66 lines and channel stop 1 on
line 1.

In type — Specifies the input data type.

Out type — Specifies the desired output data type.

Data type after conversion — Specifies the data type of the output documents.

Use block lengths — Enables or disables the use of block lengths in the record. When this option is selected, records
include a block count. The block count will directly precede the record count. In the following example, the block
count consists of the first four hexadecimal values (00 0C 00 00) and the record count consists of the second four
hexadecimal values (00 08 00 00):

00 0C 00 00 00 08 00 00 F1 F2 F3 F4
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FCB override — Enables or disables overriding FCBs. Enabling this option causes FCBs in the beginning of the data
to be ignored, functioning as if there were no FCBs in the data.

Send FCB — Enables or disables sending FCBs to the printer.

Delimiter — Selects the type of delimiter to use. You can choose one of the following:

• None — Records do not include delimiter characters.
• ASCII — Records include an ASCII delimiter. Each record ends in a carriage return and line feed character. The

actual record length is two bytes more than the fixed record length specified above.
• EBCDIC — Records include an EBCDIC delimiter. Each record ends in a carriage return and line feed character.

The actual record length is two bytes more than the fixed record length specified above.

Truncate Trailing Blanks — Enables or disables the truncating of trailing blanks.

Pad record — Enables or disables pad record. Enabling this option pads blank records with a space.

Pad skip1 — Enables or disables pad skip to channel 1. Enabling this option pads blank records with a space.

Length — Specifies the length of the fixed records. The default value is 80.

Follow on actions

Input document — Specifies the follow on actions for the input document (original document). You can choose to
delete, retain, or process the next rule for the original document. The newly created documents (output documents)
continue with the next rule action.

Transform Record Mode (Basic) dialog box
Use this dialog box to configure a business rule action to transform documents using record mode (basic). This will
perform the most common transforms for data coming from a Output Manager Print Server device. This converts .tnj
to ASCII text, .anj to AFP, and .bnj to .bin.

Server

Specifies the licensed rules agent server that you would like to use.

Follow on actions

Input document — Specifies the follow on actions for the input document (original document). You can choose to
delete, retain, or process the next rule for the original document. The newly created documents (output documents)
continue with the next rule action.

Universal PS Driver Wizard
Use the Universal PS Driver Wizard to create new windows queues, and new Output Manager Sources to associate
them with. The new queues will use which will use the NSi Universal PS Driver, Additionally, new Output Manager
Destinations and Devices can be created to associate with the new sources. All documents sent to the Windows
queues will be received in Output Manager through the new sources and automatically be routed to the associated
destinations.
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Task Description

Create a single Windows print queue This procedure describes how to create a single
Microsoft Windows print queue with an Output Manager
source, destination, and device.

Use manual grid entry to add multiple Windows print
queues

This procedure describes how to use the manual grid
entry to simultaneously add multiple Microsoft Windows
print queues with OM sources, destinations, and devices.

Import multiple queues from a file This procedure describes how to import Microsoft
Windows queue information from a file. After you
import the file, you can edit queue properties before
creating the queues.

Restriction:  The Universal PS Driver Wizard is used to create Windows queues and Output Manager
sources. These queues can be shared to Active Directory, but are not published to individual workstations.
Users can browse to the printers (Windows print queues) and add them manually. Alternatively, the printers
can be pushed out to workstations by various network management tools.

How to create a Microsoft Windows print queue
This procedure describes how to create a single Microsoft Windows print queue with an Output Manager source,
destination, and device.

In Windows Devices and Printers, confirm that the NSi Universal PS Driver is installed on all Nuance Output
Manager servers that host print queues.

You can create a new Microsoft Windows print queue using a new or existing device or destination.

1. In the Output Manager Console, click Tools > Universal PS Driver Wizard.
2. On the Welcome page, choose an option as described in the following table, and then click Next:

Option Description

Add New OM Destinations, and OM Devices Choose this option to create new Microsoft Windows
queues and new sources, new destinations, and new
devices.

Add New OM Destinations to
match with existing OM Devices

Choose this option to create Microsoft Windows
queues and new sources and new destinations when the
devices already exist in Output Manager.

Match with existing OM Destinations Choose this option to create new Microsoft Windows
queues and new Output Manager sources when the
destinations and devices already exist in Output
Manager.

3. On the Select method to create Windows Queues page, select Add one queue.
4. In the Create queues on server drop-down list box, select the Nuance Output Manager server on which to create

the queue.

Note:  The NSi Universal PS Driver must already be installed on the selected server.

5. If you selected Add New OM Destinations to match with existing OM Devices, specify how the server
communicates with the printer, and then click Next.
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• To use the printer DNS name, select Use DNS name for printers if available.
• To use the printer IP address, clear Use DNS name for printers if available.

6. In the Configure a single Windows Queue page, configure the Windows Queue Information options as
described in the following table:

Option Description

Windows queue name Specifies the print queue name on the server.

Share to the network as Enable this option to use a different name to identify
the printer to users on the network.

Location Type the physical location of the printer (for example,
Sales department, or Europe office).

Comments Type the purpose, use, configuration, ownership, or
other characteristics of the printer.

7. Select a source group in which to create the new Nuance Output Manager source.
8. Choose the File store location for documents to be stored.
9. The next steps depend on whether you are adding a new destination or device.

Add a new destination and a new device:
a) In the Create destination on server drop-down list box, select the Nuance Output Manager server on which to

create the destination.
b) Type the destination name and select the destination type.
c) Select the destination group to which the destination belongs.
d) Select the SNMP server for the new device.
e) Specify the IP address or DNS name of the device.
f) Define the port or queue name (LPR) that the destination uses to communicate with the device.
g) Select the device group to which the device belongs.
Add a new destination for an existing device:
a) Select the Nuance Output Manager server on which to create the destination.
b) Type the destination name and select the destination type.
c) Select the destination group to which the new destination belongs.
d) Define the port or queue name (LPR) that the destination uses to communicate with the device.
e) Select the existing device.
Use an existing destination:
a) Select the existing destination.

10. Click Next.
11. Review the message on the Confirm Action Wizard page, and then click Create.

This completes the procedure and displays a log form of completed actions along with any errors that may have
occurred.

12. Optional: Review and save the log form.
13. Click Finish.
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How to add multiple Microsoft Windows print queues
This procedure describes how to use the manual grid entry to simultaneously add multiple Microsoft Windows print
queues with OM sources, destinations, and devices.

Verify that the NSi Universal PS Driver is installed on all Nuance Output Manager servers that host print queues.

You can use the Output Manager Universal PS Driver Wizard documented by this procedure to create destinations
of type Socket, LPR, or IPP.

1. In the Output Manager Console, click Tools > Universal PS Driver Wizard.
2. On the Welcome page, choose an option as described in the following table, and then click Next:

Option Description

Add New OM Destinations, and OM Devices Choose this option to create new Microsoft Windows
queues and new sources, new destinations, and new
devices.

Add New OM Destinations to
match with existing OM Devices

Choose this option to create Microsoft Windows
queues and new sources and new destinations when the
devices already exist in Output Manager.

Match with existing OM Destinations Choose this option to create new Microsoft Windows
queues and new Output Manager sources when the
destinations and devices already exist in Output
Manager.

3. On the Select method to create Windows Queues page, select Add multiple queues - manual grid entry.
4. In the Create queues on server drop-down list box, select the server on which to create the queues.

Note:  The NSi Universal PS Driver must already be installed on the selected server.

5. If you selected Add new OM Destinations to match with existing OM Devices, specify how the server
communicates with the printer, and then click Next.

• To use the printer DNS name, select Use DNS name for printers if available.
• To use the printer IP address, clear Use DNS name for printers if available.

6. On the Configure multiple Windows Queues page, specify the number of queues in the Number of rows to add
field, and then click Add.

7. Configure options for each row in the grid as follows:

All queues Configure the following options for all new queues:

Option Description

Windows Queue Name Specifies the name for the queue.

Shared Select this option to share the queue on your network.

Share Name The label that identifies the shared queue on the
network. Use the share name to access a network
resource with a UNC name (for example, \\server\shar
e name).

Location Type the physical location of the printer (for example,
Sales office or Europe office).
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Option Description

Comment Type additional information about the queue.

Source Group Select the Nuance Output Manager source group folder.

File Store The location where Nuance Output Manager stores
files. The default settings is specified by the Document
file store path option in the Output Manager Console
on the Administration > Set General Preferences >
General tab.

Output Server Select the Nuance Output Manager server that hosts the
destination.

New destinations Configure the following options for new destinations:

Option Description

Destination Name Type the name for the new destination.

Destination Type Select the destination type.

Destination Group Select the destination group to which the new
destination belongs.

Port or Queue Specifies the port or queue name (LPR) that the
destination uses to communicate with the device.

New devices Configure the following options for new devices:

Option Description

Snmp Server Select the SNMP server for the device.

Device Group Select the device group to which the new device
belongs.

Ip Addr or Dns Name Type the IP address or DNS name for the device.

Existing devices Click the browse button (...) to select the existing
device.

Existing destinations Select the existing Nuance Output Manager destination.

8. Click Next.
9. Review the message on the Confirm Action Wizard page, and then click Create.

This completes the procedure and displays a log form of completed actions along with any errors that may have
occurred.

10. Optional: Review and save the log form.
11. Click Finish.
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How to import queues from a file
This procedure describes how to import Microsoft Windows queue information from a file. After you import the file,
you can edit queue properties before creating the queues.

Verify that the NSi Universal PS Driver is installed on all Nuance Output Manager servers that host print queues.

1. In the Output Manager Console, click Tools > Universal PS Driver Wizard.
2. On the Welcome page, choose an option as described in the following table, and then click Next:

Option Description

Add New OM Destinations, and OM Devices Choose this option to create new Microsoft Windows
queues and new sources, new destinations, and new
devices.

Add New OM Destinations to
match with existing OM Devices

Choose this option to create Microsoft Windows
queues and new sources and new destinations when the
devices already exist in Output Manager.

Match with existing OM Destinations Choose this option to create new Microsoft Windows
queues and new Output Manager sources when the
destinations and devices already exist in Output
Manager.

3. On the Select method to create Windows Queues page, choose Add multiple queues - import from file.
4. In the Create queues on server drop-down list box, select the server on which to create the queues.
5. If you selected Add new OM Destinations to match with existing OM Devices, specify how the server

communicates with the printer, and then click Next.

• To use the printer DNS name, select Use DNS name for printers if available.
• To use the printer IP address, clear Use DNS name for printers if available.

6. On the Select file and delimiter page, enter the path or browse to the text file that contains the values to create the
Microsoft Windows queues, sources, destinations, and devices.
This can be any text file with comma, tab, or semicolon delimiters.

7. If the first row of the file contains column headers, select First row contains column headers.
8. In the Select the file delimiter box, select the delimiter that separates values in each row of the file.
9. Click Next.

The Map imported columns page of the wizard appears.
10. For each value in the Create Queue Headers column, select the corresponding text file value in the Imported

Headers column.

Note:  If the column header values in the text file are the same as the values in the Create Queue
Headers column, Nuance Output Manager automatically maps the values.

11. Click Next.
12. Configure options for each row in the grid as follows:

All queues Configure the following options for all new queues:

Option Description

Windows Queue Name Specifies the name for the queue.

Shared Select this option to share the queue on your network.
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Option Description

Share Name The label that identifies the shared queue on the
network. Use the share name to access a network
resource with a UNC name (for example, \\server\shar
e name).

Location Type the physical location of the printer (for example,
Sales office or Europe office).

Comment Type additional information about the queue.

Source Group Select the Nuance Output Manager source group folder.

File Store The location where Nuance Output Manager stores
files. The default settings is specified by the Document
file store path option in the Output Manager Console
on the Administration > Set General Preferences >
General tab.

Output Server Select the Nuance Output Manager server that hosts the
destination.

New destinations Configure the following options for new destinations:

Option Description

Destination Name Type the name for the new destination.

Destination Type Select the destination type.

Destination Group Select the destination group to which the new
destination belongs.

Port or Queue Specifies the port or queue name (LPR) that the
destination uses to communicate with the device.

New devices Configure the following options for new devices:

Option Description

Snmp Server Select the SNMP server for the device.

Device Group Select the device group to which the new device
belongs.

Ip Addr or Dns Name Type the IP address or DNS name for the device.

Existing devices Click the browse button (...) to select the existing
device.

Existing destinations Select the existing Nuance Output Manager destination.

13. Click Next.
14. Review the message on the Confirm Action Wizard page, and then click Create.
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This completes the procedure and displays a log form of completed actions along with any errors that may have
occurred.

15. Optional: Review and save the log form.
16. Click Finish.

User and Group Selection dialog box
Use this dialog box to select Nuance Output Manager users and groups. All users and groups in the Nuance Output
Manager database will be listed. This dialog is used to select users and groups for configuring security roles,
assigning permissions for the Output Manager Console, Destinations, Sources, and Documents, and configuring
notification profiles during source configuration and business rule creation.

Select users and groups

Displays the users and groups in the Nuance Output Manager database.

More Users button

If the user or group you want is not listed, click More Users to choose the type of users you want to add. Once users
are added, they are placed in the Nuance Output Manager database, causing them to always be listed in the future.
Choose one of the following options from the list.

• Add OM User — Displays the OM User dialog box for adding Nuance Output Manager users.
• Add LDAP User — Displays the LDAP User dialog box for adding LDAP users.
• Add Windows Users and Groups — Displays the Users and Groups dialog box for adding Windows users and

groups.
• Import LDAP Users and Groups — Displays the LDAP Import Utility for importing LDAP users and groups.

User Print Rules Profile dialog box
Use this dialog box to configure a user or group print rules profile. User and group print rules profiles set restrictions
based on the type of document, for example, precluding color printing and documents that exceed a certain number of
pages.

Profile name

Specifies the name of the user or group print rules profile.

Profile description

Specifies a description of the user or group print rules profile.

Restrictions — Disallow printing

Select any of the following options to determine how printing should be restricted:

• Always — Disables printing for all documents.
• If page count exceeds — Disables printing when the number of pages exceeds the specified limit.  
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• If document byte count exceeds — Disables printing when the document size is greater than the specified byte
limit.

• If document contains color — Disables printing if a document contains color.
• Ignore Windows queue restrictions for this user (if any) — Disables any restrictions set up for this user or

group in a Windows queue profile.

Show client pop-up for this user

Displays the client pop-up window for this user or group. If you select this check box, the following configuration
options are displayed for configuration of the client pop-up window.

Client pop-up general options

Use the check box options to specify the cost accounting pop-up settings. These settings determine what is displayed
on the client pop-up window:

• Show job cost on pop-up
• Allow user to override job costs on pop-up
• Allow user to specify if job is billable
• Allow user to enter additional comments
• Show account balance on pop-up

Select up to five billing lists to be displayed on the client pop-up

Use the grid to select and configure up to five billing lists to be displayed in the client pop-up window:

• Active column — Specifies that the rows with selected check boxes will be active.
• Caption column — Specifies the caption text that will be displayed on the client pop-up window.
• Input Type column — Specifies the input type that will be displayed on the client pop-up. You can select a type of

Drop Down, Write In, or Drop Down with Write In.
• Billing List column — Specifies the billing list. Billing lists are configured in the Manage Billing Accounts

Utility.

Show this pop-up instead of the pop-up (if any) configured for the Windows queue

Indicates that you want to see this pop-up window rather than the pop-up window defined for a Windows queue. If
you have configured a pop-up window for the Windows queue, it is displayed by default. If you select this check box,
this pop-up window will be displayed rather than that for the Windows queue.

Advanced button

Converts this basic user or group profile into an advanced profile. Once the profile has been converted to an advanced
profile, it cannot be returned to a basic profile. To configure an advanced profile, you use the User Print Rules
Manager dialog box.

User Print Rule dialog box
Use this dialog box to create advanced print management rules for users and groups. You can configure print
management rules to set up restrictions based on the type of document. Examples of user print rules are precluding
color printing and documents that exceed a certain number of pages.
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Name

Specifies the name of the print management rule.

Enabled

Specifies whether the rule is enabled or disabled. This field is enabled by default.

Description

Accepts a description of the print management rule. This description is displayed in the User Print Rules Manager
dialog box and in the Manage Print Rules Profiles dialog box.

Rule definition

Always execute this rule (no conditions) — Use this option to apply the rule to all documents. Selecting this option
disables the When box because no condition statements are needed.

When

Use the When box to create and manage the rule conditions. Multiple conditions can be created and organized into
groups. A blue box is used to indicate a condition group.

To create a condition, click the <Target> link and then click the appropriate condition. Click the Operation link
to select the appropriate operation. Click the Value link to select the appropriate value. The condition statement is
completed.

You can select the condition statement and use the buttons below the box to add and remove conditions:

• To enable the Add Condition and Remove Condition buttons so that you can add and remove condition
statements, select a condition radio button (inside the blue box).

• To enable the Add Group and Remove Group buttons so that you can add and remove groups, select a group
radio button (outside the blue box). The Add Condition button, used to add a condition to the selected group, will
also be enabled.

Perform the following actions

Use the Perform the following actions box to create and manage rule actions:

• To create an action, click the <Action> link and then click the appropriate action type. You can create actions that
ignore Windows queue restrictions, override the Windows queue pop-up window, disallow printing, perform cost
accounting, route to a specified destination, set the document owner, set the document state, and notify about print
rules management restrictions.

• To create additional actions, click Add Action.
• To modify an action, click the desired action link or click the area next to the link, and then click Modify Action.
• To delete an action, click the area next to the link and click Remove Action.
• To reorder the actions, click the area next to the action link and click Move Up or Move Down.

Follow-on action

Select the action you want to take after this rule has been processed. You can continue processing rules or choose not
to process any additional rules.
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User Print Rules Manager dialog box
Administrators can use this dialog box to create advanced print management rules for users and groups. Rules are
configured by selecting an event and then configuring the document process that will be performed when that event
occurs. Examples of user print rules are precluding color printing and documents that exceed a certain number of
pages.

Rules grid

The rules grid lists all of the defined print management rules in the order that they will be processed. When you select
a rule, it is displayed for preview below the grid. The rules grid is editable. Use the following procedures from the
rules grid:

• To specify whether the rule is enabled or disabled, use the check box in the Enabled column.
• To rename a rule, click the Name cell and make the change.
• To modify the rule description, click the Description cell and make the change.
• To change the follow-on action, click the Follow-on Action cell and select the action you want to take after this

rule has been processed. You can continue processing rules or choose not to process any additional rules.

The following buttons are displayed below the grid:

• Add button — Creates a new print management rule. This opens the New User Print Rule dialog box.
• Modify button — Modifies the selected print management rule. This opens the Edit User Print Rule dialog box.
• Remove button — Deletes the selected print management rule.
• Copy button — Creates a copy of the selected rule. Click the Name cell of the new rule to rename it.
• Move Up button — Reorders the rules by moving the selected rule up.
• Move Down button — Reorders the rules by moving the selected rule down.

Rule preview

Displays a preview of the selected rule.

Users tab
Use this tab to add, remove, and manage individual users. You can configure an email address and the inheritance of
quota management settings; specify a quota management profile to disable printing under certain circumstances; and
set print balances for cost control.

Click an option you want to learn more about.

• Groups tab on page 550
• Departments tab on page 492

Show only previously configured users

Displays users that were previously added by an administrator.
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Show all users

Displays all previously configured users and any users automatically created by Nuance Output Manager. When
documents are received by a Nuance Output Manager source, the document owner is automatically added as an
Nuance Output Manager user if it is not already contained in the Nuance Output Manager database.

Include removed users

Displays users that were previously removed by an administrator.

Users grid

From this grid, you can add and manage individual users.

User Name — Specifies the user name that will be used when logging in to the server.

Full Name — Specifies the full name and email address of the user.

Type — Indicates whether this user is an Nuance Output Manager user, an LDAP user, or a Windows user.

Domain or Machine — Indicates whether the location of the security database for the user account is a domain
account or a local machine account.

Email — Specifies the email address for the user.

Inherit — Specifies whether this user inherits quota settings from the department. When a new user is automatically
added to a department or when the department settings are changed by an administrator, the administrator has the
option of assigning the existing settings to the new user or the new settings to other members of the department.
Note, however, that the balance for each user changes individually. That is, the department does not share a balance.
Assigning quotas using inheritance is a good practice because administrators can more easily manage quota settings.

Do Not Track — Specifies that you do not want to track jobs from the printer.

Card ID — Identification value for the card that the user scans to log in at a device.

Secondary Card ID — Identification value for a second card that the user scans to log in at a device. The value can
be another card ID or a user ID or PIN.

Print Rule Profile — Profile that defines printing restrictions for the user and whether the system notifies the user of
restrictions by email or through the Desktop Client.

Desktop Client Profile — Name of the client profile assigned to the user. To select a profile, click the cell and select
a profile from the list. To manage profiles, click the Browse button to display the Manage Desktop Client Profiles
dialog box. The column is only visible when the Desktop Client is licensed.

Device Profile — Profile that controls the information that appears on the device when the user logs in or releases a
print job. For example, you can configure the profile to prompt the user for a billing account when the user releases a
print job.

Print Delegates — User or group that has permission to print for the selected user.

Set Balance — Indicates if a print allowance is assigned to the user. Selecting this option activates Allowances
Profile, Remaining Balance, and Next Refresh.

Allowances Profile — Profile that controls quota and cost management values for the user. For example, you can
configure a profile that controls how many color pages a user can print during a specified period.

Remaining Balance — Monetary balance available to the user to print documents.

Remaining Copy Balance — Monetary balance available to the user to copy documents.
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Remaining Pages (Color or Total) — Number of pages available to the user if you set a total or color page limit in
the allowances profile.

Remaining Pages (B&W) — Number of black and white pages available to the user if you set a black and white page
limit in the allowances profile.

Next Refresh — Date on which the new accounting period begins.

Print Delegates — User or group that has permission to print for the selected user.

Role — Indicates whether the user is a system administrator, security administrator, or does not belong to a role.

 Print or Export Users Grid button

Opens a Preview window in which you can print, email, or export the user grid in a document, data, or image format.
The export command exports the user list to the to one of the following file formats: PDF, HTML, MHT, RTF, XLS,
XLSX, CSV, text (tab delimited), and image (BMP, EMF, WMF, GIF, JPEG, PNG, TIFF). The email command
exports and emails the user list file in all of the same formats except for HTML.

User/Group Import Wizard button

Allows importing users into Nuance Output Manager from a CSV file on disk, Active Directory users and groups, and
LDAP users and groups. You can specify exactly how you want to do the import (for example, the column from the
CSV file that contains the user names). You can also specify if you want to run the wizard as a scheduled task. For
example, if you configured the wizard to run every 24 hours and an employee changed departments, if HR updated
their department in Active Directory, Nuance Output Manager would pick that up change within 24 hours.

More Users button

If the user to whom you want to assign quota settings is not listed, click More Users to add that user. Once users are
added, they are placed in the Nuance Output Manager database and will always be listed in the future. Choose one of
the following options from the list:

• Add OM User — Displays the OM User dialog box for adding Nuance Output Manager users.
• Add LDAP User — Displays the LDAP User dialog box for adding LDAP users.
• Add Windows Users — Displays the Users and Groups dialog box for adding Windows users and groups.

Modify button

Depending on the type of user selected, displays the Edit Windows User dialog box, the OM User dialog box, or the
LDAP User dialog box so that you can change the information.

Remove button

Deletes the selected user.

Viewer Configuration dialog box
Nuance Output Manager allows you to configure the Viewer utilities that display when you right-click documents in
the Output Manager Console. The Output Manager Viewer utility is part of the Output Manager Console and can be
opened for all supported data types. In addition, you can define the other Viewer utilities you want to use, depending
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on the data type of the documents. To access the Viewer Configuration dialog box, on the Output Manager Console
menu bar, click Tools > Configure Viewer.

Step 1: Select a Viewer

Displays all of the installed Viewer utilities. Click directly in the grid to modify.

Viewer name — Specifies the name of the Viewer utility. This is the name that displays when you right-click
documents in the Output Manager Console.

Viewer path — Specifies the path and file name of the Viewer utility executable. You can type the path and file name
or click the browse button (...) in the cell to navigate.

Arguments — Specifies any command line options or switches used to start the utility with the desired configuration.

Delete — Deletes the Viewer utility in the associated row. The Output Manager Viewer cannot be deleted.

Step 2: Enter the data types

Displays the data types the selected Viewer utility can open. Click in the grid to modify.

Data Type — Specifies the data types the selected Viewer utility can open. You can select individual data types for
each row or select Undefined or All data types.

Conversion (Advanced) — Changes record formats of the incoming data, before passing the data to the Viewer
utility. Choose if you need to convert files from the Output Manager Print Server (.tnj) file format to one of the
following types: binary (.bin), text (.txt), or Xerox (.xrx).

Delete — Deletes the data type in the associated row.

Windows Queue Quota Profile dialog box
Use this dialog box to configure a Windows queue profile. Windows queue profiles consist of configuring quota
management for the queue. Quota management can be configured to set up restrictions based on the document
properties. Examples include disallowing color printing, requiring documents to be duplex, disabling print from
certain applications, and so on.

Profile name

Specifies the name of the Windows queue profile.

Profile description

Specifies a description of the Windows queue profile.

Restrictions - Disable printing

Use the following options to determine when printing should be disabled.

• Always — Disables printing for all documents.
• If document is not duplex — Disables printing for documents not configured for duplex printing.
• If page count exceeds — Disables printing when the number of pages exceeds the specified limit.
• If document byte count exceeds — Disables printing when the document size is greater than the specified byte

limit.
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• If document contains color — Disables printing if a document contains color.
• If pages printed in the calendar month exceeds — Disables printing based on the number of pages printed in a

calendar month. If the document page count is greater than the number of allowed pages to print, printing will be
disabled.

Restriction Notification Options

Use the following options to determine how you want to be notified if a restriction occurs.

• Notify via email — Selects the email profile that will be used to send notifications. You can select a profile from
the list or click the Browse button and mange profiles from the Manage Outbound Email Profiles dialog box.
From this dialog box you can create and modify email profiles.

• Notify via client pop-up — Notifications will display on the client pop-up.

Show client pop-up for this Windows queue

Displays the client pop-up for this Windows queue. Selecting this check box displays the following sections for
configuring the client pop-up.

Client pop-up general options

Use the check box options to specify the cost accounting pop-up settings. This determines what will display on the
client pop-up.

• Show job cost on pop-up
• Allow user to override job costs on pop-up
• Allow user to specify if job is billable
• Allow user to enter additional comments
• Show account balance on pop-up

Select up to five billing lists to be displayed on the client pop-up

Use the grid to select and configure up to five billing lists to be displayed in the client pop-up.

• Active column — The rows with selected check boxes will be active.
• Caption column — Specifies the caption text that will display on the client pop-up.
• Input Type column — Specifies the input type that will display on the client pop-up. You can select Drop Down,

Write In, or Drop Down with Write In.
• Billing List — Specifies the billing list. Billing lists are configured in the Manage Billing Accounts Utility.

Advanced button

Converts this basic Windows queue profile into an advanced Windows queue profile. Once the profile has been
converted to an advanced profile, it cannot be returned to a basic profile. The advanced profile will use the Windows
Queue Quota Rules Manager to configure the profile.

Windows Queue Quota Rule dialog box
Use this dialog box to create advanced quota management rules for Windows queues. You can configure quota
management rules to set up restrictions based on the type of document. Examples include disallowing color printing,
requiring documents to be duplex, disabling print from certain applications, and so on.
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Name

Enter the name of the quota management rule.

Enabled

Use the check box to enable or disable the rule. This option is enabled by default.

Description

Enter a description of the quota management rule. This will display in the Windows Queue Quota Rules Manager
dialog box.

Rule definition

Always execute this rule (no conditions) — Use this option to apply the rule to all documents. Selecting this check
box disables the When box, as no condition statements are needed.

When

The When box is used to create and manage the rule conditions. Multiple conditions can be created and organized
into groups. A blue box is used to indicate a condition group.

To create a condition, click the <Target> link and use the list to select the appropriate condition. Click the Operation
link to select the appropriate operation. Click the Value link to select the appropriate value. This will complete the
condition statement.

You can select the condition statement and use the buttons below the box to add and remove conditions.

• Select a condition radio button (inside the box) to enable the Add Condition and Remove Condition buttons for
adding and removing condition statements.

• Select a group radio button (outside the box) to enable the Add Group and Remove Group buttons for adding
and removing groups. This will also enable the Add Condition button for adding a condition to the selected
group.

Perform the following actions

The Perform the following actions box is used to create and manage rule actions.

• To create an action, click the <Action> link and select the appropriate action type. You can create actions to do
the following: disallow printing, perform cost accounting, route to destinations, set document owners, and set
document state.

• To create additional actions, click Add Action.
• To modify an action, click the desired action link or click the area next to the link and click Modify Action.
• To delete an action, click the area next to the link and click Remove Action.
• To reorder the actions, click the area next to the action link and click Move Up or Move Down.

Follow-on action

Select the action you would like to take after this rule has been processed. You can continue processing rules or select
not to process any additional rules.
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Windows Queue Print Rules Manager dialog box
Administrators can use this dialog box to create advanced quota management rules for Windows queues. Rules are
configured by selecting an event and then configuring the document process that will be performed when that event
occurs. Example quota management rules include disallowing color printing, requiring documents to be duplex,
disabling print from certain applications, and so on.

Option Description

Rules list This table lists all of the defined quota management rules
, in the order they will be processed. Selecting a rule will
display the rule for preview below the grid. You can edit
values within the table.

• Enabled — Select or clear a check box in this
column to enable or disable a rule.

• Name — Click a cell in this column to edit the name
of a rule.

• Description — Click a cell in this column to change
the description of a rule.

• Follow-on Action — To change the follow-on action,
click in a cell in this column and select the action you
would like to take after this rule has been processed.
You can choose to Continue processing rules or Do
not to process any additional rules.

Add Click this button to create a new quota management rule.
Displays the Windows Queue Quota Rule dialog box.

Modify Click this button to modify the selected quota managem
ent rule. Displays the Windows Queue Quota Rule dial
og box.

Remove Click this button to delete the selected quota managemen
t rule.

Copy Creates a copy of the selected rule. Click in the Name ce
ll of the new rule to rename.

Move Up Click to move the selected rule up in the list.

Move Down Click to move the selected rule down in the list.

Preview for rule Displays a preview of the selected rule.

Zip Package dialog box
Use this dialog box to configure a zip package ad hoc rule action. You can access this dialog when you configure the
action in the Ad Hoc Rule dialog box or when you create and run the action against documents in the Documents
grid.
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Zip File Name

Specifies the name of the zipped file.

Used as a post-processing action

Specifies this rule will be used after all documents have been received into Nuance Output Manager.

Original documents

Determines what will happen to the original documents after the zipped file has been created. You can leave them in
the spooler, move them to retain, or delete them.
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